
CUSTOMER

SAP Crystal Reports, developer version for Microsoft Visual Studio
Document Version: Support Package 15 – 2015-10-13

SAP Crystal Reports for Visual Studio .NET SDK 
Developer Guide



Content

1 SAP Crystal Reports .NET SDK Developer Guide. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.1 Start Here. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4

What is SAP Crystal Reports, developer version for Microsoft Visual Studio?. . . . . . . . . . . . . . . . . . . 4
What's New in the SAP Crystal Reports .NET SDK. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Migrating your SAP Crystal Reports .Net application. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

1.2 Setting Up the Development Environment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
System Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10
Project Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

1.3 SDK Fundamentals. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Architecture. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .29
The CrystalReportViewer Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .39
Which Persistence Approach Should I Use with SAP Crystal Reports?. . . . . . . . . . . . . . . . . . . . . . . 48
Scaling your Application. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Using SAP Crystal Reports in a Web Farm or Web Garden. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Working with Crystal Reports as a Web Service. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Security Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

1.4 Using the SDK. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
Printing a report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
Exporting a report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Filtering data with Parameters or Formulas. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
Setting the Data Source. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132
Viewing a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142
Customizing the CrystalReportViewer control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196
Working with SAP Crystal Reports Read-Only (RPTR) reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . 211

1.5 Tutorials. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212
CrystalReportViewer Object Model Tutorials. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212
ReportDocument Object Model Tutorials. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
Reduced-Code Tutorials in Visual Studio. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 421
Data Connectivity Tutorials. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 454
Other Tutorials. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 487

1.6 Deployment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .510
Deployment Components. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 510
Deployment For Visual Studio. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 519

1.7 Creating Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 531
Using the Embedded SAP Crystal Reports Designer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 531
Formula Reference. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 647

2 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

Content



User Interface Reference. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 711
1.8 Glossary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 847

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
Content C U S T O M E R 3



1 SAP Crystal Reports .NET SDK Developer 
Guide

1.1 Start Here

This online help is designed to help you develop your own Web or Windows applications with the SAP Crystal 
Reports .NET SDK. It includes tutorials and programming references that you can use to implement the SAP 
Crystal Reports .NET SDK.

1.1.1  What is SAP Crystal Reports, developer version for 
Microsoft Visual Studio?

SAP Crystal Reports, developer version for Microsoft Visual Studio allows you to create complex and professional 
reports in a GUI-based program. Then you can connect your report to almost any database source, as well as to 
proxy data, such as a result set (for example, an ADO.NET DataSet). With the wizards included in the GUI 
designer, you can set formatting, grouping, charting, and other criteria.

You can host your report in either a Web or Windows application, with one of the SAP Crystal Reports viewer 
controls. Report presentation in both Windows and HTML 4.0 clients is highly interactive and provides you with 
features such as chart drill down, report navigation, and text search.

SAP Crystal Reports, developer version for Microsoft Visual Studio ships with an extensive SDK. You can use the 
SDK to interact with the report programmatically at runtime, by use of one of four possible object models:

● CrystalReportViewer, the simplest object model.
● ReportDocument, the more extensive object model.
● ReportClientDocument, the most extensive object model. This object model is available with a RAS Server.
● InfoObject, a powerful object model for scheduling and configuring reports within the SAP Crystal Reports 

Server or SAP BusinessObjects Business Intelligence platform framework.

Note
The CrystalReportViewer object model and the ReportDocument object model are available with all 
versions of SAP Crystal Reports, developer version for Microsoft Visual Studio. The ReportClientDocument 
object model and the InfoObject object model require upgraded licensing. See SAP BusinessObjects 
Business Intelligence reporting solutions [page 59].

Your reports can be related to your Visual Studio project in many ways:

● Embed your reports directly into the project.
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● Access your reports from a file directory.
● Access your reports as a Report Web Service from a remote server.
● Connect your reports as Crystal Services.
● With an upgrade to SAP Crystal Reports Server, you can access your reports through the RAS server.
● With an upgrade to SAP BusinessObjects Business Intelligence platform, you can access your reports through 

the Page server or the RAS server contained within an SAP BusinessObjects Business Intelligence platform 
framework.

1.1.1.1 Features available in SAP Crystal Reports Designer

SAP Crystal Reports Designer provides several features that are not available with SAP Crystal Reports, developer 
version for Microsoft Visual Studio:

Feature Description

Calculated members in crosstab charts You can add rows or columns to a Cross-Tab chart by 
inserting a Calculated Member. These rows or columns can 
contain custom calculations (for example, the difference in 
sales between two regions) or can be used entirely for 
formatting purposes (for example, inserting a blank row 
every three lines to increase readability).You have complete 
flexibility in designing your own calculation formulas and can 
choose whether they appear only once or repeat regularly in 
the Cross-Tab.

Embeded Flash objects You can embed a Flash object or link to a Flash object in any 
section of a SAP Crystal Reports report.

Embedded summaries in crosstabs You can add an additional calculation to your Cross-Tab 
chart by inserting an Embedded Summary. Embedded 
Summaries do not add rows or columns to your Cross-Tab. 
Instead, they cause additional calculations to appear within 
each cell of the Cross-Tab. For example, in a report showing 
regional sales, you could insert a calculation for each region 
that shows the percentage of total sales for the country.

Editable preview With the SAP Crystal Reports Designer, you can view a report 
in the design tab or preview tab. You have the same 
formatting capabilities in the Preview tab as you do in the 
Design tab.However, in the Preview tab you are working with 
the actual data. Instead of a field frame representing many 
field values, the actual values appear in the report.

Formatted barcodes The SAP Crystal Reports Designer includes the formula and 
fonts necessary for supporting Code39 barcodes. You can 
use the Format Field option to change the appearance of a 
barcode.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
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Feature Description

There are many reasons to change the appearance of a 
barcode including the following:

● To change the size so that the barcode is not too large or 
too small for a scanner to read.

● To display the barcode in a different color.

Interactive sort fields You can design your report so that users can modify a sort 
field or sort direction without refreshing information from the 
database. You can do this by adding a Sort Control to your 
report.

A Sort Control is particularly useful for several reasons:

● It allows users to sort report data for further analysis 
without leaving the canvas of the report.

● It eliminates processing demand on the database.
● It reduces the time users spend waiting for data to be 

sorted.
● It allows users to sort fields in the report even if they do 

not have a connection or rights to access the database 
at the time of viewing.

Workbench In the Workbench, you can create projects that contain one 
or more reports. Options on the toolbar allow you to add, 
remove, or rename folders, reports,and object packages. You 
can reorganize the files in a folder or folders by dragging and 
dropping them where you want them to appear. You can also 
drag report files from Windows Explorer and drop them into 
the folder of your choice in the Workbench.

1.1.2  What's New in the SAP Crystal Reports .NET SDK

This section provides a brief summary of the new features and enhancements that are offered with SAP Crystal 
Reports, developer version for Microsoft Visual Studio.

For other important product information, see the release notes that are provided with your product distribution.

SAP Crystal Reports Read-Only (RPTR) Format

SAP Crystal Reports Read-Only (RPTR) format lets you share Crystal reports while protecting your intellectual 
property. An RPTR file can be refreshed at run-time but the report definition cannot be modified or exported.

RPTR files can be viewed using a report viewer control. For security purposes, an RPTR file cannot be converted to 
an RPT. An RPTR file cannot be opened with a designer that can modify the report, for example, the SAP Crystal 
Reports 2011 designer, or the Visual Studio embedded designer.
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You create an RPTR report by exporting an RPT report to RPTR format. If a file that includes a subreport file is 
exported to RPTR, both the subreport and report will be exported as RPTR. An RPTR file cannot be added as a 
subreport to an RPT.

For more information see Working with SAP Crystal Reports Read-Only (RPTR) reports [page 211].

New Export Formats

● Microsoft Excel 2007 (XLSX) Data-Only
Reports can now be exported to Microsoft Excel 2007 (XLSX) format. XLSX format supports the 'Big Grid'. 
This feature allows for up to 16385 columns and 1,048,576 rows in a single workbook.

● SAP Crystal Reports Read-Only (RPTR)
Reports can be exported to the SAP Crystal Reports Read-Only (RPTR) format using the Visual Studio 
Embedded designer, and the SDK. However, you cannot export RPT files to RPTR using the report viewer.

For more information see Available export formats [page 108].

SAP Crystal Report Viewer Support for WPF Applications

A CrystalReportViewer control is now available for Windows Presentation Foundation (WPF) applications.

64-bit Support

In SAP Crystal Reports, developer version for Microsoft Visual Studio x64 (AMD64) 64-bit architecture is 
supported. However, IA64 (Itanium) architecture is not currently supported.

1.1.3  Migrating your SAP Crystal Reports .Net application

This section provides information on migrating your SAP Crystal Reports .Net application to SAP Crystal Reports, 
developer version for Microsoft Visual Studio.

Note
SAP Crystal Reports, developer version for Microsoft Visual Studio includes a complete feature set and is 
available as a free download that integrates with Visual Studio 2010 or newer. SAP Crystal Reports, developer 
version for Microsoft Visual Studio is not included with the SAP Crystal Reports Designer application.
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Migration options across versions of SAP Crystal Reports

This diagram shows the various migration paths between versions of SAP Crystal Reports. 

Migrating to SAP Crystal Reports, developer version for Microsoft Visual 
Studio

SAP Crystal Reports, developer version for Microsoft Visual Studio automatically upgrades your previous projects 
to the current version. If a project has references to older components, the user is prompted to upgrade.

When you click the Yes button, the projects and its files are upgraded to the current version of SAP Crystal 
Reports. When you click the No button, the project is adjusted to use the original references. Some of the earlier 
features become disabled, because the older components do not have that particular functionality.
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Note
If the project file (any ASPX file that has any SAP Crystal Reports components or the web.config file) is locked, 
the upgrade or fix fails.

Related Information

SAP BusinessObjects Business Intelligence reporting solutions [page 59]

1.1.3.1 Migration Issues

A report based on an ADO.NET data source will not work if the project targets 
the .NET 4.x Framework 

Reports based on an ADO.NET data source will not work if the project targets the .NET 4.x Framework. The 
following error is produced: "Additional information: Mixed mode assembly is built against version 'v2.0.50727' of 
the runtime and cannot be loaded in the 4.x runtime without additional configuration information."

A solution for this issue is to update your project's .config file. Add the following lines of code within the 
<configuration></configuration> section of the file:

<startup useLegacyV2RuntimeActivationPolicy="true">   <supportedRuntime version="v4.x"/> </startup>

1.1.3.2 64-bit Limitations

In SAP Crystal Reports, developer version for Microsoft Visual Studio x64 (AMD64) 64-bit architecture is 
supported. However, IA64 (Itanium) architecture is not currently supported.

Features currently not supported in 64-bit scenarios:

● Exporting reports to HTML format.
● Geographic mapping components.
● Azalea barcode font components.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
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1.2 Setting Up the Development Environment

This section gives detailed instructions on how to install and configure your development environment, and how to 
create a Web site or Windows project in SAP Crystal Reports, developer version for Microsoft Visual Studio.

1.2.1  System Setup

This section provides an overview of how to set up your development environment to test and develop Windows 
applications or Web sites that use the SAP Crystal Reports .Net SDK.

1.2.1.1 What Needs to be Installed?

You need to install SAP Crystal Reports, developer version for Microsoft Visual Studio before you can create Web 
or Windows applications that use SAP Crystal Reports.

1.2.1.1.1 Supported Versions of Visual Studio

If you intend to use SAP Crystal Reports, developer version for Microsoft Visual Studio, you must verify that the 
version of Visual Studio that you have installed supports SAP Crystal Reports.

Visual Studio Ultimate, Premium, and Professional editions are supported for Visual Studio 2010 and newer. 
Visual Studio Express editions are not supported by SAP Crystal Reports.

Related Information

SAP BusinessObjects Business Intelligence reporting solutions [page 59]

1.2.1.1.2 SAP Crystal Reports Versions

Multiple versions of SAP Crystal Reports are available. Many of the procedures in this document are version-
specific. To best use this document to your advantage, determine first which version of SAP Crystal Reports you 
have installed.
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1.2.1.1.2.1  To determine which version of SAP Crystal Reports 
you are currently using

1. Go to the GAC (Global Assembly Cache) at either C:\WINNT\Assembly or C:\Windows\Assembly.

2. Locate the CrystalDecisions.CrystalReports.Engine file.

Note
If you have installed more than one version of SAP Crystal Reports, you have multiple versions of these files 
in the Global Assembly Cache. The CrystalDecisions.CrystalReports.Engine file is selected, because this file 
is included with every version of SAP Crystal Reports.

3. Note the Version column shown in the window.

This is the "Assembly version."
4. Locate the highest number for a particular assembly.
5. Compare the assembly version against the version number in the SAP Crystal Reports Versions chart.

1.2.1.1.2.2  SAP Crystal Reports Versions

Product Assembly Version

SAP Crystal Reports, developer version for Microsoft Visual 
Studio (.NET 4.0 Framework)

13.0.2000.0

SAP Crystal Reports 2008 (.NET 2.0 Framework) 12.0.2000.0

SAP Crystal Reports 2008 (.NET 1.1 Framework) 12.0.1100.0

SAP Crystal Reports XI Release 2 11.5.3300.0

SAP Crystal Reports XI Release 1 11.0.3300.0

SAP Crystal Reports Basic for Visual Studio 2008 10.5.3600.0

SAP Crystal Reports for Visual Studio 2005 10.2.3600.0

SAP Crystal Reports 10 10.0.3300.0

SAP Crystal Reports 9 9.2.3300

SAP Crystal Reports for Visual Studio 2003 9.1.5000

SAP Crystal Reports 2008 and SAP Crystal Reports 2008 SP1 use the same Assembly Version number. To check 
whether you have SAP Crystal Reports 2008 SP1 installed, verify that the file version starts with 12.1 and not 12.0.

1.2.1.1.3 Install the SAP Crystal Reports Update Service

SAP Crystal Reports, developer version for Microsoft Visual Studio now provides an optional SAP Crystal Reports 
Update Service that checks for updates, hot fixes, and patches for SAP Crystal Reports.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
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The SAP Crystal Reports, developer version for Microsoft Visual Studio Update Service is not provided as part of 
the installer. Instead, you must download and install the Update Service separately.

1. After installing SAP Crystal Reports, developer version for Microsoft Visual Studio, launch Visual Studio and 
create a Web Site or Windows project.

2. In Solution Explorer right-click in the bold project name and click Add New Item .
3. In the Add New Item dialog box, select Crystal Report.
4. In the Name field, enter Test.rpt, and then click Add.

Note
If this is the first time that you are using the embedded SAP Crystal Report Designer, you are asked to 
consent to the End User License Agreement. After this, the Update Service dialog box opens. If you have 
opened the embedded SAP Crystal Report Designer before, you will need to open the Update Service 
dialog box manually.

The embedded SAP Crystal Reports Designer opens and displays the new report.
5. If the Update Service dialog box fails to appear, from the Crystal Reports menu, click Check for Updates.

If the SAP Crystal Reports Update Service is not installed, you will be asked whether you want to install it.
6. In the Update Service dialog box, click Yes.

The SAP Crystal Reports Update Service Web site loads, providing a link to download the Update Service.
7. Download and install the SAP Crystal Reports Update Service.
8. Launch Visual Studio again.
9. Open Test.rpt.

The embedded SAP Crystal Report Designer launches and displays the report.
10. From the Crystal Reports menu, click Check for Updates.

The Update Service launches, and then checks for updates. You can accept or reject any available update.

1.2.1.1.4 SAP Crystal Reports Product Keycode

The product keycode is an alphanumeric string that has a length of 19 digits or characters. In SAP Crystal Reports, 
developer version for Microsoft Visual Studio, when you create deployment projects that use the Windows 
Installer you may need a product keycode to validate the licensing for Web or Windows applications.

1.2.1.2 What Needs to be Verified?

To develop a Web Site or Windows application that uses the SAP Crystal Reports .NET SDK, you will need to verify 
that the Crystal Reports developer components have been correctly installed and integrated with Visual Studio. 
To develop a Web Site, you must take the additional step of verifying that the Viewers' Virtual Directory has been 
correctly installed on the development, and deployment, web servers.

This section details the settings that you will need to verify before creating a SAP Crystal Reports .NET 
application.
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Related Information

Supported Versions of Visual Studio [page 10]

1.2.1.2.1 Verify that SAP Crystal Reports is installed

To verify that the SAP Crystal Reports component of Visual Studio is installed, check that SAP Crystal Reports 
appears in the Add New Item dialog box in Visual Studio.

1. Launch Visual Studio.
2. Create a new Web or Windows project (in any language), or open an existing Web or Windows project.
3. On the Project menu, click Add New Item.

Note
New report files must be added directly to a project. You cannot create a new Crystal report in Visual 
Studio through the File menu.

4. In the Add New Item dialog box, scroll down and verify that Crystal Reports is one of the available items.

1.2.1.2.2 Viewers' Directory

SAP Crystal Reports relies on a virtual directory to access viewers for display. The virtual directory and its 
underlying file path are unique for each version of SAP Crystal Reports; that way, succeeding versions of SAP 
Crystal Reports on the same machine work without conflict.

1.2.1.2.2.1  Default Location of Viewers' Directory

If you have installed SAP Crystal Reports with the default settings and file paths, the viewers' virtual directory is 
configured as shown below.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
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Table 1:

Version Framework File Path

SAP Crystal Reports, 
developer version for 
Microsoft Visual Studio

4.x Framework File path when using ASP.NET Development Server:

\Windows\Microsoft.NET\Framework
\v4.0.30319\ASP.NETClientFiles
\crystalreportviewers13

File path when using IIS:

\inetpub\wwwroot\aspnet_client\system_web
\4_0_30319\crystalreportviewers13

SAP Crystal Reports, 
developer version for 
Microsoft Visual Studio

2.0 Framework File path when using ASP.NET Development Server:

\Windows\Microsoft.NET\Framework
\v2.0.50727\ASP.NETClientFiles
\crystalreportviewers13

File path when using IIS:

\inetpub\wwwroot\aspnet_client\system_web
\2_0_50727\crystalreportviewers13

1.2.1.2.2.2  To locate the Viewers' Directory

1. In Control Panel, double-click Administrative Tools, and then double-click Internet Information Services.
2. In the Internet Information Services dialog box, expand the Web Sites node, and then expand the Default Web 

Site node.
3. Locate all folders containing a crystalreportsviewers13 folder.

4. Right-click on each crystalreportsviewers13 folder and select Properties.

5. In the Properties dialog box, confirm that the Local Path is correctly configured for your version of SAP Crystal 
Reports or Visual Studio.

1.2.1.2.3 Sample Reports Directory

Some of the feature examples, report binding scenarios and tutorials rely on sample reports that are available 
with SAP Crystal Reports.

You can download the sample reports from: http://www.sdn.sap.com/irj/boc/downloads .
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1.2.2  Project Setup

This section is a key learning point for both advanced and intermediate developers. It demonstrates the 
recommended best practices to follow to create and configure a new Windows project or Web project/site with 
SAP Crystal Reports, developer version for Microsoft Visual Studio.

The new project that you create also serves as a prerequisite for the tutorials that are provided with this online 
help.

1.2.2.1 Web Site Setup in Visual Studio

This section demonstrates Web Site Setup in Visual Studio. The Web Site that you create serves as a prerequisite 
for the coding tutorials that are provided with this online help.

1.2.2.1.1 Creating a New Web Site in Visual Studio

1. Launch Visual Studio.
2. From the File menu, click New Web Site.
3. In the New Web Site dialog box, click ASP.NET Web Site.
4. In the Location dropdown, select File System.
5. In the Language dropdown, select the coding language that you wish to use.
6. In the Location text field enter the directory path C:\WebSites\, followed by the name of your project.

  C:\WebSites\MyProjectName  
7. Click OK.

1.2.2.1.2 Preparing the Web Form

1.2.2.1.2.1  To create the Web Form

In this section you configure the code-behind class for the Web form.

Note
The terms "Web form", "ASPX page" and "Default.aspx" are used interchangeably.

1. From the Solution Explorer, double click on Default.aspx to open the Web form.
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2. From the View menu, click Code.

The code-behind class opens. The class is named _Default class. The class file is named Default.aspx.cs or 
Default.aspx.vb.

Note
If your Default.aspx page was created with inline code, it did not place its code into a separate file. In that 
case, delete the ASPX page and recreate it. When creating the ASPX page, select the "Place code in 
separate file" checkbox.

3. If you are writing this class in Visual Basic, type "Option Strict On" at the top of the class.

Note
As a best practice, it is recommended that you set Option Strict On at the start of every Visual Basic class 
in your Web Site. When you write code, it forces the use of best practices with strongly typed variable 
declarations and valid casting, both of which are checked at compile time. Compile-time checks that are 
strictly enforced can reduce run-time exceptions.

1.2.2.1.2.2  To add Imports/Using statements to reference 
namespaces

1. Open the Default.aspx page.
2. From the View menu, click Code.

The code-behind class for the Web Form appears.
3. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of the 

class containing the following SAP Crystal Reports namespaces.

 Imports CrystalDecisions.CrystalReports.Engine
Imports CrystalDecisions.Shared 
 using CrystalDecisions.CrystalReports.Engine;
using CrystalDecisions.Shared; 

Note
The classes of these two assemblies are commonly used in all tutorials. For any additional assemblies that 
you may occasionally require in specific tutorials, you will be directed to add them during that tutorial.
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1.2.2.1.2.3  To add a private helper method for SAP Crystal 
Reports configuration code

Within the class, add a new private scope helper method, with no return value, named 
ConfigureCrystalReports().

 Private Sub ConfigureCrystalReports()
End Sub 
 private void ConfigureCrystalReports()
{
} 

The ConfigureCrystalReports() method enables users to interact with the report at runtime. It also controls 
programmatic interaction with the report.

Next, you add a Page_Init event handler from which to call the ConfigureCrystalReports() method. Calling 
the ConfigureCrystalReports() method from this event handler guarantees that the Crystal report 
configuration code runs during the page initialization event.

1.2.2.1.2.4  To add a Page_Init event handler to the code-behind 
class

Typically the Page_Load event handler is used to enter Web Form configuration code in an ASP.NET Web 
application so that the code will be called during the Page.Load event. However, the Crystal report configuration 
code needs to be called earlier, during the Page.Init event.

1. Add the Page_Init event to your code.

○ If you are coding in Visual Basic, select Page Events from the top left drop-down list and the Init event 
from the top right drop-down list. The Page_Init event handler will be added to your code-behind class.

 Private Sub Page_Init(ByVal sender As Object, ByVal e As System.EventArgs) 
Handles Me.Init
End Sub 

○ If you are coding in C#, enter the Page_Init event handler using the exact syntax shown.

 private void Page_Init(object sender, EventArgs e)
{
} 

Note
In a C# Web form in Visual Studio 2005 or later, any Page_Init, Page_Load or Page_PreRender 
event handler in the code-behind class is wired automatically to the Init, Load or PreRender event. The 
event handler signature must match exactly in order to be called.

This feature occurs when the Page directive, found at the top of the ASPX page in HTML view, has its 
AutoEventWireup parameter set to true.
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Previous versions of Visual Studio .NET always set the AutoEventWireup Page directive to False, but 
in C# Web forms in Visual Studio 2005 and later the AutoEventWireup Page directive is set to True 
by default.

2. within the Page_Init event handler for either Visual Basic or C#, enter a call to the 
ConfigureCrystalReports() helper method.

 ConfigureCrystalReports() 
 ConfigureCrystalReports(); 

3. From the File menu, click Save All.

1.2.2.1.3 To add a CrystalReportViewer control to a Web Site

1. Open the Default.aspx page.
2. Click the Design button at the bottom of the form view.
3. From the Toolbox, open the Reporting node to locate the CrystalReportViewer control.

Note
In previous versions of SAP Crystal Reports, developer version for Microsoft Visual Studio, the 
CrystalReportViewer control appeared in the Crystal Reports node.

4. Drag and drop the CrystalReportViewer control onto the Web Form.
5. From the File menu, click Save All.

When you add a CrystalReportViewer control to your application, references to the SAP Crystal Reports 
assemblies will automatically be added to your project.

1.2.2.1.4 Configuring your Web.Config file

A Web.Config file in an ASP.NET web application stores global settings such as database connection information, 
assembly references, and error handling. This file is written in XML, and its root element must always be 
<configuration>. This is an advanced configuration and is optional.

The following elements are unique to SAP Crystal Reports and may be added to your Web.Config file.

Note
Version numbers may change according to the product that you have.

Note
In .NET 2.0 and higher, the section tag in your Web.Config file should use the following syntax:

   <configSections>
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    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="printControl" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections> 

CrystalImageCleaner

The CrystalImageCleaner process automatically deletes dynamically generated images rendered by the 
CrystalReportViewer control. This setting allows you to set the interval of time between scans of the image 
directory and the minimum age of the files before they are deleted. This element is automatically added to the 
Web.Config file when you add the CrystalReportViewer control to your website. This corresponds to the 
CrystalImageCleaner class.

● CrystalImageCleaner-Sleep initializes the amount of time in milliseconds that the image cleaner sleeps 
before scanning and cleaning up image files in the dynamic image directory.

● CrystalImageCleaner-Age initializes the minimum age in milliseconds of a file before it is deleted.
● CrystalImageCleaner-AutoStart controls the CrystalImageCleaner process. The image cleaner cleans 

up the temporary images that are created when viewing a report.

Note
Only one image cleaner can be started in a single ASP.NET worker process.

   <appSettings>
    <add key="CrystalImageCleaner-AutoStart" value="true" />
    <add key="CrystalImageCleaner-Sleep" value="60000" />
    <add key="CrystalImageCleaner-Age" value="120000" />
  </appSettings>  

CrystalImageHandler

The CrystalImageHandler element displays all dynamic images in the CrystalReportViewer control. This 
setting configures the ASP.NET worker process to redirect requests made to CrystalImageHandler.aspx to an 
internal only image handler class. If you do not have the CrystalImageHandler setting in your Web.Config file, 
the images on your website will not show. This element is automatically added to the Web.Config file when you 
add the CrystalReportViewer control to your website.

   <system.web>
    <httpHandlers>
      <add verb="GET" path="CrystalImageHandler.aspx" 
type="CrystalDecisions.Web.CrystalImageHandler, CrystalDecisions.Web, 
Version=13.0.2000.0, Culture=neutral, PublicKeyToken=692fbea5521e1304"/>
    </httpHandlers>
  </system.web> 
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documentView

The documentView element controls how the report appears in the report canvas. There are two available 
settings:

● Setting the value to printlayout displays a grey border around the report and a drop shadow on the canvas. 
This is the default value.

● Setting the value to weblayout will fill the canvas with the report.

   <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="crystalReportViewer" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections>
  <businessObjects>
    <crystalReports>
      <crystalReportViewer>
        <add key="documentView" value="weblayout"/>
      </crystalReportViewer>
    </crystalReports>
  </businessObjects> 

EnableTextClipping

The EnableTextClipping element controls if field text is clipped. When set to true, the text contained in a field 
will not overlap the text in the field beside it.

   <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="crystalReportViewer" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections>
  <businessObjects>
    <crystalReports>
      <crystalReportViewer>
        <add key="EnableTextClipping" value="true"/>
      </crystalReportViewer>
    </crystalReports>
  </businessObjects> 

globalResourcePath

The globalResourcePath element is the reference to the file directory path for global resources. This file 
directory contains your custom language resources in a central location and can be shared across multiple web 
applications. This setting allows you to access the global resources in a specific website. In SAP 
CrystalReports.NET, the default resource files are not shipped with the product install, but can be downloaded 
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from the SAP BusinessObjects technical support website: http://help.sap.com. This element needs to be 
manually added to the Web.Config file of your website.

   <appSettings>     <add key="globalResourcePath" value="c:\CrystalReportViewer_resource_files\"/>   </appSettings> 

maxNumberListOfValues

The maxNumberListOfValues element controls the number of LOV items that will be sent to the client. This 
controls the number of values displayed in the parameter panel. When this value is set, only the first n values will 
appear in a list of values. You will be able to page through multiple sets of values in the Advanced dialog box based 
on the size of your list, and the value of the maxNumberListOfValues element. For example, if you have 180 
values, and you set the maxNumberListOfValues element to 50, then you will be able to see the first 50 values 
listed in the parameter panel. You will be able to page through all 180 values in the Advanced dialog box, which will 
display three groups of 50 values, and one group of 30 values.

It is recommended that this value always be greater than 0. The default value is 200.

   <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="crystalReportViewer" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections>
  <businessObjects>
    <crystalReports>
       <crystalReportViewer>
         <add key="maxNumberListOfValues" value="50"/>
       </crystalReportViewer>
    </crystalReports>
  </businessObjects> 

printControl

The printControl element allows you to print the report directly to your local printer. The default installation 
directory is C:\Program Files (x86)\SAP BusinessObjects\Crystal Reports for .NET Framework 
4.0\Common\Crystal Reports 2011\crystalreportviewers.

This setting makes the .cab file visible to your SAP Crystal Reports.NET website. This element needs to be 
manually added to the Web.Config file of your website.

   <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="printControl" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections>

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 21

http://help.sap.com


  <businessObjects>
    <crystalReports>
      <printControl>
        <add key="url" value="http://localhost/PrintControl.cab" />
      </printControl>
    </crystalReports>
  </businessObjects> 

processingIndicatorDelay

The processingIndicatorDelay element controls the time delay before the report processing indicator 
appears. The value is specified in milliseconds. Setting this value to 0 will disable the report processing indicator. 
The default value is 200 ms.

   <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="crystalReportViewer" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections>
  <businessObjects>
    <crystalReports>
      <crystalReportViewer>
        <add key="processingIndicatorDelay" value="20"/>
      </crystalReportViewer>
    </crystalReports>
  </businessObjects> 

processingIndicatorText

The processingIndicatorText element controls the text displayed in the report processing indicator. The 
default text is: Please wait while the document is being processed.

   <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="crystalReportViewer" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections>
  <businessObjects>
    <crystalReports>
      <crystalReportViewer>
        <add key="processingIndicatorText" value="Thank you for waiting."/>
      </crystalReportViewer>
    </crystalReports>
  </businessObjects> 
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reportMappings

The reportMappings element updates websites created in Visual Studio 2003 that use embedded reports to 
non-embedded websites when opened in Visual Studio 2005 or later. This setting converts the .dll file created in 
Visual Studio 2003 to a disk file. Visual Studio 2005 and 2008 do not support embedded websites and you must 
modify your Web.Config file to ensure that your report is still functional with the newer version of Visual Studio. 
This element needs to be manually added to the Web.Config file of your website. The reportMappings setting 
requires an absolute path.

Note
This element is valid for Visual Studio 2005 and Visual Studio 2008 only.

   <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="reportMappings" 
type="CrystalDecisions.Shared.ReportMappingHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections>
    
  <businessObjects>
    <crystalReports>
      <reportMappings>         <add reportName="World Sales Report.rpt" path="C:\Report\World Sales 
Report.rpt" />       </reportMappings>
    </crystalReports>
  </businessObjects> 

resourceURI

The resourceURI element sets the location of the crystalreportviewers directory in your web application. 
The crystalreportviewers directory contains all files required by the viewer.

   <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="crystalReportViewer" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections>
  <businessObjects>
    <crystalReports>
      <crystalReportViewer>
        <add key="resourceURI" value="~/crystalreportviewers12" />
      </crystalReportViewer>
    </crystalReports>   </businessObjects>
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serverFileReportManager

The serverFileReportManager element is a web service that enumerates the server files on the server 
machine. This setting allows you to get a list of objects (folders and reports) from a remote machine. This setting 
assigns the root of the file directory for the server. In this example, the root is set to c:\inetpub\wwroot. This 
element needs to be manually added to the Web.Config file of your website.

Note
This corresponds to the serverFileReportManager class.

   <configSections>
    <sectionGroup name="crystalDecisions">
      <section name="serverFileReportManager" 
type="System.Configuration.NameValueSectionHandler" />
    </sectionGroup>
  </configSections>
  <crystalDecisions>
    <serverFileReportManager>       <add key="rootDirectory" value="c:\inetpub\wwwroot" />     </serverFileReportManager>
  </crystalDecisions> 

UseAsynchronousRequests

By default, asynchronous requests are permitted within the DHTML viewer. If you wish to enable the Back button 
in the user's browser to work with the DHTML viewer, you must disable asynchronous requests by setting this 
parameter to false.

Note
It is recommended that you do not set the UseAsynchronousRequests element to false. Doing so will 
disable the Advanced dialog box in the Parameter panel, as well as some viewer performance enhancemenets 
and enhanced appearance features.

<context-param>     <param-name>crystal_use_asynchronous_requests</param-name>
    <param-value>false</param-value> </context-param>

UseBrowserLocale

The UseBrowserLocale element retrieves the language settings in your browser for the CrystalReportViewer 
control. When set to true, this setting configures the CrystalReportViewer control to observe the browser locale. 
When set to false, this setting restricts the locale that is displayed page-by-page. This element needs to be 
manually added to the Web.Config file of your website.
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  <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="crystalReportViewer" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections>
  <businessObjects>
    <crystalReports>
      <crystalReportViewer>
        <add key="UseBrowserLocale" value="true" />
      </crystalReportViewer>
    </crystalReports>
  </businessObjects> 

Example
Sample Web.Config File

 <?xml version="1.0"?>
  <configuration>
    <appSettings>
      <add key="CrystalImageCleaner-AutoStart" value="true"/>
      <add key="CrystalImageCleaner-Sleep" value="60000"/>
      <add key="CrystalImageCleaner-Age" value="120000"/>
    </appSettings>
    <connectionStrings/>
    <system.web>
      <compilation debug="true">
        <assemblies>
          <add assembly="CrystalDecisions.Web, Version=13.0.2000, 
Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
          <add assembly="CrystalDecisions.Shared, Version=13.0.2000, 
Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
          <add assembly="CrystalDecisions.ReportSource, Version=13.0.2000, 
Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
          <add assembly="CrystalDecisions.CrystalReports.Engine, 
Version=13.0.2000, Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
        </assemblies>
      </compilation>
      <authentication mode="Windows"/>
      <httpHandlers>
        <add verb="GET" path="CrystalImageHandler.aspx" 
type="CrystalDecisions.Web.CrystalImageHandler, CrystalDecisions.Web, 
Version=12.1.2000.0, Culture=neutral, PublicKeyToken=692fbea5521e1304"/>
      </httpHandlers>
    </system.web>
  </configuration> 

Related Information

Printing 
Web: Configuring Browser-Based Localization 
Web: Configuring Global or Local Custom Resources 
How to: Add or Remove References in Visual Studio 
SAP Crystal Reports Versions
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1.2.2.2 Windows Project Setup in Visual Studio

This section is a key learning point for both advanced and intermediate developers. It demonstrates the 
recommended best practices to follow to create and configure a new Windows project with SAP Crystal Reports, 
developer version for Microsoft Visual Studio.

This section demonstrates Windows project setup using a coding model. As part of this setup, you will go into the 
Form1 class and enter code. This code-based Windows project that you create serves as a prerequisite for the 
coding tutorials that are provided with this online help.

1.2.2.2.1 Creating a New Windows Project in Visual Studio

1. Launch Visual Studio.
2. From the File menu, select New, and then click Project.
3. In the New Project dialog box, select a language folder for C# or Visual Basic from the Project Types list.
4. From the Templates list, click Windows Forms Application.
5. In the Name field, replace the default project name with the name of your project.

Use a Pascal naming convention where you set the first letter of the project name to uppercase, because the 
project name also becomes the namespace name for the assembly generated from the project.

6. Click OK.

1.2.2.2.2 Applying Standard Visual Basic Project Settings 
(Optional)

You must make a minor modification to the project settings in a Visual Basic project, to configure the project to 
work with the tutorials in this documentation.

1. In Solution Explorer, right-click the bold project name that is below the solution name, and then select 
Properties.

2. In the Properties view, click the Compile tab.
3. On the OptionStrict list, click On.
4. Close the Properties view.
5. From the File menu, click Save All.

Note
As a best practice, it is recommended that you enable OptionStrict at the start of any Visual Basic 
project. When you write code, it forces the use of best practices with strongly typed variable declarations 
and valid casting, both of which are checked at compile time. Compile-time checks that are strictly 
enforced can reduce run-time exceptions.
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1.2.2.2.3 Preparing the Windows Form in Visual

1.2.2.2.3.1  To create the Windows Form

Traditional Visual Basic 6 Windows applications typically defined a default form under the name Form1. In keeping 
with that pattern in a Windows project, you use the same default form name, Form1 with a .cs or .vb extension that 
depends on the language you use.

1. If Form1 is not already displayed in the main window, double-click Form1 in Solution Explorer.

Form1 opens in the Designer.
2. From the View menu, click Code.

The code view of the Form1 class appears. The display of this class depends on whether your Windows 
application is coded in Visual Basic or C#.

In C#, the Form1 class displays the following:
○ The class signature.
○ A constructor (Form1).

In Visual Basic, the Form1 class displays the following:
○ The class signature (a Form1 class).

Note
Additional methods and variables of the Form1 class are contained in a separate "partial" class. (This is 
true for both C# and Visual Basic.) Partial classes are explained later in Windows Project Setup.

1.2.2.2.3.2  To add a private helper method for SAP Crystal 
Reports configuration code

1. Add to this Form1 class a new private scope helper method with no return value, named 
ConfigureCrystalReports().

 Private Sub ConfigureCrystalReports()
End Sub 
 private void ConfigureCrystalReports()
{
} 

Next you add a Form_Load event handler, and then put a call to ConfigureCrystalReports() within the 
Form_Load event handler. This will cause the ConfigureCrystalReports() method to run automatically 
when the form loads.

2. From the View menu, click Designer.
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3. Double-click on Form1.
You are returned to Code view. Because you double-clicked on Form1, a Form1_Load event handler is 
automatically generated in the Form1 class.

4. Within the Form1_Load event handler, enter a call to the ConfigureCrystalReports() method.

ConfigureCrystalReports()

ConfigureCrystalReports();

5. From the File menu, click Save All.

1.2.2.2.4 Adding a CrystalReportViewer control

1.2.2.2.4.1  To add a CrystalReportViewer control to a Windows 
application

1. Open a Windows form in Design view.
2. From the Toolbox, open the Reporting node to locate the CrystalReportViewer control.

Note
In previous versions Visual Studio, the CrystalReportViewer control appeared in the Crystal 
Reports node.

3. Drag and drop the CrystalReportViewer control onto the form.
4. From the File menu, click Save All.

When you add a CrystalReportViewer control to your application, references to the SAP Crystal Reports 
assemblies will automatically be added to your project.

1.2.2.2.4.2  To add Imports/Using Statements to reference 
namespaces

1. If the References folder is not visible in Solution Explorer, on the Solution Explorer toolbar, click Show All Files 
to display all project files.

2. In Solution Explorer, expand the References folder.
3. Verify that the following SAP Crystal Reports assemblies have been added:

○ CrystalDecisions.CrystalReports.Engine
○ CrystalDecisions.Shared

4. Select Form1, and then from the View menu, click Code.
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5. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of the 
class containing the following SAP Crystal Reports namespaces.

 Imports CrystalDecisions.CrystalReports.Engine
Imports CrystalDecisions.Shared 
 using CrystalDecisions.CrystalReports.Engine;
using CrystalDecisions.Shared; 

1.3 SDK Fundamentals

1.3.1  Architecture

1.3.1.1 Choose the Correct Object Model for Your Project

To choose the correct object model for your project, you must understand best practices for how to work with the 
CrystalReportViewer control, and know how the CrystalReportViewer interacts with the other object models.

Note
In this documentation, an object model refers to a core class and those classes surrounding it, which form a 
programming model. In SAP Crystal Reports these object models center around a core class that encapsulates 
a report definition file. That core class and its surrounding object model enable programmatic interaction with 
the report.

Best practices for working with the CrystalReportViewer control

An effective Web application makes clear separation between its presentation layer and its underlying business 
logic.

The design of the ASP.NET control naturally encourages that pattern. It encapsulates presentation information 
into the control, and then binds that control to an underlying object or object model that performs the business 
logic.

The CrystalReportViewer is a .NET control that adheres to this architecture. It functions as a display object on the 
Web or Windows Form (the presentation layer), and it can be bound to any of the following report object models:

● ReportDocument object model
● ReportClientDocument object model (Report Application Server)
● InfoObject object model (SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence platform)

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 29



In a best practice scenario, the CrystalReportViewer control binds to one of the object models that performs the 
business logic, typically for report manipulation.

In that scenario, the CrystalReportViewer control limits its programmatic interaction to modify only display 
settings (for example, hiding or showing the viewer's toolbar or a button within that toolbar).

The CrystalReportViewer Object Model

The CrystalReportViewer control contains properties and methods that enable interaction with how it displays 
reports. It also has a small number of properties and methods for interacting with reports that are bound to the 
control. These properties and methods constitute a limited object model.

Some report binding scenarios rely on the CrystalReportViewer object model. In these scenarios, the 
CrystalReportViewer control is bound directly to a report (for example, you pass in a path string to the report in a 
file directory), without first encapsulating the report in an object model. In those scenarios, because the 
CrystalReportViewer control encapsulates the report directly, you must rely on the control's limited object model 
for programmatic interaction with the report.

But in most binding scenarios, using CrystalReportViewer as an object model is discouraged. Use instead the 
ReportDocument object model, for the following reasons:

● The CrystalReportViewer object model raises the risk of object model conflict. Do not mix the 
CrystalReportViewer object model with other object models.

● The CrystalReportViewer object model offers limited interaction with reports; it contains only a small subset 
of the features available in the ReportDocument object model.

● The CrystalReportViewer object model blurs the separation of the presentation layer and the underlying 
business logic in your code.

The ReportDocument Object Model

ReportDocument is a more powerful and more extensive object model than CrystalReportViewer. It ships as part 
of the SAP Crystal Reports .NET SDK and provides extensive ability to manipulate reports in the code.

Which object model should you use?

If you do not intend to upgrade to SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence 
platform, the ReportDocument object model is the recommended object model for your development work with 
the SAP Crystal Reports SDK.

Note
In SAP Crystal Reports 10 or greater, and SAP Crystal Reports for Visual Studio 2005 and later, the 
ReportDocument object model has been bridged to the ReportClientDocument object model for easy 
upgrading to a managed reporting solution.
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1.3.1.2 Avoid Mixing the Object Models

Do not mix the CrystalReportViewer object model with other object models.

Use of the CrystalReportViewer control in its role as a limited object model works properly, provided you bind the 
control directly to the report with a simple path string.

But if you encapsulate the report into one of the other object models (such as ReportDocument or 
ReportClientDocument), and then bind the control to that object model, stop using the CrystalReportViewer 
object model right away. The limited model that is provided by the CrystalReportViewer control becomes 
redundant to the more powerful object model that it is bound to. Also, settings that are applied to the 
CrystalReportViewer object model are visible to the other object model, which could result in unexpected 
behaviors and exceptions.

For example, you may want to use the ReportDocument object model to export or print a monthly report from the 
server. If you have set a month parameter on this report with the CrystalReportViewer object model, you may 
experience problems. The ReportDocument object model cannot see parameter settings applied in the 
CrystalReportViewer object model. It will try to export or print the report without knowledge of that month 
parameter setting, and then display the wrong month or even throw an exception.

The best answer is to limit use of the CrystalReportViewer control to report display settings only when the control 
has been bound to one of the underlying object models.

1.3.1.3 Embedded SAP Crystal Reports Designer

The embedded SAP Crystal Reports Designer creates or modifies reports. It consists of a graphical user interface 
for WYSIWYG report design, and a series of experts to simplify data connectivity, sorting, grouping, and other 
complex report design issues. SAP Crystal Reports Developer includes an enhanced version of the embedded 
designer that allows you to build powerful reports and reporting applications. The embedded designer that is 
included with SAP Crystal Reports, developer version for Microsoft Visual Studio contains many of the features of 
SAP Crystal Reports Designer.

Role of the embedded SAP Crystal Reports Designer in the architecture

The embedded SAP Crystal Reports Designer is included in the description of the architecture, because its role is 
crucial to SAP Crystal Reports, developer version for Microsoft Visual Studio: it creates the report files to display. 
However, the role played by the embedded SAP Crystal Reports is a design-time role. The role that involves the 
display and interaction with reports, which occurs at runtime, belongs to the SAP Crystal Reports SDK. Therefore, 
while the embedded designer creates reports that are used in the architecture, it is not part of the architecture 
itself.

Related Information

Using the Embedded SAP Crystal Reports Designer [page 531]
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1.3.1.4 Report Viewer Controls

SAP Crystal Reports, developer version for Microsoft Visual Studio includes standard form controls for report 
viewing. Each control encapsulates complex report layout information into a GUI object within the Toolbox.

There are two provided controls:

The CrystalReportViewer control. This control displays the report in a page-based layout, with the ability to 
move between pages.

The CrystalReportPartsViewer 
control.

The control displays report summary information in a small, portal-like 
window, with the ability to drill down deeper into the report through a 
series of linked parts.

Each control is used to display a report by dragging and dropping the control from the Toolbox onto the Web or 
Windows form, and then assigning the ReportSource property of that control to a report.

Related Information

How Do I Use Report Viewer Controls? [page 40]

1.3.1.5 Object Models

SAP Crystal Reports, developer version for Microsoft Visual Studioprovides an SDK that contains two object 
models. With additional licensing, the SDK expands to contain four object models.

The controls for the report viewer provide the entry point into the SDK. That is because the report viewer displays 
reports by binding to a report object; all object models in the SDK expose and manipulate report objects.

Each object model provides increasing levels of power and complexity:

● The simplest object model is CrystalReportViewer.
The CrystalReportViewer control in the Web or Windows Form has, by definition, an underlying class of 
the same name. This CrystalReportViewer class exposes properties and methods for modifying the 
control's display functionality, and for interacting with classes that manage database logons, parameters, and 
selection formulas. This set of classes is the simplest object model. The CrystalReportViewer class exists in 
two different forms: one in a Windows namespace and one in a Web namespace. Therefore, many elements of 
this object model are duplicated in both namespaces, with some variations to support the differences in the 
Windows and Web platforms.
The classes of this object model are contained within the CrystalDecisions.Web namespace for the Web 
Form version of this control or the CrystalDecisions.Windows.Forms namespace for the Windows Form 
version of this control.

● A more extensive object model is ReportDocument.
The ReportDocument class is a gateway to a set of classes in the Engine namespace, including Database, 
DataDefinition, ExportOptions, PrintOptions, ReportDefinition, ReportOptions, and 
SummaryInfo. This is an extensive set of classes that provide more powerful customization and interaction 
capability with the report.
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The classes of this object model are contained within the CrystalDecisions.CrystalReports.Engine 
namespace.

● The following object models are available by upgrade:
○ An object model with greater report modification capability, named ReportClientDocument.

This class functions as gateway to a much larger object model that is made up of many classes across 
several namespaces. It exposes the entire report structure through the SDK, so that you can create or 
modify every aspect of the report programmatically at runtime.
The classes of this object model are contained within the CrystalDecisions.ReportAppServer group 
of namespaces.
The ReportClientDocument object model is provided with a Report Application Server (RAS), for which 
additional licensing is required. A Report Application Server is available with SAP Crystal Reports Server 
and SAP BusinessObjects Business Intelligence platform.

○ An extensive object model for interacting with the platform level functions of SAP Crystal Reports Server 
or SAP BusinessObjects Business Intelligence platform, named InfoObject. It is provided with the SAP 
Crystal Reports Server or SAP BusinessObjects Business Intelligence platform license.
This class functions as a gateway to the full platform object model of SAP Crystal Reports Server or SAP 
BusinessObjects Business Intelligence platform.
The classes of this object model are contained within the CrystalDecisions.Enterprise group of 
namespaces.

Note
The InfoObject object model is provided only with SAP Crystal Reports Server and SAP 
BusinessObjects Business Intelligence platform, for which additional licensing is required.

Related Information

Choose the Correct Object Model for Your Project [page 29]
Comparing SAP BusinessObjects Business Intelligence reporting solutions [page 60]

1.3.1.5.1 CrystalReportViewer Object Model

The CrystalReportViewer class has two roles:

● In the Web or Windows Form, the CrystalReportViewer is exposed as a .NET control that can be added to the 
form to display a report. For specific information about its role as a .NET control, see Report Viewer Controls 
[page 32].

● In the underlying code-behind the Web or Windows Form, the CrystalReportViewer class provides the 
simplest object model of the SDK. We explore that object model later in this section.

The simplest way to place a report into your Web or Windows Form is to add the CrystalReportViewer control to 
the form, and then, in the code-behind class, assign the path of the report as a string to the ReportSource 
property of the CrystalReportViewer class.
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By assigning the report path directly to the control (rather than place the report within a more complex object 
model, such as ReportDocument or ReportClientDocument) you restrict your interface to only the simplest object 
model: the CrystalReportViewer.

CrystalReportViewer Object Model Comparison 

CrystalReportViewer has two object model diagrams, because the same control and class name (and therefore its 
underlying object model) is reused for both Windows and Web applications. Therefore, the CrystalReportViewer 
object model is repeated (with minor variations) in two different namespaces.

The Windows version of the CrystalReportViewer contains the major classes and events that are shared by 
both the Windows and Web versions of the object model.

The Web version of the CrystalReportViewer object model contains the same classes and events as the Windows 
version, but in addition it has the following events that are related to how the ASPX page loads.

Related Information

Report Viewer Controls [page 32]
Report Binding with CrystalReportViewer Object Model [page 149]

1.3.1.5.2 ReportDocument Object Model

The ReportDocument class provides a more extensive object model for the SDK than the 
CrystalReportViewer object model.

ReportDocument class is part of the CrystalDecisions.CrystalReports.Engine namespace. It functions 
as a gateway to a set of classes in the Engine namespace, which provide more tools for programmatic 
manipulation of a report.

The ReportDocument Object Model

In the previous section, you learned how to work with the basic CrystalReportViewer object model by 
assigning a report path string directly to the CrystalReportViewer control.

At the next level of the object model, you use the ReportDocument object model to encapsulate the report within 
an instance of ReportDocument, before it is assigned to the control. That provides access to the more complex 
and powerful object model provided in ReportDocument.

Note
Because both object models are involved in this process (CrystalReportViewer to load and display the 
report, ReportDocument to encapsulate and manipulate the report), it is easy to confuse the roles of the two 
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object models. Once the ReportDocument object model has been used to encapsulate the report, all report 
manipulation must be restricted to that model. If you try to use the properties and methods of 
CrystalReportViewer to manipulate the report, the two object models conflict and generate unexpected 
behavior.

Once you have introduced an additional object model, restrict the use of CrystalReportViewer code to only 
set display properties.

ReportDocument and ReportClientDocument (RAS)

In SAP Crystal Reports 9, the two object models were completely separate. In SAP Crystal Reports 10 and up, the 
fundamental separation between object models has been removed. The ReportDocument object model now 
functions as a proxy to (a subset of) functionality from the ReportClientDocument object model.

SAP Crystal Reports 2008 allows you to access a limited version of the ReportClientDocument object model 
through the ReportDocument.ReportClientDocument property.

Related Information

ReportDocument Object Model Tutorials [page 289]
Report Binding with ReportDocument Object Model [page 174]
CrystalReportViewer Object Model [page 33]
Choose the Correct Object Model for Your Project [page 29]

1.3.1.5.3 ReportClientDocument Object Model (RAS)

The ReportClientDocument object model provides the most powerful and extensive object model for 
manipulating reports. This object model is only available as part of a Report Application Server (RAS), which is 
available either as an unmanaged Report Application Server (RAS), or as a managed Report Application Server 
(BOE).

The ReportClientDocument object model is made up of many classes across several namespaces. Each 
namespace is prefixed with CrystalDecisions.ReportAppServer. This object model exposes the entire 
report structure in the SDK, to enable you to programmatically create, modify, and save changes to every aspect 
of the report at runtime.

An instance of ReportClientDocument comprises a report that can be modified programmatically by its class 
properties. These properties are linked to a series of other libraries in the SDK that contain controllers, data 
definition models, and report definition models:

● ReportDefinition corresponds to the layout of the report, as shown in the SAP Crystal Reports Designer.
● DataDefinition corresponds to the field explorer in the SAP Crystal Reports Designer.
● RowsetController corresponds to the processed data values of each detail row, when viewing the report at 

run time.
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ReportClientDocument instances may be instantiations of either:

● An existing .rpt file that has been loaded from a directory, and then modified with the report definition and 
data definition classes of the ReportClientDocument SDK.

● A completely new, empty report that is constructed with the report definition and data definition classes of 
the ReportClientDocument SDK.

This ReportClientDocument class instance may be loaded only long enough to pass the instance to the viewer 
for display, before it passes out of scope. However, the class instance may also be modified, and then saved as a 
report (.rpt) to a directory with one of the controller classes.

For detailed information on the ReportClientDocument Object Model, consult the SAP BusinessObjects 
RAS .NET SDK documentation.

ReportClientDocument in SAP Crystal Reports 9

SAP Crystal Reports 9 (Advanced version) shipped with unmanaged RAS and the RAS .NET assemblies required 
to program to the ReportClientDocument object model. That allowed developers to create .NET projects that 
took advantage of the ReportClientDocument object model.

However, it also meant that projects that were previously created with the ReportDocument object model that 
was provided with SAP Crystal Reports had to be completely recoded for the ReportClientDocument object 
model that is provided with RAS. The reason for that was the two object models were completely separate.

ReportClientDocument in SAP Crystal Reports 10 and up

In SAP Crystal Reports 10, the fundamental separation between object models was removed. This has been done 
by rewriting the ReportDocument object model to function as a proxy to (a subset of) functionality from the 
ReportClientDocument object model. The classes of the ReportDocument object model expose the same 
property and method signatures as before, but the underlying functionality is changed to redirect each property 
and method to properties and methods of the more powerful ReportClientDocument object model.

This does not mean that a basic version of SAP Crystal Reports Developer gains full access to an unmanaged RAS 
server or to the ReportClientDocument object model. The basic version of SAP Crystal Reports continues to 
access only the ReportDocument object model (even though the ReportDocument object model functions as 
proxy to a subset of the ReportClientDocument object model). The original reporting engine contained in 
previous versions of SAP Crystal Reports has been replaced with a limited and embedded version of the RAS 
reporting engine.

You install and gain direct access to the ReportClientDocument model only with an upgraded license to the 
unmanaged RAS server. At that point all existing code that is written for the ReportDocument object model can 
be easily redirected to the separate RAS server, by setting two properties on any given report instance, and the 
underlying ReportClientDocument object model can now be accessed directly, when you retrieve it from the 
ReportClientDocument property of the ReportDocument class.
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1.3.1.5.4 InfoObject Object Model (BOE)

The InfoObject object model is provided with the upgrade products SAP Crystal Reports Server and SAP 
BusinessObjects Business Intelligence platform.

Note
For more information, see SAP BusinessObjects Business Intelligence reporting solutions [page 59].

The InfoObject object model provides an platform-level object model for the SDK. InfoObject functions as a 
base class, in which many Enterprise objects are encapsulated in derived classes. The derived class that 
represents reports is the CrystalDecisions.Enterprise.Desktop.Report class.

The SAP BusinessObjects Business Intelligence platform SDK is built around the InfoObject object class and its 
supporting classes.

The InfoObject class

The InfoObject class is used in the SDK to represent a wide variety of information entities. These include both 
physical entities, such as report files or PDF files, and network entities, such as users, servers, or FTP 
connections.

The InfoObject class is a base class to a variety of extended classes that correspond to those information 
entities in more detail. Extended classes that inherit from InfoObject include the following: Report, User, 
Server, Folder, Program, Ftp, Smtp, Word, Excel, and Pdf.

By manipulating these InfoObject and extended class instances, you can create a client or administrative desktop 
application.

Supporting classes

Two additional classes support the InfoObject class.

InfoStore class The InfoStore class acts as a controller, or gateway, to the Central Management Server 
(CMS) repository (which is a database), where all instances of InfoObject are stored. The 
InfoStore class is used to instantiate, retrieve, and commit all InfoObject class instances that 
are stored in the CMS repository.

InfoObjects 
indexed class

The InfoObjects indexed class holds multiple instances of InfoObject. It is used by the 
InfoStore to move InfoObject instances to and from the CMS repository.

InfoObject instances cannot be managed directly by the InfoStore class. Instead, they must first be wrapped 
within the InfoObjects indexed class. Through this indexed class the individual instances of InfoObject can be 
added, retrieved, updated, or scheduled.
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Note
For detailed information on the SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence 
platform SDK, consult the SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence platform 
SDK documentation.

Related Information

Choose the Correct Object Model for Your Project [page 29]

1.3.1.6 Comparing Architectures Across SAP Business 
Intelligence Reporting Solutions

Four SAP Business Intelligence reporting solutions are available:

● SAP Crystal Reports, developer version for Microsoft Visual Studio
● SAP Crystal Reports Developer
● Unmanaged Report Application Server (RAS)
● SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence platform

A primary architectural differentiator between each reporting solution is how each one places and implements the 
report engine.

What is the Report Engine?

The report engine is at the core of each reporting solution. It processes all user requests, and it outputs report 
information.

The maximum throughput for processing simultaneous user requests varies between solutions. It is set in some 
solutions by either architectural designs or by licensing limits.

The other core parts in each reporting solution are as follows:

● The report definition (.rpt) file.
● The data source.
● The report viewer.
● The SDK.
● A platform framework (found in SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence 

platform).
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How does the Report Engine interact with other core parts?

The report engine uses the report definition (.rpt) file as the template. Then it retrieves the data from the data 
source and uses the report definition to render the currently requested report, which it then passes to the report 
viewer. Information received from the viewer, or coded with the interface SDK, triggers further processing from 
the report engine that performs further actions on the report.

How is the Report Engine configured differently across different SAP Business 
Intelligence reporting solutions?

● Report engine is embedded.
In SAP Crystal Reports, developer version for Microsoft Visual Studio, the report engine is embedded in the 
application.
This embedded report engine is limited to a maximum of three simultaneous user requests. This is not an 
arbitrary licensing limit; it is a limitation of the embedded report engine architecture.

● Report engine is extracted into a separate report server process.
In the solution that uses the unmanaged Report Application Server (RAS), the report engine is extracted into 
a separate server process. That server process can run on the same machine or be placed on separate 
physical hardware, to increase performance by offloading processing from your application server. An 
unmanaged RAS server is no longer available as an upgrade option. It is recommended that you upgrade to 
SAP Crystal Reports Server instead. For more information, see SAP BusinessObjects Business Intelligence 
reporting solutions [page 59].

● The separate report server process is encapsulated into a complete platform architecture.
In the SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence platform solution, an entire 
platform architecture is added, which encapsulates the separate report server process (RAS). The managed 
Report Application Server (RAS) becomes only one server, among many other servers in the platform 
architecture. This architecture provides a rich set of additional features, such as scheduling, load balancing, 
fail-over, and both vertical and horizontal scalability.

1.3.2  The CrystalReportViewer Control

In order to view a Crystal report, you must add a CrystalReportViewer control to your application. The 
CrystalReportViewer control is used in the .NET Framework to bind to and display reports. The default 
CrystalReportViewer control includes UI elements to assist in viewing, saving and navigating through a report.

The two CrystalReportViewer controls that are most frequently used are the CrystalReportViewer control for 
Windows applications, accessed through the CrystalDecisions.Windows.Forms.CrystalReportViewer 
class, and the CrystalReportViewer control for Web site, accessed through the 
CrystalDecisions.Web.CrystalReportViewer class. For more information, see the SAP Crystal 
Reports .NET API Reference.

Note
A CrystalReportViewer control is only necessary if you intend to display Crystal reports.
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Customizing the CrystalReportViewer control

Depending upon your application, you may wish to modify some elements of the default control. SAP Crystal 
Reports allows you to customize the look and feel of the viewer in your application in a number of different ways, 
including:

● The CrystalReportViewer toolbar can be removed from the viewer.
● The buttons on the CrystalReportViewer toolbar can be added or removed programmatically.
● The CrystalReportViewer control supports customization through CSS or Themes.

Related Information

Customizing the CrystalReportViewer control [page 196]
Viewing a Report [page 142]

1.3.2.1 How Do I Use Report Viewer Controls?

Report viewer controls are .NET controls that can be added to a form in a Windows or Web application, to display 
reports on that form.

When you plan to build an application with the SAP Crystal Reports SDK, one of your most important 
considerations is how to use the report viewer controls. Learning the SDK fundamentals that affect these controls 
helps you to choose the best structure for your SAP Crystal Reports, developer version for Microsoft Visual Studio 
project.

What are .NET controls?

Microsoft .NET controls are special type of classes that are displayed in the Toolbox of Visual Studio. They are 
added to a Web or Windows Form as GUI objects, and they inherit from a common base control class. 
Typical .NET controls include: Button, DropDownList, CheckBox, TextBox, or DataGrid.

Microsoft .NET controls conform to the following best practice: separate the presentation layer from the business 
logic layer. They encapsulate display information within the control itself on the Web or Windows Form. In the 
code-behind class, the .NET control is instantiated as a class level instance. This instance variable gives access to 
the control's properties, methods, and events.

Microsoft .NET controls are functionally identical for both Windows and Web Forms. The .NET Framework views 
each Web page as a form that contains controls, like in a Windows application.
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Why does SAP Crystal Reports use .NET controls for report viewing?

One of the strengths of reporting tools is that they encapsulate the complex issues of report structure, design, 
and rendering within a simple GUI tool. Similarly, .NET controls encapsulate complex display and data population 
issues within a simple GUI object on a Web or Windows Form.

With the use of .NET controls, complex reporting and display are brought together. All of the complex report 
information, which used to be encapsulated only in the SAP Crystal Reports stand-alone application, has now 
been encapsulated within a .NET control as a report viewer.

How many report viewer controls are there?

SAP Crystal Reports, developer version for Microsoft Visual Studiocomes with two versions of the 
CrystalReportViewer control: one for Web applications, and one for Windows applications. The 
CrystalReportViewer control, located within the CrystalDecisions.Web namespace, is used by ASP.NET Web 
projects. The CrystalReportViewer control, located within the CrystalDecisions.Windows.Forms namespace, is 
used by Windows projects.

The CrystalReportPartsViewer control is used to display only parts of reports in a Web page.

Displaying a report using the CrystalReportViewer control

The CrystalReportViewer control displays only one report at a time. Which report is displayed by the control is 
determined by which report you bind to your code. To tell the control which report to display, you bind the 
ReportSource property of the control to a particular report. At runtime, the control loads the report that is bound 
to the ReportSource property and displays it.

In its simplest form, the assignment looks like this:

 crystalReportViewer1.ReportSource = "C:\WorldSalesReport.rpt" 
 crystalReportViewer1.ReportSource = "C:\\WorldSalesReport.rpt"; 

In this case, the report is bound to the control directly from its path in the file directory.

This demonstrates the most basic way to bind a report to the CrystalReportViewer control.

Does the CrystalReportViewer control bind to data objects?

No. The CrystalReportViewer control binds to a report object, not a data object.

That is because the purpose of the CrystalReportViewer control is different than other .NET controls. Other .NET 
controls bind to data and format the raw data onto the page. Because the embedded SAP Crystal Reports 
Designer does this automatically every time it creates a report (a report by definition encapsulates data retrieval 
and display), the CrystalReportViewer control is only concerned with the display of a report object.
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The following table compares binding to a .NET data control versus binding to a CrystalReportViewer control.

Table 2:

Control type Binds to Next layer connectivity

.NET data control (such as DataGrid 
control)

A data object (DataSet, DataReader, Da
taView, IDictionary, ICollection, DataTa
ble).

None

.NET report viewer control (such as 
CrystalReportViewer control)

A report object (which encapsulates a 
Crystal report file).

The Crystal report file has built-in data 
connectivity, which connects to various 
data sources such as ODBC and OleDb, 
as well as DataReader and DataSet ob
jects.

To help you remember that a CrystalReportViewer control binds to a report object, rather than a data object, the 
source property of the report viewer control is named ReportSource (not DataSource).

Auto report binding

One other difference in binding a CrystalReportViewer control is that you do not need to manually call a bind 
method, like you would for most other .NET controls. Instead, the control automatically binds the report viewer to 
the report object.

Related Information

Viewing a Report [page 142]

1.3.2.1.1 To add a CrystalReportViewer control to a Windows 
application

1. Open a Windows form in Design view.
2. From the Toolbox, open the Reporting node to locate the CrystalReportViewer control.

Note
In previous versions Visual Studio, the CrystalReportViewer control appeared in the Crystal 
Reports node.

3. Drag and drop the CrystalReportViewer control onto the form.
4. From the File menu, click Save All.

When you add a CrystalReportViewer control to your application, references to the SAP Crystal Reports 
assemblies will automatically be added to your project.
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1.3.2.1.2 To add a CrystalReportViewer control to a Web Site

1. Open the Default.aspx page.
2. Click the Design button at the bottom of the form view.
3. From the Toolbox, open the Reporting node to locate the CrystalReportViewer control.

Note
In previous versions of SAP Crystal Reports, developer version for Microsoft Visual Studio, the 
CrystalReportViewer control appeared in the Crystal Reports node.

4. Drag and drop the CrystalReportViewer control onto the Web Form.
5. From the File menu, click Save All.

When you add a CrystalReportViewer control to your application, references to the SAP Crystal Reports 
assemblies will automatically be added to your project.

1.3.2.1.3 To bind the CrystalReportViewer control to a file on 
disk

The simplest way to bind a CrystalReportViewer control to a Crystal report is to set the ReportSource property 
to a location on disk. This non-embedded report is displayed when the application runs.

This binds the report directly to the control. All programmatic interaction with the report must be done within the 
limited CrystalReportViewer object model.

1. Add a CrystalReportViewer control to the Windows Application or Web Site.
2. Open the Web or Windows Form.
3. From the View menu, click Code.
4. Set the ReportSource property to the location of the report on your local file system.

○ When working with a Windows Forms Applications or Web Site:

 myCrystalReportViewer.ReportSource = "C:\MyReport.rpt" 
 crystalReportViewer.ReportSource = "C:\\MyReport.rpt"; 

○ When working with an WPF application:

 myCrystalReportViewer.ViewerCore.ReportSource = "C:\MyReport.rpt" 
 crystalReportViewer.ViewerCore.ReportSource = "C:\\MyReport.rpt"; 

1.3.2.2 The Smart Tasks Panel

In Visual Studio 2005 or later, when you add a .NET control to a Web or Windows Form, a Smart Task panel 
appears. Smart Task is a small panel that is attached to the upper right-hand corner of the .NET control. When the 
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panel is opened, it contains checkboxes and combo boxes that allow developers to select connectivity and other 
options for the control. This feature can significantly reduce the amount of code that the developer needs to write.

In a Web Site, selections that are made in the Smart Task panel produce auto-generated XML in the ASPX page.

In a Windows project, selections made in the Smart Task panel produce auto-generated code in a hidden class file. 
The hidden class file is a "partial" class, which acts as an addendum to the existing Windows Form class. Partial 
classes are a new feature of the .NET Framework version 2.0.

You can use the Smart Task panel to quickly and easily bind the CrystalReportViewer control to the 
CrystalReportSource control. When the CrystalReportViewer control is added to the page, the Smart Task 
appears automatically and provides you with a series of steps to create and configure a CrystalReportSource 
control.

The CrystalReportViewer control makes full use of the Smart Task panel. The selections available in the panel are 
different between Web and Windows projects.

Limitations of Smart Tasks and the Reduced Code Model

Smart Tasks facilitate a reduced-code model that auto-generates code to save time over manually writing code.

However, while auto-generated code saves time at first, it's difficult to switch from a reduced-code model to a 
coding model, should you later want to add power and flexibility to a project.

1.3.2.2.1 CrystalReportViewer Smart Task for Windows 
Projects

The CrystalReportViewer Smart Task panel for Windows allows you to create, choose, or edit a Crystal report. 
You also have the options to customize the CrystalReportViewer control.

The following functionalities are available for the Windows project's Smart Task panel.

Create a New Crystal Report...

This menu command allows you to create a report through the embedded SAP Crystal Report Designer.

Upon completion, the report code is auto-generated to bind the report to the CrystalReportViewer control for 
immediate display.

Edit the Current Crystal Report

This menu command allows you to further edit the report that has already been selected or created for the report 
source.
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Choose a Crystal Report

This menu command allows you to select a Crystal report, or ReportDocument object to act as the report source 
for the CrystalReportViewer control.

Upon completion, the report code is auto-generated to bind the report to the CrystalReportViewer control for 
immediate display.

Clear Report Source

This menu command will clear the ReportSource property for the CrystalReportViewer control.

Choose a Tool Panel View:

This menu command lets you select which tool panel will be displayed by default when the report loads. You can 
select the Group Tree or the Parameter Panel, or choose to leave the tool panel blank.

Display Toolbar

This checkbox allows you to show or hide the CrystalReportViewer control toolbar.

Display Status Bar

This checkbox allows you to show or hide the status bar within the CrystalReportViewer control.

Undock in parent container

This menu command allows you to set the Dock property to "None" or "Fill." By default, when a 
CrystalReportViewer control is dropped onto a Windows Form, the Dock property is set to "Fill." If this menu 
command is selected, the "None" Dock property leaves the CrystalReportViewer control free to be moved and 
resized within the Windows Form or other containers, (for example, a Panel control within a Windows Form.)
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1.3.2.2.2 CrystalReportViewer Smart Task for Web Sites

The CrystalReportViewer Smart Task panel for Web Sites allows you to create, choose, or edit a Crystal report. 
You also have the options to customize the CrystalReportViewer control, and to enable error reporting for 
database logons and parameter values.

The following functionalities are available for the Web Sites' Smart Task panel:

Choose Report Source

This combo box allows you to select any existing report source or to create a new report source.

Upon completion, the report code is auto-generated to bind the report to the CrystalReportViewer control for 
immediate display.

Configure Report Source...

This menu command allows you to further configure the report source that has already been selected or created.

Edit Report...

This menu command allows you to further edit the report that has already been selected or created for the report 
source.

Choose a Tool Panel View:

This menu command lets you select which tool panel will be displayed by default when the report loads. You can 
select the Group Tree or the Parameter Panel, or choose to leave the tool panel blank.

Enable Toolbar

This checkbox allows you to show or hide the CrystalReportViewer control toolbar.

Enable Report View

This checkbox allows you to show or hide the report view within the CrystalReportViewer control.
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Note
You may disable report view if you wish to use the group tree by itself in a Web Form.

Enable Database Logon Prompting

This checkbox allows you to enable or disable error reporting for database logons. When a report lacks 
information to log on to a SQL Server database, a "Logon failed" error exception is thrown. However, if the 
checkbox is selected, a prompt window appears and asks for the necessary logon information.

Enable Report Parameter Prompting

This checkbox allows you to enable or disable error reporting for parameter values. When a report lacks 
parameter information to address a parameter that is used in the selection criteria, a "Missing Parameter Values" 
error exception is thrown. However, if the checkbox is selected, a prompt window appears and asks for the 
necessary parameter information.

Reuse Parameter Value On Refreshing Report

This checkbox allows you to enable or disable parameter persistence on report refresh. If the checkbox is 
selected, parameter values that are passed into a report on first load are persisted. However, if the checkbox is 
cleared, code must be written to pass parameter values to the report on each subsequent refresh.

Related Information

CrystalReportViewer Smart Task for Windows Projects [page 44]

1.3.2.3 The CrystalReportPartsViewer Control

The CrystalReportPartsViewer control is used in the .NET Framework to bind to and display a Crystal report 
as a series of linked parts. This greatly reduces the area required to display report information as is ideal for 
displaying small amounts of report information on a portal Web page.

Note
Report parts are used only in Web Sites; they are not available for Windows projects.
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The CrystalReportPartsViewer control has been enhanced to support the Web Parts framework, a portal 
framework introduced with ASP.NET version 2.0.

The Web Parts framework enables developers to encapsulate controls on the page within configurable Web Parts.

Related Information

Tutorial: Displaying Report Parts with the CrystalReportPartsViewer Control [page 414]

1.3.2.4 The CrystalReportSource Control

The CrystalReportSource control is part of the new tag-based application development model that is provided 
with ASP.NET version 2.0.

Note
The CrystalReportSource control is only available for Web Sites.

In the DataSource control framework, .NET visual controls connect to non-visual DataSource controls (controls 
that do not manage display information). This new DataSource framework encapsulates the data connectivity 
information that is written as lines of code in .NET controls on the Web Form.

In the Design window, Visual Studio shows you the names of the controls that are connected to one another.

The .NET data providers come with their own implementation of the DataSource control. For example, 
SqlDataSource accesses Microsoft SQL Server, whereas OracleDataSource accesses Oracle.

In the case of SAP Crystal Reports, the control is implemented as a CrystalReportSource control. This design 
parallels the design from ASP.NET version 1.0, where the CrystalReportViewer control contains a ReportSource 
property instead of the more typical DataSource property.

The difference between the CrystalReportSource control and the DataSource controls is that the 
CrystalReportSource control contains a report that encapsulates the data, whereas a DataSource control (such 
as SqlDataSource) contains the data itself.

1.3.3  Which Persistence Approach Should I Use with SAP 
Crystal Reports?

When planning a Web application to build with the SAP Crystal Reports SDK, one of your most important 
considerations is which persistence approach to use.
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What is persistence?

Web pages do not preserve state (the status and information of a user connecting to a website). Each Web page is 
requested from a server, sent to the user, and the process is then terminated. This is fine when reading text 
information, but problematic when designing a Web application that needs to preserve information about a user 
across page reloads and redirects.

Persistence refers to the use of a mechanism to preserve state for each user (such as the current report page 
being viewed by each user) unhindered by page reloads and redirects.

Best practices for persistence

In this section, you explore best practices for persisting changes made to a Crystal report on a Web page while 
that report is refreshed during a Web page reload. The change that needs to be persisted may be as simple as 
going to the second page after the report viewer's Next Page button has been clicked, or as complex as displaying 
entirely different data after a report's parameters have been changed.

Persistence must be applied to the following things:

● The CrystalReportViewer control.
● The report that is bound to the CrystalReportViewer control.

Ways of persisting state in ASP and ASP.NET

In traditional ASP and ASP.NET, the state is maintained by either the Web browser or the Web server, in the 
following ways.

Table 3:

Environment Client or server? Name Method

ASP* Client browser Form fields Pass name/value pairs across 
Web pages through form sub
mission fields.

ASP* Client browser URL arguments Pass name/value pairs across 
Web pages using URL argu
ments.

ASP* Client browser Cookie Assign name/value pairs to a 
cookie on the client browser, 
and then retrieve the cookie in 
a new page.

ASP* Web server Session object Assign instantiated objects to 
the Session object on the 
server, and then retrieve from 
Session in a new page.
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Environment Client or server? Name Method

ASP* Web server Application object Assign instantiated objects to 
the Application object on the 
server, and then retrieve from 
Application in a new page.

ASP.NET Client browser ViewState object Assign string values to the 
ViewState object of the 
ASP.NET Web Form.

ASP.NET Web server Cache object Same as Application object, 
but with enhanced features.

* All ASP persistence approaches continue to work in ASP.NET.

Which persistence approaches work best with SAP Crystal Reports?

The most appropriate persistence approaches to use with SAP Crystal Reports are ViewState, Session, or Cache.

Related Information

ViewState and Persistence of the CrystalReportViewer Object Model [page 50]

1.3.3.1 ViewState and Persistence of the 
CrystalReportViewer Object Model

What is ViewState?

ViewState is a browser-based approach in ASP.NET for persisting the state of the view, that is, the Web Form. Its 
primary function is to support the persistence of Web controls.

Web controls (also called Web server controls) are modeled on Windows controls, which were introduced in Visual 
Basic. Windows controls are objects on the form that encapsulate a piece of display functionality, such as a text 
field, a button, or a table of data.

Web controls are similar to Windows controls. Like Windows controls, they operate on two levels: within the Web 
page, and in the code-behind class that supports the Web page. Similar to traditional controls in Windows Forms, 
Web controls encapsulate discrete pieces of display functionality into GUI objects: Button, TextField, 
DropDownList, DataGrid, and so on. In the code-behind class, these same controls are paralleled as classes that 
expose properties and methods.

A Web page is different from a Windows form in that a Web page is a stateless environment. Therefore some kind 
of persistence mechanism is required to preserve the state of the Web page across page reloads.
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ViewState maintains the state of controls on the Web page, much as Session maintains the state of instantiated 
objects on the server.

Note
ViewState maintains the state of all Web controls automatically. This is achieved by having ViewState store 
each control based on the control's EnableViewState property (which defaults to True).

Because ViewState stores the state of the data from the Web controls on the page, the entire ViewState object 
must be enclosed within the page as the page is transferred back and forth between the browser and the Web 
server. This is done by encrypting the entire ViewState object as a string, and then placing this string within the 
value of a hidden form tag on the page. For example, the ViewState of an ASP.NET Web page that contains only a 
single button control has the following HTML code:

 <input type="hidden" name="__VIEWSTATE"
value="dDwtNTMwNzcxMzI0Ozs+I7GfLyg3p44eTLFCiVEiRKUBzFw=" /> 

ViewState stores only information that can be converted to string format.

Persisting the report display of the CrystalReportViewer control

The CrystalReportViewer control performs the role of report display for a Crystal report. It renders the report into 
html on the page along with a toolbar and tree view for manipulating the report display. The toolbar contains 
buttons to zoom, go to next page, print, export, and so on. The tree view expands to show nested grouping of data.

ViewState persists control information; therefore it persists the state of all report display information (including 
toolbar and tree view events) for the CrystalReportViewer control across page reloads.

For example, if a user were viewing page 3 of the report and clicked the next page button in the toolbar of the 
CrystalReportViewer control, ViewState would persist the state of both pieces of information:

● The current page number.
● The state of the Next Page button (clicked).

During page reload, the ViewState would restore the CrystalReportViewer control to page 3, and then restore the 
next page event click, causing the control to move the report ahead to page 4.

Persisting the object model of the CrystalReportViewer control

The CrystalReportViewer control performs an additional role: not only report display, but also a limited object 
model (contained in the CrystalReportViewer control class). This limited object model can be used for 
programmatic interaction with the report.

ViewState persists the state of both roles:

● The report display.
● The CrystalReportViewer object model.
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However, use of the CrystalReportViewer object model is generally discouraged, in favor of the more extensive 
ReportDocument object model. This alternate object model is not contained within the control but is part of the 
class libraries in the SDK.

Sharing persistence mechanisms

If you use the CrystalReportViewer control to perform both roles (report display and object model), ViewState 
persists both of them, and you do not need any additional persistence mechanisms.

Note
An example of this would be binding the CrystalReportViewer control to a file directory path. See Binding to a 
File Directory Path in Code [page 149].

However, if you choose to use the CrystalReportViewer control only for the role of report display, and then bind 
the control to an external object model (such as ReportDocument), a separate persistence mechanism is required 
to persist that external object model. Typically that second persistence mechanism is Session (or occasionally, 
Cache).

Related Information

Which Persistence Approach Should I Use with SAP Crystal Reports? [page 48]
Session and Persistence of the ReportDocument Object Model [page 52]
Choose the Correct Object Model for Your Project [page 29]

1.3.3.2 Session and Persistence of the ReportDocument 
Object Model

What is Session?

Session is a Web server-based approach used in both ASP and ASP.NET for preserving state. Session allows you 
to persist any object for the entire length of a user's session by storing that object in the Web server's memory.

Session is typically used to do either of these things:

● Store information that needs to persist its state during the entire length of a user session, such as logon or 
other information required as users navigate the Web application.

● Store an object that needs to persist its state only across a page reload or a functionally grouped set of pages.

The strength of Session is that it preserves the user's state information on the Web server for access at any time 
from any page. Since the browser doesn't have to store any of this information, any browser can be used, even 
browser devices such as PDAs or cell phones.

52 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



Limitations of this persistence approach

● The amount of server memory required by Session grows as more users log on.
● Each user who accesses the Web application generates a separate Session object. Each Session object lasts 

for the length of the user's visit plus an inactivity period.
● If many objects are persisted into each Session, and many users are using the Web application 

simultaneously (creating many Sessions), the amount of server memory devoted to Session persistence can 
become significant, limiting scalability.

For alternate persistence approaches see the following:

● ViewState and Persistence of the CrystalReportViewer Object Model [page 50]
● Cache and Persistence of the ReportDocument Object Model [page 54]

Persisting the ReportDocument object model with Session

If the report has been encapsulated within the ReportDocument object model, the ReportDocument object model 
must be persisted using a server-based approach such as Session or Cache.

To persist a report within the ReportDocument object model using Session, instantiate the ReportDocument and 
then assign it to Session.

Session is the simplest approach and is preferred when you are learning to build an ASP.NET Web application 
using SAP Crystal Reports. It is also the recommended approach for storing ReportDocument instances where 
the report has low shareability.

Limitations of persisting the ReportDocument object model with Session

Whenever a ReportDocument instance has a high degree of shareability, consider using Cache instead of Session.

Contrasting Session and ViewState

Session is primarily concerned with persisting the state of objects in the code-behind class. ViewState is primarily 
concerned with persisting the state of controls on the Web page. When a control on the Web page is bound to an 
object in the code-behind class and both need to be persisted across page reloads, Session and ViewState share 
the roles of persistence.

In this case ViewState persists a CrystalReportViewer control, and Session persists a ReportDocument object 
that is bound to the control.
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Related Information

Tutorial: Persisting the ReportDocument Object Model Using Session [page 289]

1.3.3.3 Cache and Persistence of the ReportDocument 
Object Model

Cache is a server-based approach in ASP.NET for preserving state. Cache is functionally similar to the Application 
object found in both ASP and ASP.NET:

● Application allows you to persist any object across application scope.
● Application is not designed to preserve user-specific information.

Cache shares all of these features with Application, but it adds new levels of intelligence for managing transient 
data:

● An object added to the cache can be configured with file-based, key-based, or time-based dependencies. If 
the associated file or key changes, or if a certain period of time passes, the object is automatically removed 
from the cache, and an updated version is placed in the cache the next time the object is required.

● An object added to the cache that has no dependencies and is unused is automatically expired.
● When an object is removed from cache, an event is triggered. You can write code to run on that event and load 

an updated version of the object to the Cache.

If an alternative version of an object is added using the original key string, it overwrites the previous version. To 
prevent overwriting, concatenate the alternative definition to the key string to make each alternative version of 
the object unique.

The strength of Cache over Application is that, like Application, it stores information that is accessible to all users, 
but Cache can also update itself based on changes in its dependencies.

Behaviour of Cache in the .Net 2.0 Framework

Cache in the .Net 2.0 Framework is more efficient and secure because it is handled per user and per session.

That is, when a user views a report, a copy of the report is saved to the cache and displayed to that user. If the 
user opens the report again while the current session is active, the application will display the cached report. This 
prevents having to run the report each time it is viewed by the same user. If another user logs on and opens the 
same report, the application runs the report a second time, saves a second copy of the report to the cache, and 
displays it to that user. All users have their own cached copies of the report for their session. This prevents 
multiple users from sharing the same report.

Limitations of this persistence approach

Developers who are new to Cache may be tempted to use it everywhere for persistence, replacing Session with 
Cache. However, Cache is not designed to replace the functionality of the Session object. Attempting to emulate 
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Session uniqueness by concatenating user-specific data to the Cache key loads up the Cache with user objects 
that, unlike with Session, does not expire after a user's timeout period. As a result, Cache ends up placing a higher 
demand on Web server memory than the Session object did.

If you need to persist user-specific data, continue to use the Session object.

For alternate persistence approaches see:

● ViewState and Persistence of the CrystalReportViewer Object Model [page 50]
● Session and Persistence of the ReportDocument Object Model [page 52]

Persisting the ReportDocument object model with Cache

If the report has been encapsulated within the ReportDocument object model, the ReportDocument object model 
must be persisted using a server-based approach such as Session or Cache.

You can persist a report within the ReportDocument object model using Cache in one of two ways:

● Instantiate the report and then assign it to the Cache object, using the same syntax as for assigning a report 
to the Session object.
This method only works for a report that has high shareability, where the ReportDocument instance occurs 
exactly once, using a single set of parameters and logon credentials. For a ReportDocument instance that 
may occur multiple times due to variation in its parameters and logon information, reassigning to the Cache 
object using the same key string overwrites the previous version of the ReportDocument instance.

● Instantiate a version of the report class that implements the ICachedReport interface.
The SAP Crystal Reports SDK includes a built-in caching framework for reports. Any report that implements 
the ICachedReport interface is automatically added to the cache with a unique key based on parameters and 
user logon credentials. This method works for any report that has high shareability, but may have a few 
versions due to minor variations in parameters and logon credentials. For reports with low shareability (that 
are user-specific), assign them to the Session object instead.

Limitations of persisting the ReportDocument object model with Cache

Cache is the best approach to use when persisting ReportDocument instances that have a high degree of 
shareability across users. If the report is user-specific, then Cache will waste server memory creating user-based 
instances at an application level that will last in server memory past user expiry. User-specific reports should be 
assigned to Session instead.

Note
In most cases, use Session to persist ReportDocument instances. Use Cache (or more specifically, the 
ICachedReport interface) only when a report has high shareability and when the report is very large, or so 
complex that it takes several minutes to retrieve its data.
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Contrasting Cache and Viewstate

Cache is primarily concerned with persisting the state of objects in the code-behind class. ViewState is primarily 
concerned with persisting the state of controls on the Web page. When a control on the Web page is bound to an 
object in the code-behind class and both need to be persisted across page reloads, Cache and ViewState share 
the roles of persistence.

In this case ViewState persists a CrystalReportViewer control, and Cache persists a ReportDocument object that 
is bound to the control.

Related Information

Which Persistence Approach Should I Use with SAP Crystal Reports? [page 48]
Persistence Limitations When Report Binding in the Page_Load Event Handler [page 57]

1.3.3.3.1 To persist an embedded report that implements 
ICachedReport

1. Add the report to the project.

This creates an embedded report class. It also creates a cached report class that loads and returns a cached 
instance of the embedded report class.

2. Instantiate the cached report class.
3. Assign the cached class instance to the CrystalReportViewer control.

Related Information

Binding to a Cached Embedded Report Class [page 178]

1.3.3.3.2 To persist a non-embedded report through a utility 
class that implements ICachedReport

1. Create your own cache management utility class and set it to implement ICachedReport.
2. In this utility class, load the non-embedded report from a path string using the ReportDocument.Load() 

method.
3. Code the implementation method CreateReport() to return the ReportDocument instance of the non-

embedded report.
4. Instantiate the report cache management utility class.
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5. Assign that class instance to the CrystalReportViewer control.

Related Information

Binding to a Non-embedded Report Loaded into a Cache Management Utility Class [page 180]

1.3.3.4 Persistence Limitations When Report Binding in the 
Page_Load Event Handler

In ASP.NET Web applications it is common practice to place all startup code for the page in the Page_Load event 
handler, which is called by the Page.Load event.

In particular, control data binding code is usually stored within the Page_Load event handler. However, placing the 
binding code in this event handler causes a problem with ViewState. The problem and typical resolution is as 
follows:

● ViewState is used to persist two things across page reloads: the data that is bound to the control, and mouse 
clicks events performed on the control.

● ViewState is a string. Therefore both the data and click events must be serialized.
● During page reload, both the data and click events are restored from ViewState.
● The Page.Load event occurs after ViewState has been restored. If the Page_Load event handler contains 

control binding code, at time of page reload this binding code will overwrite ViewState, losing both the original 
data and the click events.

● This problem is typically experienced as controls that forget mouse click actions (e.g. a DropDownList 
selection) when the page reloads.

● To prevent data and mouse click events from being overwritten, any binding code in the Page_Load event 
handler is placed within a Not IsPostBack conditional block, which prevents the binding code from being 
called during postbacks.

This resolution makes one crucial assumption: that both the data and mouse click events can be serialized to 
ViewState. However, the CrystalReportViewer control binds to objects that are non-serializable (specifically, the 
ReportDocument class, the ReportClientDocument class or the InfoObject class.)

Note
There is one exception: when the CrystalReportViewer control is bound to a report by its file directory path, the 
path string can be persisted to ViewState. In this scenario only, the CrystalReportViewer control could be 
placed in a Not IsPostBack conditional block. However, this report binding scenario is less powerful and less 
commonly used than binding to the report classes listed above.

Since only the CrystalReportViewer control's mouse click events can be serialized to ViewState, binding to a non-
serializable report class creates an irresolvable problem during page reloads:

● If the report binding code is placed within a Not IsPostBack conditional block, then the mouse click events 
from ViewState will be preserved. However, report binding does not occur. Therefore, an exception is thrown.

● If the report binding code is placed outside the conditional block, the report is bound correctly. However, 
ViewState is overwritten in the process. Therefore, the mouse click events are lost.
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Note
This approach is typically observed when clicking through a multiple-page report in the 
CrystalReportViewer control. The report mysteriously keeps returning to page 1.

Recommended solution: move the CrystalReportViewer control's binding code 
to the Init event

The solution for the CrystalReportViewer control is to move your report binding code to the Init event, which 
occurs before ViewState is restored.

This solution raises one complication. Since the Init event is coded against less commonly than the Load event, it 
is harder to access. In Visual Studio .NET 2003 Web or Windows projects, the Init event handling code is located 
within the Web Form Designer Generated code region, an area that is typically hidden and reserved for generated 
code.

To resolve this, the following approach is recommended:

● Extract all CrystalReportViewer binding and configuration code into a private helper method named 
ConfigureCrystalReports().

● Within the Web Form Designer Generated code region, place only a single line of code in the Page_Init() 
event handler or OnInit() event raising method: a call to the ConfigureCrystalReports() helper 
method.

Instructions for creating and populating the ConfigureCrystalReports() helper method are given in Project 
Setup [page 15].

Related Information

Tutorial: Persisting the ReportDocument Object Model Using Session [page 289]

1.3.4  Scaling your Application

When you plan how to build an application with the SAP Crystal Reports SDK, one of your most important 
considerations is how to optimize scalability. You can scale your application in two ways:

● Optimize the performance of your application.
● Optimize the performance of your report.

Implementation of these best practices is described in the following sections.
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Scaling your application code

When using the SAP Crystal Reports .Net SDK, following the following best practices for improving performance 
can increase scalability:

● Reduce the use of DataSets.
● Take advantage of report caching.
● Release the report from memory after use.
● Share processing across servers.

Scaling your application by reducing report complexity

When designing your reports, and especially when designing reports for the Web, you should design with 
scalability in mind. Consider the following best practices for optimizing the scalability of a report.

● Reduce the size and complexity of reports where possible.
● Off-load record selection to the Database Server.
● Use on-demand subreports.

1.3.4.1 Upgrade Options

1.3.4.1.1 SAP BusinessObjects Business Intelligence 
reporting solutions

There are several reporting solutions in the SAP BusinessObjects Business Intelligence product line. The range of 
products and the various deployment licenses within those products, are designed to address the full range of 
scalability needs for a reporting solution.

This page provides a brief summary of each of the reporting solutions. More information is available on the SAP 
BusinessObjects website.

SAP Crystal Reports, developer version for Microsoft Visual Studio

SAP Crystal Reports, developer version for Microsoft Visual Studio provides developers with a fast and productive 
way to create and integrate presentation-quality reports into applications, without leaving the familiar Visual 
Studio development environment.

SAP Crystal Reports, developer version for Microsoft Visual Studio includes many of the features of SAP Crystal 
Reports. These include the ability to create reports, connect them to a CrystalReportViewer control, and 
programmatically interact with these reports using the SAP Crystal Reports SDK.
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SAP Crystal Server or SAP BusinessObjects Business Intelligence platform

A RAS server is included with SAP Crystal Reports Server and SAP BusinessObjects Business Intelligence 
platform, which provides a significant increase in performance and scalability for creating, manipulating, and 
managing reports.

SAP Crystal Reports Server gives you everything you need to create, manage, and securely deploy reports over 
the web in one low-cost package. It addresses all steps in the reporting process - including data access and report 
design, report management and delivery, and report integration with portals and applications, which makes it 
easy for existing or new Crystal reports to be shared over the web.

SAP BusinessObjects Business Intelligence platform is a multi-server business intelligence (BI) platform designed 
to address large-scale reporting and BI requirements. Its multi-server environment provides you with the fault-
tolerance, load balancing, scalability, and the reliability you need for success with larger, more mission-critical 
work. SAP BusinessObjects Business Intelligence platform is also recommended for its advanced reporting 
capabilities such as auditing, SAP Crystal Reports Explorer, and the Encyclopedia and Process Tracker.

To create, manage and securely deploy reports for your small or medium sized business, use SAP Crystal Reports 
Server. For mission critical applications, maximum scalability and additional business intelligence tools use SAP 
BusinessObjects Business Intelligence platform.

1.3.4.1.2 Comparing SAP BusinessObjects Business 
Intelligence reporting solutions

This table provides information to help you evaluate which SAP BusinessObjects Business Intelligence reporting 
solution is appropriate for the level of scalability you are targeting.

Table 4:

Feature SAP Crystal Reports, devel
oper version for Microsoft 
Visual Studio

SAP Crystal Reports SAP Crystal Reports Server 
or SAP BusinessObjects 
Business Intelligence plat
form

ASP.NET Support X X X

Interactive Report Viewing X X X

Single Sign-On X X X

Windows Application Support X X X

Enhanced Report Designer X X

Mobile Device Support X X

Native Database Drivers X X

OLAP Data Sources X X

Report Dependency Checker X X

Templates X X

Dynamic Cascading Parame
ters

X X
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Feature SAP Crystal Reports, devel
oper version for Microsoft 
Visual Studio

SAP Crystal Reports SAP Crystal Reports Server 
or SAP BusinessObjects 
Business Intelligence plat
form

Cross-platform Deployment X

Information Delivery Manage
ment System

X

Integrated Security X

Load Balancing X

Report Object Repository X

Report Scheduling X

Programmatic Report Crea
tion and Modification

X X

CrystalReportViewer Object 
Model

X X X

ReportDocument Object 
Model

X X X

ReportClientDocument Ob
ject Model

X X

RAS Server X

InfoObject Object Model X

Scalability Low Low Medium to High

Support for multiple versions 
of the .Net Framework

X X

Related Information

Comparing Architectures Across SAP Business Intelligence Reporting Solutions [page 38]

1.3.4.1.3 Report Application Server (RAS)

You can use the RAS server to create and modify Crystal reports, and to process page requests.

One of the SAP BusinessObjects technologies is the Report Application Server (RAS). RAS is both a client SDK 
and a server. You can use the RAS server to create and modify Crystal reports, and to process page requests. 
When a server process retrieves a requested report, RAS passes it to the report viewer.

The RAS server is only available as a part of SAP Crystal Reports Server or SAP BusinessObjects Business 
Intelligence platform.
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Managed RAS server

A RAS server that is managed by other components of the enterprise framework is called a managed RAS server. 
SAP Crystal Reports Server and SAP BusinessObjects Enterprise provide a framework of servers that facilitates 
enterprise-wide, web-based management and distribution of reports. The managed RAS server is one of several 
servers in this framework. It can process reports located on the same machine as the web server and the RAS 
SDK (unmanaged reports) or reports located on a separate report repository server (managed reports).

The managed RAS server can use the ReportClientDocument object Model and the InfoObject object Model.

Using the RAS API without a RAS server

In SAP Crystal Reports, you can access the advanced report creation and modification functionality of the 
ReportClientDocument Object Model from the CR .NET SDK. The deployment package in this scenario requires 
only the .NET assemblies, meaning you are using the RAS API in-process.

However, if you use the RAS API in-process, you lose the performance and stability benefits of a server-oriented, 
out-process system. To gain these benefits, use the RAS API in conjunction with a RAS Server in a SAP Crystal 
Reports Server or SAP BusinessObjects Business Intelligence platform environment.

For additional information and sample code, see the ReportClientDocument property of the 
CrystalDecisions.CrystalReports.Engine.ReportDocument class in the API reference.

Related Information

Comparing Architectures Across SAP Business Intelligence Reporting Solutions [page 38]
ReportClientDocument Object Model (RAS) [page 35]

1.3.4.2 Optimizing your Code

1.3.4.2.1 Avoid DataSets for Simple Queries

Reporting from DataSets offers advantages, but DataSets shouldn't necessarily be used as a data access 
mechanism when scalability is a consideration. If your application creates a DataSet only for use by a report, and 
especially if the query is simple such as SELECT field 1, field 2 FROM table then DataSets add little 
value.

In such cases, having SAP Crystal Reports connect directly to the database and perform the query (the default 
behavior for any report you create in the SAP Crystal Reports Designer) is faster and requires less memory.

DataSets are useful when:

● Data from multiple data sources needs to be combined.
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● Data inside the DataSet needs to be modified after the query is run.

Related Information

Tutorial: Connecting to ADO.NET DataSets [page 455]

1.3.4.2.2 If You Use DataSets, Cache Them

DataSets become even more useful as a scalability tool if they are cached.

At runtime, when a report is loaded, the SAP Crystal Reports report engine attempts to perform database 
connection pooling. For example, if three users hit the same ASPX page with the same report, a single database 
connection pools all three of these queries. However, the query itself is not pooled. Even if the query is identical in 
all three cases, the query must be performed every time a report is requested from the report engine. For a slow 
query or a large set of data, this query on a per-user basis may be the bottleneck of an application.

Performing this same per-user query multiple times to redundantly populate a DataSet would be even worse 
because of the memory overhead.

To reduce the number of queries to the database, place the DataSet into the ASP.NET Cache object after the first 
query so that all report jobs share the single DataSet in the Cache.

Related Information

Connecting to ADO.NET DataSets [page 137]
Reporting off ADO.NET Datasets [page 550]

1.3.4.2.3 Use the Close() Method to free up the report

Use one of the available Close() methods to release the memory that is used by the report.

Another way to optimize scalability in a SAP Crystal Reports, developer version for Microsoft Visual Studio project 
is to use one of the available Close() methods to release the memory that is used by the report.

Two Close() methods are available:

● ReportDocument.Close() that is used with SAP Crystal Reports.
● ReportClientDocument.Close() that is used with the RAS SDK.
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The ReportDocument.Close() method

You can use the ReportDocument.Close() method to release the memory that the Crystal report consumes on the 
Web server.

How the ReportDocument.Close() method is accessed depends on whether the report is embedded or non-
embedded:

● If the report is embedded, a report wrapper class is generated to represent the report in code. This report 
wrapper class inherits from ReportDocument, and the Close() method is accessed by inheritance.

● If the report is not embedded, it is loaded from the file directory into an instance of ReportDocument, and the 
Close() method is accessed directly from the ReportDocument class.

Both the Crystal report and the instance of the ReportDocument each consume memory. When the 
ReportDocument is freed from memory, the report continues to use memory.

For example, the ReportDocument instance falls out of scope when the Web page finishes loading. When the 
garbage collection for .NET disposes of the ReportDocument instance, the memory that is used by the 
ReportDocument instance is released from the Web server.

However, the report itself remains in memory on the Web server. It cannot be removed, because a 
ReportDocument instance no longer exists to access the report. When those circumstances are repeated in a 
highly scaled situation, the memory on the Web server fills with reports that are no longer being accessed.

To resolve that problem, call the ReportDocument.Close() method. The report itself is closed on the Web server 
and the memory is released for further reports.

When to call the ReportDocument.Close() method

The ReportDocument.Close() method should not be called on the page before the report has been displayed 
because, even if the report has been closed, ReportDocument will reopen the report if it is referenced again. The 
Close() method should only be called after the display process is complete.

The right time to call the Close() method is during the Page_Unload event.

The ReportClientDocument.Close() method

When using an unmanaged RAS or managed RAS server, reports are stored on the Report Application Server, but 
they are represented on the Web server by an instance of ReportClientDocument. If the ReportClientDocument 
instance passes out of scope without calling the ReportClientDocument.Close() method, the Report Application 
Server keeps the report open in memory, even though the report can no longer be accessed. When those 
circumstances are repeated in a highly scaled situation, the memory on the Report Application Server fills with 
reports that are no longer being accessed on the Web server.

To resolve that problem, call the ReportClientDocument.Close() method. The report is closed on the Report 
Application Server and the memory is released for further reports.
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When to call the ReportClientDocument.Close() method

The Close() method should not be called on the page before the report has been displayed, because the report 
must remain open on the server until the display process has been completed.

For a ReportClientDocument instance, the Close() method immediately closes the report and the report cannot 
be reopened. Therefore, if the Close() method is called before the report is displayed, the report will be 
inaccessible and an exception will be thrown.

The right time to call the Close() method is during the Page_Unload event.

Related Information

Comparing Embedded and Non-embedded Reports [page 143]

1.3.4.2.4 Set Up a Web Farm or Web Garden

A Web farm allows you to expand a Web Site across multiple servers. A Web garden allows you to expand a Web 
Site across multiple CPUs within a single server. Spreading the report processing workload across multiple CPUs 
or multiple servers can improve the performance of your web based reporting application.

Related Information

Using SAP Crystal Reports in a Web Farm or Web Garden [page 68]

1.3.4.3 Optimizing your Reports

1.3.4.3.1 Use Smaller Reports

Another way to optimize scalability in a SAP Crystal Reports, developer version for Microsoft Visual Studioproject 
is to reduce the size of your reports.

When possible, keep your reports to less than 15 pages. In Web applications, users often want to see only a few 
key pieces of data rather than pages and pages of data.

Reports used in desktop applications may no longer be appropriate for web-based applications.

To make reports smaller, use the record selection formula to limit the number of records returned to the report. 
This can be implemented in one of three ways:

● The record selection formula can be hard-coded into the report with the embedded SAP Crystal Reports 
Designer.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 65



● You can further filter the records that have been retrieved into the report programmatically.
○ If you use the CrystalReportViewer object model, use the SelectionFormula or 

ViewTimeSelectionFormula property of CrystalReportViewer.
○ If you use the ReportDocument object model, use the RecordSelectionFormula property of 

ReportDocument.

Related Information

Tutorial: Filtering Data Using Selection Formulas [page 249]

1.3.4.3.2 Use Smaller Graphics

Another way to optimize scalability in a SAP Crystal Reports, developer version for Microsoft Visual Studio project 
is to use smaller graphics on the report.

Graphics do not need to be eliminated from reports when scalability is a factor, but they should be used sparingly 
due to their use of system resources.

When a report is displayed in a CrystalReportViewer control and the report contains a graphic (a chart or an 
image), the report engine must create a temporary JPG file (in the dynamic_images folder) and the browser must 
make a separate request to the Web server to retrieve it.

The CrystalReportViewer control also periodically searches through the dynamic_images folder for old images 
and deletes them. This disk access can reduce report performance. Using charts and images sparingly keeps the 
disk access to a minimum.

Related Information

Configuring your Web.Config file [page 18]
Viewers' Directory [page 13]

1.3.4.3.3 Redesign Subreports to Reduce Demand

Changing the way subreports are used in your application can have a big impact on the performance of your 
application.

Another way to optimize scalability in a SAP Crystal Reports, developer version for Microsoft Visual Studio project 
is to refactor subreport calls to reduce demand.
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About using subreports

While subreports can often be used to create complex reports, they add considerable overhead. This doesn't 
mean that subreports shouldn't be used, but they should be used sparingly.

Also consider that when subreports are placed in sections that are repeated, such as group headers or the details 
section, each instance of that subreport requires its own report job. This means that a 100-record report with a 
subreport in the details section actually runs 101 report jobs.

Refactoring subreports as a .NET DataGrid control linked to reports

Subreports are frequently used in a summary/detail model:

● The main report displays summary rows.
● Each row links to a subreport that contains a detail report.

For summary data that does not need to be printed, consider presenting the summary data in a row list rather 
than a report. In other words, rather than use a report as your summary that links to multiple subreports for detail, 
use a .NET DataGrid control as your summary that links to multiple regular reports for detail. Using the .NET 
DataGrid control as your summary offers a simpler, more scalable solution.

To build this, bind a result set of data to a DataGrid control, with a link on each row id to the report. Only a single 
report is then used (with a parameter that accepts a unique id passed to it from the DataGrid row id's URL) for 
each row.

In this scenario, no report processing occurs when the DataGrid displays. Report processing occurs only when 
one of the links within the DataGrid is selected.

1.3.4.3.4 Don't Use Fields that Block On-demand Processing

Another way to optimize scalability in a SAP Crystal Reports, developer version for Microsoft Visual Studio project 
is to not use fields that block on-demand processing.

SAP Crystal Reports processes reports on-demand. For example, if the first page of a report is to be displayed, it 
only processes that first page, not the whole report. However, inserting fields or formulas onto the first page of a 
report that depend upon the completion of the report processing prevents on-demand processing.

For example, if the "Page N of M" special field is placed on the first page, the entire report must be processed to 
determine the page count before this field can be rendered. This causes the first page to wait until the whole 
report was finished processing before it can be displayed. The same behavior occurs when you use a percentage 
of summary calculations.

Consider not using these types of fields.
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1.3.4.3.5 Select the No Printer Option Under Print Setup

Another way to optimize scalability in a SAP Crystal Reports, developer version for Microsoft Visual Studio project 
is to select the No Printer option under Print Setup.

The No Printer Option

Typically, when a Crystal report is created, a default printer has been designated on the development machine. 
This default printer determines the layout of the images, fonts, and database fields on the report.

The advantage to designating a default printer is that it offers consistency in the display of reports: reports are 
displayed to the layout of the default printer. The disadvantage to using a default printer is that it can present a 
scalability problem.

For example, some printer drivers contain memory leaks or file handle leaks. If a report is configured for a printer 
driver that has one of those issues, the performance of the report is adversely affected.

Therefore, as a best practice for scalability, modify your report to use no printer driver.

Note
One consequence of setting a report to have no printer driver is that the report layout may no longer be 
identical to the output from your intended printer. It is recommended that after you have modified the report to 
have no printer driver, test your report on the intended printer. If necessary, adjust the report layout.

Related Information

To remove the default printer driver from your report [page 108]

1.3.5  Using SAP Crystal Reports in a Web Farm or Web Garden

This section provides an overview on how to use SAP Crystal Reports, developer version for Microsoft Visual 
StudioWeb Site in a Web farm or Web garden.

A Web farm allows you to expand a Web Site across multiple servers. A Web garden allows you to expand a Web 
Site across multiple CPUs within a single server.Spreading the report processing workload across multiple CPUs 
or multiple servers can improve the performance of your web based reporting application.
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1.3.5.1 Architecture of a Web Farm or Web Garden

Web farm architecture

A Web farm has multiple servers that are exposed to browser clients as a single virtual server, with one virtual 
Media Access Card and TCP/IP address.

Behind this virtual layer, each server in the Web farm receives every network packet, but only processes a subset 
of those packets. The ability to equally share the workload is what gives Web farms their superior processing 
power.

This distribution of packets is managed by Network Load Balancing. Network Load Balancing does the following:

● It balances the client requests between servers.
● It determines which server will process which request.
● It ensures that server resource use and client wait times are optimized.
● It provides a superior alternative to client affinity.

Note
In a client affinity scenario, connecting clients are restricted to return to the same server each time.

Client affinity is usually turned off, because it can create a bottleneck of requests for a particular server.

Each server on a Web farm has a Network Load Balancing network device driver, which communicates with the 
other servers, and each server typically has two network cards. The second card allows internal communications 
for Network Load Balancing to be done over a separate, internal network.

The Network Load Balancing network device driver is provided with the Windows Server family of operating 
systems.

Web garden architecture

A Web garden is like a Web farm, except that rather than use several server machines linked together, it uses 
single machine with multiple CPUs.

This single SMP (symmetric multiprocessing) server uses ASP.NET to run a separate ASP.NET worker process on 
each CPU. The server manages multiple client requests against the multiple CPUs on the server.

1.3.5.2 The ASP.NET Worker Process

ASP.NET runs within a process known as the ASP.NET worker process. All ASP.NET functionality runs within the 
scope of this process.

A regular Web server contains only a single ASP.NET worker process. This is different from both Web farms and 
Web gardens:
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● A Web farm contains multiple ASP.NET worker processes.
Each server in the group of servers handles a separate ASP.NET worker process.

● A Web garden contains multiple ASP.NET worker processes.
Each CPU in the SMP server handles a separate ASP.NET worker process.

Choosing an ASP.NET worker process

When a Web client connects to a Web farm or Web garden, one of the multiple ASP.NET worker processes is 
selected to run the request.

● In a Web farm, Network Load Balancing determines the ASP.NET worker process selected.
● In a Web garden, the ASP.NET worker process selected is determined by ASP.NET.

State management with multiple ASP.NET worker processes

When moving from a scenario with a single ASP.NET worker process (a normal Web server) to a scenario with 
multiple ASP.NET worker processes (a Web farm or Web garden), complications with state management are 
introduced.

Web pages are stateless, so a Web server must persist state through other means. Typical means to manage 
state on the Web server include Session State and the ASP.NET Cache.

Both Session and Cache are contained within the memory space of a single ASP.NET worker process. But in a 
Web farm or Web garden, multiple ASP.NET worker processes work together simultaneously. The Session or 
Cache within any individual ASP.NET worker process cannot manage state across multiple processes.

Therefore, an additional layer is required for state management: an out-of-process Session State server that 
stores and retrieves state information for every ASP.NET worker process in the Web farm or Web garden.

Related Information

Out-of-Process Session State [page 70]
Which Persistence Approach Should I Use with SAP Crystal Reports? [page 48]

1.3.5.3 Out-of-Process Session State

In Web farms and Web gardens, Session State must be shared across servers using some form of out-of-process 
Session State.

Two solutions are commonly used:

● Deploy the out-of-process Session State server that is provided with ASP.NET.
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● Manually configure each Web server to store Session State data on a SQL Server.

Serialization Requirement

In both solutions, all objects to be stored must be serializable. Unless an object can be serialized, it cannot be 
persisted to an out-of-process state server.

Note
Not all object models in the SAP Crystal Reports SDK can be serialized. However, SAP provides an upgrade 
solution for managing the state of reports with an out-of-process server.

Related Information

Serializable Object Models in SAP Crystal Reports [page 71]

1.3.5.4 Serializable Object Models in SAP Crystal Reports

Four object models are available for SAP Crystal Reports: two that ship with SAP Crystal Reports and two that are 
available by upgrade.

This section explains which object models can be serialized for use with an out-of-process Session State server.

Note
For an introduction to out-of-process Session State, see Out-of-Process Session State [page 70].

Serialization and the CrystalReportViewer object model

The CrystalReportViewer object model is a limited object model that is included within the API of the 
CrystalReportViewer control. Due to the limited scope of this object model, it usually is not recommended in 
favor of the more powerful ReportDocument object model.

However, the CrystalReportViewer object model can be used on a Web farm or Web garden. That is because 
CrystalReportViewer is contained within a Web control, and Web control persistence is managed on the client 
side, with View State. View State persistence places the state of ASP.NET Web server controls into an encrypted 
string, and then includes that encrypted string as a hidden form field within the ASPX page during page reloads. 
The state information can be delivered to any ASP .NET worker process.
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Note
This form of client persistence works only within page reloads. View State cannot persist information across 
pages.

Serialization and the ReportDocument object model

The ReportDocument object model is a more powerful object model than CrystalReportViewer, and 
therefore it is usually the recommended object model to use in SAP Crystal Reports.

However, in SAP Crystal Reports versions 9 and earlier, the ReportDocument class could not be serialized and 
therefore, by itself, could not be used with an out-of-process Session State server in a Web farm or Web garden 
scenario.

This limitation has been addressed in SAP Crystal Reports 10 and up by bridging the ReportDocument object 
model to a serializable object model, ReportClientDocument.

The ReportClientDocument object model is accessible in several different ways.

To use the ReportDocument object model in a Web farm or Web garden, you need the ASP.NET out-of-process 
Session State server to store the state of the serialized ReportDocument instance and an unmanaged RAS 
server to store the Crystal report .rpt file.

Note
You can serialize the ReportDocument object model only if you have installed the RAS server, and then set the 
ReportDocument.ReportAppServer and ReportDocument.EnterpriseSession properties to address 
that server.

Serialization and the ReportClientDocument object model

The ReportClientDocument object model can be serialized. The ReportClientDocument object model is 
accessible in several different ways.

The InfoObject object model

The InfoObject object model is part of the Crystal upgrade solution, SAP Crystal Reports Server or 
SAPBusinessObjects Business Intelligence platform. SAP Crystal Reports Server and SAP BusinessObjects 
Business Intelligence platform are multi-server enterprise solutions that are typically an alternative approach to 
an existing Web farm or Web garden.
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Related Information

Using SAP Crystal Reports in a Web Farm or Web Garden [page 68]
Choose the Correct Object Model for Your Project [page 29]
ViewState and Persistence of the CrystalReportViewer Object Model [page 50]

1.3.5.5 Configuring SAP Crystal Reports for a Web Farm or 
Web Garden

Additional servers

In addition to the Web farm or Web garden servers, you need two additional servers:

● The ASP.NET out-of-process Session State server, to store the state of the serialized ReportDocument 
instance.

● An unmanaged RAS server to store the Crystal report .rpt file.

Note
For more information, see SAP BusinessObjects Business Intelligence reporting solutions [page 59].

Special use of ReportDocument

The Web farm or Web garden uses the ASP.NET out-of-process Session State server to store the serialized 
ReportDocument object. In this scenario, the ReportDocument object is used differently than in a basic install of 
SAP Crystal Reports.

Instead, the ReportDocument.Load() method or the ReportDocument.FileName property links the 
ReportDocument instance to an out-of-process report that is stored on the unmanaged RAS server. For examples 
of how to use either approach, see the configuration information below.

Note
The storage of the report .rpt file on the out-of-process unmanaged RAS server means that every ASP.NET 
worker process in the Web farm or Web garden can access the same report .rpt file from a central location.

Configuration of ReportDocument for the unmanaged RAS server

The relationship between the ReportDocument instance and the unmanaged RAS server can be configured in the 
following ways:
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● Upload the local, embedded Crystal report within the ReportDocument instance to the unmanaged RAS 
server at runtime. This temporarily stores the report .rpt file on the out-of-process unmanaged RAS server.

● Associate an external report that is permanently stored on the out-of-process unmanaged RAS server with 
the ReportDocument instance, by assigning the file directory path of the report on the unmanaged RAS server 
to the FileName property of the ReportDocument instance.

ReportDocument instance on the Session State server, the .rpt file on the 
unmanaged RAS server

The ReportDocument instance, which can be serialized when it is used in cooperation with the unmanaged RAS 
Crystal upgrade solution, is stored on the ASP.NET out-of-process Session State server.

Because the ReportDocument instance stays alive on the Session State server, the Crystal report .rpt file 
associated with the ReportDocument instance is kept open on the unmanaged RAS server.

When a different ASP.NET worker process on the Web farm or Web garden retrieves the ReportDocument 
instance from the out-of-process Session State server, the associated .rpt file is accessed by the 
ReportDocument instance from the unmanaged RAS server.

Writing images to the network share

One additional detail needs to be configured when using a Web farm.

Images that are written during the reporting process (such as dynamic charts) must be placed on a common 
network share for access by any ASP.NET worker process. Each machine must be configured to write images to 
the same network share and to grant permission to the ASP.NET worker account on each machine to write to that 
share.

To configure a machine to be able to access this directory, add the following information to your registry.

 [HKEY_LOCAL_MACHINE\SOFTWARE\Business Objects\Suite 12.0\Report Application Server
\Viewer] "CrystalImageDir"="\\fileserver\images"

Detailed configuration instructions

For detailed configuration instructions on the configuration issues involved in running SAP Crystal Reports on a 
Web farm or Web garden, consult the Technical Support web site.

1.3.6  Working with Crystal Reports as a Web Service

This section explains how to work with Crystal reports that have been published as Report Web Services.
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Web services allow different applications to share both their data and their capabilities. For example, an 
accounting system can connect to a customer ordering system. Companies can also use Web services to share 
data and application capabilities with other companies.

Web services are independent of any particular component technology or object-calling convention for the 
following reasons:

● They use HTTP as the Web protocol.
● They are based on XML.
● They support the Secure Socket Layer (SSL).

Programs that are written in any programming language for any component model and operating system, can 
access the Web service.

SAP Crystal Reports has enabled reports to be easily published and consumed as Report Web Services. Web and 
Windows applications can connect to a Report Web Service and display the Crystal report that is exposed by this 
service.

1.3.6.1 Publishing and Consuming a Report as a Web Service

In SAP Crystal Reports, developer version for Microsoft Visual Studio, you can publish Crystal reports as Web 
services.

How a report is published as a Report Web Service

In SAP Crystal Reports, developer version for Microsoft Visual Studio, when you select the option to publish a 
Crystal report to a Report Web Service, the Report Web Service is compiled to a DLL, which generates an XML file 
with the .NET Web service file extension, ".asmx." The ASMX file describes the public functions, input parameters, 
data types, and return data types that are exposed by the Report Web Service. Both the DLL and ASMX files are 
published on the Web server as a Report Web Service. A client on a Web browser can now invoke the Report Web 
Service by calling the URL of the Web service. Data is passed to and from the Web Service over HTTP in the form 
of XML.

How the report is consumed as a Report Web Service file on the client

To access the published Report Web Service from a client application, you must pass the URL string to the 
ReportSource property of the CrystalReportViewer control, from either a Web Site or Windows project.

Related Information

Using Crystal Services [page 77]
Working with Crystal Reports as a Web Service [page 74]
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1.3.6.1.1 To publish a Report Web Service

Before you begin, you will need an existing Crystal report. The report will be published as a Web Service, which 
can then be consumed by the CrystalReportViewer.ReportSource property.

1. Start Visual Studio.
2. From the File menu, select New, and then click Web Site.
3. From the Visual Studio installed templates list, click ASP.NET Web Service.
4. In the Location field, enter a file directory path and name for your Web Service directory.

 C:\WebServices\MyCrystalReportsWebServices 
5. Click OK.
6. In Solution Explorer, right-click the bold project name and select Add Existing Item….
7. In the Add Existing Item dialog box, set Files of type to All Files (*.*).
8. Add an existing Crystal report to your project.
9. Right-click the report and select Publish as web service.

A new service is created.
10. Right-click the Web Service and select Set As Start Page.

When you run your application, the new web service will be displayed in the Web browser. You can use the 
URL of the Web Service as a report source for a CrystalReportViewer control.

Note
In Visual Studio 2005 and later, IIS is not used by default to preview Web sites and Web services. Instead, 
Visual Web Developer Web Server is the default Web server. When you use this Web server, the URL 
contains only a temporary, random port number that is valid only at compile time. To access this Web 
service URL from a client application, you must first configure the file directory for the Web service project, 
as a virtual directory in IIS. The virtual directory provides you with a consistent URL to call from your client 
application.

1.3.6.1.2 To consume the Report Web Service from a client 
project

Before you begin, you will need to have access to a report that has already been published as a Web Service.

1. Add CrystalReportViewer control to your Web site or Windows application.
2. From the View menu, click Code.
3. Assign the Report Web Service URL string to the ReportSource property of CrystalReportViewer class.

myCrystalReportViewer.ReportSource = "http://localhost/MyCrystalReportsWebService/Hierarchical_GroupingService.asmx" 

crystalReportViewer.ReportSource = "http://localhost/MyCrystalReportsWebService/Hierarchical_GroupingService.asmx"; 
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When you run your application, the CrystalReportViewer control displays the report published by the Web Service.

1.3.6.2 Using Crystal Services

SAP Crystal Reports, developer version for Microsoft Visual Studio allows you to connect programmatically to 
your reports via the Crystal Services web service. Crystal Services make it easy to connect to reports that are 
exposed by various servers on the network.

The report sources behind these sub nodes and the classes that they generate (when they are dragged onto the 
Web or Windows Form) vary across successive versions of SAP Crystal Reports.

Using Crystal Services with SAP Crystal Reports 2005 or Newer

In Visual Studio 2005, Crystal Services is accessed programmatically. Crystal Services allows you to generate a 
list of reports available on a local or remote machine, and access those reports via a web service.

Connection code must be entered manually in SAP Crystal Reports, developer version for Microsoft Visual Studio.

Crystal Services uses the Report Web Services protocol to access a virtual directory on the server, known as the 
viewers' virtual directory.

Using Crystal Services with SAP Crystal Reports for Visual Studio .NET 2003

In SAP Crystal Reports for Visual Studio 2003, Crystal Services were accessed from the Server Explorer.

The Crystal Services sub node within each server expands to reveal further sub nodes. The names of these sub 
nodes vary across versions of SAP Crystal Reports, but their common behavior is that each Crystal Services sub 
node expands to display a list of reports, either from the file directory of the local machine or from servers on the 
network.

In some cases, a Crystal Services sub node uses the Report Web Services protocol. In that case, it uses that 
protocol to access a virtual directory on the server, known as the viewers' virtual directory.

In other cases, a direct connection is made to an unmanaged RAS server, SAP Crystal Reports Server or SAP 
BusinessObjects Business Intelligence platform. In that case, the Report Web Service protocol is not used.

You may have to adjust your firewall settings in order to access the SAP BusinessObjects Business Intelligence 
platform CMS. The default port for the CMS is 6400. Contact your system administrator for more information on 
network address and port settings for your SAP BusinessObjects Business Intelligence platform system. More 
information on customizing ports can be found in the SAP BusinessObjects Business Intelligence platform 
Administrators Guide.

Note
The nodes that are available depend on your configuration and your licensing agreement.
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A report that is exposed through the Crystal Services node can be dragged into the component tray of Web or 
Windows forms in Visual Studio .NET 2003.

Related Information

Viewers' Directory [page 13]

1.3.6.3 Configuring Server Files in Crystal Services

One group of Crystal Services that is provided with SAP Crystal Reports, developer version for Microsoft Visual 
Studio is Server Files. Server Files is a collection of Report Web Services that are exposed through a virtual 
directory from a file directory path on your hard drive.

Different implementation requirements are needed for each Visual Studio version.

1.3.6.3.1 Configuring Server Files in Visual Studio .NET 2003

Server Files refers to a collection of Report Web Services that are exposed from the viewers' virtual directory in 
IIS. Server Files were originally provided as a Crystal Services node in SAP Crystal Reports in Visual Studio .NET 
2002, but the node has since been removed. Each later version of SAP Crystal Reports continues to support 
Server Files in the SDK, with some configuration work required for each version.

The Server Files are generated from underlying report files, which are stored in the sample reports folder (or any 
other folder you may designate) on the file directory path of the web server.

Server Files are accessed in two ways:

● As a visible node under Crystal Services.
This means of access is only available in SAP Crystal Reports for Visual Studio 2003.

● Through programmatic configuration of the ServerFileReport class in the SDK.
Access to Server Files through the SDK is available in all versions of SAP Crystal Reports .NET.

Server Files are exposed through a virtual directory in IIS. Connection to the underlying report files requires 
configuration of folder access permissions.

Access permissions are configured through a web.config entry.

How Server Files are configured in Visual Studio .NET 2003

In Visual Studio .NET 2003 the configuration folder for Server Files has been deprecated, in favor of adding a 
configuration entry to the web.config file.

You can add the configuration entry to the web.config file of each project, one at a time. However, it is 
recommended that you add this configuration entry to the web.config file that is located within your viewers' 
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virtual directory of SAP Crystal Reports, to make this information available to all Visual Studio .NET projects. 
Before you do that, see the next section to learn more about the "viewers' virtual directory."

Server Files and the viewers' virtual directory

Server Files are served out of Internet Information Services (IIS) from a centralized Web service that is in a special 
viewers' virtual directory. Each succeeding version of SAP Crystal Reports creates an additional viewers' virtual 
directory in IIS, which allow you to maintain multiple versions of SAP Crystal Reports.

The additional "viewers' virtual directory" becomes a maintenance issue if you have coded Server Files in a project 
with an earlier version of SAP Crystal Reports, and you are now upgrading to a later version. In your code, the 
name of the "viewers' virtual directory" in the WebServiceURL property of each ServerFileReport instance must 
be changed to the current "viewers' virtual directory," to enable your ServerFileReport instances to work.

Related Information

Configuring Server Files in Visual Studio 2005 and Newer [page 81]
Working with Crystal Reports as a Web Service [page 74]
Viewers' Directory [page 13]

1.3.6.3.1.1  To change the "viewers' virtual directory" in the 
WebServiceURL property of your 
ServerFileReport instances

1. Locate each occurrence in your project where the WebServiceURL property of a ServerFilesReport instance is 
assigned.

2. Compare the viewers' virtual directory name that is currently assigned in your code against the viewers' 
virtual directory name that is used in previous versions.

3. Change the viewers' virtual directory name that is used in your highest installed version of SAP Crystal 
Reports.

4. Recompile and verify that the reports load correctly.

Modify the web.config file in the viewers' virtual directory to properly configure Server Files in all versions 
following Visual Studio .NET 2002.
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1.3.6.3.1.2  To add the Server Files configuration entry to the 
web.config file of the viewers' virtual directory 
(all versions following Visual Studio .NET 2002)

1. Locate the viewers' virtual directory for your highest-installed version of SAP Crystal Reports.
2. To verify that the viewers' virtual directory works, open a browser and enter the URL to the published Report 

Web Service on the viewers' virtual directory.

Option Description

Visual Studio 2003 http://localhost/CrystalReportWebFormViewer2/
ServerFileReportService.asmx?wsdl

SAP Crystal Reports 2008 http://localhost/crystalreportviewers12/
ServerFileReportService.asmx?wsdl

3. In a text editor, open the web.config file that is located in the viewers' virtual directory.

Note
As an alternative, you could also choose to make these changes only in the web.config for your client web 
application that will access these Server File Reports.

4. At the top of the web.config file, just inside the configuration tag, add a configSections entry that declares a 
new sectionGroup type (crystalDecisions) and its section (serverFileReportManager).

 <configSections>
   <sectionGroup name="crystalDecisions">
      <section name="serverFileReportManager"
           type="System.Configuration.NameValueSectionHandler, System,
           Version=1.0.3300.0, Culture=neutral, 
           PublicKeyToken=b77a5c561934e089, Custom=null" />
   </sectionGroup>
</configSections> 

5. After the closing tag of configSections, add the new sectionGroup and section that you declared in the 
previous step.
In the below example, change the value of the root directory to the directory in which you have stored your 
reports. For the purposes of this example, the file path is set to C:\program files\Microsoft Visual 
Studio .NET 2003\Crystal Reports\Samples\Reports\Feature Examples.

 <crystalDecisions>
   <serverFileReportManager>
      <add key="rootDirectory"
value="C:\program files\Microsoft Visual Studio .NET 2003\Crystal Reports\Samples
\En\Reports\Feature Examples" />
   </serverFileReportManager>
</crystalDecisions> 

Note
You must enter your file directory path to your reports folder into the value field.

6. Save your changes to web.config.
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1.3.6.3.2 Configuring Server Files in Visual Studio 2005 and 
Newer

Server Files refer to a collection of Report Web Services that expose reports on an IIS server. Server Files were 
originally provided as a Crystal Services node in SAP Crystal Reports in Visual Studio .NET 2002, but the node has 
since been removed. Each later version of SAP Crystal Reports continues to support Server Files in the SDK, with 
some configuration work required for each version.

The Server Files are generated from underlying report files, which are stored in the sample reports folder (or any 
other folder you may designate) on the file directory of the web server.

Configuring Server Files

To configure server files for Visual Studio 2005 or newer, you must complete two steps. First, create the Report 
Web Service that exposes your reports. The second step is to alter the web.config file that corresponds to the new 
web service. In Visual Studio 2005, the configuration folder for Server Files that is found in Visual Studio .NET 
2002 was deprecated in favor of adding a configuration entry to the web.config file.

You could add the configuration entry to the web.config file of each project, one at a time. However, it is 
recommended instead that you add this configuration entry to the web.config file that is located within the virtual 
directory that contains the Report Web Services.

Related Information

Connecting to Report Web Services from a Secure Web Site [page 84]
Working with Crystal Reports as a Web Service [page 74]

1.3.6.3.2.1  To create the Report Web Services required for 
Server Files

1. Start Visual Studio.
2. From the File menu, select New, and then click Web Site.
3. In the New Web Site dialog box, select the Visual C# from the Language list.
4. From the Templates list, click ASP.NET Web Service
5. In the Location field, replace the default project name with the name of your project.

For the purposes of this example, we will save the project in C:\InetPub\wwwroot\ with the name 
CrystalReportsWebServices.

  C:\InetPub\wwwroot\CrystalReportsWebServices\  
6. Click OK.
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7. From the Debug menu, click Start Debugging.

A dialog box appears and states that the Web.config file must be modified. Click the OK button to enable 
debugging.

8. Once debugging is complete, return to the application.
9. From the Solution Explorer, right-click Service.asmx, and then click Delete.
10. In the Solution Explorer, expand the App_Code folder, right-click Service.cs, and then click Delete.
11. In the Solution Explorer, right-click the project name that is in bold type, and then click Add New Item.
12. In the Add New Item dialog box, do the following:

a. From the Installed Templates field, select Web Service.
b. In the Name field, enter ServerFileReportService.asmx.
c. Uncheck Place code in separate file.
d. Click Add.

13. Replace the contents of the ServerFileReportService.asmx file with the following line:

 <%@ WebService language="C#"
class="CrystalDecisions.Web.Services.ServerFileReportService" %> 

14. From the File menu, click Save All.
15. In the Solution Explorer, right-click the project name that is in bold type, and then click Add New Item.
16. In the Add New Item dialog box:

a. From the Installed Templates field, select Web Service.
b. In the Name field, enter ServerFileReportManager.asmx
c. Uncheck Place code in separate file.
d. Click Add.

17. Replace the contents of the ServerFileReportManager.asmx file with the following line:

 <%@ WebService language="C#"
class="CrystalDecisions.Web.Services.ServerFileReportManager" %> 

18. From the File menu, click Save All.

1.3.6.3.2.2  To change the "viewers' virtual directory" in the 
WebServiceURL property of your 
ServerFileReport instances

1. Locate each occurrence in your project where the WebServiceURL property of a ServerFilesReport instance is 
assigned.

2. Compare the name of the viewers' virtual directory that is currently assigned in your code against the name of 
the viewers' virtual directory that is used in previous versions.

3. Change the name of the viewers' virtual directory that is used in your highest installed version of SAP Crystal 
Reports.
If your highest installed version of SAP Crystal Reports is SAP Crystal Reports for Visual Studio 2005, enter 
the path to the Report Web Service that you created earlier in this tutorial.

4. Recompile and verify that the reports load correctly.
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Related Information

Viewers' Directory [page 13]

1.3.6.3.2.3  To add the Server Files configuration entry to the 
web.config file

1. From Solution Explorer, open the Web.Config file.
2. Replace the entire contents of the Web.Config file with the below XML.

In the below example, change the value of the root directory to the directory in which you have stored your 
reports. For the purposes of this example, the file path is set to C:\program files\Microsoft Visual 
Studio 8\Crystal Reports\Samples\en\Reports\Feature Examples.

 <?xml version="1.0"?>
<configuration
xmlns="http://schemas.microsoft.com/.NetConfiguration/v2.0">
   <configSections>
      <sectionGroup name="crystalDecisions">
         <section name="serverFileReportManager"
type="System.Configuration.NameValueSectionHandler, System,
Version=1.0.3300.0, Culture=neutral,
PublicKeyToken=b77a5c561934e089, Custom=null"/>
      </sectionGroup>
   </configSections>
   <crystalDecisions>
      <serverFileReportManager>          <add key="rootDirectory" value="C:\program files\Microsoft Visual 
Studio 8\Crystal Reports\Samples\en\Reports\Feature Examples"/>       </serverFileReportManager>
   </crystalDecisions>
   <appSettings/>
   <connectionStrings/>
   <system.web>
      <compilation debug="true">
         <assemblies>
            <add assembly="CrystalDecisions.Web, Version=12.1.2000.0, 
Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
         </assemblies>
      </compilation>
   </system.web>
</configuration> 

Note
You must enter the file directory path to your reports folder where you see 
PUT_FILE_DIRECTORY_PATH_TO_REPORTS_FOLDER_HERE.

3. Save your changes to the web.config file.
4. To verify that the viewers' virtual directory works, open a browser and enter the URL to the published Report 

Web Service.

 http://localhost/CrystalReportsWebServices/ServerFileReportService.asmx?wsdl 
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1.3.6.3.2.4  Legacy Server Files and the Viewers' Virtual 
Directory

In previous versions of SAP Crystal Reports, Server Files were served out of IIS from a centralized web service, 
which is in the viewers' virtual directory. Each succeeding version of SAP Crystal Reports creates an additional 
directory named "viewers' virtual directory" in IIS, which allows you to maintain multiple versions of SAP Crystal 
Reports.

The additional "viewers' virtual directory" becomes a maintenance issue, if you have coded Server Files in a 
project with an earlier version of SAP Crystal Reports, and you are now upgrading to a later version. In your code, 
the name of the "viewers' virtual directory" in the WebServiceURL property of each ServerFileReport instance 
must be changed to the current location of the Report Web Service to enable your ServerFileReport instances to 
work.

Related Information

Viewers' Directory [page 13]

1.3.6.4 Connecting to Report Web Services from a Secure 
Web Site

In SAP Crystal Reports, developer version for Microsoft Visual Studio, you can publish Crystal reports as Web 
services.

Because Web services are accessed over the Web, you may want to protect Report Web Services from 
anonymous access.

This section explains how to remove anonymous access from a virtual directory that contains a Report Web 
Service, and then write code that places the Report Web Service into a RemoteReportProxy class, which can be 
configured to address NT authentication on the Internet Information Services (IIS) server.

Two kinds of Report Web Services require authentication code: regular Report Web Services and Server Files.

Related Information

Publishing and Consuming a Report as a Web Service [page 75]
Configuring Server Files in Crystal Services [page 78]

1.3.6.4.1 Report Web Services and NT Authentication
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1.3.6.4.1.1  Adding NT Authentication to the Report Web 
Service

Before you add the modifications for NT authentication, you must build a project that publishes and consumes a 
Report Web Service as shown in Publishing and Consuming a Report as a Web Service [page 75].

In this section, you learn how to remove anonymous access from the directory that contains the Report Web 
Service that you have created earlier.

Related Information

Connecting to Report Web Services from a Secure Web Site [page 84]

1.3.6.4.1.1.1   To remove anonymous access from the directory 
containing the Report Web Service

1. In Control Panel, double-click Administrative Tools, and then double-click Internet Services Manager.
2. In the Internet Information Services window, expand the top nodes, and then expand the Default Web Site 

node.
3. Locate the virtual directory folder for the Report Web Service that you have created earlier.

4. Right-click the virtual directory and select Properties.
5. In the Properties dialog box, in the Directory Security tab, click Edit.
6. Clear the Anonymous Access checkbox, and then click OK.
7. Click OK to close Properties.
8. Close the Internet Information Services window.

At this point, if you want authentication on this directory to be set for a specific network user, you need to add 
individual network user permission to the folder from Windows Explorer.

1.3.6.4.1.1.2   To add a specific network user's permissions to 
the folder

1. In Windows Explorer, locate the folder that contains the Web service.
2. Right-click the folder and select Properties.
3. In the Properties dialog box, in the Security tab, click Add…
4. In the Select Users, Computers or Groups dialog box, in the <<Type names separated by semicolons>> or 

choose from list panel, type the network user name.
5. Click Check Names.
6. Verify that the user name has been added correctly, and then click OK.
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7. In the Permissions panel, select Allow for the Read permission.

1.3.6.4.1.2  Editing the Client Application to Add Secure Access

In this section, you edit your client application to securely access the Report Web Service through NT 
Authentication. You must add assemblies, namespaces, and new code.

1.3.6.4.1.2.1  To verify that your client application can no longer 
access the secure Web Service

1. Re-open the client application that you created to consume the Report Web Service (from the section 
Publishing and Consuming a Report as a Web Service [page 75]).

2. Run the application to verify that you are no longer allowed to anonymously access the Report Web Service in 
this directory.

An error message appears: "The request failed with HTTP status 401: Access Denied."

1.3.6.4.1.2.2   To add new assemblies and references to those 
assemblies

1. Right-click the References folder and select Add Reference...

2. From the Add Reference dialog box, on the .NET tab, hold down CTRL and click the following assemblies:

○ CrystalDecisions.ReportSource
○ System.Web.Services

3. Click Select on the right side of the dialog box.

4. Verify that both assemblies have been added to the Selected Components panel, and then click OK.

5. Open the Web or Windows Form that you have created in Project Setup [page 15].
6. From the View menu, click Code.

7. Above the class signature, add three "Imports" [Visual Basic] or "using" [C#] declarations to the top of the 
class for the following namespaces.

 Imports CrystalDecisions.ReportSource
Imports System.Net
Imports System.Web.Services 
 using CrystalDecisions.ReportSource;
using System.Net;
using System.Web.Services; 

Next, you learn how to add code to configure a RemoteReportProxy class that passes user credentials to the 
secure directory of the Report Web Service.

86 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



1.3.6.4.1.2.3  Coding the 
GetReportWebServiceWithAuthentication() 
Method

The GetReportWebServiceWithAuthentication() method is used to configure the remote report proxy and 
to handle NT authentication.

In this section, you learn how to code the GetReportWebServiceWithAuthentication() method to set the 
values of the URL and Credentials properties. You must add the 
GetReportWebServiceWithAuthentication() method to the ReportSource of the 
CrystalReportViewer control for declaration and instantiation of the RemoteReportProxy class.

This method optionally adds firewall proxy settings to the RemoteReportProxy instance.

1. At the bottom of the class, create the GetReportWebServiceWithAuthentication() private helper 
method that returns a RemoteReportProxy class.

 Private Function GetReportWebServiceWithAuthentication() As
RemoteReportProxy
End Function 
 private RemoteReportProxy GetReportWebServiceWithAuthentication()
{
} 

2. Within the ConfigureCrystalReports() method, select the Web service URL string that is currently 
assigned to the ReportSource property of the CrystalReportViewer control. Cut the string to the 
clipboard.

Note
Later in this procedure, you assign a new value to the ReportSource property of the 
CrystalReportViewer control.

3. Declare a reportWebServiceURL string variable and paste the URL string.

 Dim reportWebServiceURL As String =
"http://mywebserviceserver.com/MyWebServiceDirectory/Hierarchical
%20GroupingService.asmx" 
 string reportWebServiceURL =
"http://mywebserviceserver.com/MyWebServiceDirectory/Hierarchical
%20GroupingService.asmx"; 

4. Declare and instantiate the RemoteReportProxy class.

 Dim myRemoteReportProxy As RemoteReportProxy = New RemoteReportProxy() 
 RemoteReportProxy remoteReportProxy = new RemoteReportProxy(); 

5. Assign the reportWebServiceURL variable to the URL property of the RemoteReportProxy instance.

 myRemoteReportProxy.Url = reportWebServiceURL 
 remoteReportProxy.Url = reportWebServiceURL;
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6. Call the ConfigureAuthentication() method (that you will create in the next step procedures), and pass 

in a True Boolean value and the reportWebServiceURL variable. Assign this method to the Credentials 
property of the RemoteReportProxy instance.

 myRemoteReportProxy.Credentials = ConfigureAuthentication(True,
reportWebServiceURL) 
 remoteReportProxy.Credentials = ConfigureAuthentication(true,
reportWebServiceURL); 

7. Call the AddFirewallProxySettings() method (that you will create in the next step procedures), and pass 
in a False Boolean value, the URI string for a firewall proxy server, and the RemoteReportProxy instance.

Note
Replace the URI string with your firewall proxy server.

 myRemoteReportProxy = AddFirewallProxySettings(False, "<<
http://firewallproxyserver:8080>>",
myRemoteReportProxy) 
 remoteReportProxy = AddFirewallProxySettings(false, "<<
http://firewallproxyserver:8080>>",
remoteReportProxy); 

8. Return the RemoteReportProxy instance from the method.

 Return myRemoteReportProxy 
 return remoteReportProxy; 

1.3.6.4.1.2.4  Coding the ConfigureAuthentication() Method

In this section, you learn how to code the ConfigureAuthentication() method to allow two approaches to 
configure authentication.

In the first approach, you use a specific user name, password, and domain name to satisfy the requirements of the 
user security permissions that you have added in Adding NT Authentication to the Report Web Service [page 85]. 
In the second approach, you rely on NTLM authorization.

When a True Boolean value is passed to this method, the user-specific credentials are provided to access the 
Web services. A False Boolean value calls the code for NTLM credentials to access the Web services.

The ConfigureAuthentication() method is called from the 
GetReportWebServiceWithAuthentication() method.

1. At the bottom of the class, create the ConfigureAuthentication() private helper method that returns the 
ICredentials interface. This method takes two parameters, a Boolean named isUserSpecific and the 
reportWebServiceURL string.

 Private Function ConfigureAuthentication(ByVal isUserSpecific As
Boolean, ByVal reportWebServiceURL As String) As ICredentials
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End Function 
 private ICredentials ConfigureAuthentication(bool isUserSpecific,
string reportWebServiceURL)
{
} 

2. Within the method, create a conditional block that tests the isUserSpecific Boolean method parameter.

 If isUserSpecific Then
Else
End If 
 if(isUserSpecific)
{
}
else
{
} 

3. Collect the following information: the user name, password, and network domain name that you have 
authorized with user access permissions for the directory containing the Report Web Service.

4. Within the If block, declare and assign appropriate values to the username, password, and domain string 
variables.

 Dim userName As String = "fchen"
<NonSerialized()> Dim password As String = "1234"
Dim domain As String = "Enterprise" 
 string userName = "fchen";
[NonSerialized()] string password = "1234";
string domain = "Enterprise"; 

5. Declare and instantiate the NetworkCredential class and pass in the username, password, and domain 
string variables.

 Dim myNetworkCredential As NetworkCredential = New
NetworkCredential(userName, password, domain) 
 NetworkCredential networkCredential = new
NetworkCredential(userName, password, domain); 

6. Return the instance of NetworkCredential from the If block.

In the Else block, you create three alternate values: an URI for the Report Web Service, a string that indicates 
that the authentication type is NTLM, and a NetworkCredential instance. Each of those values is passed to 
the credential cache.

 Return myNetworkCredential 
 return networkCredential; 

7. Within the Else block, declare and instantiate the CredentialCache class.

 Dim myCredentialCache As CredentialCache = New CredentialCache() 
 CredentialCache credentialCache = new CredentialCache(); 
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8. Declare and instantiate the Uri class, and pass in the reportWebServiceURL parameter from the 
ConfigureAuthentication() method.

 Dim myUri As Uri = New Uri(reportWebServiceURL) 
 Uri uri = new Uri(reportWebServiceURL); 

9. Assign the string value "NTLM," to a string variable that is named "ntlmAuthorization."

 Dim ntlmAuthorization As String = "NTLM" 
 string ntlmAuthorization = "NTLM"; 

10. Declare and instantiate the NetworkCredential class.

 Dim myNetworkCredential As NetworkCredential = New
NetworkCredential() 
 NetworkCredential networkCredential = new NetworkCredential(); 

11. Pass the Uri instance, the ntlmAuthorization string, and the NetworkCredential instance to the Add() method 
of the CredentialCache instance.

 myCredentialCache.Add(myUri, ntlmAuthorization,
myNetworkCredential) 
 credentialCache.Add(uri, ntlmAuthorization, networkCredential); 

12. Return the ICredentials instance from the DefaultCredentials property of the CredentialCache 
class from the Else block.

 Return CredentialCache.DefaultCredentials 
 return CredentialCache.DefaultCredentials; 

1.3.6.4.1.2.5  Coding the AddFirewallProxySettings() Method

In this section, you learn how to code the AddFirewallProxySettings() method with the 
RemoteReportProxy instance as a parameter. You also learn how to add Web proxy settings to the 
RemoteReportProxy instance.

The AddFirewallProxySettings() method is called from the 
GetReportWebServiceWithAuthentication() method.

This method runs only when you need to access the Report Web Service through a firewall proxy.

1. At the bottom of the class, create the AddFirewallProxySettings() private helper method that returns 
the RemoteReportProxy class, and pass in a Boolean variable, a string variable, and the RemoteReportProxy 
instance.

 Private Function AddFirewallProxySettings(ByVal isFirewallProxy As
Boolean, ByVal webProxyURI As String, ByVal remoteReportProxy As
RemoteReportProxy) As RemoteReportProxy
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End Function 
 private RemoteReportProxy AddFirewallProxySettings(bool
isFirewallProxy, string webProxyURI, RemoteReportProxy
remoteReportProxy)
{ }

2. Within the method, create a conditional block that tests the isFirewallProxy Boolean variable.

 If isFirewallProxy Then
End If 
 if(isFirewallProxy)
{
} 

3. Within the conditional block, declare and instantiate the WebProxy class, and pass in the webProxyURI string 
and a True Boolean value.

 Dim myWebProxy As WebProxy = New WebProxy(webProxyURI, True) 
 WebProxy webProxy = new WebProxy(webProxyURI, true); 

4. Assign the WebProxy instance to the Proxy property of the RemoteReportProxy instance that has been 
passed to the method as a parameter.

 myRemoteReportProxy.Proxy = myWebProxy 
 remoteReportProxy.Proxy = webProxy; 

5. Outside the conditional block, return the RemoteReportProxy instance.

 Return myRemoteReportProxy 
 return remoteReportProxy; 

When a False Boolean value is passed to the isFireWallProxy parameter, the firewall proxy settings are not 
added. You may test this version of your project with the simplest NT authentication configuration and with no 
firewall between the test client and the Web service.

When you test this project with a firewall, move the client application outside the firewall, and then change the 
isFireWallProxy Boolean parameter value to True. You must assign an accurate Web proxy URI value to the 
webProxyURI string parameter, and proceed to test this code through a firewall.

Related Information

Connecting to Report Web Services from a Secure Web Site [page 84]
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1.3.6.4.1.3  Testing the NT Authentication Code and the NTLM 
Credentials

1.3.6.4.1.3.1  To test NT Authentication

Before you can test the code, you must change the report binding code in the ConfigureCrystalReports() method.

● Within the ConfigureCrystalReports() method, assign a call to the 
GetReportWebServiceWithAuthentication() method to the ReportSource property of the 
CrystalReportViewer control.

 myCrystalReportViewer.ReportSource =
GetReportWebServiceWithAuthentication() 
 crystalReportViewer.ReportSource =
GetReportWebServiceWithAuthentication(); 

You are now ready to test the NT authentication code that you have added to your Web service client project.

To test the NT authentication code in the Web service client project:

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The client application connects to the Web service and, if the user name, password, and domain are correct, 
the report is displayed successfully.

4. Return to Visual Studio and click Stop to exit from debug mode.

You have just connected to the secure directory with user-specific network credentials. Now, you learn how to test 
the connection through use of NTLM credentials.

Note
To configure the firewall proxy settings, you can change the Boolean value that is passed to the 
AddFirewallProxySettings() method as a parameter.

Related Information

Server Files and NT Authentication [page 93]
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1.3.6.4.1.3.2   To test the NTLM Credentials in the Web service 
client project

1. Locate the call to the ConfigureAuthentication() method in the 
GetReportWebServiceWithAuthentication() method.

2. In the call to the ConfigureAuthentication(), change the Boolean value of the first method parameter 
from True to False.

3. From the Build menu, select Build Solution.
4. From the Debug menu, click Start.
5. The client application connects to the Web service using NTLM authentication.
6. Return to Visual Studio and click Stop to exit from debug mode.

You are now able to successfully connect from your Web service client to a Report Web Service in a secure 
directory. You have achieved this by configuring values in the RemoteReportProxy instance and passing that 
instance to the ReportSource property of the CrystalReportViewer control.

1.3.6.4.2 Server Files and NT Authentication

You can use Server Files to easily connect to reports located on a remote machine.

However, if the virtual directory that provides the reports that are stored in Server Files is protected with NT 
authentication, additional code is required in the client application to address those reports and provide the 
necessary network credentials.

Related Information

Configuring Server Files in Crystal Services [page 78]

1.3.6.4.2.1  Creating a Project to Address a Non-secure 
Directory of Server Files

To create a project that addresses a non-secure directory, you must have Server Files configured for your 
particular version of Visual Studio.

Follow the instructions in the appropriate section and make a note of the directory file path to your reports' 
directory (you will need the path for the later procedures):

● Configuring Server Files in Visual Studio .NET 2003 [page 78]
● Configuring Server Files in Visual Studio 2005 and Newer [page 81]

Go to the reports directory for your project and locate the name of a report that you want to view through the 
Server Files.
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In the next steps, the report used is the sample report named Hierarchical Grouping.rpt.

Note
The instructions below only work for a new project that you create in Project Setup [page 15].

In this section, you learn how to set the necessary network credentials.

To begin, you build a client application that accesses the reports that are stored in Server Files and allows non-
secure access to the Web service directory. Once you have verified that your client application works, you can 
then proceed to add secure access to the virtual directory, and then write additional code in the client application 
to provide credentials for NT authentication.

To build a client application to access Server File Reports:

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Locate the ConfigureCrystalReports() method that you have created in Project Setup [page 15].

4. Within the method, declare and instantiate the ServerFileReport class.

 Dim myServerFileReport As ServerFileReport = New ServerFileReport() 
 ServerFileReport serverFileReport = new ServerFileReport(); 

5. Assign the name of the report that you want to display from the report directory to the ReportPath property 
of the ServerFileReport instance.

Note
The directory is the one that you configured for Server File Reports in the Web.config file.

When you configured the viewers' virtual directory earlier, you tested the wsdl by entering a URL to the 
ServerFileReportServer.asmx Web service from the viewers' virtual directory path. In the next step, you enter 
that URL as a value in the code.

The code example below uses the Hierarchical Grouping report, which is contained within the Feature 
Examples subdirectory of the Sample Reports folder. Be sure to include the subdirectory name, followed by a 
backslash.

 myServerFileReport.ReportPath = "Feature Examples\Hierarchical
Grouping.rpt" 
 serverFileReport.ReportPath = "Feature Examples\\Hierarchical
Grouping.rpt"; 

6. Locate the correct version of the URL to the ServerFileReportService.asmx Web service, for your 
version of SAP Crystal Reports.

If you have SAP Crystal Reports, developer version for Microsoft Visual Studio installed, this will be the 
viewer's virtual directory for your installed version of SAP Crystal Reports.

If you have SAP Crystal Reports installed, and you do not have SAP Crystal Reports, developer version for 
Microsoft Visual Studio installed as well, this will be the URL to the Report Web Service that you created in 
Configuring Server Files in Visual Studio 2005 and Newer [page 81].
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7. Assign this Web service URL to the WebService property of the ServerFileReport instance.

 myServerFileReport.WebServiceUrl =
"http://localhost/CrystalReportsWebServices/ServerFileReportService.asmx" 
 serverFileReport.WebServiceUrl =
"http://localhost/CrystalReportsWebServices/ServerFileReport.asmx"; 

The ServerFileReport instance is now configured and ready to be passed to the CrystalReportViewer 
control.

8. Assign the ServerFileReport instance to the ReportSource property of the CrystalReportViewer 
control.

 myCrystalReportViewer.ReportSource = myServerFileReport 
 crystalReportViewer.ReportSource = serverFileReport; 

Related Information

Viewers' Directory [page 13]

1.3.6.4.2.2  Reconfiguring Server Files to Address a Secure 
Directory

In this section, you learn how to reconfigure the directory and the client application to address a secure directory.

To begin, you disable anonymous access to the viewers' virtual directory in Internet Information Services (IIS).

1.3.6.4.2.2.1  To disable anonymous access to the viewers' 
virtual directory in IIS

1. In Control Panel, double-click Administrative Tools, and then double-click Internet Services Manager.
2. In the Internet Information Services window, expand the top nodes, and then expand the Default Web Site 

node.
3. Locate the expected virtual directory folder, and then right-click the expected virtual directory folder to select 

Properties.
4. In the Properties dialog box, on the Directory Security tab, click Edit…
5. Clear the Anonymous Access checkbox, and then click OK.
6. Click OK to close Properties.
7. Close the Internet Information Services window.

Next, you add an <identity> tag to the Web.config file.
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Note
This Web.config file is the file that you modified earlier when you performed the Server Files configuration 
instructions.

Related Information

Viewers' Directory [page 13]

1.3.6.4.2.2.2  To add the identity tag to the Web.config file

1. Reopen the Web.config file in the Viewers' Virtual Directory.

Note
There are two Web.config files, one in the Viewers' Virtual Directory, and the other in your local Web 
application. The identity tag that you are about to add must be added to the Web.config in the Viewers' 
Virtual Directory. This is because the identity tag is required when anonymous access has been disabled 
for a virtual directory.

2. Within the <system.web> tag, at the top, enter the identity tag as shown.

<identity impersonate='true' />

3. Save the Web.config file.
4. If you have also disabled anonymous access on the virtual directory for your client Web project, add the 

identity tag to the Web.config in your client Web project as well.

Next, you modify you client Web or Windows project to access the secure Report Web Service through NT 
Authentication.

Related Information

Viewers' Directory [page 13]

1.3.6.4.2.2.3  To modify the client project to address the secure 
Viewers' virtual directory

1. Open the client Web or Windows project in Visual Studio.
2. Right-click the References folder and select Add Reference…
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3. In the Add Reference dialog box, on the .NET tab, hold down CTRL and click to select two assemblies:
○ CrystalDecisions.ReportSource
○ System.Web.Services

4. Click Select on the right side of the dialog box.
5. Verify that both assemblies have been added into the Selected Components panel, and then click OK.
6. In Solution Explorer, right-click on the bold project name and select Add, and then Add Class.
7. In the Name field, enter the class name "NTServerFileRemoteReportSource," and then click Add.

8. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of the 
class for three namespaces.

 Imports CrystalDecisions.Shared
Imports CrystalDecisions.ReportSource
Imports System.Net 
 using CrystalDecisions.Shared;
using CrystalDecisions.ReportSource;
using System.Net; 

9. Modify the NTServerFileRemoteReportSource class signature to extend the RemoteReportSource 
class.

 Public Class NTServerFileRemoteReportSource : Inherits RemoteReportSource
End Class 
 public class NTServerFileRemoteReportSource : RemoteReportSource
{
} 

Because the base class, RemoteReportSource, fails to contain a no-argument constructor, you must create a 
constructor with arguments that overrides a constructor from the RemoteReportSource base class.

10. If you are coding your project in C#, delete the default constructor created in this class.
11. Create a constructor that includes a method parameter of ServerFileReport and call the base class 

constructor, by passing in this report parameter and the Boolean value of False.

 Public Sub New(ByVal report As ServerFileReport)
    MyBase.New(report, False)
End Sub 
 public NTServerFileRemoteReportSource(ServerFileReport report) : base(report, 
false)
{
} 

12. Within the constructor, assign the static DefaultCredentials property of the CredentialCache class to the 
Credentials property of the m_proxy property of the base class.

 MyBase.m_proxy.Credentials = CredentialCache.DefaultCredentials 
 base.m_proxy.Credentials = CredentialCache.DefaultCredentials; 

13. From the File menu, click Save All.

You are now ready to edit the code-behind class for your Web or Windows form.
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1.3.6.4.2.2.4   To edit the code-behind class to address the 
remote report source

1. Return to the original Web or Windows Form.
2. From the View menu, click Code.
3. Within the ConfigureCrystalReports() method, add a new line between the setting of the 

serverFileReport.WebServiceUrl property and the setting of the ReportSource of the 
CrystalReportViewer control. In this new line, declare and instantiate the new extended class that you 
have created, and pass in as method parameter the ServerFileReport instance.

Dim myNTServerFileRemoteReportSource As NTServerFileRemoteReportSource = New 
NTServerFileRemoteReportSource(myServerFileReport)

NTServerFileRemoteReportSource ntServerFileRRS = new 
NTServerFileRemoteReportSource(serverFileReport);

4. Modify the final line of code in this method: replace the ServerFileReport instance that was assigned to the 
ReportSource of the CrystalReportViewer control with the new NTServerFileRemoteReportSource instance.

myCrystalReportViewer.ReportSource = myNTServerFileRemoteReportSource

crystalReportViewer.ReportSource = ntServerFileRRS;

You are now ready to test the client application that has been modified to pass credentials information from a 
remote report source. This modified application addresses the Server File Reports service through the viewers' 
virtual directory, which now requires NT authentication

1.3.6.4.2.2.5  To test the remote report source with credentials 
that address the secure viewers' virtual 
directory

1. From the Build menu, select Build Solution.
2. From the Debug menu, click Start.

The client application connects to the secure viewers' virtual directory and, if the new 
NTServerFileRemoteReportSource instance is configured with the correct credentials, the report is 
displayed successfully.

3. Return to Visual Studio and click Stop to exit from debug mode.

1.3.7  Security Considerations

The following scenarios should be taken into account when designing a secure application.
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Storing of Data in the Front-End Cache

Reports viewed in a web browser may contain sensitive data that a web browser may cache. Refer to Microsoft 
documentation on how to disable caching for different browsers.

Securing the Report File

SAP Crystal Reports .rpt files may contain sensitive business data. It is recommended to protect access to your 
reports by managing them with SAP BusinessObjects Business Intelligence platform server, using file security, or 
OS level encryption.

Validating User Input with Parameter Fields

Parameter fields prompt the user to provide information used to process a report. The prompt dialog validates the 
data, but there are extra steps you can take to ensure the expected values are being provided:

1. Use the prompt text to describe the type of data that is expected.
2. Specify a minimum and maximum value to limit the range of numbers to enter when working with numerical 

data.
3. Use an edit mask to request data in a specific format.
4. Build your own prompting dialog. The SAP Crystal Reports .NET SDK provides many APIs that can be used to 

build your own prompting dialog. By creating your own prompting dialog, you have full control over how 
values for parameter fields are provided by the user.

Using the ActiveX Print Control to Print Reports from a .NET Web Form Viewer

The SAP Crystal Reports .NET web form viewer lets you print the report as a PDF or using an ActiveX Print control. 
The PDF option is the default and recommended way to print a report. The ActiveX Print control was provided as 
an alternative solution that provides one-click printing. This option is not recommended as it requires 
administrative privileges to be installed. In addition, because the ActiveX control is used in a web browser, the 
killbit is not set and is considered to be less safe.

Building an Application to View Reports from SAP BusinessObjects Business 
Intelligence platform

You can use SAP Crystal Reports, developer version for Microsoft Visual Studio to create applications to view 
reports stored in a SAP BusinessObjects Business Intelligence platform system. When building applications that 
view reports stored in a SAP BusinessObjects Business Intelligence platform system, there may be security 
impacts that may need to be considered. For more information see the SAP BusinessObjects Business Intelligence 
platform Administrators Guide.
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Related Information

Filtering data with Parameters or Formulas [page 119]

1.4 Using the SDK

This section provides detailed instructions on how to use specific features of the SAP Crystal Reports .Net SDK.

1.4.1  Printing a report

The SAP Crystal Reports .NET SDK allows you to create Windows applications, or Web sites, that can print to an 
end user's local printer, or to a printer configured on your web server.

The easiest way to add printing capabilities to your SAP Crystal Reports .NET application is to use the print button 
on the CrystalReportViewer control. When users click the print button on the toolbar, the standard system print 
dialog box appears. Custom print settings can be specified through this dialog.

The SAP Crystal Reports .NET SDK allows you to configure print options and call a printer from code, rather than 
from the SAP Crystal Reports UI. Use the PrintOptions class and the PrintToPrinter method of 
ReportDocument object model.

Classes used for printing reports

● CrystalDecisions.CrystalReports.Engine.ReportDocument
Represents a report and contains properties and methods to define, format, load, export, and print the report.

● CrystalDecisions.CrystalReports.Engine.PrintOptions
Provides properties and methods for setting the options for printing a report.

● CrystalDecisions.Windows.Forms.CrystalReportViewer
Represents the CrystalReportViewer control in a Windows Form. The CrystalReportViewer control is used to 
print reports through the UI.

● CrystalDecisions.Web.CrystalReportViewer
Provides properties, methods, and events that modify or retrieve information about how the 
CrystalReportViewer control appears and functions. The CrystalReportViewer control is used to print reports 
through the UI.

Related Information

Exporting a report [page 108]
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1.4.1.1 Printing a report from the CrystalReportViewer 
control

The easiest way to add printing capabilities to your SAP Crystal Reports .NET application is to use the print button 
on the CrystalReportViewer control. The print button is enabled on the CrystalReportViewer toolbar by default.

There are two CrystalReportViewer controls in the SAP Crystal Reports .NET SDK. For a web site, you will use the 
CrystalDecisions.Web.CrystalReportViewer class. For a Windows application, you will use the 
CrystalDecisions.Windows.Forms.CrystalReportViewer class.

Printing using the CrystalDecisions.Windows.Forms.CrystalReportViewer class

When you click the print button on the CrystalReportViewer toolbar in a Windows application, it will display the 
standard Windows print dialog. You can programmatically invoke the print dialog through the 
CrystalReportViewer.PrintReport method.

The print button can be disabled in a Windows application by setting the 
CrystalReportViewer.ShowPrintButton property to false.

Printing using the CrystalDecisions.Web.CrystalReportViewer class

The CrystalReportViewer control for Web sites supports two methods of printing: PDF and ActiveX.

PDF printing is the default setting for a web site. When you click the print button on the CrystalReportViewer 
toolbar in a web site, it will display the Print Options dialog. Enter any custom print options, and click OK. SAP 
Crystal Reports will open a new window with a PDF of your report. Print the PDF to your local printer.

When ActiveX printing is enabled, the standard Windows print dialog will be displayed when you click the print 
button. ActiveX printing requires additional setup, and may require the PrintControl.cab ActiveX plugin to be 
installed on the client machine.

The print button can be disabled in a web site by setting the CrystalReportViewer.HasPrintButton property 
to false.

Related Information

Printing a report programmatically [page 104]
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1.4.1.1.1 To Remove the Print Button from the 
CrystalReportViewer Control

You will still be able to use the SDK to print a report even if the print button is not visible.

1. Add a CrystalReportViewer control to your application.
2. Set the property that controls the visibility of the print button to false.

○ For a Windows application, set the CrystalReportViewer.ShowPrintButton property to false.
○ For a Web site, set the CrystalReportViewer.HasPrintButton property to false.

When you run your application, the print button should no longer appear on the CrystalReportViewer control.

Example
Disabling the Print button in a Windows application

 Private Sub ConfigureCrystalReports()
    CrystalReportViewer1.ShowPrintButton = False
End Sub 
 private void ConfigureCrystalReports()
{
    InitializeComponent();
    crystalReportViewer1.ShowPrintButton = false;
} 

Related Information

Printing a report [page 100]

1.4.1.1.2 To Print a Report with the 
CrystalReportViewer.PrintReport method

Ensure a printer has been configured on the client machine before attempting to print.

You can programmatically invoke the print dialog through the CrystalReportViewer.PrintReport method in 
a Windows application. Use this method to print when the CrystalReportViewer toolbar is hidden, or in an 
application that uses custom toolbar buttons.

1. Add a CrystalReportViewer control to your Windows form.
2. Configure a valid report source and bind the report source to the CrystalReportViewer control.
3. Call the PrintReport method to invoke the default print dialog.

Example
 Private Sub PrintReport()
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    CrystalReportViewer.PrintReport()
End Sub 
 private void PrintReport()
{
    crystalReportViewer.PrintReport();
} 

1.4.1.1.3 To enable ActiveX printing in a Web site

If ActiveX printing is enabled, the standard system print dialog will be displayed when users click the print button. 
ActiveX printing requires additional setup, and may require the PrintControl.cab ActiveX plugin to be installed 
on the client machine.

1. Add a CrystalReportViewer control to your application.
2. Set the print mode property of the CrystalReportViewer control to ActiveX.

 CrystalReportViewer1.PrintMode = PrintMode.ActiveX 
 CrystalReportViewer1.PrintMode = PrintMode.ActiveX; 

3. In your Web.Config file, add a reference to the PrintControl.cab ActiveX control.

   <configSections>
    <section group name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="printControl" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections>
  <businessObjects>
    <crystalReports>
      <printControl>
        <add key="url" value="http://localhost/PrintControl.cab" />
      </printControl>
    </crystalReports>
  </businessObjects> 

Replace localhost with the address of your web server.

The printControl element allows you to print the report directly to your local printer. By default, this control is 
not installed on your local machine and must be downloaded separately. This setting makes the .cab file 
visible to your SAP Crystal Reports .NET website.

The CrystalReportViewer control should now use the Windows print dialog instead of PDF printing. The first time a 
user attempts to print from the SAP Crystal Reports web site, they may be prompted to install the 
PrintControl.cab ActiveX plugin.

Related Information

Configuring your Web.Config file [page 18]
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1.4.1.2 Printing a report programmatically

You can configure print options and call a printer programmatically. To do this, you use the PrintOptions class 
and the PrintToPrinter method of ReportDocument object model.

If the Print button on the toolbar of the CrystalReportViewer control meets your printing needs, then you do not 
need to write code to configure additional print options.

However, a code-based approach to printing reports is useful in specialized scenarios:

● You can control when, where, and how printing occurs. Disable the Print button in the toolbar of the 
CrystalReportViewer control and manage all printing through code.

● You can print a report in the background, without displaying it. Print settings are accessed through the 
ReportDocument class, which can be instantiated and configured without ever displaying the report with a 
CrystalReportViewer control.

● You can centralize all printing on the Web server for a Web client. Use the PrintToPrinter() method to 
send print jobs to a printer that is connected to the Web server, rather than send print jobs to a local printer 
that is connected to the Web client.

Note
Printing programmatically using the ReportDocument object model is less extensive than the report scheduling 
framework that is provided with SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence 
platform.

Programmatic Printing from a Web application

If you use the ReportDocument.PrintToPrinter method in a Web Application, the report will be printed from 
the web server, not from the client machine. All client side printing uses the CrystalReportViewer control.

Related Information

Printing a report from the CrystalReportViewer control [page 101]

1.4.1.2.1 Setting custom print options with the 
ReportDocument object model

The PrintOptions class allows you to specify additional settings prior to printing a report programmatically. 
Through the PrintOptions class, you can do the following:

● Change the current paper source.
● Determine the height, or width, of the printed output.
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● Adjust page margins.
● Force duplex or simplex printing.
● Change the default printer.

To make changes to the print options for a report, you must retrieve a PrintOptions object through the 
PrintOptions property of the ReportDocument class.

Copying print options

Print options can be copied from, or to, the defaults for the local system using the PrintOptions.CopyFrom or 
PrintOptions.CopyTo methods.

For more information on the PrintOptions class, see the SAP Crystal Reports .NET API Reference.

Example
Force Duplex Printing

This example sets the default print mode to Duplex.

 Private Sub enableDuplex(ByVal rd As ReportDocument)
    rd.PrintOptions.PrinterDuplex = PrinterDuplex.Vertical
End Sub 
 private void enableDuplex(ReportDocument rd)
{
    rd.PrintOptions.PrinterDuplex = PrinterDuplex.Vertical;
} 

1.4.1.2.2 To print a report to the default printer

The ReportDocument.PrintToPrinter method will send a report to the default printer specified in the report 
file. To send the report to the default printer specified on the client machine, you must set the 
PrintOptions.PrinterName property before printing the report.

1. Create a new instance of the PrintDocument class.

The default printer for the client machine is specified in the PrinterSettings.PrinterName property of 
any new PrintDocument class.

 Dim localPrinter As System.Drawing.Printing.PrintDocument = New PrintDocument() 
 System.Drawing.Printing.PrintDocument localPrinter = new PrintDocument(); 

2. Set the PrinterName property of the ReportDocument object to the value specified in 
PrinterSettings.PrinterName.

 rd.PrintOptions.PrinterName = localPrinter.PrinterSettings.PrinterName 
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rd.PrintOptions.PrinterName = localPrinter.PrinterSettings.PrinterName; 
3. Call the ReportDocument.PrintToPrinter method to print the report.

 rd.PrintToPrinter(1, False, 0, 0) 
 rd.PrintToPrinter(1, false, 0, 0); 

This PrintToPrinter method takes four parameters: the number of copies to print, whether to collate the 
pages or not, the start page, and the end page.

Tip
To print all pages, set the start page and end page parameters to zero.

Example
 Private Sub printReport(ByVal rd As ReportDocument)
    Dim localPrinter As System.Drawing.Printing.PrintDocument = New 
PrintDocument()
    rd.PrintOptions.PrinterName = localPrinter.PrinterSettings.PrinterName
    rd.PrintToPrinter(1, False, 0, 0)
End Sub 
 private void printReport(ReportDocument rd) {
    System.Drawing.Printing.PrintDocument localPrinter = new PrintDocument();
    rd.PrintOptions.PrinterName = localPrinter.PrinterSettings.PrinterName;
    rd.PrintToPrinter(1, false, 0, 0);
} 

1.4.1.2.3 To print a report to a file

You can print a report to a file on your local system by changing the default PrinterSettings properties, and 
calling the ReportDocument.PrintToPrinter method. To save a report to disk for later viewing, or to save a 
report in a different format, export the report instead of printing to a file.

1. Create a new instance of the PrinterSettings and PageSettings classes.

 Dim printerSettings As New PrinterSettings()
Dim pageSettings As New PageSettings() 
 PrinterSettings printerSettings = new PrinterSettings();
PageSettings pageSettings = new PageSettings(); 

2. Copy the settings from the ReportDocument object to the PrinterSettings and the PageSettings 
objects.

 rd.PrintOptions.CopyTo(printerSettings, pageSettings) 
 rd.PrintOptions.CopyTo(printerSettings, pageSettings); 
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3. Set the PrintToFile property of the PrinterSettings object to true.

 printerSettings.PrintToFile = True 
 printerSettings.PrintToFile = true; 

4. Set the location for the output file.

 printerSettings.PrintFileName = "c:\outputFile.prn" 
 printerSettings.PrintFileName = "c:\\outputFile.prn"; 

Note
When printing to a file, the format of the output file is determined by the printer. Your printer may create 
XPS files, PS files or some other format. Consult the manufacturers manual for more information.

5. Call the ReportDocument.PrintToPrinter method to print the report.

This PrintToPrinter method takes three parameters: the printing options, the page settings, and a boolean 
value that indicates if the report needs to be reformatted to fit within the page settings.

 rd.PrintToPrinter(printerSettings, pageSettings, False) 
 rd.PrintToPrinter(printerSettings, pageSettings, false); 

Example
 Private Sub printToFile(ByVal rd As ReportDocument)
    Dim printerSettings As New PrinterSettings()
    Dim pageSettings As New PageSettings()
    rd.PrintOptions.CopyTo(printerSettings, pageSettings)
    printerSettings.PrintToFile = True
    printerSettings.PrintFileName = "c:\outputFile.prn"
    rd.PrintToPrinter(printerSettings, pageSettings, False)
End Sub 
 private void printToFile(ReportDocument rd)
{
    PrinterSettings printerSettings = new PrinterSettings();
    PageSettings pageSettings = new PageSettings();
    rd.PrintOptions.CopyTo(printerSettings, pageSettings);
    printerSettings.PrintToFile = true;
    printerSettings.PrintFileName = "c:\\outputFile.prn";
    rd.PrintToPrinter(printerSettings, pageSettings, false);
} 

Related Information

Exporting a report [page 108]
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1.4.1.3 To remove the default printer driver from your report

1. In Solution Explorer, double-click your report.

2. Right-click on any open area of the report and select Designer Printer Setup .
3. In the Print Setup dialog box, select No Printer, and then click OK.

4. Click File Save All .

Related Information

Select the No Printer Option Under Print Setup [page 68]

1.4.2  Exporting a report

SAP Crystal Reports allows you to export a report to a variety of formats. The formats available depend upon the 
version of SAP Crystal Reports that you have installed, and the method used to export the report.

A report can be exported to disk, to a browser window, or to the input/output stream as a sequence of bytes.

Classes used for exporting reports

● CrystalDecisions.CrystalReports.Engine.ReportDocument
Represents a report and contains properties and methods to define, format, load, export, and print the report.

● CrystalDecisions.Shared
Contains several classes used to specify export options for different output formats.

● CrystalDecisions.Shared.ExportOptions
Provides properties for retrieving and setting options for exporting your report.

Related Information

Printing a report [page 100]
Export Dialog Box [page 758]

1.4.2.1 Available export formats

Export formats supported by SAP Crystal Reports can be broadly categorized into two groups: page-based 
formats and record-based formats. Page-based formats put more importance on look and feel, and therefore they 
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tend to produce an output that closely matches the layout and formatting of the original. Record-based formats 
focus on accurate data representation rather than layout and formatting.

Format Description

SAP Crystal Reports (RPT) Exporting to SAP Crystal Reports format is much like using 
the Save As feature with the Save Data with Report option 
selected. This format exports (saves) your report with the 
current data without modifying the original report. If a report 
source is a SAP Crystal Reports Read-Only file (RPTR) file, 
you cannot export to SAP Crystal Reports (RPT).

SAP Crystal Reports Read-Only (RPTR) Exports (saves) your report with the current data without 
modifying the original report. RPTR reports are Crystal 
reports that can be viewed with report viewer applications, 
but cannot be modified with the SDK or opened by report 
designer applications. The definition of an RPTR report 
cannot be modified, so you cannot use this SDK to set the 
data source location of an RPTR through the database 
controller. However, you can refresh the data of an RPTR 
report at run time by refreshing the report in a viewer.

HTML 4.0 Exports the report in HTML 4.0. This format preserves the 
layout and formatting of the report by using DHTML.

Microsoft Excel (97-2003) This format converts your report contents into Excel cells on 
a page-by-page basis. Contents from multiple pages are 
exported to the same Excel worksheet. If a worksheet 
becomes full and there is more data to export, the export 
program creates multiple worksheets to accommodate the 
data. If a report object covers more than one cell, the export 
program merges cells to represent a report object. Microsoft 
Excel has a limit of 256 columns in a worksheet; therefore, 
any report object (or part of it) that is added to cells beyond 
256 columns is not exported. This export format retains most 
of the formatting, but it does not export line and box objects 
from your report.

Microsoft Excel (97-2003) Data-Only Microsoft Excel Data-only, as the name suggests, is a record-
based format that focuses on the accurate representation of 
data. Even so, this format does export most of the formatting 
too. Unlike Microsoft Excel format, Microsoft Excel Data-only 
format does not merge cells—each object is added to only 
one cell. This format can also export certain kinds of 
summaries in Crystal reports as Excel functions. The 
summaries that are supported are SUM, AVERAGE, COUNT, 
MIN and MAX.

Microsoft Excel 2007 (XLSX) Data-Only The XLSX format has the same properties as the Microsoft 
Excel (97-2003) Data-Only format, however XLSX format 
allows for up to 16385 columns and 1,048,576 rows in a 
single workbook.

Microsoft Word (97-2003) Produces an RTF (Rich Text Format) file that contains text 
and drawing objects to represent report objects. Almost all 
the formatting is retained in this export format. Text objects 
cannot, however, be placed outside the left edge of the page. 
Therefore, if you have text objects in your report that are 
placed before the left edge of the printable area, they will be 
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Format Description

pushed right. (This is most noticeable in reports with wide 
pages.)

Microsoft Word (97-2003) - Editable The Microsoft Word - Editable format is different from the 
Microsoft Word format: it is a page-based format, but not all 
the layout and formatting are preserved in the output. This 
format converts all of the report object contents to text lines. 
Unlike Microsoft Word format, this format does not use text 
frames. Text formatting is retained, but attributes such as 
background color, fill pattern, and so on may not be retained. 
All images in your report are inlined with the textual content 
and, therefore, the images automatically shift to 
accommodate text when the document is edited in Microsoft 
Word. This format does not export line and box objects from 
your report. As well, the special fields Page Number and Page 
N of M do not work when exported in this format.

ODBC ODBC is a record-based, data-exchange format. When you 
use this format, you can export your report data to any 
ODBC-compliant database.

PDF The exported documents are intended for printing and 
redistribution. PDF format will export both layout and 
formatting in a manner that is consistent with how the report 
looks on the Preview tab. PDF format embeds the TrueType 
fonts that appear in the document. (Non-TrueType fonts are 
not supported.) This export format does not support 
Microsoft font-linking technology, which is used to provide 
support for some extended character sets such as Chinese 
HKCS. Therefore, the fonts used in the report must contain 
all of the required glyphs. The following URI types are 
supported for hyperlinks: http, https and mailto.

Record Style - Columns with Spaces Exports report data as text. This format inserts spaces 
between columns.

Record Style - Columns without Spaces Exports report data as text. Does not insert spaces between 
columns.

Report Definition The Report Definition format exports your report to a text file 
that contains a brief description of the report's design view. 
This format is maintained only for compatibility with SAP 
Crystal Reports 5.0.

Rich Text Format (RTF) Produces an RTF file that contains text and drawing objects.

Seperated Values (CSV) The Separated Values format is a record-based, data-
exchange format. It exports the report object contents as a 
set of values separated by separator and delimiter characters 
that you specify. (When a comma (,) is used to separate 
fields, the format is known as Comma Separated Values 
(CSV); this export format is popular among Microsoft Excel 
users.)

Tab Separated Text (TTX) Preserves the layout of your report but with some 
differences: multi-line text objects are exported in a single 
line, all string values are surrounded by double quotes (""), 
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Format Description

and the values themselves are separated by tab characters. 
TTX files can be opened in Microsoft Excel.

Text Ouputs to plain text (does not retain formatting).

XML Used primarily for data exchange. This format produces XML 
using the SAP Crystal Reports XML schema.

Choosing an export format

The formats available depend upon the version of SAP Crystal Reports that you have installed, and the method 
used to export the report. The CrystalReportViewer control offers most export formats by default. Some formats 
are only available when using the SAP Crystal Reports .NET SDK, or the standalone SAP Crystal Reports Designer.

Format CrystalReportViewer Control SAP Crystal Reports .NET SDK SAP Crystal Reports Designer

SAP Crystal Reports (RPT) x x x

SAP Crystal Reports Read-
Only (RPTR)

x x x

HTML 4.0 x x

Microsoft Excel (97-2003) x x x

Microsoft Excel (97-2003) 
Data Only

x x x

Microsoft Excel 2007(XLSX) 
Data Only

x x x

Microsoft Word (97-2003) x x x

Microsoft Word (97-2003) - 
Editable

x x x

ODBC x

PDF x x x

Record Style - Columns with 
Spaces

x

Record Style - Columns 
without Spaces

x

Report Definition x

Rich Text Format (RTF) x x x

Seperated Values (CSV) x x

Tab Separated Text (TTX) x x

Text x x

XML x x x
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1.4.2.2 Exporting a report from the CrystalReportViewer 
control

The easiest way to add exporting capabilities to your SAP Crystal Reports .NET application is to use the export 
button on the CrystalReportViewer control. The Export button is enabled on the CrystalReportViewer toolbar by 
default.

A user can click the Export button to bring up the default export dialog box. The export options available to your 
user are determined by which drivers are included in your deployment.

Disabling the ability to Export a report from the Viewer

Exporting is enabled on all SAP Crystal Reports applications by default. You can restrict exporting in two ways:

● Remove the Export button from the viewer.
You will still be able to use the SDK to export a report even if the export button is not visible.

● Disabling specific export drivers in the SAP Crystal Reports merge modules.
When you deploy a SAP Crystal Reports application to a target machine, you must include the SAP Crystal 
Reports runtime in the form of an MSI or a Merge Module. If you choose to use Merge Modules for your 
deployment, you can specify which export drivers to include or exclude.

Related Information

Export Dialog Box [page 758]

1.4.2.2.1 To remove the export button from the 
CrystalReportViewer control

You will still be able to use the SDK to export a report even if the export button is not visible.

1. Add a CrystalReportViewer control to your application.
2. Set the property that controls the visibility of the export button to false.

○ For a Windows application, set the CrystalReportViewer.ShowExportButton property to false.
○ For a Web site, set the CrystalReportViewer.HasExportButton property to false.

When you run your application, the export button should no longer appear on the CrystalReportViewer control.

Example
Disabling the Export button in a Web application

 Private Sub ConfigureCrystalReports()
    CrystalReportViewer1.HasExportButton = False
End Sub
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 private void ConfigureCrystalReports()
{
    InitializeComponent();
    crystalReportViewer1.HasExportButton = false;
} 

1.4.2.3 Exporting a report programmatically

The SAP Crystal Reports .NET SDK allows you to programmatically export a report to a larger number of formats 
and destinations than the CrystalReportViewer control allows.

If the Export button on the toolbar of the CrystalReportViewer control meets your exporting needs, then you do 
not need to write code to configure additional export options.

However, a code-based approach to printing reports is useful in specialized scenarios:

● You can control when, where, and how exporting occurs. Disable the Export button in the toolbar of the 
CrystalReportViewer control and manage all exporting through code.

● You can export a report in the background, without displaying it.
● You can export a report to HTTP Response, or to Stream. the CrystalReportViewer control only supports 

exporting a report to disk.

There are four methods that for exporting a report. All of the methods are accessed through the 
ReportDocument class.

● ReportDocument.Export
● ReportDocument.ExportToHTTPResponse
● ReportDocument.ExportToDisk
● ReportDocument.ExportToStream

The most general method, ReportDocument.Export, allows you to export your report to any format and 
location supported by the SAP Crystal Reports .NET SDK. In order to use the ReportDocument.Export method, 
you must first set a number of parameters through the ExportOptions class.

Each of the other three methods provide a convenient way to export a report in a particular way. Using one of the 
other methods will generally result in less code, but offers less control over the resulting file.

1.4.2.3.1 Setting custom export options

In order to use the ReportDocument.Export method, you must first set a number of parameters through the 
ExportOptions class. These parameters control the export location, the export format, and several output-
specific style options.

There are four options that must be set in order to export a report using the ReportDocument.Export method.
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Export Option Description

ExportDestinationType Determines how to export the report.

ExportDestinationOptions Determines the location and name of the resulting file.

ExportFormatOptions Determines output-specific formatting options.

ExportFormatType Determines the destination file type.

Setting the ExportDestinationType property 

The ExportOptions.ExportDestinationType property determines how to export the report. Available values 
are stored in the ExportDestinationType enumeration. The most common value is 
ExportDestinationType.DiskFile. Other supported values include ExchangeFolder, MicrosoftMail and 
NoDestination.

Setting the ExportDestinationOptions property

The ExportOptions.ExportDestinationOptions property sets options specific to the target location of the 
output file. The value of the ExportDestinationOptions property will depend upon the value of the 
ExportOptions.ExportDestinationType property.

ExportDestinationType ExportDestinationOptions Sets the following values

DiskFile A DiskFileDestinationOptions 
object

● Sets the name and location of the 
output file.

ExchangeFolder An 
ExchangeFolderDestinationOp
tions object

● The user profile and password for 
the exchange server.

● The path to the exchange folder.

MicrosoftMail A 
MicrosoftMailDestinationOpt
ions object

● The user name and password for 
the email account.

● The subject and body of the email 
message.

● The recipients of the email 
message.

Setting the ExportFormatType property 

This property determines the file format of the output file. Available values are stored in the ExportFormatType 
enumeration. The options available are determined by the version of SAP Crystal Reports that you are using.

SAP Crystal Reports, developer version for Microsoft Visual Studiosupports the following export options:
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● SAP Crystal Reports (RPT)
● SAP Crystal Reports Read-Only (RPTR)
● PDF
● Rich Text Format (RTF)
● Microsoft Word (97-2003)
● Microsoft Excel (97-2003)
● Microsoft Excel (97-2003) Data-Only
● Microsoft Excel (2007) Data-Only
● HTML 4.0
● Seperated Values (CSV)
● Microsoft Word - Editable (RTF)
● Tab Separated Text (TTX)
● Text

Setting the ExportFormatOptions property 

The ExportOptions.ExportFormatOptions property sets options specific to the format of the output file. The 
value of the ExportFormatOptions property will depend upon the value of the 
ExportOptions.ExportFormatType property.

ExportFormatOptions Export Format Sets the following values

An ExcelFormatOptions object ● Microsoft Excel (97-2003)
● Microsoft Excel (97-2003) Data-

Only

● The first and last page of the report 
to export.

● The default column width.
● Whether or not to include column 

headings.

An HTMLFormatOptions object ● HTML 4.0 ● The first and last page of the report 
to export.

● The name of the default HTML 
page.

● The name of the folder that 
contains the supporting files 
needed for HTML output, such as 
the images used in the report.

A PdfRtfWordFormatOptions 
object

● PDF
● Rich Text Format (RTF)
● Microsoft Word (97-2003)
● Microsoft Word - Editable (RTF)

● The first and last page of the report 
to export.

Example
Setting the export options for Microsoft Excel - Data Only

This example sets the export options required to export a report in the “Microsoft Excel - Data Only” format.

The method instantiates a new DiskFileDestinationOptions class, and assigns a file path to the 
DiskFileDestinationOptions.DiskFileName property. To export the file to disk, the 
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ExportOptions.ExportDestinationType property must be set to ExportDestinationType.DiskFile, 
and the ExportOptions.DestinationOptions is set to a valid DiskFileDestinationOptions object.

If no special formatting is required, the ExportOptions.ExportFormatOptions can be set to null.

Private Function ConfigureExportToExcelRecord(ByVal filepath As String) As 
ExportOptions     Dim exOptions As New ExportOptions()
    
    Dim dfDestinationOptions As New DiskFileDestinationOptions()
    dfDestinationOptions.DiskFileName = filepath
    
    exOptions.ExportDestinationType = ExportDestinationType.DiskFile
    exOptions.DestinationOptions = dfDestinationOptions
    exOptions.ExportFormatType = ExportFormatType.ExcelRecord
    exOptions.ExportFormatOptions = Nothing
    Return exOptions
End Function 

private ExportOptions ConfigureExportToExcelRecord(String filepath) {
    ExportOptions exOptions = new ExportOptions();
    
    DiskFileDestinationOptions dfDestinationOptions = new 
DiskFileDestinationOptions();
    dfDestinationOptions.DiskFileName = filepath;
    
    exOptions.ExportDestinationType = ExportDestinationType.DiskFile;
    exOptions.DestinationOptions = dfDestinationOptions;
    exOptions.ExportFormatType = ExportFormatType.ExcelRecord;
    exOptions.ExportFormatOptions = null;
    return exOptions;
} 

Example
Setting the export options for HTML 4.0 output

This example sets the export options required to export a report in the “HTML 4.0” format.

When exporting as HTML, you do not need to instantiate a DiskFileDestinationOptions class. Instead, 
these options are set through the HTMLFormatOptions class.

This method instantiates a new HTMLFormatOptions class, and assigns the default file name to the 
HTMLFormatOptions.HTMLFileName property, and the default export path to the 
HTMLFormatOptions.HTMLBaseFolderName property. The base folder contains each of the HTML pages 
exported by the report, as well as all required images.

Set the ExportOptions.ExportFormatOptions property to a valid HTMLFormatOptions object.

Private Function ConfigureExportToHtml40(ByVal exportpath As String) As 
ExportOptions     Dim exOptions As New ExportOptions()
    
    Dim html40FormatOptions As New HTMLFormatOptions()
    html40FormatOptions.HTMLBaseFolderName = exportpath
    html40FormatOptions.HTMLFileName = "default.html"
    html40FormatOptions.HTMLEnableSeparatedPages = True
    html40FormatOptions.HTMLHasPageNavigator = True
    
    exOptions.ExportFormatType = ExportFormatType.HTML40
    exOptions.ExportFormatOptions = html40FormatOptions
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    Return exOptions
End Function 

private ExportOptions ConfigureExportToHtml40(String exportpath) {
    ExportOptions exOptions = new ExportOptions();
    HTMLFormatOptions html40FormatOptions = new HTMLFormatOptions();
    html40FormatOptions.HTMLBaseFolderName = exportpath;
    html40FormatOptions.HTMLFileName = "default.html";
    html40FormatOptions.HTMLEnableSeparatedPages = true;
    html40FormatOptions.HTMLHasPageNavigator = true;
    exOptions.ExportFormatType = ExportFormatType.HTML40;
    exOptions.ExportFormatOptions = html40FormatOptions;
    return exOptions;
} 

Related Information

Available export formats [page 108]

1.4.2.3.2 To export to disk with custom export options

This sample shows how to export a Crystal Report to Microsoft Word format. The SAP Crystal Reports 2008 SDK 
enables you to export reports to a specific format, such as Excel, PDF or RTF. You can export reports to various 
formats using the ReportDocument object model.

This example sets the ReportDocument.ExportOptions property, and uses the ReportDocument.Export 
method to export the report.

1. Create a method that takes a ReportDocument object and a file path as parameters.

2. Create a new instance of the DiskFileDestinationOptions class and set the value of the 
DiskFileDestinationOptions.DiskFileName property to the output file path.

 Dim dfDestinationOptions As New DiskFileDestinationOptions()
dfDestinationOptions.DiskFileName = filepath 
 DiskFileDestinationOptions dfDestinationOptions = new 
DiskFileDestinationOptions();
dfDestinationOptions.DiskFileName = filepath; 

3. Create a new instance of the ExportOptions class and set the required properties.

a. Set the ExportDestinationType property to ExportDestinationType.DiskFile.
b. Set the ExportDestinationOptions property to the DiskFileDestinationOptions object.
c. Set the ExportFormatType property to ExportFormatType.WordForWindows.
d. If no special formatting is required, the ExportOptions.ExportFormatOptions can be set to null.

 Dim wordExportOptions As New ExportOptions()
wordExportOptions.ExportDestinationType = ExportDestinationType.DiskFile
wordExportOptions.ExportDestinationOptions = dfDestinationOptions
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wordExportOptions.ExportFormatType = ExportFormatType.WordForWindows
wordExportOptions.ExportFormatOptions = Nothing 
 ExportOptions wordExportOptions = new ExportOptions();
wordExportOptions.ExportDestinationType = ExportDestinationType.DiskFile;
wordExportOptions.ExportDestinationOptions = dfDestinationOptions;
wordExportOptions.ExportFormatType = ExportFormatType.WordForWindows;
wordExportOptions.ExportFormatOptions = null; 

4. Call the Export method, and pass the ExportOptions object as a parameter.

Example

Private Sub ExportToWord_RD(ByVal rd As ReportDocument, ByVal filepath As String)     Dim dfDestinationOptions As New DiskFileDestinationOptions()
    dfDestinationOptions.DiskFileName = filepath
    
    Dim wordExportOptions As New ExportOptions()
    wordExportOptions.ExportDestinationType = ExportDestinationType.DiskFile
    wordExportOptions.ExportDestinationOptions = dfDestinationOptions
    wordExportOptions.ExportFormatType = ExportFormatType.WordForWindows
    wordExportOptions.ExportFormatOptions = Nothing
    
    rd.Export(wordExportOptions)
End Sub 
 private void ExportToWord_RD(ReportDocument rd, String filepath)
{
    DiskFileDestinationOptions dfDestinationOptions = new 
DiskFileDestinationOptions();
    dfDestinationOptions.DiskFileName = filepath;
    ExportOptions wordExportOptions = new ExportOptions();
    wordExportOptions.ExportDestinationType = ExportDestinationType.DiskFile;
    wordExportOptions.ExportDestinationOptions = dfDestinationOptions;
    wordExportOptions.ExportFormatType = ExportFormatType.WordForWindows;
    wordExportOptions.ExportFormatOptions = null;
    rd.Export(wordExportOptions);
} 

1.4.2.3.3 To export to disk as a PDF using the 
ReportDocument.ExportToDisk method

This sample shows how to export a Crystal report to PDF format. The SAP Crystal Reports 2008 SDK enables you 
to export reports to a specific format, such as Excel, PDF or RTF. You can export reports to various formats using 
the ReportDocument object model.

1. Create a method that takes a ReportDocument object as a parameter.

2. Specify an output directory and test if it exists. If the output directory does not exist, create it.
3. Call the ExportToDisk method, and specify the output format and output file name.

Example

Private Shared Sub ExportToPDF_RD(ByVal rd As ReportDocument)     Dim exportPath As String =  "C:\\Exported\\" 
    If Not System.IO.Directory.Exists(exportPath) Then
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        System.IO.Directory.CreateDirectory(exportPath)
    End If
    rd.ExportToDisk(ExportFormatType.PortableDocFormat, exportPath + 
"PortableDoc.pdf")
End Sub 

private static void ExportToPDF_RD(ReportDocument rd) {     String exportPath = "C:\\Exported\\";
    if (!System.IO.Directory.Exists(exportPath))
    {
        System.IO.Directory.CreateDirectory(exportPath);
    }
    rd.ExportToDisk(ExportFormatType.PortableDocFormat, exportPath + 
"PortableDoc.pdf");
} 

Related Information

ReportDocument Object Model [page 34]

1.4.3  Filtering data with Parameters or Formulas

SAP Crystal Reports lets you customize the data in your report through report parameters, or by changing the 
Selection Formula.

A parameter is a report variable that is set by the user and instantiated when the report is refreshed. When a 
parameter is used in a selection formula, it enables you to change the data that is included in your report at run 
time. Parameters can also be used to customize the appearance of a report.

Selection formulas specify and filter the records and groups that appear in a report. By changing the selection 
formula, you alter the query that is used when fetching data from the data source.

Classes used for setting parameters or formulas

● CrystalDecisions.CrystalReports.Engine.DataDefinition
Contains all the information relating to data manipulation based on the data source in a report.

● CrystalDecisions.CrystalReports.Engine.ParameterFieldDefinition
Represents a parameter field in the report. This object provides properties and methods for retrieving 
information and setting options for a parameter field in a report.

● CrystalDecisions.Web.Parameter
Provides properties that modify or retrieve information about a parameter in a Web Site.
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1.4.3.1 Parameters

A parameter is a report variable that is set by the user and instantiated when the report is refreshed. There are 
many types of parameters, and programmatically setting different types can result in different behaviors and 
experiences for users of your application.

Best practices for working with parameters

To avoid runtime errors when setting parameters programmatically, note the following:

● Parameter values must be of the same type as the parameter.
● If the parameter has an edit mask, the values for the parameter should respect the mask.
● When reading parameter values, ensure that you know what type of values you are reading, that is, whether 

they are discrete or ranged.
● Set the bound type on a range value before adding it to the parameter.
● Ensure that the upper bound of a range value is larger than the lower bound.

Related Information

Setting Parameters [page 576]
Data parameters and non-data parameters [page 579]
Designing Parameter Fields [page 578]

1.4.3.1.1 Properties of parameter values

Parameters support many more features than those mentioned here. For a complete list of features, see the 
ParameterField class.

Multiple or single value parameters

If a parameter supports multiple values, a user can select more than one value for a parameter when the report is 
refreshed. If a parameter supports single values, a user can only select one value for a parameter when the report 
is refreshed. If a parameter supports multiple values, it effectively changes from a single variable to an array that 
contains many values.
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Discrete or ranged parameter values

Discrete parameter values represent a singular value, such as 1, "Jill", 3.141 or True. Ranged values represent a 
particular span of values from one point to another, such as [1..45], (4..6], ["Monday","Thursday"]. The lower 
bound value of the range must be smaller than the upper bound.

In addition, parameters can be both discrete and ranged if the parameter supports multiple values.

Default values

You can specify default values for a parameter and force the user to select one or many of them. You can also 
supply default parameter values but allow the user to enter custom values. The default values are stored in the 
DefaultValues property of the ParameterField Object. Once the user has selected a set of values for the 
report's parameters, those values are stored in the CurrentValues property.

Note
Default values can only be discrete.

Optional parameter values

If a parameter value is set to optional, users are not forced to enter a value when prompted.

Static or dynamic parameter values

Static parameter values are stored in the report. Dynamic parameter values are retrieved from a data source 
outside of the report.

Dynamic cascading parameters values

A dynamic prompt can include a cascading list of values that will lead the userthrough a sequence of dynamic 
prompts to determine a final parameter value. For example, users might first be prompted to pick a country 
before the choices for region appear.
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Interactive parameter values

Parameter values can be manipulated at runtime using the 
CrystalReportViewer.ViewTimeSelectionFormula property. The view time selection formula is applied 
after the results of selection formulas saved with the report have been applied.

Types of parameter values

A parameter field must contain a certain ParameterType.

A parameter value must be one of the following parameter types:

● ReportParameter
● StoredProcedureParameter
● QueryParameter

1.4.3.1.2 The parameter panel

Interactively format and filter report data using the Parameter Panel.

The new parameter panel in SAP Crystal Reports 2008 lets users set static and dynamic parameters and refresh 
the report. Users can also interactively format and filter report data. The parameter panel is available from the 
tool panel. You can access the parameter panel by clicking the Parameters button on the toolbar or 
programmatically by using the following code:

myCrystalReportViewer.ToolPanelView = ToolPanelViewType.ParameterPanel

crystalReportViewer.ToolPanelView = ToolPanelViewType.ParameterPanel;

You can hide the Parameters button programmatically by using the following code:

myCrystalReportViewer.ShowParameterPanelButton = False

crystalReportViewer.ShowParameterPanelButton = false;

The panel displays all parameters that have been set to Editable or Read only. If a parameter is set to Editable, you 
can add, delete or modify parameter values by clicking the Show the Advanced dialog box button. If the parameter 
values are modified but not applied, an asterisk will appear beside the parameter field to indicate that the values 
were not applied to the report.

Note
If the parameter accepts custom values, you can directly edit the parameter value in the text box on the 
parameter panel.

A database icon will appear adjacent to data parameters. When you modify the value of a data parameter, the 
report refreshes and accesses the database to make the corresponding changes. When you modify the value of a 
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non-data parameter, the report is formatted or filtered based on saved data within the report. The report does not 
access the database.

Related Information

Filtering report data with selection formulas [page 129]

1.4.3.1.3 To set Parameters in the ASPX page

When you create a Crystal report, data selection for the report is controlled by the "where" criteria. The value for 
the "where" criteria can be a hard-coded value. But when the value must be dynamic, a parameter is created and 
the "where" clause is assigned to the parameter. Parameters are handled differently, depending on whether you 
develop with a coding model or a reduced-code model.

When you develop with a coding model, Crystal Reports, developer version for Microsoft Visual Studio accesses 
and interacts with parameters through a group of parameter-related classes in the SAP Crystal Reports SDK.

When you develop with a reduced-code model (the tag-based application model), the CrystalReportSource 
control accesses and interacts with parameters through use of the Parameters framework. The Parameters 
framework is new to ASP.NET version 2.0. It allows parameters to be assigned to any DataSource control (in this 
case, a CrystalReportSource control.) These parameters can be assigned to both the main report and any 
subreport, should they require parameters.

A parameter is assigned from any of the following parameter types:

● ControlParameter
● QueryStringParameter
● SessionParameter
● FormParameter
● CookieParameter

This parameter assignment enables you to create a reduced-code solution, where a report's parameters can be 
set from selections made in DropDownList controls (or other types of controls), values in the URL query string, 
values retrieved from Session, posted values from form fields, or values from a Cookie.

Setting Parameters Directly in the XML

In XML, the <Parameters> tag is nested within the <CrystalReportSource> tag. Within the nested 
<Parameters> tag, links to a default parameter or a parameter from a control can be configured.
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Example
Setting a parameter in the XML

This example sets the default value of the City parameter to Tokyo.

 <CR:CrystalReportSource ID="CrystalReportSource1" 
     runat="server">
    <Report FileName="SalesReport.rpt">
        <Parameters>
            <CR:Parameter ConvertEmptyStringToNull="False" 
                DefaultValue="Tokyo" Name="City" ReportName="" />
        </Parameters>
    </Report>
</CR:CrystalReportSource> 

Example
Binding a parameter to a control

You can bind the value of a parameter to another control within the web form. This example sets the value of a 
parameter named City to the value of a textbox control named Location.
 <CR:CrystalReportSource ID="CrystalReportSource1"
        runat="server">
    <Report FileName="SalesReport.rpt">
        <Parameters>
        <CR:ControlParameter ControlID="Location"
            ConvertEmptyStringToNull="False"
            Name="city" PropertyName="Text" ReportName="" />
        </Parameters>
    </Report>
</CR:CrystalReportSource>            

Related Information

Setting Parameters [page 576]

1.4.3.1.3.1  Access the Parameter Collection Editor dialog box

Parameters are configured in the Parameter Collection Editor dialog box.

1. Select the CrystalReportSource control.
2. From Properties, expand Report.
3. Within the Report property, click the ellipsis ( ...) on the far right of Parameters (Collection).
4. In the Parameters Collection Editor dialog box, enter one or more parameters for the main report, as well as 

for any sub reports.
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1.4.3.1.4 To set discrete parameters in a report

This sample sets the parameters to specific values that are used by the sample report.

You must have a report with a parameter field already specified.

Using the ReportDocument object model, you can set the parameter values for existing parameters in a report. 
Parameters are accessed by name, or by a numerical index value. To add a new parameter to a report, you must 
use the ReportClientDocument object model.

1. Creates a new string constant, PARAMETER_FIELD_NAME, and sets its value to the name of an existing 
parameter.

2. Create an instance of the ArrayList class.

3. For each value that you would like to assign to the parameter, add a value to the ArrayList instance.
4. Call the ReportDocument.SetParameterValue method and pass the parameter name and list of values.

The ReportDocument.SetParameterValue method sets the current value of a parameter field. The value 
can be a primitive, ParameterValue, an array of either type, or a ParameterValues collection.

Example
Setting discrete parameters in a report

Private Sub SettingParameters_RD(ByVal TestReport As ReportDocument)     Dim PARAMETER_FIELD_NAME As String = "Country"
    Dim countries As New ArrayList()
    countries.Add("Canada")
    countries.Add("USA")
    TestReport.SetParameterValue(PARAMETER_FIELD_NAME, countries.ToArray())
    crystalReportViewer.ReportSource = TestReport
End Sub 

private void SettingParameters_RD(ReportDocument TestReport) {
  string PARAMETER_FIELD_NAME = "Country";
  ArrayList countries = new ArrayList();
  countries.Add("Canada");
  countries.Add("USA");
  TestReport.SetParameterValue(PARAMETER_FIELD_NAME, countries.ToArray());
  crystalReportViewer.ReportSource = TestReport; }

A SAP Crystal Reports Web Site may require additional code to manage session state between page views.

Related Information

Tutorial: Persisting the ReportDocument Object Model Using Session [page 289]
Tutorial: Reading and Setting Discrete Parameters [page 326]
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1.4.3.1.5 To set discrete parameters in a subreport

This sample sets a parameter in a subreport to a specific value.

You must have a report with a parameter field already specified.

To set a discrete value in a report, you call the ReportDocument.SetParameterValue method with the name of 
the parameter and the parameter value. This method is not supported for subreports. Instead, you must access 
the parameter in the subreport through the ParameterFields collection of the main report and set it to a new 
ParameterDiscreteValue object.

1. Create an instance of the ParameterDiscreteValue class.

Tip
Use the ParameterRangeValue class for ranged parameters.

2. Set the ParameterDiscreteValue.Value property to the new parameter value.

     Dim dv As New ParameterDiscreteValue()
    dv.Value = parameterValue 
     ParameterDiscreteValue dv = new ParameterDiscreteValue();
    dv.Value = parameterValue; 

3. Create an instance of the ParameterFields collection, and assign to it the value of the 
ReportDocument.ParameterFields property from the main report.

     Dim parameterFields As ParameterFields = testReport.ParameterFields 
     ParameterFields parameterFields = testReport.ParameterFields; 

4. Access the parameter in the subreport through a named index of the ParameterFields instance.

     Dim parameterField As ParameterField = parameterFields(parameterFieldName, 
subreportName) 
     ParameterField parameterField = parameterFields[parameterFieldName, 
subreportName]; 

The ParameterFields collection requires two indices, one for the name of the parameter, and another for 
the name of the subreport.

5. Clear the existing value in the parameter field, and add the ParameterDiscreteValue object that you created 
earlier.

     parameterField.CurrentValues.Clear()
    parameterField.CurrentValues.Add(dv) 
     parameterField.CurrentValues.Clear();
    parameterField.CurrentValues.Add(dv); 

6. Bind the report to a CrystalReportViewer control.
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Note
The ParameterFields must be set before the ReportSource property of the CrystalReportViewer control; 
if it is not, the control will prompt for the parameter information.

Example
Setting discrete parameters in a subreport

 Private Sub SubreportSettingParameters_RD(ByVal testReport As ReportDocument, 
ByVal subreportName As String, ByVal parameterFieldName As String, ByVal 
parameterValue As String)
    Dim dv As New ParameterDiscreteValue()
    dv.Value = parameterValue
    
    Dim parameterFields As ParameterFields = testReport.ParameterFields
    Dim parameterField As ParameterField = parameterFields(parameterFieldName, 
subreportName)
    parameterField.CurrentValues.Clear()
    parameterField.CurrentValues.Add(dv)
    crystalReportViewer1.ReportSource = TestReport
End Sub 
 private void SubreportSettingParameters_RD(ReportDocument testReport, 
                 String subreportName, String parameterFieldName, String 
parameterValue)
{
    ParameterDiscreteValue dv = new ParameterDiscreteValue();
    dv.Value = parameterValue;
    ParameterFields parameterFields = testReport.ParameterFields;
    ParameterField parameterField = parameterFields[parameterFieldName, 
subreportName];
    parameterField.CurrentValues.Clear();
    parameterField.CurrentValues.Add(dv);
    crystalReportViewer1.ReportSource = TestReport;
} 

A SAP Crystal Reports Web Site may require additional code to manage session state between page views.

Related Information

Tutorial: Persisting the ReportDocument Object Model Using Session [page 289]
Tutorial: Reading and Setting Range Parameters for a Subreport [page 239]

1.4.3.1.6 To set ranged parameters in a report

You must have a report with a parameter field already specified.

Using the ReportDocument object model, you can set the parameter values for existing parameters in a report. 
Parameters are accessed by name, or by a numerical index value. To add a new parameter to a report, you must 
use the ReportClientDocument object model.
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To set a ranged parameter, you must create an instance of the ParameterRangeValue class and pass it to the 
ReportDocument.SetParameterValue method.

1. Creates a new string constant, PARAMETER_FIELD_NAME, and sets its value to the name of an existing 
parameter.

2. Create an instance of the ParameterRangeValue class.

     Dim dateRange As New ParameterRangeValue() 
     ParameterRangeValue dateRange = new ParameterRangeValue(); 

3. Set the start and end values for the ParameterRangeValue object.

     dateRange.StartValue = startDate
    dateRange.EndValue = endDate 
     dateRange.StartValue = startDate;
    dateRange.EndValue = endDate; 

4. Set the upper and lower bounds for the range.

Option Description

RangeBoundType.BoundExclusive The upper and lower range values are not included in the range.

RangeBoundType.BoundInclusive The upper and lower range values are included in the range.

RangeBoundType.NoBound No range bound selected.

     dateRange.LowerBoundType = RangeBoundType.BoundInclusive
    dateRange.UpperBoundType = RangeBoundType.BoundInclusive 
     dateRange.LowerBoundType = RangeBoundType.BoundInclusive;
    dateRange.UpperBoundType = RangeBoundType.BoundInclusive; 

5. Call the ReportDocument.SetParameterValue method and pass the parameter name and 
ParameterRangeValue object.

The ReportDocument.SetParameterValue method sets the current value of a parameter field. The value 
can be a primitive, ParameterValue, an array of either type, or a ParameterValues collection.

Example
 Private Sub SettingParameters_RD(ByVal testReport As ReportDocument, ByVal 
startDate As String, ByVal endDate As String)
    Dim PARAMETER_FIELD_NAME As String = "SalesDates"
    
    Dim dateRange As New ParameterRangeValue()
    dateRange.StartValue = startDate
    dateRange.EndValue = endDate
    dateRange.LowerBoundType = RangeBoundType.BoundInclusive
    dateRange.UpperBoundType = RangeBoundType.BoundInclusive
    
    testReport.SetParameterValue(PARAMETER_FIELD_NAME, dateRange)
    crystalReportViewer1.ReportSource = testReport
End Sub 
 private void SettingParameters_RD(ReportDocument testReport, String startDate, 
String endDate)
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{
    string PARAMETER_FIELD_NAME = "SalesDates";
    ParameterRangeValue dateRange = new ParameterRangeValue();
    dateRange.StartValue = startDate;
    dateRange.EndValue = endDate;
    dateRange.LowerBoundType = RangeBoundType.BoundInclusive;
    dateRange.UpperBoundType = RangeBoundType.BoundInclusive;
    testReport.SetParameterValue(PARAMETER_FIELD_NAME, dateRange);
    crystalReportViewer1.ReportSource = testReport;
} 

A SAP Crystal Reports Web Site may require additional code to manage session state between page views.

Related Information

Tutorial: Persisting the ReportDocument Object Model Using Session [page 289]

1.4.3.2 Filtering report data with selection formulas

Selection formulas specify and filter the records and groups that appear in a report. There are three possible 
selection formulas that you can use to filter your data:

● Record selection formula
● Saved data selection formula
● Group selection formula

The following table shows what types of fields will be allowed in different report filters:

Table 5:

Record selection formula Saved data selection for
mula

Group selection formula

Parameters X X X

Summaries - - X

Print time formulae/running 
totals

- - -

The following table shows the differences in behavior associated with the different report filters:

Table 6:

Record selection formula Saved data selection for
mula

Group selection formula

Can refer to the summary? No. Yes. Yes.

When is the formula evalu
ated?

While reading records. If a summary is used, at print 
time; otherwise, while reading 
records.

At print time.
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Record selection formula Saved data selection for
mula

Group selection formula

When is the report refreshed? If the evaluation result is false, 
when records are dropped.

If records are being read, 
when evaluated. If the evalua
tion result is false, when re
cords are dropped.

N/A

Affects the summary calcula
tion?

Yes, records that are filtered 
out are not counted.

If the filter is evaluated while 
reading records, then no; oth
erwise, yes.

No, records are counted even 
when they are filtered out.

You can apply the saved data selection formula on the output of the record selection formula. The following 
diagram shows the flowpath of how the record selection and saved data selection formulas are used:

Record selection formula

The Record selection formula specifies which records will form report saved data. This selection formula allows 
two levels of filtering:

● Filtered out by database
● Filtered out by report processing engine

Saved data selection formula

The SavedDataFilter allows users to view a subset of the data saved in a report. Changing the SavedDataFilter will 
not discard the data saved in a report or result in a database hit.

Group selection formula

The Group selection formula specifies which records will be considered when report pages are rendered. This 
formula typically uses values produced in earlier stages of report processing, such as summaries.

Note
Group selection formula filters on records and not groups.
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1.4.3.2.1 To filter data using selection formulas

This sample applies a filter to one of the database parameters that are used by the sample report. The filter allows 
users to customize the values that appear in a report.

1. Create a method that takes a ReportDocument object and a String that contains a selection formula.
The SAP Crystal Reports .NET SDK uses the same syntax for a selection formula as the SAP Crystal Reports 
Embedded Designer.

2. Assign the selection formula to the DataDefinition.RecordSelectionFormula property of the current 
ReportDocument object.

The DataDefinition class contains all the information relating to data manipulation based on the data source in 
a report. The DataDefinition class for each report is accessable through the ReportDocument.DataDefinition 
property.

3. Bind the ReportSource property of the CrystalReportViewer control to the ReportDocument instance.

The report will be refreshed with new results based upon the selection formula specified.

Example
This example accepts a ReportDocument object, and an integer parameter. The integer parameter is 
concatenated with an existing String to create a complete selection formula. The selection formula is applied to 
the report before binding the CrystalReportViewer control to the ReportDocument object.

Private Sub FilterData_RD(ByVal TestReport As ReportDocument, ByVal sales As 
Integer)     Dim selectFormula As String = "{Customer.Last Year's Sales} > " + sales
    TestReport.DataDefinition.RecordSelectionFormula = selectionFormula
    crystalReportViewer.ReportSource = TestReport
End Sub 

private void FilterData_RD(ReportDocument TestReport, int sales) {
  string selectFormula = "{Customer.Last Year's Sales} > " + sales; 
  TestReport.DataDefinition.RecordSelectionFormula = selectionFormula;
  crystalReportViewer.ReportSource = TestReport; }

A SAP Crystal Reports Web Site may require additional code to manage session state between page views.

Related Information

Tutorial: Persisting the ReportDocument Object Model Using Session [page 289]
Incorporating Parameters into Formulas [page 581]
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1.4.4  Setting the Data Source

SAP Crystal Reports can report off virtually any kind of data source, including persistent sources such as 
databases and XML files, and runtime sources such as object collections.

Using the ReportDocument object model, you can programmatically access and change the connection 
information to these data sources for the report file at run time.

There are several ways to set a data source:

● Use the ReportDocument.DatasourceConnections[0].SetConnection method.
This method allows you to log on to either a report or subreport.

● Update the ReportDocument.Table.LogOnInfo property and call the 
ReportDocument.Table.ApplyLogOnInfo method.
This method allows you to log on to either a report or subreport. This method also allows you to specify a fully 
qualified table location.

● Use the CrystalReportViewer.LogOnInfo method.
This method allows you to log on to a report, but does not allow you to set the database location.

Classes used for setting the data source

● CrystalDecisions.Shared.ConnectionInfo
Provides properties for retrieving and setting options for connecting to database servers or ODBC data 
sources.

● CrystalDecisions.CrystalReports.Engine.Table
Represents a database table accessed by the report. This class provides properties and methods to get 
information about the table and set logon information for the table.

● CrystalDecisions.CrystalReports.Engine.ReportDocument
Represents a report and contains properties and methods to specify a data source at run time.

Related Information

Supported Data Sources [page 549]
Accessing and Adding Data [page 549]

1.4.4.1 Connecting to a Database

The most common data source for a Crystal report is a database. A database is accessed from either of the 
following sources:

● Directly from the report file, using database connectivity information that is stored in the file.
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The database connectivity information is configured through the embedded SAP Crystal Report Designer 
when the report is created or modified. The information is automatically passed to the database by the report 
engine whenever the report is displayed.
Logon credentials can be saved with the report, or passed at run time.

● From SAP Crystal Reports .NET API code.
The database connectivity information can be reconfigured with code that interacts with the report 
programmatically at run time.

The most common scenario for creating a connection to a database is to set the database connection parameters 
in the SAP Crystal Reports designer, and then supply logon information programmatically at run time.

Related Information

Accessing and Adding Data [page 549]

1.4.4.1.1 Maximizing Security When Connecting to a SQL 
Server Database

Regardless of the source for your reports, the security issue remains the same: how do you protect the database 
from malicious attacks?

Use Windows Authentication with Integrated Security 

For maximum security, Microsoft recommends the use of Integrated Security through Windows Authentication. 
This configuration means a user ID and password string won't be needed in your application.

Use SQL Server Authentication with a Limited Access Database Account

If you need to use SQL Server Authentication with your database, you will have to take extra steps to achieve 
effective security.

Never use the system administrator id and password in your code, because this presents a significant security 
risk. Instead, do the following:

● Create a limited access database account.
● Configure this account, so that only the required tables in the database can be accessed.
● For each table that can be accessed, give permission only to run the SELECT statement.

Microsoft further recommends that you encrypt your user ID and password. For information about how to encrypt 
your user ID and password, see the Security information in MSDN.
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1.4.4.1.2 To Log on to a Secure SQL Server Database with a 
Subreport

To run this sample, you must have a report that includes a subreport that requires secure SQL authentication. The 
user name and password to log on to the SQL Server database must be provided.

This sample will switch the database of a subreport programmatically.

1. Retrieve the DataSourceConnections instance from the DataSourceConnections property of the report 
and subreport instances.

2. Retrieve the IConnectionInfo at index 0 of the DataSourceConnections instance.

3. Call the SetConnection method with your server name, database name, user name and password.

4. Call the SetLogon method with your user name and password.

Example
 Private Function SubreportLogon_RD(ByVal TestReport As ReportDocument) As 
ReportDocument
    Dim dataSourceConnections As DataSourceConnections = 
TestReport.DataSourceConnections
    Dim connectInfo As IConnectionInfo = dataSourceConnections(0)
    connectInfo.SetConnection("ServerName", "DatabaseName", "UserName", 
"Password")
    
    Dim TestSubreport As ReportDocument = TestReport.Subreports("Subreport1")
    Dim subreportDataSourceConnections As DataSourceConnections = 
TestSubreport.DataSourceConnections
    Dim connectInfo As IConnectionInfo = subreportDataSourceConnections(0)
    connectInfo.SetLogon("UserName", "Password")
End Function 

private ReportDocument SubreportLogon_RD(ReportDocument TestReport) {
    DataSourceConnections dataSourceConnections = 
TestReport.DataSourceConnections;
    IConnectionInfo connectInfo = dataSourceConnections[0];
    connectInfo.SetConnection("ServerName", "DatabaseName", "UserName", 
"Password");
    ReportDocument TestSubreport = TestReport.Subreports["Subreport1"];
    DataSourceConnections subreportDataSourceConnections = 
TestSubreport.DataSourceConnections;
    IConnectionInfo connectInfo = subreportDataSourceConnections[0];
    connectInfo.SetLogon("UserName", "Password"); }

1.4.4.1.3 To Log on to a Secure SQL Server Database with 
the ReportDocument object model

This sample shows how to log onto a database using secure SQL authentication.

Before you begin, you must have a report that requires secure SQL authentication.
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To update the connection information for a report using the ReportDocument object model, you must update the 
ConnectionInfo property for each Table object in the ReportDocument.Database.Tables collection. Once 
each property has been updated, you must call the Table.ApplyLogOnInfo method to commit the changes.

1. Create a new ConnectionInfo object.

2. Set the DatabaseName, UserID and Password properties of the ConnectionInfo object to the values 
required for log on.

Note
If you choose only to set the DatabaseName, UserID, and Password properties, then you are logged on to 
the default server of the database that you have specified within the report. However, if you choose to 
assign an alternate ServerName property, you can redirect the report to a different server at runtime.

3. Retrieve the Tables instance from the Database property of the ReportDocument class.

Note
Tables is an indexed class that contains instances of the Table class.

4. For each Table object in the collection:

a. Retrieve the TableLogOnInfo instance from the LogOnInfo property of the Table class.
b. Update the ConnectionInfo property of the TableLogOnInfo object.
c. Call the ApplyLogOnInfo method to commit the change.

Example
 Private Sub setDatabaseLogon(ByVal rd As ReportDocument, ByVal databaseName As 
String, ByVal userName As String, ByVal password As String)
    Dim myConnectionInfo As New ConnectionInfo()
    myConnectionInfo.DatabaseName = databaseName
    myConnectionInfo.UserID = userName
    myConnectionInfo.Password = password
    
    Dim myTables As Tables = rd.Database.Tables
    For Each myTable As Table In myTables
        Dim newLogonInfo As TableLogOnInfo = myTable.LogOnInfo
        newLogonInfo.ConnectionInfo = myConnectionInfo
        myTable.ApplyLogOnInfo(newLogonInfo)
    Next
End Sub 
 private void setDatabaseLogon(ReportDocument rd, String databaseName, String 
userName, String password)
{
    ConnectionInfo connectionInfo = new ConnectionInfo();
    connectionInfo.DatabaseName = databaseName;
    connectionInfo.UserID = userName;
    connectionInfo.Password = password;
    Tables tables = rd.Database.Tables;
    foreach (Table table in tables)
    {
        TableLogOnInfo newLogonInfo = table.LogOnInfo;
        newLogonInfo.ConnectionInfo = connectionInfo;
        table.ApplyLogOnInfo(newLogonInfo);
    }
} 
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Once you have set the database log on information for the ReportDocument instance, update the 
ReportSource property of the CrystalReportViewer object.

1.4.4.1.4 To Log on to a Secure SQL Server Database with 
the CrystalReportViewer control

When you use the CrystalReportViewer object model to log on to a secure SQL Server database, you must use 
classes from the CrystalDecisions.Shared namespace.

The properties of the ConnectionInfo class are used to connect to the database server or ODBC data sources.

1. Create a new ConnectionInfo object.

2. Set the DatabaseName, UserID and Password properties of the ConnectionInfo object to the values 
required for log on.

Note
If you choose only to set the DatabaseName, UserID, and Password properties, then you are logged on to 
the default server of the database that you have specified within the report. However, if you choose to 
assign an alternate ServerName property, you can redirect the report to a different server at runtime.

3. Retrieve the TableLogOnInfos instance from the LogOnInfo property of the CrystalReportViewer 
class.

Note
TableLogOnInfos is an indexed class that contains instances of the TableLogOnInfo class.

4. For each TableLogOnInfo object in the collection, set the ConnectionInfo property of TableLogOnInfo 
object to the ConnectionInfo object.

Example
 Private Sub setDatabaseLogon(ByVal databaseName As String, ByVal userName As 
String, ByVal password As String)
    Dim myCconnectionInfo As New ConnectionInfo()
    Dim logOnInfos As TableLogOnInfos = crystalReportViewer.LogOnInfo
    For Each logOnInfo As TableLogOnInfo In logOnInfos
        logOnInfo.ConnectionInfo = myCconnectionInfo
    Next
    myCconnectionInfo.DatabaseName = databaseName
    myCconnectionInfo.UserID = userName
    myCconnectionInfo.Password = password
End Sub 
 private void setDatabaseLogon(String databaseName, String userName, String 
password){
    ConnectionInfo connectionInfo = new ConnectionInfo();
    TableLogOnInfos logOnInfos = crystalReportViewer.LogOnInfo;
    foreach(TableLogOnInfo logOnInfo in logOnInfos) {
        logOnInfo.ConnectionInfo = connectionInfo;
    }
    connectionInfo.DatabaseName = databaseName;
    connectionInfo.UserID = userName;
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    connectionInfo.Password = password;
} 

1.4.4.2 Connecting to IDataReader

Many .NET projects use DataReader, rather than DataSet, to retrieve data. For example, a typical way to bind a 
control (such as the GridView control) to data is to create a method that retrieves data through a DataReader, and 
then return that data from the method through an IDataReader interface.

The embedded SAP Crystal Report Designer can access IDataReader, provided certain conditions are met:

● The data must be returned from a method, through the IDataReader interface.
● The data provider that is used within the method must be the OleDb .NET data provider.

Note
The classes for this data provider are located in the System.Data.OleDb namespace.

● The method must be Shared [Visual Basic] or static [C#].
● The class that contains this method must be part of a class library project and be compiled into an assembly.

In order to create a Crystal report that uses an instance of IDataReader as a data source, you must create a class 
library with a static method that returns an IDataReader object. After you compile this class library, the resulting 
assembly will act as the data source for your report.

Note
You will not be able to set the data source of your report to the IDataReader until you have created and 
compiled the class library.

Related Information

Tutorial: Connecting to IDataReader [page 466]

1.4.4.3 Connecting to ADO.NET DataSets

An ADO.NET dataset object is a collection of dataset classes created in memory. You can create an ADO.NET 
dataset from various data sources (including Access, Oracle, and SQL Server databases) by using the Visual 
Studio ADO.NET Dataset Designer. The ADO.NET Dataset Designer shows a graphic view of the database with its 
tables, its fields, and their corresponding types. You can drag tables from the Server Explorer to a schema file in 
the Schema tab of the designer.

In order to create a Crystal report that uses an ADO.Net data set as a data source, you must create a class library 
with a static method or property that returns a DataSet object. After you compile this class library, the resulting 
assembly will act as the data source for your report.
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Note
You will not be able to set the data source of your report to the DataSet until you have created and compiled 
the class library.

When to use a DataSet

DataSets are useful when:

● Data inside the DataSet needs to be modified after the query is run.
● Data from multiple data sources needs to be joined.

Note
DataSets are an XML representation of data, typically from a database. A DataSet is not equivalent to a 
single table in a database; rather it is equivalent to a group of tables. This presents a potential scalability 
problem for reports. If a report retrieves multiple tables in a DataSet and a join is required between these 
tables, the report must do the join processing as it interacts with each separate table. This is not an 
efficient process. It is always better to place your join statements within the query that you use to populate 
the DataSet. This results in a single 'pseudo-table' of pre-joined data in your DataSet, which frees the 
report to focus on data display.

Related Information

Avoid DataSets for Simple Queries [page 62]
If You Use DataSets, Cache Them [page 63]
Tutorial: Connecting to ADO.NET DataSets [page 455]

1.4.4.4 Connecting to Object Collections

SAP Crystal Reports 2008 has the ability to report off of object data. Object data can be simple, such as string or 
integer data. Or it can be complex, such as a class or a collection. Collections must be a simple array, or an 
IEnumerable object. SAP Crystal Reports can access these object collections as a regular data source, providing 
a versatile data source for your Crystal reports.

With an object collection, you can write a custom class that populates an object with data either programmatically 
or dynamically. You can also write your own data access objects, extending the number of data sources that are 
provided with a default installation SAP Crystal Reports, developer version for Microsoft Visual Studio.

To use an object collection as a data source, you must create a class that exposes at least one public property. If 
the property returns simple data, such as string or Integer values, SAP Crystal Reports will treat this data as a field 
in a database. If the property returns complex data, such as an ArrayList object, each object in the object 
collection provides one Detail row in the report.
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Accessing data within objects

Earlier versions of SAP Crystal Reports allow you to access properties that return only simple data types. For 
example, if an object contains a property that returns a string, that string is exposed as a regular field at design 
time. But if the object contains a property that returns an object, the data inside the returned object won't be 
exposed, even if it contains simple data.

SAP Crystal Reports 2008 and later allow you to access data contained in complex data types through complex 
type expansion. At design time, you will see the returned object as a hiearchical data source. The complex data 
can be expanded to reveal any simple data types that it exposes, which can then be added to the report.

To enable complex type expansion, add the CrystalComplexTypeExpansionLevels attribute to the property 
that returns the object that you wish to expand. You must set the CrystalComplexTypeExpansionLevels 
attribute to a value greater than 1 to drill down into the class data. If you do not set the 
CrystalComplexTypeExpansionLevels attribute, SAP Crystal Reports will not be able to access the field data 
inside of the class.

Example
Exposing simple data

This example has two objects: Employee and Person. When the Employee object is added to the report as a 
data source, the Employee.EmployeeID property will be exposed as a valid field; however, the 
Employee.Person property will not be visible because it returns a complex data type.

 Class Employee
    Private _employeeID As Integer
    Private _person As New Person()
    Public Property EmployeeID() As Integer
        Get
            Return _employeeID
        End Get
        Set(ByVal value As Integer)
            _employeeID = value
        End Set
    End Property
    Public ReadOnly Property Person() As Person
        Get
            Return _person
        End Get
    End Property
End Class
Class Person
    Private _name As String
    Public Property Name() As String
        Get
            Return _name
        End Get
        Set(ByVal value As String)
            _name = value
        End Set
    End Property
End Class 
 class Employee
{
    int _employeeID;
    Person _person = new Person();
    public int EmployeeID
    {
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        get { return _employeeID; }
        set { _employeeID = value; }
    }
    public Person Person
    {
        get { return _person; }
    }
}
class Person
{
    private String _name;
    public String Name
    {
        get { return _name; }
        set { _name = value; }
    }
} 

Example
Allowing complex type expansion

In the previous example, the Employee.Person property is not visible because it returns a complex data type.

In this example, the CrystalComplexTypeExpansionLevels attribute has been added to the 
Employee.Person property, which will allow the report designer to see a new field in the Field Explorer: 
Person-Name.

 Class Employee
    Private _employeeID As Integer
    Private _person As New Person()
    Public Property EmployeeID() As Integer
        Get
            Return _employeeID
        End Get
        Set(ByVal value As Integer)
            _employeeID = value
        End Set
    End Property
    <CrystalDecisions.CrystalReports.Engine.CrystalComplexTypeExpansionLevels(1)> 
_
    Public ReadOnly Property Person() As Person
        Get
            Return _person
        End Get
    End Property
End Class
Class Person
    Private _name As String
    Public Property Name() As String
        Get
            Return _name
        End Get
        Set(ByVal value As String)
            _name = value
        End Set
    End Property
End Class 
 class Employee
{
    int _employeeID;
    Person _person = new Person();
    public int EmployeeID
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    {
        get { return _employeeID; }
        set { _employeeID = value; }
    }
    [CrystalDecisions.CrystalReports.Engine.CrystalComplexTypeExpansionLevels(1)]
    public Person Person
    {
        get { return _person; }
    }
}
class Person
{
    private String _name;
    public String Name
    {
        get { return _name; }
        set { _name = value; }
    }
} 

Related Information

Tutorial: Connecting to Object Collections [page 475]

1.4.4.5 To enable report caching in a SAP Crystal Reports 
Web Site

These steps make use of the Smart Tasks feature. The Smart Tasks feature is available in Visual Studio 2005 and 
up.

Windows projects that use Crystal Reports, developer version for Microsoft Visual Studio continue to use the 
same caching framework that is used in Visual Studio .NET 2003. That is, when a report is added to a project, two 
report wrapper classes are created: a regular report class and a cached report class.

If no report wrapper classes are generated for a report, caching is controlled through the EnableCaching 
property of the CrystalReportSource control.

1. Create a Crystal Reports, developer version for Microsoft Visual Studio Web Site.
2. On the Default.aspx page, select Source view.

3. Locate the XML tag for the CrystalReportSource control.

4. Change the EnableCaching property value from False to True.

Note
For detailed information about report caching, the cached version of the report wrapper class, and an 
explanation of when and when not to use caching, see Cache and Persistence of the ReportDocument 
Object Model [page 54].
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Example

<CR:CrystalReportSource ID="myCrystalReportSource" runat="server"              EnableCaching="True">
    <Report FileName="CrystalReport1.rpt">
    </Report>
</CR:CrystalReportSource> 

1.4.4.6 Using LINQ

LINQ (Language Integrated Query) is a Microsoft Framework component that allows you to perform queries on 
any data source.

SAP Crystal Reports can report on a collection of custom objects. This lets you gain more control over how 
information is displayed in a report. However, assembling an object collection can become complicated if the 
collection contains aggregate data from multiple data sources.

Using LINQ simplifies the process of reporting on an object collection and lets you run SQL-like queries on custom 
objects. For example, assume you have an SQL database, an XML file, and a Microsoft Access file containing 
sales-related data. LINQ allows you to query from all three data sources and display the data in a single report.

LINQ enables you to do the following:

● Assemble an object collection from multiple data sources.
● Join two object collections.
● Group items within a collection.

The following software must be installed to use LINQ with SAP Crystal Reports:

● Visual Studio 2008 or newer.
● Microsoft .NET Framework version 3.5
● SAP Crystal Reports Basic for Visual Studio 2008 or newer.

Related Information

Setting the Data Source [page 132]

1.4.5  Viewing a Report

The CrystalReportViewer control is used to view Crystal reports. There are two CrystalReportViewer controls in 
the SAP Crystal Reports .NET SDK. For a web site, you will use the 
CrystalDecisions.Web.CrystalReportViewer class. For a Windows application, you will use the 
CrystalDecisions.Windows.Forms.CrystalReportViewer class.
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In order to view a report, you must first add a CrystalReportViewer control to your application, and then assign the 
ReportSource property of that control to a report. The process of assigning a report to a CrystalReportViewer 
control is called report binding.

There are several ways to bind a CrystalReportViewer control to a report. This section details each report binding 
scenario, as well as general considerations for report viewing.

Classes used for viewing reports

● CrystalDecisions.Windows.Forms.CrystalReportViewer
Provides properties, methods, and events that modify or retrieve information about how the 
CrystalReportViewer control appears and functions.

● CrystalDecisions.Web.CrystalReportViewer
Provides properties, methods, and events that modify or retrieve information about how the 
CrystalReportViewer control appears and functions.

● CrystalDecisions.CrystalReports.Engine.ReportDocument
Represents a report and contains properties and methods to define, format, load, export, and print the report.

Related Information

How Do I Use Report Viewer Controls? [page 40]
The CrystalReportViewer Control [page 39]
Report Binding Scenarios [page 147]

1.4.5.1 Comparing Embedded and Non-embedded Reports

What is the difference between embedded and non-embedded reports?

An embedded report is a report that has been imported into, or created within, a Visual Studio project. When a 
report is embedded into the project, a wrapper class is automatically generated for the report. This allows you to 
access the report by name, rather than through a seperate ReportDocument instance.

A non-embedded report is a report that is external to the Visual Studio project. You can use many ways to access 
the report and load it into an object model (to enable programmatic interaction with the report), but the report 
always remains external to the project.

How does an embedded report work?

When the report is imported into or created within the project, a wrapper class (of the same name as the report) is 
created. This wrapper class wraps, or represents, the report in the project. Once this occurs, all code in the project 
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interacts with the report class that has been created to represent the report, rather than with the original report 
file itself.

When you compile the project, both the report and its wrapper class are embedded into the assembly, the same 
as with any other project resource.

Note
The .Net Framework has size restrictions for DLL files. This means your project may not compile if it contains 
large embedded reports. For projects that use large reports, either disable saved data in the report, or change 
your project to use non-embedded reports instead. The size limit varies with each version of the .Net 
Framework. Please consult the .Net Framework documentation for more information.

A report wrapper class extends from the common base class ReportDocument. It inherits all of 
ReportDocument's properties and methods.

ReportDocument is the root class of the ReportDocument object model.

How does a non-embedded report work?

A non-embedded report is always accessed externally and made accessible to the SDK in various ways:

● The report may be located on the hard drive along a file directory path.
● The report may be exposed as a Report Web Service.
● The report may be one of a group of reports that are exposed through Crystal Services.

Non-embedded reports are never imported into the project and, therefore, a report wrapper class is never created 
(unlike embedded reports). Instead, the non-embedded report is loaded into one of the object models at runtime, 
in each their own way:

● The ReportDocument object model uses the ReportDocument.Load() method to load the report into the 
ReportDocument object model.

● The CrystalReportViewer object model uses the CrystalReportViewer.ReportSource property to bind the 
report directly to the control.

When to choose embedded or non-embedded reports

If you want to simplify deployment of your project, use embedded reports. You'll have fewer files to work with and 
no concern about reports being misplaced into the wrong file directory path. This solution also offers more 
security, in that the reports are not exposed for modifications.

Embedded reports offer simplicity and security, but add labor. They cannot be modified without recompiling the 
entire project. If reports must be modified regularly, keep the reports non-embedded to make it easy to access 
and modify them, with no concerns about the need to recompile the assemblies each time. Additionally, there are 
limits to how large an embedded report can be. You cannot compile an extremelly large report as an embedded 
resource.
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The scenarios on report binding show you many ways to bind embedded and non-embedded reports. You'll also 
see how you can use ReportDocument as your generic class for either type of report. This enables you to keep 
code changes to a minimum, should you decide to switch approaches.

Embedding Reports in a web project

Support for embedded reports is enabled through the use of a Build Provider which compiles reports into a DLL 
file. To embed the report into a DLL at compile time, you must set the embedRptInResource setting in your 
web.config file to true. To access the wrapper class through Intellisense, you must place your report in the 
App_Code/Global folder of your solution.

Note
If your report is in the App_Code/Global directory and embedRptInResource is set to false, the report file 
will fail to be copied to the target location when you publish your website. To avoid this problem, copy your 
website to your target instead.

embedRptInResource Location of report Intellisense Available Publish to Deploy Copy to Deploy

True App_Code/Global X X X

True Outside App_Code/
Global, but in project

X X

False App_Code/Global X X X

False Outside App_Code/
Global, but in project

X

Related Information

Configuring your Web.Config file [page 18]

1.4.5.2 Setting the report source

The CrystalReportViewer control displays only one report at a time. To tell the control which report to display, you 
bind the ReportSource property of the control to a particular report. At runtime, the control loads the report that 
is bound to the ReportSource property and displays it.

A CrystalReportViewer control may be bound to a file on disk, a ReportDocument object, or a 
ReportClientDocument object. Binding to an object provides additional functionality through the ReportDocument 
and ReportClientDocument object models. This is the prefered way to set the ReportSource property.
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In its simplest form, the assignment looks like this:

 crystalReportViewer1.ReportSource = "C:\WorldSalesReport.rpt" 
 crystalReportViewer1.ReportSource = "C:\\WorldSalesReport.rpt"; 

In this case, the report is bound to the control directly from its path in the file directory.

The CrystalReportSource control

The CrystalReportSource control is part of the new tag-based application development model that is provided 
with ASP.NET version 2.0.

Note
The CrystalReportSource control is only available for Web Sites.

In the DataSource control framework, .NET visual controls connect to non-visual DataSource controls (controls 
that do not manage display information). This new DataSource framework encapsulates the data connectivity 
information that is written as lines of code in .NET controls on the Web Form.

1.4.5.2.1 To bind the CrystalReportViewer control to a file on 
disk

The simplest way to bind a CrystalReportViewer control to a Crystal report is to set the ReportSource property 
to a location on disk. This non-embedded report is displayed when the application runs.

This binds the report directly to the control. All programmatic interaction with the report must be done within the 
limited CrystalReportViewer object model.

1. Add a CrystalReportViewer control to the Windows Application or Web Site.
2. Open the Web or Windows Form.
3. From the View menu, click Code.
4. Set the ReportSource property to the location of the report on your local file system.

○ When working with a Windows Forms Applications or Web Site:

 myCrystalReportViewer.ReportSource = "C:\MyReport.rpt" 
 crystalReportViewer.ReportSource = "C:\\MyReport.rpt"; 

○ When working with an WPF application:

 myCrystalReportViewer.ViewerCore.ReportSource = "C:\MyReport.rpt" 
 crystalReportViewer.ViewerCore.ReportSource = "C:\\MyReport.rpt"; 
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1.4.5.2.2 To bind the CrystalReportViewer control to a 
ReportDocument object

This report binding scenario allows you to use the more powerful ReportDocument object model with non-
embedded reports, (reports that are external to your project).

Rather than bind the directory paths directly to the viewer, you pass them into the ReportDocument.Load() 
method. Then, you bind the CrystalReportViewer control to the ReportDocument object.

1. Add a CrystalReportViewer control to the Windows Application or Web Site.
2. Open the Web or Windows Form.
3. From the View menu, click Code.
4. Instantiate a new ReportDocument object, and load a report from disk using the ReportDocument.Load 

method.

 Dim rd As ReportDocument = New ReportDocument()
rd.Load(reportPath) 
 ReportDocument rd = new ReportDocument();
rd.Load(reportPath); 

5. Set the ReportSource property to the ReportDocument object.

○ When working with a Windows Forms Applications or Web Site:

 myCrystalReportViewer.ReportSource = rd 
 crystalReportViewer.ReportSource = rd; 

○ When working with an WPF application:

 myCrystalReportViewer.ViewerCore.ReportSource = rd 
 crystalReportViewer.ViewerCore.ReportSource = rd; 

1.4.5.3 Report Binding Scenarios

SAP Crystal Reports, developer version for Microsoft Visual Studio offers several ways to bind a 
CrystalReportViewer control to a report. To help you pick the best report binding scenario for your 
application, this section summaries the pros and cons of the recommended scenarios and explains why some are 
more popular.

Note
Most Web Sites or Windows projects can rely on the two simplest binding scenarios: binding to an embedded 
or non-embedded report.

After reading through this section, you may want to view the detailed listing of all scenarios, to fully explore all 
options available in the SDK.
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Recommended binding scenarios for SAP Crystal Reports

Scenarios that bind reports with the ReportDocument object model are generally preferred to scenarios that use 
the CrystalReportViewer object model. That is because the ReportDocument object model provides a more 
extensive API for programmatic interaction with the report.

Most users prefer the scenario Binding to an Embedded Report Class [page 174]. While not the best choice to 
optimize performance, it is the simplest method to use: add a report to the project to create a report wrapper 
class, instantiate the report wrapper class, and then pass it to the CrystalReportViewer control. Because the 
report wrapper class inherits from the ReportDocument base class, you have access to the full functionality of the 
ReportDocument object model.

Another popular way to bind reports is described in Binding to a Non-embedded Report Loaded into the 
ReportDocument Class [page 176]. It too gives you access to the full functionality of the ReportDocument 
object model, but offers the additional benefit of non-embedded reports, so that you can modify reports without 
recompiling the application.

Recommended binding scenarios for Report Application Server (RAS)

For RAS, you can use additional report binding scenarios, depending on how you configure your project.

● If you use SAP Crystal Reports 10 with RAS 10, you can port projects that were originally created with SAP 
Crystal Reports (using embedded reports) over to RAS and the ReportClientDocument object model, with 
only two additional lines of code required per report.

● To optimize the above scenario, make copies of your embedded reports on the RAS server and direct RAS to 
use those copies.

Recommended binding scenarios for SAP Crystal Reports Server or SAP 
BusinessObjects Business Intelligence platform

If you have upgraded to SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence platform, you 
have four recommended report binding scenarios. Which scenario to use is determined by your requirements for 
report modification and scalability:

● You can display a report, with no programmatic modifications, for the best speed and performance possible.
● You can modify your report programmatically as part of the display process by accessing the 

ReportClientDocument object model.
● If you are using SAP Crystal Reports, developer version for Microsoft Visual Studio with SAP Crystal Reports 

Server or SAP BusinessObjects Business Intelligence platform, you can port projects that were originally 
created with SAP Crystal Reports (using embedded reports) over to SAP Crystal Reports Server or SAP 
BusinessObjects Business Intelligence platform while retaining your existing report code by publishing copies 
of the embedded reports to SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence 
platform.

● You can access your report as an InfoObject instance in the platform framework, giving you the ability to 
schedule it and modify its parameters.
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Related Information

Report Viewer Controls [page 32]

1.4.5.3.1 Report Binding with CrystalReportViewer Object 
Model

The CrystalReportViewer Object Model is the simplest of the object models. Because of its limited features, use of 
this object model is generally discouraged in favor of the more extensive ReportDocument Object Model.

Related Information

CrystalReportViewer Object Model [page 33]
Binding to a File Directory Path in Code [page 149]

1.4.5.3.1.1  Binding to a File Directory Path in Code

Object Model 

This report binding scenario uses the CrystalReportViewer object model.

Location of Reports 

Reports are in a file directory.

Description

This is the simplest report binding scenario: you bind a report in the file directory by its path string to the 
CrystalReportViewer control.
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Pros

● Low maintenance: reports can be added, removed or modified without recompiling your application.
● Simplified implementation: no need to declare and instantiate classes. It bypasses the use of the 

ReportDocument object model, by passing a report directly to the CrystalReportViewer control.

Cons

● Limited distribution: reports typically stay on the same machine as the application, due to the complications 
involved when permissions are granted to the ASPNET user account to access another machine on the 
network.

● Limited object model: this binding scenario offers only the limited object model that is part of the 
CrystalReportViewer.

Related Information

Binding to a File Directory Path Through the Properties Window [page 151]

1.4.5.3.1.1.1  To bind the CrystalReportViewer control to a file 
on disk

The simplest way to bind a CrystalReportViewer control to a Crystal report is to set the ReportSource property 
to a location on disk. This non-embedded report is displayed when the application runs.

This binds the report directly to the control. All programmatic interaction with the report must be done within the 
limited CrystalReportViewer object model.

1. Add a CrystalReportViewer control to the Windows Application or Web Site.
2. Open the Web or Windows Form.
3. From the View menu, click Code.
4. Set the ReportSource property to the location of the report on your local file system.

○ When working with a Windows Forms Applications or Web Site:

 myCrystalReportViewer.ReportSource = "C:\MyReport.rpt" 
 crystalReportViewer.ReportSource = "C:\\MyReport.rpt"; 

○ When working with an WPF application:

 myCrystalReportViewer.ViewerCore.ReportSource = "C:\MyReport.rpt" 
 crystalReportViewer.ViewerCore.ReportSource = "C:\\MyReport.rpt";
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1.4.5.3.1.2  Binding to a File Directory Path Through the 
Properties Window

Object Model

This report binding scenario uses the CrystalReportViewer object model.

Location of Reports

Reports are stored in a file directory.

Description

This is an alternative version of the simplest report binding scenario, Binding to a File Directory Path in Code 
[page 149]. You bind a report in the file directory by its path string to the CrystalReportViewer control, but set 
the assignment in the Properties window, either directly to the ReportSource property or to the 
DataBindings>ReportSource property.

For a Web project, the report path string is inserted directly into the HTML of the ASPX page, rather than into the 
code in the code-behind class.

Pros

● Design time preview: the report can be previewed at design time, in the Web or Windows Form.

Note
Design time preview is a feature that has been available in Web Sites, but it is a new feature in Windows 
projects.

● Low maintenance: reports can be added, removed or modified without recompiling your application.
● Simplified implementation: no need to declare and instantiate classes. It bypasses the use of the 

ReportDocument object model, by passing a report directly to the CrystalReportViewer control.
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Cons

● For a Web application, because binding occurs in the HTML page, you must call the DataBind() method for 
the CrystalReportViewer control in the code-behind class.

Note
This limitation was removed in SAP Crystal Reports for Visual Studio 2005.

● Limited distribution: reports typically stay on the same machine as the application, due to the complications 
involved when permissions are granted to the ASPNET user account to access another machine on the 
network.

● Limited object model: this binding scenario offers only the limited object model that is part of the 
CrystalReportViewer.

Related Information

Binding to a CrystalReportSource Control (Web Sites in Visual Studio) [page 153]

1.4.5.3.1.2.1  To bind to a file directory path using the 
Properties window

1. Create a new Web or Windows project.
2. From the Toolbox, drag a CrystalReportViewer control onto the Web or Windows Form.

3. Click the CrystalReportViewer control to select it.

4. From the Properties window, assign a file directory path string to the ReportSource property.

Note
The file directory path points to the sample reports in Visual Studio 2005.

Because of the design time preview feature, the report is displayed in preview mode.

  C:\Program Files\Microsoft Visual Studio 8.0\Crystal
Reports\Samples\En\Reports\Feature Examples\Hierarchical
Grouping.rpt  

5. To view the report, build and run your project.
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1.4.5.3.1.3  Binding to a CrystalReportSource Control (Web 
Sites in Visual Studio)

Object Model 

This report binding scenario uses the CrystalReportViewer object model.

Location of Reports 

Reports are stored in a file directory.

Description

This is an alternative version of the simplest report binding scenario, Binding to a File Directory Path in Code 
[page 149]. In this scenario, you bind the report with the new reduced-code, tag-based application development 
model of ASP.NET version 2.0.

Note
This report binding scenario is available only for Web Sites.

In this scenario, you use Smart Tasks to create a CrystalReportSource control. Then you select a report for the 
CrystalReportSource control.

Rather than manually write code to interact with the report and enable its access to the CrystalReportViewer 
object model, you make selections from the Smart Task panel (in Design view) or you directly enter declarative 
XML (in Source view).

With declarative XML, you can associate the <Parameters> and <DataSources> tags, which are nested within the 
<Report> tag, to an assortment of non-visual controls that are available from the Parameter and DataSource 
frameworks.

Note
The Parameter and DataSource frameworks are new features of ASP.NET 2.0. They include controls such as: 
ControlParameter or QueryStringParameter and SqlDataSource or JetDataSource.

The tag-based application development model provides a quick and simple method to perform limited interaction 
with the report, without the need to write code.
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Pros

● Design time preview: the report can be previewed at design time, in the Web or Windows Form.
● Easiest way to create report interaction: the simplified, reduced-code approach of the tag-based application 

development model can be used to interact with the report.
● The same pros that are listed in Binding to a File Directory Path in Code [page 149].

Cons

● Limited distribution: reports typically stay on the same machine as the application, due to the complications 
involved when permissions are granted to the ASPNET user account to access another machine on the 
network.

● Limited object model: this binding scenario offers only the limited object model that is part of the 
CrystalReportViewer.

1.4.5.3.1.3.1  To bind to a CrystalReportSource control using 
the Reduced Code model

1. Drag a CrystalReportViewer control onto the Web Form.
2. On the upper-right corner of the CrystalReportViewer control, click the small triangular button.

The Smart Task panel named CrystalReportViewer Tasks opens. In the Choose Report Source list, <None> is 
displayed.

3. Click the Choose Report Source list and select <New report source…>.
The Create ReportSource dialog box opens.

4. In the Specify a name for the control textbox, leave the default entry as CrystalReportSource1.
5. Click the Specify a report for the CrystalReportSource control list and select <Browse…> .

Your alternative selection is <New Report>. That option allows you to create a new Crystal report.
6. Select a report to display in the CrystalReportViewer control and click OK.
7. Click OK again to close the Choose Report Source dialog box.

Related Information

Tutorial: Reduced-Code Web Site Setup with SAP Crystal Reports Using Smart Tasks [page 422]
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1.4.5.3.1.4  Binding to a Report Web Service URL

Object Model 

This report binding scenario uses the CrystalReportViewer object model.

Location of Reports 

Reports are located as a Report Web Service, hosted on a (typically remote) Web server.

Description

A report, which is stored on another server and served as a Report Web Service, is bound by its URL to the 
CrystalReportViewer control.

Pros

● Wide distribution: reports can exist anywhere on the Internet.
● Ease of distribution: Report Web Services are on port 80, so they can be accessed even through firewalls.

Cons

● Limited object model: this binding scenario offers only the limited object model that is part of the 
CrystalReportViewer.

Implementation

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.

● Within the ConfigureCrystalReports() method (that you have created in Project Setup [page 15]), 
assign a Report Web Service URL string to the ReportSource property of CrystalReportViewer class.
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This binds the report directly to the control. All programmatic interaction with the report must be done within 
the limited CrystalReportViewer object model.

 myCrystalReportViewer.ReportSource = _
   "http://localhost/TestProject/World_Sales_ReportService.asmx" 
 crystalReportViewer.ReportSource = 
   "http://localhost/TestProject/World_Sales_ReportService.asmx"; 

Note
To use this binding scenario, create a Report Web Services project in Visual Studio.

Related Information

Working with Crystal Reports as a Web Service [page 74]

1.4.5.3.1.5  CrystalReportViewer Binding Scenarios that Use 
Crystal Services

Using Crystal Services in Visual Studio

SAP Crystal Reports, developer version for Microsoft Visual Studioallows programmatic access to Server Files via 
Crystal Services.

Using Crystal Services in Visual Studio 2003

In Visual Studio 2003 you can access Crystal reports through the Crystal Services node in the Server Explorer. 
When SAP Crystal Reports and Crystal Services are both installed, Crystal Services appears as a sub node within 
each server listed in the Server Explorer.

The Crystal Services node expands to display lists of reports from various locations:

● The local file directory on your hard drive.
● Report Application Server (RAS)
● Crystal Enterprise (CE)

You can drag and drop any report from these lists onto a Web or Windows Form.

Crystal Services typically exposes two sub nodes that may be expandable, depending on the version of SAP 
Crystal Reports that you have currently installed, and on any additional licensing that you may have for Report 
Application Server (RAS) or Crystal Enterprise. The table that is within the next section below describes the 
requirements to access a particular node.
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You may have to adjust your firewall settings in order to access the SAP BusinessObjects Business Intelligence 
platform CMS. The default port for the CMS is 6400. Contact your system administrator for more information on 
network address and port settings for your SAP BusinessObjects Business Intelligence platform system. More 
information on customizing ports can be found in the SAP BusinessObjects Business Intelligence platform 
Administrators Guide.

Wrapper classes

When you drag a report from Crystal Services onto a Web or Windows Form, this creates a wrapper class instance 
that references the report in the Web or Windows Form Designer generated code region of the code-behind class.

Note
The wrapper class type varies across versions of SAP Crystal Reports. See the table below.

The Crystal Services listed in the table below expose wrapper class types that do not contain an object model; 
they depend upon the limited object model provided with the CrystalReportViewer control.

The table shows the Crystal Services that are included with SAP Crystal Reports for Visual Studio 2003. These 
Crystal Services expose groups of reports, either from the local file directory or from the WCS (Web Component 
Server) of Crystal Enterprise. The reports are contained in two different wrapper classes: ServerFileReport for 
reports from the local file directory, or EnterpriseReport for reports from the WCS server of Crystal Enterprise.

Table 7:

Wrapper class ex
posed through Crystal 
Services

Node name under 
Crystal Services

SAP Crystal Reports 
versions

Description What is required to ac
cess this node?

ServerFileReport Server Files SAP Crystal Reports for 
Visual Studio .NET 
2003

(node is replaced when 
SAP Crystal Reports 9 
or 10 installed)

Exposes reports from 
the local file directory 
through a common 
Web service, ServerFi
leReportService. For 
more information, see 
Binding to Server Files 
(VS .NET 2003) [page 
158].

Configure permissions 
for ASPNET users. (See 
Binding to Server Files 
(VS .NET 2003) [page 
158].)

EnterpriseReport Crystal Enterprise SAP Crystal Reports for 
Visual Studio .NET 
2003

(node is replaced when 
SAP Crystal Reports 9 
or 10 installed)

Accesses Report Web 
Services exposed by 
the WCS server of 
Crystal Enterprise 8, 
8.5, 9 or 10 through a 
common Web service, 
EnterpriseReportSer
vice. For more informa
tion, see Binding to 
Crystal Enterprise 
(VS .NET 2003) [page 
161].

You need access to a 
Crystal Enterprise in
stallation (which ex
poses Enterprise re
ports through its WCS 
server).
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1.4.5.3.1.5.1  Binding to Server Files (VS .NET 2003)

Object Model

This report binding scenario uses CrystalReportViewer.

Location of Reports

Reports are in a folder of reports in the local file directory. Reports from this location are exposed as Report Web 
Services.

Crystal Services Overview

This report binding scenario applies to reports accessed from the Crystal Services server node in the Server 
Explorer.

This section examines the Server Files sub node of Crystal Services, within Visual Studio .NET 2003.

[SERVERNAME]

● Crystal Services
○ Server Files

Description

The Server Files sub node accesses and then displays reports that have been exposed as Report Web Services 
from a local file directory. These reports are exposed with the Report Web Services protocol. In Visual Studio .NET 
2003, to access Server Files, click the Server Files node under Crystal Services.

Pros

● Central access to reports: provides a single point of access to all reports in your sample reports directory, 
which creates an effective reports repository on your local hard drive.

Cons

● Replaced in SAP Crystal Reports 9 and 10 with an unmanaged RAS Crystal Services node. See the Description 
section above for further details.
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● Limited object model: this binding scenario offers only the limited object model that is part of the 
CrystalReportViewer.

Configuring Server Files

Server Files are provided as a Crystal Services node in SAP Crystal Reports for Visual Studio 2003. When SAP 
Crystal Reports 9 or 10 (the full versions) are installed on top of the version included with Visual Studio 2003, the 
Server Files node is removed as a visible node.

Each edition of SAP Crystal Reports Developer continues to support Server Files in the SDK. However, manual 
coding is required to work with Server Files in that version.

Related Information

Configuring Server Files in Crystal Services [page 78]
Binding to Crystal Enterprise (VS .NET 2003) [page 161]
Using Crystal Services [page 77]

1.4.5.3.1.5.1.1  To install Crystal Services

You must have SAP Crystal Reports for Visual Studio 2003 installed.

Crystal Services are not installed by default during the Visual Studio .NET 2003 install. In this procedure you will 
install Crystal Services from the Visual Studio .Net 2003 installation CD.

1. On your Microsoft Visual Studio .NET installer CD, locate Crystal Reports.
2. Select Crystal Web Services.
3. Click the Update button.

1.4.5.3.1.5.1.2  To use the Crystal Services>Server Files node

● SAP Crystal Reports for Visual Studio 2003 is installed and verified to be working.
● Or, SAP Crystal Reports 9 or greater is installed and verified to be working.

Note
In SAP Crystal Reports 9 and 10, Server Files is replaced (it is no longer displayed as a node under Crystal 
Services). However, you can still code Server Files manually.
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Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.

1. From the View menu, click Other Windows, and then Server Explorer.
2. Expand Crystal Services, and then expand Server Files.
3. Select a report from the Server Files tree and drag it onto your form.

Note
When a Server Files report is placed onto your form, an instance of ServerFileReport class is added to 
the Designer generated code region of your form.

When classes that inherit from System.ComponentModel.Component (such as ServerFileReport) are 
instantiated and configured within the Designer generated code region, an icon of this instantiated class 
appears at the bottom of the form in Design view.

At the bottom of the form Design view, a serverFileReport1 object appears.

4. Switch to code view and open the Web or Windows Form Designer generated code region.
A ServerFileReport class has been instantiated and configured within this region.

5. Within the ConfigureCrystalReports() method (that you have created in Project Setup), assign the 
ServerFileReport instance to the ReportSource property of the CrystalReportViewer control.

myCrystalReportViewer.ReportSource = serverFileReport1

crystalReportViewer.ReportSource = serverFileReport1;

To view the report, build and run your project.

1.4.5.3.1.5.1.3  To code the Server Files manually

● SAP Crystal Reports for Visual Studio 2003 is installed and verified to be working.
● Or, SAP Crystal Reports 9 or greater is installed and verified to be working.

Note
In SAP Crystal Reports 9 and 10, Server Files is replaced (it is no longer displayed as a node under Crystal 
Services). However, you can still code Server Files manually.

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.
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1. Within the ConfigureCrystalReports() method (that you have created in Project Setup), declare an 
instance of ServerFileReport.

 Dim myServerFileReport As CrystalDecisions.Shared.ServerFileReport = _
    New CrystalDecisions.Shared.ServerFileReport() 
 CrystalDecisions.Shared.ServerFileReport serverFileReport = new 
CrystalDecisions.Shared.ServerFileReport(); 

2. Set the ObjectType property of the ServerFileReport to REPORT.

myServerFileReport.ObjectType = CrystalDecisions.
[Shared].EnumServerFileType.REPORT

serverFileReport.ObjectType = CrystalDecisions.Shared.EnumServerFileType.REPORT;

3. Set the ReportPath property of the ServerFileReport to the report and it's subdirectory.

myServerFileReport.ReportPath = "\General Business\World Sales Report.rpt"

serverFileReport.ReportPath = "\\General Business\\World Sales Report.rpt";

4. Set the WebServiceURL property of the ServerFileReport to the viewer's virtual directory for your 
installed version of SAP Crystal Reports.

Note
In this sample code, the viewers' virtual directory is configured for SAP Crystal Reports 10.

myServerFileReport.WebServiceUrl = "http://localhost/crystalreportviewers10/
ServerFileReportService.asmx"

serverFileReport.WebServiceUrl = "http://localhost/crystalreportviewers10/
ServerFileReportService.asmx";

5. Set the ReportSource property of the CrystalReportViewer control to the ServerFileReport instance.

myCrystalReportViewer.ReportSource = myServerFileReport

crystalReportViewer.ReportSource = serverFileReport1;

1.4.5.3.1.5.2  Binding to Crystal Enterprise (VS .NET 2003)

This binding scenario refers to legacy technology and is intended for users with an existing installation of Crystal 
Enterprise. Crystal Enterprise has been replaced by SAP Crystal Reports Server and SAP BusinessObjects 
Business Intelligence platform.
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Object Model

This report binding scenario uses CrystalReportViewer (see Report Binding with CrystalReportViewer Object 
Model [page 149]).

Location of Reports

The report is located on the Web Component Server (WCS server) in Crystal Enterprise 8, 8.5, 9 or 10. Reports 
from the WCS server are exposed as Report Web Services through the EnterpriseReportService.asmx web 
service. This web service is located in the viewers' virtual directory on the Web Component Server.

Crystal Services Overview

This report binding scenario applies to reports accessed from the Crystal Services server node in the Server 
Explorer.

This section examines the Crystal Enterprise sub node of Crystal Services, within Visual Studio .NET 2003.

[SERVERNAME]

● Crystal Services
○ Crystal Enterprise

Description

The Crystal Enterprise sub node accesses and then displays reports that have been exposed as Report Web 
Services from a WCS server.

For the Crystal Enterprise sub node to correctly access and display a list of reports from the Crystal Enterprise 
WCS server, the following conditions must be met:

● The server that you are currently viewing in the Server Explorer is running Crystal Enterprise 8 or 8.5.

Note
You must upgrade SAP Crystal Reports for Visual Studio 2003 to SAP Crystal Reports Developer (version 
9 or greater) if you wish to connect to Crystal Enterprise 9 or greater.

● The WCS (Web Component Server) of Crystal Enterprise is installed on the Crystal Enterprise server.

Note
The WCS server is installed by default in Crystal Enterprise 9 and 10. In Crystal Enterprise 8 and 8.5, the 
WCS server must be installed separately.
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● In order to configure Report Web Services on the Crystal Enterprise 10 server, you must install Visual 
Studio .NET 2003 on the Crystal Enterprise server, and then run Custom Install to specifically add Crystal 
Services.
If the Crystal Enterprise administrator does not wish to install a full version of Visual Studio .NET 2003 onto 
the Crystal Enterprise server, they may instead do the following:
○ Install the managed.msm merge module.
○ Locate the viewers' virtual directory installed on the dev machine and copy the 

EnterpriseReportService.asmx file from that directory to the viewers' virtual directory on the server 
machine.

Once the reports are successfully displayed in Crystal Services, choose a report and drag and drop it onto the 
Web or Windows form. When dropped onto the form the report is wrapped into a report wrapper class and then 
displayed as a report instance in the component tray.

Note
There are several different report wrapper class types, depending on the source of the report on the server and 
the connection protocol. These vary across different versions of SAP Crystal Reports.

Installing Crystal Services

Crystal Services are not installed by default during the Visual Studio .NET 2003 install. To add Crystal Services, 
load your Microsoft Visual Studio .NET installer CD, locate Crystal Reports, select Crystal Web Services and click 
the update button.

Pros

● Easy access to Crystal Enterprise reports from a Web or Windows application.

Cons

● Limited object model: this binding scenario offers only the limited object model that is part of the 
CrystalReportViewer control.

Note
In SAP Crystal Reports 9 and 10, Crystal Services is upgraded to a different wrapper class and connection 
protocol.
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Related Information

Viewers' Directory [page 13]
Using Crystal Services [page 77]
Binding to Server Files (Visual Studio 2005 and up) [page 165]

1.4.5.3.1.5.2.1  To access Crystal Services>Crystal Enterprise in 
Server Explorer

1. From the View menu, click Other Windows, and then Server Explorer.
2. If your Crystal Enterprise server is on a machine other than your local machine (recommended):

a. Right-click on Servers and click Add Server...
b. In the Add Server dialog box, in the Computers field, enter the network name of the Crystal Enterprise 

server, and then click OK.
c. Within the Servers node, expand the sub node for the new server you have added, and then within it 

expand the Crystal Services sub node.
d. In the Enterprise Logon dialog box, enter values into the User name and Password fields, and then click 

OK.
3. If your Crystal Enterprise server is on your local machine:

a. Within the Servers node, expand the sub node for your local machine, and then within it expand the 
Crystal Services sub node.

b. In the Enterprise Logon dialog box, enter values into the User name and Password fields, and then click 
OK.

You are now ready to configure the Crystal Services>Crystal Enterprise in your Web or Windows project.

1.4.5.3.1.5.2.2  To configure a Crystal Services>Crystal 
Enterprise report

This procedure works only with a project that has been created from Project Setup [page 15] . Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will be 
unable to complete the procedure without that configuration.

1. Select a report from the Crystal Enterprise sub node, and drag it onto the Web or Windows form.
At the bottom of the form in the component tray, an enterpriseReport1 object appears.

2. Switch to code view and open the Web or Windows Form Designer generated code region.

Note
An EnterpriseReport class has been instantiated and configured within this region.
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3. Within the ConfigureCrystalReports() method (that you have created in Project Setup [page 15] ), 
assign the EnterpriseReport instance to the ReportSource property of the CrystalReportViewer control.

myCrystalReportViewer.ReportSource = enterpriseReport1

crystalReportViewer.ReportSource = enterpriseReport1;

4. To view the report, build and run your project.

1.4.5.3.1.5.3  Binding to Server Files (Visual Studio 2005 and 
up)

Object Model

This report binding scenario uses the CrystalReportViewer Object Model.

Location of Reports

Reports are in a folder of reports in the local file directory. Reports from this location are exposed as Report Web 
Services.

Server Files Overview

This report binding scenario applies to reports accessed as a Server File through a web service.

Description

The Server Files web service accesses and displays reports that have been exposed as Report Web Services from 
a local file directory. In Visual Studio 2005 and later, Server Files are accessed programmatically.

Pros

● Central access to reports: provides a single point of access to all reports in your sample reports directory, 
which creates an effective reports repository on your local hard drive.
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Cons

● Limited object model: this binding scenario offers only the limited object model that is part of the 
CrystalReportViewer.

Configuring Server Files 

Server Files are accessed programmatically in SAP Crystal Reports, developer version for Microsoft Visual Studio. 
Each edition of SAP Crystal Reports Developer continues to have programmatic support for Server Files in the 
SDK.

Related Information

Configuring Server Files in Visual Studio 2005 and Newer [page 81]

1.4.5.3.1.5.3.1  To code the Server Files manually

● A Report Web Service that permits programmatic access to Server Files has been configured and is verified to 
be working.

● Or, SAP Crystal Reports Developer is installed and verified to be working.

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.

1. Within the ConfigureCrystalReports() method (that you have created in Project Setup [page 15]), 
declare an instance of ServerFileReport.

 Dim myServerFileReport As CrystalDecisions.Shared.ServerFileReport = _New 
CrystalDecisions.Shared.ServerFileReport() 
 CrystalDecisions.Shared.ServerFileReport serverFileReport = new 
CrystalDecisions.Shared.ServerFileReport(); 

2. Set the ObjectType property of the ServerFileReport to REPORT.

 myServerFileReport.ObjectType = CrystalDecisions.
[Shared].EnumServerFileType.REPORT 
 serverFileReport.ObjectType = CrystalDecisions.Shared.EnumServerFileType.REPORT; 
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3. Set the ReportPath property of the ServerFileReport to the report and its subdirectory.

 myServerFileReport.ReportPath = "\General Business\World Sales
Report.rpt" 
 serverFileReport.ReportPath = "\\General Business\\World Sales
Report.rpt"; 

4. Set the WebServiceURL property of the ServerFileReport to the location of the Report Web Service.

If you have SAP Crystal Reports Developer installed, this will be the viewer's virtual directory for your installed 
version of SAP Crystal Reports, see Viewers' Directory [page 13]. If you do not have SAP Crystal Reports 
Developer installed, this will be the URL to the Report Web Service that you created in Configuring Server Files 
in Visual Studio 2005 and Newer [page 81].

Note
In the code below, the viewers' virtual directory is configured for SAP Crystal Reports for Visual Studio 
2005.

 myServerFileReport.WebServiceUrl =
"http://localhost/CrystalReportsWebServices2005/ServerFileReportService.asmx" 
 serverFileReport.WebServiceUrl =
"http://localhost/CrystalReportsWebServices2005/ServerFileReportService.asmx"; 

5. Set the ReportSource property of the CrystalReportViewer control to the ServerFileReport instance.

 myCrystalReportViewer.ReportSource = myServerFileReport 
 crystalReportViewer.ReportSource = serverFileReport1; 

1.4.5.3.1.5.4  Binding to SAP Crystal Reports Server or SAP 
BusinessObjects Business Intelligence platform 
(Visual Studio)

Object Model

This report binding scenario uses CrystalReportViewer (see Report Binding with CrystalReportViewer Object 
Model [page 149]).

Location of Reports

The report is located on the Web Component Server (WCS server) in SAP Crystal Reports Server or SAP 
BusinessObjects Business Intelligence platform. Reports from the WCS server are exposed as Report Web 
Services through the EnterpriseReportService.asmx web service. This web service is located in the viewers' virtual 
directory on the Web Component Server.
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Crystal Services Overview

This report binding scenario applies to reports accessed from the Crystal Services server node in the Server 
Explorer.

This section examines the SAP Crystal Reports Services sub node of Crystal Services, within Visual Studio.

[SERVERNAME]

● SAP Crystal Reports Services
○ Server Reports

Description

The SAP BusinessObjects Business Intelligence platform sub node accesses and then displays reports that have 
been exposed as Report Web Services from a SAP BusinessObjects Business Intelligence platform WCS server.

For the SAP BusinessObjects Business Intelligence platform sub node to correctly access and display a list of 
reports from the SAP BusinessObjects Business Intelligence platform WCS server, the following conditions must 
be met:

● The server that you are currently viewing in the Server Explorer is running SAP BusinessObjects Business 
Intelligence platform.

● In order to configure Report Web Services on the SAP BusinessObjects Business Intelligence platform, you 
must install Visual Studio on the SAP BusinessObjects Business Intelligence platform server, and then run 
Custom Install to specifically add Crystal Services.

Note
The installation on the SAP BusinessObjects Business Intelligence platform server of Visual Studio, and the 
custom install of Crystal Services, is necessary for the EnterpriseReportService.asmx file to be properly 
installed and configured within the viewers' virtual directory.

If the Crystal Enterprise administrator does not wish to install a full version of Visual Studio onto the SAP 
BusinessObjects Business Intelligence platform server, they may instead do the following:
○ Install the managed.msm merge module.
○ Locate the viewers' virtual directory installed on the dev machine and copy the 

EnterpriseReportService.asmx file from that directory to the viewers' virtual directory on the server 
machine.

Once the reports are successfully displayed in SAP BusinessObjects Services, you can bind a 
CrystalReportsViewer control to any of the reports listed. For more information, see the SAP BusinessObjects 
Business Intelligence platform documentation.

Pros

● Easy access to SAP BusinessObjects Business Intelligence platform reports from a Web or Windows 
application.
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Cons

● Limited object model: this binding scenario offers only the limited object model that is part of the 
CrystalReportViewer control.

Note
In SAP Crystal Reports 9 and 10, Crystal Services is upgraded to a different wrapper class and connection 
protocol.

Related Information

Viewers' Directory [page 13]
Using Crystal Services [page 77]
Choose the Correct Object Model for Your Project [page 29]

1.4.5.3.1.5.4.1  To access Crystal Services>Server Reports in 
Server Explorer

1. From the View menu, click Other Windows, and then Server Explorer.
2. If your Crystal Enterprise server is on a machine other than your local machine (recommended):

a. Right-click on Servers and click Add Server...
b. In the Add Server dialog box, in the Computers field, enter the network name of the Crystal Enterprise 

server, and then click OK.
c. Within the Servers node, expand the sub node for the new server you have added, and then within it 

expand the Crystal Services sub node.
d. In the Enterprise Logon dialog box, enter values into the User name and Password fields, and then click 

OK.
3. If your Crystal Enterprise server is on your local machine:

a. Within the Servers node, expand the sub node for your local machine, and then within it expand the 
Crystal Services sub node.

b. In the Enterprise Logon dialog box, enter values into the User name and Password fields, and then click 
OK.

You are now ready to configure the Crystal Services>Crystal Enterprise in your Web or Windows project.
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1.4.5.3.1.6  Binding to ReportSource (SAP Crystal Reports 
Server or SAP BusinessObjects Enterprise 11)

Note
This page describes functionality that is not available in SAP Crystal Reports, developer version for Microsoft 
Visual Studio, but is available in one of the upgraded versions.

Object Model

This report binding scenario uses the CrystalReportViewer object model.

Location of Reports

Reports are accessed from the Page Server in SAP BusinessObjects Business Intelligence platform.

Description

SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence platform enables report distribution 
from servers within an Enterprise framework. A report stored in SAP Crystal Reports Server or SAP 
BusinessObjects Business Intelligence platform can be displayed by different servers at different times, 
depending on your purpose. In SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence 
platform, if you want to display a report with the best performance possible, and you do not require significant 
programmatic modification of the report, display your report directly from the Page server with the 
ReportSource class.

The ReportSource class is not associated with an object model. If you want to modify parameters or database 
settings, you can use the limited object model provided with the CrystalReportViewer control. However, for 
more complex programmatic interaction with the report, use one of the other SAP Crystal Reports Server or SAP 
BusinessObjects Business Intelligence platform report binding scenarios.

Note
For a comparison of several scenarios that use different servers in SAP Crystal Reports Server or SAP 
BusinessObjects Business Intelligence platform, see the recommended binding scenarios for SAP Crystal 
Reports Server or SAP BusinessObjects Business Intelligence platform under Report Binding Scenarios [page 
147].

You may have to adjust your firewall settings in order to access the SAP BusinessObjects Business Intelligence 
platform CMS. The default port for the CMS is 6400. Contact your system administrator for more information on 
network address and port settings for your SAP BusinessObjects Business Intelligence platform system. More 
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information on customizing ports can be found in the SAP BusinessObjects Business Intelligence platform 
Administrators Guide.

Pros

● Fastest: offers best performance for displaying a report out of SAP Crystal Reports Server or SAP 
BusinessObjects Business Intelligence platform.

Cons

● Limited object model: programmatic modification of database logon or parameter settings are limited to the 
CrystalReportViewer object model.

● Limited availability: this scenario is only available in Crystal Enterprise version 10, SAP Crystal Reports Server 
or SAP BusinessObjects Enterprise XI.

Related Information

Report Binding with ReportDocument Object Model [page 174]

1.4.5.3.1.6.1  To bind the CrystalReportViewer control to a 
report that is served out of the SAP Crystal 
Reports Server or SAP BusinessObjects 
Business Intelligence platform Page Server

● SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence platform is installed and verified to 
be working.

● SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence platform SDK (including the .NET 
assemblies) is installed and verified to be working.

Note
If you have installed SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence platform on 
your development machine, the SDK is included with that installation.

1. Locate and write down the name of a SAP Crystal Reports Server or SAP BusinessObjects Business 
Intelligence platform server. For purposes of this example, the server name is "BOE01."
a. To find the server name, right-click the My Computer icon, and then select Properties.
b. On the System Properties dialog box, click the Network Identification tab.
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c. The computer name is in the "Full computer name" field.
2. Use the Publishing Wizard to publish the Chart.rpt to the SAP Crystal Reports Server or SAP BusinessObjects 

Business Intelligence platform server.

Note
To learn how to use the Publishing Wizard, see the SAP Crystal Reports Server or SAP BusinessObjects 
Business Intelligence platform user documentation.

3. Add the following assembly references to your project:
○ CrystalDecisions.Enterprise.Framework
○ CrystalDecisions.Enterprise.InfoStore
○ CrystalDecisions.Enterprise.Viewing.ReportSource
○ CrystalDecisions.ReportAppServer.Controllers

4. From the View menu, click Code to view the code-behind class for this Web or Windows Form. Above the 
class, add an "Imports" [Visual Basic] or "using" [C#] statement for the 
CrystalDecisions.Enterprise namespace.

 Imports CrystalDecisions.Enterprise
Imports CrystalDecisions.Enterprise.Viewing
Imports CrystalDecisions.ReportAppServer.Controllers 
 using CrystalDecisions.Enterprise;
using CrystalDecisions.Enterprise.Viewing;
using CrystalDecisions.ReportAppServer.Controllers; 

1.4.5.3.1.6.2   To logon to SAP Crystal Reports Server or SAP 
BusinessObjects Enterprise

1. Within the ConfigureCrystalReports() method (that you have created in Project Setup [page 15] ), 
declare a serverName string variable and set it to the name of the SAP Crystal Reports Server or SAP 
BusinessObjects Enterprise server.

Dim serverName As String = "BOE01"

string serverName = "BOE01";

2. Declare and instantiate the SessionMgr class.

Dim mySessionMgr As SessionMgr = New SessionMgr()

SessionMgr sessionMgr = new SessionMgr();

3. Pass the user name (Administrator), the password (blank), the serverName variable, and the logon type 
(secEnterprise) to the Logon method of the SessionMgr instance and retrieve it as an instance of 
EnterpriseSession.

 Dim myEnterpriseSession As EnterpriseSession = mySessionMgr.Logon( _
        "Administrator", "", serverName, "secEnterprise") 
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 EnterpriseSession enterpriseSession = sessionMgr.Logon(
      "Administrator", "", serverName, "secEnterprise"); 

4. Retrieve the InfoStore service (as EnterpriseService), from the GetService method of 
EnterpriseSession.

 Dim myEnterpriseService As EnterpriseService = _
        myEnterpriseSession.GetService("InfoStore") 
 EnterpriseService enterpriseService = enterpriseSession.GetService("InfoStore"); 

5. Declare and instantiate InfoStore and pass in the retrieved EnterpriseService as a parameter to 
InfoStore.

Dim myInfoStore As InfoStore = New InfoStore(myEnterpriseService)

InfoStore infoStore = new InfoStore(enterpriseService);

1.4.5.3.1.6.3  To retrieve the Hierarchical Grouping report from 
SAP Crystal Reports Server or SAP 
BusinessObjects Enterprise

1. To re-assign the value of the EnterpriseService instance to the Page Server report factory service, pass the 
"PSReportFactory" string to the GetService() method of EnterpriseService.

myEnterpriseService = myEnterpriseSession.GetService("PSReportFactory")

enterpriseService = enterpriseSession.GetService("PSReportFactory");

2. Return the Interface property of the EnterpriseService as an object variable.

Dim psrfObject As Object = myEnterpriseService.Interface

Object psrfObject = enterpriseService.Interface;

3. Cast the object variable to a PSReportFactory instance.

Dim myPSReportFactory As PSReportFactory = CType(psrfObject, PSReportFactory)

PSReportFactory psReportFactory = (PSReportFactory)psrfObject;

4. Enter the query string below to query SAP Crystal Reports Server or SAP BusinessObjects Enterprise for the 
report.

 Dim queryString As String = "Select SI_ID, SI_NAME, SI_PARENTID From 
CI_INFOOBJECTS " _
                & "Where SI_PROGID='CrystalEnterprise.Report' " _
                & "And SI_NAME Like 'Chart'" 
 string queryString = "Select SI_ID, SI_NAME, SI_PARENTID From CI_INFOOBJECTS "
   + "Where SI_PROGID='CrystalEnterprise.Report' "
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   + "And SI_NAME Like 'Chart'"; 
5. Pass the query string to the Query method of InfoStore, to retrieve an InfoObjects indexed class that 

contains the query result.

Dim myInfoObjects As InfoObjects = myInfoStore.Query(queryString)

InfoObjects infoObjects = infoStore.Query(queryString);

6. Retrieve the InfoObject from the first column of the InfoObjects indexed class.

Dim myInfoObject As InfoObject = myInfoObjects(1)

InfoObject infoObject = infoObjects[1];

7. Declare and populate a ReportSource instance from the OpenReportSource() method of the 
PSReportFactory instance, passing in the ID property of the InfoObject.

Dim myReportSource As ReportSource = 
myPSReportFactory.OpenReportSource(myInfoObject.ID)

ReportSource reportSource = psReportFactory.OpenReportSource(infoObject.ID);

8. Bind the ReportSource instance to the ReportSource property of the CrystalReportViewer control.

myCrystalReportViewer.ReportSource = myReportSource

crystalReportViewer.ReportSource = reportSource;

9. To view the report, build and run your project.
The report is now displayed from the Page Server within SAP Crystal Reports Server or SAP BusinessObjects 
Enterprise based on its ID. If you use an alternative method to access the reportID (for example, choosing 
the id from a list of reports in a DropDownList control), you won't need to query the InfoStore and 
generate an InfoObject to retrieve the reportID.

1.4.5.3.2 Report Binding with ReportDocument Object Model

The ReportDocument object model is the more powerful and extensive object model that is provided with SAP 
Crystal Reports, developer version for Microsoft Visual Studio. It is the preferred object model to use to develop a 
project with SAP Crystal Reports, developer version for Microsoft Visual Studio.

1.4.5.3.2.1  Binding to an Embedded Report Class

Object Model

This report binding scenario uses the ReportDocument object model.
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Location of Reports

Reports are embedded into the project.

Note
Previous versions of this documentation referred to embedded reports as "strongly-typed." The primary term 
now used to refer to a report that is added or imported into a Visual Studio project is "embedded."

Description

In this scenario, a report is embedded into the project. To embed a report, you can either create a new report with 
the embedded SAP Crystal Reports Designer (which is contained within Visual Studio), or import an existing 
report into the project. When the report is created or imported, a report wrapper class is automatically generated 
to represent the report. This wrapper class has the same name as the report. It is derived from the base class 
ReportDocument, and therefore inherits all of the properties and methods of ReportDocument, which makes it 
part of the ReportDocument object model.

Pros

● Added security: report is embedded and therefore distributed as part of the application.
● Extensive programmatic interaction: provides access to the powerful ReportDocument object model.
● Added security: offers the most control over access to report sources.
● Most commonly used: most developers find that this scenario offers the most advantages.

Cons

● Added maintenance: changes to reports require recompiling and redistributing the application.

1.4.5.3.2.1.1  To bind to an embedded report class

When a report is created or imported, a report wrapper class is automatically generated to represent the report. 
This wrapper class has the same name as the report. It is derived from the base class ReportDocument, and 
therefore inherits all of the properties and methods of ReportDocument, which makes it part of the 
ReportDocument object model.

1. Add a CrystalReportViewer control to a Windows form.
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Note
All version of SAP Crystal Reports support binding to an embedded report class for Windows applications. 
Some configurations provide support for this binding scenario for Web sites through an enhanced build 
provider.

2. Add a report to the project. This automatically generates a report wrapper class with the same name as the 
report.

3. Instantiate the report wrapper class.

 Dim myReport As New QuarterlySalesReport() 
 QuarterlySalesReport myReport = new QuarterlySalesReport(); 

4. Assign it to the ReportSource property of the CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = myReport 
 crystalReportViewer.ReportSource = myReport; 

1.4.5.3.2.2  Binding to a Non-embedded Report Loaded into the 
ReportDocument Class

Object Model

This report binding scenario uses the ReportDocument object model.

Location of Reports

Reports are located in the file directory.

Description

This report binding scenario allows you to use the more powerful ReportDocument object model with non-
embedded reports, (reports that are external to your project).

In Binding to a File Directory Path in Code [page 149], you bind to reports by their file directory path strings; 
however, rather than bind the directory paths directly to the viewer, you pass them into the 
ReportDocument.Load() method. This allows you to use the ReportDocument object model.

Also, because each external report is loaded into the common class ReportDocument, you can develop a report 
selection process that shares common report binding code for all reports.
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Pros

● Low maintenance: reports can be added, removed or modified without recompiling your application.
● Extensive programmatic interaction: provides access to the powerful ReportDocument object model.
● Less coding through code sharing: reports can share code, because all reports are loaded into the common 

ReportDocument class.

Cons

● Limited distribution: reports must be on the same machine as the application. (Access from the Web server's 
ASPNET user account to other servers on the network is typically restricted.)

● Added deployment effort: reports must be distributed along with the application at the correct relative path.
● Less secure report source: there is a risk of reports being relocated/removed on the deployment machine at 

runtime.

1.4.5.3.2.2.1  To bind to a non-embedded report using the 
ReportDocument object model

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.

1. Add an "Imports" [Visual Basic] or "using" [C#] statement to the top of the class for the 
CrystalDecisions.CrystalReports.Engine namespace.

Note
Declaring this namespace is required in order to access the ReportDocument class without a namespace 
prefix.

 Imports CrystalDecisions.CrystalReports.Engine 
 using CrystalDecisions.CrystalReports.Engine; 

2. Locate the World Sales Report.rpt file in the General Business subdirectory for your particular version of SAP 
Crystal Reports.

3. Copy the complete file directory path to the clipboard, including World Sales Report.rpt.
4. Within the ConfigureCrystalReports() method (that you have created in Project Setup [page 15]), 

declare a reportPath string variable and assign a string that contains the World Sales Report file directory 
path that you copied in the previous step.
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Dim reportPath As String = _    "C:\Program Files\Microsoft Visual Studio 9.0\" _
   & "Crystal Reports\Samples\En\Reports\General Business\" _
   & "World Sales Report.rpt"  
 string reportPath =     "C:\\Program Files\\Microsoft Visual Studio 9.0\\"
   + "Crystal Reports\\Samples\\En\\Reports\\General Business\\"
   + "World Sales Report.rpt";  

5. Below the string declaration, declare an instance of ReportDocument.

 Dim myReportDocument As ReportDocument = New ReportDocument() 
 ReportDocument reportDocument = new ReportDocument(); 

6. Load the string variable. which contains the file directory path, to the non-embedded report into 
ReportDocument.

 myReportDocument.Load(reportPath) 
 reportDocument.Load(reportPath); 

7. Assign the ReportDocument instance (which now contains the loaded non-embedded report) to the 
ReportSource property of the CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = myReportDocument 
 crystalReportViewer.ReportSource = reportDocument; 

8. To view the report, build and run your project.

1.4.5.3.2.3   Binding to a Cached Embedded Report Class 

Object Model

This report binding scenario uses the ReportDocument object model.

Location of Reports 

Reports are embedded into the project.
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Description

When a report is embedded into a Visual Studio project, a report wrapper class that represents the report file in 
the project is automatically generated. At the same time, a cache management utility class for that report is also 
automatically generated.

In this scenario, you bind the CrystalReportViewer control to the cache management utility class, so that report 
caching into the ASP.NET Cache object is handled automatically.

Use of caching 

Caching has a limited and specific use, which can overuse system resources if not carefully managed.

Caching non-embedded reports 

If you want to manage the caching of non-embedded reports, you must create your own cache management 
utility class. For more information, see Binding to a Non-embedded Report Loaded into a Cache Management 
Utility Class [page 180].

Pros

● Made for shareability: ideal for storing reports that have high shareability and few permutations in parameters 
or logon information.

● Optimizes data access: if reports with high shareability are very large, or have a query that is so complex that 
it takes several minutes to retrieve, the data is accessed more quickly with the cache management utility 
class.

Cons

● Server taxing: reports that remain in the ASP.NET Cache object can burden memory resources on the server.
● Persistence issues: cache has certain dependencies that allow it to check for changes in a report instance and 

recache the report instance. However, if the database changes, the report instance in the Cache does not 
refresh to show that change.

● Consumes resources: a report with parameters that are called frequently with different parameter strings 
(especially if one of those parameters is the user id) mean a new cached report each time. This consumes 
system resources. If the report is not highly shared, the report instance should instead be assigned to a 
Session object.
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Related Information

Should I Use Regular or Cached Reports? [page 193]
ReportDocument Object Model [page 34]
Session and Persistence of the ReportDocument Object Model [page 52]

1.4.5.3.2.3.1   To bind to a cache management utility class 

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.

1. Within the ConfigureCrystalReports() method (that you created in Project Setup [page 15]), delete the 
existing lines of code to replace the report wrapper class with the cache management utility class.

2. Instantiate the cache management utility class that is associated with the Hierarchical Grouping.rpt.

 Dim cachedHierarchicalGroupingReport As CachedHierarchical_Grouping
= New CachedHierarchical_Grouping() 
 CachedHierarchical_Grouping cachedHierarchicalGroupingReport = new
CachedHierarchical_Grouping(); 

3. Pass the cache management utility instance to the CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = cachedHierarchicalGroupingReport 
 crystalReportViewer.ReportSource = cachedHierarchicalGroupingReport; 

4. To view the report, build and run your project.

1.4.5.3.2.4  Binding to a Non-embedded Report Loaded into a 
Cache Management Utility Class

Object Model

This report binding scenario uses the ReportDocument object model.

Location of Reports

Reports are located on the file directory.
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Description

This report binding scenario is similar to the following report binding scenario Binding to a Cached Embedded 
Report Class [page 178]. The difference with this scenario is that reports are not embedded. For more information 
about non-embedded reports, see Comparing Embedded and Non-embedded Reports [page 143].

SAP Crystal Reports, developer version for Microsoft Visual Studiocomes with two features to assist in the 
caching of reports with the ASP.NET Cache object:

● A built-in report cache management framework, which recognizes when identical reports have unique 
parameters or logon credentials that require a unique key for each instance being cached.

● An interface, ICachedReport that identifies report cache management utility classes to the report cache 
management framework.

In Binding to a Cached Embedded Report Class [page 178], you learned about the Cached[report name] class that 
is automatically created when a report is embedded in the project. However, you can manually create a cache 
management utility class that manages non-embedded reports. For a code sample, see the Implementation 
section below.

Use of caching

Caching has a limited and specific use, which can overuse system resources if not managed carefully.

Pros

● Made for shareability: ideal for storing reports that have high shareability and few permutations in parameters 
or logon information.

● Optimizes data access: if reports with high shareability are very large, or have a query that is so complex that 
it takes several minutes to retrieve, the data is accessed more quickly with the cache management utility 
class.

Cons

● Server taxing: reports that remain in the ASP.NET Cache object can burden memory resources on the server.
● Persistence issues: cache has certain dependencies that allow it to check for changes in a report instance and 

recache the report instance. However, if the database changes, the report instance in the Cache does not 
refresh to show that change.

● Consumes resources: a report with parameters that are called frequently with different parameter strings 
(especially if one of those parameters is the user id) mean a new cached report each time. This consumes 
system resources. If the report is not highly shared, the report instance should instead be assigned to a 
Session object.
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Related Information

Binding with the ReportDocument Component [page 186]
ReportDocument Object Model [page 34]
Session and Persistence of the ReportDocument Object Model [page 52]

1.4.5.3.2.4.1   To cache and then bind a non-embedded report 
to a CrystalReportViewer control 

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.

1. Locate the World Sales Report.rpt file in the General Business subdirectory.
2. Copy to the clipboard the complete file directory path, including World Sales Report.rpt.
3. Within the ConfigureCrystalReports() method (that you created in Project Setup [page 15]), declare a 

reportPath string variable and assign a string that contains the World Sales Report file directory path that you 
copied in the previous step.

 Dim reportPath As String = _    "C:\Program Files\Microsoft Visual Studio 9.0\" _
   & "Crystal Reports\Samples\En\Reports\General Business\" _
   & "World Sales Report.rpt"  
 string reportPath =     "C:\\Program Files\\Microsoft Visual Studio 9.0\\"
   + "Crystal Reports\\Samples\\En\\Reports\\General Business\\"
   + "World Sales Report.rpt";  

4. Declare and instantiate the NonEmbeddedReportCacher class, and then pass to it the reportFile string 
variable.

Note
To learn how to create the NonEmbeddedReportCacher class, see the step procedure following this step 
procedure.

 Dim myNonEmbeddedReportCacher As NonEmbeddedReportCacher = _New 
NonEmbeddedReportCacher(reportFile) 
 NonEmbeddedReportCacher nonEmbeddedReportCacher = new 
NonEmbeddedReportCacher(reportFile); 

5. Assign the report cache management utility class instance to the ReportSource property of the 
CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = myNonEmbeddedReportCacher
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 crystalReportViewer.ReportSource = nonEmbeddedReportCacher; 

1.4.5.3.2.4.2  To create the NonEmbeddedReportCacher cache 
management utility class

1. Create a new class in your project named NonEmbeddedReportCacher.

 Public Class NonEmbeddedReportCacher
    
End Class 
 using System;
namespace MyWebApplication
{
   public class NonEmbeddedReportCacher
   {
      public NonEmbeddedReportCacher()
      {
      }
   } }

2. Append the ICachedReport interface to the class signature.

 Public Class NonEmbeddedReportCacher
    Implements ICachedReport 

public class NonEmbeddedReportCacher : ICachedReport

3. Add three "Imports" [Visual Basic] or "using" [C#] statements to the top of the class.

 Imports CrystalDecisions.Shared
Imports CrystalDecisions.ReportSource
Imports CrystalDecisions.CrystalReports.Engine 
 using CrystalDecisions.Shared;
using CrystalDecisions.ReportSource;
using CrystalDecisions.CrystalReports.Engine; 

4. Within the class, declare two class-level instances: a string instance named reportFileName and a 
ReportDocument instance named nonEmbeddedReportDocument.

 Private reportFileName As String
Private nonEmbeddedReportDocument As ReportDocument 
 private string reportFileName;
private ReportDocument nonEmbeddedReportDocument; 

5. Set the constructor to accept a reportFileName string, and within the constructor, assign that string to the 
reportFileName class variable.

 Public Sub New(ByVal reportFileName As String)
    Me.reportFileName = reportFileName
End Sub
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 public NonEmbeddedReportCacher(string reportFileName)
{
   this.reportFileName = reportFileName;
} 

The remaining steps all implement properties or methods that are required by the interface:
○ IsCacheable
○ ShareDBLogonInfo
○ CacheTimeOut
○ CreateReport()
○ GetCustomizedCacheKey(RequestContext request)

6. Create the IsCacheable property, which should return True.

 Public Overridable Property IsCacheable() As Boolean Implements 
ICachedReport.IsCacheable
    Get
        Return True
    End Get
    Set(ByVal Value As Boolean)
    End Set
End Property 
 public virtual Boolean IsCacheable
{
   get
   {
      return true;
   }
   set
   {
   }
} 

7. Create the ShareDBLogonInfo property, which should return False.

 Public Overridable Property ShareDBLogonInfo() As Boolean Implements 
ICachedReport.ShareDBLogonInfo
    Get
        Return False
    End Get
    Set(ByVal Value As Boolean)
    End Set
End Property 
 public virtual Boolean ShareDBLogonInfo
{
   get
   {
      return false;
   }
   set
   {
   }
} 

8. Create the CacheTimeOut property, which returns a constant from the CachedReportConstants class.

 Public Overridable Property CacheTimeOut() As TimeSpan Implements 
ICachedReport.CacheTimeOut
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    Get
        Return CachedReportConstants.DEFAULT_TIMEOUT
    End Get
    Set(ByVal Value As TimeSpan)
    End Set
End Property 
 public virtual TimeSpan CacheTimeOut
{
   get
   {
      return CachedReportConstants.DEFAULT_TIMEOUT;
   }
   set
   {
   }
} 

9. Create the CreateReport() method, which returns a non-embedded report loaded into the class level 
ReportDocument instance.

 Public Overridable Function CreateReport() As ReportDocument Implements 
ICachedReport.CreateReport
    nonEmbeddedReportDocument = New ReportDocument()
    nonEmbeddedReportDocument.Load(reportFileName)
    Return nonEmbeddedReportDocument
End Function 
 public virtual ReportDocument CreateReport()
{
   nonEmbeddedReportDocument = new ReportDocument();
   nonEmbeddedReportDocument.Load(reportFileName);
   return nonEmbeddedReportDocument;
} 

10. Create the GetCustomizedCacheKey() method and return null.

Note
Returning null from this method cues the SAP Crystal Reports .NET SDK to manage the cache lookup key 
itself. The alternative is to create and add your own customized cache key method here.

 Public Overridable Function GetCustomizedCacheKey(ByVal request As 
RequestContext) As String Implements ICachedReport.GetCustomizedCacheKey
    Return Nothing
End Function 
 public virtual String GetCustomizedCacheKey(RequestContext request)
{
   return null;
} 

11. To view the report, build and run your project.
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1.4.5.3.2.5  Binding with the ReportDocument Component

Object Model

This report binding scenario uses the ReportDocument object model.

Location of Reports

Reports are located on the file directory.

Description

The ReportDocument component is located in the Toolbox and provides a GUI-based method to generate class 
instantiation code for the report in the code-behind class. You can specify a non-embedded report, an embedded 
report, or a cached embedded report.

Note
The dialog box uses the legacy terms "untyped report" to refer to a non-embedded report and "strongly-typed 
report" to refer to an embedded report.

Using this dialog box to add ReportDocument as a component causes the ReportDocument class (or the 
embedded report's wrapper class) to be instantiated within the auto-generated region of the code-behind class. 
At the same time, an icon appears in the component tray of the IDE to visually represent the instantiated report 
class.

Note
You do not need to add a ReportDocument component in your project to instantiate the report in the code-
behind class. For greater control over your code, it is recommended that you add the class instantiation code 
manually.

Related Information

ReportDocument Object Model [page 34]
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1.4.5.3.2.6  ReportDocument Binding Scenarios that Use 
Crystal Services (VS.NET 2003)

Crystal Services provides convenient access reports in Visual Studio 2003. This feature is not available in Visual 
Studio 2005 or Visual Studio 2008. When SAP Crystal Reports and Crystal Services are both installed, Crystal 
Services appears as a sub node beneath each server within the Servers node of Server Explorer. The Crystal 
Services node expands to display lists of reports from various locations:

● The local file directory on your hard drive.
● Report Application Server (RAS)
● SAP Business Intelligence platform (BIP)

You can drag and drop any report from these lists onto a Web or Windows form.

Crystal Services typically exposes two sub nodes that may be expandable, depending on the version of SAP 
Crystal Reports that you have currently installed, and on any additional licensing that you may have for Report 
Application Server (RAS) or SAP BusinessObjects Business Intelligence platform. The table that is within the next 
section below describes the requirements to access a particular node.

Note
Some versions of SAP BusinessObjects Business Intelligence platform do not include support for Crystal 
Services. Consult the SAP BusinessObjects Business Intelligence platform documentation for more 
information.

You may have to adjust your firewall settings in order to access the SAP BusinessObjects Business Intelligence 
platform CMS. The default port for the CMS is 6400. Contact your system administrator for more information on 
network address and port settings for your SAP BusinessObjects Business Intelligence platform system. More 
information on customizing ports can be found in the SAP BusinessObjects Business Intelligence platform 
Administrators Guide.

Wrapper classes

When you drag a report from Crystal Services onto a Web or Windows Form, this creates a wrapper class instance 
that references the report in the Web or Windows Form Generated Code region of the code-behind class.

Note
The wrapper class type varies across versions of SAP Crystal Reports. See the table below.

The Crystal Services listed in the table below expose ReportDocument wrapper class types.

These two Crystal Services ship with SAP Crystal Reports 10. They expose groups of reports that are served from 
an unmanaged RAS server or a managed RAS server. The wrapper class has been changed (since SAP Crystal 
Reports 9) to ReportDocument.
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Table 8:

Wrapper class ex
posed through Crystal 
Services

Node name under 
Crystal Services

SAP Crystal Reports 
versions

Description What is required to ac
cess this node?

ReportDocument Report Application 
Server

SAP Crystal Reports 10 Exposes reports from a 
RAS server loaded into 
ReportDocument. For 
more information, see 
Binding to Report Ap
plication Server (SAP 
Crystal Reports 10 and 
up) [page 188].

Install an unmanaged 
RAS server.

ReportDocument Crystal Enterprise SAP Crystal Reports 10 Exposes reports from 
the managed RAS 
server, which is loaded 
into ReportDocument. 
For more information, 
see Binding to Crystal 
Enterprise (SAP Crystal 
Reports 10 and up) 
[page 190].

Install Crystal Enter
prise.

Earlier versions of Crystal Services expose wrapper class types that do not use the ReportDocument object 
model. Therefore they depend upon the limited object model provided with the CrystalReportViewer control. For 
more information, see CrystalReportViewer Binding Scenarios that Use Crystal Services [page 156].

1.4.5.3.2.6.1  Binding to Report Application Server (SAP Crystal 
Reports 10 and up)

Note
This page describes functionality that is not available in SAP Crystal Reports, developer version for Microsoft 
Visual Studio, but is available in one of the upgraded versions.

Object Model

This report binding scenario uses the ReportDocument object model.

Location of Reports

Reports are located on the unmanaged RAS server. The report is wrapped in the ReportDocument class.
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Crystal Services Overview

This report binding scenario applies to reports accessed from the Crystal Services server node in the Server 
Explorer.

This section examines the Report Application Server sub node of Crystal Services, within SAP Crystal Reports 
Developer.

[SERVERNAME]

● Crystal Services
○ Report Application Server

Description

The Report Application Server sub node accesses and then displays reports that have been exposed by an 
unmanaged RAS server. The RAS node is functional only when unmanaged RAS has been installed on your 
development machine.

When you drag and drop a report from the Crystal Services>BusinessObjects Business Intelligence platform node 
onto a Web or Windows Form, an instance of ReportDocument is generated. The ReportDocument class works as 
a wrapper class. Its purpose is to wrap (represent) the report that is passed from the unmanaged RAS server.

Pros

● Uncomplicated access: reports from the unmanaged RAS server can be easily viewed in a tree view and 
dragged onto a Web Form.

● Extensive programmatic interaction: provides access to the powerful ReportDocument object model. The 
report wrapper class in this version is ReportDocument. This is the first version of Crystal Services that gives 
you access to the ReportDocument object model.

Cons

● Coding is less direct: not as direct as coding RAS reports with the ReportClientDocument object model.

Related Information

Binding to Crystal Enterprise (SAP Crystal Reports 10 and up) [page 190]
ReportDocument Object Model [page 34]
Using Crystal Services [page 77]
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1.4.5.3.2.6.1.1  To use Crystal Services>Report Application 
Server

● SAP Crystal Reports 10 or greater is installed and verified to be working.
● The unmanaged RAS server is installed and verified to be working.

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.

1. In Visual Studio, open Server Explorer.
2. Expand Crystal Services, and then expand Report Application Server.
3. Select a report from the Report Application Server tree and drag it onto your Web or Windows Form.

At the bottom of the form in Design view, a reportDocument1 object appears.

Note
When a Report Application Server report is placed onto your form, an instance of ReportDocument class 
is added to the Designer generated code region of your form.

When classes that inherit from System.ComponentModel.Component (such as ReportDocument) are 
instantiated and configured within the Designer generated code region, an icon of this instantiated class 
appears at the bottom of the form in Design view.

4. Switch to code view, and open the Web or Windows Form Designer generated code region.

Note
A ReportDocument class has been instantiated and configured within this region.

5. Within the ConfigureCrystalReports() method (that you created in Project Setup [page 15]), assign the 
ReportDocument instance to the ReportSource property of the CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = reportDocument1 
 crystalReportViewer.ReportSource = reportDocument1; 

6. To view the report, build and run your project.

1.4.5.3.2.6.2  Binding to Crystal Enterprise (SAP Crystal 
Reports 10 and up)

Note
This page describes functionality that is not available in SAP Crystal Reports, developer version for Microsoft 
Visual Studio, but is available in one of the upgraded versions.
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Object Model

This report binding scenario uses the ReportDocument object model.

Location of Reports

Reports are located in the managed RAS server. Reports are wrapped in the ReportDocument class.

Crystal Services Overview

This report binding scenario applies to reports accessed from the Crystal Services server node in the Server 
Explorer.

This section examines the SAP BusinessObjects Business Intelligence platform sub node of Crystal Services, 
within SAP Crystal Reports Developer.

[SERVERNAME]

● Crystal Services
○ Crystal Enterprise

Description

The SAP BusinessObjects Business Intelligence platform sub node accesses and then displays reports that have 
been exposed by a managed RAS server within SAP BusinessObjects Business Intelligence platform.

The Crystal Services>SAP BusinessObjects Business Intelligence platform node exposes reports from the Crystal 
Enterprise, through the managed RAS server. The SAP BusinessObjects Business Intelligence platform node is 
functional, but if SAP BusinessObjects Business Intelligence platform has not been installed on the development 
machine, go to the Properties for this node and set the SAP BusinessObjects Business Intelligence platform 
server name on the network.

When you drag and drop a report from the Crystal Services>BusinessObjects Business Intelligence platform node 
onto a Web or Windows form, an instance of ReportDocument is generated. The ReportDocument class works as 
a wrapper class. Its purpose is to wrap (represent) the report that is passed from the RAS server within Crystal 
Enterprise.

Pros

● Easy access: easy access to RAS reports within Crystal Enterprise from a Web application.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 191



● Extensive programmatic interaction: provides access to the powerful ReportDocument object model. The 
report wrapper class in this version is ReportDocument. This is the first version of Crystal Services that gives 
you access to the ReportDocument object model.

Cons

● Coding is less direct: not as direct as coding RAS reports with the ReportClientDocument object model.

Related Information

Using Crystal Services [page 77]

1.4.5.3.2.6.2.1  To use Crystal Services>Crystal Enterprise

● SAP Crystal Reports 10 or XI is installed and verified to be working.

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.

1. In Visual Studio, open Server Explorer.
2. Expand Crystal Services, and then expand Crystal Enterprise.
3. Select a report from the Crystal Enterprise tree and drag it onto your form.

At the bottom of the form in Design view, a reportDocument1 object appears.

Note
When a Crystal Enterprise report is placed onto your form, an instance of ReportDocument class is added 
to the Designer generated code region of your form.

When classes that inherit from System.ComponentModel.Component (such as ReportDocument) are 
instantiated and configured within the Designer generated code region, an icon of this instantiated class 
appears at the bottom of the form in Design view.

4. Switch to code view and open the Web or Windows Form Designer generated code region.
A ReportDocument class has been instantiated and configured within this region.

5. Within the ConfigureCrystalReports() method (that you created in Project Setup [page 15]), assign the 
ReportDocument instance to the ReportSource property of the CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = reportDocument1 
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 crystalReportViewer.ReportSource = reportDocument1; 
6. Build and run your Web project to view the report.

1.4.5.4 Should I Use Regular or Cached Reports?

When you plan an application to build with the SAP Crystal Reports SDK, one of your most important 
considerations is whether to use regular or cached reports. Learning the SDK fundamentals that affect report 
caching helps you to choose the best structure for your SAP Crystal Reports, developer version for Microsoft 
Visual Studio project.

What are cached reports?

Cached reports are report objects that have been stored in the ASP.NET Cache object, to increase performance 
and scalability. SAP Crystal Reports supplies a specific framework for placing ReportDocument instances in the 
Cache. That framework automatically caches any report that implements the ICachedReport interface.

What is the ASP.NET Cache object?

In both ASP and ASP.NET, report objects are placed in Session or Application on the Web server, for two reasons:

1. To persist the state of the report object across page reloads.
2. To improve scalability and performance by placing large or slow-to-load reports into server memory.

In ASP.NET, an augmented variation of the Application object called Cache was introduced. Like Application, 
Cache still persists single instances of a report object. However, Cache adds intelligence that looks for file-based, 
key-based or time-based dependencies. These dependencies can automatically expire and even refresh report 
objects within the Cache, to keep the contents of the Cache current.

Reports stored in Cache are both user specific and session specific.

Note
The terms "Cache object" and "Cache" are used interchangeably, as are the terms "Session object" and 
"Session" or "Application object" and "Application," but they mean the same thing. The term "object" 
emphasizes that these are persistence objects that run within the .NET Framework memory space on the Web 
server.

How are report objects placed into the ASP.NET Cache object?

You can place report objects into the ASP.NET Cache object two ways:
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● Assign the report object to Cache with the same syntax that assigns a report object to Session or Application 
(explicit assignment).

● Instantiate a version of the report that implements the ICachedReport interface. The report engine looks for 
any report object that implements this interface and automatically places that report object into the Cache 
(implicit assignment).

What is the ICachedReport interface?

The ICachedReport interface flags any report classes that enable ICachedReport to work with the SAP Crystal 
Reports caching framework. This customized framework provides a layer over the ASP.NET Cache object, to meet 
specific needs of report caching.

The ICachedReport interface comes with method signatures that, when implemented in the report class, tells the 
framework how to cache that particular class.

What report caching features are provided when I embed a report into a Visual 
Studio project?

When you create or import a report into a Visual Studio project, that report is embedded into the project and two 
classes are automatically generated:

● A report wrapper class (with the same name as the report).
This wrapper class represents the report in the project and inherits from ReportDocument. For more 
information, see Comparing Embedded and Non-embedded Reports [page 143].

● A cache management utility class (named Cached[ReportName] class).
This cache management utility class handles the caching for that embedded report, by use of the ASP.NET 
Cache object and the caching framework that is built into the SAP Crystal Reports SDK.

The following table shows the items that are generated when you add the Hierarchical Grouping report:

Table 9:

What is it named? What is it?

Hierarchical Grouping.rpt The report

Hierarchical_Grouping class The report wrapper class

CachedHierarchical_Grouping class The cache management utility class is used to manage cach
ing for the report wrapper class

The report wrapper class and the cache management utility class have separate tasks:

● The report wrapper class inherits from ReportDocument and, therefore, has access to the complete 
ReportDocument object model. It is the core class that you program against to interact with the report.

● The cache management utility class manages and stores instances of the report wrapper class into the 
ASP.NET Cache object. It recognizes distinct instances of the report wrapper class and prevents those 
instances from overwriting each other in the Cache. For example, it recognizes differences that are created 
when parameters and logons are changed. To do that, it assigns a unique key for each unique instance of the 
report wrapper class.
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● To identify itself to the caching functionality of the SAP Crystal Reports .NET Framework, the cache 
management utility class implements the ICachedReport interface.

Both the report wrapper class and cache management utility class are generated in the same class file. To view 
both classes, right-click on the report class file in Solution Explorer, and choose View Code. When the file opens, 
you can find code for the report wrapper class at the top of the file, and the cache management utility class half 
way down.

Note
To learn how to bind the CrystalReportViewer control to this cache management utility class, see Binding to a 
Cached Embedded Report Class [page 178]. To create your own cache management utility class to bind to non-
embedded reports, see Binding to a Non-embedded Report Loaded into a Cache Management Utility Class 
[page 180].

When should I cache reports?

Keep only a low percentage of report objects in the ASP.NET Cache object. Most report objects have low 
shareability (that is, they are not used as shared resources with other objects). Therefore, they don't make 
economical use of Cache. If persistence is required, place report objects in the user's Session object instead.

Place the report object into ASP.NET Cache only when the report will be viewed many times by the same user in a 
given session. This is particularly important if the report object is very large or has a query that is so complex that 
it takes several minutes to retrieve the data.

Related Information

Binding to a Cached Embedded Report Class [page 178]

1.4.5.5 Viewing a report at design time

SAP Crystal Reports lets you preview a report at design time within Visual Studio. When a report is assigned to the 
ReportSource property in the Properties window, a preview of the report is displayed in the Windows Form, or 
ASPX page.

Static data, such as dates, images or text fields, will display as it will appear at run time. Dynamic data, such as 
data from a database, may use artificial values in place of data from your data source. If your report contains 
saved data, then that saved data will appear in the design time preview.

The Embedded SAP Crystal Reports Designer provides additional viewing functionality through the Preview tab. 
When you view your report in the Preview tab SAP Crystal Reports will attempt to fetch new data from the 
specified data source. The design time preview will not attempt to fetch data. Instead, it will display any data 
currently saved in the report.
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Note
The Preview tab is not available in the embedded SAP Crystal Reports Designer for Visual Studio .NET 2003.

Related Information

Preview Tab [page 541]

1.4.6  Customizing the CrystalReportViewer control

The CrystalReportViewer control is used in the .NET Framework to bind to and display reports. The default 
CrystalReportViewer control includes UI elements to assist in viewing, saving and navigating through a report.

Depending upon your application, you may wish to modify some elements of the default control. SAP Crystal 
Reports allows you to customize the look and feel of the viewer in your application in a number of different ways, 
including:

● The CrystalReportViewer toolbar can be removed from the viewer.
● The buttons on the CrystalReportViewer toolbar can be added or removed programmatically.
● The CrystalReportViewer control supports customization through CSS or Themes.

This section details how to modify the viewer control for your application.

Classes used for viewing reports

● CrystalDecisions.Windows.Forms.CrystalReportViewer
Provides properties, methods, and events that modify or retrieve information about how the 
CrystalReportViewer control appears and functions.

● CrystalDecisions.Web.CrystalReportViewer
Provides properties, methods, and events that modify or retrieve information about how the 
CrystalReportViewer control appears and functions.

Related Information

How Do I Use Report Viewer Controls? [page 40]
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1.4.6.1 Report Processing Indicator

The Report Processing Indicator provides a visual indication of processing time in your SAP Crystal Reports Web 
Site. When report processing time exceeds a specified threshold, a dialog box will appear to provide an indication 
of the progress of the current action.

The text of the dialog box, and the time delay before the box appears, can both be specified in the Web.Config 
file for your Web Site.

The default text is: Please wait while the document is being processed.

The default time before the Report Processing Indicator appears is 200 ms.

Related Information

Configuring your Web.Config file [page 18]

1.4.6.1.1 To customize the text of the Report Processing 
Indicator

The message text of the Report Processing Indicator is configured in the Web.Config file for your Web Site.

1. Add a CrystalReportViewer control to your application.
2. Open your Web.Config file.

If you do not have a Web.Config file, click Debug Start Debugging  to debug your application. Visual 
Studio will prompt you to create a new Web.Config file. Click OK to create the new file.

3. In your Web.Config file, add the NameValueSectionHandler setting as the first child of the configuration 
element.

   <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="crystalReportViewer" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections> 

The configSections element must be the unique, first child, of the configuration element. If you already 
have a configSections element for SAP Crystal Reports, add the section element for the 
CrystalReportViewer to the existing configSections node.

4. Add the processingIndicatorText setting directly after the configSections element.

   <businessObjects>
    <crystalReports>
      <crystalReportViewer>
        <add key="processingIndicatorText" value="Thank you for waiting"/>
      </crystalReportViewer>
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    </crystalReports>
  </businessObjects> 

5. Replace the text of the value attribute with the message that you would like to appear in the Report 
Processing Indicator.

The processingIndicatorText element controls the text displayed in the report processing indicator. The 
default text is: Please wait while the document is being processed.

The CrystalReportViewer control should now use the custom message in the Report Processing Indicator.

Example
This example reduces the delay of the Report Processing Indicator to 20 ms, and changes the display message 
to “Thank you for waiting”.

 <?xml version="1.0"?>
<configuration>
  <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="crystalReportViewer" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections>
  <businessObjects>
    <crystalReports>
      <crystalReportViewer>
        <add key="processingIndicatorText" value="Thank you for waiting."/>
        <add key="processingIndicatorDelay" value="20"/>
      </crystalReportViewer>
    </crystalReports>
  </businessObjects>
  <appSettings>
    <add key="CrystalImageCleaner-AutoStart" value="true"/>
    <add key="CrystalImageCleaner-Sleep" value="60000"/>
    <add key="CrystalImageCleaner-Age" value="120000"/>
  </appSettings>
  <connectionStrings/>
  <system.web>
    <compilation debug="true">
      <assemblies>
        <add assembly="CrystalDecisions.Web, Version=12.0.2000.0, 
Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
        <add assembly="CrystalDecisions.Shared, Version=12.0.2000.0, 
Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
        <add assembly="CrystalDecisions.ReportSource, Version=12.0.2000.0, 
Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
        <add assembly="CrystalDecisions.CrystalReports.Engine, 
Version=12.0.2000.0, Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
      </assemblies>
    </compilation>
    <authentication mode="Windows"/>
    <httpHandlers>
      <add verb="GET" path="CrystalImageHandler.aspx" 
type="CrystalDecisions.Web.CrystalImageHandler, CrystalDecisions.Web, 
Version=12.0.2000.0, Culture=neutral, PublicKeyToken=692fbea5521e1304"/>
    </httpHandlers>
  </system.web>
</configuration> 
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1.4.6.1.2 To change the delay before the Report Processing 
Indicator appears

The delay before the Report Processing Indicator appears is configured in the Web.Config file for your Web Site. 
The processingIndicatorDelay element controls the time delay before the report processing indicator 
appears.

1. Add a CrystalReportViewer control to your application.
2. Open your Web.Config file.

If you do not have a Web.Config file, click Debug Start Debugging  to debug your application. Visual 
Studio will prompt you to create a new Web.Config file. Click OK to create the new file.

3. In your Web.Config file, add the NameValueSectionHandler setting as the first child of the configuration 
element.

   <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="crystalReportViewer" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
  </configSections> 

The configSections element must be the unique, first child, of the configuration element. If you already 
have a configSections element for SAP Crystal Reports, add the section element for the 
CrystalReportViewer to the existing configSections node.

4. Add the processingIndicatorDelay setting directly after the configSections element.

   <businessObjects>
    <crystalReports>
      <crystalReportViewer>
        <add key="processingIndicatorDelay" value="20"/>
      </crystalReportViewer>
    </crystalReports>
  </businessObjects> 

5. Replace the text of the value attribute with the amount of time that should pass before the Report 
Processing Indicator appears.

The value is specified in milliseconds. Setting this value to 0 will disable the report processing indicator. The 
default value is 200 ms.

Example
This example reduces the delay of the Report Processing Indicator to 20 ms, and changes the display message 
to “Thank you for waiting”.

 <?xml version="1.0"?>
<configuration>
  <configSections>
    <sectionGroup name="businessObjects">
      <sectionGroup name="crystalReports">
        <section name="crystalReportViewer" 
type="System.Configuration.NameValueSectionHandler" />
      </sectionGroup>
    </sectionGroup>
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  </configSections>
  <businessObjects>
    <crystalReports>
      <crystalReportViewer>
        <add key="processingIndicatorText" value="Thank you for waiting."/>
        <add key="processingIndicatorDelay" value="20"/>
      </crystalReportViewer>
    </crystalReports>
  </businessObjects>
  <appSettings>
    <add key="CrystalImageCleaner-AutoStart" value="true"/>
    <add key="CrystalImageCleaner-Sleep" value="60000"/>
    <add key="CrystalImageCleaner-Age" value="120000"/>
  </appSettings>
  <connectionStrings/>
  <system.web>
    <compilation debug="true">
      <assemblies>
        <add assembly="CrystalDecisions.Web, Version=12.0.2000.0, 
Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
        <add assembly="CrystalDecisions.Shared, Version=12.0.2000.0, 
Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
        <add assembly="CrystalDecisions.ReportSource, Version=12.0.2000.0, 
Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
        <add assembly="CrystalDecisions.CrystalReports.Engine, 
Version=12.0.2000.0, Culture=neutral, PublicKeyToken=692FBEA5521E1304"/>
      </assemblies>
    </compilation>
    <authentication mode="Windows"/>
    <httpHandlers>
      <add verb="GET" path="CrystalImageHandler.aspx" 
type="CrystalDecisions.Web.CrystalImageHandler, CrystalDecisions.Web, 
Version=12.0.2000.0, Culture=neutral, PublicKeyToken=692fbea5521e1304"/>
    </httpHandlers>
  </system.web>
</configuration> 

1.4.6.2 Supporting multiple languages with the 
CrystalReportViewer control

SAP Crystal Reports, developer version for Microsoft Visual Studioincludes support for multilingual Web and 
Windows clients, through dynamic localization.

Dynamic localization allows users to view ToolTips and other content of the CrystalReportViewer control in their 
preferred language. To enable dynamic localization, you must make available language resource files in the 
desired language.

Related Information

Tutorial: Configuring Multilingual Client Support [page 488]
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1.4.6.2.1 Language Resource Files

Language resource files contain a series of key/value pairs that supply the text displayed in the application. For 
each element of text that appears in a Crystal Report application, there is a corresponding value in the Language 
Resource file that specifies how that text should appear for each language.

Language Resources Files

On the Web server or Windows client, you can access language resources for the CrystalReportViewer control 
from two possible sources:

● Default language resource DLLs, which include the following:
○ English (en)
○ French (fr)
○ German (de)
○ Spanish (es)
○ Italian (it)
○ Japanese (jp)
○ Korean (ko)
○ Simplified Chinese (zh-chs)
○ Traditional Chinese (zh-cht)

● Custom language resource files, which you create as text strings and then compile as custom language 
resource DLLs.

Neutral and Non-neutral Resources

Language resources include both neutral and non-neutral resources.

Neutral resources represent a general language setting, such as en (for English), fr (for French), and jp (for 
Japanese).

Non-neutral resources represent a version of the language that is qualified based on an additional criterion, such 
as region: for example, de-AT for German (Austria).

Global and Local Resources

Default language resources are installed in the GAC and therefore are always available globally, but custom 
language resources may be accessed either globally or locally.

The custom language resources folder may be stored in a central location and shared from that location, or it may 
be copied to the local directory of the Web or Windows application.

When the custom language resources are stored in a central location, the resources are referred to as global 
resources. In that scenario, the Web or Windows application must be informed of their location by settings in an 
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XML configuration file. For a global resource to load correctly, the name of the folder that contains the resource 
files must match the language locale.

If the custom language resources are copied to the local directory, the resources are referred to as local 
resources. In that scenario, no configuration file is necessary. For a local resource to load correctly, the culture of 
the resource files and the name of the folder that contains the resource files must match the language locale.

Choosing to Use Global or Local Resources

Global resources are the preferred choice when resources must be shared with more than one application. For 
example a Web server, with multiple Web sites that require a common set of language resources to be shared 
across all Web sites, is best suited to use global resources.

Local resources are preferred when resources are used by a single application, whose wide distribution mandates 
a simple configuration. For example a Windows application, which consists of a single application folder that is 
intended for wide distribution, is best suited to use local resources.

In most cases, Web applications are best suited for global resources, and Windows applications are best suited for 
local resources.

Which resource loads first?

If you configure both local and global resources for a particular application, the local resources take higher priority 
(they come first in the load order). If you want to guarantee that global resources are used, verify that your 
configuration file is correct, and remove the local resources folder.

Non-neutral and neutral resources are also affected by the resource loading order. If you have configured both 
non-neutral and neutral resources for a particular language (such as, "German (Austria)" and "German"), the non-
neutral resource is checked first.

In both cases, the specific takes precedence over the general.

Client-side display

The following factors determine the language that the client application displays at runtime:

In a Windows application:

● The Environment Locale settings on each user's machine.

In a Web Site:

● The Environment Locale settings of the Web server.
● The Language settings of the client browser.
● The Culture property, which you set on a separate ASPX page.
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1.4.6.2.2 Unicode and GB18030 Character Encoding Support

SAP Crystal Reports, developer version for Microsoft Visual Studioprovides support for international characters in 
the following character set standards:

● Unicode
● GB18030

In order to understand how SAP Crystal Reports supports Unicode and GB18030 encoding, you need to 
understand the three different views of characters (character repertoire, characters as code points, characters as 
encoded data). You also need to understand the relationship between code points (a more precise term for 
encoded characters) and code units.

1.4.6.2.2.1  Character Views

To understand character set standards, you must distinguish between three distinct views of the characters:

● Character repertoire (the abstract list of characters).
● Characters as code points with scalar values.
● Characters as encoded data.

Character repertoire (the abstract list of characters)

The character repertoire is an abstract list of more than one million characters found in a wide variety of scripts 
including Latin, Cyrillic, Chinese, Korean, Japanese, Hebrew, and Aramaic. Other symbols such as musical 
notation are also included in the character repertoire.

Both the Unicode and GB18030 standards have a character repertoire. As new characters are added to one 
standard, the other standard also adds those characters, to maintain parity.

Characters as code points with scalar values

Note
This second character view applies only to Unicode, not to GB18030.

Each character in the character repertoire is assigned to a code point. Each code point has a specific numerical 
value, called its scalar value. The scalar value is often expressed in hexadecimal.

Code points exist in a code space. The code space consists of a range of scalar values, which are divided across 
two planes:

● Basic Multilingual Plane (64k in size).
In Unicode, the hexadecimal expression of the values in this lower plane range from U+0000 to U+FFFF.
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● Supplemental Multilingual Plane (16 additional sections of 64k in size).
In Unicode, the hexadecimal expression of the values in this upper plane range from U+10000 to U+10FFFF.

The complete code space for all possible scalar values is 17 * 64k in size (1,088,000 possible values).

Characters as encoded data

Each encoding form converts characters from the character repertoire to encoded data.

In GB18030, the encoded data is derived directly from the character repertoire: the concept of a scalar value as an 
intermediary between the character repertoire and the encoded data is limited to Unicode only.

In Unicode, the encoded data is derived by applying an algorithm to the scalar value.

Unicode defines three character encoding forms:

● UTF-8
● UTF-16
● UTF-32

1.4.6.2.2.2  Relationship of Code Points and Code Units

To understand how SAP Crystal Reports, developer version for Microsoft Visual Studio</pname> support 
GB18030 and Unicode, it is important to understand the relationship between code points and code units.

Code points and code units

In each encoding, the code points are mapped to one or more code units.

A code unit is a single unit within each encoding form. The code unit size is equivalent to the bit measurement for 
the particular encoding:

● A code unit in UTF-8 consists of 8 bits.
● A code unit in UTF-16 consists of 16 bits.
● A code unit in UTF-32 consists of 32 bits.
● In GB18030, a code unit consists of 8 bits.

Number of code units in each code point

The number of code units required to be mapped to a code point varies across encoding forms:

● UTF-8
Multiple code units per code point are common in UTF-8 because of the smaller code units. The code points 
will be mapped to one, two, three, or four code units.
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● UTF-16
UTF-16 code units are twice as large as 8-bit code units. Therefore, any code points with a scalar value less 
than U+10000 is encoded with a single code unit.
For code points with a scalar value of U+10000 or higher, two code units are required per code point. These 
pairs of code units have a unique term in UTF-16: "Unicode surrogate pairs".

Note
Support for Unicode surrogate pairs is discussed below.

● UTF-32
The 32-bit code unit used in UTF-32 is large enough that every code point is encoded as a single code unit.

● GB18030
Multiple code units per code point are common in GB18030 because of the smaller code units. The code 
points will be mapped to one, two, or four code units.

Support for Unicode surrogate pairs

Some scripts supported by Unicode contain characters whose code points have a scalar value of U+10000 or 
higher. In UTF-16, these code points are encoded using surrogate pairs.

It is important that Unicode surrogate pairs are handled properly. For example, when working with text in an 
application that uses UTF-16 for encoding, the text cursor must navigate each code point as an individual text 
character when adding, deleting, or selecting characters to cut, copy or paste.

1.4.6.2.2.3  SAP Crystal Reports Support for GB18030 Through 
Unicode

SAP Crystal Reports, developer version for Microsoft Visual Studio</pname> does not support GB18030 directly. 
Instead it accesses GB18030 through values that have already been converted to one of the Unicode encoding 
forms.

Conversions are provided from a number of sources including the .NET Framework, certain database drivers, and 
the Windows operating system. Text is typically stored on the hard drive as UTF-8, and loaded into memory as 
UTF-16. SAP Crystal Reports supports Unicode surrogate pairs in UTF-16.

Examples of GB18030 support using Unicode

The most important areas to be aware of where GB18030 support is provided through Unicode conversion are the 
following:

● Databases that contain GB18030-encoded data.
Database data encoded in GB18030 is supported only when the database driver translates the data to UTF-16 
at retrieval time.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 205



Note
Microsoft SQL Server 2005 translates GB18030 data to UTF-16 at retrieval time. For other servers, consult 
your database provider.

● DataSets that exposes data from a GB18030 source.
Whatever the original source, DataSets are formatted as XML, which is encoded with UTF-8.

● Web services that expose data from a GB18030 source.
All text sent or received over a Web service is already converted to Unicode.

GB18030 scenarios not supported

The primary situation where GB18030 is not supported by SAP Crystal Reports is the accessing or importing of 
GB18030-encoded text files.

The GB18030-encoded text file must first be converted to Unicode by a third party, at which point SAP Crystal 
Reports can then interact with the Unicode-encoded text file.

1.4.6.3 Handling Error Events

In previous versions of SAP Crystal Reports, developer version for Microsoft Visual Studio, whenever you use the 
CrystalReportViewer control you have to trap for all possible thrown exceptions. Any exceptions that are left 
uncaught disrupt page processing and display an error.

To prevent disruptions and errors, a new event has been added to the CrystalReportViewer control, the Error 
event. When the Error event is used, the CrystalReportViewer control displays exception messages without 
disruption at the top of the CrystalReportViewer control.

1.4.6.3.1 To suppress the error page with the Error event 
method

To suppress the thrown exception, you call the Error event method and set ErrorEventArgs.Handled to True 
in the event handler.

1. Add the Error event method to your code-behind class.

2. Set ErrorEventArgs.Handled to True in the event handler.

Example
 Sub myCrystalReportViewer_Error(ByVal source As Object, ByVal e As 
CrystalDecisions.Web.ErrorEventArgs)
    e.Handled = True
End Sub 
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void crystalReportViewer_Error(object source,
CrystalDecisions.Web.ErrorEventArgs e)
{
    e.Handled = true;
} 

1.4.6.4 Customizing the CrystalReportViewer Control with 
CSS

The visual appearance of the CrystalReportViewer control is created through the use of graphics and a cascading 
style sheet (CSS).

The style sheet, named default.css, is stored in a subdirectory of the viewer's virtual directory that is named 
css.

Note
In Visual Studio 2005 and later (and ASP.NET version 2.0), the look and feel of visual controls can be managed 
by a new tool called Themes. Themes can be applied to the CrystalReportViewer control, to apply a consistent 
look to controls on a page or across an entire Web Site.

Related Information

Customizing the CrystalReportViewer Control with Themes [page 208]
Set CSS Class Dialog Box [page 798]
Formatting Reports using Cascading Style Sheets [page 613]

1.4.6.4.1 Customize the CSS for the CrystalReportViewer 
control

You access the style sheet from the CssFileName property of the CrystalReportViewer control, which can be 
viewed from the Properties window when the CrystalReportViewer control is selected in Design view.

1. Create a Web Site with a CrystalReportViewer control and a Crystal report.
2. Compile and run the project at least once to view the CrystalReportViewer control with its default style 

settings, and then exit from debug mode.
3. Open the Default.aspx page in Design view.
4. Click once on the CrystalReportViewer control to select it.
5. In the Properties window, locate the file directory path in the CssFileName property to the "default.css" file.
6. In Windows Explorer, locate this file and copy it to your Web Site directory.
7. Rename the file to "custom.css."
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8. Edit the CssFileName property to point to the Web Site directory and the "custom.css" file name.
9. Recompile and verify that the CrystalReportViewer control sees the custom.css file in your local Web Site 

directory.
10. Exit debug mode.
11. Open the file "custom.css" and edit the style sheet.
12. Recompile and verify that your changes have been applied to the CrystalReportViewer control.

1.4.6.5 Customizing the CrystalReportViewer Control with 
Themes

Themes are a tool for providing a common look and feel to all visual controls on a page (or across your Web Site).

At the page level, to manage the look and feel of visual controls, you set the Theme property of a visual control to 
the name of a theme. The theme is applied to all visual controls on the page.

The CrystalReportViewer control is compatible with ASP.NET 2.0 Themes. Any changes that you make to a 
Theme are extended to the CrystalReportViewer control and all other visual controls on the page.

For more information on how to set and customize Themes in ASP.NET 2.0, see the .NET Framework version 2.0 
documentation.

Related Information

Customizing the CrystalReportViewer Control with CSS [page 207]

1.4.6.6 Customizing the CrystalReportViewer toolbar

The CrystalReportViewer toolbar contains buttons that control common functions of the CrystalReportVIewer 
control, such as printing, exporting, or changing the current viewable page.

Customizing the toolbar buttons

The CrystalReportViewer toolbar contains buttons that control common functions of the CrystalReportVIewer 
control, such as printing, exporting, or changing the current viewable page.

The visibility of each button on the CrystalReportViewer control is controlled through a corresponding property of 
the CrystalReportViewer class. The names of the properties differ between the Windows and Web versions of 
the CrystalReportViewer control.

In a Web Site, the look of the toolbar can be controlled either through CSS or through ASP .Net Themes. You can 
change the look of the default button icons by altering the images in the Viewer's virtual directory.
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Removing the Toolbar

You can remove the toolbar from the CrystalReportViewer control programmatically, or through the Smart Tasks 
panel. You can create custom controls to replicate the behavior of many of the buttons on the 
CrystalReportViewer toolbar.

Related Information

Customizing the CrystalReportViewer Control with CSS [page 207]
Customizing the CrystalReportViewer Control with Themes [page 208]
Viewers' Directory [page 13]

1.4.6.6.1 Controlling which buttons appear on the 
CrystalReportViewer toolbar

Each of the buttons on the CrystalReportViewer toolbar can be individually enabled or disabled.

The visibility of each button on the CrystalReportViewer control is controlled through a corresponding property of 
the CrystalReportViewer class. There are two CrystalReportViewer controls in the SAP Crystal Reports .NET 
SDK. For a web site, you will use the CrystalDecisions.Web.CrystalReportViewer class. For a Windows 
application, you will use the CrystalDecisions.Windows.Forms.CrystalReportViewer class.

The name of the property that controls the visibility of a toolbar button will differ depending upon which version of 
the CrystalReportViewer control you are using. For the CrystalDecisions.Web.CrystalReportViewer class, 
each property begins with “Has”, such as HasExportButton, HasPrintButton, or HasSearchButton. For the 
CrystalDecisions.Windows.Forms.CrystalReportViewer class, each property begins with “Show”, such 
as ShowExportButton, ShowPrintButton, or ShowSearchButton.

For more information on the CrystalDecisions.Web.CrystalReportViewer class or the 
CrystalDecisions.Windows.Forms.CrystalReportViewer class, see the SAP Crystal Reports .NET API 
Reference.

Note
Removing a button from the toolbar will not disable the corresponding behavior.

Example
This example shows how to remove several buttons from the CrystalReportViewer toolbar in a Web Site.

 Private Sub ConfigureCrystalReports()
    CrystalReportViewer1.HasPrintButton = False
    CrystalReportViewer1.HasExportButton = False
    CrystalReportViewer1.HasSearchButton = False
End Sub 
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 private void ConfigureCrystalReports()
{
    InitializeComponent();
    crystalReportViewer1.HasPrintButton = false;
    crystalReportViewer1.HasExportButton = false;
    crystalReportViewer1.HasSearchButton = false;
} 

Related Information

To Remove the Print Button from the CrystalReportViewer Control [page 102]
To remove the export button from the CrystalReportViewer control [page 112]

1.4.6.6.2 To remove the CrystalReportViewer toolbar

Tip
The toolbar may be removed from your application programmatically, or by clearing the Display Toolbar 
checkbox in the CrystalReportViewer Tasks Smart Tasks panel.

1. Add a CrystalReportViewer control to your application.
2. Set the CrystalReportViewer.DisplayToolbar property to false.

When you run your application, the toolbar should no longer appear on the CrystalReportViewer control.

Example
 Private Sub ConfigureCrystalReports()
    CrystalReportViewer1.DisplayToolbar = False
End Sub 
 private void ConfigureCrystalReports()
{
    InitializeComponent();
    crystalReportViewer1.DisplayToolbar = false;
} 

1.4.6.6.3 To change the default toolbar buttons in the Web 
Viewer

The CrystalReportViewer toolbar consists of different graphics that represent most of the properties 
available. The graphics are stored in the viewer's virtual directory for your version of SAP Crystal Reports, 
developer version for Microsoft Visual Studio.
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For a Web Site, the toolbar uses graphics to represent the following properties:

● Group tree
● Export
● Print
● Drill up
● Page navigation: first, last, previous and next page
● Go to page
● Search
● SAP BusinessObjects logo

It is possible to change these buttons to your own set of custom icons.

1. Navigate to the Viewer's Virtual Directory.
2. Double-click the images folder.

3. Double-click the toolbar folder.

Within the toolbar folder, you can find all the images that are used for the CrystalReportViewer toolbar.

4. Replace the images with other images of your choice, or open the images in a graphics editor to modify the 
images. However, the image name must remain the same.

The images on the CrystalReportViewer toolbar will be changed for all web applications that use that Viewers 
Virtual Directory.

Related Information

Viewers' Directory [page 13]

1.4.7  Working with SAP Crystal Reports Read-Only (RPTR) 
reports

SAP Crystal Reports Read-Only (RPTR) reports are Crystal reports that can be viewed with report viewer 
applications, but cannot be modified with the SDK or opened by report designer applications. This lets you protect 
your intellectual property by preventing users from modifying the report or obtaining information about 
proprietary business logic stored in the report definition.

SAP Crystal Reports Read-Only format reports use the RPTR file extension instead of the RPT file extension used 
by Crystal reports. You can create an RPTR report by exporting an RPT report to RPTR format. However, there is 
no supported way to convert an RPTR report to an RPT report.

Because the definition of an RPTR report cannot be modified, you cannot use this SDK to set the data source 
location of an RPTR report through the database controller. However, you can refresh the data of an RPTR report 
at run time.

You can use this SDK to perform the following tasks:

● Create an RPTR report by exporting a Crystal report (RPT) to RPTR format.
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Note
Only reports created by SAP Crystal Reports 2011 can be exported to RPTR format.

● View an RPTR report by obtaining its report source and passing the report source to a viewer.
● Refresh the data of an RPTR report at run time.
● Open an RPTR report, and export it to formats other than RPT.

You cannot use this SDK to perform the following tasks:

● Modify the report definition of an RPTR report.
● Set the data source location of the report.
● Retrieve information about the report definition of an RPTR report, including the formulas, fields, sections, 

and objects that make up the report.
● Export an RPTR report to RPT format.
● Add an RPTR report as a subreport to an RPT report.

1.5 Tutorials

1.5.1  CrystalReportViewer Object Model Tutorials

The tutorials in this section use methods and properties from the CrystalReportViewer class and classes of the 
CrystalDecisions.Shared namespace.

The tutorials in this section use methods and properties from the CrystalReportViewer class and classes of the 
CrystalDecisions.Shared namespace.

1.5.1.1 Tutorial: Logging onto a Secure SQL Server Database

In this tutorial, you learn how to add logon code to display a report that contains information from a secure SQL 
Server database.

Introduction

When you use the CrystalReportViewer object model to log on to a secure SQL Server database, you must use 
classes from the CrystalDecisions.Shared namespace.

The properties of the ConnectionInfo class are used to connect to the database server or ODBC data sources. In 
this tutorial, you set the ServerName, DatabaseName, UserID and Password properties. If you choose only to set 
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the DatabaseName, UserID, and Password properties, then you are logged on to the default server of the 
database that you have specified within the report. However, if you choose to assign an alternate ServerName 
property, you can redirect the report to a different server at runtime.

You retrieve the TableLogOnInfos instance from the LogOnInfo property of the CrystalReportViewer control. 
Then, you assign the ConnectionInfo instance to each TableLogOnInfo object in the TableLogOnInfos instance.

The logon code in this tutorial also works for subreports that are inserted into the main report. For the 
ReportDocument object model, you must modify the code to work for subreports, (see Tutorial: Logging onto a 
Secure SQL Server Database with a Subreport [page 320]).

To build this tutorial using the ReportDocument object model, see Tutorial: Logging onto a Secure SQL Server 
Database [page 212]. The ReportDocument object model is recommended over the CrystalReportViewer object 
model.

Sample Code

Each tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_CRVObjMod_DBLogon
● C# Windows project: CS_Win_CRVObjMod_DBLogon
● Visual Basic Web Site: VB_Web_CRVObjMod_DBLogon
● Visual Basic Windows project: VB_Win_CRVObjMod_DBLogon

Related Information

Choose the Correct Object Model for Your Project [page 29]
Sample Reports Directory [page 14]

1.5.1.1.1 Creating a Report Connected to a Secure SQL 
Server Database

● SQL Server configuration:
○ If you have SQL Server (or the OEM version, MSDE) installed, it must be configured to require SQL Server 

Authentication.
○ If you do not have SQL Server (or the OEM version, MSDE) installed, you must install MSDE with SQL 

Server Authentication set to "True."
● The Northwind database provided with SQL Server must be installed and verified that it requires SQL Server 

Authentication.
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● A limited access account must be created for use within the Web site.

Once you have configured SQL Server and the Northwind database according to the sections above, you are 
ready to create a report that draws its information securely from a Northwind database.

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, in the Templates view, select the Crystal Report template.
3. In the Name field, enter the name "NorthwindCustomers.rpt", and then click Open.
4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 

Report Wizard.
5. In the Choose an Expert panel, select Standard. Click OK.

The Standard Report Creation Wizard window appears.
6. In the Available Data Sources panel, expand the Create New Connection folder.
7. From the subfolder that opens, expand the OLE DB (ADO) folder.

The OLE DB (ADO) window appears.
8. Select Microsoft OLE DB Provider for SQL Server, and then click Next.
9. Enter the values for your database server, user id and password into the Server, User ID and Password fields.
10. From the Database drop down list, select "Northwind."

Leave the Integrated Security checkbox unchecked because you are using SQL Server authentication instead 
of NT authentication.

11. Click Finish.

The OLE DB folder is now expanded, showing your database server, and within it, the Northwind database.
12. Expand the nodes Northwind, dbo, and Tables, and then select the Customers table.
13. Click the > symbol to move the table into the Selected Tables panel, and then click Next.
14. Expand the Customers table, and then hold down the Ctrl key while you click CompanyName, ContactName 

and City.
15. Click the > symbol to move these fields into the Fields to Display panel, then click Next.
16. In the Available Fields panel, under Report Fields, select Customer.City, then click the > symbol to move the 

field into the Group By panel, and then click Finish.

The NorthwindCustomers report is created and loaded into the main window of Visual Studio.

1.5.1.1.2 Binding the Report Without Logon Code

In Project Setup [page 15], you have placed a CrystalReportViewer control on the Web or Windows Form. In the 
previous step, you have added a NorthwindCustomers report to the project.
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In this section, you bind the file directory path of the NorthwindCustomers report to the CrystalReportViewer 
control. Then you test whether the report displays correctly when the database logon code has not been set.

1.5.1.1.2.1  To bind the file directory path of the 
NorthwindCustomers report to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Locate the ConfigureCrystalReports() method (that you have created in Project Setup [page 15]).

4. Declare a string variable, name it reportPath, and assign to it a runtime path to the local report. This path is 
determined differently for Web Sites and Windows projects:

○ For a Web Site, pass the name of the local report file as a string parameter into the Server.MapPath() 
method. This maps the local report to the hard drive file directory path at runtime.

 Dim reportPath As String = Server.MapPath("NorthwindCustomers.rpt") 
 string reportPath = Server.MapPath("NorthwindCustomers.rpt"); 

○ For a Windows project, concatenate the Application.StartupPath property with a backslash and the 
local report file name. This maps the report to the same directory as the Windows executable file.

Note
At compile time you will copy the report to the directory containing the executable file.

 Dim reportPath As String = Application.StartupPath & "\" & 
"NorthwindCustomers.rpt" 
 string reportPath = Application.StartupPath + "\\" + "NorthwindCustomers.rpt"; 

5. Assign the file directory path of the NorthwindCustomers report to the ReportSource property of the 
CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = reportPath 
 crystalReportViewer.ReportSource = reportPath; 

1.5.1.1.2.2  To test the loading of the NorthwindCustomers 
report

You are now ready to build and run your project. It is expected that the report loading will fail, because code has 
not yet been written to log onto the database.
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1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. If you use a non-embedded report in a Windows project, locate the compiled Windows executable in the \bin

\debug\ subdirectory, and then copy the report to that subdirectory.

Note
To have the non-embedded report loaded by the Windows executable at runtime, the report must be 
stored in the same directory as the Windows executable.

4. From the Debug menu, click Start.

The NorthwindCustomers report will not display. It will display after you add the database logon code.

Note
Results may vary, depending on the version of SAP Crystal Reports that you use. For example, if you have 
SAP Crystal Reports 10 and up installed, you are prompted for database logon information for that report. 
If you are running a previous version of SAP Crystal Reports, an exception is thrown. In either case, you 
must follow the next step procedure to create a fully functional application.

5. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.1.3 Adding the Report Logon Code

You are now ready to add the logon code to the code-behind class. You begin by creating a private helper method, 
SetDBLogonForReport().

1.5.1.1.3.1  To create and code the SetDBLogonForReport() 
method

1. Return to the code-behind class for this Web or Windows Form.
2. At the bottom of the class, create a new private method named SetDBLogonForReport() with 

ConnectionInfo passed into the method signature.

 Private Sub SetDBLogonForReport(ByVal myConnectionInfo As ConnectionInfo)
End Sub 
 private void SetDBLogonForReport(ConnectionInfo connectionInfo)
{
} 

3. Within this method, retrieve the TableLogOnInfos instance from the LogOnInfo property of the 
CrystalReportViewer class.

216 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



Note
TableLogOnInfos is an indexed class that contains instances of the TableLogOnInfo class.

 Dim myTableLogOnInfos As TableLogOnInfos = myCrystalReportViewer.LogOnInfo 
 TableLogOnInfos tableLogOnInfos = crystalReportViewer.LogOnInfo; 

4. Create a foreach loop that loops through each TableLogOnInfo instance in the TableLogOnInfos 
indexed class instance.

 For Each myTableLogOnInfo As TableLogOnInfo In myTableLogOnInfos
Next 
 foreach(TableLogOnInfo tableLogOnInfo in tableLogOnInfos)
{
} 

5. Within the foreach loop, set the ConnectionInfo property of TableLogOnInfo to the ConnectionInfo 
parameter.

 myTableLogOnInfo.ConnectionInfo = myConnectionInfo 
 tableLogOnInfo.ConnectionInfo = connectionInfo; 

1.5.1.1.3.2  To modify the ConfigureCrystalReports() method to 
address the database logon code

This step procedure has created a method to set the logon for the database. However, you must modify the 
ConfigureCrystalReports() method to address this method, for the report to be aware that it has database 
logon information.

Modifying the ConfigureCrystalReports() method requires two actions:

● Configure the ConnectionInfo instance.
● Call the SetDBLogonForReport() method.

1. In the ConfigureCrystalReports() method, declare and instantiate the ConnectionInfo class below 
the code that binds the report to the CrystalReportViewer control.

 Dim myConnectionInfo As ConnectionInfo = New ConnectionInfo() 
 ConnectionInfo connectionInfo = new ConnectionInfo(); 

2. On the next line, call the SetDBLogonForReport() method by passing in the ConnectionInfo instance.

 SetDBLogonForReport(myConnectionInfo) 
 SetDBLogonForReport(connectionInfo); 
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3. Set the DatabaseName, UserID, and Password properties of the ConnectionInfo instance.

Note
For security reasons, it is important that you use a database account with limited access permissions.

In the code that you write, replace the sample 1234 password (shown below) with your own password.

 myConnectionInfo.DatabaseName = "Northwind"
myConnectionInfo.UserID = "limitedPermissionAccount"
myConnectionInfo.Password = "1234" 
 connectionInfo.DatabaseName = "Northwind";
connectionInfo.UserID = "limitedPermissionAccount";
connectionInfo.Password = "1234"; 

1.5.1.1.3.3  To test the loading of the NorthwindCustomers 
report

You are now ready to build and run your project. The report should load properly, because you have added code to 
log on to the database.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The NorthwindCustomers report displays successfully.
4. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.1.4 Adding Ability to Change Database Location at 
Runtime

In this section, you learn how to change the database location at runtime. This requires only a minor modification 
to the ConnectionInfo instance.

Note
In this tutorial you will change the name of the Database server, not the name of the Database. It is not possible 
to change the name of the Database with the CrystalReportViewer control.

1.5.1.1.4.1  To change the database location at runtime

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code after the line that 
calls the SetDBLogonForReport() method.
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2. Within the line breaks, set the ServerName property of the ConnectionInfo instance.

Note
In the code that you write, replace the sample server name DevDatabaseServer (shown below) with the 
name of your server.

 myConnectionInfo.ServerName = "DevDatabaseServer" 
 connectionInfo.ServerName = "DevDatabaseServer"; 

1.5.1.1.4.2  To test that the report can be reset to an alternate 
database server at runtime

You are now ready to build and run your project. The report should redirect to the alternate database server at 
runtime.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The NorthwindCustomers report displays successfully.
4. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.2 Tutorial: Reading and Setting Discrete Parameters

In this tutorial, you learn how to create a report whose data can be filtered, based on a discrete parameter.

Introduction

A discrete parameter is a single value, as opposed to a range parameter, which refers to a range of values. Text 
items (such as cities) are usually accessed through discrete parameters. Numeric items (such as employee 
salaries) are usually accessed through range parameters.

In this tutorial, you set a value for a discrete parameter to view a customer report that is based on one field. The 
report displays only those customers who live in the cities you have selected from a city list. The city list is derived 
from the default values for the City parameter. Those default values for the City parameter are encapsulated 
within the report.

To begin, you create a customer report with a city parameter. The report derives its data from the sample 
database that is shipped with SAP Crystal Reports, developer version for Microsoft Visual Studio. When you 
instantiate the report in the code, you create an ArrayList that contains city names (Paris, Tokyo) and pass that 
ArrayList instance to a helper method that sets those city names as the current values for the city parameter. You 
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then bind the report to the CrystalReportViewer control and view the report with only those customers that live in 
Paris and Tokyo displayed.

In the next part of the tutorial, you do the following:

● Create a method that gets all the default values and returns them in an ArrayList.
● Add a ListBox control to the form and populate it from the ArrayList.
● Add a Button control to redisplay the report based on ListBox selections.

In the final part of the tutorial, you code the button click event to retrieve any selected items from the ListBox 
control and set those to be the current values for the city parameter. The report redisplays and shows only those 
customers who live in the cities that have been selected within the ListBox control.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_CRVObjMod_Parameters
● C# Windows project: CS_Win_CRVObjMod_Parameters
● Visual Basic Web Site: VB_Web_CRVObjMod_Parameters
● Visual Basic Windows project: VB_Win_CRVObjMod_Parameters

Xtreme database

The Xtreme database is used by some of the tutorials. It is included with the sample code package that can be 
downloaded from http://www.sdn.sap.com/irj/boc/sdklibrary . You must manually create an ODBC 
connection to the database.

Related Information

Sample Reports Directory [page 14]

1.5.1.2.1 Creating a Report with Parameters

To begin, create a report that draws information from the Xtreme database.
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1.5.1.2.1.1  To create a report with parameters

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, in the Templates view, select the Crystal Report template.
3. In the Name field, enter the name CustomersByCity.rpt and click Add.

4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 
Report Wizard.

5. In the Choose an Expert panel, select Standard, and then click OK.
6. In the Available Data Sources panel of the Standard Report Creation Wizard window, expand the Create New 

Connection folder.
7. From the subfolder that opens, expand the ODBC (RDO) folder.
8. In the ODBC (RDO) window, select the correct ODBC DSN entry for the Xtreme database, and then click 

Finish.
9. Expand the Tables node, double-click the Customer table to move the table to the Selected Tables panel, and 

then click Next.
10. Expand the Customer table, then CTRL-click Customer Name, Contact Title, Address1, Contact Last Name and 

City.
11. Click the > symbol to move these fields into the Fields to Display panel, then click the Next button.
12. In the Available Fields panel, under Report Fields, double-click Customer.City to move the field into the Group 

By panel, and then click the Finish button.

The CustomersByCity report is created and loaded into the main window of Visual Studio.

1.5.1.2.1.2  To add a City parameter

You are now ready to add a parameter named City and populate it with default values.

The Field Explorer must be visible, because it provides access to the various features of the report, including 
parameters. To make the Field Explorer visible, from the Crystal Reports menu, click Field Explorer.

1. If the Field Explorer is not visible, on the Crystal Reports toolbar, click Toggle Field View.

Tip
Another way to display the Field Explorer is to go to the Crystal Reports menu, and then click Field Explorer.

2. In the Field Explorer, right-click Parameter Fields and select New...
3. In the Create Parameter Field dialog box:

a. Set the Name to City.
b. Set the Type to String. Set the Prompting Text to Select one or more cities.
c. Set the Value Field to City.
d. Click Actions, then select Append all database values. This will add the entire cities list into the middle 

pane.
e. In the Value Options pane, set the Prompt Text to Select one or more cities.
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f. In the same pane, set Allow multiple values to True.
g. Set Allow discrete values to True.

4. Click OK to close the Create Parameter Field dialog box.

1.5.1.2.1.3  To connect the City parameter to the City database 
column

You have just set the Default Values to contain a large list of cities. Later in this tutorial, you access this same list 
of default values programmatically, through the ParameterFieldInfo property of the CrystalReportViewer 
class.

You now use the Select Expert to set a formula that connects the City database column to your newly created City 
parameter field.

1. On the Crystal Reports toolbar, click Select Expert.
2. In the Choose Field dialog box, under Report Fields, select Customer.City, and then click OK.
3. In the Select Expert dialog box, within the Customer.City tab, set the dropdown list to "is equal to."

4. In the new dropdown list that appears to the right, select the first choice in the list, {?City}, and then click OK.

Note
This selection, {?City}, is the City parameter that you created earlier.

5. From the File menu, select Save All.

You are now ready to bind the report to the CrystalReportViewer control and set the city parameter with two initial 
values, Paris and Tokyo.

1.5.1.2.2 Binding the Report

When you followed the instructions in Project Setup [page 15] to prepare for this tutorial, you have placed a 
CrystalReportViewer control on the Web or Windows Form. In the previous steps, you added a 
CustomersByCity report to the project.

In this section, you bind the file directory path of the CustomersByCity report to the CrystalReportViewer 
control. Then you test whether the report displays correctly when current values have not been set for its 
parameter field.
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1.5.1.2.2.1  To bind the file directory path of the 
CustomersByCity report to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code to view the code-behind class for this Web or Windows Form.
3. Locate the ConfigureCrystalReports() method (that you have created in Project Setup [page 15]).

4. Declare a string variable, name it reportPath, and assign to it a runtime path to the local report. This path is 
determined differently for Web Sites and Windows projects:

○ For a Web Site, pass the name of the local report file as a string parameter into the Server.MapPath() 
method. This maps the local report to the hard drive file directory path at runtime.

 Dim reportPath As String = Server.MapPath("CustomersByCity.rpt") 
 string reportPath = Server.MapPath("CustomersByCity.rpt"); 

○ For a Windows project, concatenate the Application.StartupPath property with a backslash and the 
local report file name. This maps the report to the same directory as the Windows executable file.

Note
At compile time you will copy the report to the directory containing the executable file.

 Dim reportPath As String = Application.StartupPath & "\" & 
"CustomersByCity.rpt" 
 string reportPath = Application.StartupPath + "\\" + "CustomersByCity.rpt"; 

5. Assign the file directory path of the CustomersByCity report to the ReportSource property of the 
CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = reportPath 
 crystalReportViewer.ReportSource = reportPath; 

1.5.1.2.2.2  To test the loading of the CustomersByCity report

You are now ready to build and run your project. It is expected that the report loading will fail, because code has 
not yet been written to set a value for the City parameter field.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. If you use a non-embedded report in a Windows project, locate the compiled Windows executable in the \bin

\ [Visual Basic] or \bin\debug\ [C#] subdirectory, and then copy the report to that subdirectory.
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Note
To have the non-embedded report loaded by the Windows executable at runtime, the report must be 
stored in the same directory as the Windows executable.

4. From the Debug menu, click Start.

The CustomersByCity report does not display. It displays after you add a value for the City parameter field 
later in this tutorial.

Note
Results may vary, depending on the version of SAP Crystal Reports that you use. In more recent versions, 
you can see a form requesting that you provide parameter values for that report. In earlier versions, a 
"Missing parameter field current value" exception is thrown. In either case, you must add further code to 
create a fully functional application.

5. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.2.3 Setting Parameters Manually in Code

You are now ready to set two values ("Paris" and "Tokyo") into the City parameter field for the CustomersByCity 
report.

This involves some coding, which you can separate into the following processes:

● You need a PARAMETER_FIELD_NAME constant to hold the "City" parameter field name.
● The code to add current values to the City parameter is used at different locations in this tutorial; therefore, 

you create this code as a separate helper method.
● Within the ConfigureCrystalReports() method, you add the "Paris" and "Tokyo" parameters to an 

ArrayList instance and pass in both the report and the ArrayList instance to the helper method to be 
processed.

1.5.1.2.3.1  To create a PARAMETER_FIELD_NAME constant

1. Return to the code-behind class for this Web or Windows Form.
2. At the class level, create a new string constant, PARAMETER_FIELD_NAME, and set its value to "City."

 Private Const PARAMETER_FIELD_NAME As String = "City" 
 private const string PARAMETER_FIELD_NAME = "City"; 
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1.5.1.2.3.2  To create a helper method that adds current values 
to the parameter in the report

You are now ready to create the helper method that adds current values to the parameter in the report.

1. Return to the code-behind class for this Web or Windows Form.
2. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of 

the class for the System.Collections namespace (if this namespace has not already been declared).

Note
This declaration is needed to access the ArrayList class.

 Imports System.Collections 
 using System.Collections; 

3. At the bottom of the class, create a new private method named 
SetCurrentValuesForParameterField(), with two variables in the method signature: ParameterFields 
and ArrayList.

 Private Sub SetCurrentValuesForParameterField(ByVal myParameterFields As 
ParameterFields, ByVal myArrayList As
ArrayList)
End Sub 
 private void SetCurrentValuesForParameterField(ParameterFields parameterFields, 
ArrayList arrayList)
{
} 

4. Within this method, declare and instantiate the ParameterValues class as the variable 
currentParameterValues.

Note
For the ParameterValues class to be accessible, you must have included an "Imports" [Visual 
Basic] or "using" [C#] declaration at the top of the code-behind class for the CrystalDecisions.Shared 
namespace. (You added this declaration in Project Setup [page 15].)

 Dim currentParameterValues As ParameterValues = New ParameterValues() 
 ParameterValues currentParameterValues = new ParameterValues(); 

5. Create a foreach loop to retrieve all of the submitted values (as type Object) from the ArrayList instance.

Note
In this method, you retrieve values from the ArrayList. Later you write code that adds values to the 
ArrayList.

 For Each submittedValue As Object In myArrayList
Next
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 foreach(object submittedValue in arrayList)
{
} 

6. Within the foreach loop, declare and instantiate the ParameterDiscreteValue class.

 Dim myParameterDiscreteValue As ParameterDiscreteValue = New 
ParameterDiscreteValue() 
 ParameterDiscreteValue parameterDiscreteValue = new ParameterDiscreteValue(); 

7. Within the foreach loop, convert the submittedValue to string and pass it to the Value property of the 
ParameterDiscreteValue instance.

 myParameterDiscreteValue.Value = submittedValue.ToString() 
 parameterDiscreteValue.Value = submittedValue.ToString(); 

8. Within the foreach loop, add the ParameterDiscreteValue instance into the currentParameterValues 
indexed class.

This completes the code within the foreach loop. You place the remaining code (from the steps that follow) 
after the foreach loop.

 currentParameterValues.Add(myParameterDiscreteValue) 
 currentParameterValues.Add(parameterDiscreteValue); 

9. Outside the foreach loop, retrieve the ParameterField instance from the ParameterFields indexed class 
that is based on the index entry of the PARAMETER_FIELD_NAME constant.

 Dim myParameterField As ParameterField = myParameterFields(PARAMETER_FIELD_NAME) 
 ParameterField parameterField = parameterFields[PARAMETER_FIELD_NAME]; 

10. Pass the currentParameterValues instance to the CurrentValues property of the ParameterField 
instance.

 myParameterField.CurrentValues = currentParameterValues 
 parameterField.CurrentValues = currentParameterValues; 

1.5.1.2.3.3  To call the SetCurrentValuesForParameterField() 
method before the report is bound to the 
CrystalReportViewer control

This step procedure showed you how to create a method that retrieves submitted values from an ArrayList 
instance and places them as current values into a ParameterField instance. Now, you must call this method 
before your report is bound to the CrystalReportViewer control, for the report to be aware that it has 
parameter settings.
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1. In the ConfigureCrystalReports() method, declare and instantiate an ArrayList above the line that binds 
the report to the CrystalReportViewer control.

 Dim myArrayList As ArrayList = New ArrayList() 
 ArrayList arrayList = new ArrayList(); 

2. Add the city names "Paris" and "Tokyo" as strings to the ArrayList instance.

 myArrayList.Add("Paris")
myArrayList.Add("Tokyo") 
 arrayList.Add("Paris");
arrayList.Add("Tokyo"); 

3. Below the code that binds the CrystalReportViewer control, retrieve the ParameterFields instance 
from the ParameterFieldInfo property of the CrystalReportViewer control.

 Dim myParameterFields As ParameterFields = 
myCrystalReportViewer.ParameterFieldInfo 
 ParameterFields parameterFields = crystalReportViewer.ParameterFieldInfo; 

4. Call the SetCurrentValuesForParameterField() method, and pass in the ParameterFields instance, and 
the ArrayList instance.

 SetCurrentValuesForParameterField(myParameterFields, myArrayList) 
 SetCurrentValuesForParameterField(parameterFields, arrayList); 

1.5.1.2.3.4  To test the loading of the CustomersByCity report

You are now ready to build and run your project. It is expected that the report displays successfully because there 
is now code written to set current values into the parameter field.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. Return to Visual Studio and click Stop to exit from debug mode.

In the next section, you learn how to retrieve the default values from the parameter field and set those values into 
a ListBox control. These are used at the end of the tutorial to select new cities dynamically and filter the report 
based on those newly selected cities.
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1.5.1.2.4 Create a ListBox Control that Displays Default 
Parameters

The remainder of the tutorial is concerned with displaying a complete list of default values for the parameter field 
in a ListBox control, and based on selections that you make from that ListBox control, refiltering the contents 
of the report.

In this section you learn how to populate the ListBox control from the default values of the parameter field.

Note
Remember that you set the Default Values, a large list of cities, when you created this report at the beginning of 
the tutorial.

To do this, you must add and configure a ListBox control, and then create a helper method to populate the 
ListBox control.

1.5.1.2.4.1  To create and configure a ListBox control on the 
form

1. Open the Web or Windows Form.
2. From the View menu, click Designer.
3. If you are developing a Web Site, do the following:

a. Click the CrystalReportViewer control to select it.
b. Press the LEFT ARROW on your keyboard so that a flashing cursor appears, and then press ENTER.

4. If you are developing a Windows project, do the following:
a. Click the CrystalReportViewer control to select it.
b. From the Properties window, set Dock to "Bottom."
c. Resize the CrystalReportViewer control, so that you leave enough room above it for a ListBox control.
d. From the Properties window, set Anchor to "Top, Bottom, Left, Right."

5. From the Toolbox, drag a ListBox control above the CrystalReportViewer control.
6. Click on the ListBox control to select it.
7. From the Properties window, do the following:

a. Set the ID or Name to "defaultParameterValuesList."
b. Set the SelectionMode to "Multiple" (in a Windows project, "MultiExtended").

8. From the File menu, select Save All.

1.5.1.2.4.2  To create a helper method that retrieves the default 
values from the parameter field

You are now ready to create a helper method that retrieves the default values from the parameter field.
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1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the bottom of the class, create a new private method named 

GetDefaultValuesFromParameterField() that returns an ArrayList instance, with ParameterFields 
passed into the method signature.

 Private Function GetDefaultValuesFromParameterField(ByVal
myParameterFields As ParameterFields) As ArrayList
End Function 
 private ArrayList
GetDefaultValuesFromParameterField(ParameterFields parameterFields)
{
} 

4. Retrieve the ParameterField instance from the ParameterFields indexed class, which is based on the 
index entry of the PARAMETER_FIELD_NAME constant.

 Dim myParameterField As ParameterField =
myParameterFields(PARAMETER_FIELD_NAME) 
 ParameterField parameterField =
parameterFields[PARAMETER_FIELD_NAME]; 

5. Retrieve a ParameterValues indexed class (as the variable defaultParameterValues) from the 
DefaultValues property of the ParameterField instance.

 Dim defaultParameterValues As ParameterValues =
myParameterField.DefaultValues 
 ParameterValues defaultParameterValues =
parameterField.DefaultValues; 

6. Declare and instantiate an ArrayList.

 Dim myArrayList As ArrayList = New ArrayList() 
 ArrayList arrayList = new ArrayList(); 

7. Create a foreach loop, to retrieve each ParameterValue instance from defaultParameterValues.

Within the foreach loop, you now create a nested conditional block that checks for discrete (as opposed to 
range) parameter values. Two versions of this conditional block exist, because the API has changed slightly 
across versions of SAP Crystal Reports, developer version for Microsoft Visual Studio. Check your API (using 
IntelliSense) to see which property is available under ParameterValue:

 For Each myParameterValue As ParameterValue In
defaultParameterValues
Next 
 foreach(ParameterValue parameterValue in defaultParameterValues)
{
} 

8. If the available property is IsRange then, within the foreach loop, enter this code:
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If (Not myParameterValue.IsRange) Then
End If 
 if(!parameterValue.IsRange)
{
} 

9. Or, if the available property is Kind (DiscreteOrRangeKind, an enum with three values: DiscreteValue, 
RangeValue, DiscreteAndRangeValue) then, within the foreach loop, enter this code instead:

 If (myParameterValue.Kind = DiscreteOrRangeKind.DiscreteValue) Then
End If 
 if(parameterValue.Kind == DiscreteOrRangeKind.DiscreteValue)
{
} 

10. Within this nested conditional block, cast the ParameterValue instance to its extended class, 
DiscreteParameterValue.

 Dim myParameterDiscreteValue As ParameterDiscreteValue =
CType(myParameterValue, ParameterDiscreteValue) 
 ParameterDiscreteValue parameterDiscreteValue =
(ParameterDiscreteValue)parameterValue; 

11. Also within the nested conditional block, add the Value property of the ParameterDiscreteValue instance 
(converted to String) into the ArrayList instance.

 myArrayList.Add(myParameterDiscreteValue.Value.ToString()) 
 arrayList.Add(parameterDiscreteValue.Value.ToString()); 

12. Outside the conditional block, and outside the foreach loop, at the end of the method, return the ArrayList 
instance from the method.

 Return myArrayList 
 return arrayList; 

1.5.1.2.4.3  To bind the ArrayList returned from the method to 
the ListBox in a Web project

You have retrieved the default values from the parameter field and returned them from the method as an 
ArrayList. You now bind this ArrayList to the defaultParameterValuesList ListBox control.

Your code varies slightly depending on whether you use a Web project or a Windows project; therefore, be sure to 
only complete either the Web or Windows procedure below.

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code immediately after 
the line of code that retrieves the ParameterFields instance.

2. Within the line breaks, create a Not IsPostBack conditional block.
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Note
The Not IsPostBack conditional block is used to encapsulate code that should only be run the first time 
the page loads. Controls are typically bound to data values within Not IsPostBack conditional blocks so 
that their data values (and any subsequent control events) are not reset during page reloads.

 If Not IsPostBack Then
End If 
 if(!IsPostBack)
{
} 

3. Within the Not IsPostBack conditional block, set the DataSource property of the 
defaultParameterValuesList ListBox to the GetDefaultValuesFromParameterField() helper 
method, passing in the ParameterFields instance as a method parameter.

 defaultParameterValuesList.DataSource =
GetDefaultValuesFromParameterField(myParameterFields) 
 defaultParameterValuesList.DataSource =
GetDefaultValuesFromParameterField(parameterFields); 

4. Still within the Not IsPostBack conditional block, call the DataBind() method of the 
defaultParameterValuesList ListBox.

 defaultParameterValuesList.DataBind() 
 defaultParameterValuesList.DataBind(); 

1.5.1.2.4.4  To bind the ArrayList returned from the method to 
the ListBox in a Windows project

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code immediately after 
the line of code that retrieves the ParameterFields instance.

Within these line breaks, you can now enter additional code that sets the data source for the 
defaultParameterValuesList ListBox control when the page loads for the first time.

2. Within the line breaks, set the DataSource property of the defaultParameterValuesList ListBox to the 
GetDefaultValuesFromParameterField() helper method, passing in the ParameterFields instance as a 
method parameter.

 defaultParameterValuesList.DataSource =
GetDefaultValuesFromParameterField(myParameterFields) 
 defaultParameterValuesList.DataSource =
GetDefaultValuesFromParameterField(parameterFields); 

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 231



1.5.1.2.4.5  To test the population of the 
defaultParameterValuesList ListBox control

You are now ready to build and run the project, to verify whether the defaultParameterValuesList ListBox is 
populated.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The defaultParameterValuesList ListBox control displays a complete list of default values (cities, in 
our tutorial).

4. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.2.5 Setting Parameters from ListBox Selections

In this section you add a button to redisplay the report based on selections from the 
defaultParameterValuesList ListBox control. Within the event method for this button, you call the same 
method that is called when the page first loads: SetCurrentValuesForParameterField(). But this time, 
rather than pass in arbitrary values (Paris and Tokyo), you pass in the selected values from the 
defaultParameterValuesList ListBox control.

1.5.1.2.5.1  To create and configure a redisplay Button on the 
form

1. Open the Web or Windows Form.
2. From the View menu, click Designer.
3. From the Toolbox, drag a Button control to the right of the ListBox control.
4. Click on the Button control to select it.
5. From the Properties window, do the following:

a. Set the ID or Name to "redisplay."
b. Set the Text to "Redisplay Report."

1.5.1.2.5.2  To create the click event method for the redisplay 
Button in a Web project

You are now ready to create a button click event method that checks for selected items in the ListBox control, 
and passes them to SetCurrentValuesForParameterField() method.

Your code varies slightly for a Web project or a Windows project, so only complete either the Web or Windows 
procedure below.
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1. Double-click the Redisplay Report button.

You are taken to the code-behind class where a redisplay_Click() event method has been automatically 
generated.

2. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of 
the class for the System.Web.UI.WebControls namespace (if this namespace has not already been declared).

 Imports System.Web.UI.WebControls 
 using System.Web.UI.WebControls; 

3. Within the redisplay_Click() event method that has just been auto-generated, declare and instantiate an 
ArrayList.

 Dim myArrayList As ArrayList = New ArrayList() 
 ArrayList arrayList = new ArrayList(); 

4. Create a foreach loop to retrieve each ListItem instance from the Items property of 
defaultParameterValuesList ListBox.

 For Each item As ListItem In defaultParameterValuesList.Items
Next 
 foreach(ListItem item in defaultParameterValuesList.Items)
{
} 

5. Within the foreach loop, create a nested conditional block that checks whether the Selected property of 
the current Item instance is set to True.

 If item.Selected Then
End If 
 if(item.Selected)
{
} 

6. Within the conditional block, add the Value property of the Item instance to the ArrayList instance.

 myArrayList.Add(item.Value) 
 arrayList.Add(item.Value); 

7. Outside the conditional block, and outside the foreach loop, rebind the file directory path of the 
CustomersByCity report to the ReportSource property of the CrystalReportViewer class.

Note
The file directory path that is shown below is for a Visual Studio project. "ProjectName" is replaced by the 
name of your Web Site. "UserName" is replaced by your logon name.

The default path for a Web Site project:

  myCrystalReportViewer.ReportSource = "C:\WebSites\ProjectName
\CustomersByCity.rpt"
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  crystalReportViewer.ReportSource = "C:\\WebSites\\ProjectName\
\CustomersByCity.rpt";  

8. Retrieve the ParameterFields instance from the ParameterFieldInfo property of the 
CrystalReportViewer control.

 Dim myParameterFields As ParameterFields =
myCrystalReportViewer.ParameterFieldInfo 
 ParameterFields parameterFields =
crystalReportViewer.ParameterFieldInfo; 

9. Pass in the ParameterFields and ArrayList instance to the SetCurrentValuesForParameterField() 
method.

 SetCurrentValuesForParameterField(myParameterFields, myArrayList) 
 SetCurrentValuesForParameterField(parameterFields, arrayList); 

1.5.1.2.5.3  To create the click event method for the redisplay 
Button in a Windows project

1. Double-click the redisplay Button control.

You are taken to the code-behind class where a redisplay_Click() event method has been automatically 
generated.

2. Within the redisplay_Click() event method that has just been auto-generated, declare and instantiate an 
ArrayList.

 Dim myArrayList As ArrayList = New ArrayList() 
 ArrayList arrayList = new ArrayList(); 

3. Create a foreach loop, to retrieve each item (as a string) from the SelectedItems property of 
defaultParameterValuesList ListBox.

 For Each item As String In defaultParameterValuesList.SelectedItems
Next 
 foreach(string item in defaultParameterValuesList.SelectedItems)
{
} 

4. Within the foreach loop, add item string instance to the ArrayList instance.

 myArrayList.Add(item) 
 arrayList.Add(item); 

5. Outside the foreach loop, rebind the file directory path of the CustomersByCity report to the ReportSource 
property of the CrystalReportViewer class.
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Note
The file directory path that is shown below is for a Visual Studio project. "ProjectName" is replaced by the 
name of your Windows project. "UserName" is replaced by your logon name.

The default path for a Windows project:

  myCrystalReportViewer.ReportSource = "C:\Documents and Settings\UserName\My 
Documents\Visual Studio\Projects\ProjectName\CustomersByCity.rpt"  
  crystalReportViewer.ReportSource = "C:\\Documents and Settings\\UserName\\My 
Documents\\Visual Studio\\Projects\\ProjectName\\CustomersByCity.rpt";  

6. Retrieve the ParameterFields instance from the ParameterFieldInfo property of the 
CrystalReportViewer control.

 Dim myParameterFields As ParameterFields =
myCrystalReportViewer.ParameterFieldInfo 
 ParameterFields parameterFields =
crystalReportViewer.ParameterFieldInfo; 

7. Pass in the ParameterFields and ArrayList instance to the SetCurrentValuesForParameterField() 
method.

 SetCurrentValuesForParameterField(myParameterFields, myArrayList) 
 SetCurrentValuesForParameterField(parameterFields, arrayList); 

1.5.1.2.5.4  To test the population of the 
defaultParameterValuesList ListBox control

Now that the selected values from the ListBox control have been applied as the current values for the parameter 
field, you are ready to redisplay the report.

You are now ready to build and run the project, to verify that the parameter field has been reset successfully.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. In the ListBox control, CTRL-click to select different cities in the list.
5. Click the Redisplay Report button.

The page reloads and displays the customer records for customers who live in the list of cities that you have 
selected.

6. Return to Visual Studio and click Stop to exit from debug mode.
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1.5.1.2.6 Configuring Parameter Persistence

In this section, you configure persistence (in a Web-based tutorial) for the parameter field selections that are 
made from the ListBox control.

1.5.1.2.6.1  To demonstrate lack of persistence for parameter 
selections

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. In the ListBox control, SHIFT-click to select all cities in the list.
5. Click Redisplay Report.

The page reloads, and then displays the customer records for all customers in all cities. This is a large report 
that contains many pages.

6. On the CrystalReportViewer toolbar, click Next Page.

The list of selected cities is not persisted. Page 2 of the report is not displayed. Instead, you see the startup 
parameter settings again (Paris and Tokyo).

7. Return to Visual Studio and click Stop to exit from debug mode.

You must add persistence code to your application so that changes made within the ReportDocument object 
model are persisted when Web pages are reloaded.

To begin, you add persistence code to the ConfigureCrystalReports() method, by adding an Else block to 
the Not IsPostBack conditional block. You then set unique values for the ArrayList instance for either condition 
in the conditional block. On page startup, you set the default values ("Paris" and "Tokyo") into the ArrayList 
instance. On page reloads, you retrieve the ArrayList instance that is stored in Session.

1.5.1.2.6.2  To add persistence code to the 
ConfigureCrystalReports() method

You must add persistence code to your application so that changes made are persisted when Web pages are 
reloaded.

To begin, you add persistence code to the ConfigureCrystalReports() method, by adding an Else block to 
the If Not IsPostBack conditional block. You then set unique values for the ArrayList instance for either 
condition in the conditional block. On page startup, you set the default values ("Paris" and "Tokyo") into the 
ArrayList instance. On page reloads, you retrieve the ArrayList instance that is stored in Session.

1. In the ConfigureCrystalReports() method, cut and paste the two lines of code, which add Paris and 
Tokyo to the ArrayList, into the bottom of the Not IsPostBack conditional block.

When you are finished, the conditional block should look like this:

 

236 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



If Not IsPostBack Then
    defaultParameterValuesList.DataSource =
GetDefaultValuesFromParameterField(myParameterFields)
    defaultParameterValuesList.DataBind()
    myArrayList.Add("Paris")
    myArrayList.Add("Tokyo")
End If 
 if (!IsPostBack)
{
   defaultParameterValuesList.DataSource =
GetDefaultValuesFromParameterField(parameterFields);
   defaultParameterValuesList.DataBind();
   arrayList.Add("Paris");
   arrayList.Add("Tokyo");
} 

2. Add a final line of code to the conditional block that assigns the ArrayList instance to Session.

Note
You can use the variable name as the string identifier for the Session that you add.

 Session("myArrayList") = myArrayList 
 Session["arrayList"] = arrayList; 

3. Add an Else condition to the Not IsPostBack conditional block.

4. Within the Else block, retrieve the ArrayList instance from Session and cast it to ArrayList.

 myArrayList = Ctype(Session("myArrayList"), ArrayList) 
 arrayList = (ArrayList)Session["arrayList"]; 

When you are finished, the conditional block should look like this:

 If Not IsPostBack Then
    defaultParameterValuesList.DataSource = 
GetDefaultValuesFromParameterField(myParameterFields)
    defaultParameterValuesList.DataBind()
    myArrayList.Add("Paris")
    myArrayList.Add("Tokyo")
    Session("myArrayList") = myArrayList
Else
    myArrayList = Ctype(Session("myArrayList"), ArrayList) End If

 if (!IsPostBack)
{
   defaultParameterValuesList.DataSource = 
GetDefaultValuesFromParameterField(parameterFields);
   defaultParameterValuesList.DataBind();
   arrayList.Add("Paris");
   arrayList.Add("Tokyo");
   Session["arrayList"] = arrayList;
}
else
{
   arrayList = (ArrayList)Session["arrayList"]; }
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Those modifications to ConfigureCrystalReports() method ensure that the current instance of ArrayList is 
always available to be passed into the SetCurrentValuesForParameterField() method.

In the next section, you make two changes to the code in the button click event:

● Take the ArrayList that you created and assign it to Session.
● Replace the last two lines of code (that configure and display the report) with a call to the 

ConfigureCrystalReports() method to perform this functionality on a common set of code.

1.5.1.2.6.3  To modify the code in the button click event method 
to work with Session persistence

1. Delete the last three lines of code in the button click event method.
○ The first line of code to delete is the code that binds the report file directory path to the ReportSource 

property of the CrystalReportViewer control.
○ The second line of code to delete is the code that retrieves the ParameterFields instance from the 

ParameterFieldInfo property of the CrystalReportViewer control.
○ The third line of code to delete is the call to the SetCurrentValuesForParameterField() method.

In the next step, you add two new lines of code to replace the deleted code.
2. Within the button click event method, immediately outside the foreach loop, add a line of code that assigns 

the ArrayList instance to Session.

Note
You can use the variable name as the string identifier for the Session that you add.

 Session("myArrayList") = myArrayList 
 Session["arrayList"] = arrayList; 

3. Call the ConfigureCrystalReports() method.

This retrieves the ArrayList instance, applies it to the report, and binds the report to the CrystalReportViewer 
control.

 ConfigureCrystalReports() 
 ConfigureCrystalReports(); 

1.5.1.2.6.4  To test the population of the 
defaultParameterValuesList ListBox control

You are now ready to build and run the project, to verify that the parameter field has been reset successfully.

1. From the Build menu, select Build Solution.
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2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. In the ListBox control, SHIFT-click to select all cities in the list.
5. Click Redisplay Report.

The page reloads and displays the customer records for all customers in all cities. This is a large report that 
contains many pages.

6. On the CrystalReportViewer toolbar, click Next Page.

7. The list of selected cities is now persisted. Page 2 of the report is displayed.
8. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.3 Tutorial: Reading and Setting Range Parameters for a 
Subreport

In this tutorial, you explore an additional complication: what if the report contains a subreport that requires 
different parameters?

Introduction

In the previous tutorial, Tutorial: Reading and Setting Discrete Parameters [page 219], you have learned how to 
create a report with a discrete parameter, and how to write code to set that parameter at runtime – both with 
hard-coded parameter values and parameter values that are passed from a ListBox or TextBox control.

In this tutorial, you learn how to add range parameters to a subreport.

You need to make four modifications to the project that you have previously created:

● You add a subreport into the original report.
This subreport addresses the Orders table of the Xtreme database. The Orders table is related to the 
Customers table that is used in the previous tutorial by a Customer ID foreign key.

● You add a range parameter to the subreport that filters by a range of order dates.
● You add two Text controls to the form: orderStartDate, and orderEndDate, to set the order date range at 

runtime.
● You modify the SetCurrentValuesForParameter() method that you have created in the previous tutorial.

This method creates a ParameterRangeValue instance that contains the startDate and endDate values, and 
then passes that ParameterRangeValue instance into the range parameter inside the subreport.

When you have completed this tutorial, you can filter the values that are displayed on the report at runtime. The 
code that you add limits the number of cities that are displayed in the main report, and limits the range of order 
dates to be displayed in the subreport.

This tutorial can also be completed with classes of the ReportDocument object model, see Tutorial: Reading and 
Setting Parameters with a Subreport [page 348].
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Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_CRVObjMod_ParametersSubrpt
● C# Windows project: CS_Win_CRVObjMod_ParametersSubrpt
● Visual Basic Web Site: VB_Web_CRVObjMod_ParametersSubrpt
● Visual Basic Windows project: VB_Win_CRVObjMod_ParametersSubrpt

Related Information

Choose the Correct Object Model for Your Project [page 29]
Sample Reports Directory [page 14]

1.5.1.3.1 Adding a Subreport to the Original Report

To begin, you add a subreport to the original report.

1.5.1.3.1.1  To add a subreport

1. Open the project you created in the previous tutorial, Tutorial: Reading and Setting Discrete Parameters 
[page 219].

2. From Solution Explorer, double-click the CustomersByCity report to open it.
3. Right-click the Details gray bar and select Insert Section Below.
4. Right-click within the new Details b section that you have created, point to Insert, and then click Subreport.

A gray square appears around the mouse cursor.
5. Drag the gray rectangle into the new Details b section, and then click to release.
6. In the Insert Subreport dialog box, on the Subreport tab, select Create a subreport with the Report Wizard.

Note
The Insert Subreport dialog box includes other options that allow you to choose an existing report and on-
demand subreports. For more information on these features, see Subreport Tab (Insert Subreport Dialog 
Box) [page 785].

7. In the New report name field, type "CustomerOrders."
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8. Click Report Wizard...
9. In the Available Data Sources panel of the Standard Report Creation Wizard window, expand the Create New 

Connection folder.
10. From the subfolder that opens, expand the ODBC (RDO) folder.
11. In the ODBC (RDO) window, select the correct ODBC DSN entry for the Xtreme database, and then click 

Finish.

The ODBC (RDO) folder expands and shows the Xtreme database.
12. Select the Orders table and click the > symbol to move the Orders table into the Select Tables panel, and then 

click Next.
13. From the Available Fields panel, select Order ID, Order Date, Ship Date, and Ship Via.
14. Click the > symbol to move these fields into the Fields to Display panel, and then click Finish.
15. In the Insert Subreport dialog box, select the Link tab.
16. In the panel Container Report field(s) to link to, in the list Available fields, expand the Customers table, select 

Customer ID, and then click the > symbol.
17. In the Customers.Customer ID field link panel that appears, leave the default selections unchanged.

These parameter and data selections auto-generate a relationship between the main report and the 
subreport.

18. Click OK.

The new subreport, CustomerOrders, is displayed within the Details b section of the Main report.

Note
When you add a subreport to the Details section, the subreport displays for every row, which adds a 
performance cost to your report. If you do not need subreport information with that level of granularity, 
place the subreport in a Group section rather than a Details section.

1.5.1.3.1.2  To verify the settings in the subreport

1. In the report Details section, double-click on the CustomerOrders subreport to view it.

At the bottom of the designer view, navigation buttons appear for both the Main Report and the 
CustomerOrders subreport.

2. If the Field Explorer is not visible, on the Crystal Reports toolbar, click Toggle Field View.

Note
Another way to display the Field Explorer is to go to the Crystal Reports menu, and then click Field Explorer.

3. In the Field Explorer, expand Parameter Fields.
4. Verify that the parameter field Pm-Customers.Customer ID was auto-generated when the subreport was 

linked.
5. On the Crystal Reports toolbar, click Select Expert.
6. In the Select Expert dialog box, verify that the criteria Orders.Customer ID is equal to {Pm-

Customers.Customer ID} is set, and then click OK.
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7. From the File menu, select Save All.

You have successfully added a CustomerOrders subreport to the CustomersByCity report.

1.5.1.3.1.3  To add an OrderDateRange parameter to the 
subreport

1. In the Field Explorer , right-click Parameter Fields and select New.
2. In the Create Parameter Field dialog box:

a. Set the Name to "OrderDateRange."
b. Set the Prompting text to "Specify a Date Range of Orders to display."
c. Set the Value type to " Date."
d. Set the Options to one selection only, " Range value(s)."

3. Click OK.
4. On the Crystal Reports toolbar, click Select Expert.
5. Click the New tab.
6. In the Choose Field dialog box, expand the Orders table, select Order Date, and then click OK.
7. On the new Orders.OrderDate tab, from the drop down criteria list, select formula and type the following 

formula: {Orders.Order Date} in {?OrderDateRange}
8. Click OK.
9. From the File menu, select Save All.

You have successfully added an OrderDateRange parameter to the subreport and linked it to the 
Orders.OrderDate column. In the next section, you add code to address the OrderDateRange parameter 
within the subreport.

1.5.1.3.2 Adding the Subreport Parameter Code

You are now ready to add the parameter code for the subreport to the code-behind class. To begin, you create a 
private helper method, SetDateRangeForOrders().

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the top of the class, add two new constants below the existing PARAMETER_FIELD_NAME constant added 

during the previous tutorial.

 Private Const SUBREPORT_PARAMETER_FIELD_NAME As String =
"OrderDateRange"
Private Const SUBREPORT_NAME As String = "CustomerOrders" 
 private const string SUBREPORT_PARAMETER_FIELD_NAME =
"OrderDateRange";
private const string SUBREPORT_NAME = "CustomerOrders"; 
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4. At the bottom of the class, create a new private method named SetDateRangeForOrders() with three 
parameters: ParameterFields, a string startDate, and a string endDate.

 Private Sub SetDateRangeForOrders(ByVal myParameterFields As
ParameterFields, ByVal startDate As String, ByVal endDate As
String)
End Sub 
 private void SetDateRangeForOrders(ParameterFields parameterFields,
string startDate, string endDate)
{
} 

5. Within this method, declare and instantiate the ParameterRangeValue class.

Note
For the ParameterRangeValue class to be accessible, you must include an "Imports" [Visual 
Basic] or "using" [C#] statement at the top of the code-behind class for the 
CrystalDecisions.Shared namespace. (You added this declaration in Project Setup [page 15].)

 Dim myParameterRangeValue As ParameterRangeValue = New
ParameterRangeValue() 
 ParameterRangeValue parameterRangeValue = new
ParameterRangeValue(); 

6. Set the StartValue property of the ParameterRangeValue instance to the startDate method parameter.

Note
The StartValue and EndValue properties of the ParameterRangeValue class accept values of type 
Object. This generic type allows the range value that is passed in to be of many types, including: text, 
number, date, currency, or time.

 myParameterRangeValue.StartValue = startDate 
 parameterRangeValue.StartValue = startDate; 

7. Set the EndValue property of the ParameterRangeValue instance to the endDate method parameter.

 myParameterRangeValue.EndValue = endDate 
 parameterRangeValue.EndValue = endDate; 

8. Set the lower and upper boundaries to be bound-inclusive.

Note
For BoundInclusive, the upper and lower range values are included in the range.

 myParameterRangeValue.LowerBoundType =
RangeBoundType.BoundInclusive
myParameterRangeValue.UpperBoundType =
RangeBoundType.BoundInclusive
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 parameterRangeValue.LowerBoundType = RangeBoundType.BoundInclusive;
parameterRangeValue.UpperBoundType = RangeBoundType.BoundInclusive; 

You are now ready to assign the ParameterRangeValue instance to the parameter of the subreport.

9. Retrieve the ParameterField instance from the ParameterFields indexed class, which is based on two 
indexed values: the subreport parameter field name and the subreport name. Pass in the two constant values 
that you declared at the top of the class.

 Dim myParameterField As ParameterField =
myParameterFields(SUBREPORT_PARAMETER_FIELD_NAME, SUBREPORT_NAME) 
 ParameterField parameterField =
parameterFields[SUBREPORT_PARAMETER_FIELD_NAME, SUBREPORT_NAME]; 

10. Call the Clear() method of the CurrentValues property of the ParameterField instance to remove any 
existing values from the CurrentValues property.

 myParameterField.CurrentValues.Clear() 
 parameterField.CurrentValues.Clear(); 

11. Add the ParameterRangeValue instance, which you created earlier, to the CurrentValues property of the 
ParameterField instance.

 myParameterField.CurrentValues.Add(myParameterRangeValue) 
 parameterField.CurrentValues.Add(parameterRangeValue); 

This step procedure has set start and end date values into a ParameterRangeValue instance and passed those 
values to the OrderDateRange parameter in the CustomerOrders subreport.

1.5.1.3.3 Adding TextBox Controls to Hold Range Parameter 
Values

In this section, you add two TextBox controls to provide start and end date values at runtime to the 
OrderDateRange range parameter in the CustomerOrders subreport.

Note
If you implement this tutorial in a Web Site, the persistence of date values that users enter into the text boxes 
are maintained by ViewState.
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1.5.1.3.3.1  To create and configure a redisplay Button on the 
form

1. Open the Web or Windows Form.
2. From the View menu, click Designer.
3. If you are developing a Web Site, do the following:

a. Click between the ListBox control and the Button control.
b. Press ENTER three times to create two rows between the ListBox control and the Button control.
c. In the first row created below the ListBox control, type Order Start Date.
d. In the second row created below the ListBox control, type Order End Date.

4. If you are developing a Windows project, do the following:
a. From the Toolbox, drag two Label controls to the right of the ListBox control. Place one label above the 

other, with both of them above the Button control.
b. Select the first Label control, and then from the Properties window, set the Text property to Order 

Start Date.
c. Select the second Label control, and then from the Properties window, set the Text property to Order 

End Date.

5. From the Toolbox drag a control to the right of "Order Start Date."
6. Click on the TextBox control to select it.
7. From the Properties window, set the ID (or Name ) to orderStartDate.

8. From the Toolbox, drag a TextBox control to the right of "Order End Date."
9. Click on the TextBox control to select it.
10. From the Properties window, set the ID (or Name ) to orderEndDate.

11. From the File menu, select Save All.

1.5.1.3.4 Modifying Methods to Call the Subreport

You must now modify the ConfigureCrystalReports() method and the redisplay_Click() event method 
to receive information from these TextBox controls and apply them to the SetDateRangeForOrders() method, 
to have the parameter information processed for subreports.

In the previous tutorial, Tutorial: Reading and Setting Discrete Parameters [page 219], you designed these 
methods in two different ways, depending on whether you included Session persistence.

Note
Windows projects do not require Session persistence. Web Sites typically require Session persistence.

Choose from one (but not both) of the step procedures below. Either modify the methods that exclude Session 
persistence, or modify the methods that include Session persistence.
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1.5.1.3.4.1  Modifying Methods that Exclude Session 
Persistence

If you created the previous tutorial Tutorial: Reading and Setting Discrete Parameters [page 219] and excluded 
Session persistence, work through the following procedures. Otherwise go instead to Modifying Methods that 
Include Session Persistence [page 247].

1.5.1.3.4.1.1  To modify the ConfigureCrystalReports() method 
that excludes Session persistence

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code after the lines which 
assign "Paris" and "Tokyo" as ArrayList variables.

2. Within the line breaks, declare and set hard-coded values for two string variables, startDate and endDate.

  Dim startDate As String = "8/1/1997"  Dim endDate As String = "8/31/1997"  
  string startDate = "8/1/1997";  string endDate = "8/31/1997";  

3. Below the code that calls SetCurrentValuesForParameterField(), call the 
SetDateRangeForOrders() method and pass in the ParameterFields instance and the startDate and 
endDate variables.

 SetDateRangeForOrders(myParameterFields, startDate, endDate) 
 SetDateRangeForOrders(parameterFields, startDate, endDate); 

4. From the File menu, select Save All.

1.5.1.3.4.1.2  To modify the redisplay_Click() method that 
excludes Session persistence

1. In the redisplay_Click() event method, create a couple of line breaks in the code above the line that binds 
the report to the CrystalReportViewer control.

2. Within the line breaks, declare and set values for two string variables, startDate and endDate, from the 
TextBox controls that you added to the Web or Windows form.

 Dim startDate As String = orderStartDate.Text
Dim endDate As String = orderEndDate.Text 
 string startDate = orderStartDate.Text;
string endDate = orderEndDate.Text; 
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3. Below the code that calls SetCurrentValuesForParameterField(), call the 
SetDateRangeForOrders() method and pass in the ParameterFields instance and the startDate and 
endDate variables.

 SetDateRangeForOrders(myParameterFields, startDate, endDate) 
 SetDateRangeForOrders(parameterFields, startDate, endDate); 

4. From the File menu, select Save All.

1.5.1.3.4.2  Modifying Methods that Include Session 
Persistence

If you created the previous tutorial Tutorial: Reading and Setting Discrete Parameters [page 219] and included 
Session persistence, work through the following procedures. Otherwise, continue to Modifying Methods that 
Exclude Session Persistence [page 246].

1.5.1.3.4.2.1  To modify the ConfigureCrystalReports() method 
that includes Session persistence

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code after the line that 
declares and instantiates ArrayList.

2. Within the line breaks, declare two string variables, startDate and endDate.

 Dim startDate As String
Dim endDate As String 
 string startDate;
string endDate; 

3. Within the Not IsPostBack conditional block, enter default values for the startDate and endDate variables.

  startDate = "8/1/1997"  endDate = "8/31/1997"  
  startDate = "8/1/1997";  endDate = "8/31/1997";  

4. Within the Not IsPostBack conditional block, assign the startDate and endDate variables into Session.

 Session("startDate") = startDate
Session("endDate") = endDate 
 Session["startDate"] = startDate;
Session["endDate"] = endDate; 
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5. Within the Else block, after the ArrayList instance is retrieved from Session, retrieve the startDate and 
endDate variables from Session.

 startDate = Session("startDate").ToString()
endDate = Session("endDate").ToString() 
 startDate = Session["startDate"].ToString();
endDate = Session["endDate"].ToString(); 

With that approach, you reach the end of the block with the date variables assigned in either case. This follows 
parallel logic to the assignment of the ArrayList variable that you configured in the previous tutorial.

6. Below the code that calls SetCurrentValuesForParameterField(), call the 
SetDateRangeForOrders() method and pass in the ParameterFields instance and the startDate and 
endDate variables.

 SetDateRangeForOrders(myParameterFields, startDate, endDate) 
 SetDateRangeForOrders(parameterFields, startDate, endDate); 

7. From the File menu, select Save All.

1.5.1.3.4.2.2  To modify the redisplay_Click() method that 
includes Session persistence

Now, you modify the redisplay_Click event method.

1. In the redisplay_Click() event method, create a couple of line breaks in the code after the line that 
assigns the ArrayList instance to Session.

2. Within the line breaks, assign the Text property of the orderStartDate TextBox and the orderEndDate TextBox 
to Session variables.

 Session("startDate") = orderStartDate.Text
Session("endDate") = orderEndDate.Text 
 Session["startDate"] = orderStartDate.Text;
Session["endDate"] = orderEndDate.Text; 

3. From the File menu, select Save All.

Those startDate and endDate Session values are now retrieved and applied when the 
ConfigureCrystalReports() method is called.

You are now ready to build and run the project, to verify that the TextBox values are resetting the range parameter 
in the subreport.

1.5.1.3.5 Testing the Subreport Parameter

You are now ready to test the setting of the subreport parameter from the TextBox values.
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1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. In the ListBox control, CTRL-click to select at least four different cities in the list.
5. In the orderStartDate TextBox control, enter 1/1/1997.

6. In the orderEndDate TextBox control, enter 8/31/1997.

7. Click the Redisplay Report button.

The page reloads and displays the customer records for customers who live in the list of cities that have just 
been selected, as well as a subreport that displays orders for the date range specified above.

8. In the CrystalReportViewer control, increase the Zoom level to 125%.

The page reloads at 125% zoom. The values that are selected for both cities and order date range are 
persisted.

9. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.4 Tutorial: Filtering Data Using Selection Formulas

In this tutorial, you learn to use selection formulas to filter the records that you want to display on a Crystal report.

Introduction

Selection formulas are used to filter records that you want to display on a Crystal report. To write selection 
formulas, you can use the Basic syntax and the Crystal syntax.

In this tutorial, you create a selection formula to filter customer records where the Last Year's Sales field is 
greater than a specific value, and the Customer Name field is compared to another string. A ListBox control is 
used to select a comparison operator for the Customer Name field. You can choose to display customer names 
that are equal to, less than, greater than, less than or equal to, greater than or equal to, or not equal to the string 
value that you have specified.

The formula is passed as a string variable to the SelectionFormula property of the CrystalReportViewer class. 
Once the property is set, the Crystal report that binds to the CrystalReportViewer control is filtered before it is 
displayed.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:
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● C# Web Site: CS_Web_CRVObjMod_FilteringData
● C# Windows project: CS_Win_CRVObjMod_FilteringData
● Visual Basic Web Site: VB_Web_CRVObjMod_FilteringData
● Visual Basic Windows project: VB_Win_CRVObjMod_FilteringData

Related Information

Formula Reference [page 647]
Sample Reports Directory [page 14]

1.5.1.4.1 Creating a Report with a Selection Formula

In this section, you create a report that draws information from the Xtreme database.

1.5.1.4.1.1  To create a report with secure data from the Xtreme 
database

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, in the Templates view, select the Crystal Report template.
3. In the Name field, enter the name CustomersBySalesName.rpt and click Add.

4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 
Report Wizard.

5. In the Choose an Expert panel, select Standard, and then click OK.
6. In the Available Data Sources panel of the Standard Report Creation Wizard window, expand the Create New 

Connection folder.
7. From the subfolder that opens, expand the ODBC (RDO) folder.
8. In the ODBC (RDO) window, select the correct ODBC DSN entry for the Xtreme Sample Database and then 

click Finish.

The ODBC (RDO) folder expands and shows the Xtreme database.
9. Expand the Tables node, and then double-click the Customer table to move the table to the Selected Tables 

panel, and then click Next.
10. Expand the Customer table, and then CTRL-click Customer Name, and Last Year's Sales.
11. Click the > symbol to move these fields into the Fields to Display panel, and then click Next.
12. In the Available Fields panel, under Report Fields, double-click Customer.Customer Name to move the field 

into the Group By panel, and then click Finish.

The CustomersBySalesName report is created and loaded into the main window of Visual Studio.
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1.5.1.4.1.2  To create a selection formula based on Last Year's 
Sales

Next, you create a selection formula to filter the data based on the Last Year's Sales field.

1. Open the Web or Windows Form.
2. From the View menu, click Code to view the code-behind class for this Web or Windows Form.
3. For a Web Site, within the ConfigureCrystalReports() method (that you have created in Project Setup 

[page 15]), create a Not IsPostBack conditional block.

Note
The Not IsPostBack conditional block encapsulates code that should be run only the first time the page 
loads.

 If Not IsPostBack Then
End If 
 if(!IsPostBack)
{
} 

4. For a Web Site, add the following lines of code within the Not IsPostBack conditional block. For a Windows 
project, add the code to the ConfigureCrystalReports() method, without the Not IsPostBack 
conditional block.
a. Enter the formula to select only records with Last Year's Sales greater than $11000.00, and customer 

names that begin with the letter "A".

 Dim mySelectFormula As String = "{Customer.Last Year's Sales} >
11000.00 " _
& "AND Mid({Customer.Customer Name}, 1, 1) = ""A"" " 
 string selectFormula = "{Customer.Last Year's Sales} > 11000.00
"
+ "AND Mid({Customer.Customer Name}, 1, 1) = \"A\""; 

b. Assign the selection formula string to the SelectionFormula property of the CrystalReportViewer control.

 myCrystalReportViewer.SelectionFormula = mySelectFormula 
 crystalReportViewer.SelectionFormula = selectFormula; 

1.5.1.4.2 Binding the Report

When you followed the instructions in the section Project Setup [page 15] to prepare for this tutorial, you placed a 
CrystalReportViewer control on the Web or Windows Form. In the previous steps, you added a 
CustomersBySalesName report and a selection formula to the project.
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In this section, you bind the file directory path of the CustomersBySalesName report to the 
CrystalReportViewer control. Then you test whether the report displays correctly with the records that are 
filtered by the selection formula.

1.5.1.4.2.1  To bind the file directory path of the 
CustomersBySalesName report to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code to view the code-behind class for this Web or Windows Form.
3. Locate the ConfigureCrystalReports() method (that you have created in Project Setup [page 15]).

4. Declare a string variable, name it reportPath, and assign to it a runtime path to the local report. This path is 
determined differently for Web Sites and Windows projects:

○ For a Web Site, pass the name of the local report file as a string parameter into the Server.MapPath() 
method. This maps the local report to the hard drive file directory path at runtime.

 Dim reportPath As String =
Server.MapPath("CustomersBySalesName.rpt") 
 string reportPath = Server.MapPath("CustomersBySalesName.rpt"); 

○ For a Windows project, concatenate the Application.StartupPath property with a backslash and the 
local report file name. This maps the report to the same directory as the Windows executable file.

Note
At compile time you will copy the report to the directory containing the executable file.

 Dim reportPath As String = Application.StartupPath & "\" &
"CustomersBySalesName.rpt" 
 string reportPath = Application.StartupPath + "\\" +
"CustomersBySalesName.rpt"; 

5. Assign the file directory path of the NorthwindCustomers report to the ReportSource property of the 
CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = reportPath 
 crystalReportViewer.ReportSource = reportPath; 
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1.5.1.4.2.2  To test the selection formula for the 
CustomersBySalesName report

1. From the Build menu, click Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. If you use a non-embedded report in a Windows project, locate the compiled Windows executable in the \bin

\ [Visual Basic] or \bin\debug\ [C#] subdirectory, and then copy the report to that subdirectory.

Note
To have the non-embedded report loaded by the Windows executable at runtime, the report must be 
stored in the same directory as the Windows executable.

4. From the Debug menu, click Start.

The Crystal report displays four customer records: Alley Cat Cycles, Ankara Bicycle Company, Arsenault et 
Maurier, and Athens Bicycle Co.

5. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.4.3 Adding Controls to Use in the Selection Formula

In this section, you add controls to dynamically change the values that are used in the selection formula. For the 
Last Year's Sales field, you add a textbox to specify the minimum value of sales to be displayed in the Crystal 
report. For the Customer Name field, you add a DropDownList and TextBox control to specify what customer 
names to display.

1. Open the Web or Windows Form.
2. From the View menu, click Designer.
3. If you are developing a Web Site, do the following:

a. Click the CrystalReportViewer control to select it.
b. Press the LEFT ARROW on your keyboard so that a flashing cursor appears, and then press ENTER three 

times.
The CrystalReportViewer control drops by three lines.

4. If you are developing a Windows project, do the following:
a. Click the CrystalReportViewer control to select it.
b. From the Properties window, set Dock to "Bottom".
c. Resize the CrystalReportViewer control, so that approximately three lines appear above it.
d. From the Properties window, set Anchor to "Top, Bottom, Left, Right".

5. If you are developing a Web Site, on the first line type, Enter the minimum value for last year's 
sales: $.

6. If you are developing a Windows project, do the following:
a. From the Toolbox, drag a Label control to the top of the form.
b. From the Properties window, set the Text property to Enter the minimum value for last year's 

sales: $.
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7. From the Toolbox, drag a TextBox control to the right of the text.
8. Select the TextBox control, and then from the Properties window, do the following:

a. Set the ID (or Name) to lastYearsSales.
b. Set the Text to 11000.00.

9. If you are developing a Web Site, on the second line, type Display the customer names.

10. If you are developing a Windows project, do the following:
a. From the Toolbox, drag a Label control to the second line of the form.
b. From the Properties window, set the Text property to "Display the customer names".

11. From the Toolbox, drag a DropDownList ( ComboBox in a Windows project) to the right of the text.
12. Select the DropDownList ( ComboBox) control, and then from the Properties window, set the ID (or Name) to 

"selectOperatorList".
13. From the Toolbox, drag a TextBox control to the right of the DropDownList control.
14. Select the TextBox control, and then from the Properties window, do the following:

a. Set the ID (or Name) to customerName.
b. Set the Text to A.

15. From the Toolbox, drag a Button control to the third line of the form, and above the CrystalReportViewer 
control.

16. Select the Button control, and then from the Properties window, do the following:
a. Set the ID (or Name) to redisplay.
b. Set the Text to Redisplay Report.

1.5.1.4.4 Setting the Selection Formula Manually in Code

You are now ready to add code to modify the selection formula in the code-behind class.

1.5.1.4.4.1  To code the selection formula

1. Open the Web or Windows Form.
2. From the View menu, select Designer.
3. Double-click Redisplay Report.

The code-behind class for the report appears and shows that a redisplay_Click() event method has been 
automatically generated.

4. For the selection formula, create a string variable that takes the values from the TextBox controls.

The selection formula is similar to the text you have typed within the ConfigureCrystalReports() 
method. Instead of a minimum sales value of $11000.00, you use the value from the lastYearsSales 
TextBox control. For the Customer Name field, you use the value from the customerName TextBox control.

 Dim mySelectFormula As String = "{Customer.Last Year's Sales} >
" & lastYearsSales.Text _
& " AND Mid({Customer.Customer Name}, 1, 1) > """ &
customerName.Text & """"
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 string selectFormula = "{Customer.Last Year's Sales} > " +
lastYearsSales.Text
+ " AND Mid({Customer.Customer Name}, 1, 1) > \"" +
customerName.Text + "\""; 

5. Assign the string variable to the SelectionFormula property of the CrystalReportViewer control.

 myCrystalReportViewer.SelectionFormula = mySelectFormula 
 crystalReportViewer.SelectionFormula = selectFormula; 

6. Rebind the CustomerBySalesName report to the ReportSource property of the CrystalReportViewer 
control.

Note
The file directory path that is shown here is for a Visual Studio project. ProjectName is replaced by the 
name of your Web or Windows project. UserName is replaced by your computer logon name.

○ The default path for a Web Site project is as follows:

  myCrystalReportViewer.ReportSource = "C:\WebSites\
ProjectName\CustomersBySalesName.rpt"  
  crystalReportViewer.ReportSource = "C:\\WebSites\\
ProjectName\\CustomersBySalesName.rpt";  

○ The default path for a Windows project is as follows:

  myCrystalReportViewer.ReportSource = "C:\Documents and Settings\
UserName\My Documents\Visual Studio\Projects\
ProjectName\CustomersBySalesName.rpt"  
  crystalReportViewer.ReportSource = "C:\\Documents and Settings\\
UserName\\My Documents\\Visual Studio\\Projects\\
 ProjectName\\CustomersBySalesName.rpt";  

You have now created a selection formula that you can modify at run time.

1.5.1.4.4.2  To test the selection formula

1. From the Build menu, click Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. In the lastYearsSales TextBox, type 200000.

5. In the customerName TextBox, type SAB
6. Click Redisplay Report.

The Crystal report displays three customer records: SAB Mountain, Tek Bikes, and Tienda de Bicicletas El 
Pardo.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 255



Only customer records with names greater than "SAB" and last year's sales greater than "200000" are 
displayed.

7. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.4.5 Using a DropDownList Control to Modify the 
Selection Formula

In this section, you populate the DropDownList control with comparison operators. You create an enum that 
contains the comparison operators.

The DropDownList control selects whether you want to display customer names that are equal to, less than, 
greater than, less than or equal to, greater than or equal to or not equal to the text that you have entered into the 
TextBox control.

In the redisplay_Click() event method, you modify the string that is currently assigned to the 
SelectionFormula property of the CrystalReportViewer control.

1.5.1.4.5.1  To create the CeComparisonOperator enum

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, select Class from the Templates view.
3. In the Name field, type CeComparisonOperator, and then click Add.

Note
You may be asked to place this class in a Code directory. Click the Yes button.

4. In the class signature, change the word class to enum to convert the class to an enumeration.

In a C# Windows project, you also must change the namespace to the name of your project.

Note
In Visual Basic, remember to change both the opening and the closing signatures of the class to enum.

5. Because enums do not have constructors, delete the default constructor method that is provided in the C# 
version of the code.

6. Inside the enum, enter the values:

 EqualTo
LessThan
GreaterThan
LessThan_or_EqualTo
GreaterThan_or_EqualTo
Not_EqualTo 
 EqualTo,
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LessThan,
GreaterThan,
LessThan_or_EqualTo,
GreaterThan_or_EqualTo,
Not_EqualTo 

1.5.1.4.5.2  To populate the DropDownList control from the 
CeComparisonOperator enum for a Web Site

The following procedures explain how to bind the CeComparisonOperator enum to the DropDownList control for a 
Web Site or for a Windows project. Complete the instructions in one of the step procedures below.

1. Open the Web Form.
2. From the View menu, click Code.
3. Within the Not IsPostBack conditional block of the ConfigureCrystalReports() method, before the 

selection formula string declaration, set the DataSource property of the DropDownList control to the 
values of the CeComparisonOperator enum.

 selectOperatorList.DataSource =
System.Enum.GetValues(GetType(CeComparisonOperator)) 
 selectOperatorList.DataSource =
System.Enum.GetValues(typeof(CeComparisonOperator)); 

4. Now call the DataBind() method of the selectOperatorList DropDownList to bind the values to the control.

 selectOperatorList.DataBind() 
 selectOperatorList.DataBind(); 

1.5.1.4.5.3  To populate the DropDownList control from the 
CeComparisonOperator enum for a Windows 
project

1. Open the Windows Form.
2. From the View menu, click Code.
3. Within the ConfigureCrystalReports() method, before the selection formula string declaration, set the 

DataSource property of the selectOperatorList ComboBox to the values of the CeComparisonOperator enum.

 selectOperatorList.DataSource =
System.Enum.GetValues(GetType(CeComparisonOperator)) 
 selectOperatorList.DataSource =
System.Enum.GetValues(typeof(CeComparisonOperator)); 
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1.5.1.4.5.4  To create the GetSelectedCompareOperator() 
helper method

Next, you create the GetSelectedCompareOperator() helper method to return the selected index as a string 
that represents a comparison operator sign.

1. At the bottom of the class, create a private helper method named GetSelectedCompareOperator() that 
returns a string variable.

 Private Function GetSelectedCompareOperator() As String
End Function 
 private string GetSelectedCompareOperator()
{
} 

2. Within the method, create a "Select Case" [Visual Basic] or "switch" [C#] statement that 
references the members of the CeComparisonOperator enum, and returns the comparison operator sign as a 
string variable.

 Select Case selectOperatorList.SelectedIndex
   Case CeComparisonOperator.EqualTo
      return "="
   Case CeComparisonOperator.LessThan
      return "<"
   Case CeComparisonOperator.GreaterThan
      return ">"
   Case CeComparisonOperator.LessThan_or_EqualTo
      return "<="
   Case CeComparisonOperator.GreaterThan_or_EqualTo
      return ">="
   Case CeComparisonOperator.Not_EqualTo
      return "<>"
   Case Else
      return "="
End Select 
 switch ((CeComparisonOperator)selectOperatorList.SelectedIndex)
{
   case CeComparisonOperator.EqualTo:
      return "=";
   case CeComparisonOperator.LessThan:
      return "<";
   case CeComparisonOperator.GreaterThan:
      return ">";
   case CeComparisonOperator.LessThan_or_EqualTo:
      return "<=";
   case CeComparisonOperator.GreaterThan_or_EqualTo:
      return ">=";
   case CeComparisonOperator.Not_EqualTo:
      return "<>";
   default:
      return "=";
} 
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1.5.1.4.5.5  To modify the Customer Name's comparison 
operator that is assigned to the SelectionFormula 
property

In the redisplay_Click() event method, a "greater than" sign (">") is currently used for the Customer Name 
field selection. Next, you learn how to change the sign to the comparison operator that you have selected from the 
DropDownList control. The selected sign is returned as a string when you call the 
GetSelectedCompareOperator() helper method.

1. At the top of the redisplay_Click() event method, call the GetSelectedCompareOperator() helper 
method, and assign the result to a string variable.

 Dim mySelectedOperator As String = GetSelectedCompareOperator() 
 string selectedOperator = GetSelectedCompareOperator(); 

2. For the selection formula string variable, replace the "greater than" sign (">") with the selected operator 
string.

 Dim mySelectFormula As String = "{Customer.Last Year's Sales} >
" & lastYearsSales.Text _
& " AND Mid({Customer.Customer Name}, 1, 1) " &
mySelectedOperator & " """ & customerName.Text & """" 
 string selectFormula = "{Customer.Last Year's Sales} > " +
lastYearsSales.Text
+ " AND Mid({Customer.Customer Name}, 1, 1) " + selectedOperator + "
\"" + customerName.Text + "\""; 

1.5.1.4.5.6  To test the selection formula for the 
CustomersBySalesName report

You have created a selection formula that depends on the values that you enter for the Last Year's Sales field, and 
the Customer Name field.

You can now build and test the selection formula.

1. From the Build menu, click Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

a. In the lastYearsSales TextBox, type 40000.
b. In the customerName TextBox, type Athens Bicycle Co.
c. In the DropDownList, select LessThan.
d. Click Redisplay Report.

The Crystal report displays two customer records: Alley Cat Cycles, and Ankara Bicycle Company.
4. Return to Visual Studio and click Stop to exit from debug mode.
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1.5.1.5 Tutorial: Customizing the CrystalReportViewer 
Control

In this tutorial, you learn how to customize the display of the CrystalReportViewer control.

Introduction

In this tutorial, you learn how to customize the look of the CrystalReportViewer control through use of the 
properties from its underlying class.

You also learn how to use the methods for page selection, zoom, search, and print.

To begin, you learn how to customize the CrystalReportViewer toolbar. You need a ListBox that stores the 
properties that are available for the toolbar. Only the properties selected from the ListBox control are displayed 
on the CrystalReportViewer toolbar.

Then, you add a second ListBox to store the elements for the report. For a Web Site, you also choose to display all 
the report pages as a single page or as separate pages.

You learn how to customize the background color through a DropDownList control.

Next, you learn how to select the report page that you want to view. You need a TextBox control to enter the page 
number, and a Button control to reload the report to your selected page. You also need a TextBox and a Button 
control to modify the zoom factor and to search for text in your report.

For a Web Site, you have access to properties of the CrystalReportViewer control that are not available in a 
Windows project: one property to choose the print mode and other properties to change the width, style, and 
color of borders.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_CRVObjMod_CustomizeViewer
● C# Windows project: CS_Win_CRVObjMod_CustomizeViewer
● Visual Basic Web Site: VB_Web_CRVObjMod_CustomizeViewer
● Visual Basic Windows project: VB_Win_CRVObjMod_CustomizeViewer
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Related Information

Sample Reports Directory [page 14]

1.5.1.5.1 Creating a Customized Settings Table

In this section, you create and configure a table (in a Web Site) or a TableLayoutPanel control (in a Windows 
project) to hold the various controls that make up your customized settings table.

Because Web Sites and Windows projects each use a different kind of table, please select the step procedure that 
corresponds to your Web Site or Windows project.

1.5.1.5.1.1  To create a customized settings table for a Web Site

1. Open the Default.aspx page (the Web form) in Design view.
2. Click the CrystalReportViewer control to select it.
3. Press the left arrow to move the cursor to the left of the CrystalReportViewer control and then press Enter.
4. Press the up arrow to move the cursor to the empty line above the CrystalReportViewer control.
5. From the Layout menu, click Insert Table.
6. In the Insert Table dialog box, select the Custom radio button.
7. In the Layout panel, select the Width checkbox and leave the value at 100%.
8. Increase the Rows count to 6 and the Columns count to 4.
9. In the Attributes panel, select the Border checkbox, and increase the count to 1.
10. Click the Cell Properties... button.
11. In the Cell Properties dialog box, in the Layout panel, set the Vertical align combo box to Top.
12. Select the No Wrap checkbox, and then click OK.
13. Click OK again to close the Insert Table dialog box.

You are now ready to add customized controls into this table for your Web Site.

Continue to Report and Toolbar Elements of the CrystalReportViewer control [page 263].

1.5.1.5.1.2  To create a customized settings table for a Windows 
project

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.
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1. Open the Windows Form in Design view.
2. Click the Form title bar to select the entire form, and then drag the lower right corner of the form to enlarge it 

to fill the main area.
3. Click the CrystalReportViewer control to select it.
4. From the Properties window, set Dock to "Bottom."

5. From the Properties window, set Anchor to "Top, Bottom, Left, Right."

6. From the Toolbox, drag a TableLayoutPanel control to the upper left of the Windows Form.

A TableLayoutPanel control is displayed, showing two columns and two rows.
7. If the Smart Task is not open, click the triangular button on the upper-right corner of the TableLayoutPanel 

control.

The Smart Task panel named "TableLayoutPanel Tasks" opens.
8. In the TableLayoutPanel Tasks tag, click the Edit Rows and Columns link.
9. In the Column and Row Styles dialog box, in the Member Type combo box, select Columns.
10. Click Add until you have a total of four columns.
11. For each column, do the following:

a. Select the column.
b. In the Size Type panel select Percent.
c. Set each value to 25%.

12. In the Member Type combo box, select Rows.
13. Click Add until you have a total of five rows.

Note
The table for the Windows project requires one less row than the table for a Web Site, because there are a 
few less configurable options on a CrystalReportViewer control for a Windows project.

14. For each row, do the following:
a. Select the row.
b. In the Size Type panel select Percent.
c. Set the value of the first row to 40%, and for each subsequent row set the value to 15%.

Note
(1 x 40%) and (4 x 15%) = 100% of available space.

15. Click OK.
16. Close the TableLayoutPanel tasks tag.
17. Drag the bottom right corner of the TableLayoutPanel control to enlarge the table until it fills the space you 

have created above the CrystalReportViewer control.

You are now ready to add customized controls into this table for your Windows project.
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1.5.1.5.2 Report and Toolbar Elements of the 
CrystalReportViewer control

In this tutorial you will manipulate the various Report and Toolbar Elements of the CrystalReportViewer control.

Viewer elements 

The default elements for the CrystalReportViewer control vary slightly for Web Sites or Windows projects:

● For both Web and Windows:
○ Toolbar: displays a toolbar above the main area of the report. Individual elements within the toolbar are 

controlled separately.

Note
For more information, see the section on Toolbar elements below.

○ Group tree: displays the headings for each group in the report, similar to a directory tree; it appears on 
the left column panel of the report.

● For Web only:
○ Main page: displays the report in the main area of the page.
○ Enable separate pages: determines whether to display the report in a single Web page or as separate 

formatted pages.
● For Windows only:

○ Status bar: displays current page number and other information about the report, at the bottom of the 
report area.

Toolbar elements 

The default elements for the toolbar vary slightly for Web Sites or Windows projects:

● For both Web and Windows:
○ Group tree button: shows or hides the group tree section of the report.
○ Export: saves the Crystal report to another file format, such as RPT, PDF, DOC, XLS, or RTF files.
○ Print: prints the Crystal report to a PDF file, or it calls the Print dialog box.
○ Page navigation: allows you to select next, previous, last, or first page to view.
○ Go to page: allows you to type in the page number you want to view.
○ Search: allows you to type in a string you want to search for in the report.
○ Zoom factor: allows you to select the zoom factor for the report.

● For Web only:
○ View list (only for a Web Site): chooses which view of the report to display, (for example, subreports and 

so on).
○ Drill up: opens a page that has more specific information than the current topic.
○ Crystal logo: displays the SAP Crystal Reports product logo.
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● For Windows only:
○ Refresh: redisplays the report.
○ Close current view: closes the current view of the report if more than one view is open.

1.5.1.5.3 Adding a Hide Show Mechanism for Report and 
Toolbar Elements

In this section, you learn how to add a hide show mechanism to determine which elements to display on the 
CrystalReportViewer toolbar.

You begin by adding the ListBox and Button controls into the table on the Web or Windows form.

You then create two enums that list the report elements and the toolbar elements, and you then populate each 
ListBox with the values from one of the enums.

Next, you code the Button control's click event to update the report and toolbar elements.

Within the event handler the properties of the CrystalReportViewer class are set based on selections in the two 
ListBox controls. If an item from the ListBox is selected, the toolbar property is set to true.

Later in this tutorial, the Button control is used to update additional selections.

At run time, you can select which report and toolbar elements you wish to display.

You begin by adding the controls into the table at the top of the Web or Windows Form.

1. Open the Web or Windows Form in Design view.
2. From the Toolbox, drag a Label control to the first row, column one of the table.
3. Select the Label control, and then from the Properties window, set the Text to Select report elements 

to display.

4. From the Toolbox, drag a ListBox control to the first row, column two of the table.
5. Select the ListBox control, and then from the Properties window, do the following:

a. Set the ID to listCRVReport.
b. Set the SelectionMode to Multiple (in a Windows project, MultiExtended).

6. From the Toolbox, drag a second Label control to the first row, column three of the table.
7. Select the Label control, and then from the Properties window, set the Text to Select toolbar elements 

to display .

8. From the Toolbox, drag a Button control to the third row, column one of the table.
9. Click on the Button control to select it.
10. From the Properties window:

a. Set the ID to "redisplay."
b. Set the Text to "Redisplay Report."

11. In a Windows project, resize the Button control to display the full button text.

Your next steps vary, depending on whether you are building a Web Site or a Windows project. Please choose one 
of the following:

● Configuring the ListBox controls for a Web Site [page 265]
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● Configuring the ListBox controls for a Windows project [page 270]

1.5.1.5.4 Configuring the ListBox controls for a Web Site

This section explains how to configure ListBox controls for a Web Site. If you are building a Windows project, see 
Configuring the ListBox controls for a Windows project [page 270].

You can now create the click event handler for the Button control, and then add code to this event handler. The 
event handler sets various Boolean values for the toolbar properties of the CrystalReportViewer class based on 
the user's selections in the ListBox control.

Before creating this event handler, you need to create two enums: CeWebCRVReportOptions and 
CeWebCRVToolbarOptions.

These enums provide a list of selectable report elements and toolbar elements.

1.5.1.5.4.1  To create the CeWebCRVReportOptions enum

1. In Solution Explorer, right-click the Web Site name, point to Add, and then click Add New Item.
2. In the Add New Item dialog box, select Class from the Templates view.
3. In the Name field, type "CeWebCRVReportOptions", and then click Add.

Note
You may be asked to place this class in an App_Code directory. Click the Yes button.

4. In the class signature, change the word class to "enum" to convert the class to an enumeration.

Note
In Visual Basic, remember to change both the opening and the closing signatures of the class to enum.

5. Because enums do not have constructors, delete the default constructor method that is provided in the C# 
version of the code.

6. Inside the enum, enter the values:

 Toolbar
Group_Tree
Main_Page
Enable_Separate_Pages 
 Toolbar,
Group_Tree,
Main_Page,
Enable_Separate_Pages 

7. From the File menu, click Save All.
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1.5.1.5.4.2  To create the CeWebCRVToolbarOptions enum

1. In Solution Explorer, right-click the Web Site name, point to Add, and then click Add New Item.
2. In the Add New Item dialog box, select Class from the Templates view.
3. In the Name field, type CeWebCRVToolbarOptions , and then click Add.

Note
You may be asked to place this class in an App_Code directory. Click the Yes button.

4. In the class signature, change the word class to "enum" to convert the class to an enumeration.

Note
In Visual Basic, remember to change both the opening and the closing signatures of the class to enum.

5. Because enums do not have constructors, delete the default constructor method that is provided in the C# 
version of the code.

6. Inside the enum, enter the values:

 Group_Tree_Button
Export_Button
Print_Button
View_List_Button
Drill_Up_Button
Page_Navigation_Button
Go_to_Page_Button
Search_Button
Zoom_Button
Crystal_Logo 
 Group_Tree_Button,
Export_Button,
Print_Button,
View_List_Button,
Drill_Up_Button,
Page_Navigation_Button,
Go_to_Page_Button,
Search_Button,
Zoom_Button,
Crystal_Logo 

7. From the File menu, click Save All.

1.5.1.5.4.3  To populate the ListBox controls from the enums

You now populate the ListBox controls with the enum values, which represent the properties that are available 
for the CrystalReportViewer toolbar.

1. Open the Web Form.
2. From the View menu, click Code.
3. Within the ConfigureCrystalReports() method, add a Not IsPostBack conditional block.

266 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



Note
You created the ConfigureCrystalReports() method during Project Setup [page 15] at the beginning 
of this tutorial.

 If Not IsPostBack Then
End If 
 if (!IsPostBack)
{
} 

4. Within the conditional block, set the DataSource property of the listCRVReport ListBox control to the 
values of the CeWebCRVReportOptions enum.

 listCRVReport.DataSource = System.Enum.GetValues(GetType(CeWebCRVReportOptions)) 
 listCRVReport.DataSource = System.Enum.GetValues(typeof(CeWebCRVReportOptions)); 

5. Call the DataBind() method of the listCRVReport ListBox control to bind the values to the control.

 listCRVReport.DataBind() 
 listCRVReport.DataBind(); 

6. Next set the DataSource property of the listCRVToolbar ListBox control to the values of the 
CeWebCRVToolbarOptions enum.

 listCRVToolbar.DataSource = 
System.Enum.GetValues(GetType(CeWebCRVToolbarOptions)) 
 listCRVToolbar.DataSource = 
System.Enum.GetValues(typeof(CeWebCRVToolbarOptions)); 

7. Now call the DataBind() method of the listCRVToolbar ListBox control to bind the values to the control.

 listCRVToolbar.DataBind() 
 listCRVToolbar.DataBind(); 

8. Outside the Not IsPostBack conditional block, bind the Chart.rpt file to the ReportSource property of the 
CrystalReportViewer control.
For information about sample reports, see Sample Reports Directory [page 14].

  myCrystalReportViewer.ReportSource = "C:\Program Files\Microsoft
Visual Studio 9.0\Crystal Reports\Samples\En\Reports\Feature
Examples\Chart.rpt"  
  crystalReportViewer.ReportSource = "C:\\Program Files\\Microsoft
Visual Studio 9.0\\Crystal Reports\\Samples\\En\\Reports\\Feature
Examples\\Chart.rpt";  
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1.5.1.5.4.4  To code the redisplay Button control for a Web Site

You can now add code to the click event of the Button control. The click method must set Boolean values for the 
report and toolbar elements of the CrystalReportViewer class. If an element is selected, the Boolean value is 
set to true, and the report or toolbar element is displayed. If a property is not selected, the Boolean value is set to 
False, and the report or toolbar element is not displayed.

1. Open the Web Form.
2. From the View menu, click Designer.
3. Double-click the redisplay Button control.

The code-behind class for the report appears and shows that a redisplay_Click() event method has been 
automatically generated.

4. Within the redisplay_Click() event method, call the Selected property for each item in the 
listCRVReport and listCRVToolbar ListBox controls.

The Selected property returns a Boolean value to set the CrystalReportViewer toolbar properties.

Note
The CrystalReportViewer report and toolbar elements are set to their corresponding values in the 
CeWebCRVReportOptions and CeWebCRVToolbarOptions enums. The values from the enum class 
return a string, which you need to convert to an integer.

 myCrystalReportViewer.HasToggleGroupTreeButton = 
listCRVToolbar.Items(Convert.ToInt32(CeWebCRVToolbarOptions.Group_Tree_Button)).S
elected
myCrystalReportViewer.HasExportButton = 
listCRVToolbar.Items(Convert.ToInt32(CeWebCRVToolbarOptions.Export_Button)).Selec
ted
myCrystalReportViewer.HasPrintButton = 
listCRVToolbar.Items(Convert.ToInt32(CeWebCRVToolbarOptions.Print_Button)).Select
ed
myCrystalReportViewer.HasViewList = 
listCRVToolbar.Items(Convert.ToInt32(CeWebCRVToolbarOptions.View_List_Button)).Se
lected
myCrystalReportViewer.HasDrillUpButton = 
listCRVToolbar.Items(Convert.ToInt32(CeWebCRVToolbarOptions.Drill_Up_Button)).Sel
ected
myCrystalReportViewer.HasPageNavigationButtons = 
listCRVToolbar.Items(Convert.ToInt32(CeWebCRVToolbarOptions.Page_Navigation_Butto
n)).Selected
myCrystalReportViewer.HasGotoPageButton = 
listCRVToolbar.Items(Convert.ToInt32(CeWebCRVToolbarOptions.Go_to_Page_Button)).S
elected
myCrystalReportViewer.HasSearchButton = 
listCRVToolbar.Items(Convert.ToInt32(CeWebCRVToolbarOptions.Search_Button)).Selec
ted
myCrystalReportViewer.HasZoomFactorList = 
listCRVToolbar.Items(Convert.ToInt32(CeWebCRVToolbarOptions.Zoom_Button)).Selecte
d
myCrystalReportViewer.HasCrystalLogo = 
listCRVToolbar.Items(Convert.ToInt32(CeWebCRVToolbarOptions.Crystal_Logo)).Select
ed
myCrystalReportViewer.DisplayToolbar = 
listCRVReport.Items(Convert.ToInt32(CeWebCRVReportOptions.Toolbar)).Selected
myCrystalReportViewer.DisplayGroupTree = 
listCRVReport.Items(Convert.ToInt32(CeWebCRVReportOptions.Group_Tree)).Selected
myCrystalReportViewer.DisplayPage = 
listCRVReport.Items(Convert.ToInt32(CeWebCRVReportOptions.Main_Page)).Selected
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myCrystalReportViewer.SeparatePages = 
listCRVReport.Items(Convert.ToInt32(CeWebCRVReportOptions.Enable_Separate_Pages))
.Selected 
 crystalReportViewer.HasToggleGroupTreeButton = 
listCRVToolbar.Items[Convert.ToInt32(CeWebCRVToolbarOptions.Group_Tree_Button)].S
elected;
crystalReportViewer.HasExportButton = 
listCRVToolbar.Items[Convert.ToInt32(CeWebCRVToolbarOptions.Export_Button)].Selec
ted;
crystalReportViewer.HasPrintButton = 
listCRVToolbar.Items[Convert.ToInt32(CeWebCRVToolbarOptions.Print_Button)].Select
ed;
crystalReportViewer.HasViewList = 
listCRVToolbar.Items[Convert.ToInt32(CeWebCRVToolbarOptions.View_List_Button)].Se
lected;
crystalReportViewer.HasDrillUpButton = 
listCRVToolbar.Items[Convert.ToInt32(CeWebCRVToolbarOptions.Drill_Up_Button)].Sel
ected;
crystalReportViewer.HasPageNavigationButtons = 
listCRVToolbar.Items[Convert.ToInt32(CeWebCRVToolbarOptions.Page_Navigation_Butto
n)].Selected;
crystalReportViewer.HasGotoPageButton = 
listCRVToolbar.Items[Convert.ToInt32(CeWebCRVToolbarOptions.Go_to_Page_Button)].S
elected;
crystalReportViewer.HasSearchButton = 
listCRVToolbar.Items[Convert.ToInt32(CeWebCRVToolbarOptions.Search_Button)].Selec
ted;
crystalReportViewer.HasZoomFactorList = 
listCRVToolbar.Items[Convert.ToInt32(CeWebCRVToolbarOptions.Zoom_Button)].Selecte
d;
crystalReportViewer.HasCrystalLogo = 
listCRVToolbar.Items[Convert.ToInt32(CeWebCRVToolbarOptions.Crystal_Logo)].Select
ed;
crystalReportViewer.DisplayToolbar = 
listCRVReport.Items[Convert.ToInt32(CeWebCRVReportOptions.Toolbar)].Selected;
crystalReportViewer.DisplayGroupTree = 
listCRVReport.Items[Convert.ToInt32(CeWebCRVReportOptions.Group_Tree)].Selected;
crystalReportViewer.DisplayPage = 
listCRVReport.Items[Convert.ToInt32(CeWebCRVReportOptions.Main_Page)].Selected;
crystalReportViewer.SeparatePages = 
listCRVReport.Items[Convert.ToInt32(CeWebCRVReportOptions.Enable_Separate_Pages)]
.Selected; 

1.5.1.5.4.5  To test the redisplay Button control

You are now ready to build and run the project to customize the CrystalReportViewer toolbar.

1. From the Build menu, click Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The listCRVReport and listCRVToolbar ListBox controls display a complete list of 
CrystalReportViewer report and toolbar options.

4. In the toolbar options listbox, select "Page_Navigation_Button", "Print_Button", and "Export_Button".
5. In the report options listbox, select "Toolbar", "Group_Tree", and "Main_Page".
6. Click Redisplay Report.
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The page reloads to display a CrystalReportViewer control with a visible toolbar, group tree, and main 
page. Within the toolbar, only the Page Navigation, Print, and Export buttons are visible.

7. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.5.5 Configuring the ListBox controls for a Windows 
project

This section explains how to configure ListBox controls for a Windows project. If you are building a Web Site, see 
Configuring the ListBox controls for a Web Site [page 265].

You can now create the click event handler for the Button control, and then add code to this event handler. The 
event handler sets various Boolean values for the toolbar properties of the CrystalReportViewer class based on 
the user's selections in the ListBox control.

Before creating this event handler, you need to create two enums: CeWinCRVReportOptions and 
CeWinCRVToolbarOptions.

These enums provide a list of selectable report elements and toolbar elements.

1.5.1.5.5.1  To create the CeWinCRVReportOptions enum

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Class.
2. In the Add New Item dialog box, in the Name field, type CeWinCRVReportOptions, and then click Add.

Note
In Visual Studio, you may be asked to place this class in an App_Code directory. Click the Yes button.

3. In the class signature, change the word class to "enum" to convert the class to an enumeration.

Note
In Visual Basic, remember to change both the opening and the closing signatures of the class to enum.

4. Because enums do not have constructors, delete the default constructor method that is provided in the C# 
version of the code.

5. Inside the enum, enter the values:

 Toolbar
Group_Tree
Status_Bar 
 Toolbar,
Group_Tree,
Status_Bar 

6. From the File menu, click Save All.
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1.5.1.5.5.2  To create the CeWinCRVToolbarOptions enum

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Class.
2. In the Add New Item dialog box, in the Name field, type "CeWinCRVToolbarOptions", and then click Add.

Note
You may be asked to place this class in an App_Code directory. Click the Yes button.

3. In the class signature, change the word class to "enum" to convert the class to an enumeration.

Note
In Visual Basic, remember to change both the opening and the closing signatures of the class to enum.

4. Because enums do not have constructors, delete the default constructor method that is provided in the C# 
version of the code.

5. Inside the enum, enter the values:

 Page_Navigation_Button
Go_to_Page_Button
Close_View_Button
Print_Button
Refresh_Button
Export_Button
Group_Tree_Button
Zoom_Button
Search_Button 
 Page_Navigation_Button,
Go_to_Page_Button,
Close_View_Button,
Print_Button,
Refresh_Button,
Export_Button,
Group_Tree_Button,
Zoom_Button,
Search_Button 

6. From the File menu, click Save All.

1.5.1.5.5.3  To populate the ListBox controls from the enums

You now populate the ListBox controls with the enum values, which represent the properties that are available for 
the CrystalReportViewer toolbar.

1. Open the Windows Form.
2. From the View menu, click Code.
3. Within the ConfigureCrystalReports() method, set the DataSource property of the listCRVReport 

ListBox control to the values of the CeWinCRVReportOptions enum.
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Note
You created the ConfigureCrystalReports() method during Project Setup [page 15] at the beginning 
of this tutorial.

 listCRVReport.DataSource =
System.Enum.GetValues(GetType(CeWinCRVReportOptions)) 
 listCRVReport.DataSource =
System.Enum.GetValues(typeof(CeWinCRVReportOptions)); 

4. Set the DataSource property of the listCRVToolbar ListBox control to the values of the 
CeWinCRVToolbarOptions enum.

 listCRVToolbar.DataSource =
System.Enum.GetValues(GetType(CeWinCRVToolbarOptions)) 
 listCRVToolbar.DataSource =
System.Enum.GetValues(typeof(CeWinCRVToolbarOptions)); 

5. Bind the Chart.rpt file to the ReportSource property of the CrystalReportViewercontrol.

For information about sample reports, see Sample Reports Directory [page 14].

  myCrystalReportViewer.ReportSource = "C:\Program Files\Microsoft
Visual Studio 9.0\Crystal Reports\Samples\En\Reports\Feature
Examples\Chart.rpt"  
  crystalReportViewer.ReportSource = "C:\\Program Files\\Microsoft
Visual Studio 9.0\\Crystal Reports\\Samples\\En\\Reports\\Feature
Examples\\Chart.rpt";  

1.5.1.5.5.4  To code the redisplay Button control for a Windows 
project

You can now add code to the click event of the Button control. The click method must set Boolean values for the 
report and toolbar elements of the CrystalReportViewer class. If an element is selected, the Boolean value is 
set to true, and the report or toolbar element is displayed. If a property is not selected, the Boolean value is set to 
False, and the report or toolbar element is not displayed.

1. Open the Windows Form.
2. From the View menu, click Designer.
3. Double-click the redisplay Button control.

The code-behind class for the report appears and shows that a redisplay_Click() event method has been 
automatically generated.

4. Within the redisplay_Click() event method, call the GetSelected() method, and pass each item from 
the ListBox.
The GetSelected() method returns a Boolean value to set the CrystalReportViewer report or toolbar 
properties.
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Note
The CrystalReportViewer report and toolbar elements are set to their corresponding values in the 
CeWinCRVReportOptions and CeWinCRVToolbarOptions enums.

 myCrystalReportViewer.ShowPageNavigateButtons =
listCRVToolbar.GetSelected(CeWinCRVToolbarOptions.Page_Navigation_Button)
myCrystalReportViewer.ShowGotoPageButton =
listCRVToolbar.GetSelected(CeWinCRVToolbarOptions.Go_to_Page_Button)
myCrystalReportViewer.ShowCloseButton = listCRVToolbar.
GetSelected(CeWinCRVToolbarOptions.Close_View_Button)
myCrystalReportViewer.ShowPrintButton =
listCRVToolbar.GetSelected(CeWinCRVToolbarOptions.Print_Button)
myCrystalReportViewer.ShowRefreshButton =
listCRVToolbar.GetSelected(CeWinCRVToolbarOptions.Refresh_Button)
myCrystalReportViewer.ShowExportButton =
listCRVToolbar.GetSelected(CeWinCRVToolbarOptions.Export_Button)
myCrystalReportViewer.ShowGroupTreeButton =
listCRVToolbar.GetSelected(CeWinCRVToolbarOptions.Group_Tree_Button)
myCrystalReportViewer.ShowZoomButton =
listCRVToolbar.GetSelected(CeWinCRVToolbarOptions.Zoom_Button)
myCrystalReportViewer.ShowTextSearchButton =
listCRVToolbar.GetSelected(CeWinCRVToolbarOptions.Search_Button)
myCrystalReportViewer.DisplayToolbar =
listCRVReport.GetSelected(CeWinCRVReportOptions.Toolbar)
myCrystalReportViewer.DisplayGroupTree =
listCRVReport.GetSelected(CeWinCRVReportOptions.Group_Tree)
myCrystalReportViewer.DisplayStatusBar =
listCRVReport.GetSelected(CeWinCRVReportOptions.Status_Bar) 
 crystalReportViewer.ShowPageNavigateButtons =
listCRVToolbar.GetSelected(Convert.ToInt32(CeWinCRVToolbarOptions.Page_Navigation
_Button));
crystalReportViewer.ShowGotoPageButton =
listCRVToolbar.GetSelected(Convert.ToInt32(CeWinCRVToolbarOptions.Go_to_Page_Butt
on));
crystalReportViewer.ShowCloseButton = listCRVToolbar.
GetSelected(Convert.ToInt32(CeWinCRVToolbarOptions.Close_View_Button));
crystalReportViewer.ShowPrintButton =
listCRVToolbar.GetSelected(Convert.ToInt32(CeWinCRVToolbarOptions.Print_Button));
crystalReportViewer.ShowRefreshButton =
listCRVToolbar.GetSelected(Convert.ToInt32(CeWinCRVToolbarOptions.Refresh_Button)
);
crystalReportViewer.ShowExportButton =
listCRVToolbar.GetSelected(Convert.ToInt32(CeWinCRVToolbarOptions.Export_Button))
;
crystalReportViewer.ShowGroupTreeButton =
listCRVToolbar.GetSelected(Convert.ToInt32(CeWinCRVToolbarOptions.Group_Tree_Butt
on));
crystalReportViewer.ShowZoomButton =
listCRVToolbar.GetSelected(Convert.ToInt32(CeWinCRVToolbarOptions.Zoom_Button));
crystalReportViewer.ShowTextSearchButton =
listCRVToolbar.GetSelected(Convert.ToInt32(CeWinCRVToolbarOptions.Search_Button))
;
crystalReportViewer.DisplayToolbar =
listCRVReport.GetSelected(Convert.ToInt32(CeWinCRVReportOptions.Toolbar));
crystalReportViewer.DisplayGroupTree =
listCRVReport.GetSelected(Convert.ToInt32(CeWinCRVReportOptions.Group_Tree));
crystalReportViewer.DisplayStatusBar =
listCRVReport.GetSelected(Convert.ToInt32(CeWinCRVReportOptions.Status_Bar)); 
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1.5.1.5.5.5  To test the redisplay Button control

You are now ready to build and run the project, to customize the CrystalReportViewer toolbar.

1. From the Build menu, click Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The listCRVReport and listCRVToolbar ListBox controls display a complete list of 
CrystalReportViewer report and toolbar options.

4. In the toolbar options listbox, select "Page_Navigation_Button", "Print_Button", and "Export_Button".
5. In the report options listbox, select "Toolbar", "Group_Tree", and "Main_Page".
6. Click Redisplay Report.

The page reloads to display a CrystalReportViewer control with a visible toolbar, group tree, and main 
page. Within the toolbar, only the Page Navigation, Print, and Export buttons are visible.

7. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.5.6 Modifying the Background Color of the Report

In this section, you learn how to modify the background color of the report.

To begin, you add a DropDownList control for background color selection.

1.5.1.5.6.1  To add controls for changing background color

1. Open the Web or Windows Form.
2. From the View menu, click Designer.
3. From the Toolbox, drag a Label control to the second row, column one of the table.
4. Select the Label control, and then from the Properties window, set the Text to Select background 

color.

5. From the Toolbox, drag a DropDownList control (for Web Sites) or ComboBox control (for Windows projects) 
to the second row, column two of the table.

6. Select the DropDownList/ComboBox control, and then from the Properties window, set the ID/Name to 
"selectBackColor."

1.5.1.5.6.2  To set the controls' default values

Now, you must add code to the ConfigureCrystalReports() method to set the default values for the 
background color list and the report components' checkboxes.
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1. Open the Web or Windows Form.
2. From the View menu, click Code.

Next, within the ConfigureCrystalReports() method, you add code to set the control's default values.

Note
If you are building a Web Site, place these lines of code within the Not IsPostBack conditional block. If 
you are building a Windows project, place these lines of code in the main area of the 
ConfigureCrystalReports() method.

3. Assign the KnownColor enum to the DataSource property of the selectBackColor DropDownList.

 selectBackColor.DataSource = System.Enum.GetValues(GetType(KnownColor)) 
 selectBackColor.DataSource = System.Enum.GetValues(typeof(KnownColor)); 

4. In a Web Site, bind the data source to the selectBackColor DropDownList.

 selectBackColor.DataBind() 
 selectBackColor.DataBind(); 

1.5.1.5.6.3  To assign the background color selection in a Web 
Site

Next, you add code to the Button click event to redisplay the report based on the selectBackColor DropDownList 
selection.

This code varies for a Web Site compared to a Windows project. Select the appropriate procedure below for either 
your Web Site or Windows project.

1. Open the Web Form.
2. From the View menu, click Code.
3. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of 

the class for System.Drawing (if this namespace has not already been declared).

 Imports System.Drawing 
 using System.Drawing; 

4. Within the redisplay_Click() event handler, add the following code: From the selectBackColor 
DropDownList, retrieve the selected item as a string, and pass it to the FromName() method of the Color 
class. Assign the Color value to the BackColor property of the CrystalReportViewer control.

 myCrystalReportViewer.BackColor = 
Color.FromName(selectBackColor.SelectedItem.Text) 
 crystalReportViewer.BackColor = 
Color.FromName(selectBackColor.SelectedItem.Text); 
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1.5.1.5.6.4  To assign the background color selection in a 
Windows project

You are now ready to test the Redisplay Report button. Skip to that section, below.

1. Open the Windows Form.
2. From the View menu, click Code.
3. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of 

the class for System.Drawing (if this namespace has not already been declared).

 Imports System.Drawing 
 using System.Drawing; 

4. Within the redisplay_Click() event handler, add code to retrieve the selected item from the 
selectBackColor ComboBox and convert it to a KnownColor instance.

 Dim mySelectedKnownColor As KnownColor = CType(selectBackColor.SelectedItem, 
KnownColor) 
 KnownColor selectedKnownColor = (KnownColor)selectBackColor.SelectedItem; 

5. Create a conditional block that checks if the selected background color is not transparent.

 If Not mySelectedKnownColor = KnownColor.Transparent Then
End If 
 if (selectedKnownColor != KnownColor.Transparent)
{
} 

6. Within the If block, pass the KnownColor instance to the FromKnownName() method of the 
System.Drawing.Color class. Assign the Color value to the BackColor property of the CrystalReportViewer 
control.

 myCrystalReportViewer.BackColor = 
System.Drawing.Color.FromKnownColor(mySelectedKnownColor) 
 crystalReportViewer.BackColor = 
System.Drawing.Color.FromKnownColor(selectedKnownColor); 

1.5.1.5.6.5  To test the redisplay Button control

You are now ready to test the Redisplay Report button.

1. From the Build menu, click Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The DropDownList/ComboBox is displayed, along with the ListBox and Button controls that you have added 
in the previous procedure.

276 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



4. From the selectBackColor DropDownList, select "Blue."

Note
Remember to select the report elements, especially Main_Page, so that it will be visible.

5. Click Redisplay Report.

The page reloads to display the report on a blue background.
6. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.5.7 Adding Code to Select a Report Page

In this section, you learn how to code the "Go to Page" option of the CrystalReportViewer toolbar.

The CrystalReportViewer toolbar has page navigation buttons and a textbox to select report pages. You can 
use the following methods from the CrystalReportViewer class to manually write code for page selections:

● ShowFirstPage()
● ShowLastPage()
● ShowNextPage()
● ShowNthPage(int PageNumber)
● ShowPreviousPage()

When one of these methods is called, the selected page is displayed for the current report.

1.5.1.5.7.1  To add the TextBox and Button controls for the "Go 
to Page" option

1. Open the Web or Windows Form in Design view.
2. From the Toolbox, drag a TextBox control to the fourth row, column one of the table.
3. Select the TextBox control, and then from the Properties window, do the following:

a. Set the ID (or Name) to "pageNumber".
b. Set the Text property to be blank.

4. From the Toolbox, drag a Button control to the fourth row, column two of the table.
5. Select the Button control, and then from the Properties window, do the following:

a. Set the ID (or Name) to "goToPage".
b. Set the Text to "Go to Page".
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1.5.1.5.7.2  To code the Click() event handler for the Button 
control

1. Double-click the Go to Page Button control.

The code-behind class for the report appears and shows that a goToPage_Click() event handler has been 
automatically generated.

2. Convert the text that is typed into the TextBox control to an integer, and then pass the value to the 
ShowNthPage() method of the CrystalReportViewer control.

Note
You have not validated that an integer was entered into the TextBox control. For a production application, 
you would add a validation control configured against the TextBox control.

 myCrystalReportViewer.ShowNthPage(Convert.ToInt32(pageNumber.Text)) 
 crystalReportViewer.ShowNthPage(Convert.ToInt32(pageNumber.Text)); 

1.5.1.5.7.3  To test the goToPage button control

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The Chart report and all the controls that you have added are displayed.
4. Enter 3 in the pageNumber TextBox, and then click Go to Page.

The page reloads to display page 3 of the report.
5. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.5.8 Modifying the Zoom Factor

By default, the CrystalReportViewer toolbar allows you to select a zoom factor from 25% to 400% by fixed 
increments of 25%, 50%, or 100%. In this section, you add code to allow any zoom factor that you want.

You need a TextBox control in which to type your desired zoom factor and a Button control to reload the page.
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1.5.1.5.8.1  To add the TextBox and Button controls for the 
Zoom option

1. Open the Web or Windows Form in Design view.
2. From the Toolbox, drag a TextBox control to the fourth row, column three of the table.
3. Select the TextBox control, and then from the Properties window, do the following:

a. Set the ID (or Name) to "zoomFactor".
b. Set the Text property to be blank.

4. From the Toolbox, drag a Button control to the fourth row, column four of the table.
5. Select the Button control, and then from the Properties window, do the following:

a. Set the ID (or Name) to "updateZoomFactor".
b. Set the Text to "% Zoom".

1.5.1.5.8.2  To code the Click() event handler for the Button 
control

1. Double-click the updateZoomFactor Button control.

The code-behind class for the report appears and shows that an updateZoomFactor_Click() event 
handler has been automatically generated.

2. Convert the text that is typed into the TextBox control to an integer, and then pass the value to the Zoom() 
method of the CrystalReportViewer control.

Note
You have not validated that an integer was entered into the TextBox control. For a production application, 
you would add a validation control configured against the TextBox control.

 myCrystalReportViewer.Zoom(Convert.ToInt32(zoomFactor.Text)) 
 crystalReportViewer.Zoom(Convert.ToInt32(zoomFactor.Text)); 

1.5.1.5.8.3  To test the updateZoomFactor Button control

1. From the Build menu, click Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The Chart report and all the controls that you have added are displayed.
4. Enter "38" in the zoomFactor TextBox, and then click Zoom.

The page reloads to display the current page at 38% of its original size.
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5. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.5.9 Searching in the Report

In this section, you learn how to search for text in a Crystal report that binds to the CrystalReportViewer 
control.

You need a TextBox control to type in your desired search string, a Button control to search the report, and a 
Label control to notify the success or failure of the search.

1.5.1.5.9.1  To add the TextBox, Button, and Label controls for 
the Search option

1. Open the Web or Windows Form in Design view.
2. From the Toolbox, drag a TextBox control to the fifth row, column one of the table.
3. Select the TextBox control, and then from the Properties window, do the following:

a. Set the ID (or Name) to "searchText".
b. Set the Text property to be blank.

4. From the Toolbox, drag a Button control to the fifth row, column two of the table.
5. Select the Button control, and then from the Properties window, do the following:

a. Set the ID (or Name) to "search".
b. Set the Text to "Search For Text".

6. From the Toolbox, drag a Label control to the fifth row, column three of the table.
a. Set the ID (or Name) to "message".
b. Set the Text to be blank.
c. Set the ForeColor to be Red.

7. Create the MessageConstants class to store standard replies as string constants for the search.

1.5.1.5.9.2  To code the search_Click() event handler for a Web 
Site

Next, you must call the SearchAndHighlightText() method in the search Button control.

Note
The SearchAndHighlightText() method does not have the same behavior for a Web Site compared to a 
Windows project.

Because the method behavior is different in a Web Site compared to a Windows project, complete the 
corresponding step procedure below for either a Web Site or a Windows project.
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1. Double-click the search Button control.

The code-behind class for the report appears and shows that a search_Click() event handler has been 
automatically generated.

2. Retrieve the text that is typed into the TextBox control, and then pass the value to the 
SearchAndHighlightText() method of the CrystalReportViewer control. Assign the method call to a 
Boolean variable.

Note
For the SearchDirection class to be accessible, you must include an "Imports" [Visual Basic] or 
"using" [C#] statement at the top of the code-behind class for the CrystalDecisions.Shared namespace. 
(You added this declaration in Project Setup [page 15].)

 Dim mySearchResult As Boolean = 
myCrystalReportViewer.SearchAndHighlightText(searchText.Text, 
SearchDirection.Forward) 
 bool searchResult = crystalReportViewer.SearchAndHighlightText(searchText.Text, 
SearchDirection.Forward); 

3. Create a conditional block that tests if the search is successful.

 If Not mySearchResult Then 
Else
End If 
 if(!searchResult)
{
}
else
{
} 

4. Within the If block, assign the MessageConstants.SUCCESS constant to the Text property of the message 
Label.

 message.Text = MessageConstants.SUCCESS 
 message.Text = MessageConstants.SUCCESS; 

5. Within the Else block, assign the MessageConstants.FAILURE constant to the Text property of the message 
Label.

 message.Text = MessageConstants.FAILURE 
 message.Text = MessageConstants.FAILURE; 

1.5.1.5.9.3  To code the search_Click() event handler for a 
Windows Project

Skip the following procedure for a Windows project to the testing procedure that follows.
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1. Double-click the search Button control.

The code-behind class for the report appears and shows that a search_Click() event handler has been 
automatically generated.

2. Retrieve the text that is typed into the TextBox control, and then pass the value to the 
SearchAndHighlightText() method of the CrystalReportViewer control. Assign the method call to a 
Boolean variable.

 Dim mySearchResult As Boolean = 
myCrystalReportViewer.SearchAndHighlightText(searchText.Text) 
 bool searchResult = crystalReportViewer.SearchAndHighlightText(searchText.Text); 

3. Create a conditional block that tests if the search is successful.

 If mySearchResult Then 
Else
End If 
 if(searchResult)
{
}
else
{
} 

4. Within the If block, assign the MessageConstants.SUCCESS constant to the Text property of the message 
Label.

 message.Text = MessageConstants.SUCCESS 
 message.Text = MessageConstants.SUCCESS; 

5. Within the Else block, assign the MessageConstants.FAILURE constant to the Text property of the 
message Label.

 message.Text = MessageConstants.FAILURE 
 message.Text = MessageConstants.FAILURE; 

1.5.1.5.9.4  To test the search Button control

1. From the Build menu, click Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The Chart report and all the controls that you have added are displayed.
4. Enter China in the searchText TextBox, and then click Search.

The page reloads to highlight the search result and to display a success message.
5. Enter hello in the searchText TextBox, and then click Search.
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The page reloads to display a failure message.
6. Return to Visual Studio and click Stop to exit from debug mode.

The remaining customization options are only available for the Web version of the CrystalReportViewer control. 
Therefore, if you are developing a Web Site, continue to Adding a Border to the Report for a Web Site [page 283].

If you are developing a Windows project, you have now completed the tutorial.

1.5.1.5.10  Adding a Border to the Report for a Web Site

In this section, you learn how to add a customized border to the Crystal report for a Web Site. For a Windows 
project, the properties for border width, style, and color are not available.

The border styles are listed in the BorderStyle enumeration. The colors are listed in the KnownColor enumeration. 
However, the BorderColor property of the CrystalReportViewer control takes in values from the Color class. 
Therefore, you have to convert the KnownColor value to the Color value.

To begin, you add the necessary controls to the Web Form. You need a TextBox control, two DropDownList 
controls, and a Button control to draw the border.

1.5.1.5.10.1  To add the controls to set border width, style, and 
color

1. Open the Web Form.
2. From the View menu, click Designer.
3. From the Toolbox, drag a Label control to the sixth row, column one of the table.
4. Select the Label control, and then from the Properties window, set the Text to "Border Width."
5. From the Toolbox, drag a TextBox control into the same table cell as the Label control.
6. Select the TextBox control, and then from the Properties window, set the ID (or Name) to "borderWidth".
7. From the Toolbox, drag a second Label control to the sixth row, column two of the table.
8. Select the Label control, and then from the Properties window, set the Text to "Border Style."

9. From the Toolbox, drag a DropDownList control into the same table cell as the Label control.
10. Select the DropDownList control, and then from the Properties window, set the ID (or Name) to 

"selectBorderStyle".
11. From the Toolbox, drag a third Label control to the sixth row, column three of the table.
12. Select the Label control, and then from the Properties window, set the Text to "Border Color."

13. From the Toolbox, drag a DropDownList control into the same table cell as the Label control.
14. Select the DropDownList control, and then from the Properties window, set the ID (or Name) to 

"selectBorderColor".
15. From the Toolbox, drag a Button control to the sixth row, column four of the table.
16. Select the Button control, and then from the Properties window, do the following:

a. Set the ID (or Name) to "drawBorder".
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b. Set the Text property to "Draw Border".

1.5.1.5.10.2  To populate the DropDownList controls

You now must populate the DropDownList controls with the border styles or border colors that are available for 
the CrystalReportViewer control. The DropDownList controls are populated in the 
ConfigureCrystalReports() method.

For a Web Site, Border Styles are stored in the System.Web.UI.WebControls.BorderStyle enumeration. 
Border Colors are retrieved from the System.Drawing.KnownColor enumeration.

1. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of 
the class for System.Web.UI.WebControls and System.Drawing (if this namespace has not already been 
declared).

 Imports System.Web.UI.WebControls
Imports System.Drawing 
 using System.Web.UI.WebControls;
using System.Drawing; 

2. Within the ConfigureCrystalReports() method, in the Not IsPostBack conditional block, assign the 
BorderStyle enum to the DataSource property of the selectBorderStyle DropDownList.

 selectBorderStyle.DataSource = System.Enum.GetValues(GetType(BorderStyle)) 
 selectBorderStyle.DataSource = System.Enum.GetValues(typeof(BorderStyle)); 

3. Bind the data source to the selectBorderStyle DropDownList.

 selectBorderStyle.DataBind() 
 selectBorderStyle.DataBind(); 

4. Still within the Not IsPostBack conditional block, assign the KnownColor enum to the DataSource property 
of the selectBorderColor DropDownList.

 selectBorderColor.DataSource =
System.Enum.GetValues(GetType(KnownColor)) 
 selectBorderColor.DataSource =
System.Enum.GetValues(typeof(KnownColor)); 

5. Bind the data source to the selectBorderColor DropDownList.

 selectBorderColor.DataBind() 
 selectBorderColor.DataBind(); 
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1.5.1.5.10.3  To code the Draw Border Button control

Next, you assign values to the BorderWidth, BorderStyle, and BorderColor properties of the 
CrystalReportViewer control.

1. Open the Web Form.
2. From the View menu, click Designer.
3. Double-click the Draw Border button control.

The code-behind class for the report appears and shows that a drawBorder_Click() event handler has 
been automatically generated.

4. Within the drawBorder_Click() event handler, assign the text that is typed into the borderWidth 
TextBox to the BorderWidth property of the CrystalReportViewer control.

Note
You have not validated that an integer was entered into the TextBox control. For a production application, 
you would add a validation control configured against the TextBox control.

 myCrystalReportViewer.BorderWidth =
Unit.Parse(borderWidth.Text.ToString()) 
 crystalReportViewer.BorderWidth =
Convert.ToInt32(borderWidth.Text); 

5. From the selectBorderStyle DropDownList, retrieve the selected index, and convert it into a 
BorderStyle value. Assign the BorderStyle value to the BorderStyle property of the 
CrystalReportViewer control.

 myCrystalReportViewer.BorderStyle = CType(selectBorderStyle.SelectedIndex, 
BorderStyle) 
 crystalReportViewer.BorderStyle = (BorderStyle)selectBorderStyle.SelectedIndex; 

6. From the selectBorderColor DropDownList, retrieve the selected item as a string, and pass it to the 
FromName() method of the Color class. Assign the Color value to the BorderColor property of the 
CrystalReportViewer control.

 myCrystalReportViewer.BorderColor = 
Color.FromName(selectBorderColor.SelectedItem.Text) 
 crystalReportViewer.BorderColor = 
Color.FromName(selectBorderColor.SelectedItem.Text); 

1.5.1.5.10.4  To draw a border around the Crystal report

1. From the Build menu, click Build Solution.
2. If you have any build errors, go ahead and fix them now.
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3. From the Debug menu, click Start.
4. For the border width, type 10.

5. For the border style, select Double.

6. For the border color, select SteelBlue.

7. Click the Draw Border button.

The page reloads to display a border around the Crystal report.
8. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.5.11  Configuring Session Persistence for a Web Site

In this section, you learn how to configure Session persistence for button click events.

When a Web page is reloaded on a button click event, the changes that are made to the CrystalReportViewer 
object model are lost.

1.5.1.5.11.1  To demonstrate lack of persistence for a Web Site

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. From the selectBackColor DropDownList , select "Blue."

5. Click Redisplay Report.

The page reloads to display the report with no toolbar, on a blue background.
6. For the border width, type "10".
7. For the border style, select "Double".
8. For the border color, select "SteelBlue".
9. Click Draw Border.

The page reloads to display a border around the Crystal report, and the background color is no longer blue.
10. Enter "3" in the pageNumber TextBox, and then click Go to Page.

The page reloads to display page 3 of the report, and the border around the report is no longer visible.
11. Return to Visual Studio and click Stop to exit from debug mode.

1.5.1.5.11.2  To add Session assignment code to the 
drawBorder_Click() event handler

You must add persistence code to your application, so that changes that are made within the 
CrystalReportViewer object model are persisted when Web pages are reloaded.

286 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



To begin, you add persistence code for border values to the drawBorder_Click() event handler, where those 
values are first assigned. Then, in the ConfigureCrystalReports() method, the values that are stored in 
Session are retrieved and assigned to the respective property of the CrystalReportViewer class.

In the drawBorder_Click() event handler, following the existing code add four Session assignments for 
BackColor, BorderColor, BorderStyle, and BorderWidth.

 Session("myBorderColor") =
myCrystalReportViewer.BorderColor.ToString()
Session("myBorderStyle") = myCrystalReportViewer.BorderStyle
Session("myBorderWidth") = myCrystalReportViewer.BorderWidth 
 Session["borderColor"] =
crystalReportViewer.BorderColor.ToString();
Session["borderStyle"] = crystalReportViewer.BorderStyle;
Session["borderWidth"] = crystalReportViewer.BorderWidth; 

1.5.1.5.11.3  To add Session retrieval code to the 
ConfigureCrystalReports() method

You are now ready to retrieve these values out of Session in the ConfigureCrystalReports() method.

1. At the bottom of the ConfigureCrystalReports() method, create an If block that checks whether the 
BackColor Session variable is not null.
If it is not, then within the If block, retrieve the BackColor property from Session and cast it to a string. 
Pass the string to the FromName() method of the Color class and assign the Color instance to the 
BackColor property of the CrystalReportViewer instance.

 If Not IsNothing(Session("myBackColor")) Then
    myCrystalReportViewer.BackColor = 
Color.FromName(CType(Session("myBackColor"), String))
End If 
 if (Session["backColor"] != null)
{
    crystalReportViewer.BackColor = Color.FromName((string)Session["backColor"]);
} 

2. Create a second If block that checks whether the BorderColor Session variable is not null. If it is not, then 
within the If block, retrieve the BorderColor property from Session and cast it to a string. Pass the string 
to the FromName() method of the Color class and assign the Color instance to the BorderColor property 
of the CrystalReportViewer instance.

 If Not IsNothing(Session("myBorderColor")) Then
    myCrystalReportViewer.BorderColor = 
Color.FromName(CType(Session("myBorderColor"), String))
End If 
 if (Session["borderColor"] != null)
{
    crystalReportViewer.BorderColor = 
Color.FromName((string)Session["borderColor"]);
} 
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3. Create a third If block that checks whether the BorderStyle Session variable is not null. If it is not, then 
within the If block, retrieve the BorderStyle property from Session and cast it to BorderStyle.

 myCrystalReportViewer.BorderStyle = CType(Session("myBorderStyle"), BorderStyle) 
 if (Session["borderStyle"] != null)
{
    crystalReportViewer.BorderStyle = (BorderStyle)Session["borderStyle"];
} 

4. Create a fourth If block that checks whether the BorderWidth Session variable is not null. If it is not, then 
within the If block, retrieve the BorderWidth property from Session and convert it to an integer.

 myCrystalReportViewer.BorderWidth = Convert.ToInt32(Session("myBorderWidth")) 
 if (Session["borderStyle"] != null)
{
    crystalReportViewer.BorderWidth = Convert.ToInt32(Session["borderStyle"]);
} 

1.5.1.5.11.4  To code the drawBorder Button control

In the next procedure, you add Session persistence to the redisplay Button click event handler.

1. Within the redisplay_Click() event handler, assign the selected item from the selectBackColor 
DropDownList to Session.

 Session("myBackColor") = selectBackColor.SelectedItem.Text 
 Session["backColor"] = selectBackColor.SelectedItem.Text; 

2. Within the drawBorder_Click() event handler, assign the Text property of the borderWidth TextBox to 
Session.

 Session("myBorderWidth") = borderWidth.Text 
 Session["borderWidth"] = borderWidth.Text; 

3. Assign the selected index from the selectBorderStyle DropDownList to Session.

 Session("myBorderStyle") = selectBorderStyle.SelectedIndex 
 Session["borderStyle"] = selectBorderStyle.SelectedIndex; 

4. Assign the selected item from the selectBorderColor DropDownList to Session.

 Session("myBorderColor") = selectBorderColor.SelectedItem.Text 
 Session["borderColor"] = selectBorderColor.SelectedItem.Text; 

You are now ready to build and run the project, to verify that the changes made to the report are persisted 
through button click events.
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1.5.2  ReportDocument Object Model Tutorials

This section presents a variety of tutorials for the ReportDocument object model.

This section presents a variety of tutorials for the ReportDocument object model.

1.5.2.1 Tutorial: Persisting the ReportDocument Object 
Model Using Session

In this tutorial, you use the ReportDocument object model and make programmatic changes to a report at 
runtime.

In this tutorial, you use the ReportDocument object model and make programmatic changes to a report at 
runtime. You also learn how to use Session to persist those changes across Web page reloads.

Because only Web applications require Session persistence, this tutorial does not apply to Windows projects.

Introduction

The project that you create in this tutorial uses a Web Form that contains a CrystalReportViewer control and two 
buttons that change the sort order of the report within the ReportDocument object model.

First, you construct the project without Session persistence. Without persistence, you can see that the change in 
sort order lasts no longer than a button click event.

Then, you add Session persistence to the project. The ReportDocument instance is placed into Session at the 
time of creation, and at any point where the state of the ReportDocument instance is changed.

Whenever the report needs to be redisplayed, the ReportDocument instance is pulled out of Session and bound 
to the CrystalReportViewer control. This guarantees that every time the report is displayed, the user views the 
most up-to-date version of the ReportDocument instance.

Note
In this tutorial you use Session, because you will persist modifications to the ReportDocument object model. If 
you plan to use only the limited object model contained within the CrystalReportViewer control, use 
ViewState exclusively.

When using Session to persist a ReportDocument object, are any other 
persistence models involved?

When using Session to persist a ReportDocument object, are any other persistence models involved?

Yes. In an ASP.NET Web application, objects typically use Session for persistence, while Web server controls use 
ViewState for persistence. Because a SAP Crystal Reports, developer version for Microsoft Visual StudioWeb 
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application uses objects and Web server controls to interact with reports, persistence is shared by Session and 
ViewState:

● Session persists the ReportDocument object model, which interacts with the report programmatically at 
runtime.

● ViewState persists the CrystalReportViewer control, which displays the report. In particular, ViewState 
persists the display properties that are set in the toolbar of the CrystalReportViewer. ViewState also persists 
any events (such as zoom, NextPage) that are triggered from buttons in the toolbar.

ViewState persistence is managed automatically. Therefore, in this tutorial you only code Session persistence.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_RDObjMod_Session
● Visual Basic Web Site: VB_Web_RDObjMod_Session

Related Information

Which Persistence Approach Should I Use with SAP Crystal Reports? [page 48]
Sample Reports Directory [page 14]

1.5.2.1.1 Configuring Buttons on the Web Form

To begin, you add two buttons to the Web Form, name them, and then create click events for each one.

1.5.2.1.1.1  To add buttons to the Web Form

1. Open the Default.aspx page.
2. From the View menu, click Designer.
3. Click the CrystalReportViewer control and press the LEFT ARROW on your keyboard so that a flashing cursor 

appears, and then press the ENTER key.
The CrystalReportViewer control drops by one line.

4. From the Toolbox, drag a Button Web server control above the CrystalReportViewer control.
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5. Click to the right of the Button control, so that a flashing cursor appears, and then press the spacebar twice.
6. From the Toolbox, drag a second Button Web server control to the right of the first Button control.

1.5.2.1.1.2  To set the Text and ID properties for each Button 
control

1. Click on the first Button Web server control to select it.
2. From the Properties window:

○ Set the ID to "sortOrderDescending."
○ Set the Text to "Change Sort Order to Descending."

3. Click on the second Button Web server control to select it.
4. From the Properties window:

○ Set the ID to "sortOrderAscending."
○ Set the Text to "Change Sort Order to Ascending."

1.5.2.1.1.3  Creating click events for each Button control

1. Double-click the first Button Web server control.
The code-behind class opens and a new event method, sortOrderDescending_Click(), is created at the 
bottom of the class.

2. Return to the design view of the Default.aspx page.
3. Double-click the second Button Web server control.

The code-behind class opens and a new event method, sortOrderAscending_Click(), is created at the 
bottom of the class.

1.5.2.1.2 Programming the Button Events with Sort Orders

In this procedure you program the ReportDocument object model of the report within the event method, and set 
the sort order to ascending in one event method and to descending in the other event method.

1.5.2.1.2.1  To program the ReportDocument object model of 
the report in the sortOrderDescending_Click 
event method

1. Open the code-behind class and locate the sortOrderDescending_Click() event method.
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2. Within the event method, retrieve the SortFields property from the DataDefinition property of the report 
instance and assign it to an instance of the SortFields indexed class.

 Dim mySortFields As SortFields = 
hierarchicalGroupingReport.DataDefinition.SortFields 
 SortFields sortFields = hierarchicalGroupingReport.DataDefinition.SortFields; 

3. Retrieve the first SortField instance from the SortFields indexed class and assign it to a variable named 
firstSortField.

Note
The SortFields indexed class is 0-based.

 Dim firstSortField As SortField = mySortFields(0) 
 SortField firstSortField = sortFields[0]; 

4. Set the SortDirection property of firstSortField to descending order, by use of the 
DescendingOrder selection of the SortDirection enum.

 firstSortField.SortDirection = SortDirection.DescendingOrder 
 firstSortField.SortDirection = SortDirection.DescendingOrder; 

5. Now re-assign this report (with its sort that has been modified in the ReportDocument object model) to the 
ReportSource property of the CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = hierarchicalGroupingReport 
 crystalReportViewer.ReportSource = hierarchicalGroupingReport; 

Next, you will enter the code for the sortOrderAscending_Click() event method. The code is identical, except 
for the SortDirection property setting.

1.5.2.1.2.2  To program the ReportDocument object model of 
the report in the sortOrderAscending_Click event 
method

1. Open the code-behind class and locate the sortOrderAscending_Click() event method.

2. Within the event method, retrieve the SortFields property from the DataDefinition property of the report 
instance and assign it to an instance of the SortFields indexed class.

 Dim mySortFields As SortFields = 
hierarchicalGroupingReport.DataDefinition.SortFields 
 SortFields sortFields = hierarchicalGroupingReport.DataDefinition.SortFields; 
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3. Retrieve the first SortField instance from the SortFields indexed class and assign it to a variable named 
firstSortField.

Note
The SortFields indexed class is 0-based.

 Dim firstSortField As SortField = mySortFields(0) 
 SortField firstSortField = sortFields[0]; 

4. Set the SortDirection property of the firstSortField instance to ascending order, by use of the 
AscendingOrder selection of the SortDirection enum.

 firstSortField.SortDirection = SortDirection.AscendingOrder 
 firstSortField.SortDirection = SortDirection.AscendingOrder; 

5. Now re-assign this report (with its sort that has been modified in the ReportDocument object model) to the 
ReportSource property of the CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = hierarchicalGroupingReport 
 crystalReportViewer.ReportSource = hierarchicalGroupingReport; 

This completes the programming of the ReportDocument object model of the report within each event method. 
In the next section, you test whether these sort changes work, and whether they are persisted when Session has 
not been applied.

1.5.2.1.3 Testing and Determining Persistence Failures

In this section, you see that, without the use of Session for persistence, the sort changes are lost when the page is 
reloaded to reflect changes to display settings.

1.5.2.1.3.1  To test the programmatic changes to sort order 
coded in the project

1. From the Build menu, click Build Solution.
2. If you have any build errors, go fix them now.
3. From the Debug menu, click Start.

If no build errors appear, the Default.aspx page loads into your browser, with the Hierarchical Grouping report 
generated on the form.

4. Observe the sort order carefully. You may want to print the page to compare the changes in sort order.
5. Click the Change Sort Order to Descending button.

The sort order reverses.
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6. Click the Change Sort Order to Ascending button.
The sort order returns to its original (ascending) order.

1.5.2.1.3.2  To test whether the sort changes are persisted 
when display settings are altered

In the next procedure, you verify whether the sort order is persisted when other changes to the page (such as 
display settings) are applied.

1. Click the Change Sort Order to Descending button.
The sort order is reversed.

2. From the toolbar of the report, adjust the zoom from 100% to 125%.
The page reloads the report at 125%, but the sort order reversal has not been persisted.

3. Once again, click the Change Sort Order to Descending button.
The sort order is reversed.

4. From the toolbar of the report, adjust the zoom from 125% to 100%.
5. The page reloads the report at 100%, but the sort order reversal has not been persisted.
6. Return to Visual Studio and click Stop to exit from debug mode.

From this test you can see that, at this point in the tutorial, persistence fails. The sort order is only applied when 
one of the sort buttons are clicked. The sort order is discarded when the user interacts with the page to adjust the 
zoom or open another page in a multipage report. Therefore, you must add code to persist the sort order change 
that is made within the ReportDocument object model with Session.

1.5.2.1.4 Adding Session Code

In this section, you learn how to use Session to persist the change to the sort order of the report. To the 
ConfigureCrystalReports() method that you created when you set up your project (see Project Setup [page 
15]), you add code that checks for Session and immediately reloads the report instance into Session when a user 
adjusts the sort order.

1.5.2.1.4.1  To add Session checking code to the 
ConfigureCrystalReports() method

1. Within the ConfigureCrystalReports() method, before the existing code, create an if/else conditional 
block that checks whether a Session object named hierarchicalGroupingReport exists.
You can use an identifier name of your choice for this Session object. Use a unique identifier, such as the 
name of the report instance.

 If (Session("hierarchicalGroupingReport") Is Nothing) Then
Else
End If 
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 if(Session["hierarchicalGroupingReport"] == null)
{
}
else
{
} 

2. If you are using an embedded report, move the line of code that declares and instantiates the report from its 
present location up into the If block.

 If (Session("hierarchicalGroupingReport") Is Nothing) Then
    hierarchicalGroupingReport = New Hierarchical_Grouping()
Else
End If 
 if (Session["hierarchicalGroupingReport"] == null)
{
   hierarchicalGroupingReport = new Hierarchical_Grouping();
}
else
{
} 

3. If you are using a non-embedded report, move the two lines of code that declare and instantiate the report, 
and that load the report from the directory path up from their present location into the If block.

Note
Please see Sample Reports Directory [page 14] to determine the correct path to the sample reports.

 If (Session("hierarchicalGroupingReport") Is Nothing) Then
    hierarchicalGroupingReport = New ReportDocument()     hierarchicalGroupingReport.Load("C:\Program Files\Microsoft Visual Studio 
9.0\Crystal Reports\Samples\En\Reports\Feature Examples\Hierarchical 
Grouping.rpt") Else
End If 
 if(Session["hierarchicalGroupingReport"] == null)
{
   hierarchicalGroupingReport = new ReportDocument();    hierarchicalGroupingReport.Load("C:\Program Files\Microsoft Visual Studio 
9.0\Crystal Reports\Samples\En\Reports\Feature Examples\Hierarchical 
Grouping.rpt"); }
else
{
} 

4. Within the If block, assign the report into Session, using the report variable name as the Session identifier 
string.

 Session("hierarchicalGroupingReport") = hierarchicalGroupingReport 
 Session["hierarchicalGroupingReport"] = hierarchicalGroupingReport; 

This completes the If block. The If block is performed if the report does not exist in Session. The Else block is 
performed if the report is found in Session; therefore, the purpose of the Else block is to retrieve the report 
from Session into a report instance.
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5. Within the Else block, assign the report that is stored in Session to the report instance.

 hierarchicalGroupingReport = CType(Session("hierarchicalGroupingReport"), 
ReportDocument) 
 hierarchicalGroupingReport = 
(ReportDocument)Session["hierarchicalGroupingReport"]; 

Note
Because Session only returns generic objects, you must cast the report to a report type. Whether you use 
embedded or non-embedded reports, cast the retrieved object to the ReportDocument type.

Outside and below the conditional block, the remaining code binds the report instance to the ReportSource 
property of the CrystalReportViewer control.

As you may remember from Project Setup (see Project Setup [page 15]), the ConfigureCrystalReports() 
method is called each time a page is reloaded. Therefore, your modification of this method guarantees that the 
most current report (either new, or stored in Session) is always retrieved and loaded. However, nothing has yet 
been written to actually update the report instance. In the next section, you update the report instance in Session 
each time that the sort order is modified.

1.5.2.1.4.2  To update the report instance in Session for the 
sortOrderDescending_Click event method

1. In the sortOrderDescending_Click() event method, delete the last line of code which bound the 
CrystalReportViewer control to the report.
This should leave you with the three lines of code that change the sort order direction.

2. Below the three lines of code that change the sort direction, assign the hierarchicalGroupingReport instance 
(that has been updated with a new sort order direction) into Session using the same identifier as was used in 
the ConfigureCrystalReports() method.

Note
For simplicity, copy/paste this line of code from the ConfigureCrystalReports() method.

 Session("hierarchicalGroupingReport") = hierarchicalGroupingReport 
 Session["hierarchicalGroupingReport"] = hierarchicalGroupingReport; 

3. Finally, add a call to the ConfigureCrystalReports() method, which gets the latest 
hierarchicalGroupingReport instance from Session (the one you have updated a moment ago), and then bind 
it to the CrystalReportViewer control.

 ConfigureCrystalReports() 
 ConfigureCrystalReports(); 

You now want to repeat the same steps for the second event method.
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1.5.2.1.4.3  To update the report instance in Session for the 
sortOrderAscending_Click event method

1. In the sortOrderAscending_Click() event method, delete the last line of code which bound the 
CrystalReportViewer control to the report.
This should leave you with the three lines of code that change the sort order direction.

2. Below the three lines of code that change the sort direction, assign the hierarchicalGroupingReport instance 
(that has been updated with a new sort order direction) into Session using the same identifier as was used in 
the ConfigureCrystalReports() method.

For simplicity, copy and paste this line of code from the ConfigureCrystalReports() method.

 Session("hierarchicalGroupingReport") = hierarchicalGroupingReport 
 Session["hierarchicalGroupingReport"] = hierarchicalGroupingReport; 

3. Finally, add a call to the ConfigureCrystalReports() method, which will get the latest 
hierarchicalGroupingReport instance from Session (the one you updated a moment ago) and then bind it to 
the CrystalReportViewer control.

 ConfigureCrystalReports() 
 ConfigureCrystalReports(); 

You are now ready to test whether the sort changes are being persisted successfully.

1.5.2.1.5 Testing and Determining Persistence Success

In this section, you test whether the sort changes are being persisted successfully now that Session is used for 
persistence.

1.5.2.1.5.1  To test whether sort changes are being persisted 
successfully

1. From the Build menu, click Build Solution.
If you have any build errors, fix them now.

2. From the Debug menu, click Start.
If no build errors appear, the Default.aspx page loads into your browser, with the Hierarchical Grouping report 
generated on the form.

3. Observe the sort order carefully. You may want to print the page to compare the changes in sort order.
4. Click the Change Sort Order to Descending button.

The sort order reverses.
5. From the toolbar of the report, adjust the zoom from 100% to 125%.

The page reloads the report at 125%. The sort order reversal has been persisted.
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6. Click the Change Sort Order to Ascending button.
The sort order is restored.

7. From the toolbar of the report, adjust the zoom from 125% to 100%.
The page reloads the report at 100%. The sort order retains its setting from the previous step.

From this test you can see that persistence now succeeds.

1.5.2.2 Tutorial: Logging onto a Secure SQL Server Database 
Using SQL Authentication

In this tutorial, you learn how to add logon code to display a report that contains information from a secure SQL 
Server database.

Introduction

To log onto a secure SQL Server database, you use classes from the ReportDocument object model.

The ReportDocument object has a Database property that returns a Database instance. This Database instance 
contains the database information for the report, including a Tables property that returns a Tables indexed 
class instance. Individual Table instances can then be retrieved from the Tables indexed class.

Logon occurs at the granular level of each Table instance, which must be granted individual access to the secure 
SQL Server. This is done by placing logon information into a ConnectionInfo instance, and then, within a for 
loop, applying that ConnectionInfo instance to the ConnectionInfo Property of each Table instance.

The properties of the ConnectionInfo class include the following:

● ServerName
● DatabaseName
● UserID
● Password
● IntegratedSecurity (not used in this tutorial)

Note
If you wish to work through a tutorial that uses Windows authentication (and therefore uses the 
IntegratedSecurity property rather than the UserID and Password properties), see Tutorial: Logging onto a 
Secure SQL Server Database Using Integrated Security [page 311].

If you choose only to set the DatabaseName, UserID, and Password properties, you will be logged onto the default 
server and database specified within the report. However, if you choose to assign an alternate ServerName 
property, you can redirect the report to a different server at runtime.

You begin by creating a report containing data from a secure SQL server database.

You can complete this tutorial by using classes of the CrystalReportViewer object model; however, the 
ReportDocument object model is recommended.
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Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_RDObjMod_DBLogon
● C# Windows project: CS_Win_RDObjMod_DBLogon
● Visual Basic Web Site: VB_Web_RDObjMod_DBLogon
● Visual Basic Windows project: VB_Win_RDObjMod_DBLogon

Related Information

Choose the Correct Object Model for Your Project [page 29]
Tutorial: Logging onto a Secure SQL Server Database [page 212]
Sample Reports Directory [page 14]

1.5.2.2.1 Creating a Report Connected to a Secure SQL 
Server Database

To begin, create a report that draws its information from the Northwind database.

Note
Northwind is a sample database provided with SQL Server.

Some setup is required as a prerequisite to this tutorial.

Related Information

Tutorial: Logging onto a Secure SQL Server Database Using SQL Authentication [page 298]

1.5.2.2.1.1  Prerequisite Database Setup

1. SQL Server configuration:
○ If you have SQL Server (or the OEM version, MSDE) installed, it must be configured to require SQL Server 

Authentication to work with this tutorial.
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○ If you do not have SQL Server (or the OEM version, MSDE) installed, you must install MSDE with SQL 
Server Authentication set to "True" to work with this tutorial.

2. The Northwind database provided with SQL Server must be installed and verified that it accepts SQL Server 
Authentication.

3. A limited access account must be created for use within the Web site.

1.5.2.2.1.2  To create a report with secure data from the 
Northwind database

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, in the Templates view, select the Crystal Report template.
3. In the Name field, enter the name "NorthwindCustomers.rpt" and click Open.
4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 

Report Wizard.
5. In the Choose an Expert panel, select Standard. Click OK.

The Standard Report Creation Wizard window appears.
6. In the Available Data Sources panel, expand the Create New Connection folder.
7. From the subfolder that opens, expand the OLE DB (ADO) folder.

The OLE DB (ADO) window appears.
8. Select Microsoft OLE DB Provider for SQL Server and click Next.
9. Enter the values for your database server, user id and password into the Server, User ID and Password fields.
10. From the Database drop down list, select "Northwind."

Leave the Integrated Security checkbox unchecked because you are using SQL Server authentication instead 
of NT authentication.

11. Click Finish.
The OLE DB folder is now expanded, showing your database server and within it, the Northwind database.

12. Expand the nodes Northwind, dbo, and Tables, and then select the Customers table.
13. Click the > symbol to move the table into the Selected Tables panel, then click Next.
14. Hold down the Ctrl key while clicking CompanyName, ContactName and City.
15. Click the > symbol to move these fields into the Fields to Display panel, then click Next.
16. In the Available Fields panel, under Report Fields, select Customer.City, then click the > symbol to move the 

field into the Group By panel, and then click Finish.
The NorthwindCustomers report is created and loaded into the main window of Visual Studio.

You are now ready to bind the report to the CrystalReportViewer control and set the database logon 
programmatically.
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1.5.2.2.2 Binding the Report

In Project Setup [page 15], you placed a CrystalReportViewer control on the Web or Windows Form. In the 
previous step, you have added a NorthwindCustomers report to the project.

In this section, you instantiate the NorthwindCustomers report and bind it to the CrystalReportViewer control. 
Then you test whether the report displays correctly when current values have not been set for its parameter field.

You can instantiate and bind the report in two ways:

● As an embedded report.
● As a non-embedded report.

Choose from one (but not both) of the step procedures below.

● If you use embedded reports, follow the next step procedure to instantiate the report as an embedded report.
● If you use non-embedded reports, follow the second step procedure to instantiate the report as a non-

embedded report.

1.5.2.2.2.1  To instantiate the NorthwindCustomers report as an 
embedded report and bind it to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Add a new class-level declaration for the NorthwindCustomers report wrapper class, using the variable name 

northwindCustomersReport. Set its access modifier to private.

 Private northwindCustomersReport As NorthwindCustomers 
 private NorthwindCustomers northwindCustomersReport; 

4. Within the ConfigureCrystalReports() method, instantiate the report wrapper class.

Note
You created the ConfigureCrystalReports() method in Project Setup [page 15].

 northwindCustomersReport = New NorthwindCustomers() 
 northwindCustomersReport = new NorthwindCustomers(); 

5. On the next line beneath the report instantiation, bind the ReportSource property of the CrystalReportViewer 
control to the instantiated report class (variable name: northwindCustomersReport).

 myCrystalReportViewer.ReportSource = northwindCustomersReport 
 crystalReportViewer.ReportSource = northwindCustomersReport; 
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You are now ready to build and run your project. It is expected that the report loading will fail, because code has 
not yet been written to log onto the database.

1.5.2.2.2.2  To instantiate the NorthwindCustomers report as a 
non-embedded report and bind it to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Add a new class-level declaration for the ReportDocument report wrapper class, using the variable name 

northwindCustomersReport. Set its access modifier to private.

 Private northwindCustomersReport As ReportDocument 
 private ReportDocument northwindCustomersReport; 

Note
The ReportDocument class is a member of the CrystalDecisions.CrystalReports.Engine namespace. You 
have added an "Imports" [Visual Basic] or "using" [C#] declaration for this namespace in 
Project Setup [page 15]. When you instantiate ReportDocument and load a report into the namespace, you 
gain access to the report through the SDK, without embedding the report.

4. Within the ConfigureCrystalReports() method (that you have created in Project Setup [page 15]), 
instantiate the ReportDocument class.

 northwindCustomersReport = New ReportDocument() 
 northwindCustomersReport = new ReportDocument(); 

5. Declare a string variable, name it reportPath, and assign to it a runtime path to the local report. This path is 
determined differently for Web Sites and Windows projects:
○ For a Web Site, pass the name of the local report file as a string parameter into the Server.MapPath() 

method. This maps the local report to the hard drive file directory path at runtime.

 Dim reportPath As String = Server.MapPath("NorthwindCustomers.rpt") 
 string reportPath = Server.MapPath("NorthwindCustomers.rpt"); 

○ For a Windows project, concatenate the Application.StartupPath property with a backslash and the 
local report file name. This maps the report to the same directory as the Windows executable file.

Note
At compile time you will copy the report to the directory containing the executable file.

 Dim reportPath As String = Application.StartupPath & "\" & 
"NorthwindCustomers.rpt" 
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 string reportPath = Application.StartupPath + "\\" + "NorthwindCustomers.rpt"; 
6. Call the Load() method of the ReportDocument instance and pass into it the reportPath string variable.

 northwindCustomersReport.Load(reportPath) 
 northwindCustomersReport.Load(reportPath); 

7. Bind the ReportSource property of the CrystalReportViewer to the ReportDocument instance.

 myCrystalReportViewer.ReportSource = northwindCustomersReport 
 crystalReportViewer.ReportSource = northwindCustomersReport; 

1.5.2.2.2.3  To test the loading of the NorthwindCustomers 
report

Whether you have chosen to instantiate an embedded report class or a non-embedded report through the 
ReportDocument class, the variable name used is the same: northwindCustomersReport. This allows you to use 
a common set of code in the procedures that follow.

You are now ready to build and run your project. It is expected that the report loading will fail, because code has 
not yet been written to log onto the database.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. If you use a non-embedded report in a Windows project, locate the compiled Windows executable in the \bin

\ [Visual Basic] or \bin\debug\ [C#] subdirectory, and then copy the report to that subdirectory.

Note
To have the non-embedded report loaded by the Windows executable at runtime, the report must be 
stored in the same directory as the Windows executable.

4. From the Debug menu, click Start.

The NorthwindCustomers report does not display, because the database logon code has not been added.

Note
Results may vary, depending on the version of SAP Crystal Reports that you use. For example, if you have 
SAP Crystal Reports 10 or higher installed, a form appears and requests that you provide database logon 
information for that report. This is a new feature of SAP Crystal Reports Developer. If you are running a 
previous version of SAP Crystal Reports, an exception is thrown. In either case, you must follow the next 
step procedure to create a fully functional application.

5. Return to Visual Studio and click Stop to exit from debug mode.
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1.5.2.2.3 Adding the Report Logon Code

You are now ready to add the logon code to the code-behind class. You begin by creating a private helper method, 
SetDBLogonForReport().

1.5.2.2.3.1  To create and code the SetDBLogonForReport() 
method

1. Return to the code-behind class for this Web or Windows Form.
2. At the bottom of the class, create a new private method named SetDBLogonForReport() with two 

parameters, ConnectionInfo and ReportDocument.

 Private Sub SetDBLogonForReport(ByVal myConnectionInfo As ConnectionInfo, ByVal 
myReportDocument As ReportDocument)
End Sub 
 private void SetDBLogonForReport(ConnectionInfo connectionInfo, ReportDocument 
reportDocument)
{
} 

3. Within this method, retrieve the Tables instance from the Tables property of the Database property of the 
ReportDocument parameter.

Note
Tables is an indexed class that contains instances of the Table class.

 Dim myTables As Tables = myReportDocument.Database.Tables 
 Tables tables = reportDocument.Database.Tables; 

4. Create a foreach loop that loops through each Table instance in the Tables indexed class instance.

Note
You must include the full namespace path to Table class, to distinguish it from the Table class of the 
System.Web.UI.WebControls namespace.

 For Each myTable As CrystalDecisions.CrystalReports.Engine.Table In myTables
Next 
 foreach(CrystalDecisions.CrystalReports.Engine.Table table in tables)
{
} 

5. Within the foreach loop, retrieve the TableLogonInfo instance from the LogOnInfo property of the Table 
instance.

 Dim myTableLogonInfo As TableLogOnInfo = myTable.LogOnInfo
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 TableLogOnInfo tableLogonInfo = table.LogOnInfo; 

6. Within the foreach loop, set the ConnectionInfo property of TableLogonInfo to the ConnectionInfo 
parameter.

 myTableLogonInfo.ConnectionInfo = myConnectionInfo 
 tableLogonInfo.ConnectionInfo = connectionInfo; 

7. Within the foreach loop, pass the TableLogonInfo instance as a parameter to the ApplyLogonInfo 
method of the Table instance.

 myTable.ApplyLogOnInfo(myTableLogonInfo) 
 table.ApplyLogOnInfo(tableLogonInfo); 

This step procedure has created a method to set the logon for the database. However, you must modify the 
ConfigureCrystalReports() method to address this method, for the report to be aware that it has database 
logon information.

Modifying the ConfigureCrystalReports() method requires two actions:

● Configure the ConnectionInfo instance.
● Call the SetDBLogonForReport() method.

1.5.2.2.3.2  To modify the ConfigureCrystalReports() method to 
address the database logon code

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code above the line that 
binds the report to the CrystalReportViewer control.

2. Within the line breaks, declare and instantiate the ConnectionInfo class.

Note
To make the ConnectionInfo class accessible, include an "Imports" [Visual Basic] or "using" 
[C#] statement at the top of the code-behind class for the CrystalDecisions.Shared namespace. (You 
added this declaration in Project Setup [page 15].)

 Dim myConnectionInfo As ConnectionInfo = New ConnectionInfo() 
 ConnectionInfo connectionInfo = new ConnectionInfo(); 

3. Set the DatabaseName, UserID, and Password properties of the ConnectionInfo instance.

Note
For security reasons, it is important that you use a database account with limited access permissions.
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In the code that you write, replace the sample 1234 password (shown below) with your own password.

 myConnectionInfo.DatabaseName = "Northwind"
myConnectionInfo.UserID = "limitedPermissionAccount"
myConnectionInfo.Password = "
1234" 
 connectionInfo.DatabaseName = "Northwind";
connectionInfo.UserID = "limitedPermissionAccount";
connectionInfo.Password = "
1234"; 

4. Enter a call to the SetDBLogonForReport() method, by passing in the ConnectionInfo instance and the 
NorthwindCustomers report.

 SetDBLogonForReport(myConnectionInfo, northwindCustomersReport) 
 SetDBLogonForReport(connectionInfo, northwindCustomersReport); 

This is followed by the original code that binds the report to the CrystalReportViewer control.

You are now ready to build and run your project. The report should load properly, because you have added code to 
log on to the database.

1.5.2.2.3.3  To test the loading of the NorthwindCustomers 
report

1. From the Build menu select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The NorthwindCustomers report displays successfully.
4. Return to Visual Studio and click Stop to exit from debug mode.

The NorthwindCustomers report displays successfully.

1.5.2.2.4 Adding Ability to Change Database Location at 
Runtime

In this section, you learn how to change the database location at runtime. This requires only a minor modification 
to the ConnectionInfo instance.

1.5.2.2.4.1  To change the database location at runtime

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code after the line that 
declares and instantiates the ConnectionInfo class.
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2. Within the line breaks, set the ServerName property of the ConnectionInfo instance.

Note
In the code that you write, replace the sample server name DevDatabase (shown below) with the name of 
your server.

 myConnectionInfo.ServerName = "DevDatabase" 
 connectionInfo.ServerName = "DevDatabase"; 

1.5.2.2.4.2  To test that the report can be reset to an alternate 
database server at runtime

You are now ready to build and run your project. The report should redirect to the alternate database server at 
runtime.

1. From the Build menu select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The NorthwindCustomers report displays successfully.
4. Return to Visual Studio and click Stop to exit from debug mode.

1.5.2.2.5 Addendum: Enhancements to the Database Logon 
Code

You have successfully set your code to change the database location at runtime. In this example, it is the same 
database server, the only difference is that you have called it explicitly by name.

However, you can now change this database server name string to any other database server that contains the 
Northwind database. If you are using SAP Crystal Reports with Visual Studio 2005 or 2008 then you have access 
to the enhanced API for logging on to a secure SQL Server database. The SAP Crystal Reports API helps minimize 
the amount of code that is needed to log on to the database.

In the previous procedures, you learned to create the SetDBLogonForReport() helper method, which uses a 
foreach loop to set the ConnectionInfo property of each table in the Crystal report.

In this tutorial, you learn how to delete the helper method and add code to use either the DataSourceConnections 
class from CrystalDecisions.Shared namespace or the SetDatabaseLogon() method from the 
ReportDocument class.

The DataSourceConnections class is an ArrayList that contains the ConnectionInfo instances for every 
connection that is used by the Crystal report. You can retrieve the ConnectionInfo instances at a specified 
index, and then call SetLogon() or SetConnection() to pass the logon information to the report.
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The SetLogon() method allows you to set the user name and password. This method uses the default server and 
database that you have specified in the report. The SetConnection() method allows you to set the server name, 
database name, user name, and password.

To use the new API code, you must complete the instructions in Creating a Report Connected to a Secure SQL 
Server Database [page 299] and Binding the Report [page 301].

Then, you can use one of the following enhanced API methods:

● Using the DataSourceConnections Class for Database Logon [page 309]
● Using the SetDatabaseLogon() Method of the ReportDocument Class [page 310]

If you have completed all the procedures in Tutorial: Logging onto a Secure SQL Server Database Using SQL 
Authentication [page 298], you must first delete certain lines of code that are shown in Modifying the Project for 
Database Logon [page 308], before you can use one of the enhanced API methods.

1.5.2.2.5.1  Modifying the Project for Database Logon

If you have completed all the procedures in Tutorial: Logging onto a Secure SQL Server Database Using SQL 
Authentication [page 298], you must first delete certain lines of code that are shown in the following procedure.

1.5.2.2.5.1.1  To modify the project for using the enhanced SAP 
Crystal Reports API

1. Open the completed project for this tutorial.
2. Open the Web or Windows Form.
3. From the View menu, click Code.
4. Delete the SetDBLogonForReport() helper method.

5. Within the ConfigureCrystalReports() method, delete the following lines of code:

a. Delete the code that declares an instance of the ConnectionInfo class.
b. Delete the code that uses the ServerName, DatabaseName, UserID and Password properties from the 

ConnectionInfo class.
c. Delete the call to the SetDBLogonForReport() method.

Now, the ConfigureCrystalReports() method has two lines of code.

 Private Sub ConfigureCrystalReports()
    northwindCustomersReport = new NorthwindCustomers()
    myCrystalReportViewer.ReportSource = northwindCustomersReport
End Sub 
 private void ConfigureCrystalReports()
{
   northwindCustomersReport = new NorthwindCustomers();
   crystalReportViewer.ReportSource = northwindCustomersReport;
} 

You can now choose to use one of the following enhanced API methods:
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● Using the DataSourceConnections Class for Database Logon [page 309]
● Using the SetDatabaseLogon() Method of the ReportDocument Class [page 310]

1.5.2.2.5.2  Using the DataSourceConnections Class for 
Database Logon

In this section, you learn how to add two lines of code to log on to a SQL Server database. You must retrieve the 
DataSourceConnections instance, and then set the database logon information through use of SetLogon() or 
SetConnection().

● You must create a project that is based on the instructions in Creating a Report Connected to a Secure SQL 
Server Database [page 299] and Binding the Report [page 301].

● Or, you must create a project that is based on the instructions in Modifying the Project for Database Logon 
[page 308].

If you want to use the default server and database, call the SetLogon() method with your user name and 
password.

Otherwise, if you want to change the server or database, call the SetConnection() method with your server 
name, database name, user name and password.

1.5.2.2.5.2.1  To use the SetLogon() method of the 
DataSourceConnections class

1. Between the two lines of code within the ConfigureCrystalReports(), retrieve the 
DataSourceConnections instance from the DataSourceConnections property of the 
NorthwindCustomers instance.

 Dim myDataSourceConnections As DataSourceConnections = 
northwindCustomersReport.DataSourceConnections 
 DataSourceConnections dataSourceConnections = 
northwindCustomersReport.DataSourceConnections; 

2. Retrieve the IConnectionInfo at index 0 of the DataSourceConnections instance.

 Dim myConnectInfo As IConnectionInfo = myDataSourceConnections(0) 
 IConnectionInfo connectInfo = dataSourceConnections[0]; 

3. Call the SetLogon() method with your user name and password.

Note
For security reasons, it is important that you use a database account with limited access permissions.
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In the code that you write, replace the sample 1234 password (shown below) with your own password.

 myConnectInfo.SetLogon("limitedPermissionAccount", "1234") 
 connectInfo.SetLogon("limitedPermissionAccount", "1234"); 

1.5.2.2.5.2.2  To use the SetConnection() method of the 
DataSourceConnections class

1. Between the two lines of code within the ConfigureCrystalReports(), retrieve the 
DataSourceConnections instance from the DataSourceConnections property of the NorthwindCustomers 
instance.

 Dim myDataSourceConnections As DataSourceConnections = 
northwindCustomersReport.DataSourceConnections 
 DataSourceConnections dataSourceConnections = 
northwindCustomersReport.DataSourceConnections; 

2. Retrieve the IConnectionInfo at index 0 of the DataSourceConnections instance.

 Dim myConnectInfo As IConnectionInfo = myDataSourceConnections(0) 
 IConnectionInfo connectInfo = dataSourceConnections[0]; 

3. Call the SetConnection() method with your server name, database name, user name and password.

Note
For security reasons, it is important that you use a database account with limited access permissions.

In the code that you write, replace the sample 1234 password (shown below) with your own password.

 myConnectInfo.SetConnection("ServerName", "Northwind", 
"limitedPermissionAccount", "1234") 
 connectInfo.SetConnection("ServerName", "Northwind", "limitedPermissionAccount", 
"1234"); 

You are now ready to build and run the project, to log on to the secure SQL Server database.

1.5.2.2.5.3  Using the SetDatabaseLogon() Method of the 
ReportDocument Class

Between the two lines of code within the ConfigureCrystalReports(), call the SetDatabaseLogon() 
method of the NorthwindCustomers instance, and pass in one of the following sets of parameters:
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1. Call the SetDatabaseLogon() method with your user name and password.

Note
For security reasons, it is important that you use a database account with limited access permissions.

In the code that you write, replace the sample 1234 password (shown below) with your own password.

 northwindCustomersReport.SetDatabaseLogon("limitedPermissionAccount","1234") 
 northwindCustomersReport.SetDatabaseLogon("limitedPermissionAccount","1234"); 

2. Or call the SetDatabaseLogon() method with your server name, database name, user name and password.

Note
This method does not change the server or database. You are restricted to only the default server and 
database that is specified within the report.

In the code that you write, replace the sample 1234 password (shown below) with your own password.

 northwindCustomersReport.SetDatabaseLogon("limitedPermissionAccount","1234", 
"ServerName", "Northwind") 
 northwindCustomersReport.SetDatabaseLogon("limitedPermissionAccount","1234", 
"ServerName", "Northwind"); 

1.5.2.3 Tutorial: Logging onto a Secure SQL Server Database 
Using Integrated Security

In this tutorial, you learn how to add logon code to display a report that contains information from a secure SQL 
Server database.

Introduction

To log onto a secure SQL Server database, you use classes from the ReportDocument object model.

The ReportDocument object has a Database property that returns a Database instance. This Database 
instance contains the database information for the report, including a Tables property that returns a Tables 
indexed class instance. Individual Table instances can then be retrieved from the Tables indexed class.

Logon occurs at the granular level of each Table instance, which must be granted individual access to the secure 
SQL Server. This is done by placing logon information into a ConnectionInfo instance, and then, within a for 
loop, applying that ConnectionInfo instance to the ConnectionInfo Property of each Table instance.

The properties of the ConnectionInfo class include the following:

● ServerName
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● DatabaseName
● UserID (not used in this tutorial)
● Password (not used in this tutorial)
● IntegratedSecurity

Note
If you wish to work through a tutorial that uses SQL Authentication (and therefore uses the UserID and 
Password properties rather than the Integrated Security property), see Tutorial: Logging onto a Secure SQL 
Server Database Using SQL Authentication [page 298].

If you choose only to set the DatabaseName, and IntegratedSecurity properties, you will be logged onto the 
default server and database specified within the report. However, if you choose to assign an alternate 
ServerName property, you can redirect the report to a different server at runtime.

You begin by creating a report containing data from a secure SQL server database.

You can complete this tutorial by using classes of the CrystalReportViewer object model; however, the 
ReportDocument object model is recommended.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_RDObjMod_DBLogonIntegratedSecurity
● C# Windows project: CS_Win_RDObjMod_DBLogonIntegratedSecurity
● Visual Basic Web Site: VB_Web_RDObjMod_DBLogonIntegratedSecurity
● Visual Basic Windows project: VB_Win_RDObjMod_DBLogonIntegratedSecurity

Related Information

Choose the Correct Object Model for Your Project [page 29]
Sample Reports Directory [page 14]

1.5.2.3.1 Creating a Report Connected to a Secure SQL 
Server Database Using Integrated Security

To begin, create a report that draws its information from the Northwind database.
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Note
Northwind is a sample database provided with SQL Server.

Some setup is required as a prerequisite to this tutorial.

1.5.2.3.1.1  Prerequisite Database Setup

1. SQL Server configuration:
○ If you have SQL Server (or the OEM version, MSDE) installed, it must be configured to accept Windows 

Authentication for this tutorial.
○ If you do not have SQL Server (or the OEM version, MSDE) installed, you must install MSDE with the 

(default) Windows Authentication to work with this tutorial.
2. The Northwind database provided with SQL Server must be installed and verified that it accepts Windows 

Authentication.

Once you have configured SQL Server and the Northwind database according to the sections above, you are 
ready to create a report that draws its information securely from a Northwind database.

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project 
Setup contains specific namespace references and code configuration that is required for this procedure, 
and you will be unable to complete the procedure without that configuration.

1.5.2.3.1.2  To create a report with secure data from the 
Northwind database

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, in the Templates view, select the Crystal Report template.
3. In the Name field, enter the name "NorthwindCustomers.rpt" and click Open.
4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 

Report Wizard.
5. In the Choose an Expert panel, select Standard. Click OK.

The Standard Report Creation Wizard window appears.
6. In the Available Data Sources panel, expand the Create New Connection folder.
7. From the subfolder that opens, expand the OLE DB (ADO) folder.

The OLE DB (ADO) window appears.
8. Select Microsoft OLE DB Provider for SQL Server and click Next.
9. Enter the name of your database server into the Server field.
10. Check the Integrated Security checkbox.
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11. From the Database drop down list, select "Northwind."
12. Click Finish.

The OLE DB folder is now expanded, showing your database server and within it, the Northwind database.
13. Expand the nodes Northwind, dbo, and Tables, and then select the Customers table.
14. Click the > symbol to move the table into the Selected Tables panel, then click Next.
15. Hold down the Ctrl key while clicking CompanyName, ContactName and City.
16. Click the > symbol to move these fields into the Fields to Display panel, then click Next.
17. In the Available Fields panel, under Report Fields, select Customer.City, then click the > symbol to move the 

field into the Group By panel, and then click Finish.
The NorthwindCustomers report is created and loaded into the main window of Visual Studio.

You are now ready to bind the report to the CrystalReportViewer control and set the database logon 
programmatically.

1.5.2.3.2 Binding the Report

In Project Setup [page 15], you placed a CrystalReportViewer control on the Web or Windows Form. In the 
previous step, you have added a NorthwindCustomers report to the project.

In this section, you instantiate the NorthwindCustomers report and bind it to the CrystalReportViewer control. 
Then you test whether the report displays correctly when current values have not been set for its parameter field.

You can instantiate and bind the report in two ways:

● As an embedded report.
● As a non-embedded report.

Choose from one (but not both) of the step procedures below.

● If you use embedded reports, follow the next step procedure to instantiate the report as an embedded report.
● If you use non-embedded reports, follow the second step procedure to instantiate the report as a non-

embedded report.

1.5.2.3.2.1  To instantiate the NorthwindCustomers report as an 
embedded report and bind it to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Add a new class-level declaration for the NorthwindCustomers report wrapper class, using the variable name 

northwindCustomersReport. Set its access modifier to private.

 Private northwindCustomersReport As NorthwindCustomers 
 private NorthwindCustomers northwindCustomersReport; 
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4. Within the ConfigureCrystalReports() method, instantiate the report wrapper class.

Note
You created the ConfigureCrystalReports() method in Project Setup [page 15].

 northwindCustomersReport = New NorthwindCustomers() 
 northwindCustomersReport = new NorthwindCustomers(); 

5. On the next line beneath the report instantiation, bind the ReportSource property of the 
CrystalReportViewer control to the instantiated report class (variable name: 
northwindCustomersReport).

 myCrystalReportViewer.ReportSource = northwindCustomersReport 
 crystalReportViewer.ReportSource = northwindCustomersReport; 

You are now ready to build and run your project. It is expected that the report loading will fail, because code has 
not yet been written to log onto the database.

1.5.2.3.2.2  To instantiate the NorthwindCustomers report as a 
non-embedded report and bind it to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Add a new class-level declaration for the ReportDocument report wrapper class, using the variable name 

northwindCustomersReport. Set its access modifier to private.

 Private northwindCustomersReport As ReportDocument 
 private ReportDocument northwindCustomersReport; 

Note
The ReportDocument class is a member of the CrystalDecisions.CrystalReports.Engine namespace. You 
have added an "Imports" [Visual Basic] or "using" [C#] declaration for this namespace in 
Project Setup [page 15]. When you instantiate ReportDocument and load a report into the namespace, you 
gain access to the report through the SDK, without embedding the report.

4. Within the ConfigureCrystalReports() method (that you have created in Project Setup [page 15]), 
instantiate the ReportDocument class.

 northwindCustomersReport = New ReportDocument() 
 northwindCustomersReport = new ReportDocument(); 
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5. Declare a string variable, name it reportPath, and assign to it a runtime path to the local report. This path is 
determined differently for Web Sites and Windows projects:
○ For a Web Site, pass the name of the local report file as a string parameter into the Server.MapPath() 

method. This maps the local report to the hard drive file directory path at runtime.

 Dim reportPath As String = Server.MapPath("NorthwindCustomers.rpt") 
 string reportPath = Server.MapPath("NorthwindCustomers.rpt"); 

○ For a Windows project, concatenate the Application.StartupPath property with a backslash and the 
local report file name. This maps the report to the same directory as the Windows executable file.

Note
At compile time you will copy the report to the directory containing the executable file.

 Dim reportPath As String = Application.StartupPath & "\" & 
"NorthwindCustomers.rpt" 
 string reportPath = Application.StartupPath + "\\" + "NorthwindCustomers.rpt"; 

6. Call the Load() method of the ReportDocument instance and pass into it the reportPath string variable.

 northwindCustomersReport.Load(reportPath) 
 northwindCustomersReport.Load(reportPath); 

7. Bind the ReportSource property of the CrystalReportViewer to the ReportDocument instance.

 myCrystalReportViewer.ReportSource = northwindCustomersReport 
 crystalReportViewer.ReportSource = northwindCustomersReport; 

Whether you have chosen to instantiate an embedded report class or a non-embedded report through the 
ReportDocument class, the variable name used is the same: northwindCustomersReport. This allows you to use a 
common set of code in the procedures that follow.

You are now ready to build and run your project. It is expected that the report loading will fail, because code has 
not yet been written to log onto the database.

1.5.2.3.3 Adding the Report Logon Code

You are now ready to add the logon code to the code-behind class. You begin by creating a private helper method, 
SetDBLogonForReport().
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1.5.2.3.3.1  To create and code the SetDBLogonForReport() 
method

1. Return to the code-behind class for this Web or Windows Form.
2. At the bottom of the class, create a new private method named SetDBLogonForReport() with two 

parameters, ConnectionInfo and ReportDocument.

 Private Sub SetDBLogonForReport(ByVal myConnectionInfo As ConnectionInfo, ByVal 
myReportDocument As ReportDocument)
End Sub 
 private void SetDBLogonForReport(ConnectionInfo connectionInfo, ReportDocument 
reportDocument)
{
} 

3. Within this method, retrieve the Tables instance from the Tables property of the Database property of the 
ReportDocument parameter.

Note
Tables is an indexed class that contains instances of the Table class.

 Dim myTables As Tables = myReportDocument.Database.Tables 
 Tables tables = reportDocument.Database.Tables; 

4. Create a foreach loop that loops through each Table instance in the Tables indexed class instance.

Note
You must include the full namespace path to Table class, to distinguish it from the Table class of the 
System.Web.UI.WebControls namespace.

 For Each myTable As CrystalDecisions.CrystalReports.Engine.Table In myTables
Next 
 foreach(CrystalDecisions.CrystalReports.Engine.Table table in tables)
{
} 

5. Within the foreach loop, retrieve the TableLogonInfo instance from the LogOnInfo property of the Table 
instance.

 Dim myTableLogonInfo As TableLogOnInfo = myTable.LogOnInfo 
 TableLogOnInfo tableLogonInfo = table.LogOnInfo; 

6. Within the foreach loop, set the ConnectionInfo property of TableLogonInfo to the ConnectionInfo parameter.

 myTableLogonInfo.ConnectionInfo = myConnectionInfo 
 tableLogonInfo.ConnectionInfo = connectionInfo; 
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7. Within the foreach loop, pass the TableLogonInfo instance as a parameter to the ApplyLogonInfo method of 
the Table instance.

 myTable.ApplyLogOnInfo(myTableLogonInfo) 
 table.ApplyLogOnInfo(tableLogonInfo); 

This step procedure has created a method to set the logon for the database. However, you must modify the 
ConfigureCrystalReports() method to address this method, for the report to be aware that it has database 
logon information.

Modifying the ConfigureCrystalReports() method requires two actions:

● Configure the ConnectionInfo instance.
● Call the SetDBLogonForReport() method.

1.5.2.3.3.2  To modify the ConfigureCrystalReports() method to 
address the database logon code

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code above the line that 
binds the report to the CrystalReportViewer control.

2. Within the line breaks, declare and instantiate the ConnectionInfo class.

Note
To make the ConnectionInfo class accessible, include an "Imports" [Visual Basic] or "using" 
[C#] statement at the top of the code-behind class for the CrystalDecisions.Shared namespace. (You 
added this declaration in Project Setup [page 15].)

 Dim myConnectionInfo As ConnectionInfo = New ConnectionInfo() 
 ConnectionInfo connectionInfo = new ConnectionInfo(); 

3. Set the DatabaseName and IntegratedSecurity properties of the ConnectionInfo instance.

 myConnectionInfo.DatabaseName = "Northwind"
myConnectionInfo.IntegratedSecurity = True 
 connectionInfo.DatabaseName = "Northwind";
connectionInfo.IntegratedSecurity = true; 

4. Enter a call to the SetDBLogonForReport() method, by passing in the ConnectionInfo instance and the 
NorthwindCustomers report.

 SetDBLogonForReport(myConnectionInfo, northwindCustomersReport) 
 SetDBLogonForReport(connectionInfo, northwindCustomersReport); 

This is followed by the original code that binds the report to the CrystalReportViewer control.
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You are now ready to build and run your project. The report should load properly, because you have added code to 
log on to the database.

1.5.2.3.3.3  To test the loading of the NorthwindCustomers 
report

1. From the Build menu select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The NorthwindCustomers report displays successfully.
4. Return to Visual Studio and click Stop to exit from debug mode.

In the next section, you learn how to change the database location at runtime.

1.5.2.3.4 Adding Ability to Change Database Location at 
Runtime

In this section, you learn how to change the database location at runtime. This requires only a minor modification 
to the ConnectionInfo instance.

1.5.2.3.4.1  To change the database location at runtime

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code after the line that 
declares and instantiates the ConnectionInfo class.

2. Within the line breaks, set the ServerName property of the ConnectionInfo instance.

Note
In the code that you write, replace the sample server name DevDatabase (shown below) with the name of 
your server.

 myConnectionInfo.ServerName = "DevDatabase" 
 connectionInfo.ServerName = "DevDatabase"; 

You are now ready to build and run your project. The report should redirect to the alternate database server at 
runtime.
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1.5.2.3.4.2  To test that the report can be reset to an alternate 
database server at runtime

1. From the Build menu select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The NorthwindCustomers report displays successfully.
4. Return to Visual Studio and click Stop to exit from debug mode.

1.5.2.3.5 Configuration with the SetConnection method

In this section, you learn how to apply all three changes (to the server name, database name, and integrated 
security setting) using the SetConnection() method. This requires only a minor modification to the 
ConnectionInfo instance.

1. In the ConfigureCrystalReports() method, after the line that declares and instantiates the 
ConnectionInfo class, delete the lines of code that assign the ServerName, DatabaseName, and 
IntegratedSecurity properties.

2. Enter a new line of code in which you call the SetConnection() method of the ConnectionInfo instance, 
passing to this method the server name, database name and integrated security setting.

myConnectionInfo.SetConnection("DevDatabase", "Northwind", True)

connectionInfo.SetConnection("DevDatabase", "Northwind", true);

You are now ready to build and run your project.

1.5.2.4 Tutorial: Logging onto a Secure SQL Server Database 
with a Subreport

In this tutorial, you explore an additional complication to Logging onto a Secure SQL Server Database: what if the 
report that requires secure SQL Server database logon contains a subreport?

Introduction

In this tutorial, you learn how to meet logon requirements for the subreport.

You need to make two modifications to the project you have created in the previous tutorial:

● You add a subreport into the original report.
This subreport addresses the Orders table of the Northwind database. The Orders table is related to the 
Customers table that is used by a CustomerID foreign key in the previous tutorial.
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● You add a new method.
The method retrieves subreports out of the main report, and then passes each subreport to the 
SetDBLogonForReport() helper method.

You can also complete this tutorial with classes of the CrystalReportViewer object model, although the 
ReportDocument object model is preferred.

To build this tutorial with the CrystalReportViewer object model, see Tutorial: Logging onto a Secure SQL Server 
Database [page 212].

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_RDObjMod_DBLogonSubrpt
● C# Windows project: CS_Win_RDObjMod_DBLogonSubrpt
● Visual Basic Web Site: VB_Web_RDObjMod_DBLogonSubrpt
● Visual Basic Windows project: VB_Win_RDObjMod_DBLogonSubrpt

Related Information

Sample Reports Directory [page 14]

1.5.2.4.1 Adding a Subreport to the Original Report

You begin by adding a subreport to the original report.

1.5.2.4.1.1  To add a subreport

1. Open the project you created in the previous tutorial, Tutorial: Logging onto a Secure SQL Server Database 
Using Integrated Security [page 311].

2. From Solution Explorer, double-click the NorthwindCustomers report to open it.
3. Right-click the Details gray bar and select Insert Section Below.
4. Right-click within the new Details b section that you have created, point to Insert, and then click Subreport.

A gray square appears around the mouse cursor.
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5. Drag the gray rectangle into the new Details b section, and then click to release.
6. In the Insert Subreport dialog box, on the Subreport tab, select Create a subreport with the Report Wizard.

Note
The Insert Subreport dialog box includes other options that allow you to choose an existing report and on-
demand subreports. For more information about these features, see Subreport Tab (Insert Subreport 
Dialog Box) [page 785].

7. In the New report name field, type "CustomerOrders."
8. Click Report Wizard....
9. In the Standard Report Creation Wizard dialog box, in the Available Data Sources panel, expand the Create 

New Connection folder.
10. Expand the OLE DB (ADO) folder.

The folder contains the database server, which was configured for the report when the report was created.

Note
If the server is not displayed, follow the instructions in the previous tutorial to log onto the SQL Server 
database.

11. Expand the nodes Northwind, dbo, and Tables.
12. Select the Orders table and click the > symbol to move the Orders table into the Select Tables panel, and then 

click Next.
13. From the Available Fields panel, select Order ID, Order Date, Shipped Date, and Ship Name.
14. Click the > symbol to move these fields into the Fields to Display panel, and then click Finish.
15. In the Insert Subreport dialog box, select the Link tab.
16. In the panel Container Report field(s) to link to, in the list Available fields, expand the Customers table, select 

CustomerID, and then click the > symbol.
17. In the Customers.CustomerID field link panel that appears, leave the default selections unchanged.

These parameter and data selections auto-generate a relationship between the main report and the 
subreport.

18. Click OK.
The new subreport, CustomerOrders, is displayed within the Details b section of the Main report.

Note
Adding a subreport to the Details section means the subreport displays for every row, which adds a 
performance cost to your report. If you do not need subreport information with that level of granularity, 
place the subreport in a Group section rather than a Details section.

You are now ready to verify the settings in the subreport.

1.5.2.4.1.2  To verify the settings in the subreport

1. In the report Details section, double-click the CustomerOrders subreport to view it.
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At the bottom of the designer view, navigation buttons appear for both the Main Report and the 
CustomerOrders subreport.

2. If the Field Explorer is not visible, on the Crystal Reports toolbar, click Toggle Field View.

Note
Another way to display the Field Explorer is to go to the Crystal Reports menu, and then click Field Explorer.

3. In the Field Explorer, expand Parameter Fields.
4. Verify that the parameter field Pm-Customers.CustomerID was auto-generated when the subreport was 

linked.
5. On the toolbar, click Select Expert.
6. In the Select Expert dialog box, verify that the criteria Orders.CustomerID is equal to {?Pm-

Customers.CustomerID} is set, and then click OK.
7. From the File menu, select Save All.

You have successfully added a CustomerOrders subreport to the NorthwindCustomers report. In the next section 
you add code to set secure SQL Server Database logon information for all subreports that are found within the 
main report.

1.5.2.4.2 Adding the Subreport Logon Code

You are now ready to add the logon code for the subreport to the code-behind class. To begin, you create a private 
helper method named SetDBLogonForSubreports().

1.5.2.4.2.1  To create and code the SetDBLogonForSubreports() 
method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the bottom of the class, create a new private method named SetDBLogonForSubreports() with two 

parameters, ConnectionInfo and ReportDocument.

 Private Sub SetDBLogonForSubreports(ByVal myConnectionInfo As ConnectionInfo, 
ByVal myReportDocument As ReportDocument)
End Sub 
 private void SetDBLogonForSubreports(ConnectionInfo connectionInfo, 
ReportDocument reportDocument)
{
} 

4. Within this method, retrieve the Sections instance from the Sections property of the ReportDefinition 
property of the ReportDocument parameter.
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Note
Sections is an indexed class that contains instances of the Section class.

 Dim mySections As Sections = myReportDocument.ReportDefinition.Sections 
 Sections sections = reportDocument.ReportDefinition.Sections; 

5. Create a foreach loop that loops through each Section instance in the Sections indexed class instance.

 For Each mySection As Section In mySections
Next 
 foreach(Section section in sections)
{
} 

6. Within the foreach loop, retrieve the ReportObjects instance from the ReportObjects property of the 
Section instance.

 Dim myReportObjects As ReportObjects = mySection.ReportObjects 
 ReportObjects reportObjects = section.ReportObjects; 

7. Within the foreach loop, create a new, nested foreach loop that loops through each ReportObject instance 
in the ReportObjects indexed class instance.

 For Each myReportObject As ReportObject In myReportObjects
Next 
 foreach(ReportObject reportObject in reportObjects)
{
} 

8. Within the nested foreach loop, create a condition block that tests whether the Kind property of the 
ReportObject instance is equal to the SubreportObject selection of the ReportObjectKind 
enumeration.

 If myReportObject.Kind = ReportObjectKind.SubreportObject Then
End If 
 if(reportObject.Kind == ReportObjectKind.SubreportObject)
{
} 

9. Within the conditional block, cast the ReportObject instance to a SubreportObject instance.

 Dim mySubreportObject As SubreportObject = CType(myReportObject, SubreportObject) 
 SubreportObject subreportObject = (SubreportObject)reportObject; 

10. Still within the conditional block, declare a new instance of ReportDocument as a subReportDocument 
variable and populate it by calling the OpenSubreport() method of the SubreportObject instance.

 Dim subReportDocument As ReportDocument = 
mySubreportObject.OpenSubreport(mySubreportObject.SubreportName)
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 ReportDocument subReportDocument = 
subreportObject.OpenSubreport(subreportObject.SubreportName); 

11. Finally, within the conditional block, call the original SetDBLogonForReport() method and pass to it the 
ConnectionInfo parameter and the new subReportDocument variable.

 SetDBLogonForReport(myConnectionInfo, subReportDocument) 
 SetDBLogonForReport(connectionInfo, subReportDocument); 

1.5.2.4.2.2  To modify the ConfigureCrystalReports() method to 
address the DB Logon code for subreports

This step procedure has created a method to retrieve all possible subreports as ReportDocument instances. 
Each ReportDocument instance of subreport is then passed to the original method for setting the database logon 
to a Secure SQL Server database.

However, you must now modify the ConfigureCrystalReports() method to address this method, in order for 
subreports to have their database logon information processed.

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code above the line that 
binds the report to the CrystalReportViewer control.

2. Within the line breaks, enter a call to the SetDBLogonForSubreports() method, by passing in the 
ConnectionInfo instance and the NorthwindCustomers report.

 SetDBLogonForSubreports(myConnectionInfo, northwindCustomersReport) 
 SetDBLogonForSubreports(connectionInfo, northwindCustomersReport); 

1.5.2.4.2.3  To test the loading of the NorthwindCustomers 
report

This is followed by the original code, which binds the report to the CrystalReportViewer control.

You are now ready to build and run your project. It is expected that the report loads successfully, including its 
subreport, because there is now code written to log on any subreports to the database.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The NorthwindCustomers report, including its new CustomerOrders subreport displays successfully.
4. Return to Visual Studio and click Stop to exit from debug mode.
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1.5.2.5 Tutorial: Reading and Setting Discrete Parameters

In this tutorial, you learn how to create a report whose data can be filtered based on a discrete parameter.

Introduction

A discrete parameter is a single value, as opposed to a range parameter, which refers to a range of values. Text 
items (such as cities) are usually accessed through discrete parameters. Numeric items (such as employee 
salaries) are usually accessed through range parameters.

In this tutorial, you set a value for a discrete parameter to view a customer report that is based on one field. The 
report displays only those customers who live in the cities you have selected from a city list. The city list is derived 
from the default values for the City parameter. Those default values for the City parameter are encapsulated 
within the report.

To begin, you create a customer report with a city parameter. The report derives its data from the sample 
database that is shipped with SAP Crystal Reports, developer version for Microsoft Visual Studio. When you 
instantiate the report in the code, you create an ArrayList that contains city names (Paris, Tokyo) and pass that 
ArrayList instance to a helper method that sets those city names as the current values for the city parameter. You 
then bind the report to the CrystalReportViewer control and view the report with only those customers that live in 
Paris and Tokyo displayed.

In the next part of the tutorial, you do the following:

● Create a method that gets all the default values and returns them in an ArrayList.
● Add a ListBox control to the form and populate it from the ArrayList.
● Add a Button control to redisplay the report based on ListBox selections.

In the final part of the tutorial, you code the button click event to retrieve any selected items from the ListBox 
control and set those to be the current values for the city parameter. The report redisplays and shows only those 
customers who live in the cities that have been selected within the ListBox control.

This tutorial can also be completed with classes of the CrystalReportViewer object model, although the 
ReportDocument object model is preferred.

To build this tutorial with the CrystalReportViewer object model, see Tutorial: Logging onto a Secure SQL Server 
Database [page 212].

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_RDObjMod_Parameters
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● C# Windows project: CS_Win_RDObjMod_Parameters
● Visual Basic Web Site: VB_Web_RDObjMod_Parameters
● Visual Basic Windows project: VB_Win_RDObjMod_Parameters

Xtreme Database

This tutorial uses a sample database called Xtreme. The xtreme.mdb database file is included with the SAP 
Crystal Reports .NET SDK Sample Code package. To use the Xtreme database, you must manually create an 
ODBC connection to it.

Related Information

Choose the Correct Object Model for Your Project [page 29]
Sample Reports Directory [page 14]

1.5.2.5.1 Creating a Report with Parameters

To begin, create a report that draws information from the Xtreme database.

1.5.2.5.1.1  To create a report with parameters

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, in the Templates view, select the template named Crystal Report.
3. In the Name field, enter the name CustomersByCity.rpt and click Add.

4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 
Report Wizard.

5. In the Choose an Expert panel, select Standard, and then click OK.
6. In the Available Data Sources panel of the Standard Report Creation Wizard window, expand the Create New 

Connection folder.

Note
In Visual Studio .NET 2003 where SAP Crystal Reports has not been upgraded to the full version, the 
Create New Connection folder does not exist; the contents are shown at the top level.

7. From the subfolder that opens, expand the ODBC (RDO) folder.
8. In the ODBC (RDO) window, select the correct ODBC DSN entry for the Xtreme Database, and then click 

Finish.
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The ODBC (RDO) folder expands and shows the Xtreme database.
9. Expand the Tables node and select the Customer table.
10. Double-click the Customer table to move the table into the Selected Tables panel, and then click Next.
11. Expand the Customer table, then CTRL-click Customer Name, Contact Title, Address1, Contact Last Name and 

City.
12. Click the > symbol to move these fields into the Fields to Display panel, then click the Next button.
13. In the Available Fields panel, under Report Fields, select Customer.City, click the > symbol to move the field 

into the Group By panel, and then click the Finish button.
The CustomersByCity report is created and loaded into the main window of Visual Studio.

You are now ready to add a parameter named City and populate it with default values.

1.5.2.5.1.2  To add a City parameter

The Field Explorer must be visible, because it provides access to the various features of the report, including 
parameters.

1. If the Field Explorer is not visible, on the Crystal Reports toolbar, click Toggle Field View.

Note
Another way to display the Field Explorer is to go to the Crystal Reports menu, and then click Field Explorer.

2. In the Field Explorer, right-click Parameter Fields and select New...
3. In the Create Parameter Field dialog box:

a. Set the Name to City.
b. Set the Type to String. Set the Prompting Text to Select one or more cities.
c. Set the Value Field to City.
d. Click Actions, then select Append all database values. This will add the entire cities list into the middle 

pane.
e. In the Value Options pane, set the Prompt Text to Select one or more cities.
f. In the same pane, set Allow multiple values to True.
g. Set Allow discrete values to True.

4. Click OK to close the Create Parameter Field dialog box.

You have just set the Default Values to contain a large list of cities. Later in this tutorial, you access this same list 
of default values programmatically, through the DefaultValues property of the ParameterFieldDefinition class.

You now use the Select Expert to set a formula that connects the City database column to your newly created City 
parameter field.

1.5.2.5.1.3  To connect the City parameter to the City database 
column

1. On the Crystal Reports toolbar, click Select Expert.
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2. In the Choose Field dialog box, under Report Fields, select Customer.City, and then click OK.
3. In the Select Expert dialog box, within the Customer.City tab, set the dropdown list to is equal to.
4. In the new dropdown list that appears to the right, select the first choice in the list, {?City}, and then click OK.

Note
This selection, {?City}, is the City parameter that you created earlier.

5. From the File menu, select Save All.

You are now ready to bind the report to the CrystalReportViewer control and set the city parameter with two initial 
values, Paris and Tokyo.

1.5.2.5.2 Binding the Report

When you followed the instructions in the section Project Setup [page 15] to prepare for this tutorial, you placed a 
CrystalReportViewer control on the Web or Windows Form. In the previous steps, you added a CustomersByCity 
report to the project.

In this section, you instantiate the CustomersByCity report and bind it to the CrystalReportViewer control. Then 
you test whether the report displays correctly when current values have not been set for its parameter field.

You can instantiate and bind the report two ways:

● As an embedded report.
● As a non-embedded report.

Choose from one (but not both) of the step procedures below.

● If you use embedded reports, follow the next step procedure to instantiate the report as an embedded report.
● If you use non-embedded reports, follow the second step procedure to instantiate the report as a non-

embedded report.

1.5.2.5.2.1  To instantiate the CustomersByCity report as an 
embedded report and bind it to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code to view the code-behind class for this Web or Windows Form.
3. Add a new class-level declaration for the CustomersByCity report wrapper class, with the variable name 

customersByCityReport. Set its access modifier to private.

 Private customersByCityReport As CustomersByCity 
 private CustomersByCity customersByCityReport; 

4. Within the ConfigureCrystalReports() method, instantiate the report wrapper class.
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Note
You created the ConfigureCrystalReports() method in Project Setup [page 15].

 customersByCityReport = New CustomersByCity() 
 customersByCityReport = new CustomersByCity(); 

5. On the next line beneath the report instantiation, bind the ReportSource property of the CrystalReportViewer 
control to the instantiated report class (variable name: customersByCityReport).

 myCrystalReportViewer.ReportSource = customersByCityReport 
 crystalReportViewer.ReportSource = customersByCityReport; 

Note
The CrystalReportViewer control instance is accessible in the code because you added the control to your 
Web or Windows form. If Intellisense does not recognize the CrystalReportViewer control instance, verify 
that the CrystalReportViewer control has been added as a class-level declaration to this code-behind class.

1.5.2.5.2.2  To instantiate the CustomersByCity report as a 
non-embedded report and bind it to the 
CrystalReportViewer control

You are now ready to build and run your project. It is expected that the report loading will fail, because code has 
not yet been written to set a value for the City parameter field.

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Add a new class-level declaration for the ReportDocument report wrapper class, with the variable name 

customersByCityReport. Set its access modifier to private.

 Private customersByCityReport As ReportDocument 
 private ReportDocument customersByCityReport; 

Note
The ReportDocument class is a member of the CrystalDecisions.CrystalReports.Engine namespace. You 
have added an "Imports" [Visual Basic] or "using" [C#] declaration for this namespace in 
Project Setup [page 15]. When you instantiate ReportDocument and load a report into the namespace, you 
gain access to the report through the SDK, without embedding the report.

4. Within the ConfigureCrystalReports() method (which you added during one of the procedures in Project 
Setup [page 15]), instantiate the ReportDocument class.
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customersByCityReport = New ReportDocument() 
 customersByCityReport = new ReportDocument(); 

5. Declare a string variable, name it reportPath, and assign to it a runtime path to the local report. This path is 
determined differently for Web Sites and Windows projects:
○ For a Web Site, pass the name of the local report file as a string parameter into the Server.MapPath() 

method. This maps the local report to the hard drive file directory path at runtime.

 Dim reportPath As String = Server.MapPath("CustomersByCity.rpt") 
 string reportPath = Server.MapPath("CustomersByCity.rpt"); 

○ For a Windows project, concatenate the Application.StartupPath property with a backslash and the 
local report file name. This maps the report to the same directory as the Windows executable file.

Note
At compile time you will copy the report to the directory containing the executable file.

 Dim reportPath As String = Application.StartupPath & "\" & 
"CustomersByCity.rpt" 
 string reportPath = Application.StartupPath + "\\" + "CustomersByCity.rpt"; 

6. Call the Load() method of the ReportDocument instance and pass into it the reportPath string variable.

 customersByCityReport.Load(reportPath) 
 customersByCityReport.Load(reportPath); 

7. On the next line, beneath the report loading, bind the ReportSource property of the CrystalReportViewer to 
the ReportDocument instance.

 myCrystalReportViewer.ReportSource = customersByCityReport 
 crystalReportViewer.ReportSource = customersByCityReport; 

Whether you have chosen to instantiate an embedded report class or a non-embedded report through the 
ReportDocument class, the variable name used is the same: customersByCityReport. This allows you to use a 
common set of code in the procedures that follow.

You are now ready to build and run your project. It is expected that the report loading will fail, because code has 
not yet been written to set a value for the City parameter field. You'll add a value for the City parameter field later 
in this tutorial.

1.5.2.5.2.3  To test the loading of the CustomersByCity report

1. From the Build menu select Build Solution.
2. If you have any build errors, go ahead and fix them now.
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3. If you use a non-embedded report in a Windows project, locate the compiled Windows executable in the \bin
\ [Visual Basic] or \bin\debug\ [C#] subdirectory, and then copy the report to that subdirectory.

Note
To have the non-embedded report loaded by the Windows executable at runtime, the report must be 
stored in the same directory as the Windows executable.

4. From the Debug menu, click Start.

The CustomersByCity report does not display. It displays after you add a value for the City parameter field 
later in this tutorial.

Note
Results may vary, depending on the version of SAP Crystal Reports that you use. In more recent versions, 
you can see a form requesting that you provide parameter values for that report. In earlier versions, a 
"Missing parameter field current value" exception is thrown. In either case, you must add further code to 
create a fully functional application.

5. Return to Visual Studio and click Stop to exit from debug mode.

1.5.2.5.3 Setting Parameters Manually in Code

You are now ready to set two values ("Paris" and "Tokyo") into the City parameter field for the CustomersByCity 
report.

This involves some coding, which you can separate into the following processes:

● You need a PARAMETER_FIELD_NAME constant to hold the "City" parameter field name, which is used 
several times throughout the code.

● The code to add current values to the parameter is commonly used at two different locations in this tutorial; 
therefore, you create this code as a separate helper method.

● Within the ConfigureCrystalReports() method, you add the "Paris" and "Tokyo" parameters to an 
ArrayList instance and pass in both the report and the ArrayList instance to the helper method to be 
processed.

In the next section, you learn how to retrieve the default values from the parameter field and set those values into 
a ListBox control. These are used at the end of the tutorial to select new cities dynamically and filter the report 
based on those newly selected cities.

Continue to Create a ListBox Control that Displays Default Parameters [page 336].

1.5.2.5.3.1  To create a PARAMETER_FIELD_NAME constant

1. Return to the code-behind class for this Web or Windows Form.
2. At the class level, create a new string constant, PARAMETER_FIELD_NAME, and set its value to "City."

 Private Const PARAMETER_FIELD_NAME As String = "City"
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 private const string PARAMETER_FIELD_NAME = "City"; 

1.5.2.5.3.2  To create a helper method that adds current values 
to the parameter in the report

You are now ready to create the helper method that adds current values to the parameter in the report.

1. Return to the code-behind class for this Web or Windows Form.
2. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of 

the class for the System.Collections namespace (if this namespace has not already been declared).

 Imports System.Collections 
 using System.Collections; 

Note
This declaration is needed, to access the ArrayList class.

3. At the bottom of the class, create a new private method named 
SetCurrentValuesForParameterField(), with two variables in the method signature: ReportDocument, 
and ArrayList.

Note
Later in this tutorial, if you have used an embedded report, you pass your embedded report class into the 
ReportDocument method parameter. How is this possible? All embedded report classes in SAP Crystal 
Reports inherit from the ReportDocument base class.

 Private Sub SetCurrentValuesForParameterField(ByVal myReportDocument As 
ReportDocument, ByVal myArrayList As ArrayList)
End Sub 
 private void SetCurrentValuesForParameterField(ReportDocument reportDocument, 
ArrayList arrayList)
{
} 

4. Within this method, declare and instantiate the ParameterValues that are indexed class as the variable 
currentParameterValues.

Note
For the ParameterValues class to be accessible, you must have included an "Imports" [Visual 
Basic] or "using" [C#] declaration at the top of the code-behind class for the CrystalDecisions.Shared 
namespace. (You added this declaration in Project Setup [page 15].)

 Dim currentParameterValues As ParameterValues = New ParameterValues() 
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 ParameterValues currentParameterValues = new ParameterValues(); 
5. Create a foreach loop to retrieve all of the submitted values (as type Object) from the ArrayList instance.

Note
In this method, you retrieve values from the ArrayList. Later you write code that adds values to the 
ArrayList.

 For Each submittedValue As Object In myArrayList
Next 
 foreach(object submittedValue in arrayList)
{
} 

6. Within the foreach loop, declare and instantiate the ParameterDiscreteValue class.

 Dim myParameterDiscreteValue As ParameterDiscreteValue = New 
ParameterDiscreteValue() 
 ParameterDiscreteValue parameterDiscreteValue = new ParameterDiscreteValue(); 

7. Within the foreach loop, convert the submittedValue to string and pass it to the Value property of the 
ParameterDiscreteValue instance.

 myParameterDiscreteValue.Value = submittedValue.ToString() 
 parameterDiscreteValue.Value = submittedValue.ToString(); 

8. Within the foreach loop, add the ParameterDiscreteValue instance into the currentParameterValues indexed 
class.

 currentParameterValues.Add(myParameterDiscreteValue) 
 currentParameterValues.Add(parameterDiscreteValue); 

This completes the code within the foreach loop. You place the remaining code (from the steps that follow) 
after the foreach loop.

9. Outside the foreach loop, retrieve the ParameterFieldDefinitions indexed class, which comes from the 
DataDefinition property of the ReportDocument instance.

 Dim myParameterFieldDefinitions As ParameterFieldDefinitions = 
myReportDocument.DataDefinition.ParameterFields 
 ParameterFieldDefinitions parameterFieldDefinitions = 
reportDocument.DataDefinition.ParameterFields; 

10. Retrieve the ParameterFieldDefinition instance from the ParameterFieldDefinitions indexed class that is 
based on the index entry of the PARAMETER_FIELD_NAME constant.

 Dim myParameterFieldDefinition As ParameterFieldDefinition = 
myParameterFieldDefinitions(PARAMETER_FIELD_NAME) 
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ParameterFieldDefinition parameterFieldDefinition = 
parameterFieldDefinitions[PARAMETER_FIELD_NAME]; 

11. Pass the currentParameterValues instance to the ApplyCurrentValues method of the 
ParameterFieldDefinition instance.

 myParameterFieldDefinition.ApplyCurrentValues(currentParameterValues) 
 parameterFieldDefinition.ApplyCurrentValues(currentParameterValues); 

1.5.2.5.3.3  To call the SetCurrentValuesForParameterField() 
method before the report is bound to the 
CrystalReportViewer control

This step procedure showed you how to create a method that retrieves submitted values from an ArrayList 
instance and places them as current values into a ParameterFieldDefinition instance. Now, you must call this 
method before your report is bound to the CrystalReportViewer control, for the report to be aware that it has 
parameter settings.

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code above the line that 
binds the report to the CrystalReportViewer control.
Within these line breaks, you can now enter additional code that modifies the report before it is bound to the 
viewer.

2. Within the line breaks, declare and instantiate an ArrayList.

 Dim myArrayList As ArrayList = New ArrayList() 
 ArrayList arrayList = new ArrayList(); 

3. Add the city names "Paris" and "Tokyo" as strings to the ArrayList instance.

 myArrayList.Add("Paris")
myArrayList.Add("Tokyo") 
 arrayList.Add("Paris");
arrayList.Add("Tokyo"); 

4. Call the SetCurrentValuesForParameterField() method, and pass in the CustomersByCityReport 
instance, and the ArrayList instance.

 SetCurrentValuesForParameterField(customersByCityReport,
myArrayList) 
 SetCurrentValuesForParameterField(customersByCityReport,
arrayList); 
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1.5.2.5.3.4  To test the loading of the CustomersByCity report

The final line of code in the method is code that binds the report to the CrystalReportViewer control.

You are now ready to build and run your project. It is expected that the report displays successfully because there 
is now code written to set current values into the parameter field.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The CustomersByCity report displays successfully, showing listings for customers in Paris and Tokyo.
4. Return to Visual Studio and click Stop to exit from debug mode.

1.5.2.5.4 Create a ListBox Control that Displays Default 
Parameters

The remainder of the tutorial is concerned with displaying a complete list of default values for the parameter field 
in a ListBox control, and based on selections that you make from that ListBox control, refiltering the contents of 
the report.

In this section you learn how to populate the ListBox control from the default values of the parameter field.

Note
Remember that you set the Default Values, a large list of cities, when you created this report at the beginning of 
the tutorial.

To do this, you must add and configure a ListBox control, and then create a helper method to populate the ListBox 
control.

1.5.2.5.4.1  To create and configure a ListBox control on the 
form

1. Open the Web or Windows form.
2. From the View menu, click Designer.
3. If you are developing a Web Site, do the following:

○ Click the CrystalReportViewer control to select it.
○ Press the LEFT ARROW on your keyboard so that a flashing cursor appears, and then press ENTER.

The CrystalReportViewer control drops by one line.
4. If you are developing a Windows project, do the following:

○ Click the CrystalReportViewer control to select it.
○ From the Properties window, set the Dock to "Bottom"
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Note
In Visual Studio, When you select the Dock property, a frame appears instead of a list of options. Select 
the portion of the frame that corresponds to "Bottom".

○ Resize the Windows form and the CrystalReportViewer control so that the CrystalReportViewer is large 
enough to display a report. Leave room above the CrystalReportViewer control for a ListBox control.

○ From the Properties window, set the Anchor to "Top, Bottom, Left, Right."
○ Resize the Windows form and the CrystalReportViewer control so that the CrystalReportViewer is large 

enough to display a report. Leave room above the CrystalReportViewer control for a ListBox control.
5. From the Toolbox, drag a ListBox control above the CrystalReportViewer control.

Note
If a Smart Task appears on the ListBox (when using Visual Studio), press Esc to close it.

6. Click on the ListBox control to select it.
7. From the Properties window:

○ Set the ID or Name to "defaultParameterValuesList."
○ Set the SelectionMode to "Multiple" (in a Windows project, "MultiExtended").

8. From the File menu, select Save All.

You are now ready to create a helper method that retrieves the default values from the parameter field.

1.5.2.5.4.2  To create a helper method that retrieves the default 
values from the parameter field

1. Open the Web or Windows form.
2. From the View menu, click Code.
3. At the bottom of the class, create a new private method named 

GetDefaultValuesFromParameterField() that returns an ArrayList instance, with ReportDocument 
passed into the method signature.

 Private Function GetDefaultValuesFromParameterField(ByVal myReportDocument As 
ReportDocument) As ArrayList
End Function 
 private ArrayList GetDefaultValuesFromParameterField(ReportDocument 
reportDocument)
{
} 

4. Within the GetDefaultValuesFromParameterField() method, retrieve the ParameterFieldDefinitions 
indexed class, which comes from the DataDefinition property of the ReportDocument instance.

 Dim myParameterFieldDefinitions As ParameterFieldDefinitions = 
myReportDocument.DataDefinition.ParameterFields 
 ParameterFieldDefinitions parameterFieldDefinitions = 
reportDocument.DataDefinition.ParameterFields;
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5. Retrieve the ParameterFieldDefinition instance from the ParameterFieldDefinitions indexed class, which is 

based on the index entry of the PARAMETER_FIELD_NAME constant.

 Dim myParameterFieldDefinition As ParameterFieldDefinition = 
myParameterFieldDefinitions(PARAMETER_FIELD_NAME) 
 ParameterFieldDefinition parameterFieldDefinition = 
parameterFieldDefinitions[PARAMETER_FIELD_NAME]; 

6. Retrieve a ParameterValues indexed class (as the variable defaultParameterValues) from the DefaultValues 
property of the ParameterFieldDefinition instance.

 Dim defaultParameterValues As ParameterValues = 
myParameterFieldDefinition.DefaultValues 
 ParameterValues defaultParameterValues = parameterFieldDefinition.DefaultValues; 

7. Declare and instantiate an ArrayList.

 Dim myArrayList As ArrayList = New ArrayList() 
 ArrayList arrayList = new ArrayList(); 

8. Create a foreach loop, to retrieve each ParameterValue instance from defaultParameterValues.

 For Each myParameterValue As ParameterValue In defaultParameterValues
Next 
 foreach(ParameterValue parameterValue in defaultParameterValues)
{
} 

Within the foreach loop, you now create a nested conditional block that checks for discrete (as opposed to 
range) parameter values. Two versions of this conditional block exist, because the API has changed slightly 
across versions of SAP Crystal Reports, developer version for Microsoft Visual Studio. Check your API (using 
IntelliSense) to see which property is available under ParameterValue:

9. If the available property is IsRange then, within the foreach loop, enter this code:

 If (Not myParameterValue.IsRange) Then
End If 
 if(!parameterValue.IsRange)
{
} 

10. Or, if the available property is Kind (DiscreteOrRangeKind, an enum with three values: DiscreteValue, 
RangeValue, DiscreteAndRangeValue) then, within the foreach loop, enter this code instead:

 If (myParameterValue.Kind = DiscreteOrRangeKind.DiscreteValue) Then
End If 
 if(parameterValue.Kind == DiscreteOrRangeKind.DiscreteValue)
{
} 
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11. Within this nested conditional block, cast the ParameterValue instance to its extended class, 
DiscreteParameterValue.

 Dim myParameterDiscreteValue As ParameterDiscreteValue = CType(myParameterValue, 
ParameterDiscreteValue) 
 ParameterDiscreteValue parameterDiscreteValue = 
(ParameterDiscreteValue)parameterValue; 

12. Also within the nested conditional block, add the Value property of the ParameterDiscreteValue instance 
(converted to String) into the ArrayList instance.

 myArrayList.Add(myParameterDiscreteValue.Value.ToString()) 
 arrayList.Add(parameterDiscreteValue.Value.ToString()); 

13. Outside the conditional block, and outside the foreach loop, at the end of the method, return the ArrayList 
instance from the method.

 Return myArrayList 
 return arrayList; 

1.5.2.5.4.3  To bind the ArrayList returned from the method to 
the ListBox in a Web project

You have retrieved the default values from the parameter field and returned them from the method as an 
ArrayList. You now bind this ArrayList to the defaultParameterValuesList ListBox control.

Your code varies slightly depending on whether you use a Web project or a Windows project; therefore, be sure to 
only complete either the Web or Windows procedure below.

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code immediately after 
the line of code that adds the Tokyo string value to ArrayList instance.
Within these line breaks, you can now enter additional code that sets the data source for the 
defaultParameterValuesList ListBox control when the page loads for the first time.

2. Within the line breaks, create a Not IsPostBack conditional block.

 If Not IsPostBack Then
End If 
 if(!IsPostBack)
{
} 

Note
The Not IsPostBack conditional block is used to encapsulate code that should only be run the first time 
the page loads. Controls are typically bound to data values within Not IsPostBack conditional blocks so 
that their data values (and any subsequent control events) are not reset during page reloads.
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3. Within the Not IsPostBack conditional block, set the DataSource property of the 
defaultParameterValuesList ListBox to the GetDefaultValuesFromParameterField() helper method, 
passing in the CustomersByCity report instance as a method parameter.

 defaultParameterValuesList.DataSource = 
GetDefaultValuesFromParameterField(customersByCityReport) 
 defaultParameterValuesList.DataSource = 
GetDefaultValuesFromParameterField(customersByCityReport); 

4. Still within the Not IsPostBack conditional block, call the DataBind() method of the 
defaultParameterValuesList ListBox.

 defaultParameterValuesList.DataBind() 
 defaultParameterValuesList.DataBind(); 

1.5.2.5.4.4  To bind the ArrayList returned from the method to 
the ListBox in a Windows project

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code immediately after 
the line of code that adds the Tokyo string value to ArrayList instance.
Within these line breaks, you can now enter additional code that sets the data source for the 
defaultParameterValuesList ListBox control when the page loads for the first time.

2. Within the line breaks, set the DataSource property of the defaultParameterValuesList ListBox to the 
GetDefaultValuesFromParameterField() helper method, passing in the CustomersByCity report 
instance as a method parameter.

 defaultParameterValuesList.DataSource = 
GetDefaultValuesFromParameterField(customersByCityReport) 
 defaultParameterValuesList.DataSource = 
GetDefaultValuesFromParameterField(customersByCityReport); 

1.5.2.5.4.5  To test the population of the 
defaultParameterValuesList ListBox control

You are now ready to build and run the project, to verify whether the defaultParameterValuesList ListBox is 
populated.

1. From the Build menu select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The defaultParameterValuesList ListBox control displays a complete list of default values (cities, in our 
tutorial).
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4. Return to Visual Studio and click Stop to exit from debug mode.

In the next section, you add a button to redisplay the report based on selections from the 
defaultParameterValuesList ListBox control.

1.5.2.5.5 Setting Parameters from ListBox Selections

In this section you add a button to redisplay the report based on selections from the defaultParameterValuesList 
ListBox control.

Within the event method for this button, you call the same method that is called when the page first loads: 
SetCurrentValuesForParameterField(). But this time, rather than pass in arbitrary values (Paris and 
Tokyo) you pass in the selected values from the defaultParameterValuesList ListBox control.

1.5.2.5.5.1  To create and configure a redisplay Button on the 
form

1. Open the Web or Windows form.
2. From the View menu, click Designer.
3. From the Toolbox, drag a Button control to the right of the ListBox control.
4. Click on the Button control to select it.
5. From the Properties window:

○ Set the ID or Name to "redisplay."
○ Set the Text to "Redisplay Report."

You are now ready to create a button click event method that checks for selected items in the ListBox control and 
passes them to SetCurrentValuesForParameterField() method.

Your code varies slightly for a Web project or a Windows project, so only complete either the Web or Windows 
procedure below.

1.5.2.5.5.2  To create the click event method for the redisplay 
Button in a Web project

1. Double-click the redisplay Button control.
You are taken to the code-behind class where a redisplay_Click() event method has been automatically 
generated.

2. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of 
the class for the System.Web.UI.WebControls namespace (if this namespace has not already been declared).

 Imports System.Web.UI.WebControls 
 using System.Web.UI.WebControls;

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 341



 

Note
This declaration is needed, to access the ListItem class.

3. Within the redisplay_Click() event method that has just been auto-generated, declare and instantiate an 
ArrayList.

 Dim myArrayList As ArrayList = New ArrayList() 
 ArrayList arrayList = new ArrayList(); 

4. Create a foreach loop to retrieve each ListItem instance from the Items property of 
defaultParameterValuesList.

 For Each item As ListItem In defaultParameterValuesList.Items
Next 
 foreach(ListItem item in defaultParameterValuesList.Items)
{
} 

5. Within the foreach loop, create a nested conditional block that adds the Item instance to the Arraylist instance 
if the Selected property of the current Item instance is set to True.

 If item.Selected Then
    myArrayList.Add(item.Value)
End If 
 if(item.Selected)
{
    arrayList.Add(item.Value);
} 

6. Outside the conditional block, and outside the foreach loop, call the 
SetCurrentValuesForParameterField() method and pass in the CustomersByCity report instance 
and the ArrayList instance.

 SetCurrentValuesForParameterField(customersByCityReport, myArrayList) 
 SetCurrentValuesForParameterField(customersByCityReport, arrayList); 

Now that the selected values from the ListBox control have been applied as the current values for the 
parameter field, you are ready to redisplay the report.

7. Rebind the CustomersByCity report instance to the ReportSource property of the 
CrystalReportViewer control.

 myCrystalReportViewer.ReportSource = customersByCityReport 
 crystalReportViewer.ReportSource = customersByCityReport; 
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1.5.2.5.5.3  To create the click event method for the redisplay 
Button in a Windows project

1. Double-click the redisplay Button control.
You are taken to the code-behind class where a redisplay_Click() event method has been automatically 
generated.

2. Within the redisplay_Click() event method that has just been auto-generated, declare and instantiate an 
ArrayList.

 Dim myArrayList As ArrayList = New ArrayList() 
 ArrayList arrayList = new ArrayList(); 

3. Create a foreach loop, to retrieve each item (as a string) from the SelectedItems property of 
defaultParameterValuesList.

 For Each item As String In defaultParameterValuesList.SelectedItems
Next 
 foreach(string item in defaultParameterValuesList.SelectedItems)
{
} 

4. Within the conditional block, add item String instance to the ArrayList instance.

 myArrayList.Add(item) 
 arrayList.Add(item); 

5. Outside the conditional block, and outside the foreach loop, call the 
SetCurrentValuesForParameterField() method and pass in the CustomersByCity report instance and 
the ArrayList instance.

 SetCurrentValuesForParameterField(customersByCityReport, myArrayList) 
 SetCurrentValuesForParameterField(customersByCityReport, arrayList); 

Now that the selected values from the ListBox control have been applied as the current values for the 
parameter field, you are ready to redisplay the report.

6. Rebind the CustomersByCity report instance to the ReportSource property of the CrystalReportViewer 
control.

 myCrystalReportViewer.ReportSource = customersByCityReport 
 crystalReportViewer.ReportSource = customersByCityReport; 
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1.5.2.5.5.4  To test the population of the 
defaultParameterValuesList ListBox control

You are now ready to build and run the project, to verify that the parameter field has been reset successfully.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. In the ListBox control, CTRL-click to select at least four different cities in the list.
5. Click Redisplay Report.

The page reloads and displays the customer records for customers who live in the list of cities that you have 
selected.

6. Return to Visual Studio and click Stop to exit from debug mode.

If you are working with a Windows application, you are now done. If you are working with Web Site, continue to 
Configuring Parameter Persistence [page 344].

1.5.2.5.6 Configuring Parameter Persistence

In this section, you configure persistence (in a Web-based tutorial) for the parameter field selections that are 
made from the ListBox control.

As demonstrated in the tutorial Tutorial: Persisting the ReportDocument Object Model Using Session [page 289], 
changes made within the ReportDocument object model are lost when the Web page is reloaded, each time users 
click buttons on the CrystalReportViewer toolbar (such as Next Page and Zoom).

1.5.2.5.6.1  To demonstrate lack of persistence for parameter 
selections

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. In the ListBox control, SHIFT-click to select all cities in the list.
5. Click Redisplay Report.

The page reloads, and then displays the customer records for all customers in all cities. This is a large report 
that contains many pages.

6. On the CrystalReportViewer toolbar, click Next Page.

The list of selected cities is not persisted. Page 2 of the report is not displayed. Instead, you see the startup 
parameter settings again (Paris and Tokyo).

7. Return to Visual Studio and click Stop to exit from debug mode.

You must add persistence code to your application so that changes made within the ReportDocument object 
model are persisted when Web pages are reloaded.
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To begin, you add persistence code to the ConfigureCrystalReports() method, by adding an Else block to 
the Not IsPostBack conditional block. You then set unique values for the ArrayList instance for either condition 
in the conditional block. On page startup, you set the default values ("Paris" and "Tokyo") into the ArrayList 
instance. On page reloads, you retrieve the ArrayList instance that is stored in Session.

1.5.2.5.6.2  To add persistence code to the 
ConfigureCrystalReports() method

1. In the ConfigureCrystalReports() method, cut and paste the two lines of code, which add Paris and 
Tokyo to the ArrayList, into the bottom of the If Not IsPostBack conditional block.

When you are finished, the conditional block should look like this:

 If Not IsPostBack Then
    defaultParameterValuesList.DataSource =
GetDefaultValuesFromParameterField(customersByCityReport)
    defaultParameterValuesList.DataBind()
    myArrayList.Add("Paris")
    myArrayList.Add("Tokyo")
End If 
 if (!IsPostBack)
{
   defaultParameterValuesList.DataSource =
GetDefaultValuesFromParameterField(customersByCityReport);
   defaultParameterValuesList.DataBind();
   arrayList.Add("Paris");
   arrayList.Add("Tokyo");
} 

2. Add a final line of code to the conditional block that assigns the ArrayList instance to Session.

Note
You can use the variable name as the string identifier for the Session that you add.

 Session("myArrayList") = myArrayList 
 Session["arrayList"] = arrayList; 

3. Add an Else condition to the Not IsPostBack conditional block.

4. Within the Else block, retrieve the ArrayList instance from Session and cast it to an ArrayList Object.

 myArrayList = Ctype(Session("myArrayList"), ArrayList) 
 arrayList = (ArrayList)Session["arrayList"]; 

When you are finished, the conditional block should look like this:

Those modifications to ConfigureCrystalReports() method ensure that the current instance of ArrayList is 
always available to be passed into the SetCurrentValuesForParameterField() method.

In the next section, you make two changes to the code in the button click event:
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● Take the ArrayList that you created and assign it to Session.
● Replace the last two lines of code (that configure and display the report) with a call to the 

ConfigureCrystalReports() method to perform this functionality on a common set of code.

1.5.2.5.6.3  To modify the code in the button click event 
method to work with Session persistence

1. Delete the following last two lines of code in the button click event method.
The first line of code to delete is the call to the SetCurrentValuesForParameterField() method. The 
second line of code to delete is the code that binds the customersByCityReport instance to the ReportSource 
property of the CrystalReportViewer control.

In the next step, you add two new lines of code to replace the deleted code.
2. Within the button click event method, immediately outside the foreach loop, add a line of code that assigns 

the ArrayList instance to Session.

Note
You can use the variable name as the string identifier for the Session that you add.

 Session("myArrayList") = myArrayList 
 Session["arrayList"] = arrayList; 

3. Call the ConfigureCrystalReports() method.

This retrieves the ArrayList instance, applies it to the report, and binds the report to the CrystalReportViewer 
control.

 ConfigureCrystalReports() 
 ConfigureCrystalReports(); 

You are now ready to build and run the project, to verify that the parameter field has been reset successfully.

Note
An alternative approach to persistence is to persist the ReportDocument instance. To learn how to persist the 
ReportDocument instance to Session, see the tutorial Tutorial: Persisting the ReportDocument Object Model 
Using Session [page 289].

1.5.2.5.6.4  To test the population of the 
defaultParameterValuesList ListBox control

1. From the Build menu, select Build Solution.
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2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. In the ListBox control, SHIFT-click to select all cities in the list.
5. Click Redisplay Report.

The page reloads and displays the customer records for all customers in all cities. This is a large report that 
contains many pages.

6. On the CrystalReportViewer toolbar, click Next Page.
7. The list of selected cities is now persisted. Page 2 of the report is displayed.
8. Return to Visual Studio and click Stop to exit from debug mode.

1.5.2.5.7 Addendum: Enhancements to the Discrete 
Parameters Code

You have successfully created a report with a discrete parameter value and a helper method that can accept any 
set of values in a common format (an ArrayList), and then applied those values to a report based on a specific 
parameter field name (the PARAMETER_FIELD_NAME constant).

If you have installed Visual Studio 2005 or later or SAP Crystal Reports Developer you have access to the 
enhanced API that sets the discrete parameters in the Crystal report. The SAP Crystal Reports Developer API 
helps minimize the amount of code that is needed to set the discrete parameters.

In the previous procedures, you learned to create the SetCurrentValuesForParameterField() helper method.

In this tutorial, you can delete the helper method and instead call the SetParameterValue() method of the 
ReportDocument class.

The SetParameterValue() method comes in the following overloaded methods:

● SetParameterValue(int index, object value)
● SetParameterValue(string parameterFieldName, object value)
● SetParameterValue(string parameterFieldName, object value, string subreport)

You can pass in any type of object where the value satisfies the default values for the parameter field. The object 
can be an Array instance that stores a list of parameter values.

Prerequisites:

● You must create a project that is based on the instructions in Tutorial: Reading and Setting Discrete 
Parameters [page 326].
However, in Setting Parameters Manually in Code [page 332], you only need to create the 
PARAMETER_FIELD_NAME constant. You do not need to create the SetCurrentValuesForParameterField() 
help method.

● If you already have a project that is based on the instructions in Tutorial: Reading and Setting Discrete 
Parameters [page 326], delete the SetCurrentValuesForParameterField() helper method and the call within 
the ConfigureCrystalReports() method.
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1.5.2.5.7.1  To use the SetParameterValue() method for 
Discrete Parameters

1. Open the completed project for this tutorial.
2. Open the Web or Windows Form.
3. From the View menu, click Code.
4. Within the ConfigureCrystalReports() method, above the line that binds the report to the ReportSource 

property of the CrystalReportViewer control, call the SetParameterValue() method from the CustomerByCity 
class. Pass the parameter field name and the parameter values in an Array instance to the method.

 customersByCityReport.SetParameterValue(PARAMETER_FIELD_NAME, 
arrayList.ToArray()) 
 customersByCityReport.SetParameterValue(PARAMETER_FIELD_NAME, 
arrayList.ToArray()); 

You are now ready to build and run the project, to read and set discrete parameters.

1.5.2.6 Tutorial: Reading and Setting Parameters with a 
Subreport

In this tutorial, you explore an additional complication: what if the report that requires parameters contains a 
subreport that requires different parameters?

Note
To complete this tutorial, you must complete the previous tutorial, Tutorial: Reading and Setting Discrete 
Parameters [page 326].

Introduction

In the previous tutorial, Tutorial: Reading and Setting Discrete Parameters [page 326], you have learned how to 
create a report with a parameter, and how to write code to set that parameter at runtime – both with hard-coded 
parameter values and parameter values that are passed from a ListBox control.

In this tutorial, you learn how to add parameters to a subreport.

You need to make four modifications to the project that you have created in Tutorial: Reading and Setting Discrete 
Parameters [page 326]:

● You add a subreport into the original report.
This subreport addresses the Orders table of the Xtreme database. The Orders table is related to the 
Customers table that is used in the previous tutorial by a Customer ID foreign key.

● You add a range parameter to the subreport that filters by a range of order dates.
● You add two Text controls to the form: orderStartDate, and orderEndDate, to set the order date range at 

runtime.
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● You add a new method.
This method creates a ParameterRangeValue instance that contains the startDate and endDate values, and 
then passes that ParameterRangeValue instance into the range parameter inside the subreport.

When you have completed this tutorial, you can filter the values that are displayed on the report at runtime. The 
code that you add limits the number of cities that are displayed in the main report, and limits the range of order 
dates to be displayed in the subreport.

This tutorial can also be completed with classes of the CrystalReportViewer object model, although the 
ReportDocument object model is preferred.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_RDObjMod_ParametersSubrpt
● C# Windows project: CS_Win_RDObjMod_ParametersSubrpt
● Visual Basic Web Site: VB_Web_RDObjMod_ParametersSubrpt
● Visual Basic Windows project: VB_Win_RDObjMod_ParametersSubrpt

Xtreme database

This tutorial uses a sample database called Xtreme. The xtreme.mdb database file is included with the SAP 
Crystal Reports .NET SDK Sample Code package. To use the Xtreme database, you must manually create an 
ODBC connection to it.

Related Information

Choose the Correct Object Model for Your Project [page 29]
Tutorial: Reading and Setting Range Parameters for a Subreport [page 239]
Sample Reports Directory [page 14]

1.5.2.6.1 Adding a Subreport to the Original Report

To begin, you add a subreport to the original report.
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1.5.2.6.1.1  To add a subreport

1. Open the project you created in the previous tutorial, Tutorial: Reading and Setting Discrete Parameters 
[page 326].

2. From Solution Explorer, double-click the CustomersByCity report to open it.
3. Right-click the Details gray bar and select Insert Section Below.
4. Right-click within the new Details b section that you have created, point to Insert, and then click Subreport.

A gray square appears around the mouse cursor.
5. Drag the gray rectangle into the new Details b section, and then click to release.
6. In the Insert Subreport dialog box, on the Subreport tab, select Create a subreport with the Report Wizard.

Note
The Insert Subreport dialog box includes other options that allow you to choose an existing report and on-
demand subreports. For more information on these features, see Subreport Tab (Insert Subreport Dialog 
Box) [page 785].

7. In the New report name field, type CustomerOrders.

8. Click Report Wizard....
9. In the Available Data Sources panel of the Standard Report Creation Wizard window, expand the Create New 

Connection folder.
10. From the subfolder that opens, expand the ODBC (RDO) folder.

The folder contains the database server, which has been configured for the report when the report is created.

Note
If the server is not displayed, follow the instructions in the previous tutorial to connect to the Xtreme 
database.

11. Select the Orders table and click the > symbol to move the Orders table into the Select Tables panel, and then 
click Next.

12. From the Available Fields panel, select Order ID, Order Date, Ship Date, and Ship Via.
13. Click the > symbol to move these fields into the Fields to Display panel, and then click Finish.
14. In the Insert Subreport dialog box, select the Link tab.
15. In the panel Container Report field(s) to link to, in the list Available fields, expand the Customers table, select 

Customer ID, and then click the > symbol.
16. In the Customers.Customer ID field link panel that appears, leave the default selections unchanged.

These parameter and data selections auto-generate a relationship between the main report and the 
subreport.

17. Click OK.
The new subreport, CustomerOrders, is displayed within the Details b section of the Main report.

Note
When you add a subreport to the Details section, the subreport displays for every row, which adds a 
performance cost to your report. If you do not need subreport information with that level of granularity, 
place the subreport in a Group section rather than a Details section.
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You are now ready to verify the settings in the subreport.

1.5.2.6.1.2  To verify the settings in the subreport

1. In the report Details section, double-click on the CustomerOrders subreport to view it.
At the bottom of the designer view, navigation buttons appear for both the Main Report and the 
CustomerOrders subreport.

2. If the Field Explorer is not visible, on the Crystal Reports toolbar, click Toggle Field View.

Note
Another way to display the Field Explorer is to go to the Crystal Reports menu, and then click Field Explorer.

3. In the Field Explorer, expand Parameter Fields.
4. Verify that the parameter field Pm-Customers.Customer ID was auto-generated when the subreport was 

linked.
5. On the toolbar, click Select Expert.
6. In the Select Expert dialog box, verify that the criteria Orders.Customer ID is equal to {Pm-

Customers.Customer ID} is set, and then click OK.
7. From the File menu, select Save All.

You have successfully added a CustomerOrders subreport to the CustomersByCity report. In the next section, 
you add an OrderDateRange parameter to the subreport.

1.5.2.6.1.3  To add an OrderDateRange parameter to the 
subreport

1. In the Field Explorer, right-click Parameter Fields and select New….
2. In the Create Parameter Field dialog box:

○ Set the Name to OrderDateRange.
○ Set the Value type to Date.
○ Set the Prompting text to Specify a Date Range of Orders to display.
○ Set the Options to one selection only, Range value(s).

3. Click OK.
4. On the toolbar, click Select Expert.
5. Click the New tab.
6. In the Choose Field dialog box, expand the Orders table, select Order Date, and then click OK.
7. On the new Orders.OrderDate tab, from the drop down criteria list, select formula:.
8. Type the following formula: {Orders.Order Date} in {?OrderDateRange}.

9. Click OK.
10. From the File menu, select Save All.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 351



You have successfully added an OrderDateRange parameter to the subreport and linked it to the 
Orders.OrderDate column. In the next section, you add code to address the OrderDateRange parameter within the 
subreport.

1.5.2.6.2 Adding the Subreport Parameter Code

You are now ready to add the parameter code for the subreport to the code-behind class. To begin, you create a 
private helper method, SetDateRangeForOrders().

1.5.2.6.2.1  To create and code the SetDateRangeForOrders() 
method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the top of the class, add two new constants below the existing PARAMETER_FIELD_NAME constant added 

during the previous tutorial.

 Private Const SUBREPORT_PARAMETER_FIELD_NAME As String = "OrderDateRange"
Private Const SUBREPORT_NAME As String = "CustomerOrders" 
 private const string SUBREPORT_PARAMETER_FIELD_NAME = "OrderDateRange";
private const string SUBREPORT_NAME = "CustomerOrders"; 

4. At the bottom of the class, create a new private method named SetDateRangeForOrders() with three 
parameters: ReportDocument, a string startDate, and a string endDate.

 Private Sub SetDateRangeForOrders(ByVal myReportDocument As ReportDocument, 
ByVal startDate As String, ByVal endDate As String)
End Sub 
 private void SetDateRangeForOrders(ReportDocument reportDocument, string 
startDate, string endDate)
{
} 

5. Within this method, declare and instantiate the ParameterRangeValue class.

 Dim myParameterRangeValue As ParameterRangeValue = New
ParameterRangeValue() 
 ParameterRangeValue parameterRangeValue = new
ParameterRangeValue(); 

Note
For the ParameterRangeValue class to be accessible, you must include an "Imports" [Visual Basic] 
or "using" [C#] statement at the top of the code-behind class for the CrystalDecisions.Shared 
namespace. (You added this declaration in Project Setup [page 15].)
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6. Set the StartValue property of the ParameterRangeValue instance to the startDate method parameter.

 myParameterRangeValue.StartValue = startDate 
 parameterRangeValue.StartValue = startDate; 

Note
The StartValue and EndValue properties of the ParameterRangeValue class accept values of type Object. 
This generic type allows the range value that is passed in to be of many types, including: text, number, 
date, currency, or time.

7. Set the EndValue property of the ParameterRangeValue instance to the endDate method parameter.

 myParameterRangeValue.EndValue = endDate 
 parameterRangeValue.EndValue = endDate; 

8. Set the lower and upper boundaries to be bound-inclusive.

 myParameterRangeValue.LowerBoundType = RangeBoundType.BoundInclusive
myParameterRangeValue.UpperBoundType = RangeBoundType.BoundInclusive 
 parameterRangeValue.LowerBoundType = RangeBoundType.BoundInclusive;
parameterRangeValue.UpperBoundType = RangeBoundType.BoundInclusive; 

Note
For BoundInclusive, the upper and lower range values are included in the range.

You are now ready to assign the ParameterRangeValue instance to the parameter of the subreport.
9. Retrieve the ParameterFieldDefinitions object, which comes from the DataDefinition property of 

the ReportDocument instance.

Note
ParameterFieldDefinitions is an indexed class that contains instances of the 
ParameterFieldDefinition class.

 Dim myParameterFieldDefinitions As ParameterFieldDefinitions = 
myReportDocument.DataDefinition.ParameterFields 
 ParameterFieldDefinitions parameterFieldDefinitions = 
reportDocument.DataDefinition.ParameterFields; 

10. Retrieve the ParameterFieldDefinition instance from the ParameterFieldDefinitions indexed 
class, which is based on two indexed values: the subreport parameter field name and the subreport name. 
Pass in the two constant values that you declared at the top of the class.

 Dim myParameterFieldDefinition As ParameterFieldDefinition = 
myParameterFieldDefinitions(SUBREPORT_PARAMETER_FIELD_NAME,
SUBREPORT_NAME) 
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ParameterFieldDefinition parameterFieldDefinition = 
parameterFieldDefinitions[SUBREPORT_PARAMETER_FIELD_NAME,
SUBREPORT_NAME]; 

11. Call the Clear() method of the CurrentValues property of the ParameterFieldDefinition instance to 
remove any existing values from the CurrentValues property.

 myParameterFieldDefinition.CurrentValues.Clear() 
 parameterFieldDefinition.CurrentValues.Clear(); 

12. Add the ParameterRangeValue instance, which you created earlier, to the CurrentValues property of the 
ParameterFieldDefinition instance.

 myParameterFieldDefinition.CurrentValues.Add(myParameterRangeValue) 
 parameterFieldDefinition.CurrentValues.Add(parameterRangeValue); 

13. Call the ApplyCurrentValues() method, passing into it the CurrentValues property of the 
ParameterFieldDefinition instance.

 myParameterFieldDefinition.ApplyCurrentValues(myParameterFieldDefinition.CurrentV
alues) 
 parameterFieldDefinition.ApplyCurrentValues(parameterFieldDefinition.CurrentValue
s); 

This step procedure has set start and end date values into a ParameterRangeValue instance and passed those 
values to the OrderDateRange parameter in the CustomerOrders subreport.

1.5.2.6.3 Adding TextBox Controls to Hold Range Parameter 
Values

In this section, you add two TextBox controls to provide start and end date values at runtime to the 
OrderDateRange range parameter in the CustomerOrders subreport.

Note
If you implement this tutorial in a Web Site, the persistence of date values that users enter into the text boxes 
are maintained by ViewState.

1.5.2.6.3.1  To create and configure a redisplay Button on the 
form

1. Open the Web or Windows form.
2. From the View menu, click Designer.
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3. If you are developing a Web Site, do the following:
a. Click between the ListBox control and the Button control.
b. Press ENTER three times to create two rows between the ListBox control and the Button control.
c. In the first row created below the ListBox control, type "Order Start Date."
d. In the second row created below the ListBox control, type "Order End Date."

4. If you are developing a Windows project, do the following:
a. From the Toolbox, drag two Label controls to the right of the ListBox control. Place one label above the 

other, with both of them above the Button control.
b. Select the first Label control. From the Properties window, set the Text property to "Order Start Date."
c. Select the second Label control. From the Properties window, set the Text property to "Order End Date."

5. From the Toolbox, drag a TextBox control to the right of "Order Start Date."
6. Click on the TextBox control to select it.
7. From the Properties window, set the ID (or Name) to "orderStartDate."
8. From the Toolbox, drag a TextBox control to the right of "Order End Date."
9. Click on the TextBox control to select it.
10. From the Properties window, set the ID (or Name) to "orderEndDate."
11. From the File menu, select Save All.

1.5.2.6.4 Modifying Methods to Call the Subreport

You must now modify the ConfigureCrystalReports() method and the redisplay_Click() event method 
to receive information from these TextBox controls and apply them to the SetDateRangeForOrders() 
method, to have the parameter information processed for subreports.

In the previous tutorial, Tutorial: Reading and Setting Discrete Parameters [page 326], you designed these 
methods in two different ways, depending on whether you included Session persistence.

Note
Windows projects do not require Session persistence. Web Sites typically require Session persistence.

Choose from one (but not both) of the step procedures below. Either modify the methods that exclude Session 
persistence, or modify the methods that include Session persistence.

1.5.2.6.4.1  Modifying Methods that Exclude Session 
Persistence

If you created the previous tutorial Tutorial: Reading and Setting Discrete Parameters [page 326] and excluded 
Session persistence, work through the following procedures. If you want to include Session persistence, see 
Modifying Methods that Include Session Persistence [page 357].
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1.5.2.6.4.1.1  To modify the ConfigureCrystalReports() method 
that excludes Session persistence

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code after the lines which 
assign "Paris" and "Tokyo" as ArrayList variables.

2. Within the line breaks, declare and set hard-coded values for two string variables, startDate and endDate.

 Dim startDate As String = "8/1/1997"
Dim endDate As String = "8/31/1997" 
 string startDate = "8/1/1997";
string endDate = "8/31/1997"; 

3. Create a couple of line breaks in the code above the line that binds the report to the CrystalReportViewer 
control.

4. Within the line breaks, enter a call to the SetDateRangeForOrders() method and pass in the 
CustomersByCity report and the startDate and endDate variables.

 SetDateRangeForOrders(customersByCityReport, startDate, endDate) 
 SetDateRangeForOrders(customersByCityReport, startDate, endDate); 

This is followed by the original code that binds the report to the CrystalReportViewer control.
5. From the File menu, select Save All.

Next, you modify the redisplay_Click event method.

1.5.2.6.4.1.2  To modify the redisplay_Click() method that 
excludes Session persistence

1. In the redisplay_Click() event method, create a couple of line breaks in the code above the line that binds 
the report to the CrystalReportViewer control.

2. Within the line breaks, declare and set values for two string variables, startDate and endDate, from the 
TextBox controls that you added to the Web or Windows form.

 Dim startDate As String = orderStartDate.Text
Dim endDate As String = orderEndDate.Text 
 string startDate = orderStartDate.Text;
string endDate = orderEndDate.Text; 

3. Enter a call to the SetDateRangeForOrders() method and pass in the CustomersByCity report and the 
startDate and endDate variables.

 SetDateRangeForOrders(customersByCityReport, startDate, endDate) 
 SetDateRangeForOrders(customersByCityReport, startDate, endDate); 

4. From the File menu, select Save All.
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1.5.2.6.4.2  Modifying Methods that Include Session 
Persistence

If you created the previous tutorial Tutorial: Reading and Setting Discrete Parameters [page 326] and included 
Session persistence, work through the following procedures. Otherwise, continue to Modifying Methods that 
Exclude Session Persistence [page 355].

1.5.2.6.4.2.1  To modify the ConfigureCrystalReports() method 
that includes Session persistence

1. In the ConfigureCrystalReports() method, create a couple of line breaks in the code after the line that 
declares and instantiates ArrayList.

2. Within the line breaks, declare two string variables, startDate and endDate.

 Dim startDate As String
Dim endDate As String 
 string startDate;
string endDate; 

3. Within the Not IsPostBack conditional block, enter default values for the startDate and endDate variables.

 startDate = "8/1/1997"
endDate = "8/31/1997" 
 startDate = "8/1/1997";
endDate = "8/31/1997"; 

4. Within the Not IsPostBack conditional block, assign the startDate and endDate variables into Session.

 Session("startDate") = startDate
Session("endDate") = endDate 
 Session["startDate"] = startDate;
Session["endDate"] = endDate; 

5. Within the Else block, after the ArrayList instance is retrieved from Session, retrieve the startDate and 
endDate variables from Session.

 startDate = Session("startDate").ToString()
endDate = Session("endDate").ToString() 
 startDate = Session["startDate"].ToString();
endDate = Session["endDate"].ToString(); 

With that approach, you reach the end of the block with the date variables assigned in either case. This follows 
parallel logic to the assignment of the ArrayList variable that you configured in the previous tutorial.

6. Create a couple of line breaks in the code above the line that binds the report to the CrystalReportViewer 
control.
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7. Within these new line breaks, enter a call to the SetDateRangeForOrders() method and pass in the 
CustomersByCity report and the startDate and endDate variables.

 SetDateRangeForOrders(customersByCityReport, startDate, endDate) 
 SetDateRangeForOrders(customersByCityReport, startDate, endDate); 

This is followed by the original code that binds the report to the CrystalReportViewer control.
8. From the File menu, select Save All.

Next, you modify the redisplay_Click event method.

1.5.2.6.4.2.2  To modify the redisplay_Click() method that 
includes Session persistence

1. In the redisplay_Click() event method, create a couple of line breaks in the code after the line that 
assigns the ArrayList instance to Session.

2. Within the line breaks, assign the Text property of the orderStartDate TextBox and the orderEndDate TextBox 
to Session variables.

 Session("startDate") = orderStartDate.Text
Session("endDate") = orderEndDate.Text 
 Session["startDate"] = orderStartDate.Text;
Session["endDate"] = orderEndDate.Text; 

3. From the File menu, select Save All.
Those startDate and endDate Session values are now retrieved and applied when the 
ConfigureCrystalReports() method is called.

You are now ready to build and run the project, to verify that the TextBox values are resetting the range parameter 
in the subreport. w

1.5.2.6.5 Testing the Setting of the Subreport Parameter

You are now ready to test the setting of the subreport parameter from the TextBox values.

1.5.2.6.5.1  To test the setting of the subreport parameter

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. In the ListBox control, CTRL-click to select at least four different cities in the list.
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5. In the startDate TextBox control, enter "1/1/1997."
6. In the endDate TextBox control, enter "12/31/1997."
7. Click the Redisplay Report button.

The page reloads and displays the customer records for customers who live in the list of cities that have just 
been selected, as well as a subreport that displays orders for the date range specified above.

8. In the CrystalReportViewer control, increase the Zoom level to 125%.
The page reloads at 125% zoom. The values that are selected for both cities and order date range are 
persisted.

9. Return to Visual Studio and click Stop to exit from debug mode.

1.5.2.6.6 Addendum: Enhancements to the Range 
Parameters Code for Subreports

You have successfully modified your tutorial project to use a report containing a subreport, and set an order date 
range to the range parameter that is created in the subreport. In this addendum, you will learn about reading and 
setting parameters in a subreport with enhanced API features.

In the previous procedures, you learned how to create the SetDateRangeForOrders() helper method that uses 
the ParameterFieldDefinitions and ParameterFieldDefinition classes.

In this tutorial, you must remove the lines of code that uses the ParameterFieldDefinitions and 
ParameterFieldDefinition classes. Then, you learn how to use the ParameterFields and 
ParameterField classes of the enhanced SAP Crystal Reports API to code the SetDateRangeForOrders() 
method.

Note
The enhanced API includes the SetParameterValue(string parameterFieldName, object value, 
string subreport) method for subreports with discrete parameter fields. Therefore, 
SetParameterValue() cannot be used in this tutorial because the subreport has a range parameter.

1.5.2.6.6.1  To use the enhanced SAP Crystal Reports API for 
Subreports with Range Parameters

You must create a project based on the instructions in Tutorial: Reading and Setting Parameters with a Subreport 
[page 348].

1. Open the completed project for this tutorial.
2. Open the Web or Windows Form.
3. From the View menu, click Code.
4. Within the SetDateRangeForOrders() method, delete the lines of code that use the 

ParameterFieldDefinitions or ParameterFieldDefinition classes. Delete the following lines of code:

 Dim myParameterFieldDefinitions As ParameterFieldDefinitions = 
myReportDocument.DataDefinition.ParameterFields
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Dim myParameterFieldDefinition As ParameterFieldDefinition = 
myParameterFieldDefinitions(SUBREPORT_PARAMETER_FIELD_NAME, SUBREPORT_NAME)
myParameterFieldDefinition.CurrentValues.Clear()
myParameterFieldDefinition.CurrentValues.Add(myParameterRangeValue)
myParameterFieldDefinition.ApplyCurrentValues(myParameterFieldDefinition.CurrentV
alues) 
 ParameterFieldDefinitions parameterFieldDefinitions = 
reportDocument.DataDefinition.ParameterFields;
ParameterFieldDefinition parameterFieldDefinition = 
parameterFieldDefinitions[SUBREPORT_PARAMETER_FIELD_NAME, SUBREPORT_NAME];
parameterFieldDefinition.CurrentValues.Clear();
parameterFieldDefinition.CurrentValues.Add(parameterRangeValue);
parameterFieldDefinition.ApplyCurrentValues(parameterFieldDefinition.CurrentValue
s); 

In the next step, you add the new SAP Crystal Reports API methods to the SetDateRangeForOrders() method, 
after the code that sets the range bound type.

5. Within the SetDateRangeForOrders() method, retrieve the ParameterFields instance from the 
ParameterFields property of the ReportDocument instance.

 Dim myParameterFields As ParameterFields = reportDocument.ParameterFields 
 ParameterFields parameterFields = reportDocument.ParameterFields; 

6. Retrieve the ParameterField instance from the ParameterFields indexed class, which is based on two indexed 
values: the subreport parameter field name and the subreport name. Pass in the two constant values that you 
declared at the top of the class.

 Dim myParameterField As ParameterField = 
myParameterFields(SUBREPORT_PARAMETER_FIELD_NAME, SUBREPORT_NAME) 
 ParameterField parameterField = parameterFields[SUBREPORT_PARAMETER_FIELD_NAME, 
SUBREPORT_NAME]; 

7. Call the Clear() method of the CurrentValues property of the ParameterField instance to remove any 
existing values from the CurrentValues property.

 myParameterField.CurrentValues.Clear() 
 parameterField.CurrentValues.Clear(); 

8. Add the ParameterRangeValue instance, which you created earlier, to the CurrentValues property of the 
ParameterField instance.

 myParameterField.CurrentValues.Add(myParameterRangeValue) 
 parameterField.CurrentValues.Add(parameterRangeValue); 

You are now ready to build and run the project, to read and set range parameters for a subreport.
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1.5.2.7 Tutorial: Exporting to Multiple Formats

In this tutorial, you learn how to export the report programmatically.

Introduction

In this tutorial, you learn how to export the report programmatically. SAP Crystal Reports can export to a wide 
variety of formats. The options available to you depend on the version of SAP Crystal Reports that you have 
installed.

Every version of SAP SAP Crystal Reports, developer version for Microsoft Visual Studio supports the following 
export options:

● SAP Crystal Reports (RPT)
● SAP Crystal Reports Read-Only (RPTR)
● PDF
● Rich Text Format (RTF)
● Microsoft Word (97-2003)
● Microsoft Excel (97-2003)
● Microsoft Excel (97-2003) Data-Only
● Microsoft Excel (2007) Data-Only
● HTML 4.0

SAP Crystal Reports Developer supports these additional formats:

● Seperated Values (CSV)
● Microsoft Word - Editable (RTF)
● Tab Separated Text (TTX)
● Text

You can select any of those formats, click the Export button for the CrystalReportViewer control, and export a 
report in the selected format to your local machine that runs SAP Crystal Reports in a Web or Windows 
application.

You can also export reports programmatically, to specific directories on the local Web server or Windows 
machine.

To begin this tutorial, you add a DropDownList control to your Web or Windows Form, and then populate it with 
the values from the ExportFormatType enum in the CrystalDecisions.Shared namespace.

Then, you create three private helper methods that contain the export functionality and that perform specific 
configuration for each of the export formats.

Finally, you create a click event method from a Button control on the Web or Windows Form, and call the three 
private helper methods that perform the export.
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Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_RDObjMod_Export
● C# Windows project: CS_Win_RDObjMod_Export
● Visual Basic Web Site: VB_Web_RDObjMod_Export
● Visual Basic Windows project: VB_Win_RDObjMod_Export

Related Information

Sample Reports Directory [page 14]

1.5.2.7.1 Adding Controls to the Web or Windows Form

In this section, you add a DropDownList, Button, and Label control above the CrystalReportViewer control on the 
Web or Windows Form.

1.5.2.7.1.1  To add controls to the Web or Windows Form

1. Open the Web or Windows Form.
2. From the View menu, click Designer.
3. If you are developing a Web Site, do the following:

a. Click the CrystalReportViewer control to select it.
b. Press the LEFT ARROW on your keyboard so that a flashing cursor appears, and then press ENTER.

The CrystalReportViewer control drops by one line.
4. If you are developing a Windows project, do the following:

a. Click the CrystalReportViewer control to select it.
b. Resize the CrystalReportViewer control, so that you leave enough room above it for a ComboBox control.
c. From the Properties window, set Anchor to "Top, Bottom, Left, Right."

5. From the Toolbox, drag a DropDownList control (in Web Sites) or ComboBox control (in Windows projects) 
above the CrystalReportViewer control.
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Note
If a Smart Task appears on the DropDownList (ComboBox) when you use Visual Studio 2005 or later, 
press Esc to close it.

6. Click the DropDownList (ComboBox) control to select it.
7. From the Properties window, set the ID property to "exportTypesList."
8. From the Toolbox, drag a Button control to the right of the DropDownList (ComboBox) control.
9. Click the Button control to select it.
10. From the Properties window, do the following:

○ Set the ID property to "exportByType."
○ Set the Text property to "Export As Selected Type."

11. From the Toolbox, drag a Label control to the right of the Button control.
12. Click the Label control to select it.
13. From the Properties window, do the following:

○ Set the ID property to "message."
○ Set the Text property to be blank.
○ Set the Visible property to "False."

14. From the File menu, select Save All.

Now you must populate the DropDownList control from the ExportFormatType enum of the 
CrystalDecisions.Shared namespace.

1.5.2.7.1.2  To populate the DropDownList control from the 
ExportFormatType enum for a Web Site

1. Open the Web Form.
2. From the View menu, click Code.
3. Within the ConfigureCrystalReports() method, at the bottom of the method, add a Not IsPostBack 

conditional block.

 If Not IsPostBack Then
End If 
 if (!IsPostBack)
{
} 

4. Within the conditional block, set the DataSource property of the exportTypesList ComboBox control to the 
values of ExportFormatType enum.

 exportTypesList.DataSource = System.Enum.GetValues(GetType(ExportFormatType)) 
 exportTypesList.DataSource = System.Enum.GetValues(typeof(ExportFormatType)); 

5. Call the DataBind() method of the exportTypesList DropDownList control to bind the values to the control.
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exportTypesList.DataBind() 
 exportTypesList.DataBind(); 

1.5.2.7.1.3  To populate the DropDownList control from the 
ExportFormatType enum for a Windows project

1. Open the Windows Form.
2. From the View menu, click Code.
3. Within the ConfigureCrystalReports() method, at the bottom of the method, set the DataSource 

property of the exportTypesList ComboBox control to the values of the ExportFormatType enum.

 exportTypesList.DataSource = System.Enum.GetValues(GetType(ExportFormatType)) 
 exportTypesList.DataSource = System.Enum.GetValues(typeof(ExportFormatType)); 

1.5.2.7.2 Creating Methods that Perform the Export

In this section, you create the following private helper methods that perform the export.

● ExportSetup()
● ExportSelection()
● ExportCompletion()

These methods are called later in this tutorial from a button click event method. To begin, you create the 
ExportSetup() helper method.

1.5.2.7.2.1  To create the ExportSetup() method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the top of the class, add three class declarations.

 Private exportPath As String
Private myDiskFileDestinationOptions As DiskFileDestinationOptions
Private myExportOptions As ExportOptions 
 private string exportPath;
private DiskFileDestinationOptions diskFileDestinationOptions;
private ExportOptions exportOptions; 

You later instantiate those helper classes in the ExportSetup() method.
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4. At the bottom of the class, create a private helper method named ExportSetup() with no return value.

 Public Sub ExportSetup()
End Sub 
 private void ExportSetup()
{
} 

5. Within the method, set the exportPath string variable to the root directory of the hard drive.

 exportPath = "C:\Exported\" 
 exportPath = "C:\\Exported\\"; 

Note
If you want to place the Exported folder within the Web directory of your Web server, prefix the folder name 
with the Request.PhysicalApplicationPath property.

6. Create a conditional block that tests whether the directory in the exportPath string already exists.

 If Not System.IO.Directory.Exists(exportPath) Then
End If 
 if (!System.IO.Directory.Exists(exportPath))
{
} 

7. Within the conditional block, call the CreateDirectory() method of System.IO.Directory to create the 
directory in the exportPath string.

 System.IO.Directory.CreateDirectory(exportPath) 
 System.IO.Directory.CreateDirectory(exportPath); 

8. Outside the conditional block, instantiate the DiskFileDesintationOptions class.

 myDiskFileDestinationOptions = New DiskFileDestinationOptions() 
 diskFileDestinationOptions = new DiskFileDestinationOptions(); 

9. Populate the ExportOptions instance with the ExportOptions property of the hierarchicalGroupingReport 
instance.

 myExportOptions = hierarchicalGroupingReport.ExportOptions 
 exportOptions = hierarchicalGroupingReport.ExportOptions; 

10. Set the ExportDestinationType property of the ExportOptions instance to the enum selection 
ExportDestinationType.DiskFile.

 myExportOptions.ExportDestinationType = ExportDestinationType.DiskFile 
 exportOptions.ExportDestinationType = ExportDestinationType.DiskFile; 
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11. For a Windows project, clear the values in the ExportFormatOptions property of the ExportOptions instance. 
(That line of code is not needed for a Web Site because the variable is automatically cleared on each click 
event.)

 myExportOptions.ExportFormatOptions = Nothing 
 exportOptions.ExportFormatOptions = null; 

You now create the ExportSelection() helper method.

1.5.2.7.2.2  To create the ExportSelection() method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the top of the class, add a Boolean declaration that is used to test if no export format is selected.

 Private selectedNoFormat As Boolean = True 
 private bool selectedNoFormat = true; 

4. At the bottom of the class, create a private helper method named ExportSelection() with no return value.

 Public Sub ExportSelection()
End Sub 
 private void ExportSelection()
{
} 

5. Within the method, create a "Select Case" [Visual Basic] or "switch" [C#] statement that 
references the members of the ExportFormatType enum. The enum is based on the SelectedIndex of the 
exportTypesList DropDownList control that you created in the previous procedure.

 Select Case exportTypesList.SelectedIndex
    Case ExportFormatType.NoFormat
    Case ExportFormatType.CrystalReport
    Case ExportFormatType.RichText
    Case ExportFormatType.WordForWindows
    Case ExportFormatType.Excel
    Case ExportFormatType.PortableDocFormat
    Case ExportFormatType.HTML32
    Case ExportFormatType.HTML40
    Case Else
End Select 
 switch ((ExportFormatType)exportTypesList.SelectedIndex)
{
   case ExportFormatType.NoFormat:
      break;
   case ExportFormatType.CrystalReport:
      break;
   case ExportFormatType.RichText:
      break;
   case ExportFormatType.WordForWindows:
      break;
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   case ExportFormatType.Excel:
      break;
   case ExportFormatType.PortableDocFormat:
      break;
   case ExportFormatType.HTML32:
      break;
   case ExportFormatType.HTML40:
      break;
   default:
      break;
} 

You have completed the ExportSelection() method. You now create the ExportCompletion() helper 
method.

1.5.2.7.2.3  To create the ExportCompletion() method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the bottom of the class, create a private helper method named ExportCompletion() with no return 

value.

 Public Sub ExportCompletion()
End Sub 
 private void ExportCompletion()
{
} 

4. Within the method, create a try/catch block with the Exception class that is referenced as a variable named 
"ex."

 Try
Catch ex As Exception
End Try 
 try
{
}
catch (Exception ex)
{
} 

5. Within the try block, create a conditional block to test the Boolean variable selectedNoFormat.

 If selectedNoFormat Then
Else
End If 
 if (selectedNoFormat)
{
}
else
{
} 
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6. Within the If block, set the Text property of the message Label control to the FORMAT_NOT_SUPPORTED 
constant of the MessageConstants class.

 message.Text = MessageConstants.FORMAT_NOT_SUPPORTED 
 message.Text = MessageConstants.FORMAT_NOT_SUPPORTED; 

7. Within the Else block, call the Export() method of the hierarchicalGroupingReport instance.

 hierarchicalGroupingReport.Export() 
 hierarchicalGroupingReport.Export(); 

8. Still within the Else block, set the Text property of the message Label control to the SUCCESS constant of the 
MessageConstants class.

 message.Text = MessageConstants.SUCCESS 
 message.Text = MessageConstants.SUCCESS; 

9. Within the catch block, set the Text property of the message Label control to the FAILURE constant of the 
MessagesConstants class, and then append to it the Message property of the Exception parameter.

 message.Text = MessageConstants.FAILURE & ex.Message 
 message.Text = MessageConstants.FAILURE + ex.Message; 

10. Outside the try/catch block, set the Visible property of the message Label control to "True."

 message.Visible = True 
 message.Visible = true; 

You have finished creating the three private helper methods that perform the export.

1.5.2.7.3 Creating Methods That Configure Multiple Export 
Formats

In this section, you create the private helper methods that configure the multiple export formats. All of these 
method are used similarly, except for ConfigureExportToHtml32() and ConfigureExportToHtml40(), which offer 
different ways to export to the HTML format.

● ConfigureExportToRpt()
● ConfigureExportToRtf()
● ConfigureExportToDoc()
● ConfigureExportToXls()
● ConfigureExportToPdf()
● ConfigureExportToHtml32()
● ConfigureExportToHtml40()
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1.5.2.7.3.1  To create the ConfigureExportToRpt() helper 
method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the bottom of the class, create a private helper method named ConfigureExportToRpt() with no return 

value.

 Public Sub ConfigureExportToRpt()
End Sub 
 private void ConfigureExportToRpt()
{
} 

4. Within the method, set the ExportFormatType property of the ExportOptions instance to the 
ExportFormatType enum selection CrystalReport.

 myExportOptions.ExportFormatType = ExportFormatType.CrystalReport 
 exportOptions.ExportFormatType = ExportFormatType.CrystalReport; 

5. Set the DiskFileName property of the DiskFileDestinationOptions instance to the exportPath string, 
and then follow it with the name of a document that has an .rpt file extension.

 myDiskFileDestinationOptions.DiskFileName = exportPath &
"Report.rpt" 
 diskFileDestinationOptions.DiskFileName = exportPath +
"Report.rpt"; 

6. Finally, set the ExportDestinationOptions property of the ExportOptions instance to the 
DiskFileDestinationOptions instance that you have configured in the previous step.

 myExportOptions.ExportDestinationOptions = myDiskFileDestinationOptions 
 exportOptions.ExportDestinationOptions = diskFileDestinationOptions; 

1.5.2.7.3.2  To create the ConfigureExportToRtf helper method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the bottom of the class, create a private helper method named ConfigureExportToRtf() with no return 

value.

 Public Sub ConfigureExportToRtf()
End Sub 
 private void  
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ConfigureExportToRtf() {
} 

4. Within the method, set the ExportFormatType property of the ExportOptions instance to the 
ExportFormatType enum selection RichText.

 myExportOptions.ExportFormatType = ExportFormatType.RichText 
 exportOptions.ExportFormatType = ExportFormatType.RichText; 

5. Set the DiskFileName property of the DiskFileDestinationOptions instance to the exportPath string, and then 
follow it with the name of a document that has an .rtf file extension.

 myDiskFileDestinationOptions.DiskFileName = exportPath & "RichTextFormat.rtf" 
 diskFileDestinationOptions.DiskFileName = exportPath + "RichTextFormat.rtf"; 

6. Finally, set the ExportDestinationOptions property of the ExportOptions instance to the 
DiskFileDestinationOptions instance that you have configured in the previous step.

 myExportOptions.ExportDestinationOptions = myDiskFileDestinationOptions 
 exportOptions.ExportDestinationOptions = diskFileDestinationOptions; 

1.5.2.7.3.3  To create the ConfigureExportToDoc helper method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the bottom of the class, create a private helper method named ConfigureExportToDoc() with no return 

value.

 Public Sub ConfigureExportToDoc()
End Sub 
 private void  ConfigureExportToDoc() {
} 

4. Within the method, set the ExportFormatType property of the ExportOptions instance to the 
ExportFormatType enum selection WordForWindows.

 myExportOptions.ExportFormatType = ExportFormatType.WordForWindows 
 exportOptions.ExportFormatType = ExportFormatType.WordForWindows; 

5. Set the DiskFileName property of the DiskFileDestinationOptions instance to the exportPath string, and then 
follow it with the name of a document that has a .doc file extension.

 myDiskFileDestinationOptions.DiskFileName = exportPath &
"Word.doc" 
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 diskFileDestinationOptions.DiskFileName = exportPath + "Word.doc"; 
6. Finally, set the ExportDestinationOptions property of the ExportOptions instance to the 

DiskFileDestinationOptions instance that you have configured in the previous step.

 myExportOptions.ExportDestinationOptions = myDiskFileDestinationOptions 
 exportOptions.ExportDestinationOptions = diskFileDestinationOptions; 

1.5.2.7.3.4  To create the ConfigureExportToXls helper method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the bottom of the class, create a private helper method named ConfigureExportToXls() with no return 

value.

 Public Sub ConfigureExportToXls()
End Sub 
 private void  ConfigureExportToXls() {
} 

4. Within the method, set the ExportFormatType property of the ExportOptions instance to the 
ExportFormatType enum selection Excel.

 myExportOptions.ExportFormatType = ExportFormatType.Excel 
 exportOptions.ExportFormatType = ExportFormatType.Excel; 

5. Set the DiskFileName property of the DiskFileDestinationOptions instance to the exportPath string, and then 
follow it with the name of a document that has an .xls file extension.

 myDiskFileDestinationOptions.DiskFileName = exportPath & "Excel.xls" 
 diskFileDestinationOptions.DiskFileName = exportPath + "Excel.xls"; 

6. Finally, set the ExportDestinationOptions property of the ExportOptions instance to the 
DiskFileDestinationOptions instance that you have configured in the previous step.

 myExportOptions.ExportDestinationOptions = myDiskFileDestinationOptions 
 exportOptions.ExportDestinationOptions = diskFileDestinationOptions; 

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 371



1.5.2.7.3.5  To create the ConfigureExportToPdf helper method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the bottom of the class, create a private helper method named ConfigureExportToPdf() with no return 

value.

 Public Sub ConfigureExportToPdf()
End Sub 
 private void  ConfigureExportToPdf() {
} 

4. Within the method, set the ExportFormatType property of the ExportOptions instance to the 
ExportFormatType enum selection PortableDocFormat.

 myExportOptions.ExportFormatType = ExportFormatType.PortableDocFormat 
 exportOptions.ExportFormatType = ExportFormatType.PortableDocFormat; 

5. Set the DiskFileName property of the DiskFileDestinationOptions instance to the exportPath string, and then 
follow it with the name of a document that has a .pdf file extension.

 myDiskFileDestinationOptions.DiskFileName = exportPath & "PortableDoc.pdf" 
 diskFileDestinationOptions.DiskFileName = exportPath + "PortableDoc.pdf"; 

6. Finally, set the ExportDestinationOptions property of the ExportOptions instance to the 
DiskFileDestinationOptions instance that you have configured in the previous step.

 myExportOptions.ExportDestinationOptions = myDiskFileDestinationOptions 
 exportOptions.ExportDestinationOptions = diskFileDestinationOptions; 

1.5.2.7.3.6  To create the ConfigureExportToHtml32 helper 
method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the bottom of the class, create a private helper method named ConfigureExportToHtml32() with no 

return value.

 Public Sub ConfigureExportToHtml32()
End Sub 
 private void  ConfigureExportToHtml32() 
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{
} 

4. Within the method, set the ExportFormatType property of the ExportOptions instance to the 
ExportFormatType enum selection HTML32.

 myExportOptions.ExportFormatType = ExportFormatType.HTML32 
 exportOptions.ExportFormatType = ExportFormatType.HTML32; 

5. Declare and instantiate the HTMLFormatOptions class with the variable name "html32FormatOptions."

 Dim html32FormatOptions As HTMLFormatOptions = New
HTMLFormatOptions() 
 HTMLFormatOptions html32FormatOptions = new HTMLFormatOptions(); 

6. Set the HTMLBaseFolderName property of the html32FormatOptions instance to the exportPath string, and 
the name "Html32Folder."

 html32FormatOptions.HTMLBaseFolderName = exportPath &
"Html32Folder" 
 html32FormatOptions.HTMLBaseFolderName = exportPath +
"Html32Folder"; 

7. Set the HTMLFileName property of the html32FormatOptions instance to the name "html32.html."

 html32FormatOptions.HTMLFileName = "html32.html" 
 html32FormatOptions.HTMLFileName = "html32.html"; 

8. Set the HTMLEnableSeparatedPage property of the html32FormatOptions instance to be "False."

 html32FormatOptions.HTMLEnableSeparatedPages = False 
 html32FormatOptions.HTMLEnableSeparatedPages = false; 

9. Set the HTMLHasPageNavigator property of the html32FormatOptions instance to be "False."

 html32FormatOptions.HTMLHasPageNavigator = False 
 html32FormatOptions.HTMLHasPageNavigator = false; 

10. Finally, assign the html32FormatOptions instance to the FormatOptions property of the ExportOptions 
instance.

 myExportOptions.ExportFormatOptions = html32FormatOptions 
 exportOptions.ExportFormatOptions = html32FormatOptions; 
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1.5.2.7.3.7  To create the ConfigureExportToHtml40 helper 
method

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. At the bottom of the class, create a private helper method named ConfigureExportToHtml40() with no 

return value.

 Public Sub ConfigureExportToHtml40()
End Sub 
 private void  ConfigureExportToHtml40() {
} 

4. Within the method, set the ExportFormatType property of the ExportOptions instance to the 
ExportFormatType enum selection HTML40.

 myExportOptions.ExportFormatType = ExportFormatType.HTML40 
 exportOptions.ExportFormatType = ExportFormatType.HTML40; 

5. Declare and instantiate the HTMLFormatOptions class with the variable name "html40FormatOptions."

 Dim html40FormatOptions As HTMLFormatOptions = New
HTMLFormatOptions() 
 HTMLFormatOptions html40FormatOptions = new HTMLFormatOptions(); 

6. Set the HTMLBaseFolderName property of the html40FormatOptions instance to the exportPath string and 
the name "Html40Folder."

 html40FormatOptions.HTMLBaseFolderName = exportPath &
"Html40Folder" 
 html40FormatOptions.HTMLBaseFolderName = exportPath +
"Html40Folder"; 

7. Set the HTMLFileName property of the html40FormatOptions instance to the name "html40.html."

 html40FormatOptions.HTMLFileName = "html40.html" 
 html40FormatOptions.HTMLFileName = "html40.html"; 

8. Set the HTMLEnableSeparatedPage property of the html40FormatOptions instance to "True."

 html40FormatOptions.HTMLEnableSeparatedPages = True 
 html40FormatOptions.HTMLEnableSeparatedPages = true; 

9. Set the HTMLHasPageNavigator property of the html40FormatOptions instance to be "True."

 html40FormatOptions.HTMLHasPageNavigator = True 
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 html40FormatOptions.HTMLHasPageNavigator = true; 
10. Set the FirstPageNumber property of the html40FormatOptions instance to 1.

 html40FormatOptions.FirstPageNumber = 1 
 html40FormatOptions.FirstPageNumber = 1; 

11. Set the LastPageNumber property of the html40FormatOptions instance 3.

 html40FormatOptions.LastPageNumber = 3 
 html40FormatOptions.LastPageNumber = 3; 

12. Finally, assign the html40FormatOptions instance to the FormatOptions property of the ExportOptions 
instance.

 myExportOptions.FormatOptions = html40FormatOptions 
 exportOptions.FormatOptions = html40FormatOptions; 

You have created the private helper methods that configure the multiple export formats.

1.5.2.7.4 Calling the Methods from the Case Statement

In the previous lesson, you created a case statement in the ExportSelection() method, with multiple cases. 
Each case is linked to a selection from the ExportFormatType enum. You now call each of the configuration 
methods from the corresponding case, as well as set the value of the Boolean variable selectedNoFormat.

1.5.2.7.4.1  To call the methods from the case statement

1. Locate the ExportSelection() method that you created in the previous lesson.

2. Within the Select Case [Visual Basic] or switch [C#] case statement, in the case for 
ExportFormatType.NoFormat, set the selectedNoFormat Boolean variable to True.

 selectedNoFormat = True 
 selectedNoFormat = true; 

3. Within the Select Case [Visual Basic] or switch [C#] case statement, in the case for 
ExportFormatType.CrystalReport, call the ConfigureExportToRpt() method.

 selectedNoFormat = False
ConfigureExportToRpt() 
 selectedNoFormat = false;
ConfigureExportToRpt(); 
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4. Within the Select Case [Visual Basic] or switch [C#] case statement, in the case for 
ExportFormatType.RichText, call the ConfigureExportToRtf() method.

 selectedNoFormat = False
ConfigureExportToRtf() 
 selectedNoFormat = false;
ConfigureExportToRtf(); 

5. Within the Select Case [Visual Basic] or switch [C#] case statement, in the case for 
ExportFormatType.WordForWindows, call the ConfigureExportToDoc() method.

 selectedNoFormat = False
ConfigureExportToDoc() 
 selectedNoFormat = false;
ConfigureExportToDoc(); 

6. Within the Select Case [Visual Basic] or switch [C#] case statement, in the case for 
ExportFormatType.Excel, call the ConfigureExportToXls() method.

 selectedNoFormat = False
ConfigureExportToXls() 
 selectedNoFormat = false;
ConfigureExportToXls(); 

7. Within the Select Case [Visual Basic] or switch [C#] case statement, in the case for 
ExportFormatType.PortableDocFormat, call the ConfigureExportToPdf() method.

 selectedNoFormat = False
ConfigureExportToPdf() 
 selectedNoFormat = false;
ConfigureExportToPdf(); 

8. Within the Select Case [Visual Basic] or switch [C#] case statement, in the case for 
ExportFormatType.HTML32, call the ConfigureExportToHtml32() method.

 selectedNoFormat = False
ConfigureExportToHtml32() 
 selectedNoFormat = false;
ConfigureExportToHtml32(); 

9. Within the Select Case [Visual Basic] or switch [C#] case statement, in the case for 
ExportFormatType.HTML40, call the ConfigureExportToHtml40() method.

 selectedNoFormat = False
ConfigureExportToHtml40() 
 selectedNoFormat = false;
ConfigureExportToHtml40(); 
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10. Within the Select Case [Visual Basic] or switch [C#] case statement, in the case for Switch Else 
[Visual Basic] or default: [C#], set the selectedNoFormat Boolean variable to True.

 selectedNoFormat = True 
 selectedNoFormat = true; 

If you are creating a project in Visual Studio 2005 or later, you must complete the procedures in Creating Methods 
for the New Exporting Formats [page 378] before continuing to Calling the Methods to Perform the Export [page 
377].

1.5.2.7.5 Calling the Methods to Perform the Export

You are now ready to create the button click event method for the exportByType Button control, and then call 
the methods to perform the export from that event method.

1.5.2.7.5.1  To create the exportByType_Click event method

1. Open the Web or Windows Form.
2. From the View menu, click Designer.
3. Double-click the exportByType Button control.

The exportByType_Click() event method is created and displayed in Code view.

4. Within the exportByType_Click() event method, enter calls to the three event methods that you created 
earlier to perform the export.

 ExportSetup()
ExportSelection()
ExportCompletion() 
 ExportSetup();
ExportSelection();
ExportCompletion(); 

You are now ready to build and run your project, and then export your report in multiple formats.

1.5.2.7.5.2  To test the project

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The Web or Windows application compiles and displays the Hierarchical Grouping report. A DropDownList 
control shows multiple export formats, and an Export As Selected Type button is displayed to perform the 
export.
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4. Select one of the export formats from the DropDownList control, and then click the Export As Selected Type 
button.
A message appears next to the button that indicates whether the export has been successful. If not 
successful, an error message is shown.

5. Try to export in several different formats.
6. Return to Visual Studio and click Stop to exit from debug mode.
7. Check the Exported file directory on your Web server or Windows machine to confirm that the exported files 

have been placed in the directory.

1.5.2.7.6 Addendum: Enhancements to the Exporting Code

If you have installed Visual Studio 2005 or later or SAP Crystal Reports you have access to the enhanced API for 
exporting your Crystal report to multiple formats.

In the enhanced SAP Crystal Reports API, the ExportFormatTypes enum has two new exporting formats: 
Microsoft Excel records (an .xls file that contains only the data) and text files.

In addition, you now have the following enhanced exporting methods in the ReportDocument class:

● ExportToDisk(CrystalDecisions.Shared.ExportFormatType formatType, string fileName): 
exports a report to the local drive of the Web server or to the Windows machine.

● ExportToHttpResponse(CrystalDecisions.Shared.ExportFormatType formatType, 
System.Web.HttpResponse response, bool asAttachment, string attachmentName): exports a 
report in the specified format type to a browser window, or it exports the report as an attachment.

● ExportToHttpResponse(CrystalDecisions.Shared.ExportOptions options, 
System.Web.HttpResponse response, bool asAttachment, string attachmentName): exports a 
report in the specified format type to a browser window, or it exports the report as an attachment.

● ExportToStream(CrystalDecisions.Shared.ExportFormatType formatType): exports a report's 
data in the specified format type to an input/output stream.

1.5.2.7.6.1  Creating Methods for the New Exporting Formats

In this section, you learn how to modify your project (that you have created earlier in this tutorial), to include the 
new exporting formats.

Before you modify the code to include the new exporting formats, complete all the procedures in Tutorial: 
Exporting to Multiple Formats [page 361].

1.5.2.7.6.1.1  To modify the code to include the new exporting 
formats

1. Open the completed project for this tutorial.
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2. Open the Web or Windows Form.
3. From the View menu, click Code.
4. Within the "Select Case" [Visual Basic] or "switch" [C#] statement of the ExportSelection() 

method, add a case statement for the ExcelRecord format.

 Case ExportFormatType.ExcelRecord 
 case ExportFormatType.ExcelRecord:
   break; 

Create the private helper methods that configure the multiple export formats. First, you create the 
ConfigureExportToXlsRec() method to set the ExcelRecord export options.

5. At the bottom of the class, create a private helper method named ConfigureExportToXlsRec() with no 
return value.

 Public Sub ConfigureExportToXlsRec()
End Sub 
 private void ConfigureExportToXlsRec()
{
} 

6. Within the method, set the ExportFormatType property of the ExportOptions instance to the 
ExportFormatType enum selection ExcelRecord.

 myExportOptions.ExportFormatType = ExportFormatType.ExcelRecord 
 exportOptions.ExportFormatType = ExportFormatType.ExcelRecord; 

7. Set the DiskFileName property of the DiskFileDestinationOptions instance to the exportPath string, and then 
follow it with the name of a document that has an .xls file extension.

 myDiskFileDestinationOptions.DiskFileName = exportPath & "ExcelRecord.xls" 
 diskFileDestinationOptions.DiskFileName = exportPath + "ExcelRecord.xls"; 

8. Set the ExportDestinationOptions property of the ExportOptions instance to the DiskFileDestinationOptions 
instance that you configured in the previous step.

 myExportOptions.ExportDestinationOptions = myDiskFileDestinationOptions 
 exportOptions.ExportDestinationOptions = diskFileDestinationOptions; 

You have successfully added two new exporting formats to your project.

To further explore the enhanced API, choose one of the following enhanced exporting methods:

● If you want to minimize your code and do not need to set ExportOptions, continue to Using the 
ExportToDisk() Method [page 380].

● For a Web Site, if you want to export your report to a browser window, or export the report as an attachment 
in a browser window, continue to Using the ExportToHttpResponse() Method [page 388].

● If you want pass your report's data to an input/output stream, continue to Using the ExportToStream() 
Method [page 392].
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1.5.2.7.6.2  Using the ExportToDisk() Method

The ExportToDisk() method takes an ExportFormatType and a file name parameter. This method simplifies the 
need to use the export configuration methods that you created in Creating Methods That Configure Multiple 
Export Formats [page 368].

In this section, you learn how to create a new project, how to modify an existing project, and how to add code to 
the project to use the ExportToDisk() method.

Prerequisites:

● You must create a project that is based on the instructions in Setting Up a Project for the ExportToDisk() 
Method [page 380].

● Or, you must create a project that is based on the instructions in Creating Methods for the New Exporting 
Formats [page 378].
Then, you need to modify the project as shown in Preparing the Project for the ExportToDisk() Method [page 
382].

1.5.2.7.6.2.1  Setting Up a Project for the ExportToDisk() 
Method

In this section, you learn how to create a new project for the ExportToDisk() method.

1.5.2.7.6.2.1.1  To set up a new project for the ExportToDisk() 
Method

1. Complete the instructions in Adding Controls to the Web or Windows Form [page 362].
2. Create the ExportSetup() method and the ExportSelection() method in Creating Methods that 

Perform the Export [page 364].
3. Within the "Select Case" [Visual Basic] or "switch" [C#] statement of the ExportSelection() 

method, add a case statement for the ExcelRecord format.

 Case ExportFormatType.ExcelRecord 
 case ExportFormatType.ExcelRecord:
   break; 

4. Create a conditional block to test the Boolean variable, selectedNoFormat.

 If selectedNoFormat Then
Else
End If 
 if (selectedNoFormat)
{
}
else
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{
} 

5. Within the If block, set the Text property of the message Label control to the FORMAT_NOT_SUPPORTED 
constant of the MessageConstants class.

 message.Text = MessageConstants.FORMAT_NOT_SUPPORTED 
 message.Text = MessageConstants.FORMAT_NOT_SUPPORTED; 

6. Within the Else block, set the Text property of the message Label control to the SUCCESS constant of the 
MessageConstants class.

 message.Text = MessageConstants.SUCCESS 
 message.Text = MessageConstants.SUCCESS; 

7. Create a try/catch block with the Exception class that is referenced as a variable named "ex." The try block 
encloses the "Select Case" [Visual Basic] or "switch" [C#] statement and the conditional block.

 Try
Catch ex As Exception
End Try 
 try
{
}
catch (Exception ex)
{
} 

8. Within the catch block, set the Text property of the message Label control to the FAILURE constant of the 
MessagesConstants class, and then append to it the Message property of the Exception parameter.

 message.Text = MessageConstants.FAILURE & ex.Message 
 message.Text = MessageConstants.FAILURE + ex.Message; 

9. Outside the try/catch block, set the Visible property of the message Label control to "True."

 message.Visible = True 
 message.Visible = true; 

10. From the View menu, click Designer.
11. Double-click the exportByType Button control.

The exportByType_Click() event method is created, and you are taken to the Code view.

12. Within the exportByType_Click() event method, enter calls to the ExportSetup() and ExportSelection() 
methods.

 ExportSetup()
ExportSelection() 
 ExportSetup();
ExportSelection(); 

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 381



1.5.2.7.6.2.2  Preparing the Project for the ExportToDisk() 
Method

In this section, you learn how to modify a project that is a result of the procedure in Creating Methods for the New 
Exporting Formats [page 378].

Now, you must delete certain lines of code that are not needed for the ExportToDisk() method.

1.5.2.7.6.2.2.1  To modify the project to use the ExportToDisk() 
method

1. Open the project.
2. Open the Web or Windows Form.
3. From the View menu, click Code.
4. At the top of the class, delete the following class declarations:

 Private myDiskFileDestinationOptions As DiskFileDestinationOptions
Private myExportOptions As ExportOptions 
 private DiskFileDestinationOptions diskFileDestinationOptions;
private ExportOptions exportOptions; 

5. Within the ExportSetup() method, delete all the lines of code after the conditional block. (The last line of 
code that calls the ExportFormatOptions property only occurs in a Windows project.)

 myDiskFileDestinationOptions = New DiskFileDestinationOptions()
myExportOptions = hierarchicalGroupingReport.ExportOptions
myExportOptions.ExportDestinationType = ExportDestinationType.DiskFile
myExportOptions.ExportFormatOptions = Nothing 
 diskFileDestinationOptions = new DiskFileDestinationOptions();
exportOptions = hierarchicalGroupingReport.ExportOptions;
exportOptions.ExportDestinationType = ExportDestinationType.DiskFile;
exportOptions.ExportFormatOptions = null; 

6. Delete the following export configuration methods:
○ ConfigureExportToRpt()
○ ConfigureExportToRtf()
○ ConfigureExportToDoc()
○ ConfigureExportToXls()
○ ConfigureExportToPdf()
○ ConfigureExportToHtml32()
○ ConfigureExportToHtml40()
○ ConfigureExportToXlsRec()
○ ConfigureExportToTxt()

7. Within the Select Case [Visual Basic] or switch [C#] case statements of ExportSelection(), 
delete the calls to the export configuration methods.
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8. Within the ExportCompletion() method, delete the call to the Export() method.

9. Copy and paste all the code from the ExportCompletion() method to the top of the ExportSelection() 
method.

10. Delete the ExportCompletion() method and delete the call to ExportCompletion() in the exportByType 
button click event.

11. Within the ExportSelection() method, cut and paste the Select Case [Visual Basic] or switch 
[C#] case statements above the If block within the try block.
The try/catch block now looks like the following:

 Try
    Select Case exportTypesList.SelectedIndex
        Case ExportFormatType.NoFormat
            selectedNoFormat = True
        Case ExportFormatType.CrystalReport
        Case ExportFormatType.RichText
        Case ExportFormatType.WordForWindows
        Case ExportFormatType.Excel
        Case ExportFormatType.PortableDocFormat
        Case ExportFormatType.HTML32
        Case ExportFormatType.HTML40
    End Select
    If selectedNoFormat Then
        message.Text = MessageConstants.FORMAT_NOT_SUPPORTED
    Else
        message.Text = MessageConstants.SUCCESS
    End If
Catch ex As Exception
    message.Text = MessageConstants.FAILURE & ex.Message
End Try 
 try
{
   switch ((ExportFormatType)exportTypesList.SelectedIndex)
   {
      case ExportFormatType.NoFormat:
         selectedNoFormat = true;
         break;
      case ExportFormatType.CrystalReport:
         break;
      case ExportFormatType.RichText:
         break;
      case ExportFormatType.WordForWindows:
         break;
      case ExportFormatType.Excel:
         break;
      case ExportFormatType.PortableDocFormat:
         break;
      case ExportFormatType.HTML32:
         break;
      case ExportFormatType.HTML40:
         break;
      case ExportFormatType.ExcelRecord:
         break;
   }
   if (selectedNoFormat)
   {
      message.Text = MessageConstants.FORMAT_NOT_SUPPORTED;
   }
   else
   {
      message.Text = MessageConstants.SUCCESS;
   }
}
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catch (Exception ex)
{
   message.Text = MessageConstants.FAILURE + ex.Message;
} 

1.5.2.7.6.2.3  Modifying the ExportSetup() Method

In this section, you learn how to modify the ExportSetup() method to create folders for the HTML32 and 
HTML40 export formats.

1.5.2.7.6.2.3.1  To modify the ExportSetup() method

1. At the top of the class, add the following class declarations:

 Private exportPathHTML32 As String
Private exportPathHTML40 As String 
 private string exportPathHTML32;
private string exportPathHTML40; 

2. Within the ExportSetup() method, instantiate the exportPathHTML32 and exportPathHTML40 string 
variables to the root directory of the hard drive.

 exportPathHTML32 = "C:\Exported\HTML32\"
exportPathHTML40 = "C:\Exported\HTML40\" 
 exportPathHTML32 = "C:\\Exported\\HTML32\\";
exportPathHTML40 = "C:\\Exported\\HTML40\\"; 

Note
If you want to place the folders within the Web directory of your Web server, prefix the folder name with the 
Request.PhysicalApplicationPath property.

3. Create a conditional block that tests whether the directory in the exportPathHTML32 string already exists.

 If Not System.IO.Directory.Exists(exportPathHTML32) Then
End If 
 if (!System.IO.Directory.Exists(exportPathHTML32))
{
} 

4. Within the conditional block, call the CreateDirectory() method of System.IO.Directory to create the 
directory in the exportPathHTML32 string.

 System.IO.Directory.CreateDirectory(exportPathHTML32) 
 System.IO.Directory.CreateDirectory(exportPathHTML32); 
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5. Create a conditional block that tests whether the directory in the exportPathHTML40 string already exists.

 If Not System.IO.Directory.Exists(exportPathHTML40) Then
End If 
 if (!System.IO.Directory.Exists(exportPathHTML40))
{
} 

6. Within the conditional block, call the CreateDirectory() method of System.IO.Directory to create the 
directory in the exportPathHTML40 string.

 System.IO.Directory.CreateDirectory(exportPathHTML40) 
 System.IO.Directory.CreateDirectory(exportPathHTML40); 

1.5.2.7.6.2.4  Calling the ExportToDisk() Method

In this section, you learn to call the ExportToDisk() method in each case statement of the 
ExportSelection() method.

1.5.2.7.6.2.4.1  To call the ExportToDisk() method in the 
ExportSelection() method

1. Within the ExportSelection() method, declare a string variable and instantiate the variable to an empty 
string.

 Dim myFileName As String = "" 
 string fileName = ""; 

2. Within the ExportFormatType.CrystalReport case statement, do the following:

a. Set the file name string to the exportPath string, and then follow it with the name of a document that 
has an .rpt file extension.

 myFileName = exportPath & "Report.rpt" 
 fileName = exportPath + "Report.rpt"; 

b. Call the ExportToDisk() method from the hierarchicalGroupingReport instance and pass in 
ExportFormatType.CrystalReport and the file name string.

 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.CrystalReport,
myFileName) 
 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.CrystalReport,
fileName); 
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3. Within the ExportFormatType.RichText case statement, do the following:

a. Set the file name string to the exportPath string, and then follow it with the name of a document that uses 
an .rtf file extension.

 myFileName = exportPath & "RichTextFormat.rtf" 
 fileName = exportPath + "RichTextFormat.rtf"; 

b. Call the ExportToDisk() method from the hierarchicalGroupingReport instance and pass in 
ExportFormatType.RichText and the file name string.

 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.RichText,
myFileName) 
 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.RichText,
fileName); 

4. Within the ExportFormatType.WordForWindows case statement, do the following:

a. Set the file name string to the exportPath string, and then follow it with the name of a document that uses 
a .doc file extension.

 myFileName = exportPath & "Word.doc" 
 fileName = exportPath + "Word.doc"; 

b. Call the ExportToDisk() method from the hierarchicalGroupingReport instance and pass in 
ExportFormatType.WordForWindows and the file name string.

 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.WordForWindows,
myFileName) 
 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.WordForWindows,
fileName); 

5. Within the ExportFormatType.Excel case statement, do the following:

a. Set the file name string to the exportPath string, and then follow it with the name of a document that uses 
an .xls file extension.

 myFileName = exportPath & "Excel.xls" 
 fileName = exportPath + "Excel.xls"; 

b. Call the ExportToDisk() method from the hierarchicalGroupingReport instance and pass in 
ExportFormatType.Excel and the file name string.

 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.Excel,
myFileName) 
 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.Excel,
fileName); 

6. Within the ExportFormatType.PortableDocFormat case statement, do the following:
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a. Set the file name string to the exportPath string, and then follow it with the name of a document that uses 
a .pdf file extension.

 myFileName = exportPath & "PortableDoc.pdf" 
 fileName = exportPath + "PortableDoc.pdf"; 

b. Call the ExportToDisk() method from the hierarchicalGroupingReport instance and pass in 
ExportFormatType.PortableDocFormat and the file name string.

 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.PortableDocFormat,
myFileName) 
 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.PortableDocFormat,
fileName); 

7. Within the ExportFormatType.HTML32 case statement, do the following:

a. Set the file name string to the exportPathHTML32 string, and then follow it with the name of a document 
that uses an .html file extension.

 myFileName = exportPathHTML32 & "HTML32.html" 
 fileName = exportPathHTML32 + "HTML32.html"; 

b. Call the ExportToDisk() method from the hierarchicalGroupingReport instance and pass in 
ExportFormatType.HTML32 and the file name string.

 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.HTML32, myFileName) 
 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.HTML32, fileName); 

8. Within the ExportFormatType.HTML40 case statement, do the following:

a. Set the file name string to the exportPathHTML40 string, and then follow it with the name of a document 
that uses an .html file extension.

 myFileName = exportPathHTML40 & "HTML40.html" 
 fileName = exportPathHTML40 + "HTML40.html"; 

b. Call the ExportToDisk() method from the hierarchicalGroupingReport instance and pass in 
ExportFormatType.HTML40 and the file name string.

 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.HTML40,
myFileName) 
 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.HTML40,
fileName); 

9. Within the ExportFormatType.ExcelRecord case statement, do the following:

a. Set the file name string to the exportPath string, and then follow it with the name of a document that 
uses an .xls file extension.

 myFileName = exportPath & "ExcelRecord.xls" 
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fileName = exportPath + "ExcelRecord.xls"; 
b. Call the ExportToDisk() method from the hierarchicalGroupingReport instance and pass in 

ExportFormatType.ExcelRecord and the file name string.

 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.ExcelRecord,
myFileName) 
 hierarchicalGroupingReport.ExportToDisk(ExportFormatType.ExcelRecord,
fileName); 

You are now ready to build and run the project, to export your Crystal report into different formats.

If you want use the other enhanced API methods, click the appropriate link to jump to that section:

● Using the ExportToHttpResponse() Method [page 388]
● Using the ExportToStream() Method [page 392]

1.5.2.7.6.3  Using the ExportToHttpResponse() Method

The ExportToHttpResponse() method allows you to export your Crystal report to a browser window, or to 
export the report as an attachment. This method is used only for Web Sites.

The available overloaded methods for ExportToHttpResponse() include the following:

● ExportToHttpResponse(CrystalDecisions.Shared.ExportFormatType formatType, 
System.Web.HttpResponse response, bool asAttachment, string attachmentName)

● ExportToHttpResponse(CrystalDecisions.Shared.ExportOptions options, 
System.Web.HttpResponse response, bool asAttachment, string attachmentName)

The ExportToHttpResponse() method does not support exports to HTTP Response for the HTML32 and HTML40 
formats. Therefore, when you try to export to HTML32 or HTML40, an error message appears.

If the asAttachment Boolean variable is set to True, a File Download dialog box appears. If the asAttachment 
Boolean variable is set to False, the exported report opens in the browser window.

When you choose to save the file, the file name is set to the attachmentName string variable. If you do not specify 
the attachmentName variable, then the default file name is "Untitled," with the specified file extension. The file 
name can be changed in the Save As dialog box.

1.5.2.7.6.3.1  Using the ExportToHttpResponse() Method with 
the ExportFormatType Enumeration

To use the ExportToHttpResponse() method with the ExportFormatType parameter, you must complete the 
procedure Adding Controls to the Web or Windows Form [page 362] for a Web Site. You do not need the 
ExportSetup(), ExportSelection(), and ExportCompletion() method. The required code is placed in the 
exportByType click event method.
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1.5.2.7.6.3.1.1  To use the ExportToHttpResponse() method with 
the ExportFormatType parameter

1. Open the Web Form.
2. From the View menu, click Designer.
3. Double-click the exportByType Button control.

The exportByType_Click() event method is created, and you are taken to the Code view.

4. At the top of the class, add an ExportOptions class declaration.

 Private myExportOptions As ExportOptions 
 private ExportOptions exportOptions; 

5. Within the exportByType_Click() event method, instantiate the ExportOptions instance.

 myExportOptions = New ExportOptions() 
 exportOptions = new ExportOptions(); 

6. Create a try/catch block with the Exception class that is referenced as a variable named "ex."

 Try
Catch ex As Exception
End Try 
 try
{
}
catch (Exception ex)
{
} 

7. Within the try block, create a conditional block to test if the selected item from the exportTypesList is equal to 
ExportFormatType.NoFormat.

 If (exportTypesList.SelectedIndex = ExportFormatType.NoFormat) Then
Else
End If 
 if ((ExportFormatType)exportTypesList.SelectedIndex == ExportFormatType.NoFormat)
{
}
else
{
} 

8. Within the If block, set the Text property of the message Label control to the FORMAT_NOT_SUPPORTED 
constant of the MessageConstants class.

 message.Text = MessageConstants.FORMAT_NOT_SUPPORTED 
 message.Text = MessageConstants.FORMAT_NOT_SUPPORTED; 
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9. Within the Else block, assign the selected ExportFormatType from the exportTypesList to the 
ExportFormatType property of the ExportOptions instance.

 myExportOptions.ExportFormatType = exportTypesList.SelectedIndex 
 exportOptions.ExportFormatType =
(ExportFormatType)exportTypesList.SelectedIndex; 

10. Within the Else block, call the ExportToHttpResponse() method of the hierarchicalGroupingReport 
instance. Pass in the ExportOptions instance, the ASP.NET Response object, a True Boolean value, and a file 
name string as the method parameters.

Note
The file name string for the attachment does not need an extension because the extension is automatically 
added to the exported file.

 hierarchicalGroupingReport.ExportToHttpResponse(myExportOptions,
Response, True, "ExportedReport") 
 hierarchicalGroupingReport.ExportToHttpResponse(exportOptions,
Response, True, "ExportedReport"); 

11. Within the catch block, set the Text property of the message Label control to the FAILURE constant of the 
MessagesConstants class, and then append to it the Message property of the Exception parameter.

 message.Text = MessageConstants.FAILURE & ex.Message 
 message.Text = MessageConstants.FAILURE + ex.Message; 

12. Outside the try/catch block, set the Visible property of the message Label control to "True."

 message.Visible = True 
 message.Visible = true; 

You are now ready to build and run the project, to export your Crystal report into different formats.

If you want to use the ExportToHttpResponse() method with the ExportOptions class, see Using the 
ExportToHttpResponse() Method with the ExportOptions Class [page 390].

To use the other enhanced API methods, click the appropriate link to jump to that section:

● Using the ExportToDisk() Method [page 380]
● Using the ExportToStream() Method [page 392]

1.5.2.7.6.3.2  Using the ExportToHttpResponse() Method with 
the ExportOptions Class

To use the ExportToHttpResponse() method with the ExportOptions parameter, you must complete procedure 
Adding Controls to the Web or Windows Form [page 362] for a Web Site. You do not need the ExportSetup(), 
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ExportSelection(), and ExportCompletion() method. The required code is placed in the exportByType click event 
method.

1.5.2.7.6.3.2.1  To use the ExportToHttpResponse() method 
with the ExportOptions parameter

1. Open the Web Form.
2. From the View menu, click Designer.
3. Double-click the exportByType Button control.

The exportByType_Click() event method is created, and you are taken to the Code view.

4. Within the exportByType_Click() event method, create a try/catch block with the Exception class that is 
referenced as a variable named "ex."

 Try
Catch ex As Exception
End Try 
 try
{
}
catch (Exception ex)
{
} 

5. Within the try block, create a conditional block to test if the selected item from the exportTypesList is 
equal to ExportFormatType.NoFormat.

 If (exportTypesList.SelectedIndex = ExportFormatType.NoFormat) Then
Else
End If 
 if ((ExportFormatType)exportTypesList.SelectedIndex ==
ExportFormatType.NoFormat)
{
}
else
{
} 

6. Within the If block, set the Text property of the message Label control to the FORMAT_NOT_SUPPORTED 
constant of the MessageConstants class.

Note
The If condition is satisfied when the NoFormat value from the DropDownList is selected.

 message.Text = MessageConstants.FORMAT_NOT_SUPPORTED 
 message.Text = MessageConstants.FORMAT_NOT_SUPPORTED; 

7. Within the Else block, call the ExportToHttpResponse() method of the hierarchicalGroupingReport 
instance. Pass in the selected ExportFormatType, the ASP.NET Response object, a True Boolean value, and a 
file name string as the method parameters.
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Note
The file name string for the attachment does not need an extension because the extension is automatically 
added to the exported file.

 hierarchicalGroupingReport.ExportToHttpResponse(exportTypesList.SelectedIndex,
Response, True, "ExportedReport") 
 hierarchicalGroupingReport.ExportToHttpResponse((ExportFormatType)exportTypesList
.SelectedIndex,
Response, True, "ExportedReport"); 

8. Within the catch block, set the Text property of the message Label control to the FAILURE constant of the 
MessagesConstants class, and then append to it the Message property of the Exception parameter.

 message.Text = MessageConstants.FAILURE & ex.Message 
 message.Text = MessageConstants.FAILURE + ex.Message; 

9. Outside the try/catch block, set the Visible property of the message Label control to "True."

 message.Visible = True 
 message.Visible = true; 

You are now ready to build and run the project, to export your Crystal report into different formats.

To use the other enhanced API methods, click the appropriate link to jump to that section:

● Using the ExportToDisk() Method [page 380]
● Using the ExportToStream() Method [page 392]

1.5.2.7.6.4  Using the ExportToStream() Method

In this section, you learn how to use the ExportToStream() method to export the report to the input/output 
stream as a sequence of bytes. Then, you learn how to write the sequence of bytes to a file of your specified 
format.

When you export the report to the HTML formats, the images are not exported. It is recommended to use the 
ExportToHttpResponse() methods when you want to export to the HTML formats.

Prerequisites:

● You must create a project that is based on the instructions in Setting Up a Project for the ExportToStream() 
Method [page 393].

● Or, you must create a project that is based on the instructions in Creating Methods for the New Exporting 
Formats [page 378].
Then, you need to modify the project as shown in Preparing the Project for the ExportToStream() Method 
[page 394].
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1.5.2.7.6.4.1  Setting Up a Project for the ExportToStream() 
Method

In this section, you learn how to create a new project for the ExportToStream() method.

1.5.2.7.6.4.1.1  To set up a new project for the 
ExportToStream() Method

1. Complete the instructions in Adding Controls to the Web or Windows Form [page 362].
2. Create the ExportSetup() method and the ExportSelection() method in Creating Methods that 

Perform the Export [page 364].
3. Within the "Select Case" [Visual Basic] or "switch" [C#] statement of the ExportSelection() 

method, add a case statement for the ExcelRecord format.

 Case ExportFormatType.ExcelRecord 
 case ExportFormatType.ExcelRecord:
   break; 

4. Create a conditional block to test the Boolean variable, selectedNoFormat.

 If selectedNoFormat Then
Else
End If 
 if (selectedNoFormat)
{
}
else
{
} 

5. Within the If block, set the Text property of the message Label control to the FORMAT_NOT_SUPPORTED 
constant of the MessageConstants class.

 message.Text = MessageConstants.FORMAT_NOT_SUPPORTED 
 message.Text = MessageConstants.FORMAT_NOT_SUPPORTED; 

6. Within the Else block, set the Text property of the message Label control to the SUCCESS constant of the 
MessageConstants class.

 message.Text = MessageConstants.SUCCESS 
 message.Text = MessageConstants.SUCCESS; 

7. Create a try/catch block with the Exception class that is referenced as a variable named "ex." The try block 
encloses the "Select Case" [Visual Basic] or "switch" [C#] statement and the conditional block.

 Try
Catch ex As Exception
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End Try 
 try
{
}
catch (Exception ex)
{
} 

8. Within the catch block, set the Text property of the message Label control to the FAILURE constant of the 
MessagesConstants class, and then append to it the Message property of the Exception parameter.

 message.Text = MessageConstants.FAILURE & ex.Message 
 message.Text = MessageConstants.FAILURE + ex.Message; 

9. Outside the try/catch block, set the Visible property of the message Label control to "True."

 message.Visible = True 
 message.Visible = true; 

10. From the View menu, click Designer.
11. Double-click the exportByType Button control.

The exportByType_Click() event method is created, and you are taken to the Code view.

12. Within the exportByType_Click() event method, enter calls to the ExportSetup() and ExportSelection() 
methods.

 ExportSetup()
ExportSelection() 
 ExportSetup();
ExportSelection(); 

1.5.2.7.6.4.2  Preparing the Project for the ExportToStream() 
Method

In this section, you learn how to modify a project that is a result of the procedure in Creating Methods for the New 
Exporting Formats [page 378].

Now, you must delete certain lines of code that are not needed for the ExportToStream() method.

1.5.2.7.6.4.2.1  To modify the project to use the 
ExportToStream() method

1. Open the project.
2. Open the Web or Windows Form.
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3. From the View menu, click Code.
4. At the top of the class, delete the following class declarations:

 Private myDiskFileDestinationOptions As DiskFileDestinationOptions
Private myExportOptions As ExportOptions 
 private DiskFileDestinationOptions diskFileDestinationOptions;
private ExportOptions exportOptions; 

5. Within the ExportSetup() method, delete all the lines of code after the conditional block. (The last line of 
code that calls the ExportFormatOptions property only occurs in a Windows project.)

 myDiskFileDestinationOptions = New DiskFileDestinationOptions()
myExportOptions = hierarchicalGroupingReport.ExportOptions
myExportOptions.ExportDestinationType = ExportDestinationType.DiskFile
myExportOptions.ExportFormatOptions = Nothing 
 diskFileDestinationOptions = new DiskFileDestinationOptions();
exportOptions = hierarchicalGroupingReport.ExportOptions;
exportOptions.ExportDestinationType = ExportDestinationType.DiskFile;
exportOptions.ExportFormatOptions = null; 

6. Delete the following export configuration methods:
○ ConfigureExportToRpt()
○ ConfigureExportToRtf()
○ ConfigureExportToDoc()
○ ConfigureExportToXls()
○ ConfigureExportToPdf()
○ ConfigureExportToHtml32()
○ ConfigureExportToHtml40()
○ ConfigureExportToXlsRec()

7. Within the Select Case [Visual Basic] or switch [C#] case statements of ExportSelection(), 
delete the calls to the export configuration methods.

8. Within the ExportCompletion() method, delete the call to the Export() method.

9. Copy and paste all the code from the ExportCompletion() method to the top of the ExportSelection() 
method.

10. Delete the ExportCompletion() method and delete the call to ExportCompletion() in exportByType 
button click event.

11. Within the ExportSelection() method, cut and paste the Select Case [Visual Basic] or switch 
[C#] case statements above the If block within the try block.
The try/catch block now looks like the following:

 Try
    Select Case exportTypesList.SelectedIndex
        Case ExportFormatType.NoFormat
            selectedNoFormat = True
        Case ExportFormatType.CrystalReport
        Case ExportFormatType.RichText
        Case ExportFormatType.WordForWindows
        Case ExportFormatType.Excel
        Case ExportFormatType.PortableDocFormat
        Case ExportFormatType.HTML32
        Case ExportFormatType.HTML40
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    End Select
    If selectedNoFormat Then
        message.Text = MessageConstants.FORMAT_NOT_SUPPORTED
    Else
        message.Text = MessageConstants.SUCCESS
    End If
Catch ex As Exception
    message.Text = MessageConstants.FAILURE & ex.Message
End Try 
 try
{
   switch ((ExportFormatType)exportTypesList.SelectedIndex)
   {
      case ExportFormatType.NoFormat:
         selectedNoFormat = true;
         break;
      case ExportFormatType.CrystalReport:
         break;
      case ExportFormatType.RichText:
         break;
      case ExportFormatType.WordForWindows:
         break;
      case ExportFormatType.Excel:
         break;
      case ExportFormatType.PortableDocFormat:
         break;
      case ExportFormatType.HTML32:
         break;
      case ExportFormatType.HTML40:
         break;
      case ExportFormatType.ExcelRecord:
         break;
   }
   if (selectedNoFormat)
   {
      message.Text = MessageConstants.FORMAT_NOT_SUPPORTED;
   }
   else
   {
      message.Text = MessageConstants.SUCCESS;
   }
}
catch (Exception ex)
{
   message.Text = MessageConstants.FAILURE + ex.Message;
} 

1.5.2.7.6.4.3  Modifying the Case Statements in the 
ExportSelection() Method

In this section, you learn how to set a file name string for each ExportFormatType case statement.
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1.5.2.7.6.4.3.1  To modify the case statements in the 
ExportSelection() method

1. Within the ExportSelection() method, declare a string variable and instantiate the variable to an empty 
string.

 Dim myFileName As String = "" 
 string fileName = ""; 

2. Within the ExportFormatType.CrystalReport case statement, set the file name string to the exportPath string 
that is followed by a recognizable document name with a .rpt file extension.

 myFileName = exportPath & "Report.rpt" 
 myFileName = exportPath + "Report.rpt"; 

3. Within the ExportFormatType.RichText case statement, set the file name string to the exportPath string that 
is followed by a recognizable document name with a .rtf file extension.

 myFileName = exportPath & "RichTextFormat.rtf" 
 myFileName = exportPath + "RichTextFormat.rtf"; 

4. Within the ExportFormatType.WordForWindows case statement, set the file name string to the exportPath 
string that is followed by a recognizable document name with a .doc file extension.

 myFileName = exportPath & "Word.doc" 
 fileName = exportPath + "Word.doc"; 

5. Within the ExportFormatType.Excel case statement, set the file name string to the exportPath string that is 
followed by a recognizable document name with a .xls file extension.

 myFileName = exportPath & "Excel.xls" 
 fileName = exportPath + "Excel.xls"; 

6. Within the ExportFormatType.PortableDocFormat case statement, set the file name string to the exportPath 
string that is followed by a recognizable document name with a .pdf file extension.

 myFileName = exportPath & "PortableDoc.pdf" 
 fileName = exportPath + "PortableDoc.pdf"; 

7. Within the ExportFormatType.HTML32 case statement, set the file name string to the exportPath string that 
is followed by a recognizable document name with a .html file extension.

 myFileName = exportPath & "HTML32.html" 
 fileName = exportPath + "HTML32.html"; 
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8. Within the ExportFormatType.HTML40 case statement, set the file name string to the exportPath string that 
is followed by a recognizable document name with a .html file extension.

 myFileName = exportPath & "HTML40.html" 
 fileName = exportPath + "HTML40.html"; 

9. Within the ExportFormatType.ExcelRecord case statement, set the file name string to the exportPath string 
that is followed by a recognizable document name with a .xls file extension.

 myFileName = exportPath & "ExcelRecord.xls" 
 fileName = exportPath + "ExcelRecord.xls"; 

1.5.2.7.6.4.4  Calling the ExportToStream() Method

In this section, you learn how to call the ExportToStream() method and to write the exported report data to a 
file in your specified format.

1.5.2.7.6.4.4.1  To call the ExportToStream() method in the 
ExportSelection() method

1. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of 
the class for the System.IO namespace.

 Imports System.IO 
 using System.IO; 

2. Within the Else block of the ExportSelection() method, call the ExportToStream() method of the 
hierarchicalGroupingReport instance, pass in the selected ExportFormatType from the 
exportTypesList dropdownlist, and assign the instance to the Stream class.

 Stream myStream = 
hierarchicalGroupingReport.ExportToStream(exportTypesList.SelectedIndex) 
 Stream stream = 
hierarchicalGroupingReport.ExportToStream((ExportFormatType)exportTypesList.Selec
tedIndex); 

3. Create a new byte array that has the same length as the Stream instance.

 Dim myDataArray As byte() = New byte(myStream.Length) 
 byte[] dataArray = new byte[stream.Length]; 
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4. Read the data from the Stream instance to the byte array from a zero offset to the length of the Stream 
instance.

 myStream.Read(myDataArray, 0, Convert.ToInt32(myStream.Length)); 
 stream.Read(dataArray, 0, Convert.ToInt32(stream.Length)); 

5. Create a FileStream instance that creates the file specified by the file name string variable.

 Dim myFileStream As FileStream = New FileStream(myFileName, 
System.IO.FileMode.Create) 
 FileStream fileStream = new FileStream(fileName, System.IO.FileMode.Create); 

6. Write the data stored in the byte array to the file from a zero offset to the length of the byte array.

 myFileStream.Write(myDataArray, 0, myDataArray.Length) 
 fileStream.Write(dataArray, 0, dataArray.Length); 

7. Close the FileStream instance and the Stream instance.

 myFileStream.Close()
myStream.Close() 
 fileStream.Close();
stream.Close(); 

8. Set the Text property of the message Label control to the SUCCESS constant of the MessageConstants class.

 message.Text = MessageConstants.SUCCESS 
 message.Text = MessageConstants.SUCCESS; 

You are now ready to build and run the project, to export your Crystal report into different formats.

If you want use the other enhanced API methods, click the appropriate link to jump to that section:

● Using the ExportToDisk() Method [page 380]
● Using the ExportToHttpResponse() Method [page 388]

1.5.2.8 Tutorial: Filtering Data Using Selection Formulas

In this tutorial, you learn how to filter data within the ReportDocument object model by setting the 
RecordSelectionFormula property of the DataDefinition class.

Introduction

Selection formulas are used to filter records that you want to display on a Crystal report. To write selection 
formulas, you can use the Basic syntax or the Crystal syntax.
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In this tutorial, you create a selection formula to filter customer records where the Last Year's Sales field is 
greater than a specific value, and the Customer Name field is compared to another string. A DropDownList (Web) 
or ComboBox (Windows) control selects a comparison operator for the Customer Name field. You can choose to 
display customer names that are equal to, less than, greater than, less than or equal to, greater than or equal to, 
or not equal to the string value that you have specified.

The formula is passed as a string variable to the SelectionFormula property of the CrystalReportViewer class. 
Once the property is set, the Crystal report that binds to the CrystalReportViewer control is filtered before it is 
displayed.

This tutorial can also be completed with classes of the CrystalReportViewer object model, although the 
ReportDocument object model is preferred.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The files for each sample 
code version are stored in the following folders:

● C# Web Site: CS_Web_RDObjMod_SavedDataSelectionFormula
● C# Windows Project: CS_Win_RDObjMod_SavedDataSelectionFormula
● Visual Basic Web Site: VB_Web_RDObjMod_SavedDataSelectionFormula
● Visual Basic Windows Project: VB_Win_RDObjMod_SavedDataSelectionFormula

Xtreme Database

This tutorial uses a sample database called Xtreme. The xtreme.mdb database file is included with the SAP 
Crystal Reports .NET SDK Sample Code package. To use the Xtreme database, you must manually create an 
ODBC connection to it.

Related Information

Choose the Correct Object Model for Your Project [page 29]
Sample Reports Directory [page 14]

1.5.2.8.1 Creating a Report

To begin, you create a Crystal report where you will filter data.
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1.5.2.8.1.1  To create a Crystal report

Note
This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will 
be unable to complete the procedure without that configuration.

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, in the Templates view, select the template Crystal Report.
3. In the Name field, enter the name "CustomerBySalesName.rpt" and click Add.
4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 

Report Wizard.
5. In the Choose an Expert panel, select Standard, and then click OK.
6. In the Available Data Sources panel of the Standard Report Creation Wizard window, expand the Create New 

Connection folder.
7. From the subfolder that opens, expand the ODBC (RDO) folder.
8. In the ODBC (RDO) window, select the correct ODBC DSN entry for the Xtreme Sample Database, and then 

click Finish.
The ODBC (RDO) folder expands and shows the Xtreme database.

9. Expand the Tables node and select the Customer table.
10. Double-click the Customer table to move the table into the Selected Tables panel, and then click Next.
11. CTRL-click Customer Name, Last Year's Sales, and City.
12. Click the > symbol to move these fields into the Fields to Display panel, and then click Finish button.

The CustomerBySalesName report is created and loaded into the main window of Visual Studio.
13. Click Main Report Preview.

The report is previewed with all available data. Later you filter this data programmatically.
14. Click Main Report to exit preview mode.

1.5.2.8.2 Binding the Report

In Project Setup [page 15], you placed a CrystalReportViewer control on the Web or Windows Form. In the 
previous step, you added a CustomerBySalesName report to the project.

In this section, you instantiate the CustomerBySalesName report and bind it to the CrystalReportViewer control.

You can instantiate and bind the report in two ways:

● As an embedded report.
● As a non-embedded report.

Choose from one (but not both) of the step procedures below.

● If you use embedded reports, follow the next step procedure to instantiate the report as an embedded report.
● If you use non-embedded reports, follow the second step procedure to instantiate the report as a non-

embedded report.
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1.5.2.8.2.1  To instantiate the CustomerBySalesName report as 
an embedded report and bind it to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Add a new class-level declaration for the CustomerBySalesName report wrapper class, using the variable 

name customerBySalesNameReport. Set its access modifier to private.

 Private customerBySalesNameReport As CustomerBySalesName 
 private CustomerBySalesName customerBySalesNameReport; 

4. Within the ConfigureCrystalReports() method, instantiate the report wrapper class.

Note
You created the ConfigureCrystalReports() method in Project Setup [page 15].

 customerBySalesNameReport = New CustomerBySalesName() 
 customerBySalesNameReport = new CustomerBySalesName(); 

5. On the next line beneath the report instantiation, bind the ReportSource property of the CrystalReportViewer 
control to the instantiated report class (variable name: customerBySalesNameReport).

 myCrystalReportViewer.ReportSource = customerBySalesNameReport 
 crystalReportViewer.ReportSource = customerBySalesNameReport; 

You are now ready to build and run your project. Skip to the next section below.

1.5.2.8.2.2  To instantiate the CustomerBySalesName report as 
a non-embedded report and bind it to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Add a new class-level declaration for the ReportDocument report wrapper class, with the variable name 

customerBySalesNameReport. Set its access modifier to private.

 Private customerBySalesNameReport As ReportDocument 
 private ReportDocument customerBySalesNameReport; 
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Note
The ReportDocument class is a member of the CrystalDecisions.CrystalReports.Engine 
namespace. You have added an "Imports" [Visual Basic] or "using" [C#] declaration for this 
namespace in Project Setup [page 15]. When you instantiate ReportDocument and load a report into the 
namespace, you gain access to the report through the SDK, without embedding the report.

4. Within the ConfigureCrystalReports() method (that you have created in Project Setup [page 15]), 
instantiate the ReportDocument class.

 customerBySalesNameReport = New ReportDocument() 
 customerBySalesNameReport = new ReportDocument(); 

5. Declare a string variable, name it reportPath, and assign to it a runtime path to the local report. This path is 
determined differently for Web Sites and Windows projects:
○ For a Web Site, pass the name of the local report file as a string parameter into the Server.MapPath() 

method. This maps the local report to the hard drive file directory path at runtime.

 Dim reportPath As String = Server.MapPath("CustomerBySalesName.rpt") 
 string reportPath = Server.MapPath("CustomerBySalesName.rpt"); 

○ For a Windows project, concatenate the Application.StartupPath property with a backslash and the 
local report file name. This maps the report to the same directory as the Windows executable file.

Note
At compile time you will copy the report to the directory containing the executable file.

 Dim reportPath As String = Application.StartupPath & "\" & 
"CustomerBySalesName.rpt" 
 string reportPath = Application.StartupPath + "\\" + 
"CustomerBySalesName.rpt"; 

6. Call the Load() method of the ReportDocument instance and pass into it the reportPath string variable.

 customerBySalesNameReport.Load(reportPath) 
 customerBySalesNameReport.Load(reportPath); 

7. On the next line, beneath the report loading, bind the ReportSource property of the CrystalReportViewer to 
the ReportDocument instance.

 myCrystalReportViewer.ReportSource = customerBySalesNameReport 
 crystalReportViewer.ReportSource = customerBySalesNameReport; 

Whether you have chosen to instantiate an embedded report class or a non-embedded report through the 
ReportDocument class, the variable name used is the same: customerBySalesNameReport. This allows you to 
use a common set of code in the procedures that follow.

You are now ready to build and run your project.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 403



1.5.2.8.2.3  To test the loading of the CustomerBySalesName 
report

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. If you use a non-embedded report in a Windows project, locate the compiled Windows executable in the \bin

\ [Visual Basic] or \bin\debug\ [C#] subdirectory, and then copy the report to that subdirectory.

Note
To have the non-embedded report loaded by the Windows executable at runtime, the report must be 
stored in the same directory as the Windows executable.

4. From the Debug menu, click Start.
The report is displayed, and it shows all available rows of data. In the next section, you start to filter that data 
with the RecordSelectionFormula property.

5. Return to Visual Studio and click Stop to exit from debug mode.

1.5.2.8.3 Applying a Filter to the Report Data

In this section, you learn how to apply a filter to the data in the report.

1.5.2.8.3.1  To apply a filter to report data

1. Open the Web or Windows form in Design view.
2. From the View menu, click Code.
3. At the top of the class, add three new class-level variable declarations that will represent values by which data 

will be filtered.

 Private salesAmount As String
Private operatorValue As String
Private customerName As String 
 private string salesAmount;
private string operatorValue;
private string customerName; 

4. If you are creating a Windows project, add an additional class-level variable declaration, a boolean that is 
named useDefaultValues, and then assign to it a value of True.

 Private useDefaultValues As Boolean = True 
 private bool useDefaultValues = true; 

5. Within the ConfigureCrystalReports() method, create a conditional block.
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○ If you are creating a Web Site, create a Not IsPostBack conditional block. Place this block above the 
existing code in the method.

 If Not IsPostBack Then
End If 
 if (!IsPostBack)
{
} 

○ If you are creating a Windows project, create a useDefaultValues conditional block. Place this block above 
the existing code in the method.

 If useDefaultValues Then
End If 
 if (useDefaultValues)
{
} 

6. Within the conditional block, assign values of 4000, <, and K to the three class-level variables.
These values are assigned within a conditional block, because later you override these values with a button 
click event.

 salesAmount = "4000"
operatorValue = "<"
customerName = "K" 
 salesAmount = "4000";
operatorValue = "<";
customerName = "K"; 

7. Immediately outside and below the conditional block, create a selectionFormula string in which you mix 
literals with the class-level variables you have just created.

 Dim selectionFormula As String = "{Customer.Last Year's Sales} >
" _
    & salesAmount _
    & " AND Mid({Customer.Customer Name}, 1, 1) " _
    & operatorValue _
    & "'" _
    & customerName _
    & "'" 
 string selectionFormula = "{Customer.Last Year's Sales} > "
    + salesAmount
    + " AND Mid({Customer.Customer Name}, 1, 1) "
    + operatorValue
    + "'"
    + customerName
    + "'"; 

8. In the report binding code that you created earlier, create a line break just above the line of code where 
customerBySalesName is assigned to the ReportSource property of the CrystalReportViewer control.

9. In this line break, assign the selectionFormula string variable to the ReportDocument instance.

 customerBySalesNameReport.DataDefinition.RecordSelectionFormula =
selectionFormula 
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customerBySalesNameReport.DataDefinition.RecordSelectionFormula =
selectionFormula; 

10. Compile and view your application.
The data should now be filtered.

11. Return to Visual Studio and click Stop to exit from debug mode.

In the next section, you create controls on the form that allow you to adjust the selection formula dynamically.

1.5.2.8.4 Adding Controls for Dynamic Filtering

In this section, you add controls to use in the selection formula. These controls allow you to filter the data 
dynamically.

1.5.2.8.4.1  To add controls to use in the selection formula

1. Open the Web or Windows Form.
2. From the View menu, click Designer.
3. If you are developing a Web Site, do the following:

a. Click the CrystalReportViewer control to select it.
b. Press the LEFT ARROW on your keyboard so that a flashing cursor appears, and then press ENTER five 

times.
The CrystalReportViewer control drops by five lines.

4. If you are developing a Windows project, do the following:
a. Click the CrystalReportViewer control to select it.
b. From the Properties window, set Dock to "Bottom".
c. Resize the CrystalReportViewer control, so that approximately three lines appear above it.
d. From the Properties window, set Anchor to "Top, Bottom, Left, Right".

5. From the Toolbox, drag a Label control onto the form at top left.
6. In the Properties window, set the Text to "Display the following customers:"
7. From the Toolbox, drag a second Label control onto the form below the first one.
8. In the Properties window, set the Text to "- last year's sales > $".
9. From the Toolbox, drag a third Label control onto the form below the second one.
10. In the Properties window, set the Text to "- first letter of name is".
11. From the Toolbox, drag a TextBox control to the right of the second Label control.
12. In the Properties window, set the ID to "lastYearsSales".
13. From the Toolbox, drag a DropDownList control(Web) or ComboBox control(Windows) to the right of the third 

Label control.
14. In the Properties window, set the ID to "operatorValueList".
15. From the Toolbox, drag a TextBox control to the right of the DropDownList control(Web) or ComboBox 

control(Windows).
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16. In the Properties window, set the ID to "letterOfName".
17. From the Toolbox, drag a Button control below the third Label control.
18. In the Properties window, set the ID to "redisplay" and the Text to "Redisplay Report".
19. From the Toolbox, drag a Label control below the Button control.
20.In the Properties window, set the ID to "formula" and the Text to be blank.

Ensure that the CrystalReportViewer control is adjusted to sit immediately below these controls.
21. From the File menu, click Save All.

In the next section, you populate the DropDownList (Web) or ComboBox (Windows) control.

1.5.2.8.5 Populating the DropDownList ComboBox Control

The DropDownList control (Web) or ComboBox control (Windows) requires a list of operatorValues (equal, 
greater than, and so on). The most generic way to populate this control is to provide the list of values as an 
enumerator.

1.5.2.8.5.1  To populate the DropDownList ComboBox control

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, select Class.
3. Enter the name "CeComparisonOperator" and then click OK.
4. In the class file, change the word class to enum.

Note
In Visual Basic, remember to change both the opening and closing signature. In C#, delete the constructor.

5. Enter the following enum values.

     EqualTo
    GreaterThan
    GreaterThanOrEqualTo
    LessThan
    LessThanOrEqualTo
    NotEqualTo 
     EqualTo,
    GreaterThan,
    GreaterThanOrEqualTo,
    LessThan,
    LessThanOrEqualTo,
    NotEqualTo 

6. Open the Web or Windows form in Design View.
7. From the View menu, click Code.
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8. In the ConfigureCrystalReports() method, you now populate the operatorValueList instance with values 
from the CeComparisonOperator enum. This code is placed in a different location, depending on whether you 
are building a Web Site or a Windows project.
○ In a Web Site, place the DataSource property assignment and the binding within the Not IsPostBack 

conditional block.

 operatorValueList.DataSource = 
System.Enum.GetValues(GetType(CeComparisonOperator))
operatorValueList.DataBind() 
 operatorValueList.DataSource = 
System.Enum.GetValues(typeof(CeComparisonOperator));
operatorValueList.DataBind(); 

○ In a Windows project, place only the DataSource property assignment within the useDefaultValues 
conditional block.

 operatorValueList.DataSource = 
System.Enum.GetValues(GetType(CeComparisonOperator)) 
 operatorValueList.DataSource =
System.Enum.GetValues(typeof(CeComparisonOperator)); 

Note
In a Windows project, you do not need to call a DataBind() method.

9. At the bottom of the ConfigureCrystalReports() method, assign the selectionFormula string to the Text 
property of the formula Label control.

 formula.Text = selectionFormula 
 formula.Text = selectionFormula; 

10. Compile and view the application.
The operator list and all other controls should be correctly displayed.

11. Close your browser.

In the next section, you create a method that retrieves selections from this control when the Redisplay Report 
button is clicked.

1.5.2.8.6 Retrieving Selections from the Control

In this section, you retrieve selections from the DropDownList (Web) or ComboBox (Windows) control.

1.5.2.8.6.1  To retrieve selections from the control

1. Open the Web or Windows form in Design view.
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2. From the View menu, click Code.
3. At the bottom of the class, create a private helper method GetSelectedOperator() that returns a string value.

 Private Function GetSelectedOperator() As String
End Function 
 private string GetSelectedOperator()
{
} 

4. Within the method, declare a string selectedOperator and assign it an empty string value.

 Dim selectedOperator As String = "" 
 string selectedOperator = ""; 

5. Still within the method, create a Select Case/switch case statement that checks the selected index in the list 
control and returns the corresponding enum value.

Note
In C#, you must explicitly cast the selected index to the enum in the switch signature.

 Select Case operatorValueList.SelectedIndex
    Case CeComparisonOperator.EqualTo
        selectedOperator = "="
    Case CeComparisonOperator.GreaterThan
        selectedOperator = ">"
    Case CeComparisonOperator.GreaterThanOrEqualTo
        selectedOperator = ">="
    Case CeComparisonOperator.LessThan
        selectedOperator = "<"
    Case CeComparisonOperator.LessThanOrEqualTo
        selectedOperator = "<="
    Case CeComparisonOperator.NotEqualTo
        selectedOperator = "<>"
End Select 
 switch ((CeComparisonOperator)operatorValueList.SelectedIndex)
{
    case CeComparisonOperator.EqualTo:
        selectedOperator = "=";
        break;
    case CeComparisonOperator.GreaterThan:
        selectedOperator = ">";
        break;
    case CeComparisonOperator.GreaterThanOrEqualTo:
        selectedOperator = ">=";
        break;
    case CeComparisonOperator.LessThan:
        selectedOperator = "<";
        break;
    case CeComparisonOperator.LessThanOrEqualTo:
        selectedOperator = "<=";
        break;
    case CeComparisonOperator.NotEqualTo:
        selectedOperator = "<>";
        break;
} 
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6. Return the selectedOperator from the method.

 Return selectedOperator 
 return selectedOperator; 

7. From the File menu, click Save All.

In the last section, you add a button click event to apply the new selection formula values to the report when the 
button is clicked.

1.5.2.8.7 Adding a Button Click Event

The final step in configuring dynamic filtering is to add the button click event and then write code to apply the new 
selection formula values to the report.

1.5.2.8.7.1  To add the button click event

1. Open the Web or Windows form in Design view.
2. Double-click the Button control.
3. The code-behind class loads and a button click event is created.
4. Within the method, set the class-level variable "salesAmount" to the Text property of the lastYearsSales 

control instance.

 salesAmount = lastYearsSales.Text 
 salesAmount = lastYearsSales.Text; 

5. Set the class-level variable "operatorValue" to the return value of the GetSelectedOperator helper method.

 operatorValue = GetSelectedOperator() 
 operatorValue = GetSelectedOperator(); 

6. Set the class-level variable "customerName" to the Text property of the letterOfName control instance.

 customerName = letterOfName.Text 
 customerName = letterOfName.Text; 

7. If you are building a Windows project, set the class-level variable "useDefaultValues" to False.

Note
This causes the conditional block within ConfigureCrystalReports() that sets default values for the class-
level variables to be skipped.

 useDefaultValues = False
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 useDefaultValues = false; 

8. Still within the method, call the ConfigureCrystalReports() method to perform the filtering and binding 
of the report.

 ConfigureCrystalReports() 
 ConfigureCrystalReports(); 

You are now ready to test the application.

1.5.2.8.8 Testing the Filtering of Data

In the final section, you test the filtering of data.

1.5.2.8.8.1  To test the filtering of data

1. Compile and view your application.
2. Verify that the report is displayed with the default filtering values.
3. Enter "200000" into last year's sales.
4. Select GreaterThan from the DropDownList (Web) or ComboBox (Windows).
5. Enter "M" in the TextBox, and then click Redisplay Report.

The report redisplays with the data filtered as specified above.
6. Close your browser.

1.5.2.8.9 Addendum: Enhancements to the Selection 
Formulas Code

If you have installed SAP Crystal Reports 2008, you have access to the enhanced API that filters data within the 
ReportDocument object model by setting the SavedDataSelection formula of the DataDefinition class.

In the previous procedures, you learned to use the RecordSelection formula to filter data after a button click.

In this tutorial, you modify the redisplay_Click method to use the SavedDataSelection formula to filter data 
after a button click. The SavedDataSelection formula allows you to filter on saved data instead of re-accessing 
the database.
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1.5.2.8.9.1  Modifying the Project for SavedDataSelection 
Formula

If you have completed all procedures in Tutorial: Filtering Data Using Selection Formulas [page 399], you must 
first delete certain lines of code that are shown in the following procedure.

1.5.2.8.9.1.1  To modify the project to use the 
SavedDataSelection Formula

1. Open the project that you completed for this tutorial.
2. Open the Web or Windows Form.
3. On the View menu, click Code.
4. If you are developing a Windows project, delete the class-level variable named "useDefaultValues".

5. If you are developing a Web project, within the ConfigureCrystalReports() method, delete the 
conditional block without deleting the code that is contained in it.
The modified ConfigureCrystalReports() method should look like this:

 Private Sub ConfigureCrystalReports()         salesAmount = "4000"
        operatorValue = "<" 
        customerName = "K"
        Dim selectionFormula As String = "{Customer.Last Year's Sales} > " & 
salesAmount _
        & " AND Mid({Customer.Customer Name}, 1, 1) " & operatorValue & "'" & 
customerName & "'"
        operatorValueList.DataSource = 
System.Enum.GetValues(GetType(CeComparisonOperator))
        operatorValueList.DataBind()
        customerBySalesNameReport = New ReportDocument()
        Dim reportPath As String = Server.MapPath("CustomerSalesByReport.rpt")
        customerBySalesNameReport.Load(reportPath)
        customerBySalesNameReport.DataDefinition.RecordSelectionFormula = 
selectionFormula
        myCrystalReportViewer.ReportSource = customerBySalesNameReport
        formula.Text = selectionFormula     End Sub

private void ConfigureCrystalReports()     {
        salesAmount = "4000";
        operatorValue = "<";
        customerName = "K";
        string selectionFormula = "{Customer.Last Year's Sales} > " + salesAmount
        + " AND Mid({Customer.Customer Name}, 1, 1) " + operatorValue + "'" + 
customerName + "'";
        operatorValueList.DataSource = 
System.Enum.GetValues(typeof(CeComparisonOperator));
        operatorValueList.DataBind();
        customerBySalesNameReport = new ReportDocument();
        string reportPath = Server.MapPath("CustomerBySalesName.rpt");
        customerBySalesNameReport.Load(reportPath);
        customerBySalesNameReport.DataDefinition.RecordSelectionFormula = 
selectionFormula;
        crystalReportViewer.ReportSource = customerBySalesNameReport;
        formula.Text = selectionFormula;
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     }

1.5.2.8.9.2  Adding an Event that Applies the 
SavedDataSelection Formula

In this section, you will modify the redisplay_Click method by applying the SavedDataSelection formula to the 
selectionFormula values of the report.

1.5.2.8.9.2.1  To add the button click event

1. Open the Web or Windows form.
2. On the View menu, click Code.
3. In the redisplay_Click method, delete the line that calls the ConfigureCrystalReports() method.

4. Create a selectionFormula string in which you mix literals with the class-level variables.

Dim selectionFormula As String = "{Customer.Last Year's Sales} > " _     & salesAmount _
    & " AND Mid({Customer.Customer Name}, 1, 1) " _
    & operatorValue _
    & "'" _
    & customerName _     & "'"

string selectionFormula = "{Customer.Last Year's Sales} > "     + salesAmount
    + " AND Mid({Customer.Customer Name}, 1, 1) "
    + operatorValue
    + "'"
    + customerName     + "'";

5. Assign the selectionFormula String variable to the ReportDocument instance.

customerBySalesNameReport.DataDefinition.SavedDataSelectionFormula = 
selectionFormula

customerBySalesNameReport.DataDefinition.SavedDataSelectionFormula = 
selectionFormula;

6. On the next line, bind the ReportSource property of the CrystalReportViewer to the ReportDocument 
instance.

myCrystalReportViewer.ReportSource = customerBySalesNameReport

crystalReportViewer.ReportSource = customerBySalesNameReport;

7. At the bottom of the method, assign the selectionFormula string to the Text property of the formula label 
control.

formula.Text = selectionFormula

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 413



formula.Text = selectionFormula;

You are now ready to test the application.

1.5.2.8.9.3  Testing the Filtering of Data

In this section, you test the filtering of the data.

1.5.2.8.9.3.1  To test the filtering of data

1. Compile and view your application.
2. Verify that the report is displayed with the default filtering values.
3. Enter "30000" into last year's sales.
4. Select GreaterThan from the DropDownList (Web) or ComboBox (Windows).
5. Enter "H" in the TextBox, and then click Redisplay Report.

The report redisplays with all customers whose names are between H and K and have sales that are greater 
than $30000.

6. Change "H" to "S" in the TextBox, and then click Redisplay Report.
The report redisplays with no data. This is because "S" is outside the initial parameters that are set in the 
ConfigureCrystalReports() method.

7. Close your browser.

1.5.2.9 Tutorial: Displaying Report Parts with the 
CrystalReportPartsViewer Control

In this tutorial, you learn how to break a report into parts and display each part by clicking through a series of 
successive hyperlinks.

Introduction

In this tutorial, you learn how to break a report into parts and display each part by clicking through a series of 
successive hyperlinks. The hyperlinks move from a general report summary group to increasingly detailed report 
information. You set the general starting point, and then each successive hyperlink for the report. To display the 
report as parts, you assign the report to an alternate control named the CrystalReportPartsViewer control.

Note
Report parts are used only in Web Sites; they are not available for Windows projects.
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There are two primary ways to view a report:

● You can view the report as a whole.
● You can view the report as a linked series of report parts.

Viewing the report as a whole

Reports are typically displayed as a single document (of one or more pages in length) in which detailed 
information is shown grouped by categories, subcategories and finally individual rows of detail.

For example, the Xtreme Access database that ships with SAP Crystal Reports contains customer data about 
bicycle shops from many locations in the world. A typical way to view data in a report is to see the individual 
bicycle shops that are organized into groups based on regions, and then cities, with individual rows of information 
for each bicycle shop shown at the detail level.

The CrystalReportViewer control is used to display reports as a whole.

Viewing the report as a linked series of parts

With the introduction of web portals and cell phone web browsing, both of which provide a very limited viewing 
area for looking at information, a new way of displaying reports has been developed.

To achieve this, the all-in-one report that consisted of group categories, subcategories, and detail rows is 
redefined as a series of report parts. These parts are then displayed across a series of linked page views. In this 
scenario, the highest category group of information is displayed first. When an item from that top-level group is 
selected, a subcategory of group information is displayed. This drill down continues until the individual rows of 
detail for a particular subcategory are reached.

For example, the Customer data on bicycle shops in the Xtreme database is viewed initially as a list of regions. 
When one region is selected, the cities within that region are displayed. When a particular city is selected, the 
detail rows of bicycle shops within that particular city are displayed.

This breaking of a report into parts allows a large and complex report to be effectively accessed within a very 
limited viewing area.

The CrystalReportPartsViewer control is used to display reports as a series of linked parts.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project, or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_RDObjMod_ReportParts
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● Visual Basic Web Site: VB_Web_RDObjMod_ReportParts

Xtreme Database

This tutorial uses a sample database called Xtreme. The xtreme.mdb database file is included with the SAP 
Crystal Reports .NET SDK Sample Code package. To use the Xtreme database, you must manually create an 
ODBC connection to it.

Related Information

Sample Reports Directory [page 14]

1.5.2.9.1 Creating a Report

To begin, create a report that draws information from the Xtreme database.

1.5.2.9.1.1  To create a report with parameters

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, in the Templates view, select the template named "Crystal Report."
3. In the Name field, enter the name "Customers.rpt" and click Add.
4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 

Report Wizard.
5. In the Choose an Expert panel, select Standard, and then click OK.
6. In the Available Data Sources panel of the Standard Report Creation Wizard window, expand the Create New 

Connection folder.
7. From the subfolder that opens, expand the ODBC (RDO) folder.
8. In the ODBC (RDO) window, select the correct ODBC DSN entry for the Xtreme database, and then click 

Finish.
The ODBC (RDO) folder expands and shows the Xtreme database.

9. Expand the Tables node and select the Customer table.
10. Double-click the Customer table to move the table into the Selected Tables panel, and then click Next.
11. CTRL-click Country, Customer Name, Last Year's Sales, Region and City.
12. Click the > symbol to move these fields into the Fields to Display panel, then click the Next button.
13. In the Available Fields panel, under Report Fields, complete the following instructions:

416 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



a. Select Country, click the > symbol to move the field into the Group By panel.
b. Select Region, click the > symbol to move the field into the Group By panel.
c. Click Next.

Summarized fields are created for the Last Year's Sales field in the Country and Region groups.
14. Click Finish.

The Customers report is created and loaded into the main window of Visual Studio.
15. At the bottom of the window, click Main Report Preview.

The report is displayed hierarchically in levels that are sorted first by country and then by region. If you 
change the report to display as report parts, each level is displayed separately.

You are now ready to convert the report to display report parts.

1.5.2.9.2 Converting the Report to Display Report Parts

In this section, you learn how to set hyperlinks in the report to link from general to more detailed information.

1.5.2.9.2.1  To convert the report to display report parts

1. At the bottom of the window, click Main Report.

Note
The highest group, Group #1 Name, is displayed in two locations, at the top and at the bottom of the report.

At the bottom of the report in the Group Footer #1 section, Group #1 Name is a label that is followed by a 
summary field for Customer.Last Year's Sales. This label is the preferred one to use as a report parts entry 
point.

2. Right-click Group #1 Name that is located in the Group Footer #1 section, and then click Copy.
3. Right-click in an empty area of the report, point to Report, and then click Report Options.
4. In the Report Options dialog box, click Paste Link.

The ID for the Group 1 label "GroupNameCountry2" is pasted into the Object Name field.

The Data Context field accepts a string value that filters report data. For now, this field should remain blank.
5. Click OK.
6. Right-click Group #1 Name, which is in the Group Footer #1 section, and then click Format Object.
7. In the Format Editor, click the Hyperlink tab, and then select Report Part Drilldown.
8. In the Available Fields panel, expand Group Footer #2, double-click GroupNameRegion2, and then click OK.

You have set Group #1 to link to Group #2 when Group #1 is clicked at runtime.
9. Right-click Group #2 Name, which is located in the Group Footer #2 section, and then click Format Object.
10. In the Format Editor, click the Hyperlink tab, and then select Report Part Drilldown.
11. In the Available Fields panel, do the following:

a. Expand Details.
b. CTRL-click CustomerName1, LastYearsSales1, and City1.
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c. Click the > symbol to move these fields into the Fields to Display panel.
d. Click OK.

You have set Group #2 to link to detailed information about the customer, when Group #2 is clicked at 
runtime.

12. From the File menu, select Save All.

1.5.2.9.3 Binding the Report

When you followed the instructions in the section Project Setup [page 15] to prepare for this tutorial, you placed a 
CrystalReportViewer control on the Web Form. However, to view report parts, you must use the 
CrystalReportPartsViewer control.

In this section, you instantiate the Customers report and bind it to the CrystalReportPartsViewer control. 
Then you test whether the report displays the report parts that you have created in the previous procedures.

You can instantiate and bind the report two ways:

● As an embedded report.
● As a non-embedded report.

Choose from one (but not both) of the step procedures below.

● If you use embedded reports, follow the next step procedure to instantiate the report as an embedded report.
● If you use non-embedded reports, follow the second step procedure to instantiate the report as a non-

embedded report.

Continue to Filtering Data in the Report [page 421].

1.5.2.9.3.1  To instantiate the Customers report as an 
embedded report and bind it to the 
CrystalReportPartsViewer control

1. Open the Web Form.
2. From the View menu, click Designer.
3. Delete the CrystalReportViewer control.
4. From the Toolbox, open the Crystal Reports node to locate the CrystalReportPartsViewer control.
5. Drag the CrystalReportPartsViewer control onto the Web Form.
6. From the Properties window, set the ID property:

○ For Visual Basic Web Sites, set the ID property to "myCrystalReportPartsViewer"
○ For C# Web Sites, set the ID property to "crystalReportPartsViewer".

7. From the View menu, click Code to view the code-behind class for this Web Form.
8. Add a new class-level declaration for the Customers report wrapper class, with the variable name 

customersReport. Set its access modifier to private.

 Private customersReport As Customers 
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 private Customers customersReport; 
9. Within the ConfigureCrystalReports() method, instantiate the report wrapper class.

Note
You created the ConfigureCrystalReports() method in Project Setup [page 15].

 customersReport = New Customers() 
 customersReport = new Customers(); 

10. On the next line beneath the report instantiation, bind the ReportSource property of the 
CrystalReportPartsViewer control to the instantiated report class (variable name: customersReport).

 myCrystalReportPartsViewer.ReportSource = customersReport 
 crystalReportPartsViewer.ReportSource = customersReport; 

Note
The CrystalReportPartsViewer control instance is accessible in the code because you added the control to 
your Web or Windows form. If IntelliSense does not recognize the CrystalReportPartsViewer control 
instance, verify that the CrystalReportPartsViewer control has been added as a class-level declaration to 
this code-behind class.

1.5.2.9.3.2  To instantiate the Customers report as a non-
embedded report and bind it to the 
CrystalReportPartsViewer control

You are now ready to build and run your project.

1. Open the Web Form.
2. From the View menu, click Code.
3. Add a new class-level declaration for the ReportDocument report wrapper class, with the variable name 

customersReport. Set its access modifier to private.

 Private customersReport As ReportDocument 
 private ReportDocument customersReport; 

Note
The ReportDocument class is a member of the CrystalDecisions.CrystalReports.Engine namespace. You 
have added an "Imports" [Visual Basic] or "using" [C#] declaration for this namespace in 
Project Setup [page 15]. When you instantiate ReportDocument and load a report into the namespace, you 
gain access to the report through the SDK, without embedding the report.
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4. Within the ConfigureCrystalReports() method (which you added during one of the procedures in Project 
Setup [page 15]), instantiate the ReportDocument class.

 customersReport = New ReportDocument() 
 customersReport = new ReportDocument(); 

5. Declare a string variable, name it reportPath, and assign to it a runtime path to the local report. This path is 
determined differently for Web Sites and Windows projects:
○ For a Web Site, pass the name of the local report file as a string parameter into the Server.MapPath() 

method. This maps the local report to the hard drive file directory path at runtime.

 Dim reportPath As String = Server.MapPath("Customers.rpt") 
 string reportPath = Server.MapPath("Customers.rpt"); 

○ For a Windows project, concatenate the Application.StartupPath property with a backslash and the 
local report file name. This maps the report to the same directory as the Windows executable file.

Note
At compile time you will copy the report to the directory containing the executable file.

 Dim reportPath As String = Application.StartupPath & "\" & "Customers.rpt" 
 string reportPath = Application.StartupPath + "\\" + "Customers.rpt"; 

6. Call the Load() method of the ReportDocument instance and pass into it the reportPath string variable.

 customersReport.Load(reportPath) 
 customersReport.Load(reportPath); 

7. On the next line, beneath the report loading, bind the ReportSource property of the CrystalReportPartsViewer 
to the ReportDocument instance.

 myCrystalReportPartsViewer.ReportSource = customersReport 
 crystalReportPartsViewer.ReportSource = customersReport; 

1.5.2.9.3.3  To test the loading of the Customers report

Whether you have chosen to instantiate an embedded report class or a non-embedded report through the 
ReportDocument class, the variable name used is the same: customersReport. This allows you to use a common 
set of code in the procedures that follow.

You are now ready to build and run your project. It is expected that the report loading will fail, because code has 
not yet been written to set a value for the City parameter field. You'll add a value for the City parameter field later 
in this tutorial.
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1. From the Build menu select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The Customers report is displayed in the Web browser.
4. Click a country to display a list of regions.
5. Click a region to display the Customer Name, Last Year's Sales, and City fields.
6. Return to Visual Studio and click Stop to exit from debug mode.

1.5.2.9.4 Filtering Data in the Report

In this section, you learn how to set the Data Context field to filter data that is displayed on the report. For more 
information about Data Context settings, see Implementing Report Part Drill Down [page 617].

1.5.2.9.4.1  To filter data in the report

1. Open the Crystal report.
2. Right-click in an empty area of the report. Select Report, and then click Report Options.
3. In the Data Context field, type "/Country[USA]".
4. Click OK to close the Report Options dialog.
5. From the Build menu, select Build Solution.
6. If you have any build errors, go ahead and fix them now.
7. From the Debug menu, click Start.

The report displays only records from the USA.
8. Return to Visual Studio and click Stop to exit from debug mode.

1.5.3  Reduced-Code Tutorials in Visual Studio

This section presents a variety of tutorials for the reduced-code development.

Note
For tutorials that use the coding model, see ReportDocument Object Model Tutorials [page 289].
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1.5.3.1 Tutorial: Reduced-Code Web Site Setup with SAP 
Crystal Reports Using Smart Tasks

In this tutorial, you learn how to use the new tag-based application development model in Visual Studio. You follow 
a reduced-code development model to set up a Web Site with SAP Crystal Reports, with Smart Tasks.

Introduction

In this tutorial, you create an ASP.NET Web Site in Visual Studio. Then you add a CrystalReportViewer control 
to the Web Form, which launches the new Smart Task panel. From Smart Tasks, you create a 
CrystalReportSource control, and then build a Crystal report. The report is referenced within the 
CrystalReportSource control.

Throughout this tutorial, you can preview the report three ways:

● In the embedded SAP Crystal Reports Designer, with the new Preview button in SAP Crystal Reports, 
developer version for Microsoft Visual Studio.

● In the Web Form, with dummy data.

Note
This preview of the Web Form is the new Design Time Preview feature.

● At runtime, when you build and compile the application.

At the end of this tutorial, you switch to HTML view (Source View) and explore the relationship between the 
CrystalReportViewer control and the CrystalReportSource control, in the new tag-based application model of 
Visual Studio 2005 or later.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_ReducedCode_WebSiteSetup
● Visual Basic Web Site: VB_Web_ReducedCode_WebSiteSetup
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Xtreme Database

This tutorial uses a sample database called Xtreme. The xtreme.mdb database file is included with the SAP 
Crystal Reports .NET SDK Sample Code package. To use the Xtreme database, you must manually create an 
ODBC connection to it.

Related Information

Viewing a report at design time [page 195]
Sample Reports Directory [page 14]

1.5.3.1.1 Creating a Web Site with a CrystalReportViewer 
Control

Before you create a Web Site, verify that SAP Crystal Reports, developer version for Microsoft Visual Studio has 
been installed on your system.

1. Start Visual Studio.
2. From the File menu, click New, and then select Web Site.
3. In the New Web Site dialog box, click ASP.NET Web Site.
4. In the Location dropdown, select File System.
5. In the Language dropdown, select the coding language that you wish to use.
6. In the Location text field enter the directory path C:\WebSites\, followed by the name of your project.

7. Click OK.
Your project opens in Solution Explorer and contains a Default.aspx page.

8. Open the Default.aspx page (the Web Form).
9. From the View menu, click Designer.

Note
You can also switch to design view by clicking the Design button at the bottom of the form view.

10. From the Toolbox, open the Reporting node to locate the CrystalReportViewer control.
11. Drag the CrystalReportViewer control onto the Web Form.

The "CrystalReportViewer Tasks" Smart Task panel opens.

Related Information

What Needs to be Installed? [page 10]
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1.5.3.1.2 Configuring the CrystalReportSource in Smart 
Tasks

Visual Studio 2005 and later has a new GUI feature for .NET controls that is called Smart Tasks. For the 
CrystalReportViewer control in Web Sites, the Smart Task panel is named "CrystalReportViewer Tasks."

The "CrystalReportViewer Tasks" Smart Task panel enables you to configure several features of the 
CrystalReportViewer control, without having to write code. Any selections that you make through the use of 
Smart Tasks are generated as tag-based settings within the ASPX page.

In this section, you learn how to configure the CrystalReportSource option that is available from the 
"CrystalReportViewer Tasks" Smart Task panel.

Later in these reduced-code tutorials, you examine other features of the "CrystalReportViewer Tasks" Smart 
Task.

1.5.3.1.2.1  To configure the CrystalReportSource using Smart 
Tasks

1. If the Smart Task panel is currently open, click the Web Form to close the Smart Task panel.
2. On the upper-right corner of the CrystalReportViewer control, click the small triangular button.

The Smart Task panel named "CrystalReportViewer Tasks" re-opens. In the Choose Report Source list, 
<None> is displayed.

3. Click the Choose Report Source list and select <New report source…>.
The Create ReportSource dialog box opens.

4. In the Specify a name for the control textbox, leave the default entry as CrystalReportSource1.
5. Click the Specify a report for the CrystalReportSource control list and select <New Report>.

Your alternative selection is <Browse…>. That option allows you to select an existing Crystal report from the 
file directory. However, in this tutorial you create a new report.

6. In the Create a New Crystal Report dialog box, enter the name "XtremeCustomers.rpt," and then click OK.
7. Click OK again to close the Choose Report Source dialog box.

1.5.3.1.3 Configuring the Report for the 
CrystalReportSource Control

In this section, you use the Report Wizard to configure the report and add it to the CrystalReportSource control. 
You create a database connection, set up the fields for the report, and then add the report to the control. Once 
you are finished, you test your reduced-code Web Site.
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1.5.3.1.3.1  To configure the report for the CrystalReportSource 
control

1. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 
Report Wizard.

2. In the Choose an Expert panel, select Standard, and then click OK.
3. In the Available Data Sources panel of the Standard Report Creation Wizard window, do the following:

a. Expand the Create New Connection folder.
b. Expand the ODBC (RDO) folder.

4. In the ODBC (RDO) window, select the correct ODBC DSN entry for the Xtreme database, and then click 
Finish.
The ODBC (RDO) folder expands and shows the Xtreme database.

5. Expand the Tables node and select the Customer table.
6. Double-click the Customer table to move the table into the Selected Tables panel, and then click Next.
7. Expand the Customer table, then CTRL-click Customer Name, Contact Title, Address1, Contact Last Name and 

City.
8. Click the > symbol to move these fields into the Fields to Display panel, and then click Next.
9. In the Available Fields panel, under Report Fields, select Customer.City, click the > symbol to move the field 

into the Group By panel, and then click Finish.
The XtremeCustomers report is created and loaded into the main window of Visual Studio.

10. At the bottom of the window, click Main Report Preview.

Note
The Preview button is available for the first time in the embedded SAP Crystal Reports Designer that ships 
with SAP Crystal Reports for Visual Studio 2005.

The report is displayed in preview mode and shows data from the Xtreme database.
11. At the bottom of the window, click Main Report to exit preview mode.
12. Open the Web Form.
13. From the View menu, click Designer.

The report is displayed in Design Time Preview mode, which shows the graphic layout for the report on the 
Web Form.

14. From the File menu, click Save All.

1.5.3.1.3.2  To test the reduced-code Web Site

Your report is created and designated as the report for the CrystalReportSource control. You are now ready to 
build and run your project.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
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4. The XtremeCustomers report is displayed in the Web browser.
5. Return to Visual Studio and click Stop to exit from debug mode.

1.5.3.1.4 Exploring the CrystalReportSource Control in 
Source View

In this section, you explore the tag-based application model that is used in ASP.NET version 2.0. This model 
makes it possible for you to set up a Web Site with SAP Crystal Reports, developer version for Microsoft Visual 
Studio, without having to write code. You also learn about the DataSource control framework and the 
CrystalReportSource control that are part of ASP.NET 2.0.

1. Open the Default.aspx page.
2. From the View menu, click Designer.
3. At the bottom of the Web Form, click the Source button.

The HTML for the Default.aspx page is displayed. This includes two related tags for SAP Crystal Reports:
○ The CrystalReportSource tag, which nests the Report tag. The Report tag references the report in its 

FileName property.

 <CR:CrystalReportSource ID="CrystalReportSource1" Runat="server"
EnableCaching="False" GroupPath="">
    <Report FileName="XtremeCustomers.rpt"></Report>
</CR:CrystalReportSource> 

○ The CrystalReportViewer tag, which references the CrystalReportSource by ID.

 <CR:CrystalReportViewer ID="CrystalReportViewer1" Runat="server"
AutoDataBind="True"
    Height="1158px" CssFilename="CssFilename"
ReportSourceID="CrystalReportSource1" Width="1059px" /> 

The code demonstrates the new tag-based application model that is part of ASP.NET 2.0. Similar to ASP.NET 
version 1.0, the CrystalReportViewer control is represented by an XML tag. However, the available properties 
for this control have been increased in ASP.NET 2.0, to support the tag-based application development model.

In ASP.NET 2.0, data connectivity has been encapsulated within the DataSource control. The 
CrystalReportSource control adapts the DataSource control framework, except that it encapsulates report 
connectivity, rather than data connectivity. This framework is handled by the ReportSourceID property, in the 
main visual control.

For more information about additional properties of the CrystalReportSource control, see The 
CrystalReportSource Control [page 48]. The properties are also demonstrated in other reduced-code tutorials 
later in this section.
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1.5.3.2 Tutorial: Reduced-Code Windows Project Setup with 
SAP Crystal Reports Using Smart Tasks

Introduction

In this tutorial, you learn how to create a Windows project in SAP Crystal Reports, developer version for Microsoft 
Visual Studio. You then add a CrystalReportViewer control to the Windows Form. From the Smart Task panel, you 
open the embedded SAP Crystal Reports Designer and create a new report. The Smart Tasks feature generates 
code that binds the report to the CrystalReportViewer control.

Throughout this tutorial, you can preview the report three ways:

● In the embedded SAP Crystal Reports Designer, with the new Preview button in SAP Crystal Reports, 
developer version for Microsoft Visual Studio.

● In the Windows Form, with dummy data.
● At runtime, when you build and compile the application.

At the end of this tutorial, you switch to code view, to see how the reduced-code development model functions in 
SAP Crystal Reports, developer version for Microsoft Visual Studio.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Windows project: CS_Win_ReducedCode_ProjectSetup.
● Visual Basic Windows project: VB_Win_ReducedCode_ProjectSetup.

Xtreme Database

This tutorial uses a sample database called Xtreme. The xtreme.mdb database file is included with the SAP 
Crystal Reports .NET SDK Sample Code package. To use the Xtreme database, you must manually create an 
ODBC connection to it.

Related Information

Sample Reports Directory [page 14]

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 427



1.5.3.2.1 Creating a Windows Project with a 
CrystalReportViewer Control

Before you create a Windows Project, verify that SAP Crystal Reports, developer version for Microsoft Visual 
Studio has been installed on your system.

1. Launch Visual Studio.
2. From the File menu, select New, and then click Project.
3. In the New Project dialog box, select a language folder for C# or Visual Basic from the Project Types list.
4. From the Templates list, click Windows Application.
5. In the Name field, replace the default project name with the name of your project.
6. Click OK.

Your project opens in Solution Explorer and contains a Form1 class.
7. Open the Form1 class.
8. From the Toolbox, open the Reporting node to locate the CrystalReportViewer control.
9. Drag the CrystalReportViewer control onto the Windows Form.
10. From the Properties window, set the Name property:

○ For Visual Basic projects, set the value to "myCrystalReportViewer."
○ For C# projects, set the value to "crystalReportViewer."

11. From the File menu, click Save All.

Related Information

What Needs to be Installed? [page 10]

1.5.3.2.2 Configuring the Report in Smart Tasks

For the CrystalReportViewer control in Windows projects, the Smart Task panel is named CrystalReportViewer 
Tasks.

Any selections that you make in Smart Tasks are generated as code in a Form1 partial class. In this section, you 
configure a new report with the CrystalReportViewer Tasks Smart Task panel and the embedded SAP Crystal 
Reports Designer. Later in these reduced-code tutorials, you examine other features of Smart Tasks.

1.5.3.2.2.1  Configuring the Report using Smart Tasks

1. On the upper-right corner of the CrystalReportViewer control, click on the small triangular button.
The Smart Task panel named CrystalReportViewer Tasks opens.

2. Click the Create a New Report link.
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3. In the Create a New Crystal Report dialog box, enter the name XtremeCustomers.rpt and then click OK.
The Crystal Reports Gallery dialog box opens.

4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 
Report Wizard.

5. In the Choose an Expert panel, select Standard, and then click OK.
6. In the Available Data Sources panel of the Standard Report Creation Wizard window, do the following:

a. Expand the Create New Connection folder.
b. Expand the ODBC (RDO) folder.

7. In the ODBC (RDO) window, select the correct ODBC DSN entry for the Xtreme Sample Database, and then 
click Finish.
The ODBC (RDO) folder expands and shows the Xtreme database.

8. Expand the Tables node, and then select the Customer table.
9. Double-click the Customer table to move the table into the Selected Tables panel, and then click Next.
10. CTRL-click Customer Name, Contact Title, Address1, and City.
11. Click the > symbol to move these fields into the Fields to Display panel, and then click Next.
12. In the Available Fields panel, under Report Fields, select Customer.City, click the > symbol to move the field 

into the Group By panel, and then click Finish.
The XtremeCustomers report is created and loaded into the main window of Visual Studio.

13. At the bottom of the window, click Main Report Preview.

Note
The Preview button is a new feature of the embedded SAP Crystal Reports Designer that ships with SAP 
Crystal Reports, developer version for Microsoft Visual Studio.

14. At the bottom of the window, click Main Report to exit Preview mode.
15. Return to the Form1 class.

The report is displayed in Design Time Preview mode, showing the report's graphic layout on the Web Form. 
Below Form1, the XtremeCustomers report is displayed in the component tray.

16. From the File menu, click Save All.

1.5.3.2.2.2  To rename the report variable

Your report is created and becomes the designated report for the CrystalReportViewer control. At this point, you 
may want to rename your report variable.

1. Click XtremeCustomers1 in the component tray to select it.
2. From the Properties window, set the Name field to "xtremeCustomersReport."

1.5.3.2.2.3  To test the reduced-code Windows project

You are now ready to build and run your project.
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1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. The XtremeCustomers report is displayed in a new Windows application.
5. Return to Visual Studio and click Stop to exit from debug mode.

1.5.3.2.3 Exploring the Code Generated by Smart Tasks

In this section, you explore the code that is generated by Smart Tasks, which enabled you to set up a Windows 
Project with SAP Crystal Reports without having to write code.

1.5.3.2.3.1  To explore the code generated by Smart Tasks

1. Open the Form1 class.
2. From the View menu, click Code.

The Form1 class opens in code view and displays an empty class.

Note
In C#, the empty class displays the class constructor.

 public Form1()
{
    InitializeComponent();
} 

1.5.3.2.3.2  To view the hidden Form1 partial class

Notice that the following code is missing:

● The declaration of the CrystalReportViewer control instance.
● The instance of the XtremeCustomers report.
● The code that binds the report to the CrystalReportViewer control.

The absent code has been hidden in a partial class. Partial classes allow one class to accept an addendum from 
another class file, by giving the other class file the same class name and prefixed with the word "partial." The 
partial class usually contains auto-generated designer code.

To view the auto-generated code that does not appear in the Form1 class, you will explore the 
CrystalReportViewer and report instances in the hidden Form1 partial class.

1. From Solution Explorer, click the toolbar icon Show All Files.
2. Expand Form1.cs or Form1.vb.
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The Form1.Designer.cs or .vb is displayed.
3. Right-click Form1.Designer.cs or .vb and select View Code.

The Form1 partial class opens and displays the auto-generated code for this class. This includes the 
declaration of the CrystalReportViewer control instance, the XtremeCustomers report instance, and the 
code that binds the report to the CrystalReportViewer control instance.

Note
If you prefer to write the code and place it into the code-behind class, see Project Setup [page 15].

1.5.3.3 Tutorial: Reduced-Code Secure Database Logon in a 
Web Site

In this reduced-code Web Site tutorial, you learn how to display a report that contains information from a secure 
SQL Server database.

Introduction

In this reduced-code Web Site tutorial, you learn how to display a report that contains information from a secure 
SQL Server database. To provide a secure database logon, you assign the report's DataSources property to the 
SQLDataSource control, which is part of the new DataSource control framework in .Net 2.0.

In this tutorial, to display a report that contains information from a secure SQL Server database, you use the new 
tag-based application development model to connect the key components:

● Connect a CrystalReportViewer control to a CrystalReportSource control.
● Connect the CrystalReportSource control to a report.
● Connect the report's DataSources property to an SqlDataSource control.

Note
DataSources is viewed as a report property in the Properties window, or as a tag in HTML view (Source 
view).

All of this work is done without having to write code.

Note
A coding development model of this tutorial is also available. See Tutorial: Logging onto a Secure SQL Server 
Database Using SQL Authentication [page 298] or Tutorial: Logging onto a Secure SQL Server Database Using 
Integrated Security [page 311].

To begin, you add a CrystalReportViewer control to the Web Form. From Smart Tasks, you create a 
CrystalReportSource control, and then build a Crystal report with the embedded SAP Crystal Reports Designer. 
This report logs on to a secure SQL server database. The report is referenced within the CrystalReportSource 
control.
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Then you learn how to configure the logon to the secure SQL server database, to return the required tables that 
are used by the Crystal report. To start, you select the "Enable Database Logon prompt" option in Smart Tasks. 
When that option is selected, the exception that is thrown during a database logon failure is replaced with a 
prompt that requests the user to log on manually.

To configure a consistent log on to the required database, you add a SqlDataSource control, and then configure it 
to address the secure SQL server database and return the required tables.

Finally, you assign the DataSource property of the report to the SqlDataSource control that you have created.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_ReducedCode_DBLogon
● Visual Basic Web Site: VB_Web_ReducedCode_DBLogon

Related Information

Sample Reports Directory [page 14]

1.5.3.3.1 Creating a Web Site with a CrystalReportViewer 
Control 

Before you create a Web Site, verify that SAP Crystal Reports, developer version for Microsoft Visual Studio has 
been installed on your system.

Some database setup is required as a prerequisite to this tutorial.

1.5.3.3.1.1  Prerequisite Database Setup

● SQL Server configuration:
○ If you have SQL Server (or the OEM version, MSDE) installed, it must be configured to require SQL Server 

Authentication.
○ If you do not have SQL Server (or the OEM version, MSDE) installed, you must install MSDE with SQL 

Server Authentication set to "True."
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● The Northwind database provided with SQL Server must be installed and verified that it requires SQL Server 
Authentication.

● A limited access account must be created for use within the Web site.

Once you have configured SQL Server and the Northwind database according to the sections above, you are 
ready to create a Web Site that displays a Crystal report drawing its information securely from a Northwind 
database.

1.5.3.3.1.2  To set up a reduced-code Web Site in SAP Crystal 
Reports, developer version for Microsoft Visual 
Studio

1. Launch Visual Studio.
2. From the File menu, select New, and then click Web Site.
3. In the New Web Site dialog box, click ASP.NET Web Site.
4. In the Location dropdown, select File System.
5. In the Language dropdown, select the coding language that you wish to use.
6. In the Location text field enter the directory path C:\WebSites\, followed by the name of your project.

7. Click OK.
Your project opens in the Solution Explorer and contains a Default.aspx page.

8. Open the Default.aspx page (the Web Form).
9. From the View menu, click Designer.

Note
You can also switch to design view by clicking the Design button at the bottom of the form view.

10. From the Toolbox, open the Reporting node to locate the CrystalReportViewer control.
11. Drag the CrystalReportViewer control onto the Web Form.

The Smart Task panel named "CrystalReportViewer Tasks" opens.

1.5.3.3.2 Configuring the CrystalReportSource in Smart 
Tasks

A new GUI feature for .NET controls, called Smart Tasks, was added in Visual Studio 2005. For the 
CrystalReportViewer control in Web Sites, the Smart Task panel is named "CrystalReportViewer Tasks."

The "CrystalReportViewer Tasks" Smart Task panel enables you to configure several features of the 
CrystalReportViewer control, without having to write code.

Any selections that you make in Smart Tasks are generated as tag-based settings within the ASPX page.

In this section, you configure the CrystalReportSource control that is available from the "CrystalReportViewer 
Tasks" Smart Task. Later in these reduced-code tutorials, you examine other features of Smart Tasks.
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To begin, you learn how to close and re-open Smart Tasks.

Related Information

The Smart Tasks Panel [page 43]

1.5.3.3.2.1  Configuring the CrystalReportSource using Smart 
Tasks

1. If the Smart Task panel is currently open, click on the Web Form to close Smart Tasks.
2. On the upper-right corner of the CrystalReportViewer control, click on the small triangular button.

The Smart Task panel named "CrystalReportViewer Tasks" re-opens. In the Choose Report Source list, 
<None> is displayed.

3. Click the Choose Report Source list and select <New report source…>.
The Create ReportSource dialog box opens.

4. In the Specify a name for the control textbox, leave the default entry as CrystalReportSource1.
5. Click the Specify a report for the ReportSource control drop- down list and select <New Report>.

Your alternative selection is <Browse…>. That option allows you to select an existing Crystal report from the 
file directory. However, later you will create a new report that is required for this tutorial.

6. In the Create a New Crystal Report dialog box, enter the name "NorthwindCustomers.rpt".
7. Click OK, and then click OK again to close the Create ReportSource dialog box.

1.5.3.3.3 Creating and Connecting the Report to a Secure 
Database

You now begin the process of creating and connecting the report.

1.5.3.3.3.1  To create and connect the report to a secure 
database

1. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 
Report Wizard.

2. In the Choose an Expert panel, select Standard, and then click OK.
3. In the Available Data Sources panel, expand the Create New Connection folder.
4. From the subfolder that opens, expand the OLE DB (ADO) folder.
5. In the OLE DB (ADO) dialog box, select Microsoft OLE DB Provider for SQL Server, and then click Next.
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6. You can now use either SQL Authentication, or Windows Authentication with Integrated Security:
○ If you are using SQL Authentication, enter the values for your database server, user id, and password into 

the Server, User ID, and Password fields and then from the Database list, select "Northwind."

Note
For security reasons, it is important that you use a database account with limited access permissions.

○ If you are using Windows Authentication with Integrated Security, enter the value for your database 
server and check the Integrated Security checkbox, and then from the Database list, select "Northwind."

7. Click Finish.
The OLE DB folder expands to show your database server and, within it, the Northwind database.

8. Expand the nodes Northwind, dbo, and Tables, and then select the Customers table.
9. Click the > symbol to move the table into the Selected Tables panel, and then click Next.
10. Hold down CTRL and click CompanyName, ContactName and City.
11. Click the > symbol to move these fields into the Fields to Display panel, and then click Next.
12. In the Available Fields panel, under Report Fields, select Customer.City, click the > symbol to move the field 

into the Group By panel, and then click Finish.
The NorthwindCustomers report is created and loaded into the main window of Visual Studio.

13. At the bottom of the window, click Main Report Preview.
The report is displayed in preview mode and shows data from the secure Northwind database.

14. At the bottom of the window, click Main Report to exit Preview mode.
15. Open the Web Form.
16. From the View menu, click Designer.

The report is displayed in Design Time Preview mode and shows the report's graphic layout on the Web Form.
17. From the File menu, click Save All.

1.5.3.3.3.2  To test the reduced-code Web Site

Your report is created and is now the designated report for the CrystalReportSource control. You are now ready to 
build and run your project.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.
4. A database logon prompt page appears, asking you to enter the database password.

This is the expected result, for two reasons:
○ You have not yet configured the data source.
○ In Smart Tasks for the CrystalReportViewer control, the "Enable database logon prompting" checkbox is 

selected by default.
5. Enter the password and click Logon.
6. The NorthwindCustomers report is displayed in the Web browser.
7. Return to Visual Studio and click Stop to exit from debug mode.
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1.5.3.3.4 Configuring Database Logon Prompting in the 
Smart Task

In this procedure, you examine the effect of turning off "Enable Database Logon Prompting" in the Smart Task.

1.5.3.3.4.1  To configure Database Logon Prompting in the 
Smart Task

1. Open the Default.aspx page (the Web Form).
2. From the View menu, click Designer.
3. On the upper-right corner of the CrystalReportViewer control, click on the small triangular button.

The Smart Task panel "CrystalReportViewer Tasks" opens.
4. Clear the Enable Database Logon Prompting checkbox.
5. Click on the Web Form to close the Smart Task.
6. From the Build menu, select Build Solution.
7. If you have any build errors, go ahead and fix them now.
8. From the Debug menu, click Start.

Because database logon prompting is no longer enabled, a Logon Failed exception is thrown in the Web 
application window.

9. Return to Visual Studio and click Stop to exit from debug mode.
10. Return to the Smart Task panel for the CrystalReportViewer control.
11. Select the Enable Database Logon Prompting checkbox.
12. Close Smart Tasks.
13. From the File menu, click Save All.

1.5.3.3.5 Adding a SqlDataSource control

In ASP.NET 2.0, data sources are now configured and accessed through the new DataSource control framework. 
By default, a Crystal report bypasses the need for a separate data source because data access is encapsulated 
within the report.

However, if the data is from a secure SQL server, then the report requires a data source to manage the logon 
process.

1.5.3.3.5.1  To add a SqlDataSource control

1. Open the Default.aspx page (the Web Form).
2. From the View menu, click Designer.
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Note
You can also switch to design view by clicking the Design button at the bottom of the form view.

3. Click your mouse to the right of the CrystalReportSource control, then press ENTER.
A flashing cursor appears below the CrystalReportSource control.

4. In the Toolbox, click the Data sub node to expand the Data controls.
5. From the Data sub node, drag a SqlDataSource control onto the Web Form below the CrystalReportSource 

control.
6. In the Smart Task panel (named SqlDataSource Tasks), click Configure Data Source….
7. In the Configure Data Source window, click New Connection….
8. In the Add Connection dialog box, in the Server name field, enter the name of your database server.
9. In the Log on to the server panel, choose either the Use SQL Server Authentication or the Use Windows 

Authentication radio button.
10. If you chose SQL Server Authentication, do the following:

○ Enter values into the User name and Password fields.

Note
Remember to use the limited access database account.

○ Select the Save my password checkbox.
11. If you chose Windows Authentication, go to the next step.
12. In the Connect to a database panel, select the Select or enter a database name radio button.
13. From the list, select Northwind, and then click Test Connection.
14. The Northwind connection is verified. If the connection fails, check your password.
15. Once the test connection succeeds, click OK to close the Connection Properties window.
16. In the Configure Data Source window, the Connection String field shows the complete connection information.

○ If you chose Windows Authentication, the Integrated Security property is set to true.

 Data Source=ABCDE;Initial Catalog=Northwind;Integrated Security=True 
○ If you chose SQL Authentication, the UserID and password values are assigned.

Note
For security reasons, it is important that you use a database account with limited access permissions.

In the code that you write, replace the sample server name, database name and password (shown below) 
with your own connection information.

 Server=ABCDE;User 
ID=limitedPermissionAccount;Password=1234;Database=Northwind;Persist Security 
Info=True 

17. Click Next, and in the following window click Next again to save the connection with a default name of 
"NorthwindConnectionString."

18. Click the Specify columns from a table or view option.
19. In the Name list, select "Customers."
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20.In the Columns pane, select the Company Name, Contact Name and City checkboxes, and then click Next.

Note
The columns selected here must match the columns that are selected in your original report. If you later 
change the columns that are selected in your report, with the embedded SAP Crystal Reports Designer, 
you must change the columns here in your SQL statement. For scalability purposes, it is strongly 
recommended that you do not use the asterisk selection, but instead choose the specific columns that are 
used by your report.

21. In the Test Query window, click Test Query.
22. If the query is successful, then click Finish.
23.The SqlDataSource control is displayed at the bottom of the window, below the CrystalReportViewer control 

and the CrystalReportSource control.

1.5.3.3.6 Connecting CrystalReportSource to the 
SqlDataSource Control

On your Web Form, you now have three controls that are related to each other:

● The CrystalReportViewer control, which links to the CrystalReportSource control to access the report to 
display it.

● The CrystalReportSource control, which encapsulates the report.
● The SqlDataSource control, which encapsulates data access information.

Remember that the CrystalReportSource control was linked to the CrystalReportViewer control when adding the 
CrystalReportViewer control to the Web Form. However, nothing has occurred to link the CrystalReportSource to 
the SqlDataSource. Therefore, even though the data configuration information exists, at runtime the report would 
not be able to find this information and would ask for logon.

In this section, you connect the CrystalReportSource to the SqlDataSource control. For this task, you use the 
DataSource Collection Editor dialog box.

1.5.3.3.6.1  To connect the CrystalReportSource to the 
SqlDataSource control

1. Open the Default.aspx page (the Web Form).
2. From the View menu, click Designer.
3. Select the CrystalReportSource control.
4. From Properties, expand Report.

Note
If the Properties Explorer is not visible, from the View menu, click Properties Window.
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5. Within the Report property, click the ellipsis (...) on the far right of DataSources (Collection).
6. In the Data Source Collection Editor dialog box, do the following:

a. Click Add.
b. In the Report panel, select Main report.
c. In the Choose Data Source combo box, click SqlDataSource1.
d. Select Specify Table Name, and in the field type "Customers".

7. Click OK.
8. At the bottom of the Default.aspx page, click Source.
9. Locate the CrystalReportSource tags.
10. Within the CrystalReportSource tags, locate the Report tag.
11. Within the Report tags (between the opening and closing tags), verify that the following DataSources tagging 

information has been generated.

 <DataSources>
    <CR:DataSourceRef DataSourceID="SqlDataSource1" TableName="Customers" />
</DataSources> 

12. From the Build menu, click Build Solution.
13. If you have any build errors, go ahead and fix them now.
14. From the Debug menu, click Start.

The report is now successfully displayed with secure logon to the SQL Server database.

1.5.3.4 Tutorial: Reduced-Code Parameter Setting in a Web 
Site

In this reduced-code Web Site tutorial, you learn how to display a report that contains parameters, and how to 
pass parameter values to that report with the new Data Parameters model.

Introduction

In this tutorial, you use the new tag-based application development model to connect the key components:

● Connect a CrystalReportViewer control to a CrystalReportSource control.
● Connect the CrystalReportSource control to a report that contains a parameter.
● Connect the report's Parameters tag to one of the parameter sources in the new Data Parameters model, 

which is included with ASP.NET version 2.0.

All of this work is done without having to write code.

Note
A coding model of this tutorial is also available. See Tutorial: Reading and Setting Discrete Parameters [page 
326].

To begin, you add a CrystalReportViewer control to the Web Form. From Smart Tasks, you create a 
CrystalReportSource control, and then build a Crystal report with the embedded SAP Crystal Reports Designer. 
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This report includes a parameter that is applied to search criteria for the report. The report is referenced within 
the CrystalReportSource control.

You then use the Enable Parameters Prompt option in Smart Tasks. When that option is enabled, the exception 
that is thrown during a database logon failure is replaced with a prompt that requests the user to supply a 
parameter.

However, you need a means to customize your parameter selection. To do that, you add a DropDownList that 
contains a list of parameter values that can be selected for the report.

Finally, you open the Parameter Collection Editor for the report, and configure a connection between the report 
parameter and the DropDownList control that you have added.

Note
A ControlParameter is only one possible parameter source in the Data Parameters model. Other possible 
parameter sources include the QueryStringParameter, SessionParameter, FormParameter or 
CookieParameter. For some of these parameter source types you edit the Parameters tag directly in HTML 
view (source view).

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_ReducedCode_Parameters
● Visual Basic Web Site: VB_Web_ReducedCode_Parameters

Xtreme Database

This tutorial uses a sample database called Xtreme. The xtreme.mdb database file is included with the SAP 
Crystal Reports .NET SDK Sample Code package. To use the Xtreme database, you must manually create an 
ODBC connection to it.

Related Information

Sample Reports Directory [page 14]
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1.5.3.4.1 Creating a Web Site with a CrystalReportViewer 
control

Before you create a Web Site, verify that SAP Crystal Reports, developer version for Microsoft Visual Studio has 
been installed on your system.

1. Start Visual Studio.
2. From the File menu, select New, and then click Web Site.
3. In the New Web Site dialog box, click ASP.NET Web Site.
4. In the Location dropdown, select File System.
5. In the Language dropdown, select the coding language that you wish to use.
6. In the Location text field enter the directory path C:\WebSites\, followed by the name of your project.

7. Click OK.
Your project is displayed in the Solution Explorer and contains a Default.aspx page.

8. Open the Default.aspx page (the Web Form).
9. From the View menu, click Designer.

Tip
You can also switch to design view by clicking the Design button at the bottom of the form view.

10. From the Toolbox, open the Reporting node to locate the CrystalReportViewer control.
11. Drag the CrystalReportViewer control onto the Web Form.

The "CrystalReportViewer Tasks" Smart Task panel opens.

Related Information

What Needs to be Installed? [page 10]

1.5.3.4.2 Configuring the CrystalReportSource in Smart 
Tasks

A new GUI feature for .NET controls, called Smart Tasks, was added in Visual Studio 2005. For the 
CrystalReportViewer control in Web Sites, the Smart Task panel is named "CrystalReportViewer Tasks."

The "CrystalReportViewer Tasks" Smart Task panel enables you to configure several features of the 
CrystalReportViewer control, without having to write code. Any selections that you make in Smart Tasks are 
generated as tag-based settings within the ASPX page.

In this section, you configure the main feature that is available from the "CrystalReportViewer Tasks" Smart Task: 
the CrystalReportSource control. Later in these reduced-code tutorials, you examine other features of Smart 
Tasks.

To begin, you learn how to close and re-open Smart Tasks.
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1. If the Smart Task panel is currently open, click on the Web Form to close the Smart Task panel.
2. On the upper-right corner of the CrystalReportViewer control, click on the small triangular button.

The named "CrystalReportViewer Tasks" re-opens. In the Choose Report Source list, <None> is displayed.
3. Click the Choose Report Source list and select <New report source…>.

The Create ReportSource dialog box opens.
4. In the Specify a name for the CrystalReportSource control textbox, leave the default entry as 

CrystalReportSource1.

5. Click the Specify a report for the ReportSource control drop- down list and select <New Report>.

Your alternative selection is <Browse…>. That option allows you to select an existing Crystal report from the 
file directory. However, later you will create a new report that is required for this tutorial.

6. In the Create a New Crystal Report dialog box, enter the name "XtremeCustomers.rpt" and click OK, and then 
click OK again within the Create Report Source dialog box.

1.5.3.4.3 Creating the Report with Parameters

To begin, create a report that draws information from the Xtreme database.

1.5.3.4.3.1  To create the report with parameters

1. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 
Report Wizard.

2. In the Choose an Expert panel, select Standard, and then click OK.

The Standard Report Creation Wizard window appears.
3. In the Available Data Sources panel of the Standard Report Creation Wizard window, expand the Create New 

Connection folder.
4. From the subfolder that opens, expand the ODBC (RDO) folder.
5. In the ODBC (RDO) dialog box, select the correct ODBC DSN entry for your the Xtreme database, and then 

click Next.
6. Leave the User ID and Password blank, and then click Finish.

The ODBC (RDO) folder expands and shows the Xtreme database.
7. Expand the Tables node and select the Customer table.
8. Double-click the Customer table to move the table into the Selected Tables panel, and then click Next.
9. Expand the Customer table, then CTRL-click Customer Name, Contact Title, Address1, Contact Last Name and 

City.
10. Click the > symbol to move these fields into the Fields to Display panel, and then click Next.
11. In the Available Fields panel, under Report Fields, select Customer.City, click the > symbol to move the field 

into the Group By panel, and then click Finish.
The CustomersByCity report is created and loaded into the main window of Visual Studio.

You are now ready to add a parameter named City and populate it with default values.
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1.5.3.4.3.2  To add a City parameter

The Field Explorer must be visible, because it provides access to the various features of the report, including 
parameters.

1. If the Field Explorer is not visible, on the Crystal Reports toolbar, click Toggle Field View.

Note
Another way to display the Field Explorer is to go to the Crystal Reports menu, and then click Field Explorer.

2. In the Field Explorer, right-click Parameter Fields and select New....
3. In the Create Parameter Field dialog box:

a. Set the Name to City.
b. Set the Type to String. Set the Prompting Text to Select one or more cities.
c. Set the Value Field to City.
d. Click Actions, then select Append all database values. This will add the entire cities list into the middle 

pane.
e. In the Value Options pane, set the Prompt Text to Select one or more cities.
f. In the same pane, set Allow multiple values to True.
g. Set Allow discrete values to True.

4. Click OK to close the Create Parameter Field dialog box.

1.5.3.4.3.3  To connect the City parameter to the City database 
column

You now use the Select Expert to set a formula that connects the City database column to your newly created City 
parameter field.

1. On the Crystal Reports toolbar, click Select Expert.
2. In the Choose Field dialog box, under Report Fields, select Customer.City, and then click OK.
3. In the Select Expert dialog box, within the Customer.City tab, set the list to is equal to.
4. In the new list that appears to the right, select the first choice in the list, {?City}, and then click OK.

Note
This selection, {?City}, is the City parameter that you created earlier.

5. From the File menu, select Save All.
6. At the bottom of the window, click Main Report Preview.
7. In the Enter Parameter Values dialog box, select at least one city from the Discrete Values list, click Add, and 

then click OK.

The report is displayed in preview mode, with the city parameter value that you selected.
8. At the bottom of the window, click Main Report to exit Preview mode.
9. Open the Web Form.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 443



10. From the View menu, click Designer.

The report is displayed in Design Time Preview mode and shows the report's graphic layout on the Web Form.
11. From the File menu, click Save All.

1.5.3.4.3.4  To test the reduced-code Web Site

Your report is created and is now the designated report for the CrystalReportSource control. You are now ready to 
build and run your project.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

A parameters prompt page appears, asking you to select a prompt from a DropDownList. This is the expected 
result, for two reasons:

○ You have not yet configured the Parameters tag in the report.
○ In Smart Tasks for the CrystalReportViewer control, the Enable report parameter prompting checkbox is 

selected by default.
4. Select a parameter and click OK.
5. The CustomersByCity report is displayed in the Web browser, showing the city you have selected.
6. Return to Visual Studio and click Stop to exit from debug mode.

1.5.3.4.4 Configuring Report Parameter Prompting in Smart 
Tasks

In this procedure, you examine the effect of turning off "Enable Report Parameter Prompting" in Smart Tasks.

1. Open the Default.aspx page (the Web Form).
2. From the View menu, click Designer.
3. On the upper-right corner of the CrystalReportViewer control, click on the small triangular button.

The Smart Task panel named "CrystalReportViewer Tasks" opens.
4. Clear the Enable Report Parameter Prompting checkbox.
5. Click on the Web Form to close Smart Tasks.
6. From the Build menu, select Build Solution.
7. If you have any build errors, go ahead and fix them now.
8. From the Debug menu, click Start.

Because report parameter prompting is no longer enabled, a "Missing Parameter Values" exception is thrown 
in the Web application window.

9. Return to Visual Studio and click Stop to exit from debug mode.
10. Return to the Smart Task panel for the CrystalReportViewer control.
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11. Select the Enable Report Parameters Prompting checkbox.
12. Close Smart Tasks.
13. From the File menu, click Save All.

1.5.3.4.5 Preparing a Control with Parameter Values

In this section you prepare a DropDownList control with city values. In the next section, the city values are passed 
to the report parameters.

1. Open the Default.aspx page (the Web Form).
2. From the View menu, click Designer.
3. Above the CrystalReportViewer control, type Select a city:.

4. From the Toolbox, drag a DropDownList control to the right of the text.

The Smart Task panel named "Common DropDownList Tasks" opens.
5. In the Smart Task panel, click Edit Items.
6. In the List Item Collection Editor dialog box, click Add.

In the Members panel, a new ListItem entry is created.
7. In the List Item Properties panel, click into the Text field, and type Paris.

8. Click Add again.

In the Members panel, a second ListItem entry is created.
9. In the List Item Properties panel, click into the Text field, and type Tokyo.

10. Click OK.
11. Click on the Web Form to close Smart Tasks for the DropDownList control.
12. Click DropDownList to select it.
13. From the Properties window, set the ID field to cityList.

14. From the Toolbox, drag a Button control to the right of the DropDownList control.
15. From the Properties window,

a. Set the Text field to Redisplay Report.
b. Set the ID field to redisplay.

16. From the File menu, click Save All.

You now have a DropDownList control, with two city parameter values and a button to post values from this 
control. However, the report is not yet aware of this control and the values that it contains. In the next section, you 
connect the DropDownList control to the <Parameters> tag of the report.
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1.5.3.4.6 Configuring Parameters for the 
CrystalReportSource Control

The CrystalReportSource control that you created in this tutorial implements the new Parameters model that is 
included with ASP.NET 2.0. Any parameter type that is part of the Data Parameters model can be passed as a 
parameter to the CrystalReportSource, including the following parameters:

● ControlParameter
● QueryStringParameter
● SessionParameter
● FormParameter
● CookieParameter

In this tutorial, a ControlParameter is used. The DropDownList control that you created and populated with a list 
of cities in the previous section is configured as the parameter source for the report parameter contained in the 
CrystalReportSource control.

1. Open the Default.aspx page (the Web form).
2. From the View menu, click Designer.
3. Select the CrystalReportSource control.
4. From Properties, expand Report.
5. Within the Report property, click the ellipsis ( ...) on the far right of Parameters (Collection).
6. In the Parameters Collection Editor dialog box, do the following:

a. Click Add.
b. In the Report panel, select Main report.
c. In the Parameter Name combo box, click City.
d. Select Specify Control ID, and in the combo box click cityList.

7. Click OK.
8. At the bottom of the Default.aspx page, click Source.
9. Locate the CrystalReportSource control tagging information.

10. Within the CrystalReportSource tags, locate the Report tag.

11. Within the Report tags (between the opening and closing tags), verify the following Parameters tagging 
information.

 <Parameters>
<CR:controlparameter name="City" propertyname="SelectedValue"
controlid="cityList"></CR:controlparameter>
</Parameters> 

12. From the Build menu select Build Solution.
13. If you have any build errors, go ahead and fix them now.
14. From the Debug menu, click Start.

The report is now successfully displayed with the parameter value from the default (first) selection in your list.
15. Change the parameter value to another value and click the Redisplay Report button.
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Note
If you want to populate the DropDownList control with the default values for the City parameter from the 
CustomersByCity report, see the tutorial Tutorial: Reading and Setting Discrete Parameters [page 326].

The report shows the city value you have selected in the DropDownList control.

1.5.3.5 Tutorial: Reduced-Code Exposing Report Data to 
Other Controls in a Web Site

In this reduced-code Web Site tutorial, you learn how to expose report data from the CrystalReportViewer control 
to other controls in the Web Site.

Introduction

In this tutorial, you learn to expose Crystal report data from the CrystalReportViewer control to a label control in 
the Web Site.

To begin, you create an ASP.NET Web Site in Visual Studio and you add a CrystalReportViewer control to the Web 
Form. Then you add a label to the Web Form to display report data. From Smart Tasks, you create a 
CrystalReportSource control, and then add a sample report to it. You add a drill-down event to the 
CrystalReportViewer control. Finally, you expose the drill-down event's report data to the label control.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_ReducedCode_ReportData
● Visual Basic Web Site: VB_Web_ReducedCode_ReportData

Xtreme Database

This tutorial uses a sample database called Xtreme. The xtreme.mdb database file is included with the SAP 
Crystal Reports .NET SDK Sample Code package. To use the Xtreme database, you must manually create an 
ODBC connection to it.
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Related Information

Sample Reports Directory [page 14]

1.5.3.5.1 Creating a Web Site with a CrystalReportViewer 
control 

Before you create a Web Site, verify that SAP Crystal Reports, developer version for Microsoft Visual Studio has 
been installed on your system.

1. Start Visual Studio.
2. From the File menu, select New, and then click Web Site.
3. In the New Web Site dialog box, click ASP.NET Web Site.
4. In the Location dropdown, select File System.
5. In the Language dropdown, select the coding language that you wish to use.
6. In the Location text field enter the directory path "C:\WebSites\", followed by the name of your project.

7. Click OK.
Your project is displayed in the Solution Explorer and contains a Default.aspx page.

8. Open the Default.aspx page (the Web Form).
9. From the View menu, click Designer.

Note
You can also switch to design view by clicking the Design button at the bottom of the form view.

10. Click on the Web Form and press Enter on your keyboard three times to create space for the Label control and 
for the CrystalReportViewer control.

11. From the Toolbox, open the Reporting node to locate the CrystalReportViewer control.
12. Drag the CrystalReportViewer control onto the Web Form, to the bottommost space.

The "CrystalReportViewer Tasks" Smart Task panel opens.
13. Press Esc on your keyboard to close the Smart Task panel.
14. Click the CrystalReportViewer control to select it.
15. From the Properties window, set the ID property:

○ For Visual Basic Web Sites, set the ID property to "myCrystalReportViewer".
○ For C# Web Sites, set the ID property to "crystalReportViewer".

16. From the File menu, click Save All.

Related Information

What Needs to be Installed? [page 10]
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1.5.3.5.2 Adding a Label Control to a Web Site

This section shows you how to add a label to the Web Form. The label that you add in this section shows the 
exposed report data later in this tutorial.

1. From the Toolbox, open the Standard node to locate the Label control.
2. Drag the Label control onto the Web Form, to the topmost space.
3. Click the Label control to select it.
4. From the Properties window, set the ID property to "drillLabel".
5. From the File menu, click Save All.

1.5.3.5.3 Configuring the CrystalReportSource using Smart 
Tasks

A new GUI feature for .NET controls, called Smart Tasks, was added to Visual Studio 2005. For the 
CrystalReportViewer control in Web Sites, the Smart Task panel is named CrystalReportViewer Tasks.

The CrystalReportViewer Tasks Smart Task panel enables you to configure several features of the 
CrystalReportViewer control, without having to write code. Any selections that you make in Smart Tasks are 
generated as tag-based settings within the ASPX page.

In this section, you configure the main feature that is available from the CrystalReportViewer Tasks Smart Task: 
the CrystalReportSource control. Later in these reduced-code tutorials, you examine other features of Smart 
Tasks.

1. If the Smart Task panel is currently open, click on the Web Form to close the Smart Task panel.
2. On the upper-right corner of the CrystalReportViewer control, click on the small triangular button.

The named CrystalReportViewer Tasks re-opens. In the Choose Report Source list, <None> is displayed.
3. Click the Choose Report Source list and select <New report source…>.

The Create ReportSource dialog box opens.
4. In the Specify a name for the control textbox, leave the default entry as CrystalReportSource1.
5. Click the Specify a report for the ReportSource control drop- down list and select <Browse…>.

The Select a Crystal Report dialog box opens.
6. Navigate to the World Sales Report.rpt file in the General Business folder of the SAP Crystal Reports sample 

reports directory.
7. Select the World Sales Report.rpt file and click Open.

At this point, the report becomes the designated report for the CrystalReportViewer control.
8. From the File menu, click Save All.

1.5.3.5.4 Adding a drill-down event to the 
CrystalReportViewer control

This section shows you how to add a drill-down event to the CrystalReportViewer control so that when the user 
drills down on the report, the label can display the name of the report part that was drilled down on.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 449



1. From the View menu, click Code to view the code-behind class for this Web Form.
2. From the View menu, click Designer to go back to the designer view of the Web Form.
3. Click the CrystalReportViewer control to select it.
4. In the Properties window, click the Events button to view the list of events associated with the 

CrystalReportViewer control.
5. From the list of available events, under the Action node, locate the Drill event.
6. To generate the drill-down event handler code, double click on the Drill event in the Properties window.

The following code is generated to handle the drill-down event:

 Protected Sub myCrystalReportViewer_Drill(ByVal source As Object,
ByVal e As CrystalDecisions.Web.DrillEventArgs) Handles
myCrystalReportViewer.Drill
End Sub 
 protected void crystalReportViewer_Drill(object source,
CrystalDecisions.Web.DrillEventArgs e)
{
} 

7. From the File menu, click Save All.

1.5.3.5.5 Exposing Drill-Down Event Report Data to the Label 
Control

This section shows you how to add text to the Label control to indicate which part of the report the user has drilled 
down on.

1.5.3.5.5.1  To expose drill-down event report data to the Label 
control

1. From the View menu, click Code to view the code-behind class for this Web Form.
2. Locate the following code that handles the drill-down event:

 Protected Sub myCrystalReportViewer_Drill(ByVal source As Object,
ByVal e As CrystalDecisions.Web.DrillEventArgs) Handles
myCrystalReportViewer.Drill
End Sub 
 protected void crystalReportViewer_Drill(object source,
CrystalDecisions.Web.DrillEventArgs e)
{
} 

3. To display the name of the drilled down report part on the Label control, add the following line of code in the 
event handler method:

 drillLabel.Text = e.NewGroupName 
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 drillLabel.Text = e.NewGroupName; 
4. From the File menu, click Save All.

1.5.3.5.5.2  To build and run the project

You are now ready to build and run the project.

1. From the Build menu, click Build Solution.
2. If you have any build errors, fix them now.
3. From the Debug menu, click Start.

If no build errors appear, the project loads into your Web browser and displays the Web Form, with the World 
Sales Report generated on the form.

4. To test that the label displays the drill-down event report data correctly, under the Top 5 Countries' Sales 
heading, click on USA to drill down on this part of the report. The page reloads and the USA sales report 
displays, "USA".

5. Return to Visual Studio, and then click Stop to exit from debug mode.

1.5.3.6 Tutorial: Reduced-Code Exposing Report Data to 
Other Controls in a Windows Application

In this reduced-code tutorial, you learn how to expose report data from the CrystalReportViewer control to other 
controls in the Windows project.

Introduction

In this tutorial, you learn to expose Crystal report data from the CrystalReportViewer control to a label control 
in the Windows project.

To begin, you learn how to create a Windows project in SAP Crystal Reports, developer version for Microsoft 
Visual Studio. You then add a CrystalReportViewer control to the Windows Form. Then you add a label to the 
Windows Form to display report data. From Smart Tasks, you create a CrystalReportSource control, and then 
add a sample report to it. You add a drill-down event to the CrystalReportViewer control. Finally, you expose 
the drill-down event's report data to the label control.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.
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The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Windows Application: CS_Win_ReducedCode_ReportData
● Visual Basic Windows Application: VB_Win_ReducedCode_ReportData

Xtreme Database

This tutorial uses a sample database called Xtreme. The xtreme.mdb database file is included with the SAP 
Crystal Reports .NET SDK Sample Code package. To use the Xtreme database, you must manually create an 
ODBC connection to it.

Related Information

Sample Reports Directory [page 14]

1.5.3.6.1 Creating a Windows Project with a 
CrystalReportViewer Control

Before you create a Windows Project, verify that SAP Crystal Reports, developer version for Microsoft Visual 
Studio has been installed on your system.

1. Launch Visual Studio.
2. From the File menu, select New, and then click Project.
3. In the New Project dialog box, select a language folder for C# or Visual Basic from the Project Types list.
4. From the Templates list, click Windows Application.
5. In the Name field, replace the default project name with the name of your project.
6. Click OK.

Your project opens in Solution Explorer and contains a Form1 class.
7. Open the Form1 class.
8. From the Toolbox, open the Reporting node to locate the CrystalReportViewer control.
9. Drag the CrystalReportViewer control onto the Windows Form.
10. From the Properties window, set the Name property:

○ For Visual Basic projects, set the value to myCrystalReportViewer.
○ For C# projects, set the value to crystalReportViewer.

11. From the File menu, click Save All.
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Related Information

What Needs to be Installed? [page 10]

1.5.3.6.2 Adding a label to the Windows application

This section shows you how to add a label to the Windows Form. The label that you add in this section shows the 
exposed report data later in this tutorial.

1. If the Smart Task panel is currently open, press Esc on your keyboard to close it.
2. From the Toolbox, open the Common Controls node to locate the Label control.
3. Drag the Label control onto the Windows Form and place it directly above the CrystalReportViewer control.
4. Click the Label control to select it.
5. From the Properties window, set the Name property to "drillLabel".
6. From the File menu, click Save All.

1.5.3.6.3 Configuring the CrystalReportSource using Smart 
Tasks

A GUI feature for configuring .NET controls, called Smart Tasks, was added in Visual Studio 2005. For the 
CrystalReportViewer control in Web Sites, the Smart Task panel is named CrystalReportViewer Tasks.

The "CrystalReportViewer Tasks" Smart Task panel lets you configure several features of the 
CrystalReportViewer control, without having to write code. Any selections that you make in Smart Tasks are 
generated as Windows Form Designer code.

In this section, you configure the main feature that is available from the CrystalReportViewer Tasks Smart Task: 
the CrystalReportSource control. Later in these reduced-code tutorials, you examine other features of Smart 
Tasks.

1. If the Smart Task panel is currently open, click on the Web Form to close the Smart Task panel.
2. On the upper-right corner of the CrystalReportViewer control, click on the small triangular button.

The Smart Task named CrystalReportViewer Tasks re-opens. In the Choose Report Source list, <None> is 
displayed.

3. Click the Choose Report Source list and select <New report source…>.
The Create ReportSource dialog box opens.

4. In the Specify a name for the control textbox, leave the default entry as CrystalReportSource1.
5. Click the Specify a report for the ReportSource control drop- down list and select <Browse…>.

The Select a Crystal Report dialog box opens.
6. Navigate to the World Sales Report.rpt file in the General Business folder of the SAP Crystal Reports sample 

reports directory.
7. Select the World Sales Report.rpt file and click Open.

At this point, the report becomes the designated report for the CrystalReportViewer control.
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8. From the File menu, click Save All.

1.5.3.6.4 Adding a Drill-Down Event to the 
CrystalReportViewer Control

This section shows you how to add a drill-down event to the CrystalReportViewer control so that when the user 
drills down on the report, the label can display the name of the report part that was drilled down on.

1. From the View menu, click Code to view the code-behind class for this Web Form.
2. From the View menu, click Designer to go back to the designer view of the Web Form.
3. Click the CrystalReportViewer control to select it.
4. In the Properties window, click the Events button to view the list of events associated with the 

CrystalReportViewer control.
5. From the list of available events, under the Action node, locate the Drill event.
6. To generate the drill-down event handler code, double click on the Drill event in the Properties window.

The following code is generated to handle the drill-down event:

 Private Sub myCrystalReportViewer_Drill(ByVal source As
System.Object, ByVal e As
CrystalDecisions.Windows.Forms.DrillEventArgs) Handles
myCrystalReportViewer.Drill
End Sub 
 private void crystalReportViewer_Drill(object source,
CrystalDecisions.Windows.Forms.DrillEventArgs e)
{
} 

7. From the File menu, click Save All.

1.5.3.6.5 Exposing Drill-Down Event Report Data to the Label 
Control

This section shows you how to add text to the Label control to indicate which part of the report the user has drilled 
down on.

1.5.4  Data Connectivity Tutorials

This section presents a variety of tutorials for data connectivity options in SAP Crystal Reports, developer version 
for Microsoft Visual Studio.
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1.5.4.1 Tutorial: Connecting to ADO.NET DataSets

Introduction

In this tutorial, you learn how to connect a Crystal report to an ADO.NET DataSet, through a DataSet schema. 
Some extra steps are required to report from an ADO.NET DataSet, because the report is not connected directly 
to a database.

An ADO.NET DataSet schema provides a template of the data structure in XML. However, a report cannot retrieve 
data from the DataSet schema alone. The DataSet schema must first be instantiated as a strongly-typed DataSet 
instance or as a generic DataSet instance. Then, the DataSet instance must be filled with data, through use of the 
DataAdapter classes.

In this tutorial, because of the added complexity that is involved in reporting from ADO.NET DataSets, the 
processes that you follow to create the schema and populate the DataSet are carefully kept separate from the 
SAP Crystal Reports binding code.

Note
SAP Crystal Reports, developer version for Microsoft Visual Studio provides a template, named DataSet, to 
create an ADO.NET DataSet schema. In Web Sites created with Visual Studio 2005 and later, the DataSet 
template is not accessible from the Add New Item dialog box. Only the default "XML Schema" template is 
available. However, with minor adjustments in the code (explained in the steps that follow), you can use the 
default template XML Schema to achieve the same results.

To begin, you create a data connection and build a DataSet schema that is based on that connection. You then 
create a helper class with a property that returns a populated instance of the DataSet. Finally, you write code that 
binds your Crystal report to the DataSet.

For the Crystal report binding code, you write code to do the following:

● Instantiate the report.
● Set its SetDataSource property to the populated DataSet property from the helper class.
● Bind the populated Crystal report to the CrystalReportViewer control.

Finally, if you are building a Web Site, you place your populated DataSet instance into an ASP.NET Cache object, 
to improve performance and scalability.

It is recommended that you keep the DataSet configuration process and the Crystal report binding process 
distinct, both to maintain clarity in the code when you bind the report, and to promote reusability of the DataSet 
across your Web or Windows project.

Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:
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● C# Web Site: CS_Web_Data_DataSets
● C# Windows project: CS_Win_Data_DataSets
● Visual Basic Web Site: VB_Web_Data_DataSets
● Visual Basic Windows project: VB_Win_Data_DataSets

Xtreme Database

This tutorial uses a sample database called Xtreme. The xtreme.mdb database file is included with the SAP 
Crystal Reports .NET SDK Sample Code package. To use the Xtreme database, you must manually create an 
ODBC connection to it.

Related Information

Sample Reports Directory [page 14]

1.5.4.1.1 Configuring a Connection to the Sample Database 
in the Server Explorer

In this tutorial, you use a GUI approach to generate your DataSet schema: in the main window of Visual Studio, 
you drag a database table from Server Explorer onto a DataSet window.

Your first step is to configure a database connection in the Server Explorer to the sample database that is 
provided with the SAP Crystal Reports sample reports.

1. From the View menu, click Server Explorer.
2. In Server Explorer, right-click Data Connections, and then click Add Connection...

The next steps are different depending on whether you are adding this connection in Visual Studio .NET 2003, 
or a later version of Visual Studio.

3. In Visual Studio, do the following:
a. In the Change Data Source dialog box, in the Data Provider combo box, select .NET Framework Data 

Provider for OLEDB.
b. In the DataSource list, select Microsoft Access Database File, and then click OK.

Note
If this is the first time you have added a connection in Visual Studio 2005 the Change Data Source window 
will appear. If the Add Connection dialog box appears, click Change...

4. In the Database File Name field, enter the path to the Xtreme database.
5. Set the User name and Password fields to blank, and then click Test Connection.
6. If your test connection is not successful, recheck the path to the Xtreme database and ensure that both User 

name and Password are blank.
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7. Click OK to close the Test Connection dialog box, and click OK again to close the Add Connection dialog box.
8. In Server Explorer, expand the Access node, and then the Tables node.
9. Verify that the Customer table is visible in the Server Explorer.

1.5.4.1.2 Creating a DataSet Schema

This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will be 
unable to complete the procedure without that configuration.

You are now ready to create a new Windows project or Web Site, to which you will add an ADO.NET DataSet 
schema based on a table in the Access database.

1. In the Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, in the Templates list, do the following:

○ For a Windows project, select DataSet.
○ For a Web Site, select XML Schema.

3. In the Name field, enter CustomerDataSetSchema.xsd, and then click Add.

4. From the Server Explorer, drag the Customer table (located under the node ACCESS>Tables>Customer) onto 
the CustomerDataSetSchema.xsd window.

5. From the Build menu, click Build Solution.

Note
In order to be generally consumable, the CustomerDataSetSchema.xsd file must be located in the 
App_Code directory. If you do not have an App_Code directory in your project, right-click the project name 
that is in bold type and then click New Folder. Name the new folder App_Code.

6. From the File menu, click Save All.

1.5.4.1.3 Writing a Helper Class to Populate the DataSet

The DataSet schema that you created for the Customer table is a data structure. At runtime, code is required to 
populate the DataSet structure with data from the database. In this section, you create a helper class that 
populates the DataSet with data.

1.5.4.1.3.1  To create a helper class to populate the DataSet 
with data

1. In the Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.
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2. In the Add New Item dialog box, in the Visual Studio installed templates list, select Class.
3. In the Name field, enter "DataSetConfiguration," and then click Add.

Note
If a dialog box comes up and asks you whether to place your class in a directory named "Code," click Yes.

4. Above the class signature, add an "Imports"[Visual Basic] or "using"[C#] declaration to the top of 
the class for the System.Data and System.Data.OleDb namespaces.

 Imports System.Data
Imports System.Data.OleDb 
 using System.Data;
using System.Data.OleDb; 

5. At the top of the class, create a constant named CONNECTION_STRING to hold the connection string to the 
Xtreme Sample Database.

  Private Const CONNECTION_STRING As String ="Provider=Microsoft.Jet.OLEDB.
4.0;Data Source=C:\Program Files\Microsoft Visual Studio 8\Crystal Reports
\Samples\En\Database\xtreme.mdb"  
  private const string CONNECTION_STRING = "Provider=Microsoft.Jet.OLEDB.4.0;Data 
Source=C:\\Program Files\\Microsoft Visual Studio 8\\Crystal Reports\\Samples\\En
\\Database\\xtreme.mdb";  

6. Beneath the first constant, create a second constant named QUERY_STRING to hold the database query 
string.

Note
This simple query string selects all columns, and no criteria. For the Xtreme database, this will return only a 
small amount of data. However, in most cases it is recommended to limit your query by including a WHERE 
clause and selecting a limited number of columns.

 Private Const QUERY_STRING As String = "SELECT * FROM CUSTOMER" 
 private const string QUERY_STRING = "SELECT * FROM CUSTOMER"; 

7. Beneath the second constant, create a third constant named DATATABLE_NAME for the name of the 
DataTable to be filled in the DataSet.

The following step instructs you to create a DIRECTORY_FILE_PATH constant. This constant is only required 
if you are creating a Web Site in Visual Studio 2005. Otherwise, skip this step.

 Private Const DATATABLE_NAME As String = "Customer" 
 private const string DATATABLE_NAME = "Customer"; 

8. Beneath the third constant, create a fourth constant named DIRECTORY_FILE_PATH for referring to the 
directory path location of the xsd file.
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Note
The code below demonstrates a path for a Web Site.

  Private Const DIRECTORY_FILE_PATH As String = "C:\WebSites\VB_Web_Data_DataSets\"  
  private const string DIRECTORY_FILE_PATH = @"C:\WebSites\CS_Web_Data_DataSets\";  

9. Edit the app.config or web.config file in the solution to include the following XML code within the top-level of 
the configuration tags.

This is to address the issue of using an ADO.NET DataSet as a report source under the .NET 4.0 Framework. 
See Migration Issues [page 9] for more information.

 <startup useLegacyV2RuntimeActivationPolicy="true">
    <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/> </startup>

1.5.4.1.3.2  To create a property that populates the DataSet

1. Create a read-only property named CustomerDataSet that returns an instance of DataSet.
Give the method a "Shared"[Visual Basic] or "static"[C#] modifier so that the class and property 
can be called directly without needing to be instantiated.

 Public Shared ReadOnly Property CustomerDataSet() As DataSet
    Get
    End Get
End Property 
 public static DataSet CustomerDataSet
{
    get
    {
    }
} 

2. This step has two options: one for use with the strongly-typed DataSet class (that is available with Windows 
projects) and one for use with the generic DataSet class (that is available with Web Sites).

○ For Windows projects that use the strongly-typed DataSet class, within the get clause of the 
CustomerDataSet property, declare and instantiate the CustomerDataSetSchema class (the strongly-
typed DataSet class that was generated from the DataSet schema in the previous section).

 Dim myDataSet As CustomerDataSetSchema = New
CustomerDataSetSchema() 
 CustomerDataSetSchema dataSet = new CustomerDataSetSchema(); 

○ For Web Site projects that use the generic DataSet class, within the get clause of the CustomerDataSet 
property, declare and instantiate a DataSet class, and then apply the XML Schema to the DataSet 
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instance. That is, pass the directory file path to the CustomerDataSetSchema.xsd as a string parameter 
to the ReadXmlSchema() method of the DataSet instance.

 Dim myDataSet As DataSet = New DataSet()
myDataSet.ReadXmlSchema(DIRECTORY_FILE_PATH & "XMLSchema.xsd") 
 DataSet dataSet = new DataSet();
dataSet.ReadXmlSchema(DIRECTORY_FILE_PATH + "XMLSchema.xsd"); 

3. Declare and instantiate the OleDbConnection class and pass into it the CONNECTION_STRING constant as a 
method parameter.

 Dim myOleDbConnection As OleDbConnection = New OleDbConnection(CONNECTION_STRING) 
 OleDbConnection oleDbConnection = new OleDbConnection(CONNECTION_STRING); 

4. Declare and instantiate the OleDbDataAdapter class and pass into it the QUERY_STRING constant and the 
OleDbConnection instance as method parameters.

 Dim myOleDbDataAdapter As OleDbDataAdapter = New OleDbDataAdapter(QUERY_STRING, 
myOleDbConnection) 
 OleDbDataAdapter oleDbDataAdapter = new OleDbDataAdapter(QUERY_STRING, 
oleDbConnection); 

5. Call the Fill() method of the OleDbDataAdapter instance and pass to it the CustomerDataSetSchema 
instance and the DATATABLE_NAME constant.

Note
The Fill() method populates the specified DataTable, within the DataSet instance, with the data retrieved 
from the database.

 myOleDbDataAdapter.Fill(myDataSet, DATATABLE_NAME) 
 oleDbDataAdapter.Fill(dataSet, DATATABLE_NAME); 

6. To complete the property, return the DataSet instance.

 Return myDataSet 
 return dataSet; 

The CustomerDataSet property is created and can be called from anywhere in the project.

1.5.4.1.4 Creating a Report that Connects to the DataSet 
Schema

In the previous steps, you created a method that populates the DataSet schema with data from the database. In 
this section, you create a Crystal report that bases its data connectivity on the CustomerDataSetSchema 
schema.
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1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Add New 
Item.

2. In the Add New Item dialog box, in the Visual Studio installed templates list, select Crystal Report.
3. In the Name field, enter the name Customer.rpt and click Add.

4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 
Report Wizard.

5. In the Choose an Expert panel, select Standard, and then click OK.
6. In the Available Data Sources panel of the Standard Report Creation Wizard window, expand the Project Data 

folder.
7. Expand the ADO.NET DataSets node.
8. This step has two options: one for use with the strongly-typed DataSet class (that is available with Windows 

projects.) and one for use with the generic DataSet class (that is available with Web Sites).

○ For Windows projects that use the strongly-typed DataSet class, expand the CustomerDataSetSchema 
node. Expand the Tables node if there is one.

○ For Web Sites that use the generic DataSet class in, expand the DataSetConfiguration node.
In the ADO.NET (XML) dialog box, select Use DataSet from Class. In the DataSet Names dialog box, select 
the CustomerDataSet property, and then click Finish.

9. Select the Customer table node.
10. Double-click the Customer table to move the table into the Selected Tables panel, and then click Next.
11. Expand the Customer table, then CTRL-click Customer Name, Contact Title, Address1, Contact Last Name and 

City.
12. Click the > symbol to move these fields into the Fields to Display panel, then click the Next button.
13. In the Available Fields panel, under Report Fields, select Customer.City, click the > symbol to move the field 

into the Group By panel, and then click the Finish button.

The Customer report is created, with data connectivity to the CustomerDataSetSchema (or, in a Visual 
Studio 2005 Web Site, to the CustomerDataSet property of the DataSetConfiguration class.)

1.5.4.1.5 Binding the Report and Setting the DataSource to 
the Populated DataSet

In this section, you learn how to instantiate the report that you have created, populate the report's DataSet, and 
display the report in the CrystalReportViewer control. You populate the report through the assignment of its 
SetDataSource property to the populated DataSet, which is returned from the CustomerDataSet property of 
the DataSetConfiguration class. Finally, you bind the populated report to the CrystalReportViewer 
control.

You can instantiate and bind the report in the following ways:

● As an embedded report.
● As a non-embedded report.

Choose from one (but not both) of the step procedures below.
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1.5.4.1.5.1  To instantiate and bind an embedded report to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Above the class signature, add an "Imports"[Visual Basic] or "using"[C#] declaration to the top of 

the class for the System.Data namespace if it is not there already.

 Imports System.Data 
 using System.Data; 

4. Add a new class-level declaration for the Customer report wrapper class, with the variable name 
customerReport. Set its access modifier to private.

 Private customerReport As Customer 
 private Customer customerReport; 

5. Within the ConfigureCrystalReports() method, instantiate the report wrapper class.

Note
You created the ConfigureCrystalReports() method in Project Setup [page 15].

 customerReport = New Customer() 
 customerReport = new Customer(); 

6. On the next line beneath the report instantiation, declare a DataSet.

This step and the next step separate the declaration of the variable from the assignment of the variable. Each 
line of code is kept separate because, in a Web Site addendum to this tutorial, you will refactor the variable 
assignment into a code block that caches the DataSet in the ASP.NET Cache object.

 Dim myDataSet As DataSet 
 DataSet dataSet; 

7. Assign the DataSet instance to the DataSetConfiguration.CustomerDataSet property.

 myDataSet = DataSetConfiguration.CustomerDataSet 
 dataSet = DataSetConfiguration.CustomerDataSet; 

8. Call the SetDataSource() method of the CustomerReport instance and pass into it the DataSet instance.

 customerReport.SetDataSource(myDataSet) 
 customerReport.SetDataSource(dataSet); 
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9. Bind the ReportSource property of the CrystalReportViewer control to the CustomerReport instance.

 myCrystalReportViewer.ReportSource = customerReport 
 crystalReportViewer.ReportSource = customerReport; 

1.5.4.1.5.2  To instantiate and bind a non-embedded report to 
the CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Add a new class-level declaration for the ReportDocument report wrapper class, with the variable name 

customerReport. Set its access modifier to private.

Note
The ReportDocument class is a member of the CrystalDecisions.CrystalReports.Engine namespace. You 
added an "Imports"[Visual Basic] or "using"[C#] declaration for this namespace in Project Setup 
[page 15]. When you instantiate ReportDocument and load a report into the namespace, you gain access to 
the report through the SDK, without embedding the report.

 Private customerReport As ReportDocument 
 private ReportDocument customerReport; 

4. Within the ConfigureCrystalReports() method (which you added during one of the procedures in Project 
Setup [page 15]), instantiate the ReportDocument class.

 customerReport = New ReportDocument() 
 customerReport = new ReportDocument(); 

5. Declare a string variable, name it reportPath, and assign to it a runtime path to the local report. This path is 
determined differently for Web Sites and Windows projects:

○ For a Web Site, pass the name of the local report file as a string parameter into the Server.MapPath() 
method. This maps the local report to the hard drive file directory path at runtime.

 Dim reportPath As String = Server.MapPath("Customer.rpt") 
 string reportPath = Server.MapPath("Customer.rpt"); 

○ For a Windows project, concatenate the Application.StartupPath property with a backslash and the 
local report file name. This maps the report to the same directory as the Windows executable file.
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Note
At compile time you will copy the report to the directory containing the executable file.

 Dim reportPath As String = Application.StartupPath & "\" &
"Customer.rpt" 
 string reportPath = Application.StartupPath + "\\" +
"Customer.rpt"; 

6. Call the Load() method of the ReportDocument instance and pass into it the reportPath string variable.

 customerReport.Load(reportPath) 
 customerReport.Load(reportPath); 

7. Declare a DataSet and assign to it the DataSetConfiguration.CustomerDataSet property.

 Dim myDataSet As DataSet = DataSetConfiguration.CustomerDataSet 
 DataSet dataSet = DataSetConfiguration.CustomerDataSet; 

8. Call the SetDataSource() method of the customerReport ReportDocument instance and pass into it the 
DataSet instance.

 customerReport.SetDataSource(myDataSet) 
 customerReport.SetDataSource(dataSet); 

9. On the next line, beneath the report loading, bind the ReportSource property of the 
CrystalReportViewer to the ReportDocument instance.

 myCrystalReportViewer.ReportSource = customerReport 
 crystalReportViewer.ReportSource = customerReport; 

1.5.4.1.5.3  To test the loading of the Customer report and its 
populated DataSet

You are now ready to build and run your project.

1. From the Build menu, click Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. If you use a non-embedded report in a Windows project, locate the compiled Windows executable in the \bin

\ [Visual Basic] or \bin\debug\ [C#] subdirectory, and then copy the report to that subdirectory.

Note
To have the non-embedded report loaded by the Windows executable at runtime, the report must be 
stored in the same directory as the Windows executable.
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4. From the Debug menu, click Start.
5. The Customer report displays and shows the populated data that you placed in the DataSet.
6. Return to Visual Studio and click Stop to exit from debug mode.

If you are building a Windows project, you have now completed the tutorial.

If you are building a Web Site, continue to Caching the DataSet in a Web Site [page 465].

1.5.4.1.6 Caching the DataSet in a Web Site 

If you are building a Web Site, you can gain additional scalability and performance by placing your populated 
DataSet instance into the ASP.NET Cache object. This prevents redundant (and potentially slow) calls to the 
database to populate the DataSet.

Note
If your DataSet contains standard values for all users, use the Cache object. However, if your DataSet contains 
unique values for each user (based on a user-specific criteria in the WHERE clause of the SQL query, such as 
user id) then you should use the Session object instead.

1. Open the Web Form.
2. From the View menu, click Code.
3. Locate the line of code where the DataSet instance is assigned to the 

DataSetConfiguration.CustomerDataSet property (shown below).

 myDataSet = DataSetConfiguration.CustomerDataSet 
 dataSet = DataSetConfiguration.CustomerDataSet; 

4. Replace this line of code with a complete conditional code block that checks for a Cache value named 
"customerDataSet."

Enter the conditional block and code exactly as shown here.

 If Cache("customerDataSet") Is Nothing Then
    myDataSet = DataSetConfiguration.CustomerDataSet
    Cache("customerDataSet") = myDataSet
Else
    myDataSet = CType(Cache("customerDataSet"), DataSet)
End If 
 if (Cache["customerDataSet"] == null)
{
    dataSet = DataSetConfiguration.CustomerDataSet;
    Cache["customerDataSet"] = dataSet;
}
else
{
    dataSet = (DataSet)Cache["customerDataSet"];
} 

5. To test the caching of the DataSet, select Start from the Debug menu.

The Customer report displays and shows the populated data that you placed in the DataSet.
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6. Click your browser's Refresh button.

The Customer report displays again quickly, because the DataSet is now retrieved from the ASP.NET Cache 
object.

7. Return to Visual Studio and click Stop to exit from debug mode.

Related Information

If You Use DataSets, Cache Them [page 63]

1.5.4.2 Tutorial: Connecting to IDataReader

In this data connectivity tutorial, you learn how to connect to an instance of IDataReader.

Introduction

Many .NET projects use DataReader, rather than DataSet, to retrieve data. For example, a typical way to bind a 
control (such as the GridView control) to data is to create a method that retrieves data through a DataReader, and 
then return that data from the method through an IDataReader interface.

In SAP Crystal Reports, developer version for Microsoft Visual Studio, the embedded Crystal Report Designer can 
access IDataReader, provided certain conditions are met:

● The data must be returned from a method, through the IDataReader interface.
● The data provider that is used within the method must be the OleDb .NET data provider.

Note
The classes for this data provider are located in the System.Data.OleDb namespace.

● The method must be Shared [Visual Basic] or static [C#].
● The class that contains this method must be part of a class library project and be compiled into an assembly.

In this tutorial, you learn how to connect a Crystal report to the DLL assembly file, and how to access a class and 
static method within the assembly that returns the IDataReader.

To begin, you create a class library, add a class and a static method that returns IDataReader, and then compile 
that class library into an assembly.
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Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_Data_IDataReader
● C# Windows project: CS_Win_Data_IDataReader
● Visual Basic Web Site: VB_Web_Data_IDataReader
● Visual Basic Windows project: VB_Win_Data_IDataReader

Related Information

Sample Reports Directory [page 14]

1.5.4.2.1 Creating the Class Library for the DataReader

Some setup is required as a prerequisite to this tutorial.

1.5.4.2.1.1   Prerequisite Database setup

1. SQL Server configuration:

○ If you have SQL Server (or the OEM version, MSDE) installed, it must be configured to require SQL Server 
Authentication.

○ If you do not have SQL Server (or the OEM version, MSDE) installed, you must install MSDE with SQL 
Server Authentication set to "True."

2. The Northwind database provided with SQL Server must be installed and verified that it requires SQL server 
authentication .

Note
This tutorial uses the Northwind database with SQL Server, but you can use any OleDb-compliant 
database.

3. A limited access account must be created for use within the Web site.
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1.5.4.2.1.2  To create a class library containing a static method 
that returns IDataReader

Once you have configured SQL Server and the Northwind database, you are ready to create a class library that 
returns values from the Northwind database as an IDataReader.

Note
The class library must be created within the directory of the Data_IDataReader parent project to avoid issues 
with program access rights.

1. From the File menu, point to New, and then click Project.
2. In the New Project dialog box, select a language folder for C# or Visual Basic from the Project Types list.
3. In the Templates list, click Class Library.
4. In the Name box, replace the default project name with "VB_Lib_DataLayer" [Visual Basic] or 

"CS_Lib_DataLayer" [C#], and then click OK.

5. In Solution Explorer, right-click the default class (Class1), and then click Delete.
6. In Solution Explorer, right-click the project name in bold type, point to Add, and then click Class.

The Add New Item dialog box opens.
7. In the Add New Item dialog box, in the Templates view, select the template named "Class."
8. In the Name field, type DataCenter, and then click Add.

9. If you are using Visual Basic, type Option Strict On at the top of the class.

10. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of 
the class for the System.Data and System.Data.OleDb namespaces (if these namespace have not already 
been declared).

 Imports System.Data
Imports System.Data.OleDb 
 using System.Data;
using System.Data.OleDb; 

11. At the class level, create a private string constant for the OleDb connection string.

Note
For security reasons, it is important that you use a database account with limited access permissions.

In the code that you write, replace the sample server name DBServer01 and the sample password 1234 
(shown below) with the server name and password for your database.

 Private Const OLEDB_CONNECTION_STRING As String =
"provider=sqloledb;Data Source=DBSERVER01;Initial
Catalog=Northwind;User Id=limitedPermissionAccount;Password=1234" 
 private const string OLEDB_CONNECTION_STRING =
"provider=sqloledb;Data Source=DBSERVER01;Initial
Catalog=Northwind;User Id=limitedPermissionAccount;Password=1234"; 
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12. Create a second private string constant for the database query.

 Private Const CUSTOMER_TABLE_QUERY As String = "SELECT CustomerID,
CompanyName, ContactName, Address, City FROM Customers" 
 private const string CUSTOMER_TABLE_QUERY = "SELECT CustomerID,
CompanyName, ContactName, Address, City FROM Customers"; 

13. Create a public "Shared" [Visual Basic] or "static" [C#] method named 
GetCustomersUsingOleDb() that returns IDataReader.

 Public Shared Function GetCustomersUsingOleDb() As IDataReader
End Function 
 public static IDataReader GetCustomersUsingOleDb()
{
} 

14. Within this method, declare and instantiate OleDbConnection and pass in the OLEDB_CONNECTION_STRING 
constant.

 Dim myOleDbConnection As OleDbConnection = New
OleDbConnection(OLEDB_CONNECTION_STRING) 
 OleDbConnection oleDbConnection = new
OleDbConnection(OLEDB_CONNECTION_STRING); 

15. Call the Open() method from the OleDbConnection instance to open the database connection.

 myOleDbConnection.Open() 
 oleDbConnection.Open(); 

16. Declare and instantiate OleDbCommand and pass in the CUSTOMER_TABLE_QUERY constant and the 
OleDbConnection instance.

 Dim myOleDbCommand As OleDbCommand = New
OleDbCommand(CUSTOMER_TABLE_QUERY, myOleDbConnection) 
 OleDbCommand oleDbCommand = new OleDbCommand(CUSTOMER_TABLE_QUERY,
oleDbConnection); 

17. Call the ExecuteReader() method of the OleDbCommand instance and pass it to an instance of 
IDataReader.

 Dim myIDataReader As IDataReader = myOleDbCommand.ExecuteReader() 
 IDataReader iDataReader = oleDbCommand.ExecuteReader(); 

18. Return the IDataReader instance from the method.

 Return myIDataReader 
 return iDataReader; 

19. From the Build menu, click Build Solution.
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20.From the File menu, click Close Solution.

1.5.4.2.2 Connecting a Report to the IDataReader Static 
Method

In this section you create a client project that accesses the IDataReader within the compiled assembly.

1.5.4.2.2.1  To connect a report to the IDataReader static 
method

This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will be 
unable to complete the procedure without that configuration.

1. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click New Item.
2. In the Add New Item dialog box, select Crystal Report.
3. In the Name field, enter "CustomersViaIDR.rpt", and then click OK.
4. In the Crystal Reports Gallery dialog box, click OK.
5. In the Standard Report Creation Wizard dialog box, expand Create New Connection node.
6. Expand the ADO.NET node.
7. In the ADO.NET dialog box, click the ... at the end of the File Path text field.
8. In the Open dialog box, set the Files of type list to All Files.
9. Locate the DLL assembly from the following file directory path.

Note
The DLL assembly is created in the procedure, Creating the Class Library for the DataReader [page 467].

In Visual Basic, the DLL is located in the bin directory. In C#, the DLL is located in the bin subdirectory 
named Debug. The location specified here will change depending upon the version of Visual Studio that you 
are using.

  \My Documents\Visual Studio\Projects\VB_Lib_IDataReader\VB_Lib_IDataReader\bin
\VB_Lib_DataLayer.dll  
  \My Documents\Visual Studio\Projects\CS_Lib_DataReader\CS_Lib_IDataReader\bin
\Debug\CS_Lib_DataLayer.dll  

10. Select the DLL, and then click Open.
11. From the Class Name list, select the DataCenter class, and then click Finish.

In the Available Data Sources area, the GetCustomersUsingOleDB() method appears.
12. Select GetCustomersUsingOleDb and click the > button to move the method into the Selected Tables panel, 

and then click Next.
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If the IDataReader class library has not been correctly configured, an exception is thrown.

1.5.4.2.3 Dealing With Exceptions

In this section, you learn how to deal with exceptions that may be thrown by your class library IDataReader 
method.

1. Close your Web Site or Windows project, and then reopen the class library project that contains the 
IDataReader static method.

Note
The class library project that is created in Creating the Class Library for the DataReader [page 467], is 
called "VB_Lib_DataLayer" [Visual Basic] or "CS_Lib_DataLayer" [C#].

2. Check the connection string constant for errors in the database server name or password.
3. Check the query string constant for errors in the query.
4. From the Build menu, click Build Solution.
5. From the File menu, click Close Solution.
6. Reopen the Web Site or Windows project.
7. Delete the Crystal report file that you have created, and then create a new Crystal report.
8. Repeat the steps in the previous section, Connecting a Report to the IDataReader Static Method [page 470].
9. Finally, edit the app.config or web.config file in the solution to include the following XML code within the top-

level of the configuration tags.

Note
This is to address the issue of using an ADO.NET DataSet as a report source under the .NET 4.0 
Framework. See Migration Issues [page 9] for more information.

 <startup useLegacyV2RuntimeActivationPolicy="true">
    <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/> </startup>

The GetCustomersUsingOleDb() method is successfully transferred to the Selected Tables panel.

Note
If you still get an exception, repeat the debugging process.

To debug further, create a new Web or Windows Form in your Web Site or Windows project and add a 
GridView control to that form. In the code-behind class, set the DataSource property of the GridView 
control to the IDataReader static method. Then, compile and view that Web or Windows Form to determine 
whether the display is successful.
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1.5.4.2.4 To design the report based on values from the 
IDataReader static method

You are now ready to design the report, based on values from the IDataReader static method.

Note
This step procedure assumes that you have successfully accessed the GetCustomersUsingOleDb IDataReader 
static method and, therefore, the method has been transferred into the Selected Tables panel of the Standard 
Report Creation Wizard dialog box.

1. In the Available Fields panel, expand GetCustomersUsingOleDb.
2. CTRL-click CompanyName, ContactName and City.
3. Click the > symbol to move these fields into the Fields to Display panel, and then click Next.
4. In the Available Fields panel, under Report Fields, select GetCustomerUsingOleDb.City, click the > symbol to 

move the field into the Group By panel, and then click Finish.

The CustomersViaIDR report is created and loaded into the main window of Visual Studio.
5. Click Main Report Preview to preview the report, based on a call to the IDataReader static method.

You are now ready to bind the report to the CrystalReportViewer control.

1.5.4.2.5 Binding the Report

In Project Setup [page 15], you placed a CrystalReportViewer control on the Web or Windows Form. In the 
previous step, you have added a CustomersViaIDR report to the project.

In this section, you instantiate the CustomersViaIDR report and bind it to the CrystalReportViewer control.

You can instantiate and bind the report in two ways:

● As an embedded report.
● As a non-embedded report.

Choose from one (but not both) of the step procedures below.

● If you use embedded reports, follow the next step procedure to instantiate the CustomersViaIDR report as an 
embedded report.

● If you use non-embedded reports, follow the second step procedure to instantiate the CustomersViaIDR 
report as a non-embedded report.

472 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



1.5.4.2.5.1  To instantiate the CustomersViaIDR report as an 
embedded report and bind it to the 
CrystalReportViewer control

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Add a new class-level declaration for the CustomersViaIDR report wrapper class, using the variable name 

customersViaIdrReport. Set its access modifier to private.

 Private customersViaIdrReport As CustomersViaIDR 
 private CustomersViaIDR customersViaIdrReport; 

4. Within the ConfigureCrystalReports() method, instantiate the report wrapper class.

Note
You created the ConfigureCrystalReports() method in Project Setup [page 15].

 customersViaIdrReport = New CustomersViaIDR() 
 customersViaIdrReport = new CustomersViaIDR(); 

5. On the next line beneath the report instantiation, bind the ReportSource property of the CrystalReportViewer 
control to the instantiated report class (variable name, customersViaIdrReport).

 myCrystalReportViewer.ReportSource = customersViaIdrReport 
 crystalReportViewer.ReportSource = customersViaIdrReport; 

1.5.4.2.5.2  To instantiate the CustomersViaIDR report as a 
non-embedded report and bind it to the 
CrystalReportViewer control

You are now ready to build and run your project. Skip to the next section below.

1. Open the Web or Windows Form.
2. From the View menu, click Code.
3. Add a new class-level declaration for the ReportDocument report wrapper class, using the variable name 

customersViaIdrReport. Set its access modifier to private.

Note
The ReportDocument class is a member of the CrystalDecisions.CrystalReports.Engine 
namespace. You have added an "Imports" [Visual Basic] or "using" [C#] declaration for this 
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namespace in Project Setup [page 15]. When you instantiate ReportDocument and load a report into the 
namespace, you gain access to the report through the SDK, without embedding the report.

 Private customersViaIdrReport As ReportDocument 
 private ReportDocument customersViaIdrReport; 

4. Within the ConfigureCrystalReports() method (that you have created in Project Setup [page 15]), 
instantiate the ReportDocument class.

 customersViaIdrReport = New ReportDocument() 
 customersViaIdrReport = new ReportDocument(); 

5. Declare a string variable, name it reportPath, and assign to it a runtime path to the local report. This path is 
determined differently for Web Sites and Windows projects:

○ For a Web Site, pass the name of the local report file as a string parameter into the Server.MapPath() 
method. This maps the local report to the hard drive file directory path at runtime.

 Dim reportPath As String = Server.MapPath("CustomersViaIDR.rpt") 
 string reportPath = Server.MapPath("CustomersViaIDR.rpt"); 

○ For a Windows project, concatenate the Application.StartupPath property with a backslash and the 
local report file name. This maps the report to the same directory as the Windows executable file.

Note
At compile time you will copy the report to the directory containing the executable file.

 Dim reportPath As String = Application.StartupPath & "\" &
"CustomersViaIDR.rpt" 
 string reportPath = Application.StartupPath + "\\"
+"CustomersViaIDR.rpt"; 

6. Call the Load() method of the ReportDocument instance and pass into it the reportPath string variable.

 customersViaIdrReport.Load(reportPath) 
 customersViaIdrReport.Load(reportPath); 

7. On the next line, beneath the report loading, bind the ReportSource property of the CrystalReportViewer to 
the ReportDocument instance.

 myCrystalReportViewer.ReportSource = customersViaIdrReport 
 crystalReportViewer.ReportSource = customersViaIdrReport; 
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1.5.4.2.5.3  To test the loading of the CustomersViaIDR report

Whether you have chosen to instantiate an embedded report class or a non-embedded report through the 
ReportDocument class, the variable name used is the same: customersViaIdrReport. This allows you to use a 
common set of code in the procedures that follow.

You are now ready to build and run your project.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. If you use a non-embedded report in a Windows project, locate the compiled Windows executable in the \bin

\ [Visual Basic] or \bin\debug\ [C#] subdirectory, and then copy the report to that subdirectory.

Note
To have the non-embedded report loaded by the Windows executable at runtime, the report must be 
stored in the same directory as the Windows executable.

4. From the Debug menu, click Start.

The report is displayed, showing data from the IDataReader static method.
5. Return to Visual Studio and click Stop to exit from debug mode.

1.5.4.3 Tutorial: Connecting to Object Collections

In this tutorial on data connectivity, you learn how to use an object collection as the data source for a Crystal 
report.

Introduction

SAP Crystal Reports has the ability to report off of object data. Object data can be simple, such as String or 
Integer data, or complex, such as a class or a collection. In this tutorial, you create an application that reports off 
of a collection of custom objects. Each object represents stock market information. When you build your Crystal 
report, this Stock class is accessed from the report wizard much like a database table, but rather than add table 
columns as fields to display, you add class properties instead.

The report will access an ArrayList that contains multiple instances of a Stock object. Each Stock instance has its 
properties set to unique values. You will add information to the ArrayList programmatically at design time, and 
again dynamically at run time.

The returned ArrayList, an object collection, is assigned to the SetDataSource property of the Crystal report. 
When the report is displayed, each object in the object collection provides one Detail row in the report.
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Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_Data_ObjectCollection
● Visual Basic Web Site: VB_Web_Data_ObjectCollection

Related Information

Sample Reports Directory [page 14]

1.5.4.3.1 Creating the Stock class

In this section, you create the Stock class. The Stock class contains three private fields that are exposed as public 
properties: Company, Volume, and Price. SAP Crystal Reports 2008 allows you to report off of class data, such as 
fields or objects, and even allows for calls into an object recursively. The 
CrystalComplexTypeExpansionLevels attribute lets you control how far into a class you can drill.

1. In Solution Explorer, right-click the web site name that is in bold type and then click Add New Item.
2. In the Add New Item dialog box:

a. In the Visual Studio Installed Templates field, select Class.
b. In the Name field, type "Stock", and then click Add.
c. In the dialog box that appears, click Yes.

Note
In Visual Studio 2005 and later, all classes must be placed inside of an App_Code folder if they are to be 
generally consumable. When you click the Add button, an alert box will ask you if you would like to place 
your class inside of this App_Code folder.

3. The Stock class must be set to public scope to be accessed when you create the report. Verify that the class 
you have created is public. If not, add the public modifier to the class signature to expose the class to the 
embedded SAP Crystal Report Designer.

 Public Class Stock
End Class 
 public class Stock
{
   public Stock()
   {
   }
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} 
4. If coding in Visual Basic, add a default constructor.

    Sub New()
   End Sub 

5. Within the class, add three private fields.

 Private _company As Company
Private _volume As Integer
Private _price As Double 
 private Company _company;
private double _price;
private int _volume; 

6. Create a new property named Price.

 Public Property Price() As Double
   Get
      Return _price
   End Get
   Set(ByVal value As Double)
      _price = value
   End Set
End Property 
 public double Price
{
   get
   {
      return _price;
   }
   set
   {
      _price = value;
   }
} 

7. Create a new property named Volume.

 Public Property Volume() As Integer
   Get
      Return _volume
   End Get
   Set(ByVal value As Integer)
      _volume = value
   End Set
End Property 
 public int Volume
{
   get
   {
      return _volume;
   }
   set
   {
      _volume = value;
   }
} 
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8. Create a new property named Company.
You must set the CrystalComplexTypeExpansionLevels attribute to a value greater than 1 in order to drill 
down into the class data. If you do not set the CrystalComplexTypeExpansionLevels attribute, then SAP 
Crystal Reports will not be able to access the field data inside of the Company class. Later you will create a 
custom Company class that has two String fields.

     <CrystalComplexTypeExpansionLevels(3)> _
    Public Property Company() As Company
        Get
            Return _company
        End Get
        Set(ByVal value As Company)
            _company = value
        End Set
    End Property 
     [CrystalDecisions.CrystalReports.Engine.CrystalComplexTypeExpansionLevels(3)]
    public Company Company
    {
        get
        {
            return _company;
        }
        set
        {
            _company = value;
        }
    } 

9. Finally, create a new constructor that takes the three public properties as arguments.

 Public Sub New(ByVal company As Company, ByVal volume As Integer, ByVal price As 
Double)
    _company = company
    _volume = volume
    _price = price
End Sub 
 public Stock(Company company, int volume, double price)
{
    _company = company;
    _volume = volume;
    _price = price;
} 

10. After of the Stock class, create a new Company class that exposes two public properties: symbol and name.

 Public Class Company
    Private _symbol As String
    Private _name As String
    Sub New(ByVal symbol As String, ByVal name As String)
        _symbol = symbol
        _name = name
    End Sub
    Public Property Symbol() As String
        Get
            Return _symbol
        End Get
        Set(ByVal value As String)
            _symbol = value
        End Set
    End Property
    Public Property Name() As String
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        Get
            Return _name
        End Get
        Set(ByVal value As String)
            _name = value
        End Set
    End Property 
 public class Company {
    private string _symbol;
    private string _name;
    public Company() {}
    public Company(String symbol, String name)
    {
        _symbol = symbol;
        _name = name;
    }
    public string Symbol
    {
        get { return _symbol; }
        set { _symbol = value; }
    }
    public string Name
    {
        get { return _name; }
        set { _name = value; }
    }
} 

11. From the Build menu, click Build Website.

You are now able to access this object from the embedded SAP Crystal Report Designer.

1.5.4.3.2 Connecting a Crystal report to the Stock object

In this section, you create a new Crystal report in the embedded SAP Crystal Report Designer and connect the 
report to the Stock object.

1. Right-click the project name and click Add New Item.
2. In the Add New Item dialog box, select Crystal Report.
3. In the Name field, enter "StockObjects.rpt", and then click Add.
4. In the Crystal Reports Gallery dialog box, click OK.
5. In the Standard Report Creation Wizard dialog box, expand Project Data and the sub node .NET Objects.

A list of classes within the project appears. Each class is prefixed with the project namespace.
6. Expand the Stock class to view a selectable sub node.
7. Click the right arrow to move the Stock class sub node to the Selected Tables panel, and then click Next.
8. Expand Stock and click the >> to move all columns to the Fields to Display panel, and then click Next.
9. Select Company.Symbol and click the right-arrow to move into the Group By panel, and then click Finish.
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1.5.4.3.3 To Instantiate the StockObjects report as a non-
embedded report and bind it to the 
CrystalReportViewer control

In Project Setup [page 15], you placed a CrystalReportViewer control on the Web or Windows Form. In the 
previous procedure, you added a StockObjects report to the project. In this section, you will bind the Stock 
Objects report to the SAP Crystal Reports Viewer, set the data source of the report to an Object Collection, and 
populate the Object Collection programmatically.

1. Open the default Code-Behind class, Default.aspx.cs or Default.aspx.vb.

2. Above the class signature, add an "Imports" [Visual Basic] or "using" [C#] declaration to the top of 
the class for the System.Collections namespace.

Note
This reference gives you access to the ArrayList class. ArrayList implements ICollection. This 
qualifies ArrayList as one of several class types that can be used to build an object collection that is 
recognized by SAP Crystal Reports.

 Imports System.Collections 
 using System.Collections; 

3. Add a new class-level ArrayList, call it stockValues.

 Private stockValues As ArrayList 
 private ArrayList stockValues; 

4. Add a new class-level declaration for the ReportDocument report wrapper class, with the variable name 
stockObjectsReport. Set its access modifier to private.

 Private stockObjectsReport As ReportDocument 
 private ReportDocument StockObjectsReport; 

5. Within the ConfigureCrystalReports() method you created in Project Setup [page 15], declare a string 
variable, name it reportPath, and assign to it a runtime path to the local report. Pass the name of the local 
report file as a string parameter into the Server.MapPath() method. This maps the local report to the file 
path at runtime.

 Dim reportPath As String = Server.MapPath("StockObjects.rpt") 
 string reportPath = Server.MapPath("StockObjects.rpt"); 

6. Add two line breaks, and instantiate the ReportDocument class.

 stockObjectsReport = New ReportDocument() 
 stockObjectsReport = new ReportDocument(); 
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7. On the next line, Call the Load() method of the ReportDocument instance and pass into it the reportPath 
string variable.

Note
The ReportDocument class is a member of the CrystalDecisions.CrystalReports.Engine 
namespace. You added an "Imports" [Visual Basic] or "using" [C#] declaration for this 
namespace in Project Setup. When you instantiate ReportDocument and load a report, you gain access to 
the report through the SDK.

 stockObjectsReport.Load(reportPath) 
 stockObjectsReport.Load(reportPath); 

8. Next, set the data source of the report to the stockValues ArrayList.

 stockObjectsReport.SetDataSource(stockValues) 
 stockObjectsReport.SetDataSource(stockValues); 

9. Finally, bind the ReportSource property of the CrystalReportViewer to the ReportDocument instance.

 myCrystalReportViewer.ReportSource = stockObjectsReport 
 crystalReportViewer.ReportSource = stockObjectsReport; 

At this point, the Stock Objects report is bound to the SAP Crystal Reports Viewer and the page displays the 
correct report; however, the report is currently bound to an empty data source, thus the report has no information 
to display. In the next section, you will programmatically populate the stockValues ArrayList with sample 
data.

1.5.4.3.4 Populating the Object Collection Programmatically

1. Right click on the web form in the Solution Explorer and click View Code.
2. Within the class, add a new public scope helper method, with no return value, named 

PopulateStockValuesArrayList().

 Public Sub PopulateStockValuesArrayList()
End Sub 
 public void PopulateStockValuesArrayList()
{
} 

3. Within the PopulateStockValuesArrayList() method, before the existing code, create an if/else 
conditional block that checks whether a Session object named stockValues exists.

 If (Session("stockValues") Is Nothing) Then
Else
End If 
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 if(Session["stockValues"] == null)
{
}
else
{
} 

4. Within the If block, instantiate a new ArrayList().

 stockValues = New ArrayList 
 stockValues = new ArrayList(); 

5. Create three Company objects, each with a symbol and a name.

 Dim c1 As Company = New Company("AWRK", "Arthur, Wren, Roberts and King")
Dim c2 As Company = New Company("CTSO", "Control Systems and Operations")
Dim c3 As Company = New Company("LTWR", "Letter Works") 
 Company c1 = new Company("AWRK","Arthur, Wren, Roberts and King");
Company c2 = new Company("CTSO","Control Systems and Operations");
Company c3 = new Company("LTWR","Letter Works"); 

6. Next, use the overloaded constructor for the Stock class to create and instantiate three instances of Stock.

 Dim s1 As Stock = New Stock(c1, 1200, 28.47)
Dim s2 As Stock = New Stock(c2, 800, 128.69)
Dim s3 As Stock = New Stock(c3, 1800, 12.95) 
 Stock s1 = new Stock(c1,1200,28.47);
Stock s2 = new Stock(c2,800,128.69);
Stock s3 = new Stock(c3,1800,12.95); 

7. Add these three instances to stockValues.

 stockValues.Add(s1)
stockValues.Add(s2)
stockValues.Add(s3) 
 stockValues.Add(s1);
stockValues.Add(s2);
stockValues.Add(s3); 

8. Add the updated stockValues ArrayList into session.

 Session("stockValues") = stockValues 
 Session["stockValues"]=stockValues; 

9. Inside of the Else block, write a line to assign the current values held in session to the stockValues 
ArrayList.

 stockValues = Ctype(Session("stockValues"), ArrayList) 
 stockValues = (ArrayList)Session["stockValues"]; 

10. Finally, call the PopulateStockValuesArrayList() from the ConfigureCrystalReports() method.
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This should be the first line of code executed in the ConfigureCrystalReports() method.

 PopulateStockValuesArrayList() 
 PopulateStockValuesArrayList(); 

1.5.4.3.5 Populating the Object Collection Dynamically

In the previous section, you populated the Object Collection programmatically. In this section, you will learn how 
to dynamically add information to your data source from your website. This information will automatically update 
in your report.

1.5.4.3.5.1  To Add Controls to the Web Form 

1. Open the Default.aspx file in Design View.

Note
To open an ASPX page in design view, first open the file, and then click the Design button at the bottom of 
the form.

2. Click the CrystalReportViewer control to select it.
3. Press the left arrow key on your keyboard so that the flashing cursor appears, and the press enter several 

times.
4. From the Toolbox drag a TextBox control onto the web form.
5. From the Property menu, set the ID to "symbol".
6. From the Toolbox drag a TextBox control onto the web form.
7. From the Property menu, set the ID to "name".
8. Drag a second TextBox control onto the web form. Position the second TextBox below the first.
9. From the Property menu, set the ID to "price."
10. Drag a third TextBox control onto the web form. Position the third TextBox below the second.
11. From the Property menu, set the ID to "volume."

Note
At this point, you may find it useful to add text beside each TextBox control to help identify which control 
corresponds to which parameter.

12. Next, from the Toolbox, drag a Button control onto the web form. Place the button below the three TextBox 
controls.

13. From the Property menu:
a. Set the ID of the Button to "addStockInformation."
b. Set the Text of the Button to "Add Stock Information."
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14. Finally, click twice on the "Add Stock Information" button.

Double clicking on the Button control will open up the Code-behind class and automatically generate an 
addStockInformation_Click() event handler.

1.5.4.3.5.2   To Add Information to the Collection

In this section, you will write code for the addStockInformation_Click() event handler that will add the 
information entered in the Web Form to the stockValues collection.

1. Inside of the addStockInformation_Click() event handler, create and instantiate a new Stock object.

 Dim temp As Stock = New Stock() 
 Stock temp = new Stock(); 

2. Within the addStockInformation_Click() method, create a try/catch block.

Information entered into a web form is of type String. Because two of the fields within the Stock class are 
numerical, you will need to write code to convert the String values from the web form into numerical values. 
The try/catch statement helps protect your web application from crashing during the conversion due to type 
mismatch errors.

 Try 
Catch ex As Exception
End Try  
 try
{
}
catch
{
} 

3. Within the Try block, assign the value of the symbol and name fields on the web form to the Company 
property of the Stock Object.

 temp.Company = New Company(symbol.Text, name.Text) 
 temp.Company = new Company(symbol.Text, name.Text); 

4. On the next line, assign the value of the price field on the web form to the Price property of the Stock Object. 
Convert the value from the web form to a Double before assignment.

 temp.Price = CType(price.Text, Double) 
 temp.Price = Convert.ToDouble(price.Text); 

5. Next, assign the value of the volume field on the web form to the Volume property of the Stock Object. 
Convert the value from the web form to an integer before assignment.

 temp.Volume = CType(volume.Text, Integer) 
 temp.Volume = Convert.ToInt32(volume.Text);
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6. Outside of the try/catch block, add the Stock Object to the stockValues ArrayList.

 stockValues.Add(temp) 
 stockValues.Add(temp); 

7. Update the value of stockValues currently held in Session.

 Session("stockValues") = stockValues 
 Session["stockValues"] = stockValues; 

8. Finally, call the ConfigureCrystalReports() method. This will re-bind the report to the updated 
stockValues Object Collection.

 ConfigureCrystalReports() 
 ConfigureCrystalReports(); 

9. From the Build menu, click Build Solution.
10. From the Debug menu, click Start Debugging.

If no build errors appear, the Default.aspx page loads into your browser with three default values. To add 
additional values, fill in the TextBox Controls as appropriate and click the Add Stock Information button. The 
Report will dynamically update.

When you run your web site, the report will load in your browser window with the three default values that you 
programmatically added in Populating the Object Collection Programmatically [page 481]. Above the report are 
three TextBox controls and a Button control. With these controls, you can dynamically update your Object 
Collection, and see the result of this update reflected in your report.

1.5.4.3.6 Addendum: Enhancing Your Report

Object collections are a versatile data source for your Crystal reports. With an Object collection, you can write a 
custom class that populates an object with data either programmatically or dynamically. Object collections can 
also be used to extend the number of data sources that are provided with a default installation SAP Crystal 
Reports, developer version for Microsoft Visual Studioby allowing you to write your own data access objects.

At this point, you have a fully functional web site that will display a Crystal report based off on Object Collection. 
The site displays information that is programmatically entered into an Object Collection, as well as information 
that is added dynamically at run time.

In this section, you will add two charts, a calculated field, and summary information.

1.5.4.3.6.1  To Add a Simple Chart to the Report 

1. From the solution explorer, open StockObjects.rpt.
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2. From the Crystal Reports menu, select Insert, and click Chart.
3. In the Chart Expert dialog box, select a Pie chart.
4. Select the Data tab from Report Fields.
5. Select Stock.Company-Symbol and click the top most Right Arrow to move the Stock.Company-Symbol field 

to the On Change Of field.
6. Select Stock.Volume and click the bottom most Right Arrow to move the Stock.Volume field to the Show 

Value(s) field.
7. Click OK.

A new Report Header section is created, and a chart object is added to this section.
8. From the Debug menu, click Start Debugging.

If no build errors appear, the Default.aspx page loads into your browser.

1.5.4.3.6.2   To Add a Chart Based on a Formula Field

In this section, you will create a chart that reports off of aggregate information. You will first create a formula to 
calculate the worth of a particular holding, and then create a pie chart that displays the proportional worth of all of 
your holdings.

1. From the Crystal Reports menu, select Report, and click Formula Workshop.
2. In the Formula Workshop dialog, select Formula Fields.
3. Click the New button to create a new formula.
4. In the Custom Function Name dialog, enter "worth."
5. Click Use Editor.
6. Add code to multiply the value of the price field by the value of the volume field.

 {Stock.Volume}*{Stock.Price} 
7. Click Save and Close.
8. From the Crystal Reports menu, select Insert, and click Chart.
9. In the Chart Expert dialog box, select a Pie chart.
10. Click the Data tab.
11. Select Stock.Company-Symbol and click the top most Right Arrow to move the Stock.Company-Symbol field 

to the On Change Of field.
12. Select Worth and click the bottom most Right Arrow to move the Worth formula to the Show Value(s) field.
13. Click the Text tab.
14. Beside Title, clear the Auto-text checkbox.
15. Enter Worth / Symbol in the Title field.

16. Click OK.
17. A new Report Header section is created, and a Chart Object is added to this section.
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Note
To re-position the objects within a Crystal report, drag them with your mouse and place them where you 
like. You can use the Main Report Preview button at the bottom of the form to display a preview of your 
report.

1.5.4.3.6.3   To Add Formula and Summary Fields to your 
Report

In this section, you add a formula field to your report as well as a summary field that will calculate the total value of 
your portfolio.

1. Expand the Formula Fields node of the Field Explorer.
2. Drag the worth formula onto your report. Position this field within the Details section of your report.

Note
Another way to display the Field Explorer is to go to the Crystal Reports menu, and then click Field Explorer.

This field will display the worth of each row. Use a summary field to display the total worth of your portfolio.
3. From the Crystal Reports menu, select Insert, and click Summary.
4. Within the Insert Summary dialog box:

a. Select the Worth formula from the Choose the Field to Summarize field.
b. Select Sum from the Calculate this Summary field.
c. Select Grand Total from the Summary Location field.

5. Click OK.

A summary field is added to the report.
6. From the Debug menu, click Start Debugging.

If no build errors appear, the Default.aspx page loads into your browser.

1.5.5  Other Tutorials

This section presents a collection of additional tutorials that belong in no particular category.

This section presents a collection of additional tutorials that belong in no particular category.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 487



1.5.5.1 Tutorial: Configuring Multilingual Client Support

In this tutorial, you learn how to configure multilingual client support in a Web Site or a Windows project.

Introduction

SAP Crystal Reports, developer version for Microsoft Visual Studioincludes support for multilingual Web and 
Windows clients, through dynamic localization.

Dynamic localization allows users to view ToolTips and other content of the CrystalReportViewer control in 
their preferred language.

In this tutorial, you study the following:

● How to configure the CrystalReportViewer control language resources on the Windows client or Web 
server.

● How to configure client access to localization in various ways.
● How to configure global or local settings.

Sample Code

This tutorial comes with Visual Basic and C# sample code that shows the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Web Site: CS_Web_Multilingual
● C# Windows project: CS_Win_Multilingual
● Visual Basic Web Site: VB_Web_Multilingual
● Visual Basic Windows project: VB_Win_Multilingual

Related Information

Sample Reports Directory [page 14]

1.5.5.1.1 To test the default locale of a report

This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will be 
unable to complete the procedure without that configuration.
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To begin, you build and compile a Web Site or Windows project, and then view the default language settings for 
the CrystalReportViewer toolbar.

1. From the Build menu, select Build Solution.
2. If you have any build errors, go ahead and fix them now.
3. From the Debug menu, click Start.

The Hierarchical Grouping report displays successfully.
4. Roll the mouse over the buttons on the CrystalReportViewer control toolbar.

ToolTips are now displayed in the default locale.
5. Return to Visual Studio and click Stop to exit from debug mode.

You are now ready to set up custom localized resource files for custom languages on your machine.

1.5.5.1.2 Setting up the custom resources files directory

SAP Crystal Reports, developer version for Microsoft Visual Studiois designed to work with several default 
language resource files, and also any custom language resource files created and compiled by the developer.

The default language resource files include the following:

● English (en)
● French (fr)
● German (de)
● Spanish (es)
● Italian (it)
● Japanese (jp)
● Korean (ko)
● Simplified Chinese (zh-chs)
● Traditional Chinese (zh-cht)

Note
The default resource files are included in the SAP Crystal Reports .NET SDK Sample Code package. Extract 
LanguageResourceFiles.zip to the root directory of your hard drive.

In addition to the default languages, you can create your own customized language resource files for any other 
language.

In this tutorial you will practice custom resource file compilation by working with an uncompiled folder containing 
the Spanish default language resource files. For this tutorial you will rename this folder to represent a custom 
language.

You begin by setting up a custom resource files directory to hold your custom resource files.

1. Go to the root directory of your hard drive and locate the folder LanguageResourceFiles.

2. Rename the folder to CrystalReportViewer_resource_files.
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Note
This procedure assumes that your root directory is on the C: drive.

3. In Windows Explorer, open the folder named C:\CrystalReportViewer_resource_files.

Locate the subfolder, es, containing uncompiled Spanish language strings as .txt files. While Spanish is 
already supplied as one of the default compiled languages, you will use this directory to practice creating a 
custom resource file. To do this, you rename the Spanish directory to Romanian, a language that is not one of 
the default languages. You then test this directory as if it contained Romanian language strings.

4. Rename the es directory to ro.

Note
ro is the abbreviation for the Romanian language.

For this tutorial, you will use the following:

● Default resources for three supplied languages:
○ German (de)
○ French (fr)
○ Italian (it)

● Manually compiled resources for one custom language:
○ Romanian (ro)

Follow the instructions in Compiling the resource files [page 490] to compile the custom resource files for the ro 
language folder.

Related Information

Sample Reports Directory [page 14]

1.5.5.1.3 Compiling the resource files

You are now ready to compile the resource files for the custom language subdirectory that you created in the 
previous section.

If you need to compile custom resource files for languages with non-Latin scripts such as Cyrillic, Chinese, 
Korean, Japanese, Hebrew, and Aramaic, you will need to configure environment locales for those languages 
before compilation. This ensures that the proper language scripts are available. For more information, see 
Reference: Configuring an Environment Locale [page 499].

1. Open the ro language subdirectory.

This tutorial will use the three files:
○ CRWebFormViewer.txt
○ SCRShared.txt
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○ Viewer.txt

The first two files contain resource strings for the Web-based CrystalReportViewer control. The last file 
contains resource strings for the Windows-based CrystalReportViewer control.

2. Open Viewer.txt to view its contents.

Note
This Romanian language folder currently contains Spanish-language strings. For more information, see the 
previous step in this tutorial, Setting up the custom resources files directory [page 489].

The localized strings for the CrystalReportViewer control are displayed in the current language.

3. Close Viewer.txt.

4. From the Start menu, go to Programs Visual Studio Visual Studio Tools Visual Studio Command 
Prompt .

5. Change directory to the resource files directory:

  cd c:\CrystalReportViewer_resource_files\ro\      

6. Run the resgen utility to compile the .txt files, following the syntax shown below.

Note
Do not put a space either before or after the comma.

 resgen /compile CRWebFormViewer.txt,CrystalDecisions.Web.resources
resgen /compile SCRShared.txt,CrystalDecisions.Shared.resources
resgen /compile Viewer.txt,CrystalDecisions.Windows.Forms.resources 

7. Run the al.exe utility to create a DLL for each resources file.

Note
The output name changes the extension resources.dll to custom_resources.dll.

 al.exe /t:lib /embed:CrystalDecisions.Web.resources /culture:ro /
out:CrystalDecisions.Web.custom_resources.dll
al.exe /t:lib /embed:CrystalDecisions.Shared.resources /culture:ro /
out:CrystalDecisions.Shared.custom_resources.dll
al.exe /t:lib /embed:CrystalDecisions.Windows.Forms.resources /culture:ro /
out:CrystalDecisions.Windows.Forms.custom_resources.dll 

8. Type dir to view the compiled DLLs.

You have completed resource compilation for this subdirectory.
9. If you have other custom languages that you wish to compile, repeat this section for each language.

Tip
To save time, enter all six commands into a batch file. Remember that the batch file must be run from the 
Visual Studio Command prompt to access the correct environment variables.

10. When you are finished compiling custom resources, close Visual Studio Command Prompt.
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In the next section, you configure your Web Site or Windows project to access your custom resources from either 
their global or custom location.

If you are building a Web Site, continue to To configure Global or Local custom resources [page 492].

If you are building a Windows project, continue to Configuring multilingual client support for a Windows 
application [page 497].

1.5.5.1.4 Configuring multilingual client support for a Web 
site

1.5.5.1.4.1  To configure Global or Local custom resources

Your Web Site accesses language resources either globally (at the system level) or locally (from within the Web 
Site folder).

Custom language resources may be placed in either a global or local location. Default language resources are 
always available globally.

Note
If the default resource files are not included with the product install, they can be downloaded from the SAP 
BusinessObjects Web Site and installed independently.

To expose custom resources globally, you place your custom resources in a central location in the file directory 
from which they can be shared across multiple Web applications. To then access those global resources in a 
specific Web Site, you place a reference to the global resources' file directory path in the Web.config file. For a 
global resource to load correctly, the name of the folder that contains the resource files must match the language 
locale.

To expose custom resources locally, you place the custom resources directly into the Web Site folder. For a local 
resource to load correctly, the culture of the resource files and the name of the folder that contains the resource 
files must match the language locale.

The global approach is more common with Web Sites because this approach services all Web Sites from a single 
location on the Web server, and prevents redundancy and any risk of discrepancy between versions.

To access global custom resources (more typical for Web Sites)

● In the Web.config file, add a globalResourcePath key to the appSettings node.

 <appSettings>
   <add key="globalResourcePath" value="c:\CrystalReportViewer_resource_files\"/> </appSettings> 

To access local custom resources (less typical for Web Sites)
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● Copy the custom resources subdirectory (in this case, the ro subdirectory) from the folder C:
\CrystalReportViewer_resource_files\ to the bin directory of the Web Site folder. If a bin directory 
does not exist in your web project, create one by right-clicking on the project name and selecting New Folder. 
Name the newly created folder bin.

Note
If you have added a globalResourcePath key as shown under global resources, the local resources are 
ignored. This is because global resources take precedence over local resources in the access hierarchy.

Your Web Site is now configured to access your custom language resources either globally or locally and to 
access your default language resources globally. However, no particular language has yet been specified for 
viewing, so at this point, the CrystalReportViewer control remains in the default locale.

In later sections, you learn about browser-based, page-based, and web-server-environment-based localization.

1.5.5.1.4.2  To configure browser-based localization
In this section, you learn about the browser-based scenario of dynamic localization. In this scenario, a property of 
the CrystalReportViewer control determines that dynamic localization will be based on the language setting of 
the client browser.

Because localization is browser-based in this scenario, each user's browser may retrieve a different language for 
the CrystalReportViewer control. This scenario is the most flexible when a wide variety of client browsers with 
many different language settings are expected to connect to your Web Site.

1. Launch your browser.

Note
This tutorial assumes use of Internet Explorer, but other HTML 4.0-compliant browsers are also 
compatible.

2. In Internet Explorer, from the Tools menu, click Internet Options.
3. In the Internet Options dialog box, on the General tab, click Languages...
4. In the Language Preference dialog box, click Add...
5. Add the following 4 languages:

○ German (Austria) [de-at]
○ French (France) [fr]
○ Italian (Italy) [it]
○ Romanian [ro]

6. Select Italian (Italy) [it] and click Move Up. Repeat until Italian (Italy) [it] is the top-most selection.
7. Click OK, click OK again, and then close your browser.
8. Open your Web Site in Visual Studio, and then build and compile.
9. Roll the mouse over the buttons on the CrystalReportViewer toolbar.

The ToolTip strings still display in English, ignoring your browser's language setting. You must configure a 
setting named UseBrowserLocale in your project's Web.config file so that the CrystalReportViewer 
control will observe the browser locale when rendering the ToolTip string values.
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10. Close the browser to exit debug mode.
11. Open the Web.config file.
12. Within the <configuration> tag, enter the following nested tags to set the UseBrowserLocale property to 

true.

A Web.config file can only have one configSections block, and that block must be the first child of the 
configuration tag. If your Web.config file already includes a configSections block, then edit that section 
to include the sectionGroup and section tags as shown below.

Note
In previous versions of SAP Crystal Reports, the CrystalReportViewer properties included a 
UseBrowserLocale property. This property is now deprecated, and replaced with the above setting in the 
Web.config file. If no entry is placed in the Web.config, the UseBrowserLocale defaults to false.

 <configSections>
  <sectionGroup name="businessObjects">
    <sectionGroup name="crystalReports">
      <section name="crystalReportViewer"
      type="System.Configuration.NameValueSectionHandler" />
    </sectionGroup>
  </sectionGroup>
</configSections>
<businessObjects>
  <crystalReports>
    <crystalReportViewer>
      <add key="UseBrowserLocale" value="true"/>
    </crystalReportViewer>
  </crystalReports>
</businessObjects> 

13. Rebuild and compile your application.
14. Roll the mouse over the buttons on the CrystalReportViewer toolbar.

The ToolTip strings now display in Italian. In the next step, you change the browser's language settings to 
German.

15. In Internet Explorer, from the Tools menu, click Internet Options.
16. In the Internet Options dialog box, on the General tab, click Languages...
17. Select German (Austria) [de-at] and click Move Up. Repeat until German (Austria) [de-at] is the top-most 

selection.
18. Click OK, and then click OK to return to your browser.
19. Click Refresh.
20.Roll the mouse over the buttons on the CrystalReportViewer toolbar.

The ToolTip strings now display in German.
21. Repeat this process for French (France) [fr] and Romanian [ro].

In each case, the Browser language preferences determine which string is displayed in the 
CrystalReportViewer control.
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Note
In this tutorial you have compiled your custom Romanian language resources based on language strings 
that were borrowed from a Spanish language directory, so your custom Romanian ToolTips will display in 
Spanish.

22. Return to Visual Studio and click Stop to exit from debug mode.

You have successfully configured dynamic localization using browser-based settings. In the next section, you 
learn how to configure localization using a setting on the ASPX page.

1.5.5.1.4.3  To configure Page-Based localization for a web page

In this section, you learn about the page-based scenario of dynamic localization. In this scenario, a Page directive 
of the Default.aspx page determines dynamic localization.

Because localization is page-based, each page in a Web Site could display a different language and bypass the 
language settings in the browser locale. So, this scenario is useful when you want to restrict the locale that is 
displayed on a page-by-page basis.

1. Open the Web.config file.
2. Within the <configuration> tag, enter the following nested tags to set the UseBrowserLocale property to 

false.

Note
In previous versions of SAP Crystal Reports, the CrystalReportViewer properties included a 
UseBrowserLocale property. This property is now deprecated, and replaced with the above setting in the 
Web.config file. If no entry is placed in the Web.config, the UseBrowserLocale defaults to false.

 <configSections>
  <sectionGroup name="businessObjects">
    <sectionGroup name="crystalReports">
      <section name="crystalReportViewer"
        type="System.Configuration.NameValueSectionHandler" />
    </sectionGroup>
  </sectionGroup>
</configSections>
<businessObjects>
  <crystalReports=>
    <crystalReportViewer>
      <add key="UseBrowserLocale" value="false"/>
    </crystalReportViewer>
  </crystalReports>
</businessObjects> 

3. Open the Default.aspx page in Design view.
4. Click the Default.aspx page to select it.
5. From the Properties window, set the Culture property to it-IT.

If you do not see the Culture property, select Document from the list at the top of the Properties windows.

6. Rebuild and compile your application.
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7. Roll the mouse over the buttons on the CrystalReportViewer toolbar.

The ToolTip strings display in Italian.
8. Return to Visual Studio and click Stop to exit from debug mode.

In this scenario, the following settings have been configured:

● The CrystalReportViewer.UseBrowserLocale property has been set to False. Therefore, the browser 
locale setting, which was set to Spanish in the previous step procedure, is ignored.

● The Page's Culture directive is set to Italian.

Therefore, the ToolTip strings display in Italian.

You have successfully configured dynamic localization with page-based settings. In the next section, you learn 
how to configure localization with the environment locale of the Web server.

1.5.5.1.4.4  To configure environment-based localization for a 
website

In this section, you learn about the Web-server-environment-based scenario of dynamic localization. In this 
scenario, environment locale settings for the Web server determine dynamic localization.

Because localization is environment-based, in this scenario the entire Web Site displays in a single language. So, 
this scenario is useful when you want to restrict the locale that is displayed for the entire Web Site to the 
environment locale that is configured on the Web server.

Note
The Environment locale is the default setting for the Web Site. If you choose to configure the Culture directive 
of a particular Page or the UseBrowserLocale property of a particular CrystalReportViewer control in 
your Web site, those configurations will override the default Environment locale setting and give you more 
customized localization at the Page or CrystalReportViewer control level.

1. Open the Default.aspx page in Design view.

"Document" is displayed at the top of the Properties window.
2. From the Properties window, clear the Culture property.
3. On your development machine (which is your Web server for this tutorial), change the default Environment 

locale in the Regional Options control panel to German (Austria).

Note
For detailed instructions on how to configure the Environment locale correctly in either Windows XP or 
Windows 2000, see the section at the end of this tutorial: Reference: Configuring an Environment Locale 
[page 499].

4. If you need to restart your machine to apply the regional settings, do so now.
5. Launch your Web Site again in Visual Studio, then build and compile.
6. Roll the mouse over the buttons on the CrystalReportViewer toolbar.
7. When you have confirmed the language that is displayed, close the browser to exit debug mode.
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In this scenario:

● The CrystalReportViewer.UseBrowserLocale property has been set to False (this was performed 
earlier in this tutorial). Therefore, the browser locale setting, which was last set to Spanish, is ignored.

● The Page Culture setting has been cleared. Therefore, no direction is given at the Page level.
● The localization choice defaults to the Web server's environment locale, which you have just configured to 

"German (Austria)".

Therefore, the ToolTip strings display in German.

This completes the demonstration of multilingual client support with dynamic localization in Web Sites. The 
remaining sections demonstrate dynamic localization in Windows projects.

1.5.5.1.5 Configuring multilingual client support for a 
Windows application

Your Windows project accesses language resources either globally (at the system level) or locally (from within the 
Windows executable folder).

Custom language resources may be placed in either a global or local location. Default language resources are 
always available globally.

To expose custom resources globally, you place your custom resources in a central location in the file directory 
from which they can be shared across multiple Windows applications. To then access those global resources in a 
specific Windows application, you place a reference to the global resources' file directory path in an XML 
configuration file stored in the same directory as the Windows executable. For a global resource to load correctly, 
the name of the folder that contains the resource files must match the language locale.

To expose custom resources locally, you place the custom resources into the Windows application at the same 
level as the executable file. For a local resource to load correctly, the culture of the resource files and the name of 
the folder that contains the resource files must match the language locale.

For deployment, your default language resources need to be included with the deployment. These resources will 
be accessed globally. For your custom resources, it is simpler to access them locally by configuring them to be 
installed in the same folder as the Windows executable.

1.5.5.1.5.1  To access local custom resources

1. Change your Regional Options settings to "Romanian".

Note
For detailed instructions on how to configure the Environment locale correctly in either Windows XP or 
Windows 2000, see the section at the end of this tutorial: Reference: Configuring an Environment Locale 
[page 499].

2. Copy the ro language subdirectory from the folder C:\CrystalReportViewer_resource_files\ to the 
folder that contains the Windows executable.
During development, this will likely be the \bin\debug\ folder.
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3. Compile and run the Windows application.
4. Roll the mouse over buttons on the toolbar.

The ToolTip strings display in Romanian (more accurately, since we compiled the custom Romanian resource 
with test strings in Spanish, the tool tips will actually display Spanish.)

Note
If you have added a global config file that contains a globalResourcePath key, the local resources are 
ignored. This is because global resources take precedence over local resources in the access hierarchy.

1.5.5.1.5.2  To access global custom resources (less typical 
approach for Windows applications)

In the this section, you learn how to access global resources.

1. Change your Regional Options settings to "Romanian".

Note
For detailed instructions on how to configure the Environment locale correctly in either Windows XP or 
Windows 2000, see the section at the end of this tutorial: Reference: Configuring an Environment Locale 
[page 499].

2. In Windows Explorer, locate the subdirectory of your Windows project that contains the executable file.

  \[PROJECT_PATH]\bin\debug\  
3. In this subdirectory, create a new XML configuration file with the following information:

 <?xml version="1.0"?>
<configuration>
   <appSettings>
      <add key="globalResourcePath" value="c:\CrystalReportViewer_resource_files\"/>    </appSettings>
</configuration> 

4. Save this file with the same name as the executable file, but add a .config extension.

For example:

Executable name: CS_Win_Multilingual.exe

Config file name: CS_Win_Multilingual.exe.config

Note
In Visual Basic Windows applications, this file may have been automatically generated. In that case, append 
the <app settings> node within the existing <configuration> node in the auto-generated config file.

5. Compile and run the Windows application.
6. Roll the mouse over buttons on the toolbar.
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The ToolTip strings display in Romanian (more accurately, since we compiled the custom Romanian resource 
with test strings in Spanish, the tool tips will actually display Spanish.)

1.5.5.1.6 Reference: Configuring an Environment Locale

This section applies to both Web Sites and Windows projects, for times when you need to change the environment 
locale. For this example, the regional settings are set to "German (Austria)".

The following instructions apply to Windows XP and Windows 2000.

1.5.5.1.6.1  To configure the environment locale in Windows XP

1. Click Start, click Control Panel, and then click Regional and Language Options.
2. On the Regional Options tab, from the Select an item to match its preferences list, select German (Austria).
3. In the Languages tab, click Details...

The Text Services and Input Languages dialog box is displayed.
4. In the Settings tab, click Add...
5. In the Add Input Language dialog box, do the following:

a. Set the Input Locale list to German (Austria).
b. Set the Keyboard layout/IME to German (IBM).

6. Click OK.
7. In the Default input language list, select German (Austria), and then click OK.
8. In the Languages for non-Unicode programs list, select German (Austria).
9. Click Apply, and then click OK.

In Windows XP, you do not need to reboot your computer for these changes to be applied.

1.5.5.1.6.2  To configure the environment locale in Windows 
2000

1. Click Start menu, point to Settings, click Control Panel, and then click Regional Options.

The Regional Options control panel is displayed.
2. On the General tab, do the following:

a. Click the Your locale (location) list and select German (Austria).
b. Click Set Default...
c. In the Select System Locale dialog box select German (Austria), and then click OK.

3. In the Input Locales tab, do the following:
a. Click Add...
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b. In the Add Input Locale dialog box, set the Input Locale list to German (Austria).
c. Set the Keyboard layout/IME to German (IBM), and then click OK.

4. Click Apply.

A dialog box is displayed, and it asks you to install files either from your hard drive, or from the Windows 
Installer CD.

5. Click Yes and proceed with the installation.

When installation is complete, in the Change Regional Options dialog box you are asked to restart your 
computer.

6. Click Yes.

In Windows 2000, you must reboot your computer for these changes to be applied.

1.5.5.2 Tutorial: Creating a User Function Library

In this tutorial, you learn how to create a User Function Library that can be accessed from the Formulas Expert in 
the embedded SAP Crystal Report Designer.

Introduction

In this tutorial, you learn how to create a User Function Library that can be accessed from the Formulas Expert in 
the embedded SAP Crystal Report Designer.

When developers create a Crystal report in the embedded SAP Crystal Report Designer, they often create formula 
fields to use in the report. These formula fields consist of variables and functions. The embedded SAP Crystal 
Report Designer comes with a large collection of existing functions.

However, in some scenarios a user may require the ability to create a customized function, in the form of a library 
that can be distributed across machines. The User Function Library provides this capability.

A User Function Library (UFL) is a .NET class library that has the following characteristics:

● The project name is prefixed with the string "CRUFL".
● The project consists of an interface and an implementation class.
● Both the interface and the implementation class have Com and GUID attributes.
● Upon compilation, the assembly is registered for COM Interop so that it is viewed as a COM object.
● The assembly/COM object is added to the Global Assembly Cache so that it is available across all .NET 

applications on the machine.
● This assembly/COM object (the User Function Library, or UFL) then becomes visible within the embedded 

SAP Crystal Reports Designer as a customized function under "Functions>Additional Functions>u2lcom.dll".
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Sample Code

This tutorial comes with Visual Basic and C# sample code that show the completed version of the project. Follow 
the instructions in this tutorial to create a new project or open the sample code project to work from a completed 
version.

The sample code is stored in folders that are categorized by language and project type. The folder names for each 
sample code version are as follows:

● C# Class Library: CRUFL_CS_ExchangeRate
● VB Class Library: CRUFL_VB_ExchangeRate

Xtreme Database

This tutorial uses a sample database called Xtreme. The xtreme.mdb database file is included with the SAP 
Crystal Reports .NET SDK Sample Code package. To use the Xtreme database, you must manually create an 
ODBC connection to it.

Related Information

Sample Reports Directory [page 14]

1.5.5.2.1 To create a UFL class library

In this section, you create the UFL Class library and configure it to be registered for COM Interop.

1. Launch Visual Studio.
2. From the File menu, select New, and then click Project.
3. In the New Project dialog box, select a language folder for C# or Visual Basic from the Project Types list.
4. From the Templates list, click Class Library.
5. In the Name field, enter one of the following:

○ CRUFL_VB_ExchangeRate (Visual Basic)
○ CRUFL_CS_ExchangeRate (C#)

Note
All User Function Libraries must be prefixed with CRUFL to be recognized by the embedded SAP Crystal 
Reports Designer.

6. Click OK.
7. In Solution Explorer, right-click the project name that is in bold type, and then click Properties.
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8. Click the Build/Compile tab.
9. If you are using Visual Basic, on the OptionStrict list, click On.
10. Scroll to the bottom of the Build/Compile window and select Register for COM Interop.

Note
"Register for COM Interop" causes the assembly to be automatically registered by the regasm.exe utility, 
when the project is compiled. So, you do not need to run regasm.exe manually from the command prompt.

11. From the File menu, click Save All.
12. Close the Compile/Build window.

You are now ready to create the interface.

1.5.5.2.2 To create the interface with COM attributes

In this section, you create an interface and configure it with COM attributes.

1. Delete the default class (Class1).
2. In Solution Explorer, right-click the project name that is in bold type, point to Add, and then click Class.
3. In the Name field, enter "IExchangeUfl", and then click Add.
4. Change the class signature from class to interface, and set the scope to public.

Note
In Visual Basic, remember to change both the opening and closing signature. In C#, delete the constructor.

 Public Interface IExchangeUfl
End Interface 
 public interface IExchangeUfl
{
} 

5. Above the class declaration, add the following using/Imports statement:

 Imports System.Runtime.InteropServices 
 using System.Runtime.InteropServices; 

6. From the Tools menu, click Create GUID.
7. In the Create GUID dialog box, in the GUID format panel, select Registry Format.
8. Click New GUID.
9. Click Copy, and then close the dialog box.
10. Above the interface declaration, create an attribute with three values: ComVisible, InterfaceType, and Guid (in 

C#) or GuidAttribute (in Visual Basic) with parameter string quotes.
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Note
In Visual Basic, for readability add an underscore after the close tag to place the class on the next line.

 <ComVisible(), InterfaceType(), GuidAttribute("")> _
Public Interface IExchangeUfl
End Interface 
 [ComVisible(), InterfaceType(), Guid("")]
public interface IExchangeUfl
{
} 

11. Enter a parameter value of "True" [Visual Basic] or "true" [C#] into the ComVisible attribute.
12. Enter a parameter value of ComInterfaceType.InterfaceIsDual from the ComInterfaceType enum 

into the InterfaceType attribute.
13. Paste the GUID value from the clipboard into the parameter value of the Guid attribute. Be careful to remove 

the curly braces and any carriage returns.

Note
Do not use the GUID provided in the code snippet below. Create a unique GUID for your interface.

 <ComVisible(True),
InterfaceType(ComInterfaceType.InterfaceIsDual),
GuidAttribute("E7A4EC98-BF2B-4006-B266-74C74421C394")> _
Public Interface IExchangeUfl
End Interface 
 [ComVisible(true), InterfaceType(ComInterfaceType.InterfaceIsDual),
Guid("E7A4EC98-BF2B-4006-B266-74C74421C394")]
public interface IExchangeUfl
{
} 

14. Within the IExchangeUfl interface, create a method signature.

Note
This method signature will become the name of the function that is exposed in the embedded SAP Crystal 
Reports Designer.

 Function ConvertUSDollarsToCDN(ByVal usd As Double) As Double 
 double ConvertUSDollarsToCDN(double usd); 

15. Close the interface window.

Next you create the implementation class.
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1.5.5.2.3 To create the implementation class with COM 
attributes

In this section, you create an implementation class that implements the IExchangeUfl interface, and then 
configure that class with COM attributes.

1. In Solution Explorer, right-click the bold project name that is in bold type, point to Add, and then click Class.
2. In the Name field, enter "ExchangeUfl", and then click Add.
3. Modify the class signature to implement the IExchangeUfl interface.

 Public Class ExchangeUfl : Implements IExchangeUfl
End Class 
 public class ExchangeUfl : IExchangeUfl
{
} 

4. Above the class declaration, add the following using/Imports statement:

 Imports System.Runtime.InteropServices 
 using System.Runtime.InteropServices; 

5. From the Tools menu, click Create GUID.
6. In the Create GUID dialog box, in the GUID format panel, select Registry Format.
7. Click New GUID.
8. Click Copy, and then close the dialog box.
9. Above the class declaration, create an attribute with three values: ComVisible, ClassInterface and Guid (in 

C#) or GuidAttribute (in Visual Basic) with parameter string quotes.

Note
In Visual Basic, for readability add an underscore after the close tag to place the class on the next line.

 <ComVisible(), ClassInterface(), GuidAttribute("")> _
Public Class ExchangeUfl : Implements IExchangeUfl
End Class 
 [ComVisible(), ClassInterface(), Guid("")]
public class ExchangeUfl : IExchangeUfl
{
} 

10. Enter a parameter value of "True" [Visual Basic] or "true" [C#] into the ComVisible attribute.
11. Enter a parameter value of ClassInterfaceType.None from the ClassInterfaceType enum into the 

ClassInterface attribute.
12. Paste the GUID value from the clipboard into the parameter value of the Guid attribute. Be careful to remove 

the curly braces and any carriage returns.
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Note
Do not use the GUID that is provided in this code snippet. Create a unique GUID for your class.

 <ComVisible(True), ClassInterface(ClassInterfaceType.None),
GuidAttribute("F5DCE88F-AD38-4a9a-9A69-0F8DC0EDB4E3")> _
Public Class ExchangeUfl : Implements IExchangeUfl
End Class 
 [ComVisible(true), ClassInterface(ClassInterfaceType.None),
Guid("F5DCE88F-AD38-4a9a-9A69-0F8DC0EDB4E3")]
public class ExchangeUfl : IExchangeUfl
{
} 

13. Within ExchangeUfl, fulfill the contractual method signature from the interface with a public method.

Note
This will be the name of the function that is exposed in the embedded SAP Crystal Reports Designer.

 Public Function ConvertUSDollarsToCDN1(ByVal usd As Double) As
Double Implements IExchangeUfl.ConvertUSDollarsToCDN
End Function 
 public double ConvertUSDollarsToCDN(double usd)
{
} 

14. Within the method, create a conditional block that checks whether the usd method parameter is greater than 
Double.MaxValue and throws an exception if it is.

Note
You need to perform this check to prevent the risk of an overflow.

 If usd > Double.MaxValue Then    Throw New Exception("Value submitted is larger than the maximum value allowed 
for a double.") End If 
 if(usd > Double.MaxValue)
{    throw new Exception("Value submitted is larger than the maximum value allowed 
for a double."); } 

15. Following the conditional block, return the usd method parameter multiplied by an exchange rate of 1.45.
In this tutorial, only a simple math calculation is performed. However, any code could be placed within this 
method. For example, you could retrieve an exchange rate from a bank web service, to calculate the exchange 
rate dynamically within your report.

 Return (usd * 1.45) 
 return (usd * 1.45); 
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16. From the File menu, click Save All.
17. Close the class window.

1.5.5.2.4 To assign a strong-name key to the Class library

In this section, you assign a strong-name key to the class library.

1. In Solution Explorer, right-click the bold project name that is in bold type, and then select Properties.
2. Click the Signing tab.
3. Select the Sign the assembly checkbox.
4. From the Choose a strong name key file: combo box, select <New...>
5. In the Create Strong Name Key dialog box, in the Key file name: text field, enter a string value.

Note
For example, a possible string value could be your last name and today's date.

6. Clear Protect my key file with a password, and then click OK.
7. Close the Signing window.
8. From the Build menu, click Build Solution.
9. Close Visual Studio.

Next, you add the assembly to the Global Assembly Cache (the GAC).

1.5.5.2.5 To add the assembly to the Global Assembly Cache

In this section, you add the assembly to the Global Assembly Cache (GAC).

1. In Windows Explorer, locate the project on your machine.
2. Within the project that you have created, locate the subdirectory \bin\Debug\. Confirm that the assembly 

DLL is located in this directory.
3. Copy the file directory path of the DLL to the clipboard.
4. Click Start, point to Programs > Microsoft Visual Studio > Visual Studio Tools, and then click Visual Studio 

Command Prompt.
5. You need to change directory to the directory containing your DLL. To do this, begin by typing the change 

directory command:

 cd  
6. Add a space after the cd command, and then right-click to paste the directory file path from the clipboard.
7. Press Enter.

Verify that the directory has changed to the directory that contains the assembly DLL.
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8. Type the following command, and replace the assembly DLL shown in the code snippet with the name of your 
assembly DLL.

 gacutil -if CRUFL_CS_ExchangeRate.dll 
9. Press Enter.

A message telling you that the assembly has been added to the cache should appear. If a failure message 
appears, recheck the spelling of the assembly DLL filename and run gacutil again.

10. Close Visual Studio Command Prompt.
11. In Windows Explorer, locate the subdirectory \assembly\, which is within the \Windows\ or \WinNT\ 

directory.

The assembly you added should now be visible in the assembly subdirectory (known as the GAC, or Global 
Assembly Cache.)

You are now ready to create a Crystal report that accesses this custom function.

1.5.5.2.6 To add the custom function to a Crystal report

This procedure works only with a project that has been created from Project Setup [page 15]. Project Setup 
contains specific namespace references and code configuration that is required for this procedure, and you will be 
unable to complete the procedure without that configuration.

In this section, you create a Crystal report that accesses your custom function.

1. In Solution Explorer, right-click the project name in bold type, point to Add, and then click Add New Item.
2. In the Add New Item dialog box, in the Templates view, select the template named Crystal Report.

3. In the Name field, enter the name FunctionTest.rpt, and then click Add.

4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 
Report Wizard.

5. In the Choose an Expert panel, select Standard, and then click OK.
6. In the Available Data Sources panel of the Standard Report Creation Wizard window, expand the Create New 

Connection folder.
7. From the subfolder that opens, expand the ODBC (RDO) folder.
8. In the ODBC (RDO) window, select the correct ODBC DSN entry for the Xtreme database, and then click 

Finish.

The ODBC (RDO) folder expands and shows the Xtreme database.
9. Expand the Tables node and select the Customer table.
10. Double-click the Customer table to move the table into the Selected Tables panel, and then click Next.
11. CTRL-click Customer Name, Last Year's Sales, and City.
12. Click the > symbol to move these fields into the Fields to Display panel, then click Next.
13. In the Available Fields panel, under Report Fields, select Customer.City, click the > symbol to move the field 

into the Group By panel, and then click Finish.

The FunctionTest report is created and loaded into the main window of Visual Studio.
14. If the Field Explorer is not visible, on the Crystal Reports toolbar, click Toggle Field View.
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Tip
Another way to display the Field Explorer is to go to the Crystal Reports menu, and then click Field Explorer.

15. In the Field Explorer, right-click Formula Fields, and then click New...
16. In the Formula Name dialog box, type the name MyFunctionFormula, and then click Use Editor.

The Formula Workshop window is displayed, showing four panels horizontally.
17. In the third panel, expand Functions.
18. Expand Additional Functions, and within it expand COM and .NET UFLs (u212com.dll).

The function that you created is displayed: CSExchangeRateExchangeUflConvertUSDollarsToCDN (or 
VBExchangeRateExchangeUflConvertUSDollarsToCDN).

19. Double-click CSExchangeRateExchangeUflConvertUSDollarsToCDN (or 
VBExchangeRateExchangeUflConvertUSDollarsToCDN) .

The CSExchangeRateExchangeUflConvertUSDollarsToCDN() (or 
VBExchangeRateExchangeUflConvertUSDollarsToCDN()) function appears in the lower panel, where you can 
now create your formula.

20.In the lower panel, place your cursor within the function brackets.
21. In the second panel, expand Report Fields, and then double-click Customer.Last Year's Sales.

Customer.Last Year's Sales is entered as the parameter within the ConvertUSDollarsToCDN function.
22. On the toolbar, click Check.

The formula is verified, with no errors found.
23.Close the Formula Editor.
24.From the Field Explorer, within the Formula Fields node, drag MyFunctionFormula to the right of the Last 

Year's Sales field in the Detail section of the report.
25. Arrange the fields to fit correctly on the report.
26.Click Main Report Preview.

The report is displayed, with your custom function having calculated the value of the MyFunctionFormula 
field.

27. Click Main Report to exit Preview mode.

1.5.5.2.7 To instantiate the FunctionTest report as a non-
embedded report and bind it to the 
CrystalReportViewer control

In Project Setup [page 15], you placed a CrystalReportViewer control on the Web or Windows Form. In the 
previous step, you have added a FunctionTest report to the project.

In this section, you instantiate the FunctionTest report as a non-embedded report and bind it to the 
CrystalReportViewer control.

1. Open the Web or Windows Form.
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2. From the View menu, click Code.
3. Add a new class-level declaration for the ReportDocument report wrapper class, using the variable name 

functionTestReport. Set its access modifier to private.

Note
The ReportDocument class is a member of the CrystalDecisions.CrystalReports.Engine namespace. You 
have added an "Imports" [Visual Basic] or "using" [C#] declaration for this namespace in 
Project Setup [page 15]. When you instantiate ReportDocument and load a report into the namespace, you 
gain access to the report through the SDK, without embedding the report.

 Private functionTestReport As ReportDocument 
 private ReportDocument functionTestReport; 

4. Within the ConfigureCrystalReports() method (that you have created in Project Setup [page 15]), 
instantiate the ReportDocument class.

 functionTestReport = New ReportDocument() 
 functionTestReport = new ReportDocument(); 

5. In the next line, call the Load() method of the ReportDocument instance and paste into it the report file 
name.

Note
Wrap the report file name in a Server.MapPath() method (Web project), or concatenate the report name 
to the string returned by Application.StartupPath() (Windows Form). For Web projects, this will 
automatically generate the file path to the report based on the report name. For Windows Form projects, it 
will be necessary to then copy the report to the directory that contains the executable file.

  functionTestReport.Load(Server.MapPath("FunctionTest.rpt"))  
  functionTestReport.Load(Server.MapPath("FunctionTest.rpt"));  

6. On the next line, beneath the report loading, bind the ReportSource property of the CrystalReportViewer to 
the ReportDocument instance.

 myCrystalReportViewer.ReportSource = functionTestReport 
 crystalReportViewer.ReportSource = functionTestReport; 

You are now ready to build and run your project.
7. From the Debug menu, click Start.

The report displays, with the new field calculating an exchange rate for last year's sales, based upon the User 
Function Library that you created.

8. Return to Visual Studio and click Stop to exit from debug mode.
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1.6 Deployment

This section describes the deployment process for Web or Windows applications that use SAP Crystal Reports.

This section describes the deployment process for Web or Windows applications that use SAP Crystal Reports.

Note
Deployment of Web Sites and Windows projects that use SAP Crystal Reports is available only if you have 
installed SAP Crystal Reports, developer version for Microsoft Visual Studio.

1.6.1  Deployment Components

SAP Crystal Reports, developer version for Microsoft Visual Studiosupports deployment projects that enable you 
to deploy your application to target machines. The deployment projects used are Setup Project for Windows 
Applications or Web Setup Project for Web Sites.

To distribute a Visual Studio application that uses SAP Crystal Reports, the deployment project needs the 
following components, depending on the type of deployment you are performing:

Project Output Assemblies, binaries and support files from the project necessary to deploy the 
application to client machines.

Report Files Embedded or non-embedded reports to be distributed to client machines.

Windows Installer (MSI) Components that enable clients to view applications that use SAP Crystal 
Reports.

.NET Framework 1.x or higher .NET components that are necessary for an application to run.

Windows Installer deployment

When you are deploying an application using Windows Installer deployment, you are copying all the application 
files and .rpt files from the development machine to the target machine separately from other third-party 
components.

The additional third-party components that you need to deploy for your application to work are the SAP Crystal 
Reports assemblies. The SAP Crystal Reports assemblies are the dll files that are required to view, export and 
print a report. These assemblies are deployed as a separate .msi file from the application files and .rpt files.

If you are deploying a ASP .NET web site, the application files you include in your deployment project are the 
following:

● Aspx files
● Aspx.cs or Aspx.vb files
● Images, html, or css files
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If you are deploying a windows application, the application files you include in your deployment project are the 
following:

● Form.cs or Form.vb files
● Form.Designer.cs or Form.Designer.vb files
● Resources.resx
● Resources.Designer.cs or Resources.Designer.vb
● Images, html, or css files

Figure 1: Windows Installer Deployment Components

ClickOnce Deployment

When you are deploying a Windows application using ClickOnce deployment., you are copying all the application 
files and .rpt files to a web server separately from the .NET Frameworks, which are also copied to the same web 
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server. You can then install the latest version of the application onto your target machine from a common web 
page. The application files you include in your deployment project are the following:

● Form.cs or Form.vb files
● Form.Designer.cs or Form.Designer.vb files
● Resources.resx
● Resources.Designer.cs or Resources.Designer.vb
● Images, html, or css files

Figure 2: ClickOnce Deployment Components

1.6.1.1 Project Output

Project output contains files from the Web or Windows applications that must be added to deployment projects. 
You can choose to add one or more of the following types of project output:
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● The Primary Output option adds all .dll and .exe files that have been built from the Web or Windows 
application.

Note
In SAP Crystal Reports for Visual Studio 2005 and up, Web Sites have been modified to exclude .dll 
and .exe files. Therefore, there is no Primary Output to add to Web Sites.

● The Content Files option adds Web.config, Global.asax, and all Web Forms (.aspx pages) that are created in 
the Web applications, or App.ico for Windows applications.

Note
You can also add Documentation Files, Localized Resources, Debug Symbols, and Source Files to the 
deployment project. However, those project output files are not necessary for deployment.

You must add Primary Output to Winform Setup Projects, and Content Files for Web Projects containing ASPX 
files.

1.6.1.2 Report Files

The report files that you need to include with your deployment project depend on which binding scenario is used 
with your Web or Windows projects. SAP Crystal Reports binding scenarios use either embedded or non-
embedded reports.

In SAP Crystal Reports, developer version for Microsoft Visual Studioapplications, embedded reports are 
compiled into the application. You can then deploy your application without having to distribute the report files 
separately.

For applications that use non-embedded reports, you must distribute the report files with the projects.

The following table describes what you must do to successfully distribute and view deployment projects that use 
specific reporting binding scenarios.

Table 10:

Report binding scenarios Requirements

● Binding to a File Directory Path in Code [page 149]
● Binding to a File Directory Path Through the Properties 

Window [page 151]
● Binding to a Non-embedded Report Loaded into the Re

portDocument Class [page 176]
● Binding to a Non-embedded Report Loaded into a Cache 

Management Utility Class [page 180]

● Distribute the report files with the deployment project.
● On the target computer, save the report files in the path 

directory that is used in the Web or Windows application. 
Follow the exact path name used by the application.

● Binding to a Report Web Service URL [page 155] ● No need to distribute report files; report files are com
piled into the Report Web Service project.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 513



Report binding scenarios Requirements

● Binding to a CrystalReportSource Control (Web Sites in 
Visual Studio) [page 153]

● Binding to an Embedded Report Class [page 174]
● Binding to a Cached Embedded Report Class [page 178]
● Binding to Crystal Enterprise (SAP Crystal Reports 10 

and up) [page 190]

● No need to distribute report files; report files are com
piled into the project.

Related Information

Comparing Embedded and Non-embedded Reports [page 143]

1.6.1.3 Common Language Runtime

To deploy Visual Studio .NET applications, the .NET Framework must be installed on the target computer, before 
you install the deployment project. When you create a deployment project, the .NET Framework is not included by 
default

Note
SAP Crystal Reports, developer version for Microsoft Visual Studio supports the .Net 2.0 framework and 
higher, including the 4.0 framework.

You can download the .NET Framework from the Microsoft Web site.

1.6.1.4 64-bit application support

Applications built on a .NET 2.0 Framework or later can target 32-bit or 64-bit machines. In SAP Crystal Reports, 
developer version for Microsoft Visual Studio 32-bit and x64 (AMD64) 64-bit architecture is supported.

Building a 64-bit application

You can build a 64-bit application under the following scenarios:

● The 32-bit SAP Crystal Reports, developer version for Microsoft Visual Studio on a 32-bit Windows operating 
system.

● The 32-bit SAP Crystal Reports, developer version for Microsoft Visual Studio on a 64-bit Windows server. 
The server administrator must install the 64-bit common language runtime and the 64-bit SAP Crystal 
Reports runtime redistributable package components on the server.
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● The 32-bit SAP Crystal Reports, developer version for Microsoft Visual Studio under WOW64 (the x86 
emulator that runs 32-bit applications on a 64-bit machine) on a 64-bit Windows server or workstation. The 
32-bit and 64-bit SAP Crystal Reports runtime redistributable packages must be installed on the same 
machine.

1.6.1.5 SAP Crystal Reports Runtime Redistributable 
Package

The SAP Crystal Reports runtime redistributable package contains the assemblies needed to run .NET 
applications developed with the SAP Crystal Reports SDK.

If SAP Crystal Reports, developer version for Microsoft Visual Studiois not installed on the target computer, the 
redistributable package must be installed separately.

1.6.1.5.1 Setup Modules

SAP Crystal Reports, developer version for Microsoft Visual Studiooffers the following types of redistributable 
setup modules:

● MSI-type redistributable modules that are targeted at ClickOnce, group policy and similar deployments.
● MSM-type merge modules that are targeted at developers creating their own setups that will embed the 

CR.NET runtime into the host setup.

Note
The MSI package has all the same components as the MSM modules but does not allow the same configuration 
options. The MSI package is only used for full deployment of the SAP Crystal Reports .NET embedded 
reporting framework.

Table 11:

Setup Module Type Target Use Description

SAP Crystal Reports .NET Embed
ded Reporting Framework, Multilan
guage

Filename:

● CRRuntime_32bit_13_x.msi
● CRRuntime_64bit_13_x.msi

MSI ClickOnce, group 
policy deployment, 
etc.

Includes the following groups of components:

● Native reporting runtime (e.g. printing engine, 
query engine, etc.)

● Database and Export drivers
● SAP Crystal Reports .NET components
● Multilanguage resources for all components 

included in the module in all supported lan
guages.
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Setup Module Type Target Use Description

SAP Crystal Reports .NET Embed
ded Reporting Framework, Multilan
guage

Filename:

● CRRuntime_13_0_xx.msm

MSM Embedded in setups Includes the following groups of components:

● Native reporting runtime (e.g. printing engine, 
query engine, etc.)

● Database and Export drivers
● SAP Crystal Reports .NET components
● Multilanguage resources for all components 

included in the module in all supported lan
guages.

Note
You need to install the Microsoft merge modules 
to use this merge module. The merged modules 
(msm) package is only availalable in a 32bit ver
sion.

Related Information

Language Resource Files [page 201]

1.6.1.5.2 To Perform a Silent Install of the SAP Crystal 
Reports Runtime

A silent installation is an installation that is run from the command line, and requires no user interaction.

1. Launch the command prompt.
2. Locate the path to your Windows Installer file.
3. Run the CRRuntime_32bit_13_x.msi or CRRuntime_64bit_13_x.msi executable.

Replace "C:\install.msi" with the path to your Windows Installer file.

msiexec.exe /i "C:\install.msi" /qn

The SAP Crystal Reports runtime is silently installed.

1.6.1.5.3 Merge Module Installation Options (optional) 

In SAP Crystal Reports, developer version for Microsoft Visual Studio, the merge modules that you have added to 
your deployment project allow you to include or exclude specific SAP Crystal Reports database and export 
drivers. In this task, you will learn to configure the installation options.
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1.6.1.5.3.1  To Change a Specific Installation Option

1. In Visual Studio, open your deployment project.
2. In the Solution Explorer, expand the node of the setup project. Select the merge module that you have added 

to your deployment project based on the deployment machine's type.
3. In the Properties window, expand the (MergeModuleProperties) node. A table with the drivers that are 

available for installation appears.
4. Set the value of a specific driver.

○ Set the value to 1 to include the driver in the deployment project.
○ Set the value to 0 to exclude the driver from the deployment project.

1.6.1.5.3.2  SAP Crystal Reports Installation Options

Database Drivers

Table 12:

Property name for database driver Description

InstallACT Crystal Reports database driver for PC databases

InstallBTRIEVE Crystal Reports database driver for Pervasive database

InstallCDO32 Crystal Reports database driver for Crystal Data Object

InstallCRDB_ADO Crystal Reports database driver for Microsoft ActiveX Data 
Objects/OLE DB

InstallCRDB_ADOPLUS Crystal Reports database driver for Microsoft ADO.NET

InstallCRDB_CDO Crystal Reports database driver for Crystal Data Object

InstallCRDB_COM Crystal Reports database driver for COM data provider

InstallCRDB_DATASET Crystal Reports database driver for DataSet provider

InstallCRDB_ODBC Crystal Reports database driver for ODBC

InstallCRDB_ORACLE Crystal Reports database driver for Oracle

InstallCRDB_QUERY Crystal Reports database driver for Query Data

InstallDAO Crystal Reports database driver for Microsoft Data Access 
Objects

InstallFIELDDEF Crystal Reports database driver for Field Definitions

InstallFILESYSTEM Crystal Reports database driver for File System data

InstallIBM_DB2 Crystal Reports database driver for DB2 Server

InstallINFORMIX Crystal Reports database driver for Informix Online Server

InstallP2BBDE Crystal Reports database driver for IDAPI

InstallP2BXBSE Crystal Reports database driver for xBase
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Property name for database driver Description

InstallP2IXBSE_DLL Crystal Reports physical database DLL for xBase

InstallP2SACL Crystal Reports database driver for Public Folder ACL

InstallP2SEVT Crystal Reports database driver for NT Event log

InstallP2SEXSR Crystal Reports database driver for Exchange Server Admin

InstallP2SMAPI Crystal Reports database driver for Exchange Folders and Ad
dress Book

InstallP2SMSIIS Crystal Reports database driver for IIS Log Files

InstallP2SOUTLK Crystal Reports database driver for Outlook Data

InstallP2SREPL Crystal Reports database driver for Exchange Public Folder 
Replica

InstallP2STRACK Crystal Reports database driver for Exchange Server Message 
Tracking Logs

InstallP2SWBLG Crystal Reports database driver for Web Log Files

InstallSYBASE Crystal Reports database driver for Sybase

Export Drivers

Table 13:

Property Name for Export Drivers Description

InstallBTRIEVE Export driver for BTRIEVE Export Format

InstallU2DMAPI Export driver for MAPI Export Format

InstallU2DNOTES Export driver for Lotus Notes Database Destination Export 
Format

InstallU2DVIM Export driver for Export to Lotus Notes Mail Format

InstallU2FCR Export driver for Report Export Format

InstallU2FHTML Export driver for HTML 4.0 Export Format

InstallU2FODBC Export driver for ODBC Export Format

InstallU2FPDF Export driver for PDF Export Format

InstallU2FREC Export driver for Records Export Format

InstallU2FRTF Export driver for Rich Text Format (RTF) Export Format

InstallU2FSEPV Export driver for Separated Values (CSV) Export Format

InstallU2FTEXT Export driver for Text Export Format

InstallU2FXLS Export driver for Microsoft Excel (97-2003) Export Format

InstallU2FXML Export driver for XML Export Format
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Other

Table 14:

Merged Module Properties Description

ForceLargerFonts Fonts are not shrunk when a Crystal report is exported

InstallWebViewer SAP Crystal Reports Web Viewer

Keycode SAP Crystal Reports Keycode

1.6.2  Deployment For Visual Studio

You have two ways to deploy a project that uses SAP Crystal Reports, developer version for Microsoft Visual 
Studio:

● ClickOnce deployment
● Windows Installer deployment

Windows Installer deployment

Windows Installer deployment is the preferred way to deploy projects that use SAP Crystal Reports, developer 
version for Microsoft Visual Studiocomponents. With Windows Installer deployment, you can deploy your projects 
and web servers to single machines.

Benefits:

● Allows you to update the SAP Crystal Reports runtime with the latest service packs or Hot Fixes without 
redeploying your application.

● SAP Crystal Reports runtime files are installed once.
● Permits the end-user to perform silent installations.

Limitations:

● Separate installations of the application and the SAP Crystal Reports runtime components.
● All database and export drivers are installed.

ClickOnce deployment 

ClickOnce deployment simplifies the deployment of Windows Applications across a network. With ClickOnce 
deployment, the end-user can now install the latest version of the application from a common web page instead of 
individually deploying the Windows Application to each of the target machines.

Benefits:

● Allows the end-user to install both the application and any dependencies such as the .NET Framework or SAP 
Crystal Reports with just one click.
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● Automatically detects when a newer version of the application is available then downloads and installs the 
update.

Limitations:

● Does not work with the .NET 1.x Framework.
● Increased installation time for the SAP Crystal Reports runtime.

Merge Modules deployment 

Merge Modules deployment can be used for deploying both windows applications and web projects. With Merge 
Modules deployment, you can attach a set of components that will eliminate version conflicts and other common 
installation problems. The components may include a .dll file, resources, registry entries, setup logic and related 
files.

Benefits:

● Allows you to choose which database and export drivers to install.
● One installation of the application and the Crystal Reports runtime components.
● End-users are not prompted for the product keycode at install time. Product keycode is embedded with your 

setup.
● Allows the end-user to install files required to display geographic maps in your report.
● No user interface indicating Crystal Reports or Business Objects branding id shown to the end-user.

Limitations:

● Updating the Crystal Reports runtime components requires rebuilding the setup with the latest merge 
modules and redeploying your application to the target machine.

● Deploys a full-size setup package to end-users even if the target machines already have the Crystal Reports 
runtime components installed.

1.6.2.1 Requirements

To work through the Deployment Tutorials in this section, you must complete Project Setup [page 15].

Check that the following requirements are met:

● Visual Studio is installed.
● Web or Windows Application that uses SAP Crystal Reports.

Note
The Windows Installer provides the SAP Crystal Reports runtime files required by a deployment project.

Related Information

Supported Versions of Visual Studio [page 10]
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1.6.2.2 ClickOnce Deployment for Visual Studio

In this section, you will learn to deploy projects that use ClickOnce deployment.

ClickOnce deployment reduces the time and effort required to deploy Windows Applications across a network. 
Rather than distribute a separate executable to each individual hard drive, ClickOnce deployment places the 
executable on a common Web page, from which all users can launch it. As part of the launch process, a copy is 
retrieved to the user's hard drive that can be used to re-launch the application locally. However, this local copy 
regularly checks the source executable on the Web page for updates.

Updates to the Windows Application can be re-published to the web server, and the newer application files are 
then available to clients. If an older version of the Windows Application opens locally on a client machine, an 
update dialog box gives the option to check for updates from the web server.

1.6.2.2.1 To Set the ClickOnce Deployment Options

You must have a completed Windows Application that uses SAP Crystal Reports.

You must set properties for Security and Publish from the Application's Properties window.

● The Security property sets the permissions for your application. By default, ClickOnce deployment has a 
limited subset of permissions. You can set the permissions to deploy only to client machines on the Intranet 
or Internet, or to allow full permissions.

● The Publish property sets the deployment location to a Web Site URL, an FTP server, or a file path. Also, this 
property sets necessary prerequisites and updates to the deployed application.

1. In the Solution Explorer, right-click the bold project name, and click Properties.
2. Click on the Security tab.
3. Select Enable ClickOnce Security Settings.

By default, the ClickOnce security permission is set to This is a full trust application.
4. Click on the Publish tab, and then click Prerequisites.
5. In the Prerequisites dialog box, under the Choose which prerequisites to install list, select the correct .Net 

Framework version and the correct SAP Crystal Reports version. See below for more information.

Note
If your clients install the correct SAP Crystal Reports version and the correct .NET Framework runtime 
before you deploy the Windows application, the installation time decreases significantly.

6. Click OK.
7. On the Publish tab, click Updates. From the Application Updates dialog box, ensure the following options are 

selected:
a. Select The application should check for updates.
b. In the Choose when the application should check for updates list, select Before the application starts.

8. Click OK to close the dialog box.
9. From the File menu, click Save All.
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1.6.2.2.2 To Publish the Windows Application

In this section, you learn to use the Publishing Wizard to publish the Windows Application to a Web Site.

Note
When you modify the application on the development machine, re-publish the application and set the update 
properties. If an older version of the application opens on the client machine, the client is notified about a new 
version of the Windows Application.

1. In the Solution Explorer, right-click the bold project name, and click Publish.
2. When the Publish Wizard dialog box appears, specify the location where you want to publish this application 

then click Next.
3. In the Will the application be available offline? dialog box, select Yes, this application is available online or 

offline, and then click Next.
4. From the Ready to Publish! dialog box, note the URL where the application is published, and then click Finish.

1.6.2.2.3 To Install and Run the Windows Application on a 
Client Machine

To complete ClickOnce deployment, you need to open the published Web Site on the client machine and choose 
which option to use when installing the Windows Application.

1. On the client machine, open a Web browser window.
2. In the browser's address bar, type the URL of the published Web Site that you have created in the previous 

procedure.

http://localhost/ProjectName/publish.htm

The published Web Site displays the name of your Windows Application.
3. The Web Site contains links to install and run the Windows Application with the prerequisites or without the 

prerequisites.

○ Click the launch link to run the application if you have already installed the prerequisites on the client 
machine.

○ Click the install button to install the prerequisites on the client machine and run the application.
4. Install the application, accepting the License Agreement if it appears.
5. After the installation is complete, you can access the Windows Application through the Start menu.

1.6.2.3 Windows Installer Deployment for Visual Studio

In this section, you learn to deploy projects that use SAP Crystal Reports, developer version for Microsoft Visual 
Studiowith Windows Installer technology. A Windows Installer allows for smaller deployment projects and reduced 
installation time.
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You can use the Windows Installer when many deployment projects are installed on the same target computer. In 
this case, the SAP Crystal Reports runtime files are installed once.

1.6.2.3.1 Creating a new Web Site Deployment Project with 
Windows Installer

To deploy your Web Site, follow the tutorial instructions in this section.

First, you create a Web Setup Project to deploy a Web Site that uses SAP Crystal Reports, developer version for 
Microsoft Visual Studio. Then, add output files that are necessary for the application to run. Finally, build the 
installer files that will deploy your Web Site.

1.6.2.3.1.1  To Create a Web Setup Project for Web Sites

You must have a completed Web Site that uses SAP Crystal Reports.

In this example, you create a Web Setup Project for Web Sites from the deployment projects that are available in 
Visual Studio.

1. In Visual Studio, open your Web Site.
2. On the File menu, point to Add, and then click New Project.
3. Navigate to the Project Types panel of the AddNew Project dialog box.
4. Expand Other Project Types and select Setup and Deployment Projects.
5. In the Templates panel, select Web Setup Project.
6. Choose an appropriate name for the project and specify its location and then click OK.

For the purposes of this tutorial, the setup project is referred to by the default name WebSetup1.
7. On the File System tab, click Web Application Folder.
8. In the Properties window, set the DefaultDocument property to the start page (an ASPX file) for the Web Site.

The VirtualDirectory property of the Web Setup Project has been set to the project name.

1.6.2.3.1.2  To Add Output Files to the Web Setup Project

This task adds the output files used by the Web Site to the Web Setup Project.

1. In Solution Explorer, right-click WebSetup1, point to Add, and then click Project Output....
2. In the Add Project Output Group dialog box, select Content Files and Primary output (if available).

Leave the Configuration as (Active).

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 523



1.6.2.3.1.3  To Build the Web Setup Project

Target computer has the required .NET Framework installed.

Building the Web Setup Project creates the installer files to copy to other computers. You can run either of these 
installers on the target computer to deploy the Web Site.

1. In the Solution Explorer, right-click WebSetup1 and select Properties.
For the purposes of this tutorial, the setup project is referred to by the default name WebSetup1.

2. Change the Solution Configuration to Release.
3. From the Build menu, click Build WebSetup1.

The build process creates the following installer files:

● setup.exe
● setup1.msi

1.6.2.3.1.4  To Deploy the Web Setup Project

The application server of the target machine must be set to the version number of the .Net Framework used to 
build the installation project.

1. Outside of Visual Studio, navigate to the directory where your deployment project has been saved.
2. Double-click the WebSetup1 folder.

3. Open the Release folder to find the files that were built by the Web Setup project.

4. Copy all the files to the target computer.
5. Distribute the Crystal reports that are used in the Web Site.

For more information about which binding scenarios require you to distribute report files, see Report Files 
[page 513].

6. On the target computer, double-click Setup.exe or WebSetup1.msi to install the Web Site.

7. To view the deployed Web Site, open a Web browser window on the target computer. Then type http://
localhost/WebSetup1 in the address bar.

Replace localhost with the name of your server.

1.6.2.3.2 Creating a new Windows Application Deployment 
Project with Windows Installer

To deploy your Windows applications, follow the tutorial instructions in this section.

First, you create a Setup Project for Windows Applications to deploy a Windows application that uses SAP Crystal 
Reports, developer version for Microsoft Visual Studio. Then, add output files that are necessary for the 
application to run. Finally, you build the installer files that will deploy your Windows application.
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1.6.2.3.2.1  To Create a Setup Project for Windows Applications

You need to have a completed Windows application that uses SAP Crystal Reports.

In this example, you create a Web Setup Project for Web Sites from the deployment projects that are available in 
Visual Studio.

1. In Visual Studio, open your Windows application.
2. On the File menu, point to Add, and then click New Project.
3. Navigate to the Project Types panel of the AddNew Project dialog box.
4. Expand Other Project Types and select Setup and Deployment Projects.
5. In the Templates panel, select Setup Project.
6. Choose an appropriate name for the project and specify its location, and then click OK.

For the purposes of this tutorial, the setup project is referred to by the default name Setup1.

1.6.2.3.2.2  To add Output Files to the Windows Setup Project

This example adds the output files used by the Windows application to the Setup Project.

1. In Solution Explorer, right-click Setup1, point to Add, and then click Project Output.
2. In the Add Project Output Group dialog box, select Primary output. Leave the Configuration as (Active).

1.6.2.3.2.3  To build the Windows Setup Project 

The target computer must have the .NET Framework installed.

Building the Setup Project creates the installer files to copy to other computers. You can run either of these 
installers on the target computer to deploy the Windows application.

1. In the Solution Explorer, right-click Setup1 and select Properties.
2. Change the Solution Configuration to Release.
3. From the Build menu, click Build Setup1.

The build process creates the following installer files:

● setup.exe
● setup1.msi

1.6.2.3.2.4  To deploy the Windows Setup Project 

1. Outside of Visual Studio, navigate to the directory where your deployment project has been saved.
2. Double-click the Setup1 folder.
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3. Open the Release folder to find the files that were built from the Setup Project.

4. Copy all the files to the target computer.
5. Distribute the SAP Crystal Reports that are used in the Windows application.

For more information about which binding scenarios require you to distribute report files, see

Report Files [page 513].
6. On the target computer, double-click Setup.exe or Setup1.msi to install the Windows application.
7. To view the Windows application, navigate to its installed location: C:\Program Files\Business Objects

\Setup1 and double-click the Windows application .exe file.

1.6.2.3.3 Performing a Silent Installation with a Windows 
Installer

With a Windows Installer you can perform a silent installation on a client machine. A silent installation is an 
installation that is run from the command line, and requires no user interaction.

1. Launch the command prompt.
2. Locate the path to your Windows Installer file.
3. Run the msiexec.exe executable.

Replace "C:\install.msi" with the path to your Windows Installer file.

msiexec.exe /i "C:\install.msi" /qn

The application installs.

1.6.2.4 Merge Modules Deployment for Visual Studio

The procedures in the following sections create merge module deployment projects for Web Sites or Windows 
applications that use SAP Crystal Reports, developer version for Microsoft Visual Studio.

If you are using report binding scenarios for Crystal Services, you need to use slightly different deployment 
procedures that are not described in this tutorial.

Note
Windows Installer is the preferred way to deploy projects that use SAP Crystal Reports, developer version for 
Microsoft Visual Studio.

Related Information

Windows Installer Deployment for Visual Studio [page 522]
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1.6.2.4.1 Creating a new Web Site Deployment Project with 
merge Modules

To deploy your Web Site, follow the tutorial instructions in this section.

First, you create a Web Setup Project to deploy a Web Site that uses SAP Crystal Reports, developer version for 
Microsoft Visual Studio. Then, add output files and merge modules necessary for the application to run. Finally, 
build the installer files that will deploy your Web Site.

1.6.2.4.1.1  To Create a Web Setup Project for Web Sites

You must have a completed Web Site that uses SAP Crystal Reports.

In this example, you create a Web Setup Project for Web Sites from the deployment projects that are available in 
Visual Studio.

1. In Visual Studio, open your Web Site.
2. On the File menu, point to Add, and then click New Project.
3. Navigate to the Project Types panel of the AddNew Project dialog box.
4. Expand Other Project Types and select Setup and Deployment Projects.
5. In the Templates panel, select Web Setup Project.
6. Choose an appropriate name for the project and specify its location and then click OK.

For the purposes of this tutorial, the setup project is referred to by the default name WebSetup1.
7. On the File System tab, click Web Application Folder.
8. In the Properties window, set the DefaultDocument property to the start page (an ASPX file) for the Web Site.

The VirtualDirectory property of the Web Setup Project has been set to the project name.

1.6.2.4.1.2  To Add Output Files to the Web Setup Project

This task adds the output files used by the Web Site to the Web Setup Project.

1. In Solution Explorer, right-click WebSetup1, point to Add, and then click Project Output....
2. In the Add Project Output Group dialog box, select Content Files and Primary output (if available).

Leave the Configuration as (Active).

1.6.2.4.1.3  To Build the Web Setup Project

Target computer has the required .NET Framework installed.

Building the Web Setup Project creates the installer files to copy to other computers. You can run either of these 
installers on the target computer to deploy the Web Site.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 527



1. In the Solution Explorer, right-click WebSetup1 and select Properties.
For the purposes of this tutorial, the setup project is referred to by the default name WebSetup1.

2. Change the Solution Configuration to Release.
3. From the Build menu, click Build WebSetup1.

The build process creates the following installer files:

● setup.exe
● setup1.msi

1.6.2.4.1.4  To Deploy the Web Setup Project

The application server of the target machine must be set to the version number of the .Net Framework used to 
build the installation project.

1. Outside of Visual Studio, navigate to the directory where your deployment project has been saved.
2. Double-click the WebSetup1 folder.

3. Open the Release folder to find the files that were built by the Web Setup project.

4. Copy all the files to the target computer.
5. Distribute the Crystal reports that are used in the Web Site.

For more information about which binding scenarios require you to distribute report files, see Report Files 
[page 513].

6. On the target computer, double-click Setup.exe or WebSetup1.msi to install the Web Site.

7. To view the deployed Web Site, open a Web browser window on the target computer. Then type http://
localhost/WebSetup1 in the address bar.

Replace localhost with the name of your server.

1.6.2.4.1.5  To Add Merge Modules to the Web Setup Project

1. In Solution Explorer, right-click WebSetup1, select Add, and then click Merge Module....
2. In the Add Modules dialog box, navigate to the folder where the merge modules package is located on your 

computer.
3. Select the merge modules that are required for your website application and add these to your application.
4. In the Solution Explorer, ensure that your selected merge modules were added under Setup1.

1.6.2.4.2 Creating a new Windows Application Deployment 
Project with Merge Modules

To deploy your Windows applications, follow the tutorial instructions in this section.
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First, you create a Setup Project for Windows Applications to deploy a Windows application that uses SAP Crystal 
Reports, developer version for Microsoft Visual Studio. Then, add output files and merge modules necessary for 
the application to run. Finally, you build the installer files that will deploy your Windows application.

1.6.2.4.2.1  To Create a Setup Project for Windows Applications

You need to have a completed Windows application that uses SAP Crystal Reports.

In this example, you create a Web Setup Project for Web Sites from the deployment projects that are available in 
Visual Studio.

1. In Visual Studio, open your Windows application.
2. On the File menu, point to Add, and then click New Project.
3. Navigate to the Project Types panel of the AddNew Project dialog box.
4. Expand Other Project Types and select Setup and Deployment Projects.
5. In the Templates panel, select Setup Project.
6. Choose an appropriate name for the project and specify its location, and then click OK.

For the purposes of this tutorial, the setup project is referred to by the default name Setup1.

1.6.2.4.2.2  To add Output Files to the Windows Setup Project

This example adds the output files used by the Windows application to the Setup Project.

1. In Solution Explorer, right-click Setup1, point to Add, and then click Project Output.
2. In the Add Project Output Group dialog box, select Primary output. Leave the Configuration as (Active).

1.6.2.4.2.3  To build the Windows Setup Project 

The target computer must have the .NET Framework installed.

Building the Setup Project creates the installer files to copy to other computers. You can run either of these 
installers on the target computer to deploy the Windows application.

1. In the Solution Explorer, right-click Setup1 and select Properties.
2. Change the Solution Configuration to Release.
3. From the Build menu, click Build Setup1.

The build process creates the following installer files:

● setup.exe
● setup1.msi
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1.6.2.4.2.4  To deploy the Windows Setup Project 

1. Outside of Visual Studio, navigate to the directory where your deployment project has been saved.
2. Double-click the Setup1 folder.

3. Open the Release folder to find the files that were built from the Setup Project.

4. Copy all the files to the target computer.
5. Distribute the SAP Crystal Reports that are used in the Windows application.

For more information about which binding scenarios require you to distribute report files, see

Report Files [page 513].
6. On the target computer, double-click Setup.exe or Setup1.msi to install the Windows application.
7. To view the Windows application, navigate to its installed location: C:\Program Files\Business Objects

\Setup1 and double-click the Windows application .exe file.

1.6.2.4.2.5  To add Merge Modules to the Windows Setup 
Project 

1. In Solution Explorer, right-click WebSetup1, select Add, and then click Merge Module....
2. In the Add Modules dialog box, navigate to the folder where the merge modules package is located on your 

computer.
3. Select the merge modules that are required for your Windows application and add these to your application.
4. In the Solution Explorer, ensure that your selected merge modules were added under Setup1.

1.6.2.5 Migrating a Project that Uses Merge Modules 
Deployment to a Project that Uses Windows Installer 
Deployment

To migrate an existing SAP Crystal Reports, developer version for Microsoft Visual Studio project that uses Merge 
Modules deployment to Windows Installer deployment, you need to follow the instructions in this section.

You will need to remove the merge modules from the setup project. Then, re-build the setup project. Finally, use 
the .msi Windows Installer file to deploy your application.

For the purposes of this tutorial, the setup project is referred to by the default name Setup1.

Note
If you are using a Visual Studio .NET project built with an earlier version of Visual Studio, you need to first 
convert the Windows Application or Web Site to a Visual Studio 2010 or newer project.
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1.6.2.5.1 To Remove Merge Modules from the Setup Project

1. In Visual Studio, open your project.
2. In the Solution Explorer, expand Setup1, and point to a merge module that has been added to the setup 

project. Click Remove.
3. Repeat Step 2 to remove all SAP Crystal Reports, developer version for Microsoft Visual Studio Merge 

Modules.

1.6.2.5.2 To Build and Deploy the Setup Project

After removing the merge modules from your setup project, you would need to build and deploy the setup project. 
See To build the Windows Setup Project [page 529] for more information.

1.7 Creating Reports

This section provides detailed information about using the embedded SAP Crystal Reports Designer within Visual 
Studio. It also contains an overview of syntax you can use to create formulas in a Crystal report and provides a 
user interface reference.

The embedded SAP Crystal Reports Designer comes with tutorials to help you learn and understand SAP Crystal 
Reports:

● For detailed instructions on how to use specific features of the SAP Crystal Reports .Net SDK, see Using the 
SDK [page 100]. This is useful if you are already familiar with reporting concepts.

Related Information

Using the Embedded SAP Crystal Reports Designer [page 531]

1.7.1  Using the Embedded SAP Crystal Reports Designer

SAP Crystal Reports is used to add reporting capabilities to your application or Web Service. You can create a 
report from scratch or you can use one of the Crystal Report Creation Wizards [page 542] to help you through 
the design process.

The reports you create can be used in both Web and Windows applications. You can also publish a Crystal report 
as a Report Web Service on a Web server.

Regardless of what you decide to do with your report, you will create and make changes to the report itself in the 
embedded SAP Crystal Reports Designer. The embedded SAP Crystal Reports Designer enables you to design 
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and modify reports inside the Visual Studio Integrated Development Environment (IDE). The designer can be 
directly programmed from within Visual Studio IDE. You do not need to distribute the designer with your report.

1.7.1.1 Embedded SAP Crystal Reports Designer Overview

Explains the layout and tools of the embedded SAP Crystal Reports Designer.

Use the embedded SAP Crystal Reports Designer to define the report's data source, to select and group the data 
records you want to use, and to format the report's objects and layout. You can create a report from scratch or 
you can use one of the Crystal Report Creation Wizards [page 542] to help you through the design process.

The embedded SAP Crystal Reports Designer uses a drag-and-drop approach similar to Visual Studio — you drag 
a report object onto the designer (such as a database field or text object) and use the Property window or 
shortcut menu to format the object.

1.7.1.1.1 Accessing the Embedded SAP Crystal Reports 
Designer

When you double-click an existing Crystal report object in your project, or add a new report object to your project, 
the embedded SAP Crystal Reports Designer launches automatically.

Related Information

Accessing and Adding Data [page 549]

1.7.1.1.1.1  To create a new report

1. In Solution Explorer, right-click the project name in bold type to display the shortcut menu.
2. Point to Add, and then click Add New Item.
3. In the Add New Item dialog box, select Crystal Report from the Templates area. Click Add.
4. In the Crystal Reports Gallery, select one of the following options:

○ Using the Report Wizard – guides you through the report creation process and adds your choices to the 
embedded SAP Crystal Reports Designer.

○ As a Blank Report – opens the embedded SAP Crystal Reports Designer.
○ From an Existing Report – creates a new report with the same design as another report you specify.

Note
The Gallery contains a number of experts to guide you through the creation of specific types of reports. 
You may want to build your first reports using the experts, in order to decide which method of report 
construction suits your needs.
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5. Click OK.
6. Save the report by clicking Save on the Standard toolbar.

If you chose to use the Report Wizard, the Standard Report Creation Wizard dialog box appears with the Data 
screen active. Select the data required for each folder, work through the Report Creation Wizard's screen 
interface, and click Finish to access the embedded SAP Crystal Reports Designer and your report.

1.7.1.1.2 Layout of the Embedded SAP Crystal Reports 
Designer

When creating a report, you do most of the report design work in the embedded SAP Crystal Reports Designer. 
The designer is divided into labeled report sections. You can place report objects, such as database fields, formula 
fields, parameter fields, and running total fields, in the section you would like them to appear.

The embedded SAP Crystal Reports Designer provides a very efficient environment for designing a report 
because, even though you are working with database data, you are working in a design environment where the 
data does not need to be refreshed whenever you make changes to the report. When you place a field on the 
report, the embedded SAP Crystal Reports Designer uses a frame to identify the field on the tab, rather than 
retrieving the data. Thus, you can add and delete fields and other objects, move them around, and set up complex 
formulas, without having to wait for the data to be refreshed.

The following diagram shows the embedded SAP Crystal Reports Designer displaying a sample World Sales 
report.

The Field Explorer [page 539] and the Crystal Reports Toolbars [page 540] (buttons on the Toolbar) are part 
of the embedded SAP Crystal Reports Designer. The report sections in the embedded SAP Crystal Reports 
Designer show the report objects included in each section.

In the example below, "Report Header a" contains the company's logo, and "Report Header c" contains a chart 
showing last year's sales by country. The logo and chart are report objects that were dragged onto the design 
page and formatted. Because the logo and chart are part of the Report Header, they will only appear once in the 
finished report.

The Field Explorer [page 539] lists all the fields available for this report. The check marks indicate which fields 
are currently inserted in the report.
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Related Information

Designing New Reports [page 546]

1.7.1.1.2.1  Report Section Overview

For a new report, the embedded SAP Crystal Reports Designer is divided into five report sections. You can choose 
to create additional sections, or to hide certain sections.

● Report Header
● Page Header
● Details
● Report Footer
● Page Footer

The data that appears in the finished report is contingent upon your design choices: in particular, report data 
varies depending on the sections into which you choose to insert particular report objects. For example, if you 
insert a chart object in the Report Header section, the chart will appear only once at the beginning of the report 
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and will summarize the data contained in the report. Alternatively, if a chart object is added to the Group Header 
section, a separate chart will appear at the beginning of each group of data and will summarize the data relating 
only to that group.

Related Information

Determining Printing Area Characteristics [page 549]
Report Processing Model [page 544]
Hiding Report Sections [page 641]
Designing New Reports [page 546]

1.7.1.1.2.1.1  Report Header

Objects placed in the Report Header section print once, at the beginning of the report.

The Report Header section generally contains the report title and other information you want to appear only at the 
beginning of the report.

● Charts and cross-tabs placed in this section contain data for the entire report.
● Formulas placed in this section are evaluated once, at the beginning of the report.

Related Information

Determining Printing Area Characteristics [page 549]
Embedded SAP Crystal Reports Designer Overview [page 532]

1.7.1.1.2.1.2  Page Header

Objects placed in the Page Header section print at the beginning of each new page.

The Page Header section generally contains information that you want to appear at the top of each page. This can 
include text fields such as chapter names, document name, or other similar information. This section can also be 
used to contain field titles, which will then display as labels above the columns of field data in the report.

● Charts or Cross-Tabs cannot be placed in this section.
● Formulas placed in this section are evaluated once per page, at the beginning of each new page.
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Related Information

Determining Printing Area Characteristics [page 549]
Embedded SAP Crystal Reports Designer Overview [page 532]

1.7.1.1.2.1.3  Details

Objects placed in the Details section print with each new record.

The Details section contains data for the body of the report. The bulk of the report data usually appears in this 
section. When the report is run, the Details section is re-printed for each record. For example, if you add a 
database object to the Details section, and this database object contains 100 records, then the report will print 
100 individual detail sections at runtime.

● Charts or cross-tabs cannot be placed in this section.
● Formulas placed in this section are evaluated once for each record.

Related Information

Determining Printing Area Characteristics [page 549]
Embedded SAP Crystal Reports Designer Overview [page 532]

1.7.1.1.2.1.4  Report Footer

Objects placed in the Report Footer section print once at the end of the report.

This section is used to contain information you want to appear only once at the end of the report, such as grand 
totals.

● Charts and Cross-Tabs placed in this section contain data for the entire report.
● Formulas placed in this section are evaluated once, at the end of the report.

Related Information

Determining Printing Area Characteristics [page 549]
Embedded SAP Crystal Reports Designer Overview [page 532]
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1.7.1.1.2.1.5  Page Footer

Objects placed in the Page Footer section print at the bottom of each page.

This section usually contains the page number and any other information you want to appear at the bottom of 
each page.

● Charts and Cross-Tabs cannot be placed in this section.
● Formulas placed in this section are evaluated once per page, at the end of each new page.

Related Information

Determining Printing Area Characteristics [page 549]
Embedded SAP Crystal Reports Designer Overview [page 532]

1.7.1.1.2.1.6  Additional Report Sections

If a group, summary, or subtotal is added to the report, the program creates two additional sections: the Group 
Header and the Group Footer.

When a group, summary, or subtotal is added, the Group Header section appears directly above the Details 
section, and the Group Footer section appears directly below the Details section. Like the original report sections, 
each of these newly added sections can contain one or more subsections. By default, they each contain a single 
section.

Group Header

Objects placed in the Group Header section print at the beginning of each new group.

This section typically holds the group name field, and it can also be used to display charts or cross-tabs that 
include data specific to the group. The Group Header section is printed once at the beginning of each group.

● Charts and cross-tabs placed in this section contain data just for the group.
● Formulas placed in this section are evaluated once for each group, at the beginning of the group.

Group Footer

Objects placed in the Group Footer section print at the end of each group.

This section generally holds the summary value, if any, and can be used to display charts or cross-tabs. The Group 
Footer section is printed once at the end of each group.
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● Charts and cross-tabs placed in this section contain data just for the group.
● Formulas placed in this section are evaluated once for each group, at the end of the group.

Related Information

Determining Printing Area Characteristics [page 549]
Designing New Reports [page 546]

1.7.1.1.2.2  Report Section Characteristics

A report consists of several sections, including the Report Header, Page Header, Group Header, Details, Group 
Footer, Page Footer, and Report Footer.

Each report section is made up of a series of lines. When a text-based object is placed in a section, it is placed on a 
line in such a way that the text is aligned to the baseline. The line's height is then adjusted by the printer driver so 
that it is high enough to accommodate the object.

A line's height is determined by the text-based object with the largest font size on the line.

● If you place another text-based object on the same line with a font size larger than that of the first object, the 
line's height extends to accommodate the second object

● If you place another text-based object on the same line with a font size even larger than the previous two 
objects, the line's height extends to accommodate the third object.

As you add text-based objects to a report, either in the same section or other sections, the line height adjusts to 
accommodate the various fonts. Since this vertical spacing is set up by the printer driver, it is difficult to create 
reports designed for pre-printed forms when they are printed in various environments.

When designing reports, you should do the following:

● keep all font sizes the same
● be sure to print pre-printed forms on the same machine

Related Information

Field and Text Objects [page 556]
Report Processing Model [page 544]
Hiding Report Sections [page 641]

538 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



1.7.1.1.2.3  Formatting Report Sections

Use the commands on shortcut menus to format report sections. For example:

● To format a section in a report, right-click in the embedded SAP Crystal Reports Designer, point to Report, 
and click Section Expert.

● To change page margins, right-click in the embedded SAP Crystal Reports Designer, point to Design, and click 
Page Setup.

● To turn the ruler on or off, right-click in the embedded SAP Crystal Reports Designer, point to Design, and 
click Ruler.

● To turn the design grid on or off, right-click in the embedded SAP Crystal Reports Designer, point to Design, 
and click Grid.

Related Information

Formatting Data [page 608]

1.7.1.1.2.4  Field Explorer

Use the Field Explorer to insert, modify, or delete fields on your Crystal report.

The Field Explorer, which is part of the embedded SAP Crystal Reports Designer, shows a tree view of Database 
Fields and Special Fields that are available for you to add to your report. The Field Explorer also shows the 
Formula, Parameter, Group Name, Running Total, SQL Expression, and Unbound Fields that you have defined for 
use in your report.

The Field Explorer displays check marks next to fields already added directly to the report, and next to fields you 
have referenced or otherwise used within other fields and calculations (such as formula fields, groups, running 
totals, and summaries).

1.7.1.1.2.4.1  To view the Field Explorer from the embedded SAP 
Crystal Reports Designer

1. From the Crystal Reports menu, click Field Explorer.
2. Right-click any field to view its menu options.

Note
There is an alternate way to access the field explorer. Click the View menu, point to Other Windows, and click 
Document Outline.
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Related Information

Accessing and Adding Data [page 549]
Embedded SAP Crystal Reports Designer Overview [page 532]

1.7.1.1.2.5  Crystal Reports Toolbars

When you open the embedded SAP Crystal Reports Designer to create or modify a report, two Crystal Reports 
toolbars automatically appear on your toolbar:

Crystal Reports – 
Main toolbar

This toolbar contains shortcuts to the Field Explorer, Select Expert, Group Sort Expert, 
Record Sort Expert, and Format Editor dialog boxes. This toolbar also contains basic 
formatting options for text objects and a Zoom drop-down list.

Crystal Reports – 
Insert toolbar

This toolbar contains shortcuts to the Insert Summary, Insert Group, Insert Subreport, 
Chart Expert dialog boxes. This toolbar also includes a shortcut for adding a picture to 
your report.

To show/hide the Crystal Reports toolbars:

● On the View menu, point to Toolbars and click Crystal Reports – Insert or Crystal Reports – Main.

Related Information

Layout of the Embedded SAP Crystal Reports Designer [page 533]
Field Explorer [page 539]
Customizing the CrystalReportViewer control [page 196]

1.7.1.1.2.6  Crystal Reports Menu

When you open the embedded SAP Crystal Reports Designer to create or modify a report, the Crystal Reports 
menu automatically appears on the Visual Studio IDE toolbar.

The Crystal Reports menu has the same options as the menu that appears when you right-click on the embedded 
SAP Crystal Reports Designer.

This menu contains the Insert, Database, Report, and Design submenus. In addition, there are options to close the 
subreport, preview the report, set the cascading style sheet (CSS) class, go to the previous or next report view, 
check for updates, and register SAP Crystal Reports.

The Insert submenu is used to insert objects on the report, such as database fields, text objects, summaries, 
groups, sections, cross-tabs, subreports, charts, and pictures.

The Database submenu has the following options:
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● Database Expert Dialog Box [page 833]
● Set Datasource Location Dialog Box [page 799]
● Log On or Off Server (see Data Explorer Dialog Box [page 745])
● Verify Database
● Verify on Every Print
● Show SQL Query Dialog Box [page 802]

The Report submenu has the following options:

● Select Expert Dialog Box [page 846]
● Selection Formula (see Formula Editor Dialog Box [page 774])
● Formula Workshop Dialog Box [page 779]
● Section Expert [page 841]
● Group Expert Dialog Box [page 838]
● Group Sort Expert Dialog Box [page 839]
● Hierarchical Group Options Dialog Box [page 781]
● Record Sort Expert [page 793]
● Report Options Dialog Box [page 795]
● Set Print Date and Time Dialog Box [page 801]
● Summary Info (see Document Properties Dialog Box [page 754])

The Design submenu has the following options:

● Print Setup Dialog Box [page 792]
● Page Setup Dialog Box [page 791]
● Default Settings Dialog Box [page 745]
● Ruler
● Grid
● Field Explorer [page 539]

Related Information

Layout of the Embedded SAP Crystal Reports Designer [page 533]
User Interface Reference [page 711]

1.7.1.1.2.7  Preview Tab

The Preview tab displays a read-only version of the Crystal report (.rpt file), through use of the ActiveX report 
viewer. The report cannot be modified in the preview window.

The current report is displayed with its default data. If there is a database logon failure or if the report uses report 
off application data (for example, DataSets or object collections), then the data is temporarily generated. A report 
that contains saved data will display the saved data instead of accessing the database. Click the refresh button in 
the preview mode to generate new data. To save data in preview mode, select the Save data in the report option at 
the top of the report preview screen. To set a report to always save data when the report is saved you must use 
the standalone designer.
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Note
The Preview tab is not available in the embedded SAP Crystal Reports Designer for Visual Studio .NET 2003.

The Preview tab can be found at the bottom of the embedded SAP Crystal Reports Designer, with the name, "Main 
Report Preview".

1.7.1.1.3 Crystal Report Creation Wizards

You can use the embedded SAP Crystal Reports Designer to create a report from scratch, or you can use one of 
the SAP Crystal Reports Creation Wizards to help you through the design process. The following Report Creation 
Wizards are included in SAP Crystal Reports:

● Standard
● Cross-Tab
● Mail Label

Each Report Creation Wizard consists of several screens that lead you through step-by-step instructions for 
creating the specified report. Many of the Report Creation Wizards have tabs unique to a specific type of report. 
For example, the Mailing Labels Report Creation Wizard [page 543] has a tab that allows you to specify the type 
of mailing label you want to use.

1.7.1.1.3.1  Standard Report Creation Wizard

The Standard Report Creation Wizard is the most generic of the experts. It guides you through choosing a data 
source and linking database tables. It also helps you add fields and specify the grouping, summarization (totals), 
and sorting criteria you want to use. Finally, the Standard Report Creation Wizard leads you through chart 
creation and record selection.

The Template screen contains predefined layouts for you to apply to your report to give it more impact.

The Standard Report Creation Wizard has the following screens:

● Data Screen (Report Creation Wizard) [page 813]
● Link Screen (Report Creation Wizard) [page 813]
● Fields Screen (Report Creation Wizard) [page 813]
● Grouping Screen (Report Creation Wizard) [page 814]
● Summaries Screen (Report Creation Wizard) [page 814]
● Group Sorting Screen (Report Creation Wizard) [page 815]
● Chart Screen (Report Creation Wizard) [page 816]
● Record Selection Screen (Report Creation Wizard) [page 816]
● Report Style (Report Creation Wizard) [page 817]
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1.7.1.1.3.2  Cross-Tab Report Creation Wizard

The Cross-Tab Report Creation Wizard guides you through the creation of a report in which your data is displayed 
as a Cross-Tab Objects [page 634]. Two special screens (Cross-Tab and Grid Style) help you to create and 
format the cross-tab itself.

The Cross-Tab Report Creation Wizard has the following screens:

● Data Screen (Report Creation Wizard) [page 813]
● Link Screen (Report Creation Wizard) [page 813]
● Cross-Tab Screen (Cross-Tab Report Creation Wizard) [page 817]
● Chart Screen (Report Creation Wizard) [page 816]
● Record Selection Screen (Report Creation Wizard) [page 816]
● Grid Style Screen (Cross-Tab Report Creation Wizard) [page 818]

Related Information

Cross-Tab Objects [page 634]
Crystal Report Creation Wizards [page 542]
Designing New Reports [page 546]
Cross-Tab Objects [page 634]

1.7.1.1.3.3  Mailing Labels Report Creation Wizard

The Mailing Labels Report Creation Wizard lets you create a report that is formatted to print on a mailing label of 
any size. You can use the Label screen to select a commercial label type, or you can define your own layout of 
rows and columns for any multi-column style report.

The Mailing Labels Report Creation Wizard has the following screens:

● Data Screen (Report Creation Wizard) [page 813]
● Link Screen (Report Creation Wizard) [page 813]
● Fields Screen (Report Creation Wizard) [page 813]
● Label Screen (Mailing Labels Report Creation Wizard) [page 819]
● Record Selection Screen (Report Creation Wizard) [page 816]

Related Information

Crystal Report Creation Wizards [page 542]
Designing New Reports [page 546]
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1.7.1.1.4 Report Processing Model

SAP Crystal Reports uses a three-pass reporting method to generate reports. A pass is a process that SAP 
Crystal Reports uses each time the data is read and manipulated. Depending on the complexity of the report SAP 
Crystal Reports may make 1, 2, or 3 passes over the data. This feature allows for complex reporting and formula 
manipulation.

Pre-Pass 1

When previewing a report, the first elements to be evaluated are "constant" formulas. Constant formulas are 
those that have a constant value for the entire report. They do not change from record to record. For example, 
100* 30 would be a constant formula. Constant formulas are evaluated at the beginning of the print generation 
process and are never evaluated again. This process is known as "BeforeReadingRecords." If you were to place a 
constant formula field (i.e., 100*30) in the Details section, the result would be 3000 for each record displayed.

Pass 1

After the "BeforeReadingRecords" process has taken place, SAP Crystal Reports begins reading the database 
records. During the record reading process, the following will occur:

● Record retrieval. Where possible record selection and sorting are pushed down to the database in this step.
● Evaluation of recurring formulas. These formulas are those that contain database fields but do not contain 

references to subtotals or summary information. This evaluation time is known as "WhileReadingRecords." 
Formulas that contain references to subtotals or summary information are processed in the second pass.

● Application of the record selection locally. If the record selection is too complex to be pushed down to the 
database, it is applied by SAP Crystal Reports in this step.

● Sorting, grouping, and totaling. In this step, SAP Crystal Reports sorts the records, separates them into 
groups, and then calculates the subtotals and summaries needed for each group.
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● Cross-Tab, chart, and map generation. Only Cross-Tabs, charts, and maps that are based entirely on 
database fields and recurring formulas are generated in Pass 1. If these objects include running totals and/or 
PrintTime formulas, they are generated in Pass 2.

● Storage of saved data. After the totaling process is complete, all of the records and totals are stored in 
memory and to temporary files. SAP Crystal Reports does not read the database again, but instead uses this 
saved data during all subsequent processing.

● Application of the saved data selection formula on saved data. If a new parameter is set using this formula, it 
will not result in a database hit.

Pre-Pass 2

During Pre-Pass 2, SAP Crystal Reports orders the groups in the report for Top/Bottom N or Hierarchical 
Grouping. The records are not read in this process, instead SAP Crystal Reports only looks at group instances 
from Pass 1, and takes the Top N as appropriate, or orders the groups based on the Hierarchical Grouping settings 
specified.

Pass 2

SAP Crystal Reports enters the second pass through the data to format pages. The pages are formatted on 
demand. This means that SAP Crystal Reports will not format a page until it is requested by the user, or it is 
required for the total page count in Pass 3.

During page formatting, SAP Crystal Reports does the following:

● Group selection formulas
● Running totals
● Calculation of formulas marked "WhilePrintingRecords."

These are formulas that contain references to subtotals or summary information, also known as "PrintTime" 
formulas. This evaluation time is known as "WhilePrintingRecords."

● Cross-Tabs, charts, and maps
Cross-Tabs, charts, and maps that include running totals and/or PrintTime formulas, and charts that are 
based on Cross-Tabs are generated in Pass 2.

● OLAP grids
● Subreports
● Generate Pages on Demand

Note
Subtotals, grand totals, and summaries may be incorrect if the report has a group selection formula. This 
occurs because the grand totals and summaries are calculated during Pass 1, but the group selection 
formula filters the data again in Pass 2. Running total fields can be used instead of summaries to total data 
in reports with a group selection formula.
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Pass 3

In the third, and final pass, the total page count is determined. This applies to reports that use the total page 
count, or Page N of M, special variable fields.

1.7.1.2 Designing New Reports

Explains how to access the embedded SAP Crystal Reports Designer and provides detailed steps on how to 
design a new report.

You create reports in the embedded SAP Crystal Reports Designer. The designer automatically launches when 
you add a SAP Crystal Reports object to your project, or when you double-click an existing SAP Crystal Reports 
object in your project.

Related Information

Report Section Overview [page 534]

1.7.1.2.1 Planning the Content of the Report

Before you do anything else, you should outline the information you want the report to provide. The following 
sections can act as a guide to making that outline.

Related Information

Accessing and Adding Data [page 549]

1.7.1.2.1.1  Stating the Purpose of the Report

Reports are management tools. Their purpose is to help you quickly grasp the essential elements and 
relationships found in raw data and to help you make effective decisions.

A good starting place in the development of a report is to write out the purpose of the report in a sentence or two. 
The purpose statement helps you focus on your primary needs, and it gives the report both a starting point and a 
goal.

Examples of Purpose Statements
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● The purpose of this report is to show monthly and year-to-date sales by sales representatives, to compare 
this year's numbers to last year's, and to flag representatives whose sales figures do not meet company 
standards.

● The purpose of this report is to show sales activity for each item in inventory, and to suggest reorder 
quantities based on that activity.

Defining the purpose of the report before you start is a critical step in the overall process.

Meeting Many Users' Needs

A single report is often used by many individuals. A detailed, company-wide sales report, for example, may be 
used by sales representatives, the regional sales manager, the national sales manager, and the Chief Operating 
Officer (COO).

These individuals will be interested in different aspects of the report. Since each user of the report has different 
interests, it is important to plan the report so it includes the information each user is looking for.

Some options to consider incorporating into a report are:

● Inserting Charts [page 622] that show high-level information, but allow users to drill down to more detailed 
information.

● Setting Parameters [page 576] that prompt users to enter information so that unnecessary information is 
filtered out before the report is viewed.

1.7.1.2.1.2  Understanding Your Data Source

This step requires you to look at the available database table(s). SAP Crystal Reports allows you to combine data 
from different databases when you create reports, so you have a great deal of flexibility in your work.

● Much of the data in a typical report is taken directly from data fields. Which data fields will be used, and where 
are they located?

● Other data will be calculated based on data fields. Which data fields will be used in the calculations?
● Other data will be placed directly into the report using text objects (for example: headings, notes, and labels).

Note
SAP Crystal Reports can generate information such as the current date or page numbers.

Related Information

Selecting a Database [page 551]
To Insert Database Fields [page 555]
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1.7.1.2.1.3  Manipulating Data

Organize Data into Groups

SAP Crystal Reports provides several options for Selecting Records [page 566] and Grouping Data [page 582] 
in a report.

You can base a report on all records in a given database, or on a limited set of records from the database. SAP 
Crystal Reports can be used to select records based on simple date ranges or comparisons, or to create complex 
formulas to identify the records to be included.

Summarize Data

Do you want to subtotal, average, count, add percentages, or determine the maximum or minimum value included 
in all the values in any column on the report?

SAP Crystal Reports allows you to accomplish all of these calculations, and it also allows the grand total (or the 
grand total average, grand total count, and so on) to be placed at the bottom of the selected column.

Flag Data

You may want to call attention to some data by flagging it on the report. For example, non-moving inventory items 
are often flagged on inventory reports so they can be given special attention. You might want to flag each item 
that has shown no activity during the last month, during the last three months, or during some other defined 
period. To flag information, identify it and any conditions that will trigger the flagging.

Format Flagged Data

SAP Crystal Reports gives you the opportunity to underline report elements, and to change the font type, size, or 
color used for specific report items. It allows you to put borders around items, to draw lines and boxes (to break 
the report into sections), to set off headings, and so on. All of these formatting tools can be used to highlight key 
data on a report.

Related Information

Selecting Top or Bottom N Groups [page 587]
Adding Percentages to a Report [page 592]
To subtotal data [page 591]
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1.7.1.2.1.4  Determining Printing Area Characteristics

Each report section has its own printing characteristics. It is important to understand these characteristics 
because they affect when and how often different report objects get printed.

Sections print from top to bottom according to the order in which they appear on the embedded SAP Crystal 
Reports Designer. If there is more than one subsection in any given section, the subsections print in order of 
appearance. For example, if you have three Report Header sections, all three of those sections will print, in order, 
before the Page Header section(s) begin to print.

The way objects print will determine how you design your report. Understanding printing area characteristics 
helps you to decide where to place charts, cross-tabs, and formulas to get specific results.

1.7.1.2.2 Accessing and Adding Data

In the embedded SAP Crystal Reports Designer, you first select the data source that your report will reference. 
You can use more than one data source in a report.

Next, you choose the database tables you want to use in the report. SAP Crystal Reports can automatically link 
the tables, or you can specify how you want the tables linked. Database tables are linked so records from one 
database match related records from another.

Related Information

Setting the Data Source [page 132]

1.7.1.2.2.1  Supported Data Sources

SAP Crystal Reports connects to databases through database drivers. Each driver is written to handle a specific 
database type or database access technology.

All versions of SAP Crystal Reports, developer version for Microsoft Visual Studio can access and report off of the 
following data sources:

● Any database with an ODBC driver
● Any database with an OLEDB Provider
● Microsoft Access databases

Note
There is no 64-Bit driver for Microsoft Access databases. You will not be able to connect to a Microsoft 
Access database if you are designing your report on a 64-Bit machine.

● Microsoft Excel (97-2003) workbooks
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● ADO.NET datasets
● ADO.NET datatables
● ADO recordsets
● CDO recordsets
● IDataReader
● Object Collections
● DAO recordsets
● RDO recordsets
● XML in SQL Server 2005
● User Defined Types (UDT) in SQL Server 2005

Other versions of SAP Crystal Reports, developer version for Microsoft Visual Studio include native drivers and 
support for additional data sources such as JDBC, Teradata and OLAP.

1.7.1.2.2.2  Reporting off ADO.NET Datasets

Explains how to connect your report to an ADO.NET dataset.

SAP Crystal Reports supports reports that access ADO.NET datasets.

An ADO.NET dataset object is a collection of dataset classes created in memory. You can create an ADO.NET 
dataset from various data sources (including Access, Oracle, and SQL Server databases) by using the Visual 
Studio ADO.NET Dataset Designer. The ADO.NET Dataset Designer shows a graphic view of the database with its 
tables, its fields, and their corresponding types. You can drag tables from the Server Explorer to a schema file in 
the Schema tab of the designer.

Generating ADO.NET Datasets

An ADO.NET dataset object provides a data description from which you can add tables to your Crystal report. The 
Database Expert in the embedded SAP Crystal Reports Designer is used to add tables from the ADO.NET dataset 
object.

You can invoke the Database Expert when you are Accessing the Embedded SAP Crystal Reports Designer [page 
532] with a Report Creation Wizard. Or, to access the Database Expert from a report that has already been set up 
with ADO.NET, right-click in the embedded SAP Crystal Reports Designer, point to Database, and click Database 
Expert.
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Viewing Reports using ADO.NET Datasets

A dataset object generated with the ADO.NET Dataset Designer contains only the data description, and not the 
actual data. Consequently, when working with a report connected to such a dataset object, you cannot browse 
field data in the embedded SAP Crystal Reports Designer at design time.

To have the report display the actual data at runtime, you must first push the data into the dataset object using 
the ADO.NET Object Model, and then pass the populated dataset to the report engine using the Report Engine 
Object Model. You must also bind the report by report object in the corresponding source file for the Web or 
Windows form.

Related Information

Tutorial: Connecting to ADO.NET DataSets [page 455]

1.7.1.2.2.3  Selecting a Database

Explains how to connect to a database or dataset and select the tables to use in your report.

To make changes to the data source of a report, right-click in the embedded SAP Crystal Reports Designer, point 
to Database, and then select Database Expert from the shortcut menu.

You can then manipulate a data source by re-linking tables, adding and removing a database, setting a database 
location, verifying a database, and converting to a different database driver.

1.7.1.2.2.3.1  To select a database

1. Right-click Database Fields in the Field Explorer and click Database Expert.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

2. In the Database Expert dialog box, browse the folders to find your data source tables.
3. Select the tables that contain the data you want to report on and click OK.

Note
Instead of selecting the tables, double-click the Add Command node to enter an SQL query.

4. In the Links tab, click Link to automatically link the database tables, or click and drag a database field from one 
table to another table to create a manual link.

5. If you have linked more than two tables, click Order Links to arrange the links in the order you would like them 
to be processed.
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6. Click OK.

The database tables you selected now appear under the Database Fields in the Field Explorer.

Related Information

Connecting to ADO.NET DataSets [page 137]
Defining Virtual Tables Based on a Command/SQL Query [page 552]
Linking Database Tables [page 554]
To Insert Database Fields [page 555]

1.7.1.2.2.3.2  To change the data source location

Use the Set Location command to indicate the new name or location of tables that are active in a report. This is 
especially useful if someone sends you a report that uses a database that has a different location on your system, 
or if you have changed the directory or disk location of a database. In addition, the Set Location command 
automatically converts your database driver to the data source you have chosen. For example, you can 
automatically convert a direct access data source to an ODBC data source using the Set Location command.

The procedure is the same whether you are replacing all tables from a particular data source with tables of the 
same name from another data source, or replacing an individual table with another table.

1. Right-click in the embedded SAP Crystal Reports Designer, point to Database, and click Set Datasource 
Location.

2. From the Current Data Source list, choose the data source table from which you want to change.
3. In the Replace with list, browse for the new data source.
4. Select the table you want to change to.
5. Click Update.
6. Click Close after you have changed all tables you want to change; otherwise repeat these steps for any 

unmodified tables or data sources.

1.7.1.2.2.3.3  Defining Virtual Tables Based on a Command/SQL 
Query

If the database you are using supports a query language such as SQL, you can write your own command which will 
be represented in SAP Crystal Reports as a Table object. This allows experienced database users complete 
control of the data processing that gets pushed down to the database server. An experienced user can write a 
highly optimized command that can considerably reduce the size of the set of data returned from the server.

You can write your own command by using the Add Command node in the Database Expert to create a virtual 
table which will represent the results of processing the command.

When you use a virtual table that was created as a Command, SAP Crystal Reports does not alter the syntax of the 
SQL submitted to the server (that is, it does not automatically add quoting or escape characters). This behavior 
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also applies to parameters used in Commands. Therefore, your must add the quoting and escape characters that 
are necessary for your database driver.

Related Information

To Insert Database Fields [page 555]

1.7.1.2.2.3.3.1  To create your own command object

1. Right-click Database Fields in the Field Explorer and click Database Expert.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

2. In the Database Expert dialog box, browse the folders to locate your data source.
3. Under your data source, double-click the Add Command node.
4. In the Add Command to Report dialog box, enter an appropriate query/command for the data source you 

have opened.
For example:

 SELECT
    Customer.`Customer ID`,
    Customer.`Customer Name`,
    Customer.`Last Year's Sales`,
    Customer.`Region`,
    Customer.`Country`,
    Orders.`Order Amount`,
    Orders.`Customer ID`,
    Orders.`Order Date`
FROM
    Customer Customer INNER JOIN Orders Orders ON
        Customer.`Customer ID` = Orders.`Customer ID`
WHERE
    (Customer.`Country` = 'USA' OR
    Customer.`Country` = 'Canada') AND
    Customer.`Last Year's Sales` < 10000.
ORDER BY
    Customer.`Country` ASC,
    Customer.`Region` ASC 

5. Click OK.
You return to the embedded SAP Crystal Reports Designer. In the Field Explorer, under Database Fields, a 
Command table appears listing the database fields you specified.

Note
By default, your command is called command. You can change its alias by selecting it and pressing F2.
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1.7.1.2.2.3.3.2  To edit a command object

1. In the Selected Tables area of the Database Expert, select the command you want to edit.
2. Right-click the command and select Edit Command from the shortcut menu.
3. Make the changes you want in the Modify Command dialog box and click OK when you're done.

You can create a parameter field while working in the Add Command to Report dialog box or the Modify Command 
dialog box.

1.7.1.2.2.3.3.3  To create a parameter for a command object

1. In the Parameter List area of the Add Command to Report dialog box or the Modify Command dialog box, click 
Create.

2. In the Command Parameter dialog box, enter the following information in the fields provided:

Parameter Name Enter the name you want to identify your parameter by.

Prompting Text Enter the text you want to appear when the program prompts you.

Value Type Enter the data type of the parameter field.

Default Value Enter the value you want the program to use if you do not supply a new value.

3. Click OK.
Your parameter is added to the Parameter List. You can modify or delete it by returning to the Modify 
Command dialog box.

1.7.1.2.2.3.3.4  To add a parameter to a command object

1. Place the cursor in the query text.
2. Double-click the parameter's name in the Parameter List.

The parameter is added where your cursor is sitting. It should look like this:

 WHERE 
    Customer.`Country` = '{?CountryParam}' 

If you want to change the parameter field you have created, go to the Field Explorer and select it from the 
Parameter Fields node.

1.7.1.2.2.4  Linking Database Tables

Explains how to link database tables so records from one table will match another.

You link tables so records from one table will match related records from another. When you link, you are using a 
field that is common to both tables. SAP Crystal Reports uses the link to match up records from one table with 
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those from the other. For example, if you activate an Orders table and a Customers table, you link the tables so 
that each order (from the Orders table) can be matched up with the customer (from the Customer table) that 
made the order. In this example, the link assures that the data in each row of the report refers to the same order.

Use the link tab in the Database Expert dialog box to link database tables. The easiest way to link tables is to select 
Auto-Link. Auto-Linking automatically chooses links for your tables based on common fields in tables or indexed 
fields (if your database supports indexed fields).

You can also manually link database tables. There are no limitations to your linking structure, provided they are 
within the limitations defined by the database vendor. If you have multiple links, you can use the Order Links 
function to arrange the links in the order you would like them to be processed.

1.7.1.2.2.4.1  To access the Database Expert

1. In the Field Explorer, right-click Database Fields and select Database Expert.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

2. In the Database Expert, dialog box, click the Links tab.
3. On the Links tab, click Link to automatically link the database tables, or, click and drag a database field from 

one table to another table to create a manual link.
4. If you have more than two tables, click Order Links to arrange the links in the order you would like them to be 

processed.
5. Click OK.

Related Information

To Insert Database Fields [page 555]

1.7.1.2.2.5  To Insert Database Fields

Explains how to add a database field to your report.

All available database fields are listed in the Field Explorer.

1. In the Field Explorer, expand Database Fields to view the database tables.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

2. Expand a database table and select a database field.
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When you select a field name, you can review the values for that field (as well as the field type and size) by 
right-clicking and selecting Browse Data from the shortcut menu. The browse dialog box lists a subset of field 
values, along with the field name, type, and length.

3. Drag the selected field onto the Details section or any other section of the report. You cannot add multiple 
fields to the report at the same time.

As you drag the field onto the report, notice the object frame that attaches itself to the mouse pointer. This object 
frame represents the object you have just selected for placement. The size of the object frame approximates the 
length of the field data.

1.7.1.2.3 Field and Text Objects

The embedded SAP Crystal Reports Designer uses a drag-and-drop approach similar to Visual Studio .NET — you 
drag a report object onto the designer (such as a database field or text object) and use the Property window or 
shortcut menu to format the object.

Field Objects

● Inserting and Moving Fields
● Resizing Fields
● Deleting Fields
● Displaying Field Names
● Adding Field Headings

Text Objects

● Inserting Text Objects
● Inserting Databases Fields into Text Objects
● Rotating Text

Special Fields

● Inserting Special Fields

Troubleshooting

● Troubleshooting Field and Text Objects
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1.7.1.2.3.1  Inserting and Moving Fields

To insert fields, drag the desired field from the Field Explorer onto the report. Use the shortcut menu to insert field 
objects and other report objects that are not available in the Field Explorer (for example, text objects, summary 
fields, charts, subreports, pictures, and so on).

Related Information

Resizing Fields [page 557]

1.7.1.2.3.1.1  To insert additional fields and report objects

1. Right-click in the embedded SAP Crystal Reports Designer, point to Insert and select a field or other object 
from the submenu.

2. If prompted, fill in the necessary dialog boxes.
3. Drag the object's frame onto the desired section of the report.

1.7.1.2.3.1.2  Selecting Field Objects

To do anything with a field (change the font, move it, and so on), you first have to select it. When a field is selected, 
the object frame displays handles on its right, left, top, and bottom edges. These handles indicate that the field is 
selected, and therefore active.

● Position the pointer inside the object frame and click once. The resizing handles appear, indicating that you 
have selected the object.

● Move the pointer away from the object frame and click in an empty part of the window. The handles 
disappear.

1.7.1.2.3.2  Resizing Fields

1. Select the field you want to resize.

Tip
Resize a field and its field heading together by using the CTRL-click combination to select both objects.

2. Point to one of the object frame's resizing handles.
3. When the pointer becomes a resizing arrow, drag the resizing handle to resize the field.
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Related Information

Preventing Truncated Text [page 563]

1.7.1.2.3.3  Deleting Fields

1. Select the field you want to delete.

Tip
Delete a field and its field heading together by using the CTRL-click combination to select both objects.

2. Press Delete.

Related Information

Field and Text Objects [page 556]

1.7.1.2.3.4  Displaying Field Names

When you add fields to your report, you can choose the type of field information you want to appear when 
designing the report.

Field Options

Table 15:

Field Option Explanation Example

Show Field Names Displays the name of the field. Customer ID

PrintDate

Show Object Names Displays the object name of the field. Field1

Field2

Show Format Symbols Displays the output format of the field. 5,555,555

1:23:45AM
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Related Information

Formatting Data [page 608]
Preventing Truncated Text [page 563]

1.7.1.2.3.4.1  To display field names or to change your field 
options settings

1. Right-click in the embedded SAP Crystal Reports Designer, point to Design and click Default Settings.
2. On the Layout tab of the Options dialog box, select the Show Field Names check box (or any other option).
3. Click OK.

1.7.1.2.3.5  Adding Field Headings

When you add a database field to a report, the program automatically adds a heading based on the database field 
name.

1.7.1.2.3.5.1  To add a field heading

1. Right-click in the embedded SAP Crystal Reports Designer, point to Insert and click Text Object.

Note
Once you click Text Object and move across the report, an empty object frame appears next to your mouse 
pointer.

2. Place the text object in the Page Header section and align the object frame above the desired field object.
3. Double-click the text object to place the insertion point inside the object frame.
4. Type your heading name into the text object.
5. To format the heading, right-click the text object and click Format Object.

Related Information

Preventing Truncated Text [page 563]
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1.7.1.2.3.6  Inserting Text Objects

The primary function of a text object is to hold text used to create titles, headings, label summaries, and so on.

However, text objects can hold database fields as well; this characteristic makes text objects ideal for creating 
custom form letters.

Related Information

Formatting Data [page 608]
Preventing Truncated Text [page 563]

1.7.1.2.3.6.1  To insert a text object

1. Right-click in the embedded SAP Crystal Reports Designer, point to Insert, and click Text Object.
2. Position the text object where you want it to appear in the report.

○ Select the text object and drag its handles to resize it.
○ Drag the text object to move it.
○ Double-click inside the text object to select it for text editing.
○ Avoid designing reports where the space between each object is very tight. Leave room for growth by 

expanding the width of the object by approximately 5 per cent. Or, if this is not possible, consider 
reducing the size of the font.

○ If you are displaying your report through a Web Forms Viewer, use spaces instead of tabs to maintain 
consistent spacing.

1.7.1.2.3.6.2  Inserting Database Fields into Text Objects

1. Insert a text object in the report.
2. Double-click the text object and type the text that you want to appear before the first database field (if any).
3. In the Field Explorer, locate the database field you want to insert into the text object.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

4. Drag the database field from the Field Explorer into the text object.
5. Drag the object until the insertion point is inside the text object, at the place where you want the database 

field to appear; then drop the field into the text object.
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1.7.1.2.3.7  Rotating Text

On the Common tab of the Format Editor, you can use the text rotation options to vertically align the fields and 
text-based objects on your report. You can rotate text 90 or 270 degrees.

1. Right-click the report object and select Format Object.
2. In the Common tab, select the degree of rotation in the Text Rotation field.

○ When you select a text rotation of 90 degrees, the text shifts 90 degrees in a counter-clockwise direction.
○ If text rotation is left at 0 degrees, your report is horizontally formatted.
○ For text rotation of text-based objects, the Can Grow option that prevents the truncation of text inside an 

object is automatically cleared. For more information on the Can Grow option, see Preventing Truncated 
Text [page 563].

○ Vertically formatted text that spans over the edge of the page cannot be displayed as part of your report.

1.7.1.2.3.8  Working with Special Fields

Special fields contain the types of information that aren't derived from an underlying database table or from a 
report formula. The embedded SAP Crystal Reports Designer provides a list of Sepcial Fields to choose from.

Print Date Use the Print Date Field to include the current date when the report prints. This field can be 
placed in any section of your report, depending on how often you want it to print. The date 
can be changed in the Set Print Date and Time Dialog Box.

Print Time Use the Print Time Field to include a field that contains the time when the report prints. This 
field can be placed in any section of your report, depending on how often you want it to print.

Modification Date Use the Modification Date Field to include a field that contains the date the report was last 
modified. Modified refers to any modification (including something as simple as moving a 
field). When you modify the report and print it, the program prints the modification date even 
if you have not saved the report before printing. This field can be placed in any section of your 
report, depending on how often you want it to print.

Modification 
Time

Use the Modification Time Field to include a field that contains the time the report was last 
modified. This field works the same way as the Modification Date. This field can be placed in 
any section of your report, depending on how often you want it to print.

Data Date Use the Data Date Field to include a field that contains the date the data was last retrieved 
(refreshed). This field can be placed in any section of your report, depending on how often 
you want it to print.

Data Time Use the Data Time Field to include a field that contains the time the data was last retrieved 
(refreshed). This field can be placed in any section of your report, depending on how often 
you want it to print.

Record Number Use the Record Number Field to number each record printed in the Details section of your 
report.

Page Number Use the Page Number Field to insert a field that prints the current page number. These fields 
are most often placed in the Page Header or Page Footer sections.
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Group Number Use the Group Number Field to number each group in your report. You can place this field in 
either the Group Header or Group Footer section of your report.

Total Page Count Use the Total Page Count Field to print the total number of pages in the report. You can use 
this field in a variety of instances. For example, you can use it in combination with the Page 
Number Field to create a text object that reads 'Page x of y' where x is the Page Number Field 
and y is the Total Page Count Field. These fields can be placed in any section of your report, 
depending on how often you want them to print.

Report Title Use the Report Title Field to include a field that contains the title you specified in the 
Document Properties Dialog Box. This field can be placed in any section of your report, 
depending on how often you want it to print.

Report 
Comments

Use the Report Comments Field to include a field that contains the comments you specified 
in the Document Properties Dialog Box. This field can be placed in any section of your report, 
depending on how often you want it to print.

Note
Only the first 256 characters of the comments you entered on the Summary tab of the 
Document Properties dialog box dialog box are displayed.

Record Selection 
Formula

Use the Record Selection Formula Field to insert a record selection formula field into your 
report. (Use the Select Expert to create a record selection formula for your report.)

Group Selection 
Formula

Use the Group Selection Formula Field to insert a group selection formula field into your 
report. (Use the Select Expert to create a group selection formula for your report.)

File Path and 
Name

Use the File Path and Name field command to insert a field that displays the file path and file 
name for the report.

File Author Use the File Author Field command to include a field that displays the name of the author of 
the report (as specified in the Document Properties dialog box).

File Creation 
Date

Use the File Creation Date Field command to include a field that displays the date when you 
created the report.

Page N of M Use the Page N of M Field to insert a field that specifies the page number and the total 
number of pages in the report. For example, a field value of Page 1 of 8 would indicate the first 
page in an eight-page report.

Note
If you include the special fields "Page N of M" or "Total Page Count" in your report, the 
report needs to finish processing before it can calculate this value. Avoid using these 
special fields in your report unless the report is very small or you absolutely require the 
value.

1.7.1.2.3.8.1  Inserting Special Fields
To display special information — such as Page Numbers, Print Date, and Report Comments — use the fields 
available in the Special Fields node of the Field Explorer.

562 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

1. In the Field Explorer, expand the Special Fields node.
2. Drag the required field from the Special Fields list onto the desired section of your report.

Note
For the Special Fields commands that print report summary information (such as Author Name or Report 
Comments), make sure that the relevant information is entered in the Document Properties dialog box. 
Right-click in the embedded SAP Crystal Reports Designer, point to Report and click Summary Info.

Related Information

Formula Overview [page 597]

1.7.1.2.3.9  Troubleshooting Field and Text Objects

This section provides information on how to deal with common problems that deal with field and text objects.

1.7.1.2.3.9.1  To prevent the truncation of text inside an object

1. Right-click the object you want to format and click Format Object.
2. In the Format Editor dialog box, click the Common tab and select the Can Grow check box.
3. Click OK to save your changes.

The object is then formatted to print on multiple lines. If the text prints wider than the object, the text wraps 
onto additional lines.

1.7.1.2.3.9.1.1  Preventing Truncated Text

When a text-based object is placed on a report, the object is represented by an object frame. The height of the 
object frame is based on the height of the font. The width, however, is determined differently, depending on the 
object you are working on.

Whether the default widths are accepted or the text-based objects are resized, a problem could arise if the text 
inside the object prints right to the edge of the object frame. While the report may look fine on the machine it was 
designed on, when the report is printed using another printer driver that measures the font wider, the length of the 
text grows, but the object frame remains fixed. The resulting text is cut-off or truncated.
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Database Fields

For database fields that are not memo fields, the width is initially determined by the width of the field as defined in 
the database, and by the average character width as provided by the selected font and font size.

For example, you have a database field called {customer.LAST NAME} and your database defines this field as a 
text field with a length of 35 characters. When you place this field on your report, the width of the boundary is 35 
times the average character width of the font and font size that the database field is formatted to. Remember that 
this is the initial default boundary width. The width can always be resized to increase or decrease as you see fit.

Text-based Objects

For text-based objects, the default width is approximately 17 average character widths wide. Objects are different 
from database fields in that their width automatically expands as you enter in text and/or database fields into the 
object. As with all other text-based objects, the width can be resized by the user.

Number Fields

For different number fields (double, single, integer, long integer, and byte) the default widths are all different. As 
with all text-based objects, the width can be resized by the user.

1.7.1.2.3.9.2  Preventing Overlapping Text

Avoid designing reports where the space between each object is very tight. Leave room for growth by expanding 
the width of the object by approximately 5 per cent. Or, if this is not possible, consider reducing the size of the 
font.

Multi-Line Text-Based Objects

If the printer driver expands or contracts the spacing of the text, word wrapping may differ, changing the number 
of lines necessary to print the object in order to accommodate growth or shrinkage.

When placing multi-line, text-based objects, you could encounter problems if other objects in the same section 
are placed directly below them.

Unlike single-line, text-based objects, expanding the object frame of a multi-line, text-based object to 
accommodate growth is not a viable option. When you do this, the line width increases according to the expanded 
boundaries.

So, when possible, place multi-line, text-based objects at the bottom of a section. If they require more lines to 
print, the section expands downward to accommodate the growth, and they do not endanger other objects.
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1.7.1.2.3.9.3  Increasing White Space between Sections

The height of a section in relation to the objects within it affects the amount of white space that appears between 
rows on the report.

To add extra white space between rows in the report, move the pointer over the lower section boundary line. The 
pointer changes to a Resizing cursor. When the Resizing cursor appears, drag the section boundary downward to 
add extra white space.

To correct spacing inconsistencies in text objects, use spaces instead of tabs. This helps maintain consistent 
spacing if your report is viewed through a Web Forms Viewer.

1.7.1.2.3.9.4  Preventing Truncated Numbers

SAP Crystal Reports uses Overflow Field Representation to assist users when working with numeric or currency 
values in report cells. Normally, if a numeric or currency value is larger than the field containing it, that value is 
truncated, or "clipped." For example, values like 100,000,000 might appear on the report as 1,000, or as 000 
(depending on the properties you have set). This could potentially cause confusion when the report is read.

When the Allow Field Clipping option is cleared, numeric/currency field values that exceed the field size will be 
represented by number signs (######), letting you know immediately when the field is too small.

1. Right-click the currency field or number field you want to format and click Format Object.

The Format Editor dialog box appears with the Number tab open.
2. Click the Customize button.

The Custom Style dialog box appears with the Number tab open.
3. To allow overflow field representation, clear the Allow Field Clipping check box.

You also have the option to click the Format button to enter a formula in the Format Formula Editor. In the 
Format Formula Editor, you can specify that field clipping will be disabled only when certain conditions are 
met.

4. Click OK to save your changes.

If you disabled field clipping, any numeric/ currency field values that are larger than the fields containing them will 
be represented by number signs (######).

1.7.1.2.3.10  Working With Right-to-Left Languages

SAP Crystal Reports supports the display of right-to-left languages for reports that have been formatted as shown 
here. When formatted for right-to-left languages, the reading order of the text will be rendered according to 
browser language settings.

1. Right-click on a report field, and click Format Field.
The Format Editor dialog box appears.

2. On the Common tab, change the settings adjacent to the horizontal alignment label.
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○ If the report contains data in a single right-to-left language, select Right from the box.
○ If the report contains data in multiple languages, click the condition formula button and apply a formula 

that checks the language format.

if {UnicodeData.Right_to_Left} then crRightAligned
else crLeftAligned

Note
The example references database field called Right_to_Left from a table called UnicodeData.

3. On the Paragraph tab of the Format Editor dialog box, change the settings under the Reading Order label.

○ If the report contains data in a single right-to-left language, select Right to Left.
○ If the report contains data in multiple languages, select the condition formula button and apply a formula 

that checks the language format.

if {UnicodeData.Right_to_Left} then crRightToLeftTextReadingOrder
else crLeftToRightTextReadingOrder

Note
The example references database field called Right_to_Left from a table called UnicodeData.

4. Click OK.

Right-to-left languages will be displayed correctly in the report.

1.7.1.2.4 Filtering Data

This section shows you how to filter the records you want included in a report. You filter data using record 
selection formulas and parameters.

For example, using the record selection tools, you could limit the records in your report in order to include records 
for only a specific group of customers, a specific range of account numbers, or a particular date range.

1.7.1.2.4.1  Selecting Records

When a field is selected to appear on a report, field values from every record in the active table(s) are printed by 
default. In many cases, you may not want to include all the values, but only a subset of those values.

SAP Crystal Reports includes a very sophisticated formula language that you can use to specify virtually any type 
of record selection. However, you may not always need the flexibility in record selection that the formula language 
provides. The Select Expert is designed for such instances.

You can select records in one of two ways:
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● Basic Record Selection [page 571]
● Customizing Record Selection Formulas [page 572]

Determining Which Fields to Use

When you select records, you are basing your report only on those records that meet some conditions that you 
have set. You base those conditions on the kind of information you want in the finished report.

Assume, for example, that you want a report that only shows data from California. The challenge is to find the best 
way to identify those records that come from California.

● If the table used in a report has a State or Region field, you can specify in your request that the program use 
only those records in which the value in the state field is equal to California (Region is equal to CA).

● If the table does not have a State field and you still want to report only on California data, there may be 
another way to identify that data.

● If the table has a Postal Code field, you could base your record selection on the range of ZIP codes that apply 
to California (Postal Code is between n and N).

● If the table has an Area Code field, you could base your record selection on California Area Codes (Area Code 
is one of x, y...z).

Note
○ If the Area Code is stored in the telephone number field, you will not be able to do this same record 

selection using the Select Expert based on the Area Code. You will have to create a record selection 
formula using the formula language to extract the Area Code part of the phone number and then do 
record selection based on that.

○ As a general rule, if you can base your record selection on a number of fields (as in this example), you 
should select an indexed field instead of a field that is not indexed.

1.7.1.2.4.1.1   Filtering report data with selection formulas

Selection formulas specify and filter the records and groups that appear in a report. There are three possible 
selection formulas that you can use to filter your data:

● Record selection formula
● Saved data selection formula
● Group selection formula

The following table shows what types of fields will be allowed in different report filters:

Table 16:

Record selection formula Saved data selection for
mula

Group selection formula

Parameters X X X

Summaries - - X
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Record selection formula Saved data selection for
mula

Group selection formula

Print time formulae/running 
totals

- - -

The following table shows the differences in behavior associated with the different report filters:

Table 17:

Record selection formula Saved data selection for
mula

Group selection formula

Can refer to the summary? No. Yes. Yes.

When is the formula evalu
ated?

While reading records. If a summary is used, at print 
time; otherwise, while reading 
records.

At print time.

When is the report refreshed? If the evaluation result is false, 
when records are dropped.

If records are being read, 
when evaluated. If the evalua
tion result is false, when re
cords are dropped.

N/A

Affects the summary calcula
tion?

Yes, records that are filtered 
out are not counted.

If the filter is evaluated while 
reading records, then no; oth
erwise, yes.

No, records are counted even 
when they are filtered out.

You can apply the saved data selection formula on the output of the record selection formula. The following 
diagram shows the flowpath of how the record selection and saved data selection formulas are used:

Record selection formula

The Record selection formula specifies which records will form report saved data. This selection formula allows 
two levels of filtering:

● Filtered out by database
● Filtered out by report processing engine

Saved data selection formula

The SavedDataFilter allows users to view a subset of the data saved in a report. Changing the SavedDataFilter will 
not discard the data saved in a report or result in a database hit.
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Group selection formula

The Group selection formula specifies which records will be considered when report pages are rendered. This 
formula typically uses values produced in earlier stages of report processing, such as summaries.

Note
Group selection formula filters on records and not groups.

1.7.1.2.4.1.2  Pushing Down Record Selection to the Database 
Server

The most important thing you can do to speed up report processing is to limit the amount of data that is returned 
from the database. Your primary tool for doing this is the record selection formula.

The drivers provided with SAP Crystal Reports for SQL data sources allow "pushing down" record selection to the 
database server. When you specify a record selection formula in a report based on an SQL data source, SAP 
Crystal Reports analyzes it, generates a SQL query from it and passes the SQL query to the database server. 
Record selection is then carried out in two stages:

● the first stage of record selection takes place when the database server processes the SQL query and returns 
a set of records to SAP Crystal Reports

● in the second stage, SAP Crystal Reports further evaluates locally the record selection formula for the set of 
records returned from the database server.

Since database servers are usually faster machines than workstations, it is to your advantage to specify record 
selection formulas that can be processed by the server in the first stage. Doing so minimizes record selection on 
the local machine in the second stage. The following kinds of record selections can be pushed down to the server:

● Selections with indexed and non-indexed fields (indexed fields provide faster response).
● SQL queries with AND and OR clauses.
● SQL expression fields that carry out formula calculations for record selection. (For the types of SQL 

expressions supported by your SQL server, consult the documentation provided with the server.)

Example
Pushing Down Record Selection

This example demonstrates the benefits of writing record selection formulas that can be pushed down to the 
database server.

In the Orders table of the Xtreme sample database, there are 2,192 records, of which 181 have order dates prior 
to 2001. Suppose you want to report on only those records. On the one hand, you could use this record 
selection formula:

 Year ({Orders.Order Date}) < 2001 

The SQL query generated will send all 2,192 records to SAP Crystal Reports, and then the record selection 
formula will reduce this to 181. To see this, click Show SQL Query on the Database menu and notice that the 
SQL query has no WHERE clause. This is because SAP Crystal Reports is not able to push down the Year ( ) 
function in the WHERE clause.
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On the other hand, this record selection formula generates the same report:

 {Orders.Order Date} < #Jan 1, 2001# 

This second formula, however, can be performed on the database server, so it is pushed down. The SQL query 
generated will send only 181 records to SAP Crystal Reports. So, when the record selection formula is evaluated 
by SAP Crystal Reports, no further records need to be eliminated. Click Show SQL Query on the Database 
menu and notice that the resulting SQL query has a WHERE clause.

As this example shows, your report's processing speed improves when you enhance your record selection 
formula. In this case, both formulas generate the same report, but the second takes advantages of the power 
and optimizations that the database server can use when handling its own data.

1.7.1.2.4.1.2.1  Record Selection Performance Tips

Consider the following performance-related items when setting up record selection requests:

General

● To push down record selection, you must select "Use Indexes or Server for Speed" in the Report Options 
dialog box (right-click in the embedded SAP Crystal Reports Designer, point to Report, and select Report 
Options).

● In record selection formulas, avoid data type conversions on fields that are not parameter fields.
For example, avoid using ToText( ) to convert a numeric database field to a string database field.

● You are able to push down some record selection formulas that use constant expressions.

SQL Databases

● You can push down record selection on indexed or non-indexed fields.
● Your SQL server will respond faster if you use indexed fields.
● You can push down AND and OR clauses.
● Record selection formulas containing some types of embedded formulas can be pushed down.
● You should incorporate SQL Expression fields to push down formula calculations necessary for the record 

selection.
● On the Database menu, click Show SQL Query to view the SQL that will be sent to the database server.
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1.7.1.2.4.1.3  Basic Record Selection

The Select Expert makes it easy to specify the records you want included in your report. When you work with the 
Select Expert, you select the field to which you want to apply selection conditions and then you specify those 
conditions.

The Select Expert can be used to set up simple record selection requests. For example:

● customers from Arizona
● orders in the first quarter
● sales over $10,000

The Select Expert can also be used to set up some sophisticated requests:

● customers whose names start with "A", "M", or "S"
● customers from California or Florida who ordered in July

These are all range limit requests. One or more constants define the range. The program compares the field value 
in each record to the constant(s) and rejects records with values outside the range. The report is limited to values 
within the range. You can set up all of these types of record selection requests without any previous knowledge of 
the formula language.

Note
The Select Expert can be used to set up both record selection and group selection requests. When a group 
name or summary field is selected, the program knows that the selection criteria set up is intended for group 
selection. In all other cases, the program knows that you are setting up record selection.

1.7.1.2.4.1.3.1  To set up record selection using the Select 
Expert

1. Right-click in the embedded SAP Crystal Reports Designer, point to Report and click Select Expert.
2. In the Choose Field dialog box, highlight the field on which you want to base record selection and click OK.
3. In the Select Expert dialog box, use the drop-down lists to enter your selection criteria for the indicated field.

Tip
To base record selection on more than one field, click the New tab. Select the next field from the Choose 
Field dialog box.

4. Click OK when finished.

Note
To view the selection formula, click the Show Formula button. The Select Expert expands to show the 
formula. Click the Formula Editor button to modify the formula.

A selection formula is generated based on your specifications, limiting the report to the records you indicated.
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1.7.1.2.4.1.4  Customizing Record Selection Formulas

Use Crystal Syntax to create a record selection formula.

Related Information

Crystal Syntax [page 680]
Troubleshooting Record Selection Formulas [page 575]
Pushing Down Record Selection to the Database Server [page 569]
Formula Editor Dialog Box [page 599]

1.7.1.2.4.1.4.1  To set up record selection using a formula

1. Right-click in the embedded Crystal Reports Designer, point to Report, select Selection Formula and click 
Record.

2. In the Record Selection Formula Editor, enter the formula by typing in the components or selecting them from 
the component trees.

Note
The resulting formula must be Boolean; that is, it must return either a True or False value.

3. Click the Check button to identify any errors in the formula.
4. Fix any syntax errors the Formula Checker identifies.
5. When the formula has the correct syntax, click the Save and close button.

1.7.1.2.4.1.5  Record Selection Formula Templates

The following sample formulas can be used as templates to help you create your own selection formulas using the 
Record Selection Formula Editor. These examples illustrate different selections that you could do, not necessarily 
the best selections.

Selecting Records using Character Strings

 {file.FIELD} startswith "C" 
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Selects those records in which the value in the {file.FIELD} field begins with the character "C" (includes values like 
CyclePath, Corp. and Cyclist's Trail Co.; excludes values like Bob's Bikes Ltd. and Feel Great Bikes, Inc.).

 not ({file.FIELD} startswith "C") 

Selects those records in which the value in the {file.FIELD} field does not begin with the character "C" (includes 
values like Bob's Bikes Ltd. and Feel Great Bikes, Inc.; excludes values like CyclePath, Corp. and Cyclist's Trail 
Co.).

 "999" in {file.FIELD}[3 to 5] 

Selects those records in which the 3rd through 5th digits of the {file.FIELD} field is equal to "999" (includes values 
like 10999, 70999, and 00999; excludes values like 99901 and 19990).

 "Cycle" in {file.FIELD} 

Selects those records in which the value in the {file.FIELD} field contains the string "Cycle" (includes values such 
as CyclePath Corp. and CycleSporin, Inc.; excludes values like Cyclist's Trail Co. and Feel Great Bikes, Inc.).

Selecting Records using a Single Numeric Values

 {file.FIELD} > 99999 

Selects those records in which the value in the {file.FIELD} field is greater than 99999.

 {file.FIELD} < 99999 

Selects those records in which the value in the {file.FIELD} field is less than 99999.

Selecting Records using a Range of Numeric Values

 {file.FIELD} > 11111 and {file.FIELD} < 99999 

Selects those records in which the value in the {file.FIELD} field is greater than 11111 but less than 99999 (neither 
11111 or 99999 is included in the range of values).

 {file.FIELD} >= 11111 and
{file.FIELD} <= 99999 

Selects those records in which the value in the {file.FIELD} field is greater than 11111 but less than 99999 (both 
11111 and 99999 are included in the range of values).
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Selecting Records Using Dates

The Month, Day, and Year functions can all be used in examples like the following:

 Year ({file.DATE}) < 1999 

Selects those records in which the year found in the {file.DATE} field is earlier than 1999.

 Year ({file.DATE}) > 1992 and
Year ({file.DATE}) < 1996 

Selects those records in which the year found in the {file.DATE} field falls between 1992 and 1996 (1992 and 1996 
not included).

 Year({file.DATE}) >= 1992 and
Year({file.DATE}) <= 1996 

Selects those records in which the year found in the {file.DATE} field falls between 1992 and 1996 (1992 and 1996 
are included).

 Month({file.DATE}) in 1 to 4 

Selects those records in which the month found in the {file.DATE} field is one of the first four months of the year 
(includes January, February, March, and April).

 Month({file.DATE}) in [1,4] 

Selects those records in which the month found in the {file.DATE} field is the first or fourth month of the year 
(includes January and April, excludes February and March).

Selecting Records Using Preset Data Ranges

The preset date ranges can be used to create selection formulas similar to these:

 {file.DATE} in LastFullMonth 

Selects those records in which the date found in the {file.DATE} field falls within the last full month. (If the month is 
May, this selects all records with an April date.)

 not({file.DATE} in LastFullMonth) 

Selects all records except those in which the date found in the {file.DATE} field falls within the last full month (if the 
month is May, this selects all records except those with an April date).

 {file.DATE} < CurrentDate 

Selects all records in which the date found in the {file.DATE} field falls before today's date.
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Selecting Records Using Date/Number/Character Combinations

 "C" in {file.FIELD}[1] and Month({file.DATE}) in [1,4] 

Selects those records in which the value in the {file.FIELD} field begins with "C" and the month is either January or 
April. For example, if this kind of formula was used with an order database, you could be asking for a report 
showing all customers whose names begin with "C" and who placed orders in January or in April.

 "AOK" in {file.HISTORY}[3 to 5] and
{file.OPENCRED} >= 5000 

Selects those records in which the {file.HISTORY} field shows the characters "AOK" as the 3, 4, and 5 characters 
and the {file.OPENCRED} field (the amount of available credit) is at least 5000.

These templates can be used as they are (with your own data), or they can be combined to create complex 
formulas.

1.7.1.2.4.1.6  Troubleshooting Record Selection Formulas

To troubleshoot your selection formula, you should first begin by making sure that all of the fields referenced in 
the selection formula are placed on your report. Then delete the selection formula and test it as you rebuild it, step 
by step.

Correcting Selections that Do Not Generate Data

You may encounter a situation in which you create a record selection formula and, while header and footer 
information prints on your report, no detail information appears. The problem is the selection formula is rejecting 
all records. This usually occurs because of an error in the creation of the selection formula.

There are a couple of potential causes of your problem in the selection formula:

● Uppercase/lowercase inconsistency
● Extra spaces

Correcting Uppercase/Lowercase Inconsistency

Record selection formulas are case sensitive. That is, "Bob" matches only with "Bob". It does not match with 
"bob", "BOB", "BoB", "bOB", "boB", or "BOb". Thus, if your selection formula is set to include only those records 
with "BOB" in the {customer.CONTACT FIRST NAME} field, but all the entries in the {customer.CONTACT FIRST 
NAME} field are mixed case ("Bob", for example), the selection formula will find no matches and thus will not print 
any details for the report.

You can solve this problem by using the UpperCase (str) or LowerCase (str) functions in your selection formula to 
convert field data to a consistent case before the program begins its selection. For example, if you were using this 
formula:

 {customer.CONTACT FIRST NAME} = "BOB" 
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you can change the formula to this:

 UpperCase({customer.CONTACT FIRST NAME}) = "BOB" 

This second formula first converts the value of the {customer.CONTACT FIRST NAME} field to upper case 
characters and then checks to see if the value in that field is equal to "BOB". Using this formula, any instance of 
the three letters "b," "o," and "b" will be a match, regardless of case, because the case will be converted to 
uppercase.

You could use the LowerCase function in a similar manner to match with "bob."

Check your selection formula closely and make sure you have the correct case for any text you are trying to 
match. If in doubt, use the UpperCase (or LowerCase) function to assure consistency and proper matching.

Another formula which performs much the same functions is the following:

 "BOB" in UpperCase({customer.CONTACT FIRST NAME}) 

Unwanted Spaces Appear in Selection Formula

Spaces are characters, and when you include spaces in the search key of a record selection formula, the formula 
looks for records with the exact match in the selected field, spaces and all. For example, the following formula:

 "Mr . " in {customer.TITLE} 

will not find any matches with the form of address "Mr." because there is an extra space in the search key between 
the letter "r" and the period. Likewise, "Ph. D" will not match "Ph.D".

Check your selection formula closely, and make sure that the spaces in the selection formula match the spaces in 
the fields you are trying to match.

1.7.1.2.4.2  Setting Parameters

Parameters prompt the user of a report to enter information. Think of a parameter as a question that the user 
needs to answer before the report is generated. The information users enter, or the way they respond, determines 
what appears in the report. For example, in a report used by salespeople, there might be a parameter that asks 
the user to choose a region. The report would return the results for the specific region, instead of returning the 
results for all of the regions.

By using parameter fields in formulas, selection formulas, and in the report itself, you can create a single report 
that you can modify whenever your needs change. Parameter fields can also be used in subreports.

If a parameter is missing or is invalid, the program shows an error. Setting the EnableParameterPrompt property 
of the SAP Crystal Report Viewer to true causes the report to prompt the user for the parameter again instead.

Parameter Field Considerations

There are a number of things to keep in mind when working with parameter fields:

● To have a user be prompted with a parameter, you must include the parameter somewhere in the report — in 
a record or group selection, in a formula, or simply as a field on the report.
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● A parameter field does not have to be placed in a report in order to be used in a record or group selection 
formula. You create the parameter field and then enter it in your formula as you would any other field.

● A parameter field must be of the same data type as the field against which it is being compared. For example, 
if a {Customer Name} field of type String is being used in a report that limits record selections to a particular 
Customer Name, then the parameter field created for this purpose must also be of type String.

● Parameter fields support the following data types:

Table 18:

Data Type Explanation Parameter Example

Boolean Requires a yes/no or true/false an
swer.

Include planned budget numbers in the 
summary?

Currency Requires a dollar amount. Display customers with sales over 
XXXXX.

Date Requires an answer in a date format. Enter the start and end dates of the 
quarter.

DateTime Requires both date and time. Display statistics for 07/04/2000 be
tween 1:00pm-2:00pm.

Number Requires a numeric value. Enter the customer identification num
ber.

String Requires a text answer. Enter the region.

Time Requires an answer using a time for
mat.

Display the total number of calls from 
1:00pm-2:00pm.

● You can create a pick list for the user to choose the parameter value rather than having them enter it 
manually.

● Parameter field prompting text can be up to four lines long with approximately 60-70 characters per line 
(depending on character width, up to the 254 character limit). Text over one line in length will automatically 
word wrap.

Types of Parameters

In SAP Crystal Reports 2008 you have access to the following types of parameters:

Static Parameters Retrieve parameter values that are stored in the report.

Dynamic 
Parameters

Retrieve parameter values from a data source outside of the report.

Note
Dynamic prompts are supported by all viewers except the Java Applet viewer.

Cascading 
Parameters

Lead a user through a sequence of dynamic prompts to determine a final parameter value.

Optional 
Parameters

Do not require a parameter value and may be left blank. No visual cue in the parameter 
dialog indicates that a parameter is optional; however, the report designer may add 
custom text to the prompt text indicating it is optional.
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Note
Static prompts are displayed if the prompting service fails to retrieve the list of values, the Enterprise Session is 
inaccessible, or the datasource is inaccessible.

1.7.1.2.4.2.1  Designing Parameter Fields

To have a user be prompted with a parameter, you must include the parameter somewhere in the report — in a 
record or group selection, in a formula, or simply as a field on the report.

1. From the Field Explorer, right-click Parameter Fields and click New.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

2. Enter a name for the parameter in the Name field (up to 255 alphanumeric characters).
3. Enter the desired prompting text in the Prompting Text field (up to 255 alphanumeric characters).

This is the text that appears in the Enter Parameter Values dialog box when the report is refreshed.
4. Enter the Value Type.
5. Click Default Values if you want to limit or specify the options for the user.
6. In the Set Default Values dialog box, specify the table and field for the parameter value.
7. Click >> to move any values to the Default Values area.

The user will be able to choose any values you move to the Default Values area. If you want to limit the 
selection, move only the values you would like the user to choose from.

Tip
For a string parameter field that you are setting the default values for, you can choose to enter an Edit 
Mask in the Edit Mask field, rather than specifying a range.

8. Click OK.

The Create Parameter Field dialog box appears.
9. Click OK.
10. Drag and drop the parameter onto your report.

Related Information

Limiting Entry Type and Format in Parameters [page 579]
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1.7.1.2.4.2.2  Data parameters and non-data parameters

Depending on how parameters are used, they are marked as either data parameters or non-data parameters. 
Data parameters are stored in a database. Non-data parameters, such as a report title, are stored with the report. 
How these parameters are used within a report will impact whether the report data will automatically refresh when 
parameter values are changed. The number of parameters that are refreshed will affect processing demand on 
the database.

Data parameters are used in the following:

● Record Selection Formulas (directly or indirectly by way of being encapsulated within a formula)
● Command Objects
● Stored Procedures
● Universe Parameters

Changes made to the value of a data parameter require a report refresh to fetch new data from the database. For 
example, a report will be automatically refreshed when a data parameter is used to generate a query.

Non-data parameters are used in the following:

● Saved Data Selection Formulas
● Conditional Formulas
● Parameters placed on the report

Changes made to the value of a non-data parameter will filter the saved data of the report and not require a 
refresh. This process minimizes the processing demand on the database. For example, a title is a non-data 
parameter.

Note
Non-data parameters change the presentation of existing data. It is best to use them only in a way that makes 
sense for the report. For example, do not filter using a saved data selection formula to display values that are 
below 100,000 if you have a record selection formula that only selects values above 100,000 from the 
database. Using selection formulas improperly may provide confusing results, or even blank pages.

Related Information

Filtering report data with selection formulas [page 129]
The parameter panel [page 122]

1.7.1.2.4.2.3  Limiting Entry Type and Format in Parameters

For a string parameter field that you are setting the default values for, you can choose to enter an Edit Mask in the 
Edit Mask field, rather than specifying a range. An Edit Mask can be any of a set of masking characters used to 
restrict the values you can enter as parameter values (the Edit Mask also limits the values you can enter as default 
prompting values).

You can enter any of the following masking characters, or any combination of them.
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Masking Character Mask Result

"A" Allows an alphanumeric character and requires the entry of a 
character in the parameter value.

"a" Allows an alphanumeric character and does not require the 
entry of a character in the parameter value.

"0" Allows a digit [0 to 9] and requires the entry of a character in 
the parameter value.

"9" Allows a digit or a space, and does not require the entry of a 
character in the parameter value.

"#" Allows a digit, space, or plus/minus sign, and does not 
require the entry of a character in the parameter value.

"L" Allows a letter [A to Z], and requires the entry of a character 
in the parameter value.

"?" Allows a letter, and does not require the entry of a character 
in the parameter value.

"&" Allows any character or space, and requires the entry of a 
character in the parameter value.

"C" Allows any character or space, and does not require the entry 
of a character in the parameter value.

". , : ; - /" Separator characters. Inserting separator characters into an 
Edit Mask is something like hard coding the formatting for the 
parameter field. When the field is placed on the report, the 
separator character will appear in the field object frame, like 
this: LLLL/0000. This example depicts an edit mask that 
requires four letters followed by four numbers.

"<" Causes subsequent characters to be converted to lowercase.

">" Causes subsequent characters to be converted to 
uppercase.

"\" Causes the subsequent character to be displayed as a literal. 
For example, the Edit Mask "\A" would display a parameter 
value of "A." If the Edit Mask is "00\A00," then a valid 
parameter value would consist of two digits, the letter "A," 
and then two additional digits.

"Password" Allows you to set the Edit Mask to "Password," you can 
create conditional formulas specifying that certain sections 
of the report become visible only when certain user 
passwords are entered.
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Some of the Edit Mask characters require that you enter a character in their place (when entering a parameter 
value), while others allow you to leave a space, if needed. For example, if the Edit Mask is 000099, you can enter a 
parameter value with four digits, five digits, or six digits, since the '9' Edit Mask character does not require the 
entry of a character. However, since '0' does require such an entry, you could not enter a parameter value with 
less than four digits.

Related Information

Incorporating Parameters into Formulas [page 581]
Setting Parameters [page 576]

1.7.1.2.4.2.4  Incorporating Parameters into Formulas

A parameter field does not have to be placed in a report in order to be used in a record or group selection formula. 
You create the parameter field and then enter it in your formula as you would any other field.

Record Selection with Formulas

To decrease the amount of data transferred from the database server, and increase performance, incorporate 
parameter fields right into your record selection formula.

This record selection formula prompts users to enter a sales quota and displays all only those customers whose 
Last Year's Sales exceeded that sales quota.

 {Customer.Last Year's Sales} > {?SalesQuota} 

Sorting and Grouping with Parameter Fields

This Crystal syntax formula incorporates the parameter ?group, which prompts users to choose either Customer 
or Group as their group option. The UpperCase function converts the parameter value to uppercase for 
consistency.

 WhileReadingRecords;
If UpperCase ({?group})= "CUSTOMER" then
    {Customer.Customer Name}
Else if UpperCase ({?group}) = "REGION" then
    {Customer.Region}  

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 581



Conditional Formatting with Parameter Fields

Parameter fields can be used to create conditional formatting formulas. You can use a conditional formatting 
formula to color-flag data that meets certain conditions. If the conditions under which you flag these items never 
change, you do not need to use parameter fields — use formulas or conditional formatting.

This Crystal syntax formula incorporates the parameter ?SalesTarget, which prompts users for a sales target 
value. All customers who are over that sales target value will appear in red in the report.

 If {Customer.Last Year's Sales} > {?SalesTarget} Then
    Red
Else
    Black 

1.7.1.2.5 Grouping, Sorting, and Totaling Data

When you first insert a database field into your report, the data within the fields appears in the order in which it 
was originally entered into the database. Grouping, sorting, and totaling help turn disorganized data into useful 
information on a report.

1.7.1.2.5.1  Grouping Data

Explains how to group and summarize report data based on a report field. Also describes how to select the top or 
bottom N groups.

In many reports you need to break the data into groups in order to make it easier to read and to analyze.

This section shows you how to group data in a report.

1.7.1.2.5.1.1  To group report data

1. Right-click in the embedded SAP Crystal Reports Designer, point to Insert and click Group.
2. In the Insert Group dialog box, from the top drop-down list, select the field you want the data sorted and 

grouped by.
3. Select the sort direction from the second drop-down list.
4. If you want to show a different value in the group header, click the Options tab.

Tip
By default, the group header of the report will display the value of the field you are grouping on.

5. Select the Customize Group Name Field check box and choose a new group name.
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For example, if you group by {Customer.CustomerID}, at each change of a group you will see the 
corresponding customer ID. If you want to display a different value (customer ID as well as customer name), 
customize the group name field by choosing an alternate data field, or by creating a formula.

6. Click OK.
Notice that two new sections now appear in the Design tab: Group Header #1 and Group Footer #1. This is 
how the program shows that the report has been grouped.

Tip
To hide the group header name, right-click the group header, select Format Object, and click Suppress on 
the Common tab of the Format Editor.

Related Information

Summarizing Grouped Data [page 585]
Selecting Top or Bottom N Groups [page 587]

1.7.1.2.5.1.2  Grouping Data Hierarchically

You can group data in a report to show hierarchical relationships. When you group data hierarchically, SAP Crystal 
Reports sorts information based on the relationship between two fields. A hierarchical relationship must be 
inherent in the data that you use for the report:

● Parent and child fields must be of the same data type for the program to recognize a relationship between 
them.

● The data in the parent field must be a subset of the data in the child field.
● For the top level of a hierarchy to appear in a report, the value must appear in the child data, and the 

corresponding row in the parent data must be empty.
● There cannot be any circular logic in the data (that is, A cannot be related to B, while B is related to C, and C is 

related back to A).

For example, if you want to show the hierarchical structure of a department, you could group data by employee ID 
and specify the hierarchy using the data field listing whom the employee reports to.

1.7.1.2.5.1.2.1  To group data hierarchically

1. Right-click in the embedded SAP Crystal Reports Designer, point to Insert and click Group.
2. In the Insert Group dialog box, select the field to be the basis of your hierarchy (the child field).

For example, if you want to view the hierarchical structure of a company's employees, select the employee 
field.

3. Select in ascending order.
By default, the group header of the report will display the value of the field you are grouping on.
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4. Click the Options tab and select the Customize Group Name Field check box if you want to show a different 
value in the group header.
For example, if you grouped by the employee field, at each change of a group you will see the corresponding 
employee name. If you want to display a different value (employee name instead of employee ID), customize 
the group name field by choosing an alternate data field, or creating a formula.

5. Click OK.
The group you created is added to the report.

6. Right-click in the embedded SAP Crystal Reports Designer, point to Report, and click Hierarchical Grouping 
Options.

7. In the Available Groups list of the Hierarchical Group Options dialog box, select the group you want to organize 
hierarchically.

8. Select the Sort Data Hierarchically check box.
9. In the Parent ID Field list, select the field by which you want the Instance ID Field organized.

For example, for an employee hierarchical report, you might select the data field listing the supervisor to 
whom the employee reports.

Note
The Instance ID Field and Parent ID Field must be of the same data type. For example, if the Instance ID 
Field holds string data, then the Parent ID Field must also hold string data.

10. In the Group Indent field, enter the amount you want to indent for each subgroup.

Note
The value that you enter in the Group Indent field affects all other objects that are in the same area as your 
hierarchical group. For example, if your report contains a salary field on the same line as the name of the 
employee, the salary field is also indented when you use the employee field to create a hierarchical group.

11. Click OK.
The report data is now grouped hierarchically.

Note
The level at which a name appears in the hierarchy of this report is determined by the number of 
employees who report to him or her. Those employees with no one reporting to them are at the lowest level 
in the hierarchy.

Related Information

Totaling Data [page 591]
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1.7.1.2.5.1.3  Summarizing Grouped Data

One of the primary purposes for breaking data into groups is to run calculations on each group of records instead 
of on all the records in the report. When the program summarizes data, it sorts the data, breaks it into groups, and 
then summarizes the values in each group. It does this all automatically.

The program includes a number of summarizing options. Depending on the data type of the field you plan to 
summarize, you can:

● Sum the values in each group.
● Count all the values or only those values that are distinct from one another.
● Determine the maximum, minimum, average, or Nth largest value.
● Calculate up to two kinds of standard deviations and variances.

For example:

● Customer List reports determine the number of customers in each state. The summary would count the 
distinct customers in each state group.

● Order reports determine the average order placed each month. The summary would calculate the size of the 
average order for each month group.

● Sales reports determine the total sales per sales representative. The summary would sum or subtotal the 
order amounts for each sales representative group.

Related Information

Hiding Details in Summary Reports [page 587]
Ordering Groups by Summarized Values [page 586]
To subtotal data [page 591]
Adding Percentages to a Report [page 592]
Selecting Top or Bottom N Groups [page 587]

1.7.1.2.5.1.3.1  To summarize grouped data

1. Right-click in the embedded SAP Crystal Reports Designer to access the shortcut menu.
2. Point to Insert and click Summary.
3. In the Insert Summary dialog box, select the desired field to summarize from the "Choose the field to 

summarize" list.
4. Select a summary operation from the Calculate this summary list.
5. Select a location in which to place the summary from the Summary location list.

Tip
You can create a new group for you report by clicking the Insert Group button.

6. If you want to display your summary value as a percentage of a total, select Show as a percentage of from the 
Options area, and then select a total field from the list.
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7. If you want to summarize across a hierarchy, select Summarize across hierarchy.
For more information about hierarchies, see Grouping Data Hierarchically [page 583].

8. Click OK.
For example, if you wanted to count the number of customers in each country, you would create a count field 
based on customer and grouped by country.

1.7.1.2.5.1.4  Ordering Groups by Summarized Values

Groups can be organized in either ascending or descending order by summary value. For example, in an orders 
report, if you subtotal the order amount by state, you could order the groups:

● From lowest to highest order amount (ascending).
● From highest to lowest order amount (descending).

You order the groups by summary values using the Group Sort Expert.

1. Right-click in the embedded SAP Crystal Reports Designer, point to Report and click Group Sort Expert.

Note
You must have a summary field in your report for the Group Sort Expert to be available. See Summarizing 
Grouped Data [page 585].

The Group Sort Expert dialog box appears with a tab for each of the summarized groups in the report.
2. Click the tab for the group you want to sort.
3. Select All from the drop-down list on the left.
4. Choose the summary that you want to base your selection on from the summary drop-down list on the right.

The summary drop-down list on the right is for those cases in which you have multiple summaries within a 
single group section. For example, in an orders report, you might sum and average the orders for each 
customer and then display both the sum and the average in the same group section. In such a case, you would 
select the sum or the average from this drop-down list.

5. Specify the sort direction by clicking Ascending or Descending.
6. To select a second group sort, repeat Steps 2-5.
7. Click OK when finished.

When you run the report, the program will order the groups based on the summary value(s) specified.

Related Information

Adding Percentages to a Report [page 592]
Enhancing Report Presentation [page 622]
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1.7.1.2.5.1.5  Hiding Details in Summary Reports

By hiding a summary report's Details section, you avoid overwhelming users with data they may not immediately 
need. When the Details section is hidden, users navigate with the Group tree first, to locate the desired data. Then, 
by drilling down on the report, they can request specific data, which is returned quickly without unnecessary 
records.

To facilitate navigation in this way, you first need to group the data and insert the summary fields you want to 
include in your report.

Right-click the Details report section and select Hide (Drill-Down OK).

Related Information

Selecting Top or Bottom N Groups [page 587]
Adding Percentages to a Report [page 592]
Enhancing Report Presentation [page 622]

1.7.1.2.5.1.6  Selecting Top or Bottom N Groups

At times, you might want to show only the "top" or "bottom" groups in a report: the fastest selling product lines, 
the least productive sales regions, the states that generate the most orders, and so on. Because this kind of group 
selection is so popular, the program includes the Group Sort Expert for setting it up easily:

● With Top N grouping, you are instructing the program to display those groups that have the highest summary 
values.

● With Bottom N grouping, you are instructing the program to display those groups that have the lowest 
summary values.

There is one other element to consider when selecting the Top N or Bottom N groups: what will you do with the 
records from the remaining groups — that is, those groups that do not fit your specified Top N or Bottom N 
criteria? You need to decide whether to eliminate those records from your report entirely, or to lump them all 
together into a single group. The program enables you to choose either option.

Note
This procedure shows you how to select top or bottom N groups. Top or bottom percentages work the same 
way except that you define the percentage value instead of the number of groups.

1. Right-click in the embedded SAP Crystal Reports Designer, point to Report and click Group Sort Expert.

Note
A report must contain a summary value in order to perform a Top N or Bottom N selection. See 
Summarizing Grouped Data [page 585].
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The Group Sort Expert appears with a tab for your group. If you have multiple groups, the program will display 
a tab for each of the groups.

2. Select Top N or Bottom N from the first drop-down list.
3. Choose the summary that you want to base your selection on from the summary drop-down list on the right.

The summary drop-down list on the right is for those cases in which you have multiple summaries within a 
single group section. For example, in an orders report, you might sum and average the orders for each 
customer and then display both the sum and the average in the same group section. In such a case, you would 
select the sum or the average from this drop-down list.

4. In the "Where N is" text box, enter the number of groups you want to display.
For example:
○ To report on the three fastest selling product lines, select the Top N option in the Top N/Sort Group 

Expert and set N to be equal to three.
○ To report on the five least productive sales regions, select the Bottom N option in the Top N/Sort Group 

Expert and set N to be equal to five.
5. If you want to group all remaining records together in a single group, select the Include Others, with the name 

option and enter an appropriate name.
6. Select Include ties to accommodate groups whose summarized values are equal.

For example, suppose you had the following groups:
○ Order 1 = 100
○ Order 2 = 90
○ Order 3 = 80
○ Order 4 = 80

If you set your top N to be three, but you do not select "Include ties," your report will show Order 1, Order 2, 
and Order 3.

If, in the same scenario, you do select "Include ties," your report will show Order 1, Order 2, Order 3, and Order 
4 even though N is set as three. In this way, the program accommodates the equal values of orders 3 and 4.

7. Click OK.

When the program runs the report, it will include only those groups that you specified.

Related Information

Adding Percentages to a Report [page 592]
Enhancing Report Presentation [page 622]

1.7.1.2.5.2  Sorting Data

Describes how to sort data on a specified field. Also explains the various sort options.

When you first add a database field to your report, the field's data values appear in the order in which they where 
originally entered into the database. By sorting records, you can organize data in a particular order to help you 
find and evaluate the information.
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1.7.1.2.5.2.1  To sort your data

1. Right-click in the embedded SAP Crystal Reports Designer to access the shortcut menu.
2. Point to Report and click Record Sort Expert to access the Record Sort Expert.
3. Highlight the field to be sorted from the Available Fields area.
4. Click the > arrow.

The selected field is added to the Sort Fields list.
5. In the Sort Direction area of the dialog box, click Ascending or Descending.
6. If sorting by more than one field, highlight the second field you want the data to be sorted by and add it to the 

Sort Fields list.

Note
The order of the fields listed in the Sort fields list is the order by which data will be sorted.

7. Click OK when finished.

1.7.1.2.5.2.2  Understanding Sort Options

When you sort, the program asks you to define two things:

● The field you want the sort to be based on (the sort field).
● The sort direction.

Sort Field

The sort field is the field that determines the order in which data appears on your report. Almost any field can be 
used as a sort field, including formula fields. A field's data type determines the method by which the data from 
that field is sorted.

Note
You cannot sort on memo or BLOB fields.

Table 19:

Field Type Sort Order

Single-character string fields Blanks

Punctuation

Numbers

Uppercase letters

Lowercase letters
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Field Type Sort Order

Multiple character string field Two letters

Three letters

Four letters, etc

For example:

● "BOB" comes before "bob"
● "123" comes before "124"
● " " (blank) comes before "aaa"

Currency fields Numeric order

Number fields Numeric order

Date fields Chronological order

DateTime fields Chronological order

Same-date values sorted by time

Time fields Chronological order

Boolean comparison fields False values(0)

True values (1)

Null values Null values

Non-null values

Sort Direction

The sort direction is the order in which the values are displayed, once they have been sorted.

Ascending Ascending order means smallest to largest (1 to 9, A to Z, False to True). The program sorts the 
records in ascending order based on the values in the sort field you select.

Descending Descending order means largest to smallest (9 to 1, Z to A, True to False). The program sorts the 
records in descending order based on the values in the sort field you select.

1.7.1.2.5.2.3  Sort Controls

SAP Crystal Reports 2008 allows users to modify a sort field or sort direction without refreshing information from 
the database. You can do this using a Sort Control. Adding a Sort Control to a text field will place two sort arrows 
beside the field when the report is previewed. Users can sort the fields you have selected by clicking the sort 
arrows that appear beside the text object.
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Sort Controls are available in all of the SAP Crystal Report viewers; however a sort control can not be added from 
the embedded designer. You must use the standalone designer if you wish to add a Sort Control to your report.

A Sort Control is particularly useful for several reasons:

● It allows users to sort report data for further analysis without leaving the canvas of the report.
● It eliminates processing demand on the database.
● It reduces the time users spend waiting for data to be sorted.
● It allows users to sort fields in the report even if they do not have a connection or rights to access the 

database at the time of viewing.

When planning to include a Sort Control in your report, it is important to consider the following points:

● Sort Controls apply across an entire record set; you cannot sort only one group.
● Sort Controls cannot be used in sub-reports.
● The use of Sort Controls causes any open drill-down tabs to close (a warning prompt alerts users).
● Sort Controls must be added to a report with the standalone designer.

1.7.1.2.5.3  Totaling Data

Explains how to subtotal grouped data, add percentages to a report, and create running totals.

To assist users in analyzing report data, you can add totals to your reports. Totaling can be as simple as providing 
the grand total at the bottom of a list of records, or as complex as showing a running total based on conditions 
specified by a formula. Use the Experts provided to total your data.

Related Information

Performing Report Calculations [page 597]

1.7.1.2.5.3.1  To subtotal data

A subtotal is a summary that totals or sums numeric values in a group.

1. Right-click in the embedded SAP Crystal Reports Designer to access the shortcut menu.
2. Point to Insert and click Summary.
3. In the Insert Summary dialog box, click the top drop-down list and select the field you want to subtotal.
4. Click the Insert Group button.

The Insert Group dialog box appears so you can specify the group you want to add to your report.
5. Choose the field you want the data grouped by, specify a sort direction and then click OK when finished.
6. On the Insert Summary dialog box, select the group you just created from the Summary location list and then 

click OK.
The values in each group are now subtotaled.
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7. Click OK.

Related Information

Grouping Data [page 582]
Adding Percentages to a Report [page 592]

1.7.1.2.5.3.2  Adding Percentages to a Report

You can calculate the percentage of one group within a broader grouping. For example, you could show the sales 
in each city as a percentage of the total sales for each country. Or, you could show each country's percentage 
contribution to the grand total of sales.

1. Right-click in the embedded SAP Crystal Reports Designer to access the shortcut menu.
2. Point to Insert and click Summary.
3. In the Insert Summary dialog box, select the field for which you want to calculate the sum.
4. In the second drop-down list, select Sum.

Note
The "sum" calculation appears in the list only when a field containing numeric data is displayed in the first 
drop-down list.

5. Select the summary location.

Note
The summary location cannot be Grand Total (Report Footer) when you are calculating a percentage.

6. Select the Show as a percentage of check box.
7. In the Show as a percentage of list, select the group you want the percentage based on.

You can choose to show a percentage of a group within another group, or to show a percentage of the grand 
total.

8. Click OK.

The summary percentage field is added to your report.

Related Information

Grouping Data [page 582]
Enhancing Report Presentation [page 622]
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1.7.1.2.5.3.3  Creating Running Totals

Running total fields, although similar to summary fields, offer more control over how the total is calculated and 
when it is reset. Running total fields are particularly well suited to perform these totaling functions:

● Show values of a total as it is calculated record by record.
● Total a value independent of the report's grouping.
● Total a value conditionally.
● Total a value after a group selection formula has been applied.

A running total field can be used on database fields and first-pass formulas, but cannot be used on second-pass 
formulas or formulas that reference other second-pass formulas.

1.7.1.2.5.3.4  Placement of Running Total Fields

The calculation of a running total field is determined by the settings selected in the Running Total Expert. 
However, your placement of the running total affects the actual value that appears on the report. For example, if 
you place a running total that evaluates every record and never resets (a grand total) in the Report Header, only 
the value of the first record will appear. Placing the same running total in the Report Footer returns the desired 
value. The running total is properly calculated in both cases, but it is displayed too soon in the first case.

The following is a list of the report sections and the records that the running total will use.

Table 20:

Report Section Running Total Calculated For

Report Header The first record in the report.

Page Header All records up to and including the first record on the current 
page.

Group Header All records up to and including the first record in the current 
group

Details All records up to and including the current record.

Group Footer All records up to and including the last record in the current 
group.

Page Footer All records up to and including the last record on the current 
page.

Report Footer All records in the report.

Related Information

Creating Running Totals in a List [page 594]
Creating Running Totals for a Group [page 595]
Creating Conditional Running Totals [page 596]

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 593



1.7.1.2.5.3.5  Creating Running Totals in a List

Running totals are totals that are displayed generally on a record-by-record basis. They total all records (in the 
report, in the group, and so on) up to and including the current record. The most basic form of a running total is a 
single running total maintained throughout a list.

You create running total fields with the Running Total Expert, which allows you to select the field to summarize, 
the summary operation to use, a condition upon which to base the evaluation, and a condition upon which to reset 
the evaluation.

Note
A running total field can be used on database fields and first-pass formulas, but cannot be used on second-pass 
formulas or formulas that reference other second-pass formulas. See Report Processing Model [page 544].

1.7.1.2.5.3.5.1  To create a running total in a list 

1. In the Field Explorer, right-click Running Total Fields and click New.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

2. In the Create Running Total Field dialog box, enter a name for the running total object in the Running Total 
Name field.

3. In the Available Tables and Fields area, select the field you want to summarize.
4. Click the first arrow button to add the field to the Field to summarize box.
5. In the Evaluate section of the dialog box, choose when you want the running total to execute.

For a running total in a list, click "On change of field."
6. In the Available Tables and Fields area, select your "on change of" field.
7. Click the second arrow button to add the field to the On change of field box.
8. In the Reset section of the dialog box, click Never.

This gives you a running total that never resets; that is, the running total continues throughout the report and 
provides a grand total.

9. Click OK to save the running total field.
Your running total now appears in the Field Explorer, under Running Total Fields.

10. Drag your running total field onto the Details section of the report.

Note
A running total that is placed on a report is indicated by the # prefix (for instance, #Total1).
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Related Information

Placement of Running Total Fields [page 593]
Creating Running Totals [page 593]

1.7.1.2.5.3.6  Creating Running Totals for a Group

A common use for running totals is tallying items in a group. The running total starts with the first item in the 
group and ends with the last. Then it starts all over again for the next group, then the next, and so on.

You need to have data grouped before creating a running total on the group. To group data, see Grouping Data 
[page 582].

1.7.1.2.5.3.6.1  To create a running total for a group

1. In the Field Explorer, right-click Running Total Fields and click New.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

2. In the Create Running Total Field dialog box, enter a name for the running total object in the Running Total 
Name field.

3. In the Available Tables and Fields area, select the field you want to summarize.
4. Click the first arrow button to add the field to the Field to summarize box.
5. In the Evaluate section of the dialog box, click For each record.
6. In the Reset section of the dialog box, click On change of group and accept the default group name.
7. Click OK to save the running total field.

Your running total now appears in the Field Explorer, under Running Total Fields.
8. Either drag the running total field onto the Details section of the report, or, if you want to view a grand total of 

each group, drag the running total field onto the Group Footer section.

Note
A running total that is placed on a report is indicated by the # prefix (for instance, #Total1).

Related Information

Placement of Running Total Fields [page 593]
Creating Running Totals [page 593]
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1.7.1.2.5.3.7  Creating Conditional Running Totals

There may be times when you have a list of ungrouped values, and you only want to subtotal some of the values in 
the list.

Suppose that:

● You have a list that contains both Canadian and U.S. customers.
● You want to keep customer records sorted alphabetically based on customer name.
● You do not want to break the data into groups based on the country.
● You want a total of the values from just the Canadian records.
● You also want a total of the values from just the U.S. records.

To accomplish this, create two running totals, one to keep a running total of the U.S. records, and one to keep a 
running total of the Canadian records.

● USTotal
Maintains a running total of the U.S. records.

● CanadaTotal
Maintains a running total of the Canadian records.

1.7.1.2.5.3.7.1  To create a conditional running total

1. In the Field Explorer, right-click Running Total Fields and click New.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

2. In the Create Running Total Field dialog box, enter a name for the running total object in the Running Total 
Name field.

3. In the Available Tables and Fields area, select the first field you want to summarize.
4. Click the first arrow button to add the field to the Field to summarize box.
5. In the Type of summary list, click sum.
6. In the Evaluate section of the dialog box, click Use a formula and then click the Formula button (labelled x+2).
7. In the Running Total Condition Formula dialog box, enter the formula in the formula box.

For example, if using Crystal syntax to create a running total of U.S. sales, you would enter:

 {Customer.Country} = "USA" 

If using Basic syntax, you would enter:

 Formula = {Customer.Country} = "USA" 

This tells the program to evaluate the running total each time it comes to a record where 
{Customer.COUNTRY} is equal to "USA." The running total will ignore all other records.

8. Click the Save and close button.
9. In the Reset section of the Create Running Total Field dialog box, click Never.
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10. Click OK to save the running total field.
11. Create another running total using the above steps. The only difference will be the value in the formula.
12. Return to the Field Explorer and locate your Running Total Fields.
13. Either drag both of your running total fields onto the Details section of the report, or, if you want to view a 

grand total, drag them onto the Report Footer section of your report.

Note
A running total that is placed on a report is indicated by the # prefix (for instance, #Total1).

Related Information

Placement of Running Total Fields [page 593]
Creating Running Totals [page 593]

1.7.1.2.6 Performing Report Calculations

In many cases, the data needed for a report already exists in database table fields. Sometimes, however, you need 
to put data on the report that does not exist in any of the data fields. In such cases, you need to create a formula.

1.7.1.2.6.1  Formula Overview

Explains how to create formulas and incorporate them into reports.

There are several different kinds of formulas in SAP Crystal Reports: report, conditional formatting, selection, 
search formulas, and running total condition. The majority of formulas in a report are report formulas and 
conditional formatting formulas.

Report Formulas

Report formulas are formulas that you create to stand alone in a report. For example, a formula that calculates the 
days between the order date and the shipping date is a report formula.

Conditional Formatting Formulas

Formatting formulas change the layout and design of a report, as well as the appearance of text, database fields, 
objects, or entire report sections. You format text through the Format Editor. If you need to create a formatting 
formula, you access the Formula Editor from the Format Editor.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 597



Selection Formulas

Selection formulas specify and limit the records and groups that appear in a report. You normally do not enter 
these formulas directly, but instead specify the selection using the Select Expert. SAP Crystal Reports then 
generates the record selection and group selection formulas. You have the option to manually edit these formulas, 
but you must use Crystal syntax.

Search Formulas

Search formulas help you locate data in your report. Like selection formulas, you normally do not enter these 
formulas directly, but instead specify the search criteria using the Search Expert. SAP Crystal Reports generates 
the formula. You have the option to manually edit these formulas, but you must use Crystal syntax.

If you already know Basic syntax, you need to know only a small amount of Crystal syntax to modify most 
selection and search formulas.

Running Total condition formulas

Running Total condition formulas let you define the condition upon which your running total will be evaluated or 
reset. See Creating Conditional Running Totals [page 596] for more information.

Related Information

Inserting Formulas [page 598]
Tutorial: Filtering Data Using Selection Formulas [page 249]

1.7.1.2.6.1.1  Inserting Formulas

When creating formulas, you have the option of using either Crystal or Basic syntax. Almost any formula written 
with one syntax can be written with the other. Reports can contain formulas that use Basic syntax as well as 
formulas that use Crystal syntax.

Related Information

Basic Syntax [page 647]
Crystal Syntax [page 680]
Tutorial: Filtering Data Using Selection Formulas [page 249]
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1.7.1.2.6.1.1.1  To insert a formula into a report

1. In the Field Explorer, right-click Formula Fields and click New.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

2. In the Formula Name dialog box, enter a name for your formula.
3. Click Use Editor.
4. In the Formula Editor dialog box, choose either Crystal Syntax or Basic Syntax.
5. Enter the formula by typing and by selecting components from the component trees.

Tip
The Report Fields, Functions, and Operators trees at the top of the Formula Editor contain the primary 
formula components. Double-click any component to add it to your formula. See Formula Editor Dialog Box 
[page 599].

6. Click the Check button to identify any errors in the formula.
7. Fix any syntax errors identified by the Formula Checker.
8. When the formula has the correct syntax, click the Save and close button.

Your formula now appears in the Field Explorer, under Formula Fields.
9. Drag the formula to position it where you want it to appear on your report.

Note
A formula that is placed on a report is indicated by the @ prefix (for instance, @ProcessTime).

1.7.1.2.6.1.2  Formula Editor Dialog Box

In cases other than selection and search formulas — which you can define using the Select Expert and the Search 
Expert — you create all formulas in the Formula Editor of SAP Crystal Reports.

Accessing the Formula Editor

1. In the Field Explorer, right-click Formula Fields and click New.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

2. In the Formula Name dialog box, enter the name you want to identify the formula with.
3. Click Use Editor.
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The Formula Editor appears.

Sections of the Formula Editor

The Formula Editor contains four main windows.

Window Description of Contents

Report Fields Report fields include all database fields accessible for your 
report. They also include any formulas or groups already 
created for the report.

Functions Functions are pre-built procedures that return values. They 
perform calculations such as average, sum, count, sin, trim, 
and uppercase.

Operators Operators are the "action verbs" you use in formulas. They 
describe an operation or an action to take place between two 
or more values.

Examples of operators: add, subtract, less than, and greater 
than.

Formula text window Area where you create a formula.

Syntax Options

The top right corner of the Formula Editor contains a drop-down list where you can choose between Crystal and 
Basic syntax for the formula you are creating.

Changing the syntax from Crystal syntax to Basic syntax or vice versa will change the list of functions in the 
Functions window as well as the list of operators in the Operators window. The functions and operators differ from 
syntax to syntax.

The available report fields remain the same since the report fields are available to both syntaxes.

Entering Formula Components

The Report Fields, Functions, and Operators trees at the top of the Formula Editor contain the primary formula 
components. Double-click any component to add it to your formula.
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Related Information

Customizing Record Selection Formulas [page 572]
Tutorial: Filtering Data Using Selection Formulas [page 249]

1.7.1.2.6.2  Custom Functions

Explains how to create custom functions that you can reference in formulas.

Custom functions are procedures you create in SAP Crystal Reports to evaluate, make calculations on, or 
transform data. When you use a custom function in a formula, all the operations in its definition are performed 
without you having to specify them individually in the formula itself.

Note
A custom function cannot be placed directly in a report; it must be used as a part of a formula.

Related Information

Advantages of Using Custom Functions [page 601]
Custom Functions Work Flow [page 602]
Creating Custom Functions [page 602]
Basic Syntax for Custom Functions [page 603]
Crystal Syntax for Custom Functions [page 605]

1.7.1.2.6.2.1  Advantages of Using Custom Functions

Consider these advantages when deciding if you want to use a custom function:

● Custom functions can replace sections of formula logic common to many different formulas.
● Existing formulas can be converted to custom functions using the Extract Custom Function from Formula 

Dialog Box [page 760].
● Custom functions can have arguments, which makes them flexible.
● You can define help text and default argument values for custom functions, which makes it easier for your 

users to use them.
● Custom functions, unlike User Function Libraries (UFLs) to which they are related, are saved as part of the 

report file (.rpt) and don't have any external dependencies.
● Custom functions are stateless; the same input always yields the same result.
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1.7.1.2.6.2.2  Custom Functions Work Flow

Although there are different ways to work with custom functions in SAP Crystal Reports, this sample work flow will 
acquaint you with how they might be used.

Related Information

Creating Custom Functions [page 602]

1.7.1.2.6.2.2.1  To add a custom function to a report

1. Extract the custom function from an existing report formula using the Extract Custom Function from Formula 
Dialog Box [page 760].

2. Create the custom function directly in the Custom Function Editor.

1.7.1.2.6.2.2.2  To include a custom function in a report formula 

1. Enter the custom function directly as part of your formula logic in the Formula Editor.
2. Choose a custom function to supply formula logic in the Formula Expert [page 837].

1.7.1.2.6.2.3  Creating Custom Functions

When creating a new custom function, you can enter its logic directly in the Custom Function Editor, or you can 
extract the logic from an existing report formula.

1.7.1.2.6.2.3.1  Using the Custom Function Editor 

1. In the Formula Workshop, click New and select Custom Function from the list.
2. Enter a name for your custom function in the Custom Function Name dialog box.
3. Click Use Editor.
4. Define your custom function in the Custom Function Editor.

Using the Custom Function Editor is like using the Formula Editor to create a report formula. For information 
on how to use the Formula Editor, see the Formula Editor Dialog Box [page 599]. For more information on 
what syntax to use when writing a custom function, see Basic Syntax for Custom Functions [page 603] or 
Crystal Syntax for Custom Functions [page 605].
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Tip
Ctrl+Space brings up a list of the available functions. If you've already started typing, it brings up a list of 
keywords that are possible matches for what you've already typed.

5. Check and save your custom function.

Once the custom function has been saved, you can modify it or use it in report formulas as needed.

1.7.1.2.6.2.3.2  Using the Extract Custom Function from 
Formula Dialog Box

When you extract a custom function from an existing formula, the program copies the formula and replaces its 
fields with arguments. A custom function created using the Extractor can return only simple types, like strings and 
integers. It cannot return arrays. To create a custom function that can return arrays, use the Custom Function 
Editor. For more information on return types and the syntax rules associated with custom functions, see Basic 
Syntax for Custom Functions [page 603] or Crystal Syntax for Custom Functions [page 605].

1. In the Formula Workshop, click New and select Custom Function from the list.
2. Enter a name for your custom function in the Custom Function Name dialog box.
3. Click Use Extractor.
4. In the Formula list, select the report formula whose logic you want to use in your custom function.

Tip
You will probably want to create meaningful names for the arguments in your custom function. The 
program assigns generic names (v1, v2, v3, and so on) by default.

Once you've selected a formula, the Return Type, Arguments, and Formula Text fields are completed with 
information that relates to that formula. These fields cannot be changed without selecting a different formula. 
The remaining fields are optional. See Extract Custom Function from Formula Dialog Box [page 760] for a 
description of each.

5. Click OK to save the custom function to the Report Custom Functions node of the Formula Workshop.

Once the custom function has been extracted and saved, you can modify it or use it in report formulas as needed.

Note
You cannot add new arguments to your custom function while you are creating it in the Extract Custom 
Function from Formula dialog box. To add new arguments, save the custom function and modify it in the 
Custom Function Editor.

1.7.1.2.6.2.4  Basic Syntax for Custom Functions

The syntax for custom functions in Basic syntax is very similar to the syntax for functions in Visual Basic.

Functionname [(argList)] [ As type]
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[statements]

[name=expression]

[ Exit Function]

...

End Function

name Required. This is the name of the function. It must be the same as the name given to the function 
when you created it. The name cannot begin with a number, and cannot contain any spaces or 
punctuation marks other than the underscore. Also, it cannot be the same as a keyword in either 
Basic or Crystal syntax.

type Optional. Represents the type of the data value returned by the function. May be any of the simple 
SAP Crystal Reports types (Number, Currency, String, Boolean, Date, Time, DateTime) or range 
types (Number Range, Currency Range, String Range, Date Range, Time Range, DateTime Range). 
If the return type is omitted, it is deduced by the type of the expression in the first assignment to 
name (implicit typing).

Note
If an array return type is desired, you must use the implicit typing since there is no explicit 
notation for this.

expression Assign expression to name to specify the value returned by the function. If type is specified, then 
this is optional, otherwise, it is required so that SAP Crystal Reports will know the return type of the 
function through implicit typing.

The Exit Function statement causes SAP Crystal Reports to immediately exit from the function. You can use this 
statement any number of times, anywhere in the body of the function.

Note
The only statements you can place before the start of the function, or after the end of the function declaration 
are comments — either with apostrophes or Rem statements.

argList Syntax

[ Optional] varName [()] AsvarType [= defaultValue]

● Optional
Optional. Indicates that the argument can be omitted when the custom function is called. If an argument is 
optional, all subsequent arguments must be optional as well. If you supply a value for an optional argument, 
then you must supply a value for each preceding argument.

● varName
Required. Specifies the name of the variable representing the argument.

● () 
Optional. If present, then it means that the argument variable is an array variable.
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● varType
Required. Indicates the type of the argument variable. It can be any of the seven simple or six range types 
mentioned in the argList description above. If the optional parentheses are present, the type is an array type 
whose elements are of type varType.

● = defaultValue
Required for optional arguments. defaultValue is a constant or constant expression, that is, an expression 
involving no variables that can be simplified at compile time to a constant value. If an optional argument is 
omitted when the function is called, then the default value for the argument will be used.

Note
Unlike Visual Basic, if an argument is optional, a default value must be supplied.

Passed By Value

All arguments are passed by value. In Visual Basic, arguments can be passed either by value or by reference, and 
are passed by reference by default. However, custom functions do not support reference arguments.

1.7.1.2.6.2.5  Crystal Syntax for Custom Functions

Crystal syntax custom functions are expression oriented, like Crystal syntax formulas. You can use either syntax 
formats listed below.

Function ([ argList])

expressions

Function ([ argList])

(

expressions

)

argList Syntax

Optional. A list of variables representing arguments that are passed into the function when it is called. Multiple 
variables are separated by commas. An empty argList is allowed; however, the parentheses surrounding argList 
are not optional and must be used even when argList is empty.

[ Optional] simpleType [ Range] [ Array] varName [:=defaultValue]

● Optional
Optional. Indicates if the argument can be omitted when the custom function is called. If an argument is 
optional, all subsequent arguments must be optional as well. If you supply a value for an optional argument 
when calling the function, then you must supply values for each preceding argument.
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● simpleType
Required. You can use one of:
○ NumberVar
○ CurrencyVar
○ StringVar
○ BooleanVar
○ DateVar
○ TimeVar
○ DateTimeVar

● Range
Optional. Specifies if the argument is a range variable.

Note
You cannot use Boolean Ranges.

● Array
Optional. Specifies if the argument is an array variable.

● varName
Required. The name of the variable representing the argument.

● :=defaultValue
Required for optional arguments. defaultValue is a constant or constant expression; that is, it's an expression 
involving no variables that can be simplified at compile time to a constant value. If an optional argument is 
omitted when calling a custom function, then the default value for the argument will be used.

● expressions
Required. The value returned by the Crystal syntax custom function is the value of the last expression 
evaluated in the expression sequence. The syntax is the same as that in Crystal syntax formulas.

Scope

Variable declarations within a custom function are local scope by default. This contrasts with variable declarations 
in Crystal syntax formulas, where global scope is the default.

1.7.1.2.6.2.6  Custom Function Syntax Rules

Due to the independent nature of custom functions, there are some limitations:

● You cannot use report or database fields, including summary fields, in a custom function.
● You cannot use shared or global variables in a custom function, but you can pass a global or shared variable in 

as an argument when calling a custom function from within a formula.
● You cannot use recursion, either direct or indirect, in a custom function.
● You cannot directly use UFLs in a custom function.
● You cannot call Evaluation Time, Print State, or Document Properties functions. Also, you cannot use the 

functions: Rnd, CurrentFieldValue, DefaultAttribute and GridRowColumnValue.
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These restrictions are designed to make custom functions independent of the report they are being used in.

Variables

You can use local variables and argument variables in custom functions. If you need to use a shared or global 
variable in your custom function, you can pass it in as an argument.

1.7.1.2.6.2.7  Custom Function Evaluation Time

Formulas are not evaluated "on demand" or called (that is, one formula cannot call another formula to do some 
processing, even through the use of global variables).

 Rem Formula PrintSquare
Global x As Number
x = 5 formula = "The square of " & CStr(x,0) & " is " & ToText ({@square}, 0) & "." Rem Formula Square
Global x As Number
formula = x * x 

Using formula PrintSquare in a report, you get:

  The square of 5 is 0.  

In this example, formula PrintSquare uses formula Square, so SAP Crystal Reports order their evaluations. First 
Square is evaluated and then PrintSquare is evaluated. When Square is evaluated, the value of the global variable 
x is 0, since that is the value of an uninitialized Number variable.

In contrast, custom functions are evaluated on demand, or called. Using a custom function in the previous 
example:

 Rem Formula PrintSquare formula = "The square of " & CStr (5,0) & " is " & CStr(cf9Square (5),0) + "."
Rem Custom Function cf9Square
Function cf9Square (x As Number)
cf9Square = x * x
End Function 

Now if you use formula PrintSquare in your report, you'll get:

  The square of 5 is 25.  
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1.7.1.2.6.3  SQL Expressions

Explains when to use SQL Expressions in reports.

SQL expressions are like formulas, but they are written in Structured Query Language (SQL). An SQL expression 
can be used to query the database for specific sets of data. You can sort, group, and select based on SQL 
expression fields.

SQL expressions are useful in optimizing report performance because the tasks they execute are normally 
performed on the database server (as opposed to a regular formula, which is sometimes executed on the local 
machine).

Don't use SQL expressions exclusively, because SAP Crystal Reports includes its own formula language, which is 
much more powerful than standard SQL. Both Crystal Syntax and Basic Syntax allow you to enhance and hone 
your formulas in ways that are either difficult or impossible with SQL. In certain circumstances, however, creating 
and using SQL Expression fields can speed up the processing of your reports.

Related Information

Formula Editor Dialog Box [page 599]
Optimizing Report Performance [page 644]

1.7.1.2.6.3.1  To create an SQL Expression field

1. In the Field Explorer, right-click SQL Expression Fields and click New.

Note
When an SQL/ODBC data source is used to design a report, the program adds SQL Expressions Fields to 
the Field Explorer.

2. Enter a name in the Name box, and then click OK.
The SQL Expression Editor appears. The SQL Expression Editor functions in the same way as the Formula 
Editor.

3. Type the expression in the SQL Expression Editor.
4. Click the Save and close button.

1.7.1.2.7 Formatting Data

Formatting refers to changes in the layout and design of a report, as well as the appearance of text, objects, or 
entire report sections.

You can use formatting to do many things, including:
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● calling attention to certain data
● giving the report a professional appearance
● changing the presentation of dates, numbers, Boolean values, currency values, and text strings

You can use the commands on shortcut menus to format data. For example:

● To format an object, right-click the object and click Format Object.
● To format a chart object, right-click the chart and click Chart Expert.
● To format a report section, right-click the report section and click Section Expert.

Tip
You can also use the Visual Studio Properties window to format objects or sections.

1.7.1.2.7.1  Absolute Formatting

Absolute formatting applies under any condition. This type of formatting property always follows a select-then-
apply procedure. For example, you select what it is that you want to format (object or section), then you apply the 
formatting to the selection using property settings.

To format an object, right-click the object and select Format or use the Visual Studio Properties window.

1.7.1.2.7.1.1  Formatting Numbers and Dates

As a way of supporting the conventions used in the accounting profession, SAP Crystal Reports lets you decide on 
how to display the currency symbol, negative values, and zero values on your financial reports. You can also set 
up your report to reverse the signs for credit and debit amounts.

Note
There are many date formats you can choose to use on an English report, but if you send the report to a 
Japanese system, there may be some formatting irregularities. Not all English date formats are viewable on a 
Japanese system, and the same is true going from Japanese to English. For instance, abbreviated English 
months do not appear on a Japanese system and Japanese eras in short format do not appear on an English 
system.

1.7.1.2.7.1.1.1  To format numbers and dates

1. Right-click the currency, number, or date field and select Format Object.
2. Select a format option, or click Customize to specify another format.
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1.7.1.2.7.1.2  Adding Borders, Colors, and Shading to Fields

SAP Crystal Reports allows you to add borders, color, and shading to fields on your report in order to emphasize 
important data and create professional-looking reports.

1.7.1.2.7.1.2.1  To add borders, colors, and shading

1. Right-click the object and select Format Object.
2. Click the Border tab and select the line style, color, and background color of the field.
3. Click OK to save your changes.

1.7.1.2.7.1.3  Inserting Shapes

When designing report formats in SAP Crystal Reports, you can insert a variety of shapes such as circles, eclipses, 
and boxes with rounded corners, as part of your report.

1. To add a box to your report, right-click in the embedded SAP Crystal Reports Designer, point to Insert, and 
click Box.

Tip
You can also use the Toolbox to select and drag a box object.

2. Use the pencil cursor to draw the box where desired.
3. Right-click the box, and select Format Object.
4. Click the Rounding tab.
5. Move the slider to the right to increase the curvature of the box corners.
6. Click OK.

Related Information

Absolute Formatting [page 609]
Conditional Formatting [page 610]

1.7.1.2.7.2  Conditional Formatting

Conditional formatting applies only under certain conditions. For example, in a report you may only want:

● customer balances printed in red if they are past due
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● dates to appear in Day, Month, Year format if the customer is Canadian
● background color to appear on every other line

You specify conditional formatting using formulas. When a conditional formatting formula is set up, the formula 
overrides any fixed settings you have made in the Format Editor. For example, if you select the Suppress option, 
and then set up a conditional formula for the Suppress option, the property will still apply only if the condition in 
the formula is met.

You are able to set "on or off" properties and attribute properties conditionally. However, each of these types of 
properties requires a different kind of formula.

1.7.1.2.7.2.1  To add conditional formatting to an object

1. Right-click the object, and select Format Object.
2. Click the appropriate Formula button located on the right side of the dialog box.
3. In the Format Editor dialog box, enter the formula.
4. Click Save and close.

○ If there is an error in the formula, a message box appears, asking whether to exit without examining the 
error. If you click No, a second message box will be displayed, detailing the error.

○ If there is no error in the formula, you are returned to the Format Editor. Note that the Formula button has 
changed. This indicates that a formula has been entered for that property.

5. Click OK to return to your report.

1.7.1.2.7.2.2  Conditional On or Off Properties

A conditional "on or off" property tests to see if a condition has been met. The property is on if the condition is 
met, off if the condition is not met. Use Boolean formulas for this kind of formatting.

The program tests each value to see if it meets the condition and it returns a "yes" or "no" answer. It then applies 
the property to every value that returns a "yes" answer.

Example
Crystal Syntax Example

condition

Example
Basic Syntax Example

formula = condition
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Related Information

Conditional Formatting Functions (Basic Syntax) [page 668]
Conditional Formatting Functions (Crystal Syntax) [page 698]

1.7.1.2.7.2.3  Conditional Attribute Properties

A conditional attribute property tests to see which of two or more conditions is met. The program then applies the 
formatting appropriate to the condition. For example, assume that you want values under quota printed in red, 
and all other values printed in black. The program tests to see whether the value is under quota or not. If the value 
is under quota, then the program applies the red attribute; if the value is not under quota, then the program 
applies the black attribute.

Use an If-Then-Else formula for this kind of conditional formatting.

Crystal Syntax Example

 If Condition A Then
   crRed
Else
   crBlack 

Basic Syntax Example

 If Condition A Then
   formula = crRed
Else
   formula = crBlack
End If 

When conditional attribute properties are set up, SAP Crystal Reports loads a selection of attributes into the 
Functions list in the Formula Editor. Double-click any of these attributes to add it to a formula. For example, if you 
are setting horizontal alignment conditionally, the Functions list contains attributes such as DefaultHorAligned, 
LeftAligned, and Justified. If you are setting borders conditionally, the Functions list contains attributes such as 
NoLine, SingleLine, and DashedLine.

Note
Always include the Else keyword in conditional formulas; otherwise, values that don't meet the If condition may 
not retain their original format. To retain the original format of values that don't meet your If condition, use the 
DefaultAttribute function.

Crystal Syntax Example

 If Condition A Then
   crRed
Else If Condition B Then
   crBlack
Else If Condition C Then
   crGreen
Else
   crBlue 
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Basic Syntax Example

 If Condition A Then
   formula = crRed
ElseIf Condition B Then
   formula = crBlack
ElseIf Condition C Then
   formula = crGreen
Else
   formula = crBlue
End If 

Related Information

Conditional Formatting Functions (Basic Syntax) [page 668]
Conditional Formatting Functions (Crystal Syntax) [page 698]

1.7.1.2.7.3  Formatting Reports using Cascading Style Sheets

Instead of formatting report objects or sections in the embedded SAP Crystal Reports Designer, you can use 
classes in a cascading style sheet (CSS) to apply formatting to reports viewed over the Web.

Generally, when you create a report, you format a particular report object (for example, a database field or text 
object) within the embedded SAP Crystal Reports Designer. When the report is rendered into HTML and viewed 
through a Web Forms Viewer, these formatting options are automatically converted into HTML. To change the 
formatting of the HTML page, you would need to make a change to the Crystal report itself.

The Set CSS Class option enables you to apply CSS classes to report objects and to sections of a report, instead 
of manually changing the formatting of the report. You specify the name of the class and its scope in the 
embedded SAP Crystal Reports Designer and then specify the value of the class within the .aspx file of your 
project or through an external style sheet. The external style sheet or the formatting specified in the .aspx file is 
then applied to the report when the report is rendered into HTML.

1. Right-click in the embedded SAP Crystal Reports Designer and select Set CSS Class.
2. In the Object Scope field, select the objects or sections you would like the class to be applied to.
3. Enter the name of the class in the CSS Class Name field.

Tip
Use CssClass in the Properties window to view, edit, or delete the class values for a specific report object or 
section.

4. Click OK.
5. Save the report.
6. Access the .aspx file in your project.
7. In the HTML tab of the .aspx file, reference an external style sheet that has the class already defined, or enter 

the class value.
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<HTML>
   <STYLE>
.classname
{
   background-color:808080; border-color:000000; color:000000;
font-family:Arial; font-weight:bold; font-style:italic; }
   <STYLE>
</HTML> 

1.7.1.2.8 Report Part Drill Down and Hyperlink 
Customization

In general, the CrystalReportViewer controls are page viewers that let you see complete pages of your Crystal 
reports. However, the CrystalReportPartsViewer Class lets you see specific report objects without viewing 
the entire page. Report objects displayed in such a way are referred to as Report Parts.

The key difference between Report Part navigation and regular (page) navigation is that, when navigating with 
Report Parts (using the CrystalReportPartsViewer control), you see only the objects identified as Report Parts. In 
regular navigation, you go to the identified object(s), but you see the entire page.

1.7.1.2.8.1  Report Parts Overview

Report objects displayed by themselves in a viewer — without the rest of the report page — are referred to as 
Report Parts. More precisely, however, Report Parts are objects that use hyperlinks to point from a home report 
object to a destination object.

Report Parts work with the DHTML viewer subset of the SAP Crystal Report Viewers to expand the navigation 
possibilities within and between reports. Report Part hyperlinks can link to other objects in the current report or to 
objects in any other report. This linking lets you create a guided path through your reports that shows only 
specific information at each stop along the path.

Report Part Viewer

The Report Part Viewer is a viewer that lets you display Report Parts without the rest of the report page. You can 
integrate this viewer into web applications so that your users see only specific report objects without having to see 
the rest of the report.

You set up the Report Part hyperlinks in the embedded SAP Crystal Reports Designer, or through code, but you 
take advantage of their functionality in the report viewers.
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Differences between how the viewers display hyperlinks 

Table 21:

Page Viewers Report Part Viewer

Another Report Object:

● Navigates to destination objects and shows contents of 
the entire page.

Another Report Object:

● Navigates to destination objects and shows only the des
tination objects.

Report Part Drilldown:

● Navigates (drills down) to the group and shows the com
plete contents of the group.

Report Part Drilldown:

● Navigates to destination objects and shows only the des
tination objects.

Default drill down (no hyperlink):

● Group drill down from a group header or footer, chart, or 
map displays the group view.

● Subreport drill down displays the subreport view.

Default drill down (no hyperlink):

● Not available.

1.7.1.2.8.2  Hyperlink Navigation Overview

The navigation functionality in SAP Crystal Reports lets you move to other report object(s) in the same report, or 
to object(s) in another report — with a specified data context. This navigation is available only in the DHTML 
viewers (zero-client, server-side viewers). Its advantage is that you can link directly from one object to another; 
the required data context is passed automatically so you go to the object and data that is relevant.

Report Parts use this navigation functionality when linking between Report Part objects. The key difference 
between Report Part navigation and regular (page) navigation is that, when navigating with Report Parts (using 
the Report Part Viewer), you see only the objects identified as Report Parts. In regular navigation, you go to the 
identified object(s), but you see the entire page.

Setting Up Navigation

Navigation (page or Report Part) is set up on the Hyperlink tab of the Format Editor Dialog Box [page 762].

In the DHTML Viewer Only area of the Hyperlink tab, you can select one of two options:

● Report Part Drilldown
The Report Part Drilldown option is available for summary fields, group charts and maps, and fields in your 
report's group header or group footer. This option is relevant only to Report Parts; regular navigation (using 
the page view) drills down by default. For more information, see Report Part-Specific Navigation [page 617].

● Another Report Object
You can use the Another Report Object option for both Report Part and page navigation. This option lets you 
specify the destination object(s) you want to navigate to and the data context to pass.

When you select the Report Part Drilldown option, the "Hyperlink information" area contains these options:

● Available Fields
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The Available Fields area lists, as a tree view, all the sections in your report that contain report objects you can 
use for Report Part drill down. You select objects from this area and add them to the Fields to Display area.

● Fields to Display
The Fields to Display area lists, as a tree view, the section and objects that you have selected for drilling down 
on.

See Implementing Report Part Drill Down [page 617] for information about how to use these options.

When you select the Another Report Object option, the "Hyperlink information" area contains these options:

● Paste the Report Part link
Use the Past Link button to add detailed information about a report object that you previously selected and 
copied. The pasted information depends, in part, on the option you select from the list associated with the 
button.

● Select From
After you paste link information, the Select From field contains the path and file name of the report you 
selected and copied from (it is blank when the current report is referenced). You add information to this field 
by pasting a report part link; otherwise it is not accessible.

● Report Title
The Report Title field defaults to the title of the report specified in the Select From field (it contains the text 
<Current Report> when the current report is referenced). If a report title was not defined in the Document 
Properties dialog box, the field defaults to the report's file name. You add information to this field by pasting a 
report part link; otherwise it is not accessible.

● Object Name
By adding one or more objects to this field, you are identifying the destination objects for your navigation. In 
page navigation, this information determines what object you move to in the page. For Report Part navigation, 
this information determines what object(s) the viewer displays upon navigation (the viewer displays only the 
identified objects).
You can select any of the following report object types in the Object Name field (you can select one or more 
objects from the same report section):
○ Field objects
○ Charts or maps
○ Bitmaps
○ Cross-tabs
○ Text objects

You cannot select the follow report object types as destinations:
○ Objects inside the Page Header or Page Footer.
○ Lines or boxes.
○ Subreports or any object inside a subreport.
○ Entire sections (you must select the objects inside the section individually).

You can add specific information in one of two ways:
○ You can type the object name(s) as they appear in the Report Explorer.
○ You can copy report object(s) from the current report or another and paste its information into the object 

field.
● Data Context

The program normally completes the Data Context field when you paste information for the destination 
object(s). You can also customize this option by using the Conditional Formula button. For more information, 
see Data Context Formats [page 622].

See Another Report Object Option [page 619] for information about how to use these options.
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1.7.1.2.8.2.1  Report Part-Specific Navigation

Report Parts use the SAP Crystal Reports navigation functionality. However, some special cases apply only to 
Report Parts:

● The viewer displays only the object identified as the destination object.
● You must use the Report Part Drilldown option, so that you can specify the destination object(s).
● You must specify Initial Report Part Settings for each report that is the first stop on the Report Part navigation 

path.

1.7.1.2.8.3  Implementing Report Part Drill Down

Use the Report Part Drilldown option only to navigate between objects in the same report. If you want to navigate 
to other reports, see Another Report Object Option [page 619].

The Report Part Drilldown option in the Hyperlink tab of the Format Editor lets you define a hyperlink so that the 
Report Part Viewer can emulate the drill-down functionality of SAP Crystal Reports. The Report Part Viewer 
displays only destination objects; therefore, to make drill down work, you need to define a navigation path from a 
home object to one or more destination objects. When you have multiple destination objects, they must all reside 
in the same report section.

The Report Part Drilldown option does not affect the DHTML page viewers since the option emulates the default 
SAP Crystal Reports behavior for drill down (which the page viewers already support). Page viewers, however, do 
not limit which objects are displayed — they always show all report objects.

1.7.1.2.8.3.1  Defining the Home Object

Because the Report Part Viewer shows only destination objects, you must define Initial Report Part Settings (that 
is, a default home object) for a report before your Report Part Drilldown hyperlinks can work. A report's Initial 
Report Part Settings define the object that appears first in the Report Part Viewer. Think of this object as the place 
you'll begin your path of drill-down hyperlinks from.

1. Open the report whose default home object you want to define.
2. Click the object you want to set as the default home object and copy its name listed in the Name field of the 

Properties window (for example: Text1, Field1, Graph1, and so on).
3. Right-click in the embedded SAP Crystal Reports Designer, point to Report, and select Report Options.
4. In the Initial Report Part Settings area of the Report Options dialog box, click the Paste Link button.

Tip
Include another object from the same section of the report by entering a semi-colon (;) and typing the 
name of the object.

The name and data context of the report object you selected as your home object are pasted into the 
appropriate fields.
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5. Click OK.

1.7.1.2.8.3.2  Defining the Destination Object

Before you begin this procedure, see Hyperlink Navigation Overview [page 615] to acquaint yourself with the 
limitations of creating this type of hyperlink.

To define the destination object you will create a Report Part Drilldown hyperlink.

1. Open a report and right-click the intended destination object and select Format Object from the shortcut list.
2. In the Format Editor, click the Hyperlink tab.
3. In the DHTML Viewer Only area, select Report Part Drilldown.

Note
The Available Fields area does not show suppressed report objects.

The Hyperlink Information area changes to show the appropriate fields for this type of hyperlink.

The Available Fields area shows only the sections and report objects you can select for drill down. In general, 
these objects include field objects, charts, maps, bitmaps, cross-tabs, and text objects contained in the next 
section down (that is, for example, objects in group two when the object you selected is in group one).

4. In the Available Fields area, select the section or report object(s) you want to use as your drill down 
destination.

Tip
Use the Properties Window to quickly identify the default names assigned to each of your report objects.

5. Use the arrow buttons to move the selected section or object(s)to the Fields to Display area.

Note
For ease of identification, the program creates a section node in the Fields to Display area. This node 
contains the objects that you selected in the Available Fields area.

6. If you want to add another object to the Fields to Display area, select it in the Available Fields list and drag it 
into position.

Tip
The position an object has in the Fields to Display area determines how it appears in the Report Part 
Viewer; top to bottom in the Fields to Display area equates to left to right in the viewer. Use the arrows 
above the Fields to Display area to change the order of objects.

Note
The Fields to Display area can contain only one section at a time. If you try to add a second section, it 
replaces any existing section in the Fields to Display area.
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7. Click OK.

You have established a hyperlink from your report's home object to a destination object or objects. In the 
Report Part Viewer, you will see the home object first, and when you click it for drill down, you will see the 
destination object(s).

1.7.1.2.8.3.3  Another Report Object Option

The Another Report Objectoption in the Hyperlink tab of the Format Editor lets you define a hyperlink path for 
linking objects in the same or different reports. If you are defining a hyperlink path to a different report, that report 
must be managed in SAP BusinessObjects Business Intelligence platform. The CrystalReportPartsViewer 
control displays only the objects you specify. Like the Report Part Drilldown Option, all destination objects must 
be from the same report section.

The Another Report Object option can also be used by the DHTML page viewer for navigation purposes.

1.7.1.2.8.3.3.1  To create a Report Part Drilldown hyperlink

Because the Another Report Object option allows you to create hyperlinks between objects in different reports 
managed in SAP Crystal Reports Server or SAP BusinessObjects Business Intelligence platform, it requires more 
set up on the Hyperlink tab. This is an overview of the steps you have to complete to set up your hyperlink 
successfully.

● Open the report that contains the object you want to be the destination object and copy it.
● Open the report that contains the home object, select it, and open the Format Editor.
● On the Hyperlink tab, paste the information from the destination object into the appropriate fields.

Note
Before you begin this procedure, see Hyperlink Navigation Overview [page 615] to acquaint yourself with 
the limitations of creating this type of hyperlink.

1. Open your source and target reports.

Your source report is the report you copy an object from; the target report is the report you add the hyperlink 
information to.

When you view your target report in the ReportPartViewer, you first see its home object. When you drill down 
on that object, you go to the destination object you selected in the source report.

2. In your source report, click the intended destination object and copy its name listed in the Name field of the 
Properties window (for example: Text1, Field1, Graph1, and so on)

3. In your target report, right-click the intended home object and choose Format Object from its shortcut menu.
4. In the Format Editor, click the Hyperlink tab, and then select the Another Report Object option.
5. In the "Hyperlink information" area, click Paste Link.

Note
The Paste Link button is unavailable if you have not copied a destination object.
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6. The program pastes the identifying information from the destination object you selected in the source report 
into the appropriate fields.

The Paste Link button includes a list of options that you can use when pasting a link to the destination object. 
Depending on the type of link you are creating (for example, a link to a specific data context rather than a link 
to a generic data context), you may see these options:
○ Context Report Part

This is the default option; it is selected when you click Paste Link without viewing the other list options. 
Use this option to paste a link that includes the most complete data context that the program can 
determine. For more information, see Context Report Part Option Scenarios [page 620].

○ Design View Report Part
Use this option to paste a link that includes a generic data context (that is, a data context that does not 
point to a specific record). Use this option when you want a broad data context, or when data is not yet 
present in your source report.

○ Preview Report Part
Use this option to paste a link that includes a specific data context (that is, a data context that points to a 
specific record). Use this option when you want a narrow data context, or when data is present in your 
source report.

Note
If you choose the Design View Report Part option (or if you choose the Context Report Part option for 
an object copied from a report's Design view) and your source and target reports have different data 
structures, you'll see the Report Part Map Fields dialog box. Each field in the Unmapped Fields area 
represents a group in your source report. Use this dialog box to map these groups to fields in your 
target report. When you've mapped all the groups, the OK button is available, and you can proceed.

7. If you want to add other fields from the same section of the link to report, click the Object Name field and 
move the cursor to the end of the existing text. Enter a semi-colon (;) and then the name of the field(s).

8. You can broaden your Data Context by using an asterisk (*) to represent all records in a group.

For example, if your Data Context is /USA/CA/Changing Gears (which will show only that specific detail 
record), you could change it to /USA/CA/* to show all detail records within that group.

Tip
If your report has a group selection formula, check the data context for your destination object to ensure it 
contains the correct child index.

9. Click OK.

You have established a hyperlink from your home object to a destination object or objects. In the Report Part 
Viewer, you would see the home object first, and when you clicked it for drill down, you would see the 
destination object(s).

1.7.1.2.8.3.4  Context Report Part Option Scenarios

When pasting linking information for a Report Part, the Context Report Part option mainly affects the data context 
of the link; the Select From field (the report URI) and the Object Name field are always the same for any of the 
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choices available in the Paste Link list. This section provides various scenarios and describes how the program 
creates a data context for each.

Scenario 1

If your source report contains data (that is, if the report is in Preview view), the Context Report Part data context 
(in the target report) is the source report's Preview data context for all children of the selected field. For example, 
you might see this in the Data Context field: /Country[USA]/Region[*]. Otherwise, the program uses the source 
report's Design view data context as the Context Report Part data context in the target report.

Scenario 2

If your source and target reports are the same report, and the object you choose as your source is from the 
Preview view, when the target object you choose to link to is in a higher level than the source object, the data 
context is left empty. For example, when the source data context is /Country[Australia]/ChildIndex[5], and the 
target data context is /Country[Australia], the Context Report Part data context is left empty.

Scenario 3

If your source and target reports are the same report, and the object you choose as your source is from the 
Preview view, when the target object you choose to link to is in a lower level than the source object, the data 
context pasted is a Design view data context (in the form of a formula). For example, when the source data 
context is /Country[Australia], and the target data context is /Country[Australia]/ ChildIndex[5], the Context 
Report Part data context is "/"+{Customer.Country}.

Cross-tabs

If the object you copy in your source report is part of a cross-tab, the Context Report Part data context is based on 
the selected object embedded in the cross-tab. SAP Crystal Reports creates the data context by tracking if the 
selected object in the cross-tab is a row, column, or cell. Next, the program retrieves row and column names. 
Then it parses the Design view data context. Finally, it generates the Context Report Part data context by adding 
the GridRowColumnValue function if the group in the data context formula appears in the row or column names 
retrieved earlier. You might see, for example, a data context such as:

 "/"+GridRowColumnValue("Customer.Country")+"/"+GridRowColumnValue("Customer.Region") 
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1.7.1.2.8.3.5  Data Context Formats

Normally, a data context formula appears as follows:

 "/" + {Table.Field} + "/" + {Table.Field} 

You can also use these formats:

● XPath-like format:

 /USA/Bicycle 
● Strongly-Typed format:

 /Country[USA]/Product Class[Bicycle] 
● Detail-level information in 0-based format:

 /USA/Bicycle/ChildIndex[4] 
● A wildcard to identify all instances:

 /USA/* 
● For Cross-Tab objects, you can use navigation on cells, columns, or rows. To define the data context, use the 

GridRowColumnValue formatting function. For example:

 "/" + GridRowColumnValue ("Supplier.Country") + "/" +
GridRowColumnValue ("Product.Product Class"). 

1.7.1.2.9 Enhancing Report Presentation

This section describes the methods you can use to draw attention to data; change the presentation of dates, 
numbers, and other values; hide unwanted sections; and perform additional formatting tasks that give your report 
a professional appearance.

1.7.1.2.9.1  Inserting Charts

Lists the charts available and explains how to insert charts into reports.

SAP Crystal Reports enables you to include sophisticated, colorful charts in your reports. Not only is charting a 
means of presenting data — it is also an analysis tool. Users can drill down on a chart, or a chart's legend, for 
detailed information.

You can chart on the following:

● summary and subtotal fields
● detail, formula, and Running Total fields
● Cross-Tab summaries
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Note
You can chart on OLAP data in other versions of SAP Crystal Reports. SAP Crystal Reports, developer 
version for Microsoft Visual Studio .NET does not support OLAP grids.

When you add a chart to your report, you will typically chart on summary and subtotal information at the group 
level.

1.7.1.2.9.1.1  To insert a chart

1. Right-click in the embedded SAP Crystal Reports Designer, point to Insert and click Chart.
2. In the Type tab, select the Chart Types [page 624].
3. Select Automatically set chart options if you want the Chart Expert to use default options on the Axes and 

Options tabs.
4. Click the Data tab.
5. In the Placement area, specify how often your chart appears on the report, then click Header or Footer to 

specify where to place your chart.
6. In the Layout area, select the Chart Layouts [page 624].
7. In the Data area, specify the database fields you want to use as conditions.
8. If the Axes and Options tabs appear, you can customize some of the chart's properties, such as scaling of the 

axes, the legend, and the data points.
9. Click the Text tab. Accept the default title information or add new titles to your chart.
10. Click OK.

Related Information

Chart Layouts [page 624]
Chart Types [page 624]

1.7.1.2.9.1.2  Where to Place a Chart?

The placement of a chart determines which data is displayed and where it is printed. For example, a chart placed 
in the Report Header section includes the data for the entire report, while a chart that is placed in a Group Header 
or in a Group Footer section displays only the group specific data.

Note
● If your report contains subreports, you can place charts in those subreports as well. For more information 

on subreports, see Inserting Subreports [page 631].
● By default, when you insert a chart, it is placed in the Report Header.
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1.7.1.2.9.1.3  Chart Layouts

The Chart Expert provides four layouts that correspond to certain sets of data.

You can create charts with any of the following layouts and, depending on the data you are using, you can change 
the chart from one layout to another.

Advanced Use the Advanced layout when you have multiple chart values or when you do not have any group or 
summary fields in the report.

The Advanced chart layout supports one or two condition fields: with these condition fields, you can 
create a 2-D or 3-D chart. Other specific functions with the Advanced layout include:

● values can be grouped in ascending, descending, or specified order, as well as by Top N or Sort 
totals

● values can be plotted for each record
● values can be plotted as a grand total for all records
● charts can be based on formula and Running Total fields

Group The Group layout is a simplified layout in which you show a summary on change of field for topics 
such as Country.

In order to create a chart using the Group layout, you must have at least one group and at least one 
summary field for that group.

Cross-Tab Use the Cross-Tab layout to chart on a Cross-Tab object. A Cross-Tab chart uses the fields in the 
cross-tab for its condition and summary fields.

OLAP Use the OLAP layout to chart on an OLAP grid. An OLAP chart uses the fields in the OLAP grid for its 
condition and summary fields.

Note
You can chart on OLAP data in other versions of SAP Crystal Reports. SAP Crystal Reports, 
developer version for Microsoft Visual Studio does not support OLAP grids.

1.7.1.2.9.1.4  Chart Types

Different sets of data are particularly suited to a certain chart type. The following is an overview of the main chart 
types and their most common uses.

Bar A bar chart (also known as a column chart) displays or compares several sets of data. Two useful 
bar charts are the Side-by-Side bar chart and the Stacked bar chart.

Side-by-Side 
bar chart

A Side-by-Side bar chart displays data as a series of vertical bars. This type of 
chart is best suited for showing data for several sets over a period of time (for 
example, last year's sales figures for AZ, CA, OR, and WA).
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Stacked bar 
chart

A Stacked bar chart displays data as a series of vertical bars. This type of chart 
is best suited for representing three series of data, each series represented by a 
color stacked in a single bar (for example, sales for 1997, 1998, and 1999).

Line A line chart displays data as a series of points connected by a line. This type of chart is best suited 
for showing data for a large number of groups (for example, total sales over the past several 
years).

Area An area chart displays data as areas filled with color or patterns. This type of chart is best suited 
for showing data for a limited number of groups (for example, percentage of total sales for AZ, CA, 
OR, and WA).

Pie A pie chart displays data as a pie, split and filled with color or patterns. Pie charts are typically 
used for one group of data (for example, the percentage of sales for the entire inventory); 
however, you have the option to choose multiple pie charts for multiple groups of data.

Doughnut A doughnut chart is similar to a pie chart, displaying data as sections of a circle or doughnut. If, for 
example, you charted sales by region on a particular report, you would see the total number of 
sales (the figure) in the center of the doughnut and the regions as colored sections of the 
doughnut. As with the pie chart, you have the option to choose multiple doughnut charts for 
multiple groups of data.

3-D Riser A 3-D Riser chart displays data in a series of 3-dimensional objects, lined up side-by-side, in a 3-
dimensional plane. The 3-D Riser chart shows the extremes in your report data. For example, the 
differences between sales by customer by country are visually dynamic when presented in this 
chart.

3-D Surface 3-D Surface charts present a topographic view of multiple sets of data. If, for example, you need a 
chart to show the number of sales by customer by country, in a visually dynamic and relational 
format, you might consider using the 3-D Surface chart.

XY Scatter An XY Scatter chart is a collective of plotted points that represent specific data in a pool of 
information. The XY Scatter chart allows the user to consider a larger scope of data for the 
purpose of determining trends. For example, if you input customer information, including sales, 
products, countries, months, and years, you would have a collective of plotted points that 
represents the pool of customer information. Viewing all of this data on an XY Scatter chart would 
allow you to speculate as to why certain products were selling better than others or why certain 
regions were purchasing more than others.

Radar A radar chart positions group data, such as countries or customers, at the perimeter of the radar. 
The radar chart then places numeric values, increasing in value, from the center of the radar to the 
perimeter. In this way, the user can determine, at a glance, how specific group data relates to the 
whole of the group data.

Bubble A bubble chart displays data as a series of bubbles, where the size of the bubble is proportional to 
the amount of data. A bubble chart would be very effective with the number of products sold in a 
certain region; the larger the bubble, the greater the number of products sold in that region.

Stock A stock chart presents high and low values for data. It is useful for monitoring financial or sales 
activities.

Numeric 
Axis

A numeric axis chart is a bar, line, or area chart that uses a numeric field or a date/time field as its 
"On change of" field. Numeric axis charts provide a way of scaling your X-axis values, thus creating 
a true numeric X-axis or a true date/time X-axis.
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Gauge A gauge chart presents values graphically as points on a gauge. Gauge charts, like pie charts, are 
typically used for one group of data (for example, the percentage of sales for the entire inventory).

Gantt A Gantt chart is a horizontal bar chart often used to provide a graphical illustration of a schedule. 
The horizontal axis shows a time span, while the vertical axis shows a series of tasks or events. 
Horizontal bars on the chart represent event sequences and time spans for each item on the 
vertical axis. You should use only date fields when creating a Gantt chart. The field you choose for 
the data axis should be set to "For Each Record," and the start and end-date fields should be 
added to the "Show value(s)" area of the Chart Expert's Data tab.

Funnel Funnel charts are often used to represent stages in a sales process. For example, the amount of 
potential revenue shown for each stage. This type of chart can also be useful in identifying 
potential problem areas in an organization's sales processes. A funnel chart is similar to a stacked 
bar chart in that it represents 100% of the summary values for the groups included in the chart.

Histogram A histogram is a type of bar chart used to depict how measurements vary from the mean value. It 
can help to identify the cause of problems in a process by the shape of the distribution as well as 
the width (deviation) of the distribution. In a histogram, the frequency is represented by the area 
of a bar rather than the height of the bar.

Note
Gantt charts and Funnel Charts are available in SAP Crystal Reports for Visual Studio 2005 and 
higher, and in SAP Crystal Reports Developer. Histogram is not available in SAP Crystal 
Reports, developer version for Microsoft Visual Studio, but is available in one of the upgraded 
versions.

1.7.1.2.9.1.5  Creating Charts

When you design a report, you will typically chart on summary and subtotal information at the group level. 
However, depending on the type of data you are working with, you can create an Advanced or Cross-Tab chart for 
your report.

1.7.1.2.9.1.5.1  Charting on Summary or Subtotal Fields

Since charts are a good way to display summarized information, they are often based on a summary field in your 
report. In order to create these charts, you must have a summary or subtotal already inserted into your report in a 
group header or footer. For more information on inserting summaries and subtotals, see Summarizing Grouped 
Data [page 585] and To subtotal data [page 591].

Related Information

Chart Types [page 624]

626 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



Chart Layouts [page 624]

1.7.1.2.9.1.5.1.1  To chart on a summary or subtotal field

1. Right-click in the embedded SAP Crystal Reports Designer, point to Insert and click Chart.
2. On the Type tab, select the Chart Types [page 624], and click the chart subtype that best illustrates your data.
3. Select Automatically set chart options if you want the Chart Expert to use default options on the Axes and 

Options tabs.
4. Click the Data tab.
5. In the Placement area, specify how often your chart appears on the report, then click Header or Footer to 

specify where to place your chart.
6. In the Layout area, click Group, if it is not already selected.
7. In the Data area, in the On change of list, click the group field you want to base your chart on; then, in the Show 

list, click the summary field you want to display on your chart.
8. If the Axes and Options tabs appear, you can customize some of the properties, such as scaling of the axes, 

the legend, and the data points.
9. Click the Text tab. Accept the default title information or add new titles to your chart.
10. Click OK.

When your chart is inserted, it may cover a portion of the report. Move and resize the chart so that it fits properly 
within the report.

1.7.1.2.9.1.5.2  Charting on Cross-Tab summaries

SAP Crystal Reports allows you to include a chart based on summary values in your Cross-Tab report. For 
example, with a Cross-Tab that shows the amount of a certain product sold in each region of the United States, 
you may want to include a chart showing the percentage of total sales provided by each region for that product.

To create a Cross-Tab chart, you must first have a Cross-Tab in your report. For information about how to create 
a Cross-Tab, see Creating Cross-Tabs [page 634].

Related Information

Chart Types [page 624]
Chart Layouts [page 624]

1.7.1.2.9.1.5.2.1  To chart on a Cross-Tab summary

1. Right-click in the embedded SAP Crystal Reports Designer, point to Insert and click Chart.
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2. On the Type tab, select the Chart Types [page 624], and click the chart subtype that best illustrates your data.
3. Select Automatically set chart options if you want the Chart Expert to use default options on the Axes and 

Options tabs.
4. Click the Data tab.
5. In the Placement area, specify how often your chart appears on the report, then click Header or Footer to 

specify where to place your chart.
6. In the Layout area, click Cross-Tab, if it is not already selected.
7. In the Data area, in the On change of list, click the group field you want to base your chart on.
8. If necessary, in the Subdivided by list, click a secondary row or column you want to base your chart on.
9. In the Show list, click the summary field you want to display on your chart.
10. If the Axes and Options tabs appear, you can customize some of the properties, such as scaling of the axes, 

the legend, and the data points.
11. Click the Text tab. Accept the default title information or add new titles to your chart.
12. Click OK.

When your chart is inserted, it may cover a portion of the report. Move and resize the chart so that it fits properly 
within the report.

1.7.1.2.9.1.5.3  Charting on Details or Formula Fields

The Advanced layout allows you to create a chart based on specific values. Since charts are a good way to display 
summarized information, they are often based on a summary field in your report. With an Advanced layout, you 
can create a chart without the need for a summary field by using values that appear in the Details section of your 
report.

To create a chart based on the Advanced layout, you must specify two things:

Conditions (there 
can be two)

The condition is used to indicate when to plot the point. For example, a chart showing last 
year’s sales for your customers uses the Customer Name field as the condition. Each time 
the condition changes (the customer name changes), a point is plotted.

You also have the option of plotting a point for each record, or plotting one point for all 
records.

Values (there can 
be multiple values)

The Advanced chart uses the value to indicate what information is plotted as the points on 
your chart. For example, to create a chart showing last year’s sales for your customers, the 
Last Year’s Sales field would be the value.

Related Information

Chart Types [page 624]
Chart Layouts [page 624]
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1.7.1.2.9.1.5.3.1  To chart on a details or formula field

1. Right-click in the embedded SAP Crystal Reports Designer, point to Insert and click Chart.
2. On the Type tab, select the Chart Types [page 624], and click the chart subtype that best illustrates your data.
3. Select Automatically set chart options if you want the Chart Expert to use default options on the Axes and 

Options tabs.
4. Click the Data tab.
5. In the Placement area, specify how often your chart appears on the report, then click Header or Footer to 

specify where to place your chart.
6. In the Layout area, click Advanced, if it is not already selected.
7. In the Data area, specify the database fields you want to use as conditions.

You can select On Change of from the list, then add up to two database fields in the box underneath the list.
8. Add the database fields you want to use as values to the Show value(s) list.
9. If you do not want the embedded SAP Crystal Reports Designer to automatically summarize the chart values 

for a formula field, select the Don't summarize check box.
10. If the Axes and Options tabs appear, you can customize some of the properties, such as scaling of the axes, 

the legend, and the data points.
11. Click the Text tab. Accept the default title information or add new titles to your chart.
12. Click OK.

When your chart is inserted, it may cover a portion of the report. Move and resize the chart so that it fits properly 
within the report.

1.7.1.2.9.1.6  Working with Charts

Once you have created a chart, you may want to add a new title, headings, or a legend, change fonts, or even 
change the type of chart. The embedded SAP Crystal Reports Designer provides many options for working with 
your existing charts.

1.7.1.2.9.1.6.1  Editing Charts Using the Chart Expert

Editing charts with the Chart Expert allows you to return to the expert in which you designed your chart. You can 
modify many of your original choices, such as the type of chart to display and the data on which the chart is 
based.

Related Information

Editing Charts Using the Chart Options Menu Items [page 630]
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1.7.1.2.9.1.6.1.1  To edit a chart using the Chart Expert

1. Right-click the chart to bring up the shortcut menu.
2. On the shortcut menu, click Chart Expert.
3. In the Chart Expert dialog box, make the desired change.
4. Click OK.

1.7.1.2.9.1.6.2  Editing Charts Using the Chart Options Menu 
Items

Some of the editing options available in the Chart Expert are also available directly from the Chart Options menu. 
This menu, which is available when you right-click a chart, contains three dialog boxes with advanced formatting 
options.

Choose a Chart 
Type Dialog Box

Use the Choose a Chart Type dialog box to change the chart type and chart layout, or 
apply a custom template. This dialog box appears when you right-click on a chart, point to 
Chart Options, and click Template.

Chart Options 
Dialog Box

Use the Chart Options dialog box to change the general format, layout, and look of a chart. This 
dialog box appears when you right-click a chart in a report, point to Chart Options and click 
General.

Titles Dialog 
Box

Use the Titles dialog box to add, change, or delete a Title, Subtitle, Footnote, Group Title, Data 
Axis Title, Data2 Axis Title, and a Series Axis title in your chart. This dialog box appears when 
you right-click a chart, point to Chart Options, and select Titles.

Related Information

Editing Charts Using the Chart Expert [page 629]
Formatting Charts [page 630]

1.7.1.2.9.1.6.3  Formatting Charts

Use the Format Editor to change the appearance of the chart. This dialog box appears when you right-click on a 
chart and click Format Object.

Common Tab Use this tab to set properties like object name, suppress, horizontal alignment, and keep object 
together, for the chart.

Border Tab Use this tab to format the borders, background fill, and drop shadows for the chart.
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Hyperlink Tab Use this tab to create a hyperlink to a Web site, a field value, an e-mail address, a file, or another 
SAP Crystal Reports file.

Related Information

Format Editor Dialog Box [page 762]

1.7.1.2.9.1.6.4  Using the Underlay Feature with Charts

Since charts can print only in certain sections of your report, the underlay feature gives you more control in the 
overall look of your report. Instead of having a chart print ahead of the data it represents, it can appear next to the 
data for a more comprehensible report.

Related Information

Section Expert [page 841]

1.7.1.2.9.1.6.4.1  To underlay a chart

1. Create your chart and place it in the Report Header section.
For information on how to create a chart, see Creating Charts [page 626].

2. From the Crystal Reports menu, point to Report, and click Section Expert.
The Section Expert dialog box appears.

3. In the Sections area, click Report Header, then select the Underlay Following Sections check box.
4. Click OK.
5. Click the Preview tab to view your work.

Your chart will now underlay the sections below it.
6. If necessary, return to the design mode to move or resize the chart.

1.7.1.2.9.2  Inserting Subreports

Explains how to add hyperlinks to other reports or report data.

A subreport is a report within a report. With subreports, unrelated reports can be combined into a single report. 
You can coordinate data that could not otherwise be linked, or you can present different views of the same data in 
a single report.
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If your report has a section that handles a large number of records, you can put that section into an on-demand 
subreport. An on-demand subreport appears as a hyperlink in the primary report. When you open the primary 
report, no data is retrieved for the on-demand subreport until you drill down on the hyperlink.

Tip
Whenever possible, coordinate your report data by linking database tables with the Visual Linking Expert, 
rather than by linking regular subreports — that is, subreports that aren't on-demand subreports — to the main 
report. Since each subreport is run as a separate report, linked tables often have a performance advantage.

1.7.1.2.9.2.1  To insert a subreport 

1. Right-click in the embedded Crystal Reports Designer, point to Insert, and click Subreport.
2. Drag the subreport object onto the report.
3. Choose a report in your project, another existing report, or create a new report for the subreport.
4. Choose On-demand subreport to have the ability to retrieve the data on the subreport when needed. 

Otherwise, all subreport data will appear with the report.

Note
Using on-demand subreports will increase the performance of reports that contains subreports.

5. Click the Link tab if you need to link a subreport to the data in the main report.
6. Select the field you want used as a link field in the primary (containing) report from the Available Fields list, 

and add it to the Field(s) to link to list.
7. Use the field link section (which will appear only if you have selected a link field) to set up the link for each link 

field:
a. Select the field you want linked to the primary report from the Subreport parameter field to use
b. Select the Select data in subreport based on field check box on and select a field from the adjacent drop-

down list to organize the subreport data based on a specific field (this is the quick equivalent of using the 
Select Expert). If nothing is specified here, the subreport will adopt the organization of the primary report.

8. Click OK.

When you run the report, the program will coordinate the data in the primary report with the data in the subreport.

Note
The field type of the Containing Report field determines which subreport fields are visible. Because the 
embedded SAP Crystal Reports Designer reads dates as either strings, dates, or date/time fields, you must 
make sure your subreport parameter field type matches the field type set up in Report Options in the main 
report for the field you want linked.

Related Information

Unlinked vs. Linked Subreports [page 633]
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1.7.1.2.9.2.2  Unlinked vs. Linked Subreports

Unlinked Subreports

Unlinked subreports are free-standing; their data is not in any way coordinated with the data of the primary 
report.

In unlinked subreports, there is no attempt to match up the records in one report with records in the other. An 
unlinked subreport does not have to use the same data as the primary report; it can use the same data source or a 
different data source entirely. In addition, the subreport is not limited to reporting on a single table. An unlinked 
subreport can be based on a single table or on multiple tables. Regardless of the underlying data sources, the 
reports are treated as unrelated.

Linked Subreport

Linked subreports are just the opposite; their data is coordinated. The program matches up the records in the 
subreport with records in the primary report. If you create a primary report with customer information and a 
subreport with order information and link them, the program creates a subreport for each customer and includes 
in that subreport all the orders for that customer.

How Subreport Linking Works

When you link a subreport to a primary report, the program creates the link by using a parameter field.

When a subreport link field is selected, the program creates:

● a parameter field in the subreport which is then used to retrieve values passed to it by the primary report.
● a record selection formula for the subreport using the parameter field.

The selection formula limits the subreport to those records in which the link field is equal to the parameter 
field value.

When the report is run, the program finds the first primary field record it needs and passes the value in the link 
field to the parameter field in the subreport. The program then creates the subreport with record selection based 
on the parameter field value. Here is an example:

● You create a report that shows customer data and a subreport that shows order data and then you link the 
two reports using the Customer ID field.

● When you run the report, the program finds the first customer record it needs and passes the Customer ID 
value from that record to the subreport parameter field.

● The program runs the Orders subreport. Since the subreport selection formula selects only those records in 
which the Customer ID value is equal to the parameter field value, and since that parameter field value is 
equal to the Customer ID in the first record in the primary report, the subreport contains only those records 
that have the same customer ID. Namely, those records that are orders for the first customer.

● When the subreport is finished, the program locates the second record it needs in the primary report, prints 
the customer data, and then passes this customer's ID number to the parameter field.
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● The program then runs a subreport including only those order records for the second customer.
● The process continues until the report is finished.
● All of this parameter field manipulation takes place behind the scenes. You simply pick the fields that will link 

the primary report with the subreport and the program does the rest. The values are passed without the 
parameter field prompting you for a value.

1.7.1.2.9.3  Cross-Tab Objects

Explains how to add Cross-Tab grid objects to organize data in your report.

A cross-tab object is a grid that returns values based on criteria you specify. Data is presented in compact rows 
and columns. This format enables users to compare data and identify trends.

A cross-tab object is made up of three elements:

● Rows
● Columns
● Summary fields

1.7.1.2.9.3.1  Creating Cross-Tabs

You can create a Cross-Tab object in a new report or add a Cross-Tab object to an existing report. The following is 
a list of things to keep in mind when using Cross-Tab objects:

● You can have multiple rows, columns, and summarized fields.
● You can use print-time formulas as your rows or columns.
● You can use Running Total fields as your summarized field.
● You can include a group sort (top or bottom N) on the rows in your Cross-Tab.
● Group sorting cannot be applied to columns.
● You can insert as many Cross-Tab objects in a report as you need.
● You can insert the Cross-Tab into either the Report Header or Footer, or the Group Header or Footer.
● You can place Cross-Tab objects in subreports. This is useful when you want to refer to the results from 

another report.
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1.7.1.2.9.3.1.1  Creating a New Cross-Tab Report

The embedded SAP Crystal Reports Designer provides Cross-Tab Report Creation Wizard [page 543] to guide 
you through the creation of a Cross-Tab report.

Related Information

Report Section Overview [page 534]

1.7.1.2.9.3.1.1.1  To create a New Cross-Tab report

1. In Solution Explorer, right-click the project name in bold type, point to Add, and then click New Item.
2. In the Add New Item dialog box, in the Templates view, select the template Crystal Report.
3. In the Name field, enter a desired name, and Click Add.
4. In the Create New Crystal Report Document panel of the Crystal Reports Gallery dialog box, select Using the 

Report Wizard.
5. In the Choose an Expert list, select Cross-Tab, and click OK.

The Cross-Tab Report Creation Wizard appears.
6. On the Data screen, locate the data source you want to use, add the desired tables to the Selected Tables 

area, and click Next.
The Link screen appears.

7. Modify the links if it is necessary, and click Next.
The Cross-Tab screen appears

8. Add fields to the Rows, Columns, and Summary Fields areas, select the summary operation you want to 
perform from the list beneath the Summary Fields area, and click Next.
The Chart screen appears.

9. Select the chart type, change the default charting information to suit your report, and click Next.
The Record Selection screen appears.

10. Use this screen to apply selection conditions, and click Next.
The Grid Style screen appears.

11. Select a predefined style, and click Finish.
The Cross-Tab report is created and loaded into the main window of Visual Studio.

1.7.1.2.9.3.1.2  Adding a Cross-Tab to an Existing Report 

1. Right-click in the embedded SAP Crystal Reports Designer, point to Insert and click Cross-Tab.
2. Place the Cross-Tab object in your report.
3. In the Cross-Tab Expert dialog box, add fields to the Rows, Columns, and Summarized Field areas.
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4. Click the Style tab to select a cross-tab design, or click the Customize Style tab to create your own cross-tab 
design.

Related Information

Report Section Overview [page 534]
Cross-Tab Expert Dialog Box [page 829]

1.7.1.2.9.3.2  Working with Cross-Tabs

This section describes ways you can work with a Cross-Tab once you’ve added it to your report.

1.7.1.2.9.3.2.1  Showing Values as Percentages

1. In the embedded SAP Crystal Reports Designer, right-click a summarized field in the Cross-Tab.
2. Click Change Summary Operation from the shortcut menu.

The Edit Summary dialog box appears.
3. Select the Show as a Percentage of check box.
4. For From, choose Row or Column depending on whether you want your percentage values to be calculated 

horizontally (row) or vertically (column).
5. Click OK, and click Main Report Preview to review the change.

Summarized field values are now displayed as percentages on your Cross-Tab.

Related Information

Edit Summary Dialog Box [page 756]

1.7.1.2.9.3.2.2  Using Running Totals in Cross-Tabs

Running Total fields can be useful as summary fields in Cross-Tab objects. Create your Cross-Tab, but choose a 
running total field as your Summary Field.

Note
You cannot use Running Total fields as columns or rows in a Cross-Tab.
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If you add a Group Sort (top or bottom N sort) based on a Running Total field, the sort is carried out on the 
running total values as shown in the Cross-Tab's Row/Column Total areas-it is not based on the summary field's 
totals. Also, in this case, the running total results appear correctly only in the total data and not in the cell data.

Related Information

Creating Running Totals [page 593]
Sorting Data [page 588]

1.7.1.2.9.3.2.2.1  To total down columns

If you want a running total that totals down the Cross-Tab's columns, you must sort the records in the Cross-Tab 
by Column and then Row.

1. Right-click the embedded SAP Crystal Reports Designer, point to Report, and select Record Sort Expert.
2. Sort your Cross-Tab by the field you designated as a Column in the Cross-Tab Expert.
3. Create a second sort on the field you designated as a Row in the Cross-Tab Expert.

1.7.1.2.9.3.2.2.2  To total across rows

If you want a running total that totals across the Cross-Tab's rows, you must sort the records in the Cross-Tab by 
Row and then Column.

1. Right-click the embedded SAP Crystal Reports Designer, point to Report, and select Record Sort Expert.
2. Sort your Cross-Tab by the field you designated as a Row in the Cross-Tab Expert.
3. Create a second sort on the field you designated as a Column in the Cross-Tab Expert.

1.7.1.2.9.3.2.3  Printing Cross-Tabs that Span Multiple Pages

When you create a Cross-Tab that is wider or longer than the specified page size, the program automatically 
spans the printing across enough pages to accommodate the size of the Cross-Tab. For ease in reading, column 
headings will be repeated on subsequent pages. Row headings can also be repeated using the Keep Columns 
Together option.

1.7.1.2.9.3.2.3.1  To repeat row labels

1. In the embedded SAP Crystal Reports Designer, right-click the blank top-left area of the Cross-Tab.
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2. Select Cross-Tab Expert from the shortcut menu.
3. In the Cross-Tab Expert, click the Customize Style tab, select the Repeat Row Labels check box.
4. Select the Keep Columns Together check box, if it is not already selected.
5. Click Main Report Preview to review your work.

1.7.1.2.9.3.3  Formatting Cross-Tabs

SAP Crystal Reports has powerful formatting capabilities that can be applied to Cross-Tabs.

To emphasize important data and create professional-looking, easy-to-understand Cross-Tabs, you can use the 
Format Editor to apply such formatting as background color, borders, and fonts. To access the Format Editor, 
right-click the Cross-Tab and, on the shortcut menu, click Format Editor.

You can also use the Highlighting Expert to apply conditional formatting to Cross-Tab cells. To access the 
Highlighting Expert, right-click the cell you want to format and, on the shortcut menu, click Highlighting Expert. 
For more details, see Highlighting Expert Dialog Box [page 840].

1.7.1.2.9.3.3.1  Formatting Fields

1. Right-click the field you want to format and choose Format Field from the shortcut menu.
If you need to format several fields, use the Shift-click method to highlight the desired fields, right-click any 
one of them, and choose Format Multiple Objects from the shortcut menu.
The Format Editor appears.

2. In the Format Editor, make font, background, borders, numbering, currency symbols, and printing 
characteristics choices.

3. Click OK to return to the Cross-Tab.
The field is formatted as specified.

1.7.1.2.9.3.3.2  Changing Width, Height, and Alignment of 
Cross-Tab Cells

1. Click a cell within the Cross-Tab to activate the sizing handles.
2. Click and drag one of the sizing handles to expand the width or height of the cell.
3. Click an alignment option on the Crystal Report - Main toolbar to change the alignment of the data in the cell.

Note
Changing one cell affects all like cells. For example, changing the width of one summary field cell changes 
all other summary field cells at the same time.
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1.7.1.2.9.3.3.3  Formatting Background Color of Entire Rows or 
Columns

Use background colors to emphasize rows or columns within your Cross-Tab.

1. Right-click the blank top-left area of the Cross-Tab and select Cross-Tab Expert from the shortcut menu.
The Cross-Tab Expert appears.

2. Click the Customize Style tab.
3. Click the row (in the Rows area) or column (in the Columns area), and select a color from the Background 

Color drop-down list.
4. Click OK to return to the Cross-Tab.

The row or column is formatted as specified.

1.7.1.2.9.3.3.4  Suppressing Cross-Tab Data

This section provides you with the steps required to suppress data in your report. You can suppress:

● Empty rows and columns.
● Row and column grand totals.
● Subtotals and their labels.

1.7.1.2.9.3.3.4.1  To suppress empty rows and columns

1. Right-click the blank top-left area of the Cross-Tab and select Cross-Tab Expert from the shortcut menu.
The Cross-Tab Expert appears.

2. Click the Customize Style tab.
3. Select either the Suppress Empty Rows or Suppress Empty Columns check box.
4. Click OK.

Now, when you print the report, empty rows and/or columns will not appear.

1.7.1.2.9.3.3.4.2  To suppress row and column grand totals

1. Right-click the blank top-left area of the Cross-Tab and select Cross-Tab Expert from the shortcut menu.
The Cross-Tab Expert appears.

2. Click the Customize Style tab.
3. Select either the Suppress Row Grand Totals or Suppress Column Grand Totals check box.
4. Click OK.
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1.7.1.2.9.3.3.4.3  To suppress subtotals and their labels

If you have more than two groups in your Cross-Tab you can suppress the subtotal and label for one of them.

1. Right-click the blank top-left area of the Cross-Tab and select Cross-Tab Expert from the shortcut menu.
The Cross-Tab Expert appears.

2. Click the Customize Style tab.
3. Click the field whose subtotal you want to suppress.

The suppress Subtotal and the Suppress Label check boxes become active.
4. In the Group Options area, select the Suppress Subtotal check box.
5. Click the Suppress Label check box to suppress the label associated with subtotal, and click OK.

1.7.1.2.9.3.3.5  Displaying Summarized Fields Horizontally

If you have two or more summarized fields in your Cross-Tab, you can display their values horizontally instead of 
vertically (the default).

1. Right-click the blank top-left area of the Cross-Tab and select Cross-Tab Expert from the shortcut menu.

The Cross-Tab Expert appears.
2. Click the Customize Style tab.
3. In the Summarized Fields area, select Horizontal.
4. Click the Show Labels check box if you want to display labels for the summarized fields.

Labels are displayed in the direction you chose for the summarized fields.
5. Click OK.

1.7.1.2.9.4  Inserting Underlaying Images

Explains how to underlay objects next to or underneath (instead of above) objects placed in the proceeding report 
section.

Underlaying objects placed in report section appear next to or underneath objects placed in the following report 
section.

Note
The underlay feature works by report section. All objects in that section will underlay the following section.

You can use the underlay feature to format reports for pre-printed forms, or to insert a chart or an employee 
picture to print beside the details pertaining to the chart or employee.

If you print on pre-printed forms, you will be able to:

● scan a form.
● place it in the report as a bitmap.
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● use the underlay feature to line up the bitmap and report, as well as move objects anywhere you want them to 
appear.

● eliminate the need to print the forms separately by printing the report and the form as a single unit.

1.7.1.2.9.4.1  To underlay report objects

1. Add the objects you want to underlay to a report section.
2. Right-click the report section and select Section Expert.
3. Select the Underlay Following Sections check box.
4. Click OK.
5. Resize the object vertically if you want it to underlay more sections.

The area in which the object underlays depends on the following conditions:
○ size of the object.
○ section in which the object was originally placed.
○ position of the object in the section.

1.7.1.2.9.5  Hiding Report Sections

Explains how to hide or drill down on report information.

SAP Crystal Reports has three properties you can set to hide report sections.

● Hide (Drill-Down OK)
● Suppress (No Drill-Down)
● Suppress Blank Section

1.7.1.2.9.5.1  To hide a section

The Hide property hides a section whenever you run the report. For example, in a summary report, the Hide 
property can be used to display only the summaries, but not the details behind the summaries. When the Hide 
property is applied to a section, it becomes visible when the Drill-down cursor is used to drill down on the section 
contents. This property is absolute; it cannot be conditionally applied using a formula.

Right-click the report section and select Hide (Drill-Down OK).

1.7.1.2.9.5.2  To suppress a section

The Suppress property also hides a section when you run the report. Unlike the Hide property, however, you 
cannot apply the Suppress property, then drill down to reveal the section contents. This property can be applied 
absolutely, or conditionally using a formula. This is useful for writing form letters. For example, in a form letter, 
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you might create two Details sections: one to suppress when sales are over $X and one to suppress when sales 
are under $X.

Right-click the report section and select Suppress (No Drill-Down).

1.7.1.2.9.5.3  To suppress a blank section

The Suppress Blank Section property hides a section whenever there is nothing in it. If something is placed within 
the section, then it becomes visible.

Right-click the report section and select Format Section. In the Section Expert, click the Suppress Blank Section 
check box.

1.7.1.2.9.6  Aligning and Resizing Objects

The layout toolbar allows you to align or resize multiple objects at the same time. Click an object to select it and 
then Shift-Click or Ctrl-Click to select further objects. Once you have selected the objects that you want to align or 
resize, click a button on the toolbar to align or resize the objects.

The buttons on the layout toolbar perform the following functions:

Use the Align To Grid button to align the selected objects with the grid.

Use the Align Lefts button to align the left of the selected objects with the left of the last object selected.

Use the Align Centers button to align the center of the selected objects with the center of the last object 
selected.

Use the Align Rights button to align the right of the selected objects with the right of the last object 
selected.

Use the Align Tops button to align the tops of the selected objects with the top of the last object 
selected.

Use the Align Middles button to align the (vertical) middles of the selected objects with the (vertical) 
middle of the last object selected.

Use the Align Bottoms button to align the bottoms of the selected objects with the bottom of the last 
object selected.

Resizes the selected objects to the same width as the last object you selected.

Resizes the selected objects to the same height as the last object you selected.

Resizes the selected objects to the same height as the last object you selected.
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Tip
You can access each of these items through a right-click menu in the embedded designer. Select two or more 
objects and right-click one of the objects to access the Align or Size menus.

1.7.1.3 Customizing Existing Reports

Describes how to import reports that use non-Crystal formats, contain unsupported drivers, or were created with 
an older version of SAP Crystal Reports.

This section offers guidelines on how to access, view, and update older versions of Crystal reports.

1.7.1.3.1 Importing Earlier Versions of SAP Crystal Reports

Earlier versions of Crystal reports (.rpt files) retain their functionality when opened in later versions of the SAP 
Crystal Reports designer. However, the following limitations apply when opening a report in SAP Crystal Reports, 
developer version for Microsoft Visual Studio:

Maps Map objects are not supported in SAP Crystal Reports, developer version for Microsoft 
Visual Studio. Map objects will appear blank in the report.

OLAP Grids OLAP grid objects are not supported in SAP Crystal Reports, developer version for 
Microsoft Visual Studio. Reports designed with OLAP grids will not open.

Dictionaries, 
InfoViews and QRY 
files

Reports based off of Crystal Dictionaries, InfoViews, and QRY files are not supported in 
SAP Crystal Reports, developer version for Microsoft Visual Studio and will not open.

Saving Reports

Crystal reports created in previous versions of SAP Crystal Reports will be upgraded to the latest version when 
you save the file.

Note
If a report is saved, it can still be opened in previous versions of SAP Crystal Reports. However, new features or 
functionality will not be available.

1.7.1.3.2 Working with Reports using Unsupported Drivers

SAP Crystal Reports can use reports that are based off of unsupported database drivers. If the report contains 
saved data you will be able to export, print or view the report, however the output will contain the static data saved 
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in the report. If there is either no data in the report or if the report is refreshed a Query Engine Error message will 
be displayed. To prevent an error message from occurring you can either disable the ability of refreshing the 
report (for reports with saved data) or you can set the location to a supported data source.

1.7.1.4 Optimizing Report Performance

Suggests ways to increase the performance speed of reports.

This section suggests ways to enhance reports so they take advantage of performance enhancements made to 
SAP Crystal Reports. While the suggestions made here are especially important for optimizing the performance of 
reports distributed over the thin-wire environment of the Web, the majority of the guidelines and procedures are 
applicable to all of your reports.

Related Information

Scaling your Application [page 58]

1.7.1.4.1 Scale with SAP BusinessObjects Enterprise

SAP BusinessObjects Enterprise extends the value and scalability of SAP Crystal Reports. It provides a flexible, 
managed reporting solution. It gives you the ability to deliver the report-design power of SAP Crystal Reports, 
atop a scalable, Web-based infrastructure for managing a central report repository, user security, and report 
scheduling and processing.

Using Visual Studio .NET, you can build applications that can access SAP BusinessObjects Business Intelligence 
platform servers. This enables you to build a small client that you can distribute to thousands of users and use the 
SAP BusinessObjects Business Intelligence platform servers to handle report management, processing, and 
scheduling.

Related Information

SAP BusinessObjects Business Intelligence reporting solutions [page 59]
Comparing Architectures Across SAP Business Intelligence Reporting Solutions [page 38]
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1.7.1.4.2 Off-Loading Record Selection to the Database 
Server

The most important thing you can do to speed up report processing is to limit the amount of data that is returned 
from the database. Your primary tool for doing this is the record selection formula.

SAP Crystal Reports analyzes your record selection formula and generates an SQL query from it. This SQL query 
is then processed by the database, which sends the resulting records back to SAP Crystal Reports. SAP Crystal 
Reports then evaluates the record selection formula locally for each of the records retrieved from the database, 
thereby calculating the set of records used to generate the report.

Unnecessary records are eliminated at two stages: at the database with the SQL query and within SAP Crystal 
Reports by the record selection formula. For speed, you want as many records as possible to be eliminated in the 
first stage. By designing your record selection formula effectively, you can off-load much of the processing to the 
database server, thus eliminating unnecessary records before returning them to SAP Crystal Reports. This is 
commonly called Pushing Down Record Selection to the Database Server [page 569].

Parameter Fields

Instead of displaying all of a report's data every time the report is opened, you can create parameter fields that 
prompt users to specify the data they want to see. To decrease the amount of data transferred from the database 
server, incorporate these parameter fields right into your record selection formula.

In general, parameter fields provide interactivity for users, who respond to the parameter prompts in order to 
specify the data they want to see. However, by incorporating your parameter fields right into your record selection 
formula, you not only provide interactivity, but you also decrease data transfer and increase performance.

You can add a parameter field to your record selection formula by using the Select Expert or the Record Selection 
Formula Editor. When using the Record Selection Formula Editor, you treat the parameter field as you would any 
other field. See Incorporating Parameters into Formulas [page 581].

SQL Expression Fields

To maintain optimum report processing speeds, avoid using formulas (whether Crystal or Basic syntax) within 
record selection formulas. Instead, replace the original formula with an equivalent SQL Expression field, and then 
incorporate the SQL Expression field into your record selection formula. Doing so will greatly improve the chances 
of your record selection being pushed down to the server.

In addition, you should avoid sorting, grouping, or totaling on a formula field (whether Crystal or Basic syntax). 
Instead, replace the original formula field with an equivalent SQL Expression field, and then sort, group, or total on 
the SQL Expression Field. Again, this will greatly improve the chances of the processing being done on the server.

Finally, if your database supports Case Logic, and your report needs to summarize an If-Then-Else formula 
calculation, replace the formula with an SQL Expression field. In such cases, SQL Expression fields enable SAP 
Crystal Reports to perform the report's grouping on the server. See SQL Expressions [page 608].
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Related Information

SQL Expressions [page 608]

1.7.1.4.3 Design Choices to Optimize Performance

When designing your reports, and especially when designing reports for the Web, you should allow report users to 
drive the data they see. In other words, display summarized information so each user can navigate the report 
quickly and then drill down to access additional data. In this way, Web traffic and response times are minimized, 
because only the data requested by the user is transferred from the database server.

These are only a few of the benefits of designing user-driven reports:

● Report users gain interactive control over the type and quantity of information they view over the Web.
● Data transfer and network traffic decrease, because only the information requested by users is returned from 

the database server.
● When users need real-time reporting of live data over the Web, user-oriented reports respond quickly and 

communicate efficiently with the database server.
● Reports become more useful, because each user customizes the report's contents, thereby creating a 

reporting solution specific to his or her particular decision-making problem.

Summary Reports

Designing and distributing summary reports is a relatively easy way to ensure that users quickly find the data they 
need over the Web. A summary report can include as much data as any other report. However, by hiding a 
summary report's Details section, you avoid overwhelming users with data they may not immediately need.

When the Details section is hidden, users navigate with the Group tree first, to locate the desired data. Then, by 
drilling down on the report, they can request specific data, which is returned quickly without unnecessary records. 
This is especially important for improving navigation of long summary reports, which might consist of hundreds, 
thousands, or even tens of thousands of pages.

On-Demand Subreports

If your report has a section that handles a large number of records, you can put that section into an on-demand 
subreport. An on-demand subreport appears as a hyperlink in the primary report. When you open the primary 
report, no data is retrieved for the on-demand subreport until you drill down on the hyperlink.

For example, when designing a report that shows each employee's quarterly sales for each product and each 
product type, you might also want to track each employee's progress by including weekly sales information. This 
additional data, however, may not be of interest to many users viewing the report. In such a case, extract the 
weekly sales portion of the report and attach it as an on-demand subreport. Detailed information about weekly 
sales is retrieved from the database only when a user drills down on the on-demand subreport.
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Many report objects — such as large cross-tabs and advanced charts — are ideal candidates to include in on-
demand subreports, so that the object is not processed until you drill down.

You could also place such report objects in a hidden Details section of a report that uses the Perform Grouping On 
Server option. When you do this, the database server performs the majority of the processing, and only a subset 
of the records is transferred from the server to the local machine.

Linking Tables instead of Linking Subreports

Whenever possible, coordinate your report data by linking database tables with the Visual Linking Expert, rather 
than by linking regular subreports — that is, subreports that aren't on-demand subreports — to the main report. 
Since each subreport is run as a separate report, linked tables often have a performance advantage.

Related Information

Hiding Details in Summary Reports [page 587]
Inserting Subreports [page 631]
Linking Database Tables [page 554]

1.7.2  Formula Reference

When creating formulas, you have the option of using either Crystal or Basic syntax. Almost any formula written 
with one syntax can be written with the other. Reports can contain formulas that use Basic syntax as well as 
formulas that use Crystal syntax, but a single formula can use only one syntax.

If you are familiar with Microsoft Visual Basic or other versions of Basic, then Basic syntax may be more familiar to 
you. In general, Basic syntax is similar to Visual Basic except that it has specific extensions to handle reporting.

For descriptions and examples of individual functions and operators, see the SAP Crystal Reports User's Guide.

1.7.2.1 Basic Syntax

When creating formulas, you have the option of using either Crystal or Basic syntax. If you are familiar with 
Microsoft Visual Basic or other versions of Basic, then Basic syntax may be more familiar to you. In general, Basic 
syntax is similar to Visual Basic except that it has specific extensions to handle reporting.

Using Basic syntax does not slow report processing down. Reports using Basic syntax formulas can run on any 
machine that SAP Crystal Reports runs on. Also, using Basic syntax formulas does not require distributing any 
additional files with your reports.
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1.7.2.1.1 Basic Syntax Fundamentals

Familiar Features

● Many Basic syntax functions work in the same way as their counterparts in Visual Basic. This includes string 
functions such as Len, Mid and Filter, math functions such as Abs, Rnd and Sin, financial functions such as 
PV, programming shortcut functions such as IIF, and date functions such as DateSerial, DateAdd and 
DateDiff.

● Most operators supported by Visual Basic are also in Basic syntax. For example, string concatenation (&) and 
date-time literals (#...#).

● Most statements and control structures use the same syntax as in Visual Basic. This includes the If, Select, Do 
While, Do Until, While and For/Next statements.

● Basic style comments and line continuation characters are supported, as is the Basic language use of new 
lines, colons, and the equal sign.

The Result of a Formula

The result of a formula, or the value that is printed when the formula is placed in a report, is called the value 
returned by the formula. Every formula in SAP Crystal Reports must return a value. Basic syntax does this by 
setting the value of the special variable "formula". For example, here is a simple Basic syntax formula that returns 
the value 10:

 formula = 10 

The value returned by a formula can be one of the seven simple data types supported: Number, Currency, String, 
Boolean, Date, Time and DateTime. SAP Crystal Reports also supports range types and array types, but these 
cannot be returned by a formula.

The variable that is named formula must be assigned a value

If the variable that is named formula is not assigned a value, it is not a complete Basic syntax formula.

Sometimes you may want to write a formula that just declares and initializes some global variables. These 
formulas are commonly inserted into the report header section of a report. In such cases, assign any value to the 
special variable that is named formula. Every formula must return a value, even if you are not interested in using 
that value.

Example

  Rem Some Global variable declarations.  Rem Remember to set the value of 'formula'. Global x As String, y As Number, z As DateTime
x = "hello"
y = 10.5
z = #Aug 6, 1976#
formula = 10 
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Data Types and the Variable that is named Formula

The variable that is named formula can be set several times within a single formula. For example, suppose a 
company has a shipping policy in which orders over $1,000 are insured, but orders below that amount are not 
insured:

  Rem A formula that returns a String value If {Orders.Order Amount} >= 1000 Then    formula = "Insured shipping" Else    formula = "Regular shipping" End If 

The above variable that is named formula returns the text string value "Insured shipping" if the value of the 
database field {Orders.Order Amount} is greater than or equal to 1000; otherwise, it returns the text string value 
"Regular Shipping." Notice that this variable appears twice in the above example.

If the variable that is named formula is set to a value of one type, it cannot be set to a value of another type later in 
the same formula. For example, replacing the String "Regular Shipping" in the above example with the Number 10 
would result in an error since the special variable formula was first set to the String value "Insured shipping."

The reason for this restriction is that SAP Crystal Reports needs to know in advance what the return type of a 
formula will be so that it can allocate enough storage for the returned values. This is because different types have 
different storage requirements. Another reason is that the formatting options available for a formula field depend 
on its type. For example, a Number field has Number formatting options, such as the number of decimals to 
display, which do not make sense for a String field.

Note
The special variable that is named formula should not be declared, unlike other variables used in a Basic syntax 
formula.

Case Sensitivity

Basic syntax is not case-sensitive. What this means is that "formula", "Formula" and "FORMULA" are all 
considered to be the same. This is true of all variable names, functions, and keywords used in a Basic syntax 
formula.

Note
The only exception to this rule is for strings. The string "Hello" is not the same as the string "hello".

1.7.2.1.1.1  Comparing Basic Syntax Formulas with Functions in 
Visual Basic

The use of the formula variable is similar to writing a function named formula in Visual Basic.
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Consider the following Basic syntax formula:

  Rem A formula that returns a String value.  Rem The function Rnd returns a random number between 0 and 1. Rem between 0 and 1
If Rnd > 0.9 Then    formula = "You won!" Else    formula = "Sorry, try again." End If 

The above formula returns the text string value "You won!" if the random number returned by Rnd is greater than 
0.9 and the text string value "Sorry, try again." otherwise.

The above formula could be written as a Visual Basic function as follows:

  Rem The following code is in Visual Basic. Function formula()
    If Rnd > 0.9 Then        formula = "You won!"     Else        formula = "Sorry, try again."     End If
End Function 

1.7.2.1.2 Comments (Basic Syntax)

Formula comments are notes included with a formula to explain its design and operation. Comments do not print 
and they do not affect the formula; they appear only in the Formula Editor. Use comments to explain the purpose 
of a formula or explain the steps involved in writing it.

Comments work as in Visual Basic. Begin comments with a Rem or an apostrophe.

Note
A comment beginning with Rem is a separate statement and must either start on a new line or be separated 
from the previous statement by a colon.

  Rem This is a comment.  Rem This is another comment.  formula = 10 'So is any text after an apostrophe.  formula = 20 : Rem This is also a comment.  'Comments can occur after the formula text.  

1.7.2.1.3 Fields (Basic Syntax)

Many of the fields you use when creating your report can also be referred to in your formulas. For example, 
database, parameter, running total, SQL expression, summary, and group name fields can all be used in a 
formula. You can also refer to other formula fields in your formula.

The easiest way to insert a field into your report is to double-click a field's name in the Report Fields tree. This 
ensures that the correct syntax for the field is used.
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How Fields Appear in Formulas

Database, parameter, formula, running total and SQL expression fields have their names surrounded by braces.

Database field names are taken from the database: {Employee.Last Name}

Parameter, formula, running total, and SQL expression field names are specified when the fields are created.

● parameter fields include a question mark: {?my parameter field}
● formula fields include an at sign: {@another formula }
● running totals fields include a pound sign: {#my running total}
● SQL expression fields include a percent sign: {%my SQL expression}

Summary and group name fields look like function calls. However, they are really shorthand notation for a report 
field.

● sum summary field: Sum({Orders.Order Amount}, {Orders.Ship Via})
● group name field: GroupName({Orders.Ship Via})

Example

The formula in this example uses the Xtreme database. To find out how many days it takes to ship the product 
from the date when the order was placed, subtract the ship date database field from the order date database field:

 formula = {Orders.Ship Date} - {Orders.Order Date} 

To find the total dollar amount of a given product that was ordered, multiply its unit price by the quantity ordered:

 formula = {Orders Detail.Unit Price} * _
          {Orders Detail.Quantity} 

Note
The example uses the line continuation character " _ " (space underscore). See Statements (Basic Syntax) 
[page 651].

To calculate a sale price of 80 percent of the original unit price:

 formula = {Orders Detail.Unit Price} * 0.80 

1.7.2.1.4 Statements (Basic Syntax)

A Basic syntax formula consists of a sequence of statements. Each statement must be separated from the 
previous statement by either a new line or a colon. Typically, each statement takes one line, but you can continue 
a statement onto the next line by using the line continuation character, which is a space followed by an 
underscore.

  'Declare a variable x to hold a number. Dim x As Number 'Assign the value of 30 to x. x = 10 + 10 + 10 'This also assigns the value of 30 to x. 
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x = 10 + _
    10 + 10 'Line continuation characters _
 can also be used in comments. Dim y as String 'Three statements separated by two colons.  y = "Hello" : x = 30 : formula = True  

1.7.2.1.5 Assignment (Basic Syntax)

Use the equal sign (=) when making assignments. The keyword Let can be optionally included as well.

Example
 x = 10
Let y = 20 

1.7.2.1.6 Simple Data Types (Basic Syntax)

This section describes the simple data types available in SAP Crystal Reports.

1.7.2.1.6.1  Number (Basic Syntax)

Enter numbers without any comma separators or currency symbols. (Generally, you would want to have 
formatted numbers appearing as the result of a formula and not in the formula itself.)

Examples of numeric values include:

 10000
-20
1.23 

1.7.2.1.6.2  Currency (Basic Syntax)

Use the CCur function to create a Currency value. The initial C in CCur stands for convert and it can be used to 
convert Number values to Currency values.

 CCur (10000)
CCur (-20)
CCur (1.23) 
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1.7.2.1.6.3  String (Basic Syntax)

Strings are used to hold text. The text must be placed between double quotation marks (") and cannot be split 
between lines. If you want to include double quotes in a string, use two consecutive double quotation marks.

 "This is a string."
"123"
"The word ""hello"" is quoted." 

You can extract individual elements or substrings from a string by specifying the character position or a range of 
character positions. Negative values are allowed; they specify the position starting from the end of the string.

 "hello" (2) 'Equal to "e"
"hello" (-5) 'Equal to "h"
"604-555-1234" (1 to 3) 'Equal to "604"
"abcdef" (-3 to -1) 'Equal to "def" 

You can also extract substrings from a string using the Left, Right and Mid functions.

1.7.2.1.6.4  Boolean (Basic Syntax)

The Boolean values are:

 True
False 

Note
Yes can be used instead of True and No instead of False.

1.7.2.1.6.5  Date, Time, and DateTime (Basic Syntax)

The DateTime type can hold date-times, dates only or times only. The Date type holds dates only and the Time 
type holds times only. The Date and Time types are more efficient than the DateTime type, and so can be used in 
situations where the added functionality and flexibility of the DateTime type is not needed.

Visual Basic does not support separate types for holding dates only or times only. The Basic syntax DateTime 
type is similar to Visual Basic's Date type.

You can create DateTime values directly using the date-time literal construction. It is formed by typing in the date-
time between two pound (#) signs. Many different formats are supported, as in Visual Basic.

Note
Date-time literals cannot be split between lines.

Examples
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#8/6/1976 1:20 am#
#August 6, 1976#
#6 Aug 1976 13:20:19#
#6 Aug 1976 1:30:15 pm#
#8/6/1976#
#10:20 am# 

Even though #10:20 am# looks like it could have the Time type and #8/6/1976# looks like it could have the Date 
type, they do not. They both have the DateTime type, as do all date-time literals. For example, you can think of 
#10:20 am# as a DateTime value with a null date part. To convert it to the Time type use CTime (#10:20 am#).

Instead of using date-time literals you can use CDateTime to convert a String to a DateTime. For example,

 CDateTime ("8/6/1976 1:20 am")
CDateTime ("10:20 am") 

However, there is one key difference between using date-time literals and the above usage of CDateTime. Date-
time literals always use U.S. English date formats rather than settings from the locale of the particular computer 
on which SAP Crystal Reports is running. Thus, the date-time literal examples above would work on all computers. 
On the other hand, on a French system, you could use constructions like:

  CDateTime ("22 aout 1997") 'Same as #Aug 22, 1997#.  

Date values can be constructed with CDate and Time values with CTime:

 CDate ("Aug 6, 1969") CDate (1969, 8, 6) 'Specify the year, month, day.  'Converts the DateTime argument to a Date. CDate (#Aug 6, 1969#)
CTime ("10:30 am") CTime (10, 30, 0) 'Specify the hour, minute, second. CTime (#10:30 am#) 

1.7.2.1.7 Range Data Types (Basic Syntax)

Ranges are designed to handle a spectrum of values. Range types are available for all the simple types except for 
Boolean. That is: Number Range, Currency Range, String Range, Date Range, Time Range and DateTime Range. 
You can generate ranges using the To, _To, To_, _To_, Is >, Is >=, Is < and Is <= keywords. In general, To is used 
for ranges with two endpoints, and Is is used for open ended ranges (only one endpoint). The underscores are 
used to indicate whether or not the endpoints are in the range.

Examples of Number Range values

The range of numbers from 2 to 5 including both 2 and 5

 2 To 5 

The range of numbers from 2 to 5, not including 2 but including 5

 2 _To 5 

All numbers less than or equal to 5

 Is <= 5 
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All number less than 5

 Is < 5 

Examples of DateTime Range values

 #Jan 5, 1999# To #Dec 12, 2000#
Is >= #Jan 1, 2000# 

Ranges in Formulas

There are twenty-seven functions in SAP Crystal Reports that specify date ranges. For example, the function 
LastFullMonth specifies a range of date values that includes all dates from the first to last day of the previous 
month. So if today's date is September 15, 1999 then LastFullMonth is the same as the range value CDate (#Aug 1, 
1999#) To CDate (#Aug 31, 1999#).

Ranges are often used with If or Select statements. The following example computes student letter grades based 
on their test scores. Scores greater than or equal to 90 receive an "A", scores from 80 to 90, not including 90 
receive a "B" and so on.

 Select Case {Student.Test Scores}
   Case Is >= 90
      formula = "A"
   Case 80 To_ 90
      formula = "B"
   Case 70 To_ 80
      formula = "C"
   Case 60 To_ 70
      formula = "D"
   Case Else
      formula = "F"
End Select 

The above example uses the Select statement which is discussed in more detail in Control Structures (Basic 
Syntax) [page 672]. You can check if a value is in a range by using the In operator. For example:

 formula = 5 In 2 To 10 'True
formula = 5 In 2 To_ 5 'False
formula = 5 In 2 To 5 'True 

The Maximum and Minimum functions can be used to find the endpoints of a range:

 formula = Maximum (2 To 10) 'Returns 10 

1.7.2.1.8 Array Data Types (Basic Syntax)

Arrays in SAP Crystal Reports are ordered lists of values that are all of the same type. These values are known as 
the array's elements. The elements of an array can be any simple type or range type. One way to create an array is 
using the Array function.
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Arrays are most useful when used with variables. Using variables, you can change the individual elements of an 
array and resize the array to accommodate more elements. This capability significantly expands the capabilities 
of the formula language to do complex calculations.

For example, you can accumulate database field values into a global array variable in a detail level formula, and 
then use a formula in a group footer to perform a calculation based on those values. This allows you to perform a 
wide variety of customized summary operations.

Examples

An array of three Number values. The first element is 10, the second is 5 and the third is 20.

 Array (10, 5, 20) 

An array of seven String values:

 Array ("Sun", "Mon", "Tue", "Wed", "Th", "Fri", "Sat") 

An array of two DateTime Range values:

 Array (#Jan 1, 1998# To #Jan 31, 1998#, _
       #Feb 1, 1999# To #Feb 28, 1999#) 

You can extract individual elements out of an array using parentheses containing the index of the element you 
want. This is called subscripting the array:

 Array (10, 5, 20) (2) ' = 5 

Note
Arrays in Basic syntax are indexed from 1 (this means the first element has index 1). This is unlike in Visual 
Basic where arrays are indexed from 0 by default. However, in Visual Basic, arrays can be indexed from 1 by 
using the Option Base statement.

Number ranges can also be used to subscript arrays. The result is another array. For example:

 Array (10, 5, 20) (2 To 3) ' = Array (5, 20) 

1.7.2.1.9 Variables (Basic Syntax)

A variable represents a specific data item, or value, and acts as a placeholder for that value. When a formula 
encounters a variable, the formula searches for the value of the variable and uses it in the formula. Unlike a 
constant value, which is fixed and unchanging, a variable can be repeatedly assigned different values. You assign a 
value to a variable and the variable maintains the value until you later assign a new value. Because of this 
flexibility, it is necessary for you to declare variables before you use them so that SAP Crystal Reports is aware of 
them and understands how you intend to use them.
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This section describes the key components of variables and shows you how to create variables and assign values 
to them.

If you wanted to report on customers by area code, you could create a variable that extracts the area code from a 
customer fax number. The following is an example of a variable called areaCode:

 Dim areaCode As String
areaCode = Left ({Customer.Fax}, 3) Rem You could also use: areaCode = {Customer.Fax} (1 To 3)  

The first line of the variable example is the variable declaration; it gives the variable a name and type. The 
database field {Customer.Fax} is a String field and the Left function extracts the first three characters from its 
current value. The variable areaCode is then assigned this value.

1.7.2.1.9.1  Variable Declarations using Dim (Basic Syntax)

Before using a variable in a formula, you must declare it. A variable can hold values of a given type. The allowed 
types are the seven simple types (Number, Currency, String, Boolean, Date, Time and DateTime), the six range 
types (Number Range, Currency Range, String Range, Date Range, Time Range and DateTime Range) and 
variables that hold arrays of the previously mentioned types. This gives a total of 26 different types that a variable 
can have.

When you declare a variable, you also specify its name. A variable cannot have the same name as any function, 
operator or other keyword that is valid for Basic syntax. For example, your variable cannot be named Sin, Mod or 
If because Sin is a built in function, Mod is a built in operator and If is a built in keyword. When typing formulas in 
the formula editor, the names of the built-in functions, operators, and other keywords are highlighted in a different 
color. This makes it easy to check if the variable name conflicts.

Once a variable is declared, it can be used in the formula. For example, you might want to assign it an initial value:

 Dim x As Number 'Declare x to be a Number variable
x = 10 'Assign the value of 10 to x 

You can declare more than one variable per statement by separating their declaration by commas:

 Dim x As Number, y as String, z as DateTime Range
x = 10 : y = "hello"
z = #Jan 1, 1999# To #Jan 31, 1999# 

Declaring variables without immediately specifying their type

In general, the type of a variable does not need to be explicitly given when declaring it. In such cases, the variable's 
type is determined by the first assignment that is made to it. This is similar to the special variable formula. This is 
different from Visual Basic in which a variable whose type is not given at declaration automatically has the Variant 
type. However, in practice, it means that you can write formulas in a similar style to what you would do if using a 
Variant in Visual Basic.

 Dim p 'The type of p is not known yet
p = "bye" 'The type of p is now set to be String
Dim q 'The type of q is not known yet
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q = Array ("hello", p) 'q is a String Array
'Error- p is a String variable and cannot hold a Number
p = 25
Dim r
'r is a Number variable, and holds the value 5
r = (10 + 5) / 3
'The types of a and c are not known yet
Dim a, b As Boolean, c
b = False
'The type of a is now set to Boolean
'and its value is False
a = b
'The type of c is now set to Number and its value is 17
c = 2 + 3 * 5 

Examples of declaring and initializing range variables

 Dim gradeA, quarter
'The type of gradeA is set to Number Range
gradeA = 90 To 100
'The type of quarter is set to Date Range
quarter = CDate (1999, 10, 1) To CDate (1999, 12, 31) 

1.7.2.1.9.2  Variable Scope (Basic Syntax)

Variable scopes are used to define the degree to which variables in one formula are made available to other 
formulas. There are three levels of scope in SAP Crystal Reports:

● Local
● Global
● Shared

Every variable has a scope, and this scope is specified when the variable is declared.

1.7.2.1.9.2.1  Local Variables (Basic Syntax)

Variables with local scope, also known as local variables, are declared using either the Dim or Local keywords. The 
below expressions are equivalent.

 Local x As Number
Dim y As Number 

Local variables are restricted to a single formula and a single evaluation of that formula. This means that you 
cannot access the value of a local variable in one formula from a different formula.

Example

 Rem Formula A
Local x as Number
x = 10
formula = x
Rem Formula B
EvaluateAfter ({@Formula A})
Local x as Number
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formula = x + 1 

The function call EvaluateAfter ({@Formula A}) ensures that Formula B will be evaluated after Formula A is 
evaluated. Formula A returns a value of 10 and Formula B returns a value of 1. Formula B does not have access to 
Formula A's x and thus cannot use the value of 10 and add 1; instead, it uses the default value for the uninitialized 
local variable x found in Formula B, which is 0, and adds 1 to it to get 1.

You can also create local variables with the same name but different types in different formulas. For example, the 
type declarations in formulas A and B do not conflict with:

 Rem Formula C
Local x as String
x = "hello"
formula = x 

Local variables are the most efficient of the three scopes. In addition, they do not interfere with one another in 
different formulas. For these reasons, it is best to declare variables to be local whenever possible.

1.7.2.1.9.2.2  Global Variables (Basic Syntax)

Global variables use the same memory block to store a value throughout the main report. This value is then 
available to all formulas that declare the variable, except for those in subreports. Declare a global variable as in the 
following example:

 Global y As String 

Since global variables share their values throughout the main report, you cannot declare a global variable in one 
formula with one type and then declare a global variable with the same name in a different formula with a different 
type.

When to Use Global Variables

Global variables are often used to perform complex calculations where the results of a formula depend upon the 
grouping and page layout of the actual printed report. This is accomplished by creating several formulas, placing 
them in different sections of the report, and having the different formulas interact via global variables.

Example

 Rem Formula C
Global x as Number
x = 10
formula = x
Rem Formula D
WhileReadingRecords
Global x as Number
x = x + 1
formula = x 

If Formula C is placed in the Report Header and then Formula D is placed in a detail section, Formula C will be 
evaluated before Formula D. Formula C will be evaluated once and then Formula D will be evaluated for each 
record appearing in the detail section. Formula C returns 10. For the first detail record, Formula D returns 11. This 
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is because the value 10 of x is retained from when it was set by Formula C. Formula D then adds 1 to this value, 
setting x to 11 and then returns 11. For the second detail record, formula D return 12, adding 1 to the previously 
retained value of x which was 11. This process continues for the remaining detail records.

The call to WhileReadingRecords tells SAP Crystal Reports to re-evaluate Formula D as it reads in each record of 
the report. Otherwise, since the formula does not contain any database fields, the program will evaluate it only 
once before reading the records from the database. The formula will then return the value 11 instead of 11, 12, 
13, ... as the successive records are processed.

If the statement x = x + 1 is replaced by x = x + {Orders Detail.Quantity}, you create the effect of a running total 
based on {Orders Detail.Quantity}, although it is one starting at 10 rather than 0 because of Formula C. In this 
case, you can omit the call to WhileReadingRecords, since it will automatically occur because the formula 
contains a database field.

1.7.2.1.9.2.3  Shared Variables (Basic Syntax)

Shared variables use the same memory block to store the value of a variable throughout the main report and all of 
its subreports. Thus shared variables are even more general than global variables. To use a shared variable, 
declare it in a formula in the main report as in the following example:

 Shared x As Number
x = 1000 

and declare it in a formula in the subreport as in the following example:

 Shared x as Number 

To use shared variables, the variable must be declared and assigned a value before it can be passed between the 
main report and the subreport.

1.7.2.1.9.3  Declaring Array Variables (Basic Syntax)

There are several different ways to declare array variables. The first way is to use empty parentheses and 
explicitly specify the type of the array:

  'Declare x to be a Global variable of Number Array type. Global x () As Number 'Initialize x. x = Array (10, 20, 30) 'Declare y to be a Shared variable of String Range Array type. Shared y () As String Range 'Initialize y. y = Array ("A" To "C", "H" To "J") 

The second way is to declare the variable without specifying that it is an array and without giving its type and 
waiting for the first assignment to the variable to completely specify its type:

  'Declare y to be a Local variable but do not specify its type. Dim y 'The type of y is now set to be a String Array y = Array ("Sun", "Mon", "Tue", "Wed", "Th", _
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           "Fri", "Sat") 

The third way is to declare that the variable is an array but not specify its type fully until the first assignment. 
Assuming the declaration of y above:

  'Declare z to be a Local variable that is an Array. Local z() 'z is set to Array ("Mon", "Tue") and is a String Array. z = y(2 to 3) 

The fourth way is to explicitly specify the size of the array during the declaration. If you use this technique, the 
array is automatically created and default values are used to fill the array. For example, for a Number Array, each 
element is initialized to 0 and for a String array each element is initialized to the empty string "". Since this type of 
declaration actually creates the array, you must specify its type with the As clause so that SAP Crystal Reports 
knows how much storage space to reserve for the array.

 Dim a(2) As String
a(1) = "good"
a(2) = "bye" 'The & operator can be used to concatenate strings the formula returns the String 
"goodbye". formula = a(1) & a(2) 

Assigning Values to Elements of an Array

You can assign values to elements of an array and also use the values of the elements for other computations.

 Global x() As String
x = Array ("hello", "bye", "again")
' x == Array ("hello", "once", "again").
x (2) = "once" 'The statement below would cause an error if not commented out since the array has 
size 3. 'x (4) = "zap" 'The formula returns the String "HELLO". formula = UCase (x (1)) 

The Redim and Redim Preserve keywords can be used to resize an array, which is useful if you want to add extra 
information to it. Redim erases the previous contents of the array first before resizing it whereas Redim Preserve 
preserves the previous contents.

 Dim x () As Number
Redim x (2) ' x = Array (0, 0)
x (2) = 20 ' x = Array (0, 20)
Redim x (3) ' x = Array (0, 0, 0)
x (3) = 30 ' x = Array (0, 0, 30)
Redim Preserve x (4) ' x = Array (0, 0, 30, 0)
formula = "finished" 
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Arrays and For/Next loops

The following example creates and then uses the array Array (10, 20, 30, ..., 100) using a For/Next 
loop. The below formula returns the Number 20.

 Dim b (10) As Number
Dim i
For i = 1 To 10
   b(i) = 10 * i
Next i
formula = b(2) 

Several variables can be declared in a single statement by separating their declarations with commas.

Related Information

For/Next Loops (Basic Syntax) [page 675]

1.7.2.1.9.4  Default Values for Simple Types (Basic Syntax)

An uninitialized variable will have the default value for its type. In general, it is not a good programming practice to 
rely on the default values of types. For example, initialize all local variables in your formula, initialize all global 
variables in a formula placed in the Report Header, and initialize all shared variables in a formula placed in the 
Report Header of the main report.

When an array is resized using the Redim keyword, the entries are filled with default values for the type.

Default values

● Number

 0 
● Currency

 CCur (0) 
● String

  "" 'The empty string.  
● Date

  CDate (0, 0, 0) 'The null Date value.  
● Time

The null Time value. Value held by an uninitialized Time variable.
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● DateTime
The null DateTime value. Value held by an uninitialized DateTime variable.

Note
It is not recommended that your formulas rely on the values of uninitialized range or array variables.

Related Information

Simple Data Types (Basic Syntax) [page 652]

1.7.2.1.9.5  Automatic Type Conversions (Basic Syntax)

Generally in SAP Crystal Reports, values of one type cannot be used where values of another type are expected 
without explicitly supplying a type conversion function. For example:

 Dim postalCode as String 'Error- assigning a Number value to a String variable. postalCode = 10025 'OK- use the type conversion function CStr to create "10025". postalCode = CStr (10025, 0) 

However, there are a few conversions that are made automatically:

● Number to Currency
● Date to DateTime
● Simple type to Range value of the same underlying simple type

For example, the following assignments are correct:

 Dim cost As Currency 'Same as: cost = CCur (10) cost = 10
Dim orderDate As DateTime 'Same as: orderDate = CDateTime (1999, 9, 23, 0, 0, 0) orderDate = CDate (1999, 9, 23)
Dim aRange As Number Range 'Same as: aRange = 20 To 20 aRange = 20
Dim aRangeArray () As Number Range 'Same as: aRangeArray = Array (10 To 10, 20 To 25, 2 To 2) aRangeArray = Array (10, 20 To 25, 2) 

Note
The opposite conversions are not allowed. For example:

 Dim num As Number num = 5 + CCur (10) 'This will produce an error. ' Convert to Number type using the CDbl function.
num = CDbl (5 + CCur (10)) 
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5 is converted to CCur (5) and added to CCur (10) to make CCur (15). However, this Currency value cannot be 
automatically assigned to the Number variable num since automatic conversions from Currency to Number are 
not allowed. Similarly, functions accepting a Currency argument can be supplied a Number argument instead, and 
the Number argument will be converted to a Currency, whereas functions accepting a Number argument cannot 
be supplied a Currency argument without first explicitly converting the Currency to a Number using CDbl.

1.7.2.1.10  Functions (Basic Syntax)

Functions are built-in procedures or subroutines used to evaluate, make calculations on, or transform data. When 
you specify a function, the program performs the set of operations built into the function without you having to 
specify each operation separately.

1.7.2.1.10.1  Functions Overview (Basic Syntax)

When using a function in a formula, type the name of the function and supply the arguments required. For 
example, the Len function requires a String argument and computes the length of the string. The below formula 
returns the Number 5.

 Dim x As String
x = "hello"
formula = Len (x) 

Supplying arguments of the incorrect type required by the function produces an error. For example, calling Len 
(3) would produce an error since Len does not accept a Number argument.

Functions sometimes can accept different numbers of arguments or types of arguments. For example, the CDate 
function could accept a single String argument to form a Date value or 3 Number values holding the year, month 
and day respectively and form a Date value from them. See Date, Time, and DateTime (Basic Syntax) [page 653].

Example with the Mid function

 Dim x as String
x = "hello" 'Start at position 2, go to the end of the string  formula = Mid (x, 2) 'formula is now "ello" 'Start at position 2, extract 1 character formula = Mid (x, 2, 1) 'formula is now "e"  

The classes of functions are: Math, Summary, Financial, String, Date/Time, Date Range, Array, Type Conversion, 
Programming Shortcuts, Evaluation Time, Print State, Document Properties and Additional Functions. There are 
also some functions specific to conditional formatting formulas.

Functions Similar to Visual Basic Functions

The Math, Financial, String, Date/Time, Type Conversion and Programming Shortcuts groups consist mainly of 
functions that are familiar to Visual Basic users. Most of the functions are intended to work in the same way as the 
Visual Basic function of the same name.
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● Sometimes functions will have more overloads than are available in Visual Basic.
For example, the CDate function supports the Visual Basic overload of creating a Date value from a String 
value, such as CDate ("Sept 18, 1999") but it also supports an overload of creating a Date value by supplying 
the year, month and day as Number arguments e.g. CDate (1999, 9, 18). The overloads are indicated in the 
Functions tree.

● Some functions that are supported by Basic syntax are not listed in the Basic syntax Functions tree. This is 
because they are equivalent to Basic syntax functions that are already listed in the tree.
For example, the Length function, which is the traditional Crystal syntax function for finding the length of a 
string, is not listed in the Basic Syntax functions tree because it works the same as the Len function.

1.7.2.1.10.2  Summary Functions (Basic and Crystal Syntax)

The Summary function group provides functions for creating summary fields such as:

 Sum({Orders.Order Amount}, {Orders.Ship Via}) 

Summary fields are normally created using the Insert Summary or Insert Grand Total dialogs. Alternatively, you 
can create a summary field exclusively for use by your formula by filling in the arguments to one of the functions in 
the Summary functions section. However, any groups that refer to summary fields must already exist in the 
report.

1.7.2.1.10.3  Date Ranges (Basic and Crystal Syntax)

Date ranges produced by these functions depend on the current date. For example, if today's date is September 
18, 2000, then LastFullMonth is the Date Range value:

 CDate(#Aug 1, 2000#) To CDate(#Aug 31, 2000#) 

This functionality is often useful, but if you want to determine a date range based on a database field such as 
{Orders.Order Date}? The Date/Time functions can be used instead.

Basic Syntax Example

 Dim d As Date
d = CDate ({Orders.Order Date})
Dim dr As Date Range
dr = DateSerial (Year(d), Month(d) - 1, 1) To _
     DateSerial (Year(d), Month(d), 1 - 1) 'At this point dr is the Date Range value holding the last full month before 
{Orders.Order Date}.  

Crystal Syntax Example

 Local DateVar d := CDate ({Orders.Order Date});
Local DateVar Range dr;
dr := DateSerial (Year(d), Month(d) - 1, 1) To
      DateSerial (Year(d), Month(d), 1 - 1); //At this point dr is the Date Range value holding the last full month before 
{Orders.Order Date}.  
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The DateSerial function makes this easy because you don't have to worry about special cases. It never lets you 
create an invalid date. For example, DateSerial (1999, 1 - 1, 1) is December 1, 1998. Note that in the above example, 
{Orders.Order Date} is actually a DateTime field and so the CDate function is used to convert it to a date by 
truncating the time part.

Related Information

Range Data Types (Basic Syntax) [page 654]

1.7.2.1.10.4  Array Functions (Basic and Crystal Syntax)

The array functions compute summaries of an array's elements. For example, the Sum function when applied to 
an array returns the sum of the elements of the array.

Basic Syntax Example

The following formula returns 100:

 formula = Sum (Array (10, 20, 30, 40)) 

Crystal Syntax Example

The following formula returns 100:

 Sum ([10, 20, 30, 40]) 

Related Information

Array Data Types (Basic Syntax) [page 655]
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1.7.2.1.10.5  Evaluation Time Functions (Basic and Crystal 
Syntax)

These are the report specific functions: BeforeReadingRecords, WhileReadingRecords, 
WhilePrintingRecords and EvaluateAfter. You can use these functions to guide SAP Crystal Reports as to 
when your formula should be evaluated.

Should the formula be evaluated before retrieving the records from the database, while reading the records from 
the database but before the records have been grouped, sorted and summarized, or while printing the report, 
when the records are grouped, sorted and summarized? In general, SAP Crystal Reports sets an appropriate 
evaluation time for your formula, based on how much information the formula needs. For example, if a formula 
uses a database field, then it cannot be evaluated before the records are read from the database. However, you 
sometimes need to force a later evaluation time than normal to get the desired effect. See Global Variables (Basic 
Syntax) [page 659] or Global Variables (Crystal Syntax) [page 691] for an example.

Normally, the returned value of a function is used further in a formula. However, evaluation time functions are 
called to change the internal behavior of SAP Crystal Reports and their return value is not used. They can be called 
by just placing their name in a separate statement, optionally preceded by the keyword Call.

 WhilePrintingRecords
Call WhilePrintingRecords 

1.7.2.1.10.6  Print State Functions (Basic and Crystal Syntax)

These functions are reporting-specific functions that deal with the state of a report being previewed.

For example, the notation {Orders.Order Date} refers to the value of the field in the current record where 
PreviousValue ({Orders.Order Date}) refers to the value in the immediately preceding record. 
NextValue ({Orders.Order Date}) refers to the value in the next record. IsNull ({Orders.Order 
Date}) checks if the field's value is null.

Other examples are PageNumber and TotalPageCount. These can be used to access pagination information 
about your report.

1.7.2.1.10.7  Document Properties Functions (Basic and Crystal 
Syntax)

These functions return values of attributes pertaining to a document. For example, PrintDate and 
ReportTitle.
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1.7.2.1.10.8  Additional Functions (Basic and Crystal Syntax)

These are functions that are in User Function Libraries (UFLs). A UFL is a separate dynamic link library or 
Automation server that you create and SAP Crystal Reports uses to add your own customized functions to the 
formula language. Writing a UFL is more involved than writing a formula using Basic or Crystal syntax.

Note
Using UFLs makes your reports less portable because you must distribute your UFL along with the report.

1.7.2.1.10.9  Conditional Formatting Functions (Basic Syntax)

When writing a conditional formatting formula, you may want to use the additional functions that appear at the 
top of the Functions tree.

If you wanted to format the {Customer.Last Year's Sales} field so that sales of more than $100,000 are printed in 
green and sales of less than $15,000 are printed in red and all else are printed in black.

 If {Customer.Last Year's Sales} > 100000 Then
   formula = crGreen
ElseIf {Customer.Last Year's Sales} < 15000 Then
   formula = crRed
Else
   formula = crBlack
End If 

Since this is a font color formatting function, the list of Color Constants appears in the Functions tree. This 
example uses three: crGreen, crRed and crBlack. You could have used the actual numeric values of the color 
constants instead. For example, crRed is 255 and crGreen is 32768. However, the formula is easier to understand 
using the color constants. All constant functions in Basic syntax have the "cr" prefix.

Note
Some formatting attributes do not use constant functions. For example, if you wanted to not print 
{Customer.Last Year's Sales} values if the sales were less than $50,000, you could write the following 
conditional formatting formula for the suppress attribute:

 If {Customer.Last Year's Sales} < 50000 Then    formula = True ' Suppress the value. Else    formula = False ' Do not suppress the value. End If 

Or more simply:

 formula = {Customer.Last Year's Sales} < 50000 

If the last year's sales are less than $50,000, then the expression

 {Customer.Last Year's Sales} < 50000 
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is True, and so the formula returns True. On the other hand, if the last year's sales are greater than or equal to 
$50,000, then

 {Customer.Last Year's Sales} < 50000 

is False and so the formula returns False.

1.7.2.1.10.10  General Purpose Conditional Formatting 
Functions (Basic Syntax)

There are three general purpose conditional formatting functions:

● CurrentFieldValue
● DefaultAttribute
● GridRowColumnValue

These functions are displayed at the top of the Functions tree whenever appropriate. See Formula Editor Dialog 
Box [page 599].

DefaultAttribute can be used for any formatting formula, CurrentFieldValue for any formatting formula 
where you are formatting a field value, and GridRowColumnValue for any formatting formula where you are 
formatting a field value in a Cross-Tab or OLAP grid.

CurrentFieldValue enables you to conditionally format Cross-Tab or OLAP grid cells based on their value. 
GridRowColumnValue enables you to conditionally format the cells of a Cross-Tab or OLAP grid based on row or 
column headings values. These two functions are essential in some situations as there is no other way in the 
formula language to refer to these fields.

For example, if you wanted Cross-Tab cells to be suppressed if the values are less than 50,000:

 formula = CurrentFieldValue < 50000 

1.7.2.1.11  Operators (Basic Syntax)

Operators are special symbols or words that describe an operation or an action to take place between two or 
more values. The program reads the operators in a formula and performs the actions specified.

1.7.2.1.11.1  Arithmetic Operators (Basic Syntax)

Arithmetic operators are used to combine numbers, numeric variables, numeric fields and numeric functions to 
get another number.

The arithmetic operators are addition (+), subtraction (-), multiplication (*), division (/), integer division (\), 
modulus (Mod), negation (-) and exponentiation (^).

  'Outstanding preferred stock as a percent of common stock.
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 formula = ({Financials.Preferred Stock} / _
           {Financials.Common Stock}) * 100
formula =  7 + 2 * 3 - 2 + Sqr(6 + 3) * Len("up") 'The formula returns 17.  

Order of Precedence

In general, the program evaluates expressions in the following order:

● from left to right
● follows the rules of precedence from basic math

The arithmetic operators in SAP Crystal Reports have the same order of precedence as in Visual Basic. Here is the 
list, from highest precedence to lowest:

● Exponentiation (^)
● Negation (-)
● Multiplication and division (*, /)
● Integer Division (\)
● Modulus (Mod)
● Addition and subtraction (+, -)

Multiplication and division are performed first from left to right. Then addition and subtraction are performed. For 
example, 5 + 10 * 3 = 5 + 30 = 35.

You can change this order of precedence by using parentheses. For example, (5 + 10) * 3 = 15 * 3 = 45. If you are 
unsure of the order of precedence, it is a good idea to clarify your intentions with parentheses.

1.7.2.1.11.2  Comparison Operators (Basic Syntax)

Comparison operators are usually used to compare operands for a condition in a control structure such as an If 
statement.

The comparison operators are equal (=), not equal (<>), less than (<), less than or equal to (<=), greater than (>) 
and greater than or equal to (>=).

Comparison operators as a group all have lower precedence than the arithmetic operators. For example, 
expressions like 2 + 3 < 2 * 9 are the same as (2 + 3) < (2*9).

1.7.2.1.11.3  Boolean Operators (Basic Syntax)

Boolean operators are typically used with comparison operators to generate conditions for control structures.

The Boolean operators are, in order of precedence from greatest to lowest: Not, And, Or, Xor, Eqv and Imp.

Boolean operators as a group have lower precedence than the comparison operators. Thus for example, the 
expression 2 < 3 And 4 >= -1 is the same as (2 < 3) And (4 >= -1).
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1.7.2.1.11.4  Null Fields and Null Values (Basic Syntax)

In general, when SAP Crystal Reports encounters a null valued field in a formula, it immediately stops evaluating 
the formula and produces no value. If you want to handle null field values in your formula, you must explicitly do so 
using one of the special functions designed for handling them: IsNull, PreviousIsNull or NextIsNull.

Relating to operators, when SAP Crystal Reports evaluates the condition:

 IsNull({Product.Color}) Or _
InStr({Product.Color}, " ") = 0 

It first evaluates IsNull ({Product.Color}), and when it determines that this is True, it knows that the whole 
condition is True, and does not need to check whether

 InStr({Product.Color}, " ") = 0 

In other words, SAP Crystal Reports will stop evaluating a Boolean expression when it can predict the results of 
the whole expression. In the following example, the formula guards against attempting to divide by zero in the 
case that denom is 0:

 Dim num As Number, denom As Number
...
If denom <> 0 And num / denom > 5 Then
... 

Note
Visual Basic does not support this technique, since all parts of a Boolean expression in Visual Basic are 
evaluated, even if not necessary.

The {Product.Color} field contains both basic colors such as "red" and "black" and more descriptive two word 
colors such as "steel satin" and "jewel green". Here's an example of a formula that writes out "basic" for the basic 
colors and "fancy" for the others.

 If InStr({Product.Color}, " ") = 0 Then
    formula = "basic"
Else
    formula = "fancy"
End If 

The function call to InStr searches the {Product.Color} string for a space. If it finds a space, it returns the position 
of the space, otherwise it returns 0. Since basic colors are only one word with no spaces, InStr will return 0 for 
them.

For some products, such as the Guardian Chain Lock, a color value was not recorded and so the {Product.Color} 
field has a null value in the database for that record. Thus, the Guardian Chain Lock record does not have any 
word printed beside it.

Here is an example of how to fix the above example using IsNull:

 If IsNull({Product.Color}) Or _
   InStr({Product.Color}, " ") = 0 Then
   formula = "basic"
Else
   formula = "fancy"
End If 
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1.7.2.1.12  Control Structures (Basic Syntax)

Formulas without control structures execute each statement in the formula only once. When this happens the 
formula is evaluated. The statements are executed in a sequential fashion, from the first statement in the formula 
to the last. Control structures enable you to vary this rigid sequence. Depending upon which control structure you 
choose, you can skip over some of the statements or repeatedly evaluate some statements depending on certain 
conditions. Control structures are the primary means of expressing business logic and typical report formulas 
make extensive use of them.

Basic syntax supports many of the main control structures from Visual Basic with the same syntax. One of the 
advantages of the Basic language is it is easy to read block notation for control structures. This simplifies the 
writing and debugging of complex formulas.

1.7.2.1.12.1  If Statements (Basic Syntax)

The If statement is one of the most useful control structures. It enables you to evaluate a sequence of statements 
if a condition is true and evaluate a different sequence of statements if it is not true.

Note
When formatting with conditional formulas, always include the Else keyword; otherwise, values that don't meet 
the If condition may not retain their original format. To prevent this, use the DefaultAttribute function (If...Else 
formula = DefaultAttribute).

Example

A company plans to pay a bonus of 4 percent to its employees except for those who work in Sales who will receive 
6 percent. The following formula using an If statement would accomplish this:

 If {Employee.Dept} = "Sales" Then
   formula = {Employee.Salary} * 0.06
Else
   formula = {Employee.Salary} * 0.04
End If 

In this example, if the condition {Employee.Dept} = "Sales" evaluates as true, then the

 formula = {Employee.Salary} * 0.06 

statement is processed. Otherwise the statement following the Else, namely the

 formula = {Employee.Salary} * 0.04 

is processed.

Suppose another company wants to give employees a 4% bonus, but with a minimum bonus of $1,000. Notice 
that the Else clause is not included; it is optional, and not needed in this case.

 formula = {Employee.Salary} * 0.04
If formula < 1000 Then
   formula = 1000
End If 
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Now suppose that the previous company also wants a maximum bonus of $5,000. You now need to use an ElseIf 
clause. Notice that ElseIf is all one word. The following example has only one ElseIf clause, but you can add as 
many as you need.

Note
There is a maximum of one Else clause per If statement.

The Else clause is executed if none of the If or ElseIf conditions are true.

 formula = {Employee.Salary} * 0.04
If formula < 1000 Then
   formula = 1000
ElseIf formula > 5000 Then
   formula = 5000
End If 

Suppose that a company wants to compute an estimate of the amount of tax an employee needs to pay and write 
a suitable message. Income below $8,000 is not taxed, income between $8,000 and $20,000 is taxed at 20%, 
income between $20,000 and $35,000 is taxed at 29%, and income above $35,000 is taxed at 40%.

 Dim tax As Currency, income As Currency
income = {Employee.Salary}
Dim message As String
If income < 8000 Then
   tax = 0    message = "no" ElseIf income >= 8000 And income < 20000 Then    message = "lowest"    tax = (income - 8000)*0.20
ElseIf income >= 20000 And income < 35000 Then    message = "middle"    tax = (20000 - 8000)*0.20 + (income - 20000)*0.29
Else    message = "highest"    tax = (20000 - 8000)*0.20 + (35000 - 20000)*0.29 + _
        (income - 35000)*0.40
End If
Dim taxStr As String Rem Use 2 decimal places and use the comma as a thousands separator. taxStr = CStr (tax, 2, ",") formula = "You are in the " & message & _
          " tax bracket. " & _
          "Your estimated tax is " & taxStr & "."  

Notice, the use of variables to simplify the logic of the computation. Also, notice that there are two statements 
that are executed when one of the conditions are met; one assigns the tax variable, and the other assigns the 
message variable. It is often useful to have multiple statements executed as a result of a condition.

1.7.2.1.12.1.1  Single-Line and Multi-Line If Statements (Basic 
Syntax)

There are two kinds of If statement, the single-line if statement and the multi-line if statement. Starting on a new 
line after the first Then turns your If statement into a multi-line If statement. Otherwise it is a single-line If 
statement. The multi-line If statement always includes an End If whereas the single line If statement does not.
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Note
Because of the use of line-continuation characters, single-line If statements do not need to be on a single line. 
In general, it is preferable to use multi-line If statements since they have a clearer layout. However, for simple 
situations, the single-line If statement is sometimes used.

 If {Employee.Dept} = "Sales" Then _
   formula = {Employee.Salary} * 0.06 _
Else _
   formula = {Employee.Salary} * 0.04 

Here is an example showing various forms of single-line If statements:

 Dim per As Number, extra As Boolean
per = 2 : extra = False 'An example with no Else clause. If {Employee.Dept} = "Sales" Then per = 10 'More than 1 statement in the Then or Else part can be included by separating them 
with colons. If {Employee.Dept} = "R&D" Then _
   per = 5 : extra = True _
Else _
   per = 3 

1.7.2.1.12.2  Select Statements (Basic Syntax)

The Select statement is similar to an If statement. Sometimes however, you can write formulas that are clear and 
less repetitive using the Select statement. This example evaluates the {Customer.Fax} field to determine if the 
area code is for Washington state (206, 360, 509) or British Columbia, Canada (604, 250):

 Select Case Left ({Customer.Fax}, 3)
   Case "604", "250"
      formula = "BC"
   Case "206", "509", "360"
      formula = "WA"
End Select 

The expression right after the Select Case keywords is called the Select condition. In the above example it is Left 
({Customer.Fax}[1 To 3]). The Select statement tries to find the first Case that matches the Select condition, and 
then executes the statements following it, up until the next Case.

 Dim areaCode As String
areaCode = Left ({Customer.Fax}, 3)
If areaCode In Array ("604", "250") Then
   formula = "BC"
ElseIf areaCode In Array ("206", "509", "360") Then
   formula = "WA"
End If 

This formula groups the number of Oscar nominations a movie received into low, medium, high or extreme 
categories and in the process, shows some of the possibilities for the expression lists following the Case labels. 
Notice the optional Case Else clause. If none of the Case expression lists are matched by the preceding Case 

674 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



clauses, then the Case Else clause is matched. For example, in the following example, if {movie.NOM} is 11, then 
the formula returns "extreme".

 Rem Select example 2
Select Case {movie.NOM}
   Case 1,2,3, Is < 1       Rem Can have multiple statements in the statement blocks.        formula = "low"    Case 4 To 6, 7, 8, 9       formula = "medium"    Case 10       formula = "high"    Case Else       formula = "extreme" End Select 

1.7.2.1.12.3  For/Next Loops (Basic Syntax)

For/Next loops enable you to evaluate a sequence of statements multiple times. This is unlike the If and Select 
statements where the program passes through each statement at most once during the formula's evaluation.

For/Next loops are best when you know the number of times that the statements needs to be evaluated in 
advance.

For Loop Syntax

Suppose you want to reverse the {Customer.Customer Name} string. For example, "City Cyclists" becomes 
"stsilcyC ytiC".

 formula = ""
Dim strLen
strLen = Len ({Customer.Customer Name})
Dim i
For i = 1 To strLen
   Dim charPos
   charPos = strLen - i + 1
   formula = formula & _
             Mid({Customer.Customer Name}, charPos, 1)
Next i 

Examine how this formula works assuming that the current value of the field {Customer.Customer Name} is 
"Clean Air". The variable strLen is assigned to be the length of "Clean Air", namely 9. At this time it is also typed to 
be a Number variable. The variable i is known as a For counter variable since its value changes with each iteration 
of the For loop. In other words, it is used to count the iterations of the loop. The For loop will iterate 9 times, during 
the first time, i is 1, then i is 2, then i is 3 and so on until finally i = 9. During the first iteration, the ninth character of 
{Customer.Customer Name} is appended to the empty special variable formula. As a result formula equals "r" 
after the first iteration. During the second iteration, the eighth character of {Customer.Customer Name} is 
appended to formula and so formula equals "ri". This continues until after the ninth iteration, formula equals, "riA 
naelC" which is the reversed string.
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Here is a simpler version of the above formula that uses a Step clause with a negative Step value of -1. For the 
"Clean Air" example, i is 9 for the first iteration, 8 for the second, 7 for the third and so on until it is 1 in the final 
iteration.

 formula = ""
Dim i
For i = Len ({Customer.Customer Name}) To 1 Step -1
   formula = formula + _
             Mid({Customer.Customer Name}, i, 1)
Next i 

The simplest version is to use the built in function StrReverse:

 formula = StrReverse ({Customer.Customer Name}) 

The built in String functions in SAP Crystal Reports can handle many of the string processing applications which 
would traditionally be handled using a For/Next loop or some other kind of loop. However, For/Next loops provide 
the most flexibility and power in processing strings and arrays. This can be essential if the built-in functions do not 
cover your intended application.

1.7.2.1.12.3.1  For/Next Loop Example (Basic Syntax)

Here is a more detailed example of SAP Crystal Reports' string processing capabilities. The Caesar cipher is a 
simple code that is traditionally credited to Julius Caesar. In this code, each letter of a word is replaced by a letter 
five characters further in the alphabet. For example, "Jaws" becomes "Ofbx". Notice that "w" is replaced by "b". 
Since there are not 5 characters after "w" in the alphabet, it starts again from the beginning.

Here is a formula that implements applying the Caesar cipher to the field {Customer.Customer Name} in the 
Xtreme database:

 Dim inputString
inputString = {Customer.Customer Name}
Dim shift
shift = 5
formula = ""
Dim i
For i = 1 To Len(inputString)
   Dim inC, outC
   inC = Mid(inputString, i, 1)
   Dim isChar, isUCaseChar
   isChar = LCase(inC) In "a" To "z"
   isUCaseChar = isChar And (UCase (inC) = inC)
   inC = LCase(inC)
   If isChar Then
      Dim offset
      offset = (Asc(inC) + shift - Asc("a")) Mod _
               (Asc("z") - Asc("a") + 1)
      outC = Chr(offset + Asc("a"))
      If isUCaseChar Then outC = UCase(outC)
   Else
      outC = inC
   End If
   formula = formula & outC
Next i 

In the above example, there is a multi-line If statement nested within the statements block of the For/Next loop. 
This If statement is responsible for the precise details of shifting a single character. For example, letters are 
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treated differently from punctuation and spaces. In particular, punctuation and spaces are not encoded. Control 
structures can be nested within other control structures and multiple statements can be included in the 
statement block of a control structure.

1.7.2.1.12.3.2  Exiting from For/Next Loops (Basic Syntax)

You can exit from a For/Next loop by using the Exit For statement. The following example searches the Global 
array names for the name "Fred". If it finds the name, it returns the index of the name in the array. Otherwise it 
returns -1. For example, if the names array is:

 Array ("Frank", "Helen", "Fred", "Linda") 

Then the formula returns 3.

 Global names () As String ' The names array has been initialized and filled in other formulas. Dim i
formula = -1 ' The UBound function returns the size of its array argument. For i = 1 to UBound (names)
   If names (i) = "Fred" Then
      formula = i
      Exit For
   End If
Next I 

1.7.2.1.12.4  Do Loops (Basic Syntax)

A Do loop can be used to execute a fixed block of statement an indefinite number of times.
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The 4 different types of Do loops

Table 22:

Type of Do Loop Explanation Example

Do While … Loop The Do While ... Loop evaluates the con
dition, and if the condition is true, then it 
evaluates the statements following the 
condition.

When it has finished doing this, it evalu
ates the condition again and if the condi
tion is true, it evaluates the statements 
again.

It continues repeating this process until 
the condition is false.

 Do While condition
   statements
Loop 

Do Until ... Loop The Do Until ... Loop is similar to the Do 
While ... Loop except it keeps evaluating 
the statements until the condition is true 
rather than while it is true.

 Do Until condition
   statements
Loop 

Do ... Loop While The Do ... Loop While evaluates the 
statements only once.

It then evaluates the condition, and if the 
condition is true, evaluates the state
ments again. This process continues un
til the condition is false.

 Do
   statements
Loop While condition 

Do ... Loop Until Similar to Do ... Loop While except that it 
evaluates the statements until the condi
tion is true.

 Do
   statements
Loop Until condition 

Note
The Do loops support an Exit Do statement to immediately jump out of the loop. The Exit Do statement is 
similar to the Exit For in For/Next loops.

Do While ... Loop Formula Example

The following example searches for the first occurrence of a digit in an input string. If a digit is found, it returns its 
position, otherwise it returns -1. In this case, the input string is set explicitly to a string constant, but it could be set 
equal to a String type database field instead.

For example, for the input String, "The 7 Dwarves", the formula returns 5, which is the position of the digit 7.

 Dim inString
inString = "The 7 Dwarves"
Dim i, strLen
i = 1
strLen = Len (inString)
formula = -1
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Do While i <= strLen And formula = -1
   Dim c As String
   c = Mid (inString, i, 1)
   If IsNumeric (c) Then formula = i
   i = i + 1
Loop 

1.7.2.1.12.5  While Loops (Basic Syntax)

The While loop is similar to the Do While ... Loop except that it does not support an Exit statement. It uses While ... 
Wend instead of Do While ... Loop as its syntax.

 While condition
   statements
Wend 

1.7.2.1.12.6  Preventing Infinite Loops (Basic Syntax)

There is a safety mechanism to prevent report processing from hanging due to an infinite loop. Any one evaluation 
of a formula can have at most 100,000 loop condition evaluations per formula evaluation. For example:

 Dim i
i = 1
Do While i <= 200000
   If i > {movie.STARS} Then Exit Do
   i = i + 1
Loop
formula = 20 

If {movie.STARS} is greater than 100,000 then the loop condition (i <= 200000) will be evaluated more than the 
maximum number of times and an error message is displayed. Otherwise the loop is OK.

Note
The safety mechanism applies on a per formula base, not for each individual loop. For example:

 Dim i
i = 1
For i = 1 To 40000
   formula = Sin (i)
Next i
Do While i <= 70000
   i = i + 1
Loop 

The above formula also triggers the safety mechanism since the 100,000 refers to the total number of loop 
condition evaluations in the formula and this formula will have 40001 + 70001 such evaluations.
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1.7.2.2 Crystal Syntax

When creating formulas, you have the option of using either Crystal or Basic syntax. Almost any formula written 
with one syntax can be written with the other. Reports can contain formulas that use Basic syntax as well as 
formulas that use Crystal syntax, but a single formula can use only one syntax.

1.7.2.2.1 Crystal Syntax Fundamentals

The Result of a Formula

The result of a formula, or the value that is printed when the formula is placed in a report, is called the value 
returned by the formula. Every formula in SAP Crystal Reports must return a value. For example, here is a simple 
Crystal syntax formula that returns a value of 10:

 10 

The value returned by a formula can be one of the seven simple data types supported. These are Number, 
Currency, String, Boolean, Date, Time, and DateTime.

Note
SAP Crystal Reports also supports range types and array types, but these cannot be returned by a formula.

For example, suppose a company has a shipping policy in which orders over $1,000 are insured, but orders below 
that amount are not insured:

 If {Orders.Order Amount} >= 1000 Then    "Insured shipping" Else    "Regular shipping"  

The formula returns the text string value "Insured shipping" if the value of the database field {Orders.Order 
Amount} is greater than or equal to 1000; otherwise, it returns the text string value "Regular Shipping" otherwise.

Expression-Based Syntax

A Crystal syntax formula consists of a sequence of expressions. An expression is any combination of keywords, 
operators, functions, and constant values that result in a value of a given type. The value of the final expression is 
the value returned by the formula and what gets printed. Each expression must be separated from the previous 
expression by a semicolon (;).

The fact that a Crystal syntax formula is a sequence of expressions whose result is the value of the final 
expression is the most important concept in understanding Crystal syntax. This expression-based syntax allows 
you to write very short formulas with a lot of functionality.
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Case-Sensitivity

All variable names, functions, and keywords used in a Crystal syntax formula are not case-sensitive. For example, 
the keyword Then could equivalently be typed in as then or THEN.

The only exception to this rule is for strings. The string "Hello" is not the same as the string "hello".

Practice using the Xtreme Sample Database

Many of the examples in this section refer to the Xtreme database.

1.7.2.2.2 Comments (Crystal Syntax)

Formula comments are notes included with a formula to explain its design and operation. Comments do not print 
and they do not affect the formula; they appear only in the Formula Editor. Use comments to explain the purpose 
of a formula or explain the steps involved in writing it.

Comments begin with two forward slashes (//) and are followed by the text of the comment. Everything that 
follows the slashes on the same line is treated as being part of the comment:

  //This formula returns the string "Hello".  //This is another comment.  "Hello" //Comments can be added at the end of a line.  //Comments can occur after the formula text.  

1.7.2.2.3 Fields (Crystal Syntax)

Many of the fields you use when creating your report can also be referred to in your formulas. For example, 
database, parameter, running total, SQL expression, summary, and group name fields can all be used in a 
formula. You can also refer to other formula fields in your formula.

The easiest way to insert a field into your report is to double-click a field's name in the Report Fields tree. This 
ensures that the correct syntax for the field is used.

How fields appear in formulas

Database, parameter, formula, running total and SQL expression fields have their names surrounded by braces.

Database field names are taken from the database: {Employee.Last Name}

Parameter, formula, running total, and SQL expression field names are specified when the fields are created.

● parameter fields also includes a question mark: {?my parameter field}
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● formula fields include an at sign: {@another formula}
● running totals fields include a pound sign: {#my running total}
● SQL expression fields include a percent sign: {%my SQL expression}

Summary and group name fields look like function calls. However, they are really shorthand notation for a report 
field.

● sum summary field: Sum({Orders.Order Amount}, {Orders.Ship Via})
● group name field: GroupName({Orders.Ship Via})

Example

The formula in this example uses the Xtreme database. To find out how many days it takes to ship the product 
from the date when the order was placed, you can just subtract the ship date database field from the order date 
database field:

 {Orders.Ship Date} - {Orders.Order Date} 

To find the total dollar amount of a given product that was ordered, multiply its unit price by the quantity ordered:

 {Orders Detail.Unit Price} * {Orders Detail.Quantity} 

To calculate a sale price of 80 percent of the original unit price:

 {Orders Detail.Unit Price} * 0.80 

1.7.2.2.4 Expressions (Crystal Syntax)

An expression is any combination of keywords, operators, functions, and constant values that result in a value of a 
given type. For example:

  //An expression that evaluates to the Number value 25 10 + 20 - 5 //An expression that evaluates to the String value "This is a string."  "This is a string."  

A Crystal syntax formula consists of a sequence of expressions. The value of the final expression is the value 
returned by the formula and what gets printed. Each expression must be separated from the previous expression 
by a semicolon (;).

1.7.2.2.4.1  Multiple Expressions (Crystal Syntax)

Typically, each expression takes one line, but you can continue an expression onto the next line if you need more 
space.

The formula below consists of five expressions. It returns the Number value 25 since that is the value of the last 
expression in the formula.
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Example

  //The first expression returns the Number 30. 10 + 20; //The second expression returns the String value "Hello World". "Hello " +
"World"; //The third expression returns a value of type Number. {Orders Detail.Quantity} * 2 - 5; //The fourth expression returns a value of type String. If {Orders Detail.Quantity} > 1 Then
   "multiple units"
Else
   "one unit"; //The fifth and final expression returns the Number 25. 20 + 5 

Placing a semicolon after the last expression in the formula is also allowed, but is optional. For example, the above 
formula could have ended with:

 20 + 5; 

Some of the sample formulas in the Expressions (Crystal Syntax) [page 682] section do not have semicolons. 
This is because they consist of a single expression, and a semicolon is optional after the last expression. Many 
formulas in Crystal syntax can be written as a single expression.

Notice that there is no semicolon after the "multiple units" string. In fact, if you put a semicolon there, the program 
will report an error. This is because a semicolon separates expressions, and the

 Else
   "one unit"; 

is not a separate expression. It does not stand alone apart from the If. In fact, it is an integral part of the If 
expression since it describes the value that the If expression will return under certain circumstances.

Note
The example is not a practical example because the first four expressions in the formula did not have any effect 
on the last expression.

How Earlier Expressions Affect Later Expressions

The fact that a Crystal syntax formula is a sequence of expressions whose result is the value of the final 
expression is the most important concept in understanding Crystal syntax. This expression-based syntax allows 
you to write very short formulas with a lot of functionality.

  // This expression declares the Number variable and then returns 
// the value of an uninitialized Number variable, which is 0. NumberVar x; //Second expression. It assigns the value of 30 to x,
//and returns 30. x := 30 
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The above formula would give an error if the first expression were omitted. This is because the second expression 
refers to the Number variable x, and the program needs to have x declared before it understands expressions 
involving it.

In general, you use variables to get the earlier expressions in a formula to affect the final expression.

Related Information

Variables (Crystal Syntax) [page 689]

1.7.2.2.5 Assignment (Crystal Syntax)

The assignment operator is a colon followed by an equal sign (:=).

For example:

  //Assign the Number value of 10 to the variable x. x := 10; //Assign the String value of "hello" to the variable named greeting. greeting := "hello"; 

The equality operator (=) is used to check when two values are equal. A common error is to use the equality 
operator when the assignment operator is actually intended. This can generate a mysterious error message or no 
error message at all since it is often syntactically correct to use the equality operator. For example:

 greeting = "hello"; 

The above formula checks if the value held by the variable greeting is equal to the value "hello". If it is, then the 
expression's value is True, and if is not then the expression's value is False. In any case, it is a perfectly correct 
Crystal syntax expression (assuming that the greeting is a String variable).

1.7.2.2.6 Simple Data Types (Crystal Syntax)

This section describes the simple data types available in SAP Crystal Reports.

1.7.2.2.6.1  Number (Crystal Syntax)

Enter numbers without any comma separators or currency symbols. (Generally, you would want to have 
formatted numbers appearing as the result of a formula and not in the formula itself.)

Example

 10000
-20
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1.23 

1.7.2.2.6.2  Currency (Crystal Syntax)

Use the dollar sign ($) to create a Currency value.

Example

 $10000
-$20
$1.23 

You can also use the CCur function. The initial C in CCur stands for convert and it can be used to convert Number 
values to Currency values:

 CCur (10000)
CCur (-20)
CCur (1.23) 

1.7.2.2.6.3  String (Crystal Syntax)

Strings are used to hold text. The text must be placed between double quotation marks (") or apostrophes (') and 
cannot be split between lines. If you want to include double quotation marks in a string delimited by double 
quotation marks, use two consecutive double quotation marks. Similarly, if you want to include an apostrophe in a 
string delimited by apostrophes, use two consecutive apostrophes.

Example

 "This is a string."
"123"
"The word ""hello"" is quoted."
'This is also a string.'
'123'
'Last Year''s Sales' 

If you use double quotes for the left side of the string, you must use double quotes on the right side. Similarly for 
apostrophes. The following example is incorrect:

 'Not a valid string." 

You can extract individual elements or substrings from a string by specifying the character position or a range of 
character positions. Negative values are allowed; they specify the position starting from the end of the string.

 "hello" [2] //Equal to "e"
"hello" [-5] //Equal to "h"
"604-555-1234" [1 to 3] //Equal to "604"
"abcdef" [-3 to -1] //Equal to "def" 

You can also extract substrings from a string using the Left, Right and Mid functions.
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1.7.2.2.6.4  Boolean (Crystal Syntax)

The valid Boolean values are:

 True
False 

Note
Yes can be used instead of True and No instead of False.

1.7.2.2.6.5  Date, Time, and DateTime (Crystal Syntax)

The DateTime type can hold date-times, dates only, or times only. The Date type holds dates only and the Time 
type holds times only. The Date and Time types are more efficient than the DateTime type, and so can be used in 
situations where the added functionality and flexibility of the DateTime type is not needed.

You can create DateTime values directly using the date-time literal construction. It is formed by typing in the date-
time between two pound (#) signs. Many different formats are supported.

Note
Date-time literals cannot be split between lines.

Examples

 #8/6/1976 1:20 am#
#August 6, 1976#
#6 Aug 1976 13:20:19#
#6 Aug 1976 1:30:15 pm#
#8/6/1976#
#10:20 am# 

Even though #10:20 am# looks like it could have the Time type and #8/6/1976# looks like it could have the Date 
type, they do not. They both have the DateTime type, as do all date-time literals. For example, you can think of 
#10:20 am# as a DateTime value with a null date part. To convert it to the Time type use CTime (#10:20 am#).

Instead of using date-time literals, you can use CDateTime to convert a String to a DateTime. For example,

 CDateTime ("8/6/1976 1:20 am")
CDateTime ("10:20 am") 

However, there is one key difference between using date-time literals and the above usage of CDateTime. Date-
time literals always use U.S. English date formats rather than settings from the locale of the particular computer 
on which SAP Crystal Reports is running. Thus, the date-time literal examples above would work on all computers. 
On the other hand, on a French system, you could use constructions like:

  CDateTime ("22 aout 1997") //Same as #Aug 22, 1997#.  

Date values can be constructed with CDate and Time values with CTime:
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CDate ("Aug 6, 1969") CDate (1969, 8, 6) //Specify the year, month, day.  //Converts the DateTime argument to a Date. CDate (#Aug 6, 1969#)
CTime ("10:30 am") CTime (10, 30, 0) //Specify the hour, minute, second. CTime (#10:30 am#) 

1.7.2.2.7 Range Data Types (Crystal Syntax)

Ranges are designed to handle a spectrum of values. Range types are available for all the simple types except for 
Boolean. That is: Number Range, Currency Range, String Range, Date Range, Time Range and DateTime Range. 
You can generate ranges using the To, _To, To_, _To_, UpTo, UpTo_, UpFrom, and UpFrom_ keywords. In general, 
To is used for ranges with two endpoints, and UpTo and UpFrom are used for open ended ranges (only one 
endpoint). The underscores are used to indicate whether or not the endpoints are in the range.

Examples of Number Range values

The range of numbers from 2 to 5 including both 2 and 5

 2 To 5 

The range of numbers from 2 to 5, not including 2 but including 5

 2 _To 5 

All numbers less than or equal to 5

 UpTo 5 

All number less than 5

 UpTo_ 5 

Examples of DateTime Range values:

 #Jan 5, 1999# To #Dec 12, 2000#
UpFrom #Jan 1, 2000# 

Using Ranges in Formulas

There are twenty-seven functions in SAP Crystal Reports that specify date ranges. For example, the function 
LastFullMonth specifies a range of date values that includes all dates from the first to last day of the previous 
month. So if today's date is September 15, 1999 then LastFullMonth is the same as the range value CDate (#Aug 1, 
1999#) To CDate (#Aug 31, 1999#).

Ranges are often used with If or Select expressions. The following example computes student letter grades based 
on their test scores. Scores greater than or equal to 90 receive an "A", scores from 80 to 90, not including 90, 
receive a "B" and so on.
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Select {Student.Test Scores}
   Case UpFrom 90 :
      "A"
   Case 80 To_ 90 :
      "B"
   Case 70 To_ 80 :
      "C"
   Case 60 To_ 70 :
      "D"
   Default :
      "F"; 

The above example uses the Select expression which is discussed in more detail in Control Structures (Crystal 
Syntax) [page 702]. You can check if a value is in a range by using the In operator. For example:

 5 In 2 To 10; //True
5 In 2 To_ 5; //False
5 In 2 To 5; //True 

The Maximum and Minimum functions can be used to find the endpoints of a range:

 Maximum (2 To 10) //Returns 10 

Related Information

Array Data Types (Crystal Syntax) [page 688]
Simple Data Types (Crystal Syntax) [page 684]

1.7.2.2.8 Array Data Types (Crystal Syntax)

Arrays in SAP Crystal Reports are ordered lists of values that are all of the same type. These values are known as 
the array's elements. The elements of an array can be any simple type or range type. Arrays can be created using 
square brackets ([ ]).

Arrays are most useful when used with variables. Using variables, you can change the individual elements of an 
array and resize the array to accommodate more elements. For example, you can accumulate database field 
values into a global array variable in a detail level formula, and then use a formula in a group footer to perform a 
calculation based on those values. This enables you to perform a wide variety of customized summary operations.

Examples

An array of three Number values. The first element is 10, the second is 5, and the third is 20.

 [10, 5, 20] 

An array of seven String values:

 ["Sun", "Mon", "Tue", "Wed", "Th", "Fri", "Sat"]
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An array of two DateTime Range values:

 [#Jan 1, 1998# To #Jan 31, 1998#,
 #Feb 1, 1999# To #Feb 28, 1999#] 

You can extract individual elements out of an array using square brackets containing the index of the element you 
want. This is called subscripting the array:

 [10, 5, 20] [2] // = 5 

Number ranges can also be used to subscript arrays. The result is another array. For example:

 [10, 5, 20] [2 To 3] // = [5, 20] 

1.7.2.2.9 Variables (Crystal Syntax)

A variable represents a specific data item, or value, and acts as a placeholder for that value. When a formula 
encounters a variable, the formula searches for the value of the variable and uses it in the formula. Unlike a 
constant value, which is fixed and unchanging, a variable can be repeatedly assigned different values. You assign a 
value to a variable and the variable maintains the value until you later assign a new value. Because of this 
flexibility, it is necessary for you to declare variables before you use them so that SAP Crystal Reports is aware of 
them and understands how you intend to use them.

If you wanted to report on customers by area code, you could create a variable that extracts the area code from a 
customer fax number. The following is an example of a variable called areaCode:

 Local StringVar areaCode;
areaCode := {Customer.Fax} [1 To 3]; 

The first line of the variable example is the variable declaration; it gives the variable a name and type. The 
database field {Customer.Fax} is a String field and [1 To 3] extracts the first three characters from its current 
value. The variable areaCode is then assigned this value.

1.7.2.2.9.1  Variable Declarations (Crystal Syntax)

Before using a variable in a formula, you must declare it. A variable can hold values of a given type. The allowed 
types are the seven simple types (Number, Currency, String, Boolean, Date, Time and DateTime), the six range 
types (Number Range, Currency Range, String Range, Date Range, Time Range and DateTime Range) and 
variables that hold arrays of the previously mentioned types. This gives a total of 26 different types that a variable 
can have.

When you declare a variable, you also specify its name. A variable cannot have the same name as any function, 
operator or other keyword that is valid for Crystal syntax. For example, your variable cannot be named Sin, Mod or 
If because Sin is a built in function, Mod is a built in operator and If is a built in keyword. When typing formulas in 
the formula editor, the names of the built in functions, operators and other keywords are highlighted in a different 
color and so it is easy to check if the variable name conflicts.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 689



Once a variable is declared, it can be used in the formula. For example, you might want to assign it an initial value:

 Local NumberVar x;
x := 10; 

Note
The keyword for declaring the Number variable has a Var at the end. This is true for all the variable types in 
Crystal syntax.

A variable can only hold values of one type. For example, if a variable holds a Number value, you cannot later use it 
to hold a String.

 Local StringVar y;
y := "hello"; //OK- the Length function expects a String argument. Length (y); //Error- y can only hold String values. y := #Jan 5, 1993#; //Error- y can only hold String values. y := ["a", "bb", "ccc"]; //Error- the Sin function expects a Number argument. Sin (y); 

You can combine declaring a variable and assigning it a value in a single expression. For example:

 Local NumberVar x := 10 + 20;
Local StringVar y := "Hello" + " " + "World";
Local DateVar z := CDate (#Sept 20, 1999#);
Local NumberVar Range gradeA := 90 To 100; 

This is a good practice because it is more efficient and helps prevent the common mistake of having incorrectly 
initialized variables.

Here are some more examples of declaring and initializing range variables:

 Local NumberVar Range gradeA;
Local DateVar Range quarter;
gradeA := 90 To 100;
quarter := CDate (1999, 10, 1) To CDate (1999, 12, 31); 

Related Information

Variable Scope (Crystal Syntax) [page 690]

1.7.2.2.9.2  Variable Scope (Crystal Syntax)

Variable scopes are used to define the degree to which variables in one formula are made available to other 
formulas. There are three levels of scope in SAP Crystal Reports:

● Local
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● Global
● Shared

Every variable has a scope, and this scope is specified when the variable is declared.

1.7.2.2.9.2.1  Local Variables (Crystal Syntax)

Variables with local scope are declared using the Local keyword followed by the type name (with the Var suffix) 
followed by the variable name.

Local variables are restricted to a single formula and a single evaluation of that formula. This means that you 
cannot access the value of a local variable in one formula from a different formula.

Example

 //Formula A 
Local NumberVar x;
x := 10;
//Formula B
EvaluateAfter ({@Formula A})
Local NumberVar x;
x := x + 1; 

The function call EvaluateAfter ({@Formula A}) ensures that Formula B will be evaluated after Formula A is 
evaluated. Formula A returns a value of 10 and Formula B returns a value of 1. Formula B does not have access to 
Formula A's x and thus cannot use the value of 10 and add 1; instead, it uses the default value for the uninitialized 
local variable x found in Formula B, which is 0, and adds 1 to it to get 1.

You can also create local variables with the same name but different types in different formulas. For example, the 
type declarations in formulas A and B do not conflict with:

 //Formula C
Local StringVar x := "hello"; 

Local variables are the most efficient of the three scopes. In addition, they do not interfere with one another in 
different formulas. For these reasons, it is best to declare variables to be local whenever possible.

1.7.2.2.9.2.2  Global Variables (Crystal Syntax)

Global variables use the same memory block to store a value throughout the main report. This value is then 
available to all formulas that declare the variable, except for those in subreports. You declare a global variable as 
in the following example:

 Global StringVar y; 

You can also omit the Global keyword which creates a Global variable by default:

  StringVar y; //Same as: Global StringVar y;  

However, even though global variables are easy to declare, it is recommended that you use them only when local 
variables do not suffice.
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Since global variables share their values throughout the main report, you cannot declare a global variable in one 
formula with one type and then declare a global variable with the same name in a different formula with a different 
type.

Example
 //Formula A
Global DateVar z;
z := CDate (1999, 9, 18)
//Formula B
NumberVar z;
z := 20 

In this case, if you enter and save Formula A first, SAP Crystal Reports will return an error when you check or 
try to save Formula B. This is because the declaration of the Global variable z as a Number conflicts with its 
earlier declaration in Formula A as a Date.

When to Use Global Variables

Global variables are often used to perform complex calculations where the results of a formula depend upon the 
grouping and page layout of the actual printed report. This is accomplished by creating several formulas, placing 
them in different sections of the report, and having the different formulas interact via global variables.

Example

 //Formula C
Global NumberVar x;
x := 10;
//Formula D
WhileReadingRecords;
Global NumberVar x;
x := x + 1 

If Formula C is placed in the Report Header and then Formula D is placed in a detail section, Formula C will be 
evaluated before Formula D. Formula C will be evaluated once and then Formula D will be evaluated for each 
record appearing in the detail section. Formula C returns 10. For the first detail record, Formula D returns 11. This 
is because the value 10 of x is retained from when it was set by Formula C. Formula D then adds 1 to this value, 
setting x to 11 and then returns 11. For the second detail record, formula D return 12, adding 1 to the previously 
retained value of x which was 11. This process continues for the remaining detail records.

The call to WhileReadingRecords tells SAP Crystal Reports to re-evaluate Formula D as it reads in each record of 
the report. Otherwise, since the formula does not contain any database fields, the program evaluates it only once 
before reading the records from the database. The formula will then return the value 11 instead of 11, 12, 13, ... as 
the successive records are processed.

If the expression x := x + 1 is replaced by x := x + {Orders Detail.Quantity}, you create the effect of a running total 
based on {Orders Detail.Quantity}, although it is one starting at 10 rather than 0 because of Formula C. In this 
case, you can omit the call to WhileReadingRecords, since it will automatically occur because the formula 
contains a database field.
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1.7.2.2.9.2.3  Shared Variables (Crystal Syntax)

Shared variables use the same memory block to store the value of a variable throughout the main report and all of 
its subreports. Thus shared variables are even more general than global variables. To use a shared variable, 
declare it in a formula in the main report as in the following example:

 Shared NumberVar x := 1000; 

and declare it in a formula in the subreport as in the following example:

 Shared NumberVar x; 

In order to use shared variables, the variable must be declared and assigned a value before it can be passed 
between the main report and the subreport.

Related Information

Global Variables (Crystal Syntax) [page 691]
Inserting Subreports [page 631]

1.7.2.2.9.3  Declaring Array Variables (Crystal Syntax)

You can declare array variables by following the type name with the keyword Array.

//Declare x to be a Global variable of Number Array type Global NumberVar Array x := [10 , 20, 30]; //Cost is a Global variable of Currency Array type.  //It is automatically Global since the scope specifier (one of Local, Global or 
Shared) is omitted. CurrencyVar Array cost := [$19.95, $79.50, $110.00,
                           $44.79, $223.99]; //payDays is a Global variable of Date Array type. Global DateVar Array payDays := [CDate(1999, 5, 15),
CDate(1999, 5, 31)]; //y is a Shared variable of String Range Array type. Shared StringVar Range Array y := ["A" To "C",
                                   "H" To "J"]; //days is a Local variable of String Array type. Local StringVar Array days;
days := ["Sun", "Mon", "Tue", "Wed", "Th", "Fri", "Sat"]; 

Assigning Values to Elements of an Array

You can assign values to elements of an array and also use the values of the elements for other computations.

 StringVar Array x := ["hello", "bye", "again"];
x [2] := "once"; // x == ["hello", "once", "again"] 
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//The expression below would cause an error if not commented out since the array 
has size 3.  //The formula returns the String "HELLO". UpperCase (x [1]) 

The Redim and Redim Preserve keywords can be used to resize an array if you want to add extra information to it. 
Redim erases the previous contents of the array first before resizing it whereas Redim Preserve preserves the 
previous contents.

 Local NumberVar Array x;
Redim x [2]; // x = [0, 0]
x [2] := 20; // x = [0, 20]
Redim x [3]; // x = [0, 0, 0]
x [3] := 30; // x = [0, 0, 30]
Redim Preserve x [4]; // x = [0, 0, 30, 0]
"finished"
Local StringVar Array a;
Redim a [2];
a[1] := "good";
a[2] := "bye"; a[1] & a[2] //The formula returns the String "goodbye"  

Arrays and For Loops

Arrays are commonly used with For loops. The following example creates and then uses the Array [10, 20, 30, ..., 
100] using a For loop. The below formula returns the Number 20.

 Local NumberVar Array b;
Redim b[10];
Local NumberVar i;
For i := 1 To 10 Do
(
   b[i] := 10 * i
);
b [2] 

1.7.2.2.9.4  Default Values for Simple Types (Crystal Syntax)

An uninitialized variable will have the default value for its type. In general, it is not a good programming practice to 
rely on the default values of types. For example, initialize all local variables in your formula, initialize all global 
variables in a formula placed in the Report Header and initialize all shared variables in a formula placed in the 
Report Header of the main report.

When an array is resized using the Redim keyword, the entries are filled with default values for the type.
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1.7.2.2.9.4.1  Default Values

Number

 0 

Currency

 $0 

String

  "" //The empty string.  

Date

  Date (0, 0, 0) //The null Date value.  

Time

The null Time value. Value held by an uninitialized Time variable.

DateTime

The null DateTime value. Value held by an uninitialized DateTime variable.

Note
It is not recommended that your formulas rely on the values of uninitialized range or array variables.
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1.7.2.2.9.5  Automatic Type Conversions (Crystal Syntax)

Generally in SAP Crystal Reports, values of one type cannot be used where values of another type are expected 
without explicitly supplying a type conversion function. For example:

 Local StringVar postalCode; //Error- assigning a Number value to a String. postalCode := 10025; //OK - use the type conversion function CStr to create "10025". postalCode := CStr (10025, 0); 

However, there are a few conversions that are made automatically:

● Number to Currency
● Date to DateTime
● Simple type to Range value of the same underlying simple type

For example, the following assignments are correct:

 Local CurrencyVar cost; //Same as: cost := $10 cost := 10;
Local DateTimeVar orderDate; //Same as: orderDate := CDateTime (1999, 9, 23, 0, 0, 0) orderDate := CDate (1999, 9, 23);
Local NumberVar Range aRange; //Same as: aRange := 20 To 20 aRange := 20;
Local NumberVar Range Array aRangeArray; //Same as: aRangeArray := [10 To 10, 20 To 25, 2 To 2] aRangeArray := [10, 20 To 25, 2]; 

Note
The opposite conversions are not allowed. For example:

 Local NumberVar num;
num := 5 + $10; //OK- convert to Number type using the CDbl function num := CDbl (5 + $10) 

5 is converted to $5 and added to $10 to make $15. However, this Currency value cannot be automatically 
assigned to the Number variable num since automatic conversions from Currency to Number are not allowed. 
Similarly, functions accepting a Currency argument can be supplied a Number argument instead, and the Number 
argument will be converted to a Currency, whereas functions accepting a Number argument cannot be supplied a 
Currency argument without first explicitly converting the Currency to a Number using CDbl.

1.7.2.2.10  Functions (Crystal Syntax)

Functions are built-in procedures or subroutines used to evaluate, make calculations on, or transform data. When 
you specify a function, the program performs the set of operations built into the function without you having to 
specify each operation separately.
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1.7.2.2.10.1  Functions Overview (Crystal Syntax)

When using a function in a formula, type the name of the function and supply the arguments required. For 
example, the Length function requires a String argument and computes the length of the string. The below 
formula returns the Number 5.

 Local StringVar x := "hello";
Length (x) 

Supplying arguments of the incorrect type required by the function produces an error. For example, calling Length 
(3) would produce an error since Length does not accept a Number argument.

Functions sometimes can accept different numbers of arguments or types of arguments. For example, the CDate 
function which could accept a single String argument to form a Date value or three Number values holding the 
year, month and day respectively and form a Date value from them. See Date, Time, and DateTime (Crystal 
Syntax) [page 686].

Example with the Mid function

 Local StringVar x := "hello";
Local StringVar y; //Start at position 2, go to the end of the string.  y := Mid (x, 2); //y is now "ello". //Start at position 2, extract 1 character y := Mid (x, 2, 1) //y is now "e".  

These classes of functions are: Math, Summary, Financial, String, Date/Time, Date Range, Array, Type 
Conversion, Programming Shortcuts, Evaluation Time, Print State, Document Properties and Additional 
Functions. There are also some functions specific to conditional formatting formulas.

1.7.2.2.10.2  Non Reporting-Specific Functions (Crystal Syntax)

The Math, Financial, String, Date/Time, Type Conversion, and Programming Shortcuts groups consist mainly of 
functions that are not specific to reporting, but might be found in any full featured programming environment. 
Many of the functions are similar in functionality to Visual Basic functions of the same or similar name.

Note
Some functions that are supported by Crystal syntax are not listed in the Crystal syntax Functions tree. This is 
because they are equivalent to Crystal syntax functions already listed in the tree.

For example, the Length function is the traditional Crystal syntax function for finding the length of a string. Crystal 
syntax also supports Len as a synonym. Len is the Visual Basic and Basic syntax function for this and its inclusion 
is for the convenience of Visual Basic and Basic syntax users who want to write or modify Crystal syntax formulas.
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1.7.2.2.10.3  Conditional Formatting Functions (Crystal Syntax)

When writing a conditional formatting formula, certain additional functions appear at the top of the Functions tree 
to help you with this. For example, you can format the {Customer.Last Year's Sales} field to print sales of more 
than $100,000 in green, sales of less than $15,000 in red, and all other sales in black.

Example

 If {Customer.Last Year's Sales} > 100000 Then
   crGreen
Else If {Customer.Last Year's Sales} < 15000 Then
   crRed
Else
   crBlack 

Since this is a font color formatting function, the list of Color Constants appears in the Functions Tree. This 
example uses three: crGreen, crRed and crBlack. You could have used the actual numeric values of the color 
constants instead. For example, crRed is 255 and crGreen is 32768. However, the formula is more understandable 
using the color constants. All constant functions in Crystal syntax can have the "cr" prefix.

Crystal syntax still supports constant functions from previous versions without the "cr" prefix. For example, you 
can use "Red" instead of "crRed". However, using the "cr" prefix organizes constant functions and is 
recommended.

Note
Some formatting attributes do not use constant functions. For example, if you wanted to not print 
{Customer.Last Year's Sales} values if the sales were less than $50,000, you could write the following 
conditional formatting formula for the suppress attribute:

 If {Customer.Last Year's Sales} < 50000 Then    True // Suppress the value. Else    False // Do not suppress the value.  

Or more simply:

 {Customer.Last Year's Sales} < 50000 

If the last year's sales are less than $50,000, then the expression

 {Customer.Last Year's Sales} < 50000 

is True, and so the formula returns True. On the other hand, if the last year's sales are greater than or equal to 
$50,000, then

 {Customer.Last Year's Sales} < 50000 

is False and so the formula returns False.
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1.7.2.2.10.4  General Purpose Conditional Formatting Functions 
(Crystal Syntax)

There are three general purpose conditional formatting functions:

● CurrentFieldValue
● DefaultAttribute
● GridRowColumnValue

DefaultAttribute can be used for any formatting formula, CurrentFieldValue for any formatting formula 
where you are formatting a field value, and GridRowColumnValue for any formatting formula where you are 
formatting a field value in a Cross-Tab or OLAP grid.

CurrentFieldValue enables you to conditionally format Cross-Tab or OLAP grid cells based on their value. 
GridRowColumnValue enables you to conditionally format the cells of a Cross-Tab or OLAP grid based on row or 
column headings values. These two functions are essential in some situations as there is no other way in the 
formula language to refer to these fields.

For example, if you wanted Cross-Tab cells to be suppressed if the values are less than 50,000:

 CurrentFieldValue < 50000 

1.7.2.2.11  Operators (Crystal Syntax)

Operators are special symbols or words that describe an operation or an action to take place between two or 
more values. The program reads the operators in a formula and performs the actions specified.

1.7.2.2.11.1  Arithmetic Operators (Crystal Syntax)

Arithmetic operators are used to combine numbers, numeric variables, numeric fields and numeric functions to 
get another number.

The arithmetic operators are addition (+), subtraction (-), multiplication (*), division (/), integer division (\), 
percent (%), modulus (Mod), negation (-) and exponentiation (^).

  //Outstanding preferred stock as a percent of common stock. {Financials.Preferred Stock} %
{Financials.Common Stock};
7 + 2 * 3 - 2 + Sqr(6 + 3) * Length("up"); //The formula returns 17.  
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Order of Precedence

In general, the program evaluates expressions in the following order:

● from left to right
● follows the rules of precedence from basic math

List of arithmetic operators, from highest precedence to lowest

● Exponentiation (^)
● Negation (-)
● Multiplication, division, and percent (*, /, %)
● Integer Division (\)
● Modulus (Mod)
● Addition and subtraction (+, -)

Multiplication and division are performed first from left to right. Then addition and subtraction are performed. For 
example, 5 + 10 * 3 = 5 + 30 = 35.

You can change this order of precedence by using parentheses. For example, (5 + 10) * 3 = 15 * 3 = 45. If you are 
unsure of the order of precedence, it is a good idea to clarify your intentions with parentheses.

1.7.2.2.11.2  Comparison Operators (Crystal Syntax)

Comparison operators are usually used to compare operands for a condition in a control structure such as an If 
expression.

The comparison operators are equal (=), not equal (<>), less than (<), less than or equal (<=), greater than (>) 
and greater than or equal (>=).

Comparison operators as a group all have lower precedence than the arithmetic operators. Thus, expressions like 
2 + 3 < 2 * 9 are the same as (2 + 3) < (2*9).

1.7.2.2.11.3  Boolean Operators (Crystal Syntax)

Boolean operators are typically used with comparison operators to generate conditions for control structures.

The Boolean operators are, in order of precedence from greatest to lowest: Not, And, Or, Xor, Eqv and Imp.

Boolean operators as a group have lower precedence than the comparison operators. Thus for example, the 
expression 2 < 3 And 4 >= -1 is the same as (2 < 3) And (4 >= -1).
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1.7.2.2.11.4  Null Fields and Null Values (Crystal Syntax)

In general, when SAP Crystal Reports encounters a null valued field in a formula, it immediately stops evaluating 
the formula and produces no value. If you want to handle null field values in your formula, you must explicitly do so 
using one of the special functions designed for handling them: IsNull, PreviousIsNull or NextIsNull.

Relating to operators, when SAP Crystal Reports evaluates the condition:

 IsNull({Product.Color}) Or
InStr({Product.Color}, " ") = 0 

It first evaluates IsNull ({Product.Color}), and when it determines that this is True, it knows that the whole 
condition is True, and thus does not need to check whether

 InStr({Product.Color}, " ") = 0 

In other words, SAP Crystal Reports will stop evaluating a Boolean expression when it can deduce the results of 
the whole expression. In the following example, the formula guards against attempting to divide by zero in the 
case that denom is 0:

 Local NumberVar num;
Local NumberVar denom;
...
If denom <> 0 And num / denom > 5 Then
... 

The {Product.Color} field contains both basic colors such as "red" and "black" and fancy two word colors such as 
"steel satin" and "jewel green". Suppose that you want to write a formula that writes out "basic" for the basic 
colors and "fancy" for the others.

 If InStr({Product.Color}, " ") = 0 Then
   "basic"
Else
   "fancy" 

The function call to InStr searches the {Product.Color} string for a space. If it finds a space, it returns the position 
of the space, otherwise it returns 0. Since basic colors are only one word with no spaces, InStr will return 0 for 
them.

For some products, such as the Guardian Chain Lock, a color value was not recorded and so the {Product.Color} 
field has a null value in the database for that record. Thus, the Guardian Chain Lock record does not have any 
word printed beside it.

Here is how to fix up the previous example using IsNull:

 If IsNull({Product.Color}) Or 
   InStr({Product.Color}, " ") = 0 Then
   "basic"
Else
   "fancy" 

Related Information

Formula Editor Dialog Box [page 599]
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1.7.2.2.12  Control Structures (Crystal Syntax)

Formulas without control structures execute each expression in the formula exactly once when the formula is 
evaluated. The expressions are executed in a sequential fashion, from the first expression in the formula to the 
last. Control structures enable you to vary this rigid sequence. Depending upon which control structure you 
choose, you can skip over some of the expressions or repeatedly evaluate some expressions depending on certain 
conditions. Control structures are the primary means of expressing business logic and typical report formulas 
make extensive use of them.

1.7.2.2.12.1  If Expressions (Crystal Syntax)

The If expression is one of the most useful control structures. It allows you to evaluate an expression if a condition 
is true and evaluate a different expression otherwise.

Note
When formatting with conditional formulas, always include the Else keyword; otherwise, values that don't meet 
the If condition may not retain their original format. To prevent this, use the DefaultAttribute function (If...Else 
DefaultAttribute).

Example

A company plans to pay a bonus of 4 percent to its employees except for those who work in Sales who will receive 
6 percent. The following formula using an If expression would accomplish this:

 If {Employee.Dept} = "Sales" Then
   {Employee.Salary} * 0.06
Else
   {Employee.Salary} * 0.04 

In this example, if the condition {Employee.Dept} = "Sales" evaluates as true, then the

 {Employee.Salary} * 0.06 

expression is processed. Otherwise the expression following the Else, namely the

 {Employee.Salary} * 0.04 

is processed.

Suppose another company wants to give employees a 4% bonus, but with a minimum bonus of $1,000. Notice 
that the Else clause is not included; it is optional, and not needed in this case.

 Local CurrencyVar bonus := {Employee.Salary} * 0.04;
If bonus < 1000 Then
   bonus := 1000; //The final expression is just the variable 'bonus'.  //This returns the value of the variable and is the result of the formula. bonus 

Another way of accomplishing example 2 is to use an Else clause:
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Local CurrencyVar bonus := {Employee.Salary} * 0.04;
If bonus < 1000 Then
   1000
Else
   bonus 

Now suppose that the previous company also wants a maximum bonus of $5,000. You now need to use an Else If 
clause. The following example has only one Else If clause, but you can add as many as you need.

Note
There is a maximum of one Else clause per If expression.

The Else clause is executed if none of the If or Else If conditions are true.

 Local CurrencyVar bonus := {Employee.Salary} * 0.04;
If bonus < 1000 Then
   1000
Else If bonus > 5000 Then
   5000
Else
   bonus; 

Example

Suppose that a company wants to compute an estimate of the amount of tax an employee needs to pay and write 
a suitable message. Income below $8,000 is not taxed, income between $8,000 to $20,000 is taxed at 20%, 
income between $20,000 to $35,000 is taxed at 29%, and income above $35,000 is taxed at 40%.

 Local CurrencyVar tax := 0;
Local CurrencyVar income := {Employee.Salary};
Local StringVar message := "";
If income < 8000 Then
(
   message := "no";
   tax := 0
)
Else If income >= 8000 And income < 20000 Then
(
   message := "lowest";
   tax := (income - 8000)*0.20
)
Else If income >= 20000 And income < 35000 Then
(
   message := "middle";
   tax := (20000 - 8000)*0.20 + (income - 20000)*0.29
)
Else
(
   message := "highest";
   tax := (20000 - 8000)*0.20 + (35000 - 20000)*0.29 +
          (income - 35000)*0.40
); //Use 2 decimal places and the comma as a thousands separator. Local StringVar taxStr := CStr (tax, 2, ","); "You are in the " & message & " tax bracket. " &
"Your estimated tax is " & taxStr & "."  
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Note
The use of variables is to simplify the logic of the computation. Also, there are two expressions that are 
executed when one of the conditions are met; one assigns the tax variable, and the other assigns the message 
variable. It is often useful to have multiple expressions executed as a result of a condition.

1.7.2.2.12.1.1  Grouping Expressions (Crystal Syntax)

The If expression is an expression. In other words it evaluates to a value of a given type. If there is no Else clause, 
and the condition is not true, then the value is the default value for the type. For example:

 If Length ({Employee.First Name}) < 5 Then
   "short" 

The above If expression returns a String value. The string value is "short" if the Employee's first name has fewer 
than 5 letters and the empty String "" otherwise.

Consider the formula:

 If Year({Orders.Order Date}) >= 1995 Then
   {Orders.Order Date} 

For order dates before 1995, the above If expression returns the null DateTime value. It is a DateTime value rather 
than a Date value since {Orders.Order Date} is a DateTime database field. The null DateTime value is not printed 
by SAP Crystal Reports so if the above formula is placed in a report, the formula field would be blank for order 
dates before 1995. Null Time values and null Date values behave similarly.

Here is an example that illustrates the use of parentheses to have more than one expression executed as the 
outcome of an If condition. A company charges a 5 percent fee for orders shipped within three days and a 2 
percent fee otherwise. It wants to print messages such as "Rush shipping is $100.00" or "Regular shipping is 
$20.00" as appropriate.

 Local StringVar message;
Local CurrencyVar ship;
If {Orders.Ship Date} - {Orders.Order Date} <= 3 Then
(
   message := "Rush";    //A semicolon at the end of the next line is optional.    ship := {Orders.Order Amount} * 0.05 ) //A semicolon cannot be placed here. Else
(
   message := "Regular";
   ship := {Orders.Order Amount} * 0.02;
); //The preceding semicolon is required to separate the If expression from the final 
expression below. message & " shipping is " & CStr (ship) 

When expressions are grouped together with parentheses, the whole group is considered as a single expression, 
and its value and type are the value and type of the final expression inside the parentheses.

  //The parentheses group expression as a whole has Currency type. (    //The first expression in the parentheses has String type.
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    message := "Rush";    //The second and final expression in parentheses has Currency type.    ship := {Orders.Order Amount} * 0.05;
) 

Thus, for example, the following formula gives an error. The reason is that the Then part of the If expression 
returns a Currency value while the Else part returns a String value. This is not allowed, since the If expression is an 
expression and so must always return a value of a single type.

 Local StringVar message;
Local CurrencyVar ship;
If {Orders.Ship Date} - {Orders.Order Date} <= 3 Then
(
   message := "Rush";
   ship := {Orders.Order Amount} * 0.05
)
Else
(    //The following 2 lines were interchanged.    ship := {Orders.Order Amount} * 0.02;
   message := "Regular";
);
message & " shipping is " & CStr (ship) 

One way of fixing up the erroneous formula without being careful about expression order is just to make the If 
expression return a constant value of the same type in every branch. For example, the If expression now returns 
the Number value 0:

 Local StringVar message;
Local CurrencyVar ship;
If {Orders.Ship Date} - {Orders.Order Date} <= 3 Then
(
   message := "Rush";
   ship := {Orders.Order Amount} * 0.05;
   0
)
Else
(
   ship := {Orders.Order Amount} * 0.02;
   message := "Regular";
   0
);
message & " shipping is " & CStr (ship) 

1.7.2.2.12.2  Select Expressions (Crystal Syntax)

The Select expression is similar to an If expression. Sometimes however, you can write clearer and less repetitive 
formulas using the Select expression. This example evaluates the {Customer.Fax} field to determine if the area 
code is for Washington state (206, 360, 509) or British Columbia, Canada (604, 250):

 Select {Customer.Fax}[1 To 3]
   Case "604", "250" :
      "BC"
   Case "206", "509", "360" :
      "WA"
   Default :
      ""; 
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The expression right after the Select keyword is called the Select condition. In the above example it is 
{Customer.Fax}[1 To 3]. The Select expression tries to find the first Case that matches the Select condition, and 
then executes the expression following the colon for that Case. The Default case is matched if none of the 
preceding cases match the Select condition. Notice that there is also a colon after the Default.

 Local StringVar areaCode := {Customer.Fax}[1 To 3];
If areaCode In ["604", "250"] Then
   "BC"
Else If areaCode In ["206", "509", "360"] Then
   "WA"
Else
   ""; 

This formula groups the number of Oscar nominations a movie received into low, medium, high or extreme 
categories and in the process, shows some of the possibilities for the expression lists following the Case labels.

 Select {movie.NOM}
   Case 1,2,3, Is < 1 :
   (
      10 + 20;
      "low"
   )
   Case 4 To 6, 7, 8, 9 :
      "medium"
   Case 10 :
      "high"
   Default :
      "extreme" 

The Default clause of the Select expression is optional. If the Default clause is missing and none of the cases are 
matched, then the Select expression returns the default value for its expression type. For example, if in the above 
example the Default clause were omitted and {movie.NOM} = 11, it would return the empty string "". The Select 
expression is an expression, and similar comments as in the More details on If expressions section apply to it as 
well.

1.7.2.2.12.3  For Loops (Crystal Syntax)

For loops enable you to evaluate a sequence of expressions multiple numbers of times. This is unlike the If and 
Select expressions where the program passes through each expression at most once during the formula's 
evaluation.

For loops are best when you know the number of times that the expressions needs to be evaluated in advance.

Example
Using a For loop

Suppose you want to reverse the {Customer.Customer Name} string. For example, "City Cyclists" becomes 
"stsilcyC ytiC".

 Local StringVar str := "";
Local NumberVar strLen := 
   Length ({Customer.Customer Name});
Local NumberVar i;
For i := 1 To strLen Do
(
   Local NumberVar charPos := strLen - i + 1;
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   str := str + {Customer.Customer Name}[charPos]
);
str 

Examine how this formula works assuming that the current value of the field {Customer.Customer Name} is 
"Clean Air". The variable strLen is assigned to be the length of "Clean Air", namely 9. The variable i is known as a 
For counter variable since its value changes with each iteration of the For loop. In other words, it is used to 
count the iterations of the loop. The For loop will iterate 9 times, during the first time, i is 1, then i is 2, then i is 3 
and so on until finally i = 9. During the first iteration, the ninth character of {Customer.Customer Name} is 
appended to the empty string variable str. Thus str equals "r" after the first iteration. During the second 
iteration, the eighth character of {Customer.Customer Name} is appended to str and so str equals "ri". This 
continues until after the ninth iteration, str equals, "riA naelC" which is the reversed string.

Example
Using a For loop and a Step clause

Here is a simpler version of the above formula that uses a Step clause with a negative Step value of -1. For the 
"Clean Air" example, i is 9 for the first iteration, 8 for the second, 7 for the third and so on until it is 1 in the final 
iteration.

 Local StringVar str := "";
Local NumberVar strLen := 
   Length ({Customer.Customer Name});
Local NumberVar i;
For i := strLen To 1 Step -1 Do
(
   str := str + {Customer.Customer Name}[i]
);
str 

Example
Using StrReverse

The simplest version is to use the built in function StrReverse:

 StrReverse ({Customer.Customer Name}) 

The built in String functions in SAP Crystal Reports can handle many of the string processing applications that 
would traditionally be handled using a For loop or some other kind of loop. However, For loops provide the most 
flexibility in processing strings and also power in processing arrays, which can be essential if the built-in 
functions do not cover your intended application.

1.7.2.2.12.3.1  For Loop Example (Crystal Syntax)

Here is a more detailed example of SAP Crystal Reports' string processing capabilities. The Caesar cipher is a 
simple code that is traditionally credited to Julius Caesar. In this code, each letter of a word is replaced by a letter 
five characters further in the alphabet. For example, "Jaws" becomes "Ofbx". Notice that "w" is replaced by "b"; 
since there are not 5 characters after "w" in the alphabet, it starts again from the beginning.
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Here is a formula that implements applying the Caesar cipher to the field {Customer.Customer Name} in the 
Xtreme database:

 Local StringVar inString := {Customer.Customer Name};
Local NumberVar shift := 5;
Local StringVar outString := "";
Local NumberVar i;
For i := 1 To Length(inString) Do
(
   Local StringVar inC := inString [i];
   Local StringVar outC;
   Local BooleanVar isChar :=
   LowerCase(inC) In "a" To "z";
   Local BooleanVar isUCaseChar :=
   isChar And (UpperCase (inC) = inC);
   inC := LCase(inC);
   If isChar Then
   (
      Local NumberVar offset :=
         (Asc(inC) + shift - Asc("a")) Mod
         (Asc("z") - Asc("a") + 1);
      outC := Chr(offset + Asc("a"));
      If isUCaseChar Then outC := UpperCase(outC)
   )
   Else
      outC := inC;
   outString := outString + outC
);
outString 

In the above example there is an If expression nested within the expression block of the For loop. This If 
expression is responsible for the precise details of shifting a single character. For example, letters are treated 
differently from punctuation and spaces. In particular, punctuation and spaces are not encoded. The general 
points here are that control structures can be nested within other control structures and that multiple expressions 
can be included in the (parentheses enclosed) expression blocks of other control structures.

1.7.2.2.12.3.2  Exiting from For Loops (Crystal Syntax)

You can exit from a For loop by using Exit For. The following example searches the Global array names for the 
name "Fred". If it finds the name, it returns the index of the name in the array. Otherwise it returns -1.

For example, if the names array is:

 ["Frank", "Helen", "Fred", "Linda"] 

Then the formula returns 3.

 Global StringVar Array names; //The names array has been initialized and filled in other formulas. Local NumberVar i;
Local NumberVar result := -1; //The UBound function returns the size of its array argument. For i := 1 to UBound (names) Do
(
   If names [i] = "Fred" Then
   (
      result := i;
      Exit For
   )
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);
result 

When considered as an expression, the For loop always returns the Boolean value True. Thus you will almost 
never want a For loop to be the last expression in a formula, since then the formula will then just display the value 
True rather than your intended result.

1.7.2.2.12.4  While Loops (Crystal Syntax)

A While loop can be used to execute a fixed block of statement an indefinite amount of time.

Two Types of While Loops

Table 23:

Type of Loop Explanation Example

While ... Do The While ... Do loop evaluates the con
dition, and if the condition is true, then it 
evaluates the expression following the 
Do.

When it has finished doing this, it evalu
ates the condition again and if the condi
tion is true, it evaluates the expression 
following the Do again.

It continues repeating this process until 
the condition is false.

 While condition Do
   expression 

Do ... While The Do ... While loop evaluates the ex
pression once no matter what.

It then evaluates the condition, and if the 
condition is true, evaluates the expres
sion again. This process continues until 
the condition is false.

 Do
   expression
While condition 

Note
The While loops support an Exit While statement to immediately jump out of the loop. Its use is analogous to 
the use of Exit For in For loops. As with the For loop, the While loop when considered as an expression always 
returns the Boolean value True.

While ... Do loop Example

The following example searches for the first occurrence of a digit in an input string. If a digit is found, it returns its 
position, otherwise it returns -1. In this case, the input string is set explicitly to a string constant, but it could be set 
equal to a String type database field instead.
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For example, for the input String, "The 7 Dwarves", the formula returns 5, which is the position of the digit 7.

 Local StringVar inString := "The 7 Dwarves";
Local NumberVar strLen := Length (inString);
Local NumberVar result := -1;
Local NumberVar i := 1;
While i <= strLen And result = -1 Do
(
   Local StringVar c := inString [i];
   If NumericText (c) Then
      result := i;
   i := i + 1;
);
result 

1.7.2.2.12.5  Preventing Infinite Loops (Crystal Syntax)

There is a safety mechanism to prevent report processing from hanging due to an infinite loop. Any one evaluation 
of a formula can have at most 100,000 loop condition evaluations per formula evaluation. For example:

 Local NumberVar i := 1;
While i <= 200000 Do
(
   If i > {movie.STARS} Then
      Exit While;
   i := i + 1
);
20 

If {movie.STARS} is greater than 100,000 then the loop condition (i <= 200000) will be evaluated more than the 
maximum number of times and an error message is displayed. Otherwise the loop is OK.

Note
The safety mechanism applies on a per formula base, not for each individual loop. For example:

 Local NumberVar i := 1;
For i := 1 To 40000 Do
(
   Sin (i);
);
While i <= 70000 Do
(
   i := i + 1;
) 

The above formula also triggers the safety mechanism since the 100,000 refers to the total number of loop 
condition evaluations in the formula and this formula will have 40001 + 70001 such evaluations.

710 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



1.7.2.3 Formula Size Restrictions

For reference purposes, here are the size restrictions of the formula language:

● The maximum length of a String constant, a String value held by a String variable, a String value returned by a 
function or a String element of a String array is 65,534 characters.

● The maximum size of an array is 1000 elements.
● The maximum number of arguments to a function is 1000. (This applies to functions that can have an 

indefinite number of arguments such as Choose).
● The maximum number of loop condition evaluations per evaluation of a formula is 100,000.
● Date-time functions modeled on Visual Basic accept dates from year 100 to year 9999. Traditional SAP 

Crystal Reports functions accept dates from year 1 to year 9999.

1.7.3  User Interface Reference

This section describes the dialog boxes available in SAP Crystal Reports. These topics appear when you press F1 
or click Help (the ? button) in a SAP Crystal Reports dialog box or window.

1.7.3.1 SAP Crystal Reports Dialog Boxes

This section describes the dialog boxes available in SAP Crystal Reports. These topics appear when you press F1 
or click Help (the ? button) in a SAP Crystal Reports dialog box or window.

1.7.3.1.1 Add Command to Report Dialog Box

Use this dialog box to write your own SQL command (query) which will be represented in SAP Crystal Reports as a 
Table object.

This dialog box appears when you double-click Add Command in the Database Expert.

SQL Query Enter the text of your SQL command in this box.

Parameter List Create, remove, or modify parameters for your SQL command in this box. Clicking Create or 
Modify opens the Command Parameter dialog box.

Related Information

Defining Virtual Tables Based on a Command/SQL Query [page 552]
Database Expert Dialog Box [page 833]
Command Parameter Dialog Box [page 731]
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1.7.3.1.2 Browse and Paste Data Dialog Box

Use the Browse and Paste Data dialog box to preview the data type, length, and content of any field and to paste a 
value into your formula or selection criteria.

This dialog box appears when you click the Browse Data button in the Formula Editor Dialog Box [page 774]. The 
source of the field (alias) and the field name appear as the title for the dialog box.

Type The data type for the field (string, number, and so on).

Length The field length that is defined for the specified data type.

Scroll Box A list of field values appears in the scroll box.

When you browse a field, by default you see the first 500 unique values of the field. You can change 
this for the current report by clearing the Select Distinct Data for Browsing option in the Report 
Options dialog box.

If Select Distinct Data for Browsing is not selected, browsing returns the unique values in the first 
500 records.

Note
Since most SQL servers do not support selecting distinct records for long data types such as 
memo and blob fields, selecting and browsing distinct records are not supported for such fields.

Paste Data Click the Paste Data button to paste the value into your formula.

If you fail to connect to a database because it is unavailable or password-protected, you can still 
browse on saved data.

Related Information

Report Options Dialog Box [page 795]
Accessing and Adding Data [page 549]
Performing Report Calculations [page 597]

1.7.3.1.3 Browse Data Dialog Box

Use the Browse Data dialog box to preview the data type, length, and content of any field.

This dialog box appears when you right-click a database field in the Field Explorer and choose Browse Field Data, 
or when you click the Browse Data button in a dialog box. The source of the field (alias) and the field name appear 
as the title for the dialog box.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.
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Type The data type for the field (string, number, and so on).

Length The field length that is defined for the specified data type.

Scroll Box A list of field values appears in the scroll box.

When you browse a field, by default you see the first 500 unique values of the field. You can change 
this for the current report by clearing the Select Distinct Data for Browsing option in the Report 
Options dialog box.

If Select Distinct Data for Browsing is not selected, browsing returns the unique values in the first 
500 records.

Note
Since most SQL servers do not support selecting distinct records for long data types such as 
memo and blob fields, selecting and browsing distinct records are not supported for such fields.

If you fail to connect to a database because it is unavailable or password-protected, you can still 
browse on saved data.

Related Information

Report Options Dialog Box [page 795]
Field Explorer [page 539]
Accessing and Adding Data [page 549]
Field and Text Objects [page 556]

1.7.3.1.4 Change Group Options Dialog Box

Use the Change Group Options dialog box to edit an existing group. This dialog box appears when you click the 
Options button in the Group Expert dialog box.

For details, see the Insert Group Dialog Box [page 782], which has the same functionality.

Related Information

Group Expert Dialog Box [page 838]

1.7.3.1.5 Change in Record Selection Formula Dialog Box

This dialog box appears when SAP Crystal Reports detects a change in your report's record selection formula.
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Use Saved Data Click this option to run the report using the current data (that is, fresh data is not retrieved 
from the database).

Refresh Data Click this option if you want to run the report with fresh data from the database.

Related Information

Selecting Records [page 566]

1.7.3.1.6 Chart Options Dialog Box

Use the Chart Options dialog box to change the general format, layout, and look of a chart. This dialog box 
appears when you right-click a chart in a report, point to Chart Options and click General.

1.7.3.1.6.1  General Tab (Chart Options)

The General tab lets you change the general formatting of the chart. The options available in the tab vary 
depending on the type of chart used in the report.

General

Use Depth Use this check box to apply a depth effect or to make a completely flat chart. This option is not 
available for 3D Charts.

Depth When Use Depth is selected, use this slider to specify the amount of depth to be applied to the chart 
frame and risers.

Direction When Use Depth is selected, use this slider to specify the direction in which the depth is applied.

Bar, Gantt, Numeric Axis, Radar, Stock, and 3D Riser Charts

Overlap Use this slider to change how much risers within each category overlap each other. At -100, the 
bars within each group will overlap each other. At +100, the bars will be as far apart as possible 
without overlapping the next category. This option is not available for Stock and 3D Riser charts.

Gap Width Use this slider to change the gap between each group of bar risers in each category. Larger values 
increase the distance between each group of bars, smaller values decrease the gap between each 
group.
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Riser Shape Choose an option from this list box to change the shape of each bar riser. This field is deactivated if 
the Use Depth checkbox is selected.

Bubble Charts

Size Use this slider to change the size of all markers in the bubble chart.

Shape Choose an option from this list box to change the shape of the markers from rectangular to circle, plus, 
star, etc. This selection will also change the shape of markers in the legend area of the chart if it is 
shown.

Column Charts

Overlap Use this slider to change how much risers within each category overlap each other. At -100, the 
columns within each group will overlap each other. At +100, the columns will be as far apart as 
possible without overlapping the next category. This option is not available for True 3D column 
charts.

Gap Width Use this slider to change the gap between the group of bar risers in each category. Larger values 
increase the distance between each group of columns, smaller values decrease the gap between 
each group.

Riser Shape Choose an option from this list box to change the shape of the column risers from rectangular to 
circle, star, plus, and so on. For True 3D column charts, you can select Rectangular Riser, Round 
Column, Cone/Pyramid, Floating Cube, or Floating Sphere. This field will be deactivated/grayed-
out if the Use Depth check box is selected.

Display 
Series Line

For stacked and percent column charts only, use this check box to show or hide a line that 
connects each series of risers in the chart.

Funnel Charts

Tilt Use this slider to tilt the funnel chart. Smaller values make the funnel more flat (facing the 
viewer), the maximum value will tilt the funnel such that its opening is an oval.

Funnel Width Use this slider to change the width of the bottom of the funnel. Larger values increase the width 
of the funnel's bottom, smaller values decrease the width until the funnel becomes a point.

Funnel Height Use this slider to change the height of the funnel chart. Larger values make the funnel appear 
more squat, while smaller values make the funnel appear taller (higher).

Explode Exploding a funnel chart detaches each data slice and adds an effect of the funnel being hollow 
inside. Use the slider to determine the distance between each detached slice.
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Restore 
Funnel

If you have changed formatting options in a Funnel chart, select this button to restore the 
options to their original settings.

Gauge Charts

Start Angle Adjust the angle to increase or decrease the circular range. A Start Angle of 0 and a Stop 
Angle of 180 creates a half-circle.

Stop Angle Adjust the angle to increase or decrease the circular range.

Circular Thickness Use this slider to change the thickness of the outline of the gauge. You may want to 
increase the circular thickness if you are adding Quality Bands to your gauge chart.

Number of Gauges 
per row

Use this slider to specify how many gauges you want to appear in one row in your report.

Beveled Frame Select this check box to add depth to the frame around the chart so that the frame looks 
like a button. To make your chart look like a button, you need to apply a fill color to the 
background of the chart.

Histogram Charts

Gap Width Use this slider to change the spacing between risers and the width of risers. Larger values make 
more space between the risers and thinner risers. Smaller values create less space between the 
riser and fatter risers.

Riser Shape Choose an option from this list box to change the shape of the risers. This field will be deactivated if 
the Use Depth checkbox is selected.

Line Charts

Line Style Use this list to choose the style of line you want to use. You can choose Markers and Lines, Markers 
Only, or Lines Only.

Size When either Markers and Lines or Markers Only is selected, use this slider to change the size of the 
markers.

Shape When either Markers and Lines or Markers Only is selected, choose an item from this list box to 
change the shape of markers from rectangular to circle, star, plus, etc.
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Pie or Doughnut Charts

Tilt Use this slider to tilt the pie chart. Smaller values make the pie more flat (facing the viewer), 
the maximum value will tilt the pie such that only the pie edge is shown.

Depth Use this slider to change the thickness of the pie.

Rotation Use this slider to rotate the pie.

Explode Exploding a pie or doughnut chart detaches all slices away from its center. Use this slider to 
detach all slices from the pie.

Pie Per Row In multi-pie charts, you can select how many pie charts are displayed on each row of the chart. 
The default setting displays two pie charts on each row. Use this slider to select a number of 
pies per row.

Hole Size If a doughnut (ring pie) chart is selected, use this slider to select the doughnut hole size (0 to 
100). A value of zero will select a normal pie chart with no hole in the middle.

Restore All 
Slices

When slices have been detached or removed from a pie chart, select this button to restore all 
slices to their original settings.

Scatter Charts

Show Markers Use this check box to show or hide the markers in a scatter chart. If you hide markers and do not 
select Connect Data Points with Lines, the scatter chart will not contain any risers that 
represent the values in your data.

Size Use this slider to change the size of the markers in the scatter chart. This option will only be 
available if Show Markers is selected.

Shape Choose a selection from this list box to change the shape of the markers in a scatter chart from 
rectangular to circle, star, plus, and so on. This selection will also change the shape of the 
markers in the legend area if it is shown. This option will only be available if Show Markers is 
selected.

Connect Data 
Points with 
Lines

Use this check box to show or hide a connecting line between each marker in a series.

Related Information

Chart Options Dialog Box [page 714]
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1.7.3.1.6.2  Layout Tab (Chart Options)

Use the Layout tab to change the chart type, select a dual-axes chart, and apply or remove 2.5D depth effect to 
the chart risers and frame.

The descriptions in this section apply to all chart types except Bubble, Histogram, Pie or Doughnut, Scatter, 
Surface, and Stock.

Type Select a radio button to change the chart type. See Chart Types [page 624] for overview of the main 
chart types and their most common uses.

Dual 
Axes

Select this check box to make the area chart have two numeric axes (Y1 and Y2). This option is only 
available for clustered and stacked area charts. It is not available for Percent and True 3D charts.

Split 
Dual 
Axes

When the Dual Axes check box is selected, half of the series in the chart are assigned to the primary 
numeric axis (Y1) and the other half to the secondary numeric axis (Y2). However, all risers are drawn 
from a single category axis base line. The series assigned to the Y1 and Y2 axes are drawn on opposite 
sides of the chart. If you want to physically split the chart and show two separate numeric axes, select 
this check box. If the Dual Axes check box is not selected, this check box will be grayed out.

Funnel Charts

2D Funnel Select this check box if you want a flat effect applied to the funnel. Do not select this check box if you 
want a 3D chart.

Bubble Charts

The chart layout options for a bubble chart can be used to select a dual-axes chart.

Dual Axes Select this check box to make the Bubble Chart have two numeric axes (Y1 and Y2).

Histogram Charts

The chart layout options for a histogram chart can be used to select a vertical or horizontal histogram.

Type To change the chart layout, select one of these radio buttons — Vertical Column or Horizontal Bar.

Pie or Doughnut Charts

Type To change the chart layout, select one of these radio buttons — Pie or Ring Pie.
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Pie Size 
Proportional to 
Total

Use this check box to make the size of the each pie chart proportional to the total values in 
your data. This option is only used for multiple pie charts. When your data includes more 
than one group/column, a pie chart is drawn for each category. Selecting this option will 
draw each pie proportional to the total that each pie represents.

2D Circular Pie By default, all 2D-charts are presented with a 3D-depth effect applied to the chart frame. 
Select this check box if you do not want this 3D-depth applied.

Scatter Charts

Dual Axes Select this check box to make the Scatter Chart have two numeric axes (Y1 and Y2).

Stock Charts

Style To change the riser style, select either Wall Street or Candle.

Layout To change the detail of the data shown by the risers, choose High Low, High Low Open, High Low Close, 
or Open High Low Close.

Note
The option you choose in the Layout area depends on the data available for your stock chart. For 
example, to use High Low Open, your data must include values for an opening price.

3D Surface Charts

Type To change the chart layout, select one of these radio buttons — Surface, Surface with Sides, or 
Honeycombed Surface.

Related Information

Dual Y Options Tab (Chart Options) [page 722]
Chart Options Dialog Box [page 714]
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1.7.3.1.6.3  Quality Bands Tab (Chart Options)

This option is available only for gauge charts. Use Quality Bands to break up a gauge into segments. Once you 
create these segments, you can add color to them.

For example, if you are using a gauge chart to track orders by region, you can add colored bands along the gauge 
to show that the red area of the gauge falls below the forecasted amount (for example, 0-499 orders), the yellow 
area of the gauge meets the forecasted amount (500-800 orders), and the green area of the gauge exceeds the 
forecasted amount (801-1000 orders).

Band Click the check box beside a band to activate it. Specify the minimum and maximum value for this band. 
You can add a maximum of 5 different bands to the gauge.

1.7.3.1.6.4  Ticks Tab (Chart Options)

This option is available only for stock charts. Use Ticks to show a short horizontal line that extends from the right 
or left of a bar in a stock chart. Ticks are used to represent open and close values.

Ticks Length Use this slider to change the length of Ticks in a stock chart.

Ticks Height Use this slider to change the height of Ticks in a stock chart.

Show Close Tick Select this option if you want to include a tick for close values in your stock chart.

1.7.3.1.6.5  Data Labels Tab (Chart Options)

Data labels show the actual values of each chart cell. Use the Data Labels tab to add data labels to your chart. 
Selectable data label values and locations will be slightly different depending on the chart type. Data labels are not 
available in 3D Surface charts.

Show Data 
Labels

You can show or hide data labels for all series in a chart or for a single series in a chart. Select 
this check box to show or hide data labels for all series in the chart.

Labels Location When the Show Data Labels check box is selected, choose an option from this list box to select 
where the data labels are displayed next to their associated riser in the chart. This option is not 
available for True 3D charts.

Label Format For area, bar, column, and line charts, choose the Value selection to show the values from the 
data sheet at the corresponding location on each riser. If Label is selected, the series labels are 
drawn. If Label & Value is selected, the series labels and the value from the data sheet will be 
shown.

For bubble charts, if (X,Y) value is selected, the first two values (X and Y position) that define 
each data point will be drawn for each bubble marker. If (X,Y, Bubble Size) is selected, the X-
position, Y-Position, and Size values will be shown. This selection is not available for Scatter 
charts or True 3D charts.
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Show as 
Percentage

If you selected a Label Format of Value or Label & Value in a percent or stacked chart, select 
this check box to show the percentage value that each riser represents.

Cumulative 
Values

If you selected a Label Format of Value or Label & Value in a percent or stacked chart, select 
this radio button to show the cumulative value of each riser.

Absolute Values In percent and stacked area charts, select this radio button to show the absolute value of each 
riser. You must have also selected either Value or Label & Value in the Label Format field.

Show Total If you selected Absolute Values, select this check box to show the total value of each category 
of risers.

Funnel Charts

Data labels can be used to show the actual values from your data. You can show the value associated with each 
funnel ring, or the values as a percentage of the whole. You can position this information on the funnel ring or 
outside each ring.

Show Values Select this check box to show or hide data label values for each ring in the funnel 
chart.

Show Values As 
Percentage

If Show Values is selected, select the check box to show the data values as a 
percentage of the total. Do not select this check box to show the absolute value that 
defines each ring.

Values on Funnel 
Rings / Values outside 
Funnel Rings

If Show Values is selected, select one of these radio buttons to display the data values 
on each funnel ring or outside each funnel ring.

Show Labels Select this check box to show or hide the series label associated with each funnel ring.

Labels on Funnel 
Rings / Labels outside 
Funnel Rings

If Show Labels is selected, select one of these radio buttons to display the labels on 
each funnel ring or outside each funnel ring.

Show Leader Lines If Show Values and the "Labels outside Funnel Rings" radio button is selected, or if 
Show Labels and the "Values outside Funnel Rings" radio button is selected, use this 
check box to show or hide leader lines from each funnel ring to the data value 
displayed next to it.

Pie or Doughnut Charts

Data labels can be used to show the actual values from your data. You can show the value associated with each 
pie slice, the series label only, or the value and the series label. You can position this information on the pie slice or 
outside each slice.

Note
You can also show or hide and format data labels for an individual series in a chart.
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Show Values Select this check box to show or hide data label values for each slice in the pie chart.

On Slices / Outside 
Slices

If Show Values is selected, select one of these radio buttons to display the data values on 
each pie slice or outside each pie slice.

As Percentage If Show Values is selected, select the check box to show the data values as a percentage 
of the total. Do not select this check box to show the absolute value that defines each 
slice.

Show Labels Select this check box to show or hide the series label associated with each pie slice.

On Slices / Outside 
Slices

If Show Labels is selected, select one of these radio buttons to display the series labels on 
each pie slice or outside each pie slice.

Show Leader Lines If Show Values and the Outside Slices radio button is selected, or if Show Labels and the 
Outside Slices radio button is selected, use this check box to show or hide leader lines 
from each pie slice to the data value and/or series label displayed next to it.

Labels on Sides Select this check box to draw labels on the sides of the pie chart.

1.7.3.1.6.6  Numbers Tab (Chart Options)

When you enable the display of data labels in the Data Labels tab of Chart Options, you can select different kinds 
of information to display:

● For Area, Bar, Column, Line, Numeric Axis, and Radar charts, you can select Value, Label, or Label & Value. If 
you selected Label, the chart will show series labels only and you cannot format them as numeric values even 
if the series labels are numbers. If you selected Value or Label & Value, you can format these values using the 
Numbers tab in Chart Options.

● For Bubble charts, you can select (X,Y) Value or (X,Y, Bubble Size). Only the Bubble Size values can be 
formatted using the Numbers tab in Chart Options. (X,Y) Values always use the number format selected for 
the X- and Y-axis labels.

● For Scatter charts, the Numbers tab is not included in the Chart Options dialog box. The data labels use the 
same format and the X- and Y-axis labels.

Use the Numbers tab to format data label numbers. See Numeric Axis Grids and Scales Dialog Box [page 790] if 
you want to format numbers that appear on a numeric axis (Y1, Y2, or X).

1.7.3.1.6.7  Dual Y Options Tab (Chart Options)

Use the Dual Y Options tab to change the layout of any chart (except Gantt, Gauge, Histogram, Stock, Pie, and 3D 
charts) to include two numeric axes — a Primary (Y1) axis and a Secondary (Y2) axis. When a dual-axes layout is 
chosen, you can split the two axis to be drawn from separate physical base lines or have all risers drawn from a 
single base line.

Primary (Y1) 
Axis/Secondary 
(Y2) Axis

When the Dual Axes check box is selected on the Layout tab of the Chart Options dialog box, 
the number of series is automatically divided and half of the series are assigned to one axis 
and the other half to the second axis. Select a series label in the Primary (Y1) Axis list box and 
click the [>>] button to move the series to the Secondary (Y2) Axis. Select a series label in the 
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Secondary (Y2) Axis list box and click the [<<] button to move the series to the Primary (Y1) 
axis.

Note
The arrow buttons will be inactive unless you select a series label first.

Split Position When the Dual Axes and Split Dual Axes check boxes are selected in the Layout tab of the 
Chart Options dialog, use this slider to select the location where the two halves of the chart 
will be physically split.

Show Axis Split Select this check box to show or hide the dual axes split line.

1.7.3.1.6.8  Look Tab (Chart Options)

Use the Look tab to format the color of the risers and to change the placement of the legend and marker text. You 
can color the risers by series (area) or segment (category).

Color Mode In the normal configuration, a different color riser or marker is used for each series that is 
defined in the data. However, you may choose that all risers in a group use the same color or that 
risers be colored according to their height (or their associated value in the data). Choose an 
option from this list box. This option is not available in area, bubble, pie, doughnut, and scatter 
charts.

Note
For line charts, the options are called Color by Line (Series) and Color by Segment (Group).

Show Legend Select this check box to show or hide the chart legend. If this check box is not selected, all other 
selections in this dialog box will be grayed out. This option is not available for histogram and 3D 
charts.

Markers and 
Text

If Show Legend is selected, select from this list box to define the content and format of the 
legend area. This option is not available for histogram and 3D charts.

Layout Choose an item from this list box to define where the legend area (markers and text) should be 
drawn within the chart frame: Legend on Right Side, Legend on Left Side, or Legend Below Chart. 
This option is not available for histogram and 3D charts.

Box Style Select an item from this list box to draw text box around the entire legend area: No Frame, Single 
Line Frame, Double Line Frame, Beveled Frame, or Reverse Beveled Frame. This option is not 
available for histogram and 3D charts.

Link Wall 
Colors to 
Floor Color

Select this check box to link the colors of the walls of a 3D riser chart to the color of the floor.
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3D Surface Charts

Color Mode In the normal configuration, a different color riser or marker is used for each series that is 
defined in the data. However, you may choose that all risers in a group use the same color or 
that risers be colored according to their height (or their associated value in the data). Choose an 
option from this list box.

Color By 
Height

If Exact Color by Height is selected in the Color Mode field, select the fill color tabs to show the 
color grid where you can choose the beginning and ending colors to be used for coloring the 
surface risers by their height.

Link Wall 
Colors to Floor 
Color

Select this check box to link the colors of the walls to the color of the floor.

Pie or Doughnut Charts

Show Legend Select this check box to show or hide the chart legend. If this check box is not selected, all other 
selections in this dialog box will be grayed out.

Show Values Select this check box to add data values to your legend.

Show Percents Select this check box to add percentages of the total data value to your legend.

Note
You can add both data values and percentages of the total data value by selecting both 
options.

1.7.3.1.6.9  Display Status Tab (Chart Options)

Use the Display Status tab to show or hide chart objects.

Group Axis Select this check box to show or hide the group axis and its labels.

Data Axis Select this check box to show or hide the data axis and its labels.

Data2 Axis If the Dual Axes check box was selected on the Layout tab of the Chart Options dialog box, use this 
check box to show or hide the secondary numeric axis and its labels.

Series Axis If a True 3D chart is selected on the Layout tab of the Chart Options dialog box or a 3D surface 
chart is selected, use this check box to show or hide the series axis and its labels.

X-Axis In Bubble, Scatter, and Histogram charts, select this check box to show or hide the X-axis and its 
labels.

Major Grid For each axis in the chart (Category, Value Axis, Secondary Value Axis, X-axis), select these check 
boxes to show or hide the major gridlines on each axis.
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Minor Grid For each axis in the chart (Category, Value Axis, Secondary Value Axis, X-axis), select these check 
boxes to show or hide minor major gridlines on each axis.

Legend Select this check box to show or hide the chart legend. This option is not available in True 3D and 
Histogram charts.

Data Labels Select this check box to show or hide data labels for all series in the chart. This option is not 
available in True 3D charts.

Left Wall In 3D charts only, select this check box to show or hide the 3D cube left wall.

Right Wall In 3D charts only, select this check box to show or hide the 3D cube right wall.

Floor In 3D charts only, select this check box to show or hide the 3D cube floor.

Funnel Charts

You can show or hide chart objects on the Display Status tab of the Chart Options dialog box.

Show Funnel Name Select this check box to show or hide the funnel name.

Show Legend Select this check box to show or hide the chart legend.

Funnel Labels Select this check box to show or hide data labels for each slice in a funnel chart.

Pie or Doughnut Charts

You can show or hide chart objects on the Display Status tab of the Chart Options dialog box.

Show Pie Name In pie charts, the category label(s) are drawn below each pie. Select this check box to show or 
hide the pie name.

Show Pie Total In doughnut (ring pie) charts, select this check box to show or hide the total value in the center 
of each pie.

Show Legend Select this check box to show or hide the chart legend.

Slice Labels Select this check box to show or hide data labels for each slice in a pie chart.

1.7.3.1.7 Chart Sort Order Dialog Box

Use the Chart Sort Order dialog box to sort and group your chart data. This dialog box appears when you click the 
Order button on the Data tab of the Chart Expert for a chart with the Advanced layout type.

For details, see the Insert Group Dialog Box [page 782], which has similar functionality.
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1.7.3.1.8 Choose a Chart Type Dialog Box

Use the Choose a Chart Type dialog box to change the chart type and chart layout. This dialog box appears when 
you right-click on a chart, point to Chart Options, and click Template.

Area Charts

After you select Area on the Gallery tab, you can choose one or more of the following options:

Layout Select Absolute, Stacked, Percent or a True 3D area chart.

Dual Axes For Absolute and Stacked area charts, select this check box if you want to make an area chart 
with two numeric axes. This will allow you to chart some of the series on one axis and some of 
the series on another axis.

Split Dual 
Axes

When the Dual Axes check box is selected, use the Split Dual Axes check box to divide the series 
between two physical axes in the chart.

Use Depth Select this check box if you want a 3D-depth effect applied to the chart frame and risers. Do not 
select this check box if you want a flat 2D chart.

Bar or Column Charts

After you select Bar or Column on the Gallery tab, you can choose one or more of the following options:

Layout Select Clustered, Stacked, Percent or a True 3D riser chart. The True 3D option is not available 
for Bar charts.

Riser Shape Click this list box to select from a list of riser shapes (for example, for a True 3D Riser chart, you 
might select Rectangular Riser, Round Column, Cone/Pyramid, Floating Cube, or Floating 
Sphere).

Dual Axes For Clustered and Stacked charts, select this check box if you want to make a bar or column 
chart with two numeric axes. This will allow you to chart some of the series on one axis and some 
of the series on another axis.

Split Dual 
Axes

When the Dual Axes check box is selected, use the Split Dual Axes check box to divide the series 
between two physical axes in the chart.

Use Depth Select this check box if you want a 3D-depth effect applied to the chart frame and risers. Do not 
select this check box if you want a flat 2D chart.
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Bubble Charts

After you select Bubble on the Gallery tab, you can choose one or more of the following options:

Marker 
Shape

Select this list box to choose a different marker shape. The standard configuration draws circular 
markers. After the chart is created, you can select different marker shapes for all or individual 
series in the chart.

Dual Axes Select this check box if you want to make a chart with two numeric axes. This will allow you to 
chart some of the series on one axis and some of the series on another axis.

Funnel Charts

After you select Funnel on the Gallery tab, you can choose the following option:

2D Funnel Select this check box if you want a flat effect applied to the funnel. Do not select this check box if you 
want a 3D chart.

Gantt Charts

After you select Gantt on the Gallery tab, you can choose the following option:

Use Depth Select this check box if you want a 3D-depth effect applied to the chart frame and risers. Do not 
select this check box if you want a flat 2D chart.

Gauge Charts

After you select Gauge on the Gallery tab, you can choose one or more of the following options:

Start Angle Adjust the angle to increase or decrease the circular range. A Start Angle of 0 and a Stop 
Angle of 180 creates a half-circle.

Stop Angle Adjust the angle to increase or decrease the circular range.

Circular Thickness Use this slider to change the thickness of the outline of the gauge. You may want to 
increase the circular thickness if you have added Quality Bands to your gauge chart.

Number of Gauges 
per row

Use this slider to specify how many gauges you want to appear in one row in your report.

Beveled Frame Select this check box to add depth to the frame around the chart so that the frame looks 
like a button. To make your chart look like a button, you need to apply a fill color to the 
background of the chart.
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Histogram Charts

After you select Histogram on the Gallery tab, you can choose one or more of the following options:

Layout For Histograms, you can select Vertical Column or Horizontal Bar.

Marker 
Shape

If Use Depth is not selected in the field below, select this list box to choose a different marker 
shape. The standard configuration draws rectangular markers for all risers. After the chart is 
created, you can select different marker shapes for all or individual series in the chart.

Use Depth Select this check box if you want a 3D-depth effect applied to the chart frame and risers. Do not 
select this check box if you want a flat 2D chart.

Line Charts

After you select Line on the Gallery tab, you can choose one or more of the following options:

Layout Select Absolute, Stacked, Percent or a True 3D Line chart.

Line Style Use this list to choose the style of line you want to use. You can choose Markers and Lines, 
Markers Only, or Lines Only.

Marker 
Shape

If either Markers and Lines or Markers Only is selected for an Absolute, Stacked, or Percent line 
chart, select this list box to choose a different marker shape. The standard configuration draws 
rectangular markers for all risers. After the chart is created, you can select different marker 
shapes for all or individual series in the chart.

Dual Axes For Absolute and Stacked line charts, select this check box if you want to make a chart with two 
numeric axes. This will allow you to chart some of the series on one axis and some of the series on 
another axis.

Split Dual 
Axes

When the Dual Axes check box is selected, use the Split Dual Axes check box to divide the series 
between two physical axes in the chart.

Use Depth Select this check box if you want a 3D-depth effect applied to the chart frame and risers. Do not 
select this check box if you want a flat 2D chart.

Pie or Doughnut Charts

After you select Pie on the Gallery tab, you can choose one or more of the following options:

Layout For Pie charts, select a Pie or Ring Pie chart.

Note
Ring Pie charts are also known as Doughnut charts.
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Pie Size Proportional 
to Total

For multiple pies only. Select this checkbox to make the size of each pie proportional to 
the other pies in your chart.

2D Circular Pie Select this check box if you want to have a flat (2D) pie chart. By default, all charts are 
presented with a 3D-depth effect applied to the chart frame and risers. Select this check 
box if you do not want this 3D-depth applied.

Scatter Charts

After you select Scatter on the Gallery tab, you can choose one or more of the following options:

Marker Shape Select this list box to choose a different marker shape. The standard configuration draws 
rectangular markers for all risers. After the chart is created, you can select different marker 
shapes for all or individual series in the chart.

Connect Data 
Points with Lines

For Scatter charts only, select this check box if you want the scatter markers in the chart to be 
connected with lines.

Dual Axes Select this check box if you want to make a scatter chart with two numeric axes. This will allow 
you to chart some of the series on one axis and some of the series on another axis.

Stock Charts

After you select Stock on the Gallery tab, you can choose one or more of the following options:

Style Select Wall Street or Candle as your chart's style.

Layout Select High Low, High Low Open, High Low Close, or Open High Low Close as your chart's layout.

Dual Axis Select this check box if you want to make a stock chart with two numeric axes. This will allow you to 
chart some of the series on one axis and some of the series on another axis.

Surface

After you select Surface on the Gallery tab, you can choose the following option:

Layout For 3D Surface charts, you can select Surface, Surface with Sides, or Honeycomb Surface.

Custom Charts

The custom charts are chart templates that have been created by Crystal Decisions. After you have created your 
first chart, you may also use the Save As function in the File menu to create your own custom charts (you can also 
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use the Save as Template option on the chart's shortcut menu). The custom chart files (.3TF) contain attributes 
and data that define the format and look of a chart.

After you click the Custom tab, you can do the following:

● Click one of the items in the Categories list box to show the custom charts in each category.
● Click a custom chart picture that you want to import into your application.
● Click the OK button to import the chart.

Related Information

Chart Types [page 624]

1.7.3.1.9 Choose Field Dialog Box

Use the Choose Field dialog box to select a field for record selection or to select a field as a function argument in 
the Formula Expert.

This dialog box appears when you choose Select Expert from the Report shortcut menu if you do not have a field 
selected and you have not already created a record selection formula. The dialog box also appears when you click 
Choose Other Field in the Function Arguments area of the Formula Expert.

Fields This list displays the report fields and database fields available in your report for use in record selection 
or the Formula Expert.

Browse Click Browse to browse the data in the selected field.

Related Information

Select Expert Dialog Box [page 846]
Filtering Data [page 566]

1.7.3.1.10  Color Dialog Box

Use this dialog box to specify the color you'd like to use on your report if one of the default values will not do.

The Color dialog box opens when you choose Custom or More from any list of colors.

Basic colors This grid displays an assortment of pre-defined colors and shades. These choices allow you to 
use color shades to represent data ranges in your reports. For example, a best selling item 
might be bright blue, while subsequent items are represented by darker shades of blue.
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Custom colors This grid displays colors you have created by using Define Custom Colors (until you define 
custom colors, the grid contains only white sample boxes).

Define Custom 
Colors

Click Define Custom Colors to see the custom color palette. Click and drag in the color and/or 
solid palettes to see a sample of the color as you create it. You can also define custom colors 
by entering settings in the boxes below the palettes.

Add to Custom 
Colors

Click this button to add your new color to the Custom colors grid.

Related Information

Formatting Data [page 608]

1.7.3.1.11  Command Parameter Dialog Box

The Command Parameter dialog box appears when you click Create or Modify in the Add Command to Report 
dialog box.

Use this dialog box to create or modify parameters for your SQL command. See Create Parameter Field Dialog 
Box [page 731] for information about how to complete the fields in this dialog box.

Related Information

Setting Parameters [page 576]
Add Command to Report Dialog Box [page 711]

1.7.3.1.12  Create Parameter Field Dialog Box

Use the Create Parameter Field dialog box to create a parameter field that you can use in a formula, in a record 
selection formula, or in the body of the report itself.

This dialog box appears when you right-click Parameter Fields in the Field Explorer and click New.

Note
This dialog box is the same as the Edit Parameter Field dialog box. This description applies to both dialog 
boxes.
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Name Enter the name you want to assign to the parameter field in this box. This is the name that will 
appear in the Fields list in the Formula Editor and it will be used to identify the field when the field 
is used in the report or in a formula.

Note
When a parameter field name appears, the program puts a question mark at the beginning of 
the name, to identify it as a parameter field. Thus, if you name a parameter field "Prompt 1," 
the name will appear in the field list in the Formula Editor as "?Prompt1."

Prompting 
text

Enter the text you want the program to use for your prompt into this box.

Value type Select the data type of the parameter field from this list.

If you select Date or DateTime for your parameter's Value type, you can alter the default date/
time formats in the Fields Tab (Default Settings) [page 752] of the Default Settings dialog box.

All Parameter Value Types Except Boolean

Allow multiple values By selecting the Allow multiple values check box, you can select more than one default 
value for your parameter field.

Discrete value(s) By selecting the Discrete value(s) option, you can select only discrete, or singular, values 
for your parameter field. If you have Allow multiple values selected, you will be able to 
select more than one discrete value for your parameter field, though those discrete values 
will continue to function singularly as opposed to a range value.

Range value(s) By selecting the Range value(s) option, you can select a range of values for your 
parameter field.

Discrete and Range 
Values

This option is only available if you select the Allow multiple values check box.

Selecting this option enables you to choose both discrete and range values for your 
parameter field.

Default Values Click the Default Values button to set the default prompt settings for the parameter field 
you are creating.

Allow editing of 
default values when 
there is more than 
one value

This check box is, by default, selected. With the check box selected, you can edit values in 
the parameter field after the parameter field has been added to the report.

Boolean Parameter Value Types

Place in 
parameter group

Select the Place in parameter group check box to add your Boolean parameter field to a 
group. When users select a group of Boolean parameters, they can assign the same or 
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different values to each item in the group (this behavior is controlled by the Group is 
exclusive option).

Parameter group 
number

Use this field to enter the number of the group you want to add the current Boolean 
parameter to.

Group is exclusive Select this check box to ensure that users can choose only one Boolean parameter from a 
given group to have True values. All other parameters in the same group automatically 
become False.

If you clear this check box, users can combine Boolean parameters from several different 
groups and select which are to be True.

Default Values Click Default Values to set the default prompt settings for the parameter field you are 
creating.

Dynamic Cascading Parameters

Both dynamic prompts and cascading lists of values are available in SAP Crystal Reports Developer. These 
features let you populate the lists of values associated with a prompt from a data source outside of your report. A 
dynamic prompt can include a cascading list of values; that is, you can create a prompt whose final value is 
determined through a sequence of choices. For example, users might first be prompted to pick a country before 
the choices for region appear. The users might then need to pick a region before the choices for city appear, and 
so on. For example, a list of countries could be a dynamic prompt, while a hierarchical list of countries, regions, 
and cities could be a dynamic prompt with a cascading list of values.

Note
The Dynamic Cascading Parameters feature is not available in SAP Crystal Reports, developer version for 
Microsoft Visual Studio, but is available in one of the upgraded versions.

Related Information

Setting Parameters [page 576]
Limiting Entry Type and Format in Parameters [page 579]
Incorporating Parameters into Formulas [page 581]
Tutorial: Reading and Setting Discrete Parameters [page 219]
Tutorial: Reading and Setting Discrete Parameters [page 326]
Field Explorer [page 539]
SAP BusinessObjects Business Intelligence reporting solutions [page 59]
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1.7.3.1.13  Create Running Total Field Dialog Box

Use this dialog box to create or edit running total fields. Running totals are totals that are displayed on a record by 
record basis. Running Totals total all records (in the report, in the group, and so on) up to and including the 
current record.

This dialog box appears when you right-click Running Total Fields in the Field Explorer and click New.

Note
This dialog box is the same as the Edit Running Total Field dialog box. This description applies to both dialog 
boxes.

Available Tables and 
Fields

Lists all tables and fields in the report. Choose the field you want to summarize (the field 
on which a running total will be based) from this list.

Running Total Name Type the name of your running total, for example Last Year's Sales, into the Running 
Total Name box.

Summary

Field to 
summarize

The Field to summarize list will display a field you select from the Available Tables and Fields 
list. The running total you are creating will be based on the field in the Field to summarize list.

Use the Add button (>) to copy a field from the Available Tables and Fields list to the Field to 
summarize list.

Type of 
summary

Use the Type of summary list to select from a number of summary options. The summary type 
you choose will determine the running total calculation.

Note
Summary-type options change depending on the field you chose to summarize.

Evaluate

For each record Use the For each record option to have your running total evaluate each record in a field.

On change of field Use the On change of field option to have your running total perform its evaluation only 
when a specified field has changed.

Note
Use the Add button (>) to copy a field from the Available Tables and Fields list to the On 
change of field list.
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On change of 
group

Use the On change of group option to have your running total perform its evaluation only 
when a specified group has changed.

Use a formula Select the Use a formula option to have your running total use a formula when performing 
its calculations.

Reset

Never Use the Never option to lock your running total field. With the Never button selected, your 
running total will perform its calculations on that field throughout the entire report.

On change of 
field

Use the On change of field list to have your running total evaluate or reset when a designated 
field changes.

Note
Use the Add button (>) to copy a field from the Available Tables and Fields list to the On 
change of field list.

On change of 
group

Use the On change of group list to have your running total evaluate or reset when a 
designated group changes.

Use a formula Select the Use a formula option to have your running total use a formula to determine when 
to reset.

Related Information

Creating Running Totals [page 593]
Placement of Running Total Fields [page 593]
Formula Editor Dialog Box [page 599]

1.7.3.1.14  Cross-Tab Group Options Dialog Box

Use the Cross-Tab Group Options dialog box to create or modify group options for any row or column field used in 
the cross-tab report. The Group Options button is not available for summarized fields.

For details, see the Insert Group Dialog Box [page 782], which has similar functionality.

1.7.3.1.15  Crystal Report Gallery Dialog Box

Use the Crystal Report Gallery to select a Report Expert for step-by-step help in creating a report, or to create a 
report from scratch.
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Create a New Crystal Report Document

Using the Report Expert Guides you through the report creation process and adds your choices to the Report 
Designer.

As a Blank Report Opens the Report Designer.

From an Existing Report Creates a new report with the same design as another report you specify.

Choose an Expert

Standard The Standard Report Expert guides the creation of a typical report.

Cross-Tab The Cross-Tab Report Expert guides the creation of a report that contains a summarized grid.

Mail Label The Mail Label Report Expert guides the creation of a report with multiple columns. This is 
commonly used to create a sheet of address labels.

Related Information

Using the Embedded SAP Crystal Reports Designer [page 531]
Report Processing Model [page 544]
Report Creation Wizards [page 812]

1.7.3.1.16  Custom Function Name Dialog Box

Use the Custom Function Name dialog box to specify a name for your function.

This dialog box appears when you select Report Custom Functions in the Formula Workshop dialog box and then 
click the New button.

Name Use this box to type in the name of your new function.

Note
The name you assign a custom function can contain only numbers, letters, and the underscore 
character. Custom function names cannot begin with a number.

Use Extractor Click the Use Extractor button if you want to use the Extract Custom Function from Formula 
dialog box for creating your function.

Use Editor Click the Use Editor button if you want to use the Custom Function Editor dialog box for creating 
your formula.
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Related Information

Formula Workshop Dialog Box [page 779]
Custom Functions [page 601]

1.7.3.1.17  Custom Function Properties Dialog Box

Use this dialog box to specify additional information and default values for your custom function. The Custom 
Function Properties dialog box appears when you:

● select an existing custom function when the Toggle properties display button is selected on the Formula 
Workshop toolbar.

● click Enter More Info on the Extract Custom Function from Formula dialog box
● click More Info in the Formula Expert (in this case, the content of the Custom Function Properties dialog box is 

only for reference).

Name This field is only for reference. It displays the name specified when the custom function was 
created.

Summary Use this area to add additional information about your custom function to help identify its 
purpose, intended use, and so on.

Category Use this area to define a category for your custom function. Categories are a way of grouping 
certain custom functions; they appear as subfolders in the Report Custom Functions folder of 
the Formula Workshop tree view and in the Functions window of the Formula Editor dialog 
box.

If you want to create further levels, use a forward slash in the category definition.

Repository This field is only for reference. It displays the name of the repository to which the custom 
function is connected or was last connected, if any. The custom function must be connected 
to the repository for this field to contain information.

Display in 
Experts

Select this option if you want your function to be displayed in the Custom Function Supplying 
Logic list of the Formula Expert.

Author Use this field to add the name of the creator of the custom function.

Return Type This field is only for reference. It displays the data type of the argument.

Help Text Clicking this button opens the Help Text dialog box. Use the dialog box to specify a message 
to help others use the function. Help text is available only in this dialog box.

Arguments The fields in this area display the definition of your custom function.

Name This field is only for reference and shows the argument name.

Type This field is only for reference and shows the data type of the corresponding database field.

Description This field lets you add an optional description for an argument. This description appears in the 
Formula Expert.
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Default Values This field lets you define default values for an argument. Clicking a Default Values field opens 
the Default Values for dialog box. Default values created here can be used in the Formula 
Expert.

You cannot create default values for range, array, or range array argument types.

For information about creating a set of default values, see Defining default argument values 
for custom functions.

Related Information

Custom Functions [page 601]
Formula Workshop Dialog Box [page 779]
Help Text Dialog Box [page 780]
Default Values For Dialog Box [page 753]

1.7.3.1.18  Custom Styles Dialog Box

Use this dialog bog to specify formatting for currency, number, time, or date fields in your report.

This dialog box appears when you click Customize from the Number, Date, or Time tab of the Format Editor. It 
displays the following tabs depending on the type of item being formatted.

1.7.3.1.18.1  Currency Symbol Tab (Custom Styles)

Use the Currency Symbol tab to set detailed formatting options for currency fields in your report.

Use System 
Default Format

Select this check box to use the format specified in your Windows Regional Settings

Enable Currency 
Symbol

Select this check box if you want to display currency symbols in your currency fields.

Fixed Click this option if you want the program to place the currency symbol in the first (far left) 
position in the field. The program will leave extra space between the symbol and the 
currency if the field is justified to the right.

Floating Click this option if you want the program to place the currency symbol as close to the 
currency amount as possible so that there are never any extra spaces between the symbol 
and the amount.

One Symbol Per 
Page

Select this check box if you want the program to displays/print a currency symbol only once 
per page, beside the first number/currency value that appears on the page for each field. No 
currency symbols will appear beside any of the other values for that field on the page.

Position This list displays all the available positions for the currency symbol.
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Currency Symbol Use this box to enter the desired currency symbol.

1.7.3.1.18.2  Number Tab (Custom Styles)

Use the Number tab to set detailed formatting options for number fields in your report.

Use 
Accounting 
Format

When you select this option:

● the negative symbol used and its position is determined by the Windows Regional Settings 
(it will be either the minus sign or the brackets)

● the dash will be automatically chosen for Show Zero Values as (zero values are 
automatically displayed as dashes ('-') in your report)

● the currency symbol is fixed on the left side

Suppress if 
Zero

When you select this check box, nothing is printed in a column of number field data if it the value 
is zero.

Decimals When you are setting up a custom format for a number field object, use this list to set the 
Decimals property for that object. This option allows you to specify the number of decimal 
places you want to print. You can specify from 0 to 10 decimal places. When you choose the 
number of decimal places you want, the program changes the sample number at the bottom of 
the dialog box to show you the results of your selection.

Rounding When you are setting up a custom format for a number field object, use this list to set the 
Rounding property for that object. This property allows you to specify the number of places you 
want to round to. When you choose the number of places you want, the program changes the 
sample number at the bottom of the dialog box to show you the results of your selection.

Negatives When you are setting up a custom format for a number field object, this property enables you to 
specify the way you want negative values to appear. Your options are:

Table 24:

-1.23 Prints negative values with a leading minus sign (-100.00, -225.73, -1,000,000).

1.23- Prints negative values with a trailing minus sign (100.00-, 225.73-, 1,000,000.00-).

(1.23) Prints negative values in parentheses [ (100.00), (225.73), (1,000,000) ].

The program changes the sample number at the bottom of the dialog box to reflect the property 
you choose.

Reverse Sign 
for Display

You can reverse the sign for debit and credit amounts in financial reports by selecting this check 
box.

Allow Field 
Clipping

The Allow Field Clipping check box determines whether overflow field representation is enabled 
for the selected field(s).

● Select this check box to disable overflow field representation. This means that if the value in 
the field is too large for the field, the value will be truncated.

● Clear this check box to disallow field clipping and enable overflow field representation. With 
overflow field representation enabled, values that are too large for their fields will be 
represented by a string of # signs.
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Decimal 
Separator

When you are setting up a custom format for a number field object, the Decimal box allows you 
to type in the character(s) you want to use as a decimal separator. The default is a decimal point 
(.). If you want to change the separator, replace the character in the edit box with the separator 
of your choice. The program modifies the sample number at the bottom of the dialog box as you 
type in your characters.

Note
The box does not expand as you type in your separation characters; you are limited to the 
number of characters the box will hold.

Thousands 
Separator

The Thousands separator property allows you to choose the way you want numbers over 999 to 
appear on your reports.

● When you select the property (check mark), the program inserts a comma (,) or another 
separator of your choice as a thousands separator character for amounts over 999. Your 
numbers are printed like this: 1,000.00, 10,000.00, 999,000.00.

● When you clear the property you deactivate the thousands separator character. Your 
numbers are printed like this: 1000.00, 10000.00, 999000.00.

Symbol This box displays the current thousands separator. The default is a comma (,). If you would like 
to use a different thousands separator, type it in this box. The changes you make in this box do 
not apply unless you select the Thousands Separator check box.

Leading Zero Leading Zero allows you to include a zero, if you wish, before the decimal point in decimal 
amounts less than one.

● Select this property if you want the program to include a zero before the decimal point 
whenever you have a decimal amount less than one (0.001, 0.9999, 0.755).

● Clear this property if you do not want the leading zero (.001, .999, .755).

Show Zero 
Values as

This list contains the options available for displaying values of zero (0) in the selected field.

1.7.3.1.18.3  Date Tab (Custom Styles)

Use the Date tab to set detailed formatting options for date fields in your report.

Date type The Regional Settings dialog box in the Windows Control Panel allows you to specify default date 
formats for use with any Windows program. You can specify the month/day/year separator and 
the order in which the date elements appear. These dialog boxes also allow you to specify a short 
date style (like 12/24/96 or 16 Mar, 1996) and a long date style (like Sunday, April 21, 1996).

This list lets you:

● choose one of the two default styles
● choose Custom to create your own style in the Format Editor.

Select the option that fits your needs. The program modifies the sample date at the bottom of the 
dialog box to demonstrate the style you have chosen.
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Calendar 
type

Your operating system may support more than one calendar type.

Format

Month If you want to create a custom format for a date field object, use this list to specify the way you want 
the program to print/display the month part of the date. Your options are:

Table 25:

3 Prints a month as a number. If the month number is only a single digit, it prints the number with
out a leading zero.

03 Prints the month as a number. If the month number is only a single digit, it prints the number with 
a leading zero.

Mar Prints a three letter abbreviation for the month.

March spells out the full name of the month.

The program modifies the sample date at the bottom of the dialog box to reflect your choice.

Day If you want to create a custom format for a date field object, use this list to specify the way you want 
the program to print/display the day part of the date. Your options are:

Table 26:

1 Prints the day as a number. If the day number is only a single digit, it prints the number without a 
leading zero.

01 Prints the day as a number. If the day number is only a single digit, it prints the number with a 
leading zero.

The program modifies the sample date at the bottom of the dialog box to reflect your choice.

Year If you want to create a custom format for a date field object, use this list to specify the way you want 
the program to print/display the year part of the date.

Table 27:

99 Prints the year in its short, two digit format.

1999 Prints the year in its long, four digit format.

The program modifies the sample date at the bottom of the dialog box to reflect your choice.

Era/
Period 
Type

Use the Era/Period Type list to select either a short or long era/period of time.
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Order

YMD, DMY, 
MDY 
options

If you want to create a custom format for a date field object, use these options to select the order 
in which you want the elements of the date to appear. Your options are:

Table 28:

MDY Prints the date in the order Month, Day, Year.

DMY Prints the date in the order Day, Month, Year.

YMD Prints the date in the order Year, Month, Day.

The program modifies the sample date at the bottom of the dialog box to demonstrate the 
sequence you have chosen.

Day of Week

Type When you are setting up a custom format for a date field object, if you want the name of the day (or an 
abbreviation of that name) to appear before the rest of the date, use this option to set the format for 
that name. Your options are:

Table 29:

Short Prints an abbreviation of the day name before the date (for example, Fri).

Long Prints the full day name before the date (for example, Friday).

None Does not print a day name before the date.

The program modifies the sample date at the bottom of the dialog box to reflect your choice.

If you set this property to Short or Long, you need to specify the character(s) you want to use to 
separate the name from the date itself. You do that in the Separator box.

Sep When you are setting up a custom format for a date field object, , you need to specify the character(s) 
you want to use to separate the day of the week from the date itself. You do that in this box. Within 
practical limits, you can use as many characters as you need.

Type in the characters you want to use. The program modifies the sample date at the bottom of the 
dialog box as you do.

Encl Use the Enclosures list to select parentheses or square brackets as an enclosure for date/time fields 
on your report.

Position Use the Position list to select either a Leading or a Trailing position.

Separators

When you are setting up a custom format for a date field object, the program enables you to specify the 
separators, if any, that you want to use to separate the date elements. Since each date has three elements (YMD, 
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DMY, or MDY), you can specify two different separators. The first separator goes between the first and second 
elements, the second separator goes between the second and third elements.

Link 
separators to 
date order

Select this option if you want any separators you specify to be considered when sort date fields.

Prefix Use the Prefix box to create a prefix for dates in your date field, for example, DATE.

First When you are setting up a custom format for a date field object, the program enables you to 
specify the separators, if any, that you want to use to separate the date elements. Since each 
date has three elements (YMD, DMY, or MDY), you can specify two different separators. The first 
separator goes between the first and second elements, the second separator goes between the 
second and third elements. Type the character(s) you want to use for the first separator in this 
box. Within practical limits, you can use as many characters as you need. For example,

● if you are using a short format, all numbers, you may want to specify a forward slash (/) as 
the first separator and as the second separator as well (like 12/25/96)

● if you are using a long format with the month spelled out, you may not want to use any 
separator between the first and second elements and then use a comma between the 
second and third (like March 22, 1998).

Second When you are setting up a custom format for a date field object, the program enables you to 
specify the separators, if any, that you want to use to separate the date elements. Since each 
date has three elements (YMD, DMY, or MDY), you can specify two different separators. The first 
separator goes between the first and second elements, the second separator goes between the 
second and third elements. Type the character(s) you want to use for the second separator in 
this box. Within practical limits, you can use as many characters as you need. For example,

● if you are using a short format, all numbers, you may want to specify a forward slash (/) as 
both the first and second separators (for example, 12/25/96)

● if you are using a long format with the month spelled out, you may not want to use any 
separator between the first and second elements and then use a comma between the 
second and third (like March 22, 1998).

Suffix Use the Suffix box to create a suffix that follows the dates in your date field.

1.7.3.1.18.4  Time Tab (Custom Styles)

Use the Time tab to set detailed formatting options for time fields in your report.

Use System 
Default Format

Select this check box to use the format specified in your Windows Regional Settings

12 Hour Select this check box if you want the time to be displayed in a 12 hour format.

24 Hour Select this check box if you want the time to be displayed in a 24 hour (military time) 
format.

00:00-11:59 Use this box to specify the characters you want to use to identify the time between midnight 
and noon if you want to use something other than the default, AM.
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12:00-23:59 Use this box to specify the character(s) you want to use to identify the time between noon 
and midnight if you want to use something other than the default, PM.

Symbol Position Use the Symbol position list to select the placement for the AM or PM symbols in your time 
field.

Note
Symbol position is only available for the 12-hour time format.

Hour This list shows all the possible formats for the hour display. Choose the format you want. 
When you do, the program formats the sample time at the bottom of the dialog box to 
reflect your choice.

Minute This list shows all the possible formats for the minute display. Choose the format you want. 
When you do, the program formats the sample time at the bottom of the dialog box to 
reflect your choice.

Second This list shows all the possible formats for the seconds display. Choose the format you 
want. When you do, the program formats the sample time at the bottom of the dialog box to 
reflect your choice.

Hr/Min Separator Use this box to enter the character(s) you want to use to separate hours and minutes in 
your time field.

Min/Sec 
Separator

Use this box to enter the character(s) you want to use to separate minutes and seconds in 
your time field.

1.7.3.1.18.5  Date and Time Tab (Custom Styles)

Use the Date and Time tab to set detailed formatting options for date/time fields in your report.

Order From this list, select the order in which you want the elements of your date/time field to appear. You 
can select:

● Date Time (99/03/01 1:23:45AM)
● Time Date (1:23:45AM 99/03/01)
● Date (99/03/01)
● Time (1:23:45AM)

Separator Type the character(s) you want to separate the date and time elements of your date/time field. For 
example, typing an "X" in the Separator box produces the following formatting for a date/time field 
sorted in Date Time order: 99/03/01 X 1:23:45AM

Note
The Separator character has no effect if you select Date or Time as your sort order.
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1.7.3.1.19  Data Explorer Dialog Box

The Data Explorer lets you select the server you want to log on to or off of from a tree view like that in the 
Database Expert.

Log On Logs you onto the data source you've selected from the data source list.

Log Off Logs you off the data source you've selected from the data source list.

Add to Favorites Adds the selected data source to your Favorites folder.

Delete Favorite Removes the selected data source from your Favorites folder.

Options Provides access to the options you can set globally on the Database tab of the Options dialog 
box.

1.7.3.1.20  Data Source Connection Information Dialog Boxes

To create a report, you have to select a data source from the list of Available Data Sources on the Data tab 
(Database Expert). Depending on the data source, you might also have to provide additional information.

Note
This dialog box differs depending on the data source you are connecting to and whether you are connecting 
through a provider or directly to the data source.

Related Information

Database Expert Dialog Box [page 833]
Accessing and Adding Data [page 549]
Reporting off ADO.NET Datasets [page 550]

1.7.3.1.21  Default Settings Dialog Box

Use the Default Settings dialog box to configure the settings and format options for the program. Access this 
dialog box by right-clicking in the Report Designer, point to Design and click Default Settings.

Tip
Use the Default Settings dialog box to change the default values for the program, use the Report Options dialog 
box to change the options for the current report.
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1.7.3.1.21.1  Layout Tab (Default Settings)

Use the Layout tab to set the default grid, ruler, and object format options.

Field Options

Select the format you want to use to view the fields on the report when in design mode.

Table 30:

Field Option Explanation Example

Show Field Names Displays the name of the field. Customer ID

PrintDate

Show Object Names Displays the object name of the field. Field1

Field2

Show Format Symbols Displays the output format of the field. 5,555,555

1:23:45AM

Insert Detail Field 
Titles

When you select this check box, a default field title appears in the Page Header section 
whenever you insert a field in the Details section. The default title is the name of the field, 
underlined. This option is selected by default.

Insert Group 
Name with 
Group

When you select the check box, the program automatically enters the Group Name in the 
Group Header whenever you insert a new group. This option is selected by default.

View Options

Show Rulers When you select this check box, the Ruler is displayed in Design mode. This option is 
selected by default.

Show Hidden 
Sections

When you select this check box, hidden and suppressed sections in your report are 
displayed in the Design mode. Report objects in these sections are shown on a gray 
background. This option is selected by default.

Show Page Breaks in 
Wide Pages

When you select this check box, indicators are displayed for page breaks in wide pages. 
This option is selected by default.
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Grid Options

Snap to Grid When you select this check box, new database fields you insert snap to the nearest grid positions. 
When you clear this check box, new database fields are left where you place them. This option is 
selected by default.

Show Grid When you select this check box, a grid is displayed in the Designer.

Grid Size This box lets you specify the size of the grid increments. The unit of measure used for grid 
increments is based on your settings in the International section of the Windows Control Panel.

1.7.3.1.21.2  Database Tab (Default Settings)

Use the Database tab to set SQL/ODBC database options, the method you want to use to sort and display table 
and field names, and other advanced options.

Tables and Fields

By setting the options in this section of the Database tab, you can specify the text that you want the program to 
use for tables and fields.

Show Name If you select this option, the program identifies tables and fields using the actual name, for 
example, "Customer" table and "Customer Name" field. This option is selected by default.

Show Description If you select this option, the program identifies tables and fields using the description you 
have specified, for example, "Our Clients" table and "The names of all our customers" 
field.

Show Both If you select this option, the program identifies tables and fields using both the name and 
the description you have assigned, for example, "Customer - Our Clients" table and 
"Customer Name - The names of all our customers" field.

Sort Tables 
Alphabetically

When you select this check box, tables are displayed throughout the program sorted in 
alphabetical order (instead of the order they appear in the database). This option is 
selected by default.

Sort Fields 
Alphabetically

When you select this check box, fields are displayed throughout the program sorted in 
alphabetical order (instead of the order they appear in the database table). This option is 
not selected by default.

Data Explorer Options

Tables When you select this check box, the program allows reporting on database tables in your SQL/
ODBC data sources. This option is selected by default.
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Views When you select this check box, the program allows reporting on virtual tables in your SQL/
ODBC data sources. This option is selected by default.

System Tables When you select this check box, the program allows reporting on system tables. These tables 
are typically used by the system administrator only but are available for use if you have the 
appropriate permissions. This option is not selected by default.

Synonyms When you select this check box, the program allows reporting on virtual tables that are 
available on some hosts. This option is not selected by default.

Stored 
Procedures

When you select this check box, the program will allow reporting on the result sets from stored 
procedures if you are using SQL systems that support stored procedures. This option is not 
selected by default.

Table name 
LIKE

This box allows you to enter the SQL LIKE function to specify the kinds of table names you want 
to appear in the Database Expert. You can use the underscore character (_) and the percent 
sign character (%) as wildcards with this function. The underscore character specifies any 
single character, and while the percent sign signifies any character string. For example, DAV_ 
matches DAVE only, while DAV% matches both DAVE and DAVID. Table name Like C% would 
display only those tables that have a table name beginning with the letter C.

Owner LIKE This box works exactly like the Table name Like box except that the LIKE function here is used 
to select the Owner (or Creator or Alias) of the table, not the table name itself. For example, 
Owner Like C% would display only those tables that have an owner beginning with the letter C.

Advanced Options

Use Indexes or 
Server for Speed

Select this check box to use the available indexes/servers to speed the record selection 
process. If this check box is cleared, the record section process may be much slower. This 
option is selected by default.

Note
If an index has a name that is different from the database it indexes, you need to identify 
the index for the program. You do this using the Link Options dialog box.

Perform 
Grouping on 
Server

Select this check box to have the program perform grouping on the server (server-side 
processing). Server-side processing allows you to set up a report that performs the majority 
of its processing on the server and pushes only relevant details to your computer. Server-
side processing provides you with a number of benefits:

● less time connected to the server
● less memory needed to process the report on your computer
● lower transfer time from the server to the client

Server-side processing works only for reports based on SQL data sources (you cannot, for 
example, use server-side processing for a report based on a query, since a query is not an 
SQL data source).

This option is not selected by default
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Database Server 
is Case-
Insensitive

Select this check box if you want to search for strings in your SQL data without checking the 
case. For example, if your report contains SQL data and the data is of mixed case (red, RED, 
Red), a case-sensitive search for "red" returns only "red." If you select this check box, the 
same query will return red, RED, and Red when using red as a record selection value. This 
option is selected by default.

Select Distinct 
Data for 
Browsing

When Select Distinct Data for Browsing is selected, you can see the first 500 distinct 
(unique) records when you browse the contents of a database field.

When Select Distinct Data for Browsing is not selected, browsing returns the unique values in 
the first 500 records.

Note
Since most SQL servers do not support selecting distinct records for long data types such 
as memo and blob fields, selecting and browsing distinct records are not supported for 
such fields.

Verify On First 
Refresh

When this check box is selected, the report refreshes with the current version of the active 
database and resets its record buffers to the current record size the first time you refresh it 
per session. This option is selected by default.

Verify Stored 
Procedures On 
First Refresh

When this check box is selected, the report refreshes with the current version of the stored 
procedure and resets its record buffers to the current record size the first time you refresh it 
per session. This option is not selected by default.

Verify When 
Database Driver 
Upgraded

When this check box is selected, the report refreshes with the current version of the active 
database and resets its record buffers to the current record size when the database driver is 
changed. This option is selected by default.

1.7.3.1.21.3  Editors Tab (Default Settings)

The Editors tab allows you to customize formatting options for the text you create in editors such as the Formula 
Editor or the SQL Expression Editor.

Format Options

Font Use the Font list to select from font options for text created in Editors. Changes to font affect all 
Editors elements.

Font size Use the Font size list to select a font size for text created in Editors. Changes to font size affect all 
Editors elements.

Tab size Use the Tab size box to enter the number of spaces that the program will use to indicate a <tab> in the 
text.
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Color

Element The Element list contains four kinds of elements you can put into an Editor. By selecting the 
Comment or Keyword elements, you can change either the foreground or the background 
colors. The Text and Text Selection elements can only be formatted for Font, Font Size, and 
Tab Size.

Foreground Use the Foreground list to change the text color of an Editor element. You have three separate 
color options for each element.

Note
The Foreground and Background lists become active for Text and Text Selection elements 
when the "Use Windows system color" check box is not selected.

Background Use the Background list to change the background color of an Editor element. You have three 
separate color options for each element, including a custom option which brings up the Color 
dialog box for an even greater selection of background colors.

Use Windows 
system color

Clear the Use Windows system color check box to activate the Foreground and Background 
lists for the Text and Text Selection elements.

Sample

The Sample box shows an example of how the Font, Font Size, Foreground Color, and Background Color changes 
you made will appear on the Editor.

Reset All Click Reset All to return all formatting changes you have made on the Editors tab back to the original 
default settings.

1.7.3.1.21.4  Data Source Defaults Tab (Default Settings)

Data 
Directory

Use this box to enter the name (and path) of the Data Directory that you want to use for your 
report. If you do not know the full name and path, click the Browse button.

Browse When you click the Browse button, the Browse For Folder dialog box appears. Use the tree 
control to select the folder of your choice. Click Make New Folder to add a folder that does not 
already exist. Click OK to return to the Data Source Defaults tab.

Database File 
Filter

Enter any database file extensions you would like to have as the default when browsing for data 
sources. The extensions you enter here define the extensions in the User Default option in the 
Files of type filter when you are browsing for a data source in the Database Expert.
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1.7.3.1.21.5  Reporting Tab (Default Settings)

The reporting options on this tab let you place a governor on data selection, and they let you specify whether or 
not data will be saved with your report.

Convert Database 
NULL Values to 
Default

Select this check box to have the program convert null values from the database to a 0 (for 
numeric fields) or a blank (for non-numeric fields). This option is not selected by default.

Note
This option affects only null values found in the database used for a report.

Convert Other Null 
Values to Default

Select this check box to have the program convert non-database null values in the report to 
a 0 (for numeric fields) or a blank (for non-numeric fields). This option is not selected by 
default.

Note
This option affects only non-database null values in the report.

Always Sort Locally Select this check box to ensure your records are sorted locally even if they were pre-sorted 
when retrieved from your data source.

Discard Saved 
Data When Loading 
Reports

Select this check box to discard saved data when loading reports. When you open a report, 
this function removes that report's current set of data from the database, so that you can 
enter new data while retaining the report's format and settings. This option is not selected 
by default.

Re-Import 
Subreport When 
Opening Reports

Select this check box to re-import any subreports used in the report. Any changes made to 
the subreport since the main report was last opened will be reflected.

Show All Headers 
on Drill Down

Use this check box if you would like report drill-down views to include headers for all 
sections above the drill-down records. This option is not selected by default.

Save Preview 
Picture

Use this check box to globally set the Save Preview Picture option found in the Document 
Properties dialog box.

Because the Save Preview Picture option is not selected by default in the Document 
Properties box, selecting this check box ensures each report you create, preview, and save 
is saved with a preview picture (or thumbnail image).

Retain Original 
Image Color Depth

If you want images in your report to keep their original color depth when they are viewed, 
select this option. Otherwise, all images are converted to 8 bits per pixel before being 
displayed. The advantage of selecting this option is that it lets SAP Crystal Reports render 
images as exact copies of the originals. SAP Crystal Reports, however, will then store more 
information about the images, which may lead to larger files and slower response time in 
loading reports.

Formula Language Use this list to choose the formula language you want the program to use. You can choose 
between Crystal Syntax and Basic Syntax. Crystal Syntax is selected by default.
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1.7.3.1.21.6  Fields Tab (Default Settings)

Use the Fields tab to set the default format for string, number, currency, date, time, date/time, and Boolean fields. 
The program will use the default formats for all field objects that have not been custom formatted.

String Click this button to set default formatting properties for string field objects. When you click this 
button, the program takes you to the Common tab of the Format Editor.

Number Click this button to set default formatting properties for number field objects. When you click this 
button, the program takes you to the Common tab of the Format Editor. A Number tab is also 
present in the Format Editor.

Currency Click this button to set default formatting properties for currency field objects. When you click 
this button, the program takes you to the Common tab of the Format Editor. A Number tab is also 
present in the Format Editor.

Date Click this button to set default formatting properties for date field objects. When you click this 
button, the program takes you to the Common tab of the Format Editor. A Date tab is also present 
in the Format Editor.

Time Click this button to set default formatting properties for time field objects. When you click this 
button, the program takes you to the Common tab of the Format Editor. A Time tab is also 
present in the Format Editor.

Date and 
Time

Click this button to set default formatting properties for Date and Time field objects. When you 
click this button, the program takes you to the Common tab of the Format Editor. A Date and 
Time tab is also present in the Format Editor.

Boolean Click this button to set default formatting properties for Boolean field objects. When you click this 
button, the program takes you to the Common tab of the Format Editor. A Boolean tab is also 
present in the Format Editor.

1.7.3.1.21.7  Fonts Tab (Default Settings)

Use the Fonts tab to change the fonts for any field in your report.

Fields When you click this button, the Font dialog box appears. You can then set the font for all the 
fields in your report.

Summary Fields When you click this button, the Font dialog box appears. You can then set the font for all the 
summary fields in your report.

Group Name 
Fields

When you click this button, the Font dialog box appears. You can then set the font for all the 
group name fields in your report.

Text Objects When you click this button, the Font dialog box appears. You can then set the font for all the 
text objects in your report.

Field Titles When you click this button, the Font dialog box appears. You can then set the font for all the 
field titles in your report.

Charts When you click this button, the Font dialog box appears. You can then set the font for all the 
charts in your report.

752 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



1.7.3.1.22  Default Values For Dialog Box

This dialog box appears when you click a Default Values field for an argument in the Custom Function Properties 
dialog box.

The complete dialog box name appends the selected argument's name and type. For example, if you select a 
DateTime argument called "DayInQuarter," the dialog box name appears as "Default Values for DayInQuarter 
(Date Time)."

The "Default Values for" dialog box lets you create a set of default values to be used in the Formula Expert.

Use the upper list to create the default values you want your users to see. You can enter values directly or, as in 
the case of date values, select from a calendar or list.

The lower list contains the values you have defined. That is, it contains the values your users will see in the 
Formula Expert.

Add Use the Add button to add values from the upper list to the lower list.

Remove Use the Remove button to remove values from the lower list.

Up and Down Use the Up and Down buttons to reorder values in the lower list.

1.7.3.1.23  Define Description Dialog Box

This dialog box enables you to define a description for a default parameter value. It appears when you click the Set 
Description button in the Set Default Values dialog box.

Enter the description in the box and click OK.

Related Information

Set Default Values Dialog Box [page 799]
Create Parameter Field Dialog Box [page 731]

1.7.3.1.24  Define Named Group Dialog Box

When you use specified order grouping, you have to use the Define Named Group dialog box to create the groups 
and to specify the values in each when you group in a specific order.

This dialog box appears when you click either the New button, or the Edit button on the Specified Order tab of the 
Insert Group dialog box or Chart Sort Order dialog box.

Group Name Type the name you want to use for the group into this box. By default the name will appear in the 
group header section.
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There is a tab for the named group in which you can specify the selection criterion. Select a type 
of selection criterion from the list. To add another selection criterion, click the New tab.

Group 
Selection

Choose the grouping criteria. Depending on the option you choose, you may need to select field 
data from the drop down list.

Browse Data Click this button to browse the field data. You can select data from the dialog box that opens and 
click the Paste button to paste data to the Selection list. Click the Done button to return to the 
Define Named Group dialog box.

Tabs The tabs display the fields whose values you are using to create the group. The tabs are all related 
to the same group, and each tab relates to a specific portion of the query used to create the 
group. When you click a tab, the appropriate portion of the query appears in the dialog box. If you 
want to expand the query, click the New tab.

Related Information

Browse Data Dialog Box [page 712]
Chart Sort Order Dialog Box [page 725]
Grouping, Sorting, and Totaling Data [page 582]
Report Creation Wizards [page 812]

1.7.3.1.25  Document Properties Dialog Box

Use the Document Properties dialog box to

● add summary data to your report (to help you and other users identify the report).
● view the statistical information the program generates for each report.

This dialog box appears when you right-click in a report, point to Report, and choose Summary Info.

1.7.3.1.25.1  Summary Tab (Document Properties)

Use the Summary tab to add summary information to your report file. You and other users can later use this 
information to help identify the content of the report.

Author Type the name(s) of the report author(s) in this box.

Keywords Type keywords that will help identify the content of the report in this box.

Comments Type comments that you want saved with the report in this box. These comments might help 
describe the content of the report, the reason for the report's creation, and so on.
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Note
If you include these comments on a report using the Special Field called Report Comments, 
only the first 256 characters will be displayed.

Title Type the report title in this box. A title entered here can be added to the report by using the 
Special Field called Report Title.

Subject Type the overall subject of your report in this box.

Template If you created the report by using another report as a template, type the name of that template 
here.

Save Preview 
Picture

Select this check box if you'd like to create a picture of the first page of the report so you can 
see it when selecting a report in the Open dialog box. This check box is not selected by default.

Related Information

Default Settings Dialog Box [page 745]

1.7.3.1.25.2  Statistics Tab (Document Properties)

Use the Statistics tab to view the document management information that the program generates for the report.

Last Saved By This tab displays the name found in the Author box on the Summary tab (Document Properties) 
the last time you saved the report. If there was no name present when you last saved the report, 
this line is blank.

Revision 
number

This line displays the number of times the report has been revised. Each new report begins with 
the revision number set to zero (0). That value increases by one each time you save the report, 
even if you made no changes before saving.

Total Editing 
Time

This line displays the total number of minutes since you opened the report for editing, 
regardless of whether or not you have actually edited the report during that time.

Note
This value does not refresh while the dialog box is open. Each time you open the Document 
Properties dialog box, the program updates the value.

Last Printed This line displays the date and time your report was sent to a printer.

Note
The value does not update when you export or preview the report.

Created This line displays the date and time that your report was initially created.
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Last Saved This line displays the date and time that your report was last saved.

Related Information

Default Settings Dialog Box [page 745]

1.7.3.1.26  Edit Summary Dialog Box

Use the Edit Summary dialog box to set or change the summary operation for the selected field.

This dialog box appears when you select a summary field on a report, right-click it, and select the Change 
Summary Operation command from the shortcut menu. The command is also available when you:

● When you click the Change Summary button for a summarized field in the Cross-Tab Expert.
● When you click the Set Summary Operation button on the Data tab (Map Expert) of the Chart Expert or Map 

Expert.
The Set Summary Operation button is available for charts and maps with an Advanced layout type. You must 
move a field to the "values" list and select it in order to activate the button.

Note
Map objects are not supported in this version of SAP Crystal Reports.

Choose the field to 
summarize

This list displays the fields and formulas used in the report along with the fields available in 
the report's data source tables. Select the field that you want to summarize.

Calculate this 
summary

This list contains all the summary operations available for use in your report. Select the 
desired operation.

Note
Not all the summary types available apply to all fields. For example, you cannot sum or 
average a text, Boolean, date/time, time, or date field.

Show as a 
percentage of

Select this check box if you want to calculate the percentage total of one group within a 
broader grouping. For example, you can show the percentage of sales in each city based on 
the total sales for each country.

After you select the check box, you can choose the total or group you want the comparison 
to be based on.

Note
The percentage option is available only when the result of a summary operation is 
numeric.
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Summarize across 
hierarchy

This option enables you to calculate a summary across hierarchical groupings. To set or edit 
Hierarchical Options for existing groups, click Hierarchical Grouping Options on the Report 
menu.

Related Information

Insert Summary Dialog Box [page 787]
Summarizing Grouped Data [page 585]

1.7.3.1.27  Enter Value For Dialog Box

This dialog box appears when you select the Enter Constant Value option from the Value list in the Function 
Arguments area of the Formula Expert.

Not every argument type requires the use of this dialog box; simple types that don't have formatting restrictions 
(such as you'd encounter with a date field, for example), can be entered directly.

The complete dialog box name appends the selected argument's name and type. For example, if you select a 
DateTime argument called "DayInQuarter," the dialog box name appears as "Enter Value for DayInQuarter 
(DateTime)."

There are different versions of this dialog box to accommodate each of the following:

● The selection of a single value.
● The selection of a range of values.
● The selection of an array of values.
● The selection of an array of ranged values

Single 
value

Use the options in this dialog box to select a single value to use in your formula. You can create a 
formula with a value such as CDateTime (2001, 12, 07, 15, 50, 18) by using this version 
of the dialog box.

Range of 
values

Use the options in this dialog box to select a starting and ending value to use as the bounds of your 
formula's range. You can create a formula with a range such as (10000 To 50000) by using this 
version of the dialog box.

Note
The options in the Value list let you define more exactly how the formula's range is to be 
calculated. The list includes options such as "is between, including endpoints," "is between, 
excluding endpoints," and so on.

Array of 
values

Use the options in this dialog box to select an array of values to use in your formula. You can create 
a formula with an array such as (["Canada", "England", "USA"]) by using this version of the 
dialog box.
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Array of 
ranged 
values

Use the options in this dialog box to select an array of ranged values to use in your formula. You can 
create a formula with an ranged array such as (["AL" To "AZ", "CA" To "CT"]) by using this 
version of the dialog box.

Note
The options in the Value list let you define more exactly how each range in the formula's array is 
to be calculated. The list includes options such as "is between, including endpoints," "is between, 
excluding endpoints," and so on.

Related Information

Formula Expert [page 837]

1.7.3.1.28  Export Dialog Box

Use the Export dialog box to export your report to an electronic file in a format that can be read by another 
software application.

Note
Export Dialog Box is only available from the Main Report Preview mode. To access this dialog box, click on Main 
Report Preview from the bottom left corner of your report, then click on the Export Report icon on the top left 
corner of the report (Alternatively right-click on the report, and click Export).

Export formats supported by SAP Crystal Reports can be broadly categorized in two groups: page-based formats 
and record-based formats. Page-based formats put more importance on layout representation and formatting, 
and hence tend to produce a more exact output. Record-based formats emphasize data rather than the layout 
and formatting.

Choosing an Export Format

PDF Exports both layout and formatting in a manner that is consistent with how the report 
looks on the Preview tab.

SAP Crystal Reports 
(RPT)

Exports (saves) your report with the current data without modifying the original 
report.

SAP Crystal Reports 
Read Only (RPTR)

Exports (saves) your report with the current data without modifying the original 
report. RPTR reports are Crystal reports that can be viewed with report viewer 
applications, but cannot be modified with the SDK or opened by report designer 
applications. The definition of an RPTR report cannot be modified, so you cannot use 

758 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



this SDK to set the data source location of an RPTR through the database controller. 
However, you can refresh the data of an RPTR report at run time by refreshing the 
report in a viewer.

HTML 4.0 HTML 4.0 preserves the layout and formatting of the report by using DHTML.

MHTML Can be used to send HTML files in email messages.

Microsoft Excel 
(97-2003)

Converts your report contents into Excel cells on a page-by-page basis.

Microsoft Excel 
(97-2003) Data-only

Microsoft Excel Data-only is useful for data transfer but retains less formatting 
information.

Microsoft Excel (2007) 
Data-only

Microsoft Excel Data-only is useful for data transfer but retains less formatting 
information. This feature allows for up to 16385 columns and 1,048,576 rows in a 
single workbook.

Microsoft Word 
(97-2003)

Produces an RTF (Rich Text Format) file that contains text and drawing objects to 
represent report objects.

Microsoft Word 
(97-2003)-Editable

Converts all of the report object contents to text lines. Text formatting is retained, but 
other attributes may not be retained.

Record Style-Columns 
with spaces

Exports report data as text. This format inserts spaces between columns.

Record Style-Columns 
without spaces

Exports report data as text. Does not insert spaces between columns.

Rich Text Format (RTF) Produces an RTF file that contains text and drawing objects.

Separated Values (CSV) Exports the report object contents as a set of values separated by separators and 
delimiters.

Tab Separated Text 
(TTX)

Preserves the layout of your report but with some differences: multi-line text objects 
are exported in a single line, all string values are surrounded by double quotes (""), 
and the values themselves are separated by tab characters.

Text Outputs to plain text (does not retain formatting).

XML Used primarily for data exchange. This format produces XML using the SAP Crystal 
Reports XML schema.

The destination determines the export location of your report. SAP Crystal Reports enables you to choose one of 
four destinations.

Choosing a Destination

Application Exports the report to a temporary file in the specified format and then opens the file in the 
appropriate application.

Disk File Exports the report to a specified disk or diskette.

Exchange Folder Exports the report to an Exchange folder. An Exchange folder can contain standard notes 
(mail), files, and instances of Exchange forms.
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MAPI Exports the report as an email attachment.

Note
This option works only if you have a mail client installed (Microsoft Outlook, Microsoft Mail, 
or Exchange), as well as an email account configured properly.

1.7.3.1.29  Extract Custom Function from Formula Dialog Box

The Extract Custom Function from Formula dialog box appears — in the Formula Workshop dialog box — when 
you enter a name in the Custom Function Name dialog box and click the Use Extractor button.

Use this dialog box to create a custom function from an existing report formula. Doing so lets you migrate formula 
logic from a formula field to a custom function. You can then replace the appropriate part of your formula with the 
new custom function.

Formula Use this list to choose an existing report formula to base your new custom function on. When 
you select a formula, information from it appears in various fields in the Extract Custom 
Function from Formula dialog box.

Custom Function 
Name

Use this field to change the name you assigned your custom function in the Custom Function 
Name dialog box, if you wish.

Names for custom functions can be alphanumeric, but cannot contain spaces and cannot 
begin with a number.

Enter More Info Click this button to see the Custom Function Properties dialog box. You can add further 
information such as default argument values and help text while you are defining your custom 
function. If you don't add additional information now, you can right-click your custom function 
and select Properties later.

Return Type This field displays your custom function's return type. The field cannot be changed because 
the return type is based on the report formula you selected in the Formula list.

Summary Use this area to add additional information about your custom function to help identify its 
purpose, intended use, and so on.

Arguments This area displays field-based arguments from the report formula you selected in the Formula 
list. While the Field Name and Type cannot be changed, you can enter a name and description 
for the argument. If you don't assign an Argument Name, the default names (v1, v2, v3, and so 
on) are used to describe the variables.

Arrow buttons Use the arrow button adjacent to the Arguments area to change the default order (that is, the 
order in which the fields are used in the report formula) of the arguments.

Formula Text This area displays the report formula as it was defined in the Formula Editor dialog box. The 
text is only for information and cannot be edited.

Modify formula 
to use new 
custom function

Select this option if you want to use your new custom function in the report formula you are 
basing it on. In other words, the appropriate formula text is replaced by a call to the custom 
function with the fields used in the formula supplied as argument values.
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Related Information

Formula Workshop Dialog Box [page 779]
Custom Function Properties Dialog Box [page 737]
Creating Custom Functions [page 602]

1.7.3.1.30  Find Dialog Box (Formula Editor)

The Find dialog box allows you to locate text in the Formula Editor and replace it if required. This dialog box 
appears when you click the Find/Replace button on the Formula Editor toolbar.

Find what Type the text you want to search for, paste it from the clipboard or click a recent entry from the 
list.

Replace with Type the text you want to replace the find text with.

Find Next Click this button to find and select the next occurrence of the text specified in the Find what box.

Mark All Click this button to mark all occurrences of the find text.

This option is only available when Edit Text is selected.

Replace Click this button to search for text that matches the find text, then replace it with the text in the 
Replace with field.

This option is only available when Edit Text is selected.

Replace All Replaces all occurrences of the find text with the text in the Replace with field. This option is only 
available when Edit Text is selected.

Search Click an option to specify the type of text to search for.

Direction Specifies which direction to search starting from the current cursor position. Click Up to search 
toward to start of the report or Down to search toward the end of the report.

Match Case Select or clear this check box to control whether the exact sequence of upper and lower case 
letters in the search text should be considered.

Related Information

Formula Editor Dialog Box [page 774]
Performing Report Calculations [page 597]

1.7.3.1.31  Find Field Name Dialog Box

The Find Field Name dialog box opens when you choose Find Field from the Fields tab of any Report Creation 
Wizard.
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Use this dialog box to specify the name of the field you want to locate.

Related Information

Report Creation Wizards [page 812]

1.7.3.1.32  Font Dialog Box

Use the Font dialog box to change the fonts, the font size, and/or the font style for text and data fields on your 
reports.

Access the Font dialog box through the Fonts tab of the Default Settings dialog box.

Font Lists all the available fonts. Click a font name to select a different font.

Font style Lists the available styles for the specified font. Click a font style to select a different style.

Size Lists the available point sizes for the specified font. Click a size to change the size of the font.

Color Displays the colors you can choose to apply to your font. Click More to see the Color Dialog Box 
[page 730] so you can define further font colors.

Strikeout Specifies whether the font should appear with strikeout marks.

Underline Specifies whether the font should appear with underlines.

Preview Shows a sample of how the text will appear with the specified font settings.

1.7.3.1.33  Format Editor Dialog Box

With the Format Editor, you can change the appearance of report fields and other report objects. At its simplest, 
the Format Editor has one tab. Other tabs are added as you select other field types (Date/Time, Boolean, 
Hyperlink, and so on).

The Format Editor contains tabs specific to the type of field specified on the fields tab of the Options dialog box, or 
to the type of field you selected.

Related Information

Formatting Data [page 608]
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1.7.3.1.33.1  Common Tab (Format Editor)

Use the Common tab to set properties like suppress, horizontal alignment, and keep object together, for a desired 
field.

Object Name Use this field to define a name for the object you are formatting. This name is used when 
defining Report Part hyperlinks.

A default name is created for each field in a report. If the default name suits you, you can ignore 
this field.

CSS Class 
Name

Use this field to specify a class name for the report object you're formatting. The class name 
can be used in your CSS to indicate a unique style for the selected report object.

You can also create a conditional name for the class by using the Formula Editor dialog box. 
Doing so allows you to indicate in your CSS that certain repetitions of an object have different 
formatting from others.

Repeat on 
Horizontal 
Pages

Use this option to repeat a report object that does not expand horizontally, such as text 
objects, field objects, OLE objects, charts, maps, lines, boxes, and so on, on each additional 
horizontal page that a cross-tab or OLAP grid might create.

Suppress Select this check box if you want to suppress the selected field. The field values won't appear 
when the report is previewed, nor will the field print.

Horizontal 
Alignment

This list contains the horizontal alignment types available for the field (for example, left, center, 
and right).

Keep Object 
Together

Select this check box if you want to keep all the objects from a given section together on the 
same page. If there is enough room to keep them on the current page, the program will print 
them on the current page. If there is not enough room, the program will print them on the next 
page.

Note
If you have objects that are larger than a page, this property will not work.

Close Border 
on Page Break

If an object has a border and the object is split over two pages, you have two options: put a 
border around each part of the split object, or display each part of the object with a partial 
border. Select this check box to display a full border.

Can Grow This check box is useful for objects that contain variable length strings, such as memo fields.

● Select this check box if you want the program to expand the object frame vertically when 
the text within the object is larger than the frame.

● Clear this check box to truncate the data when the value is larger than the frame.

By default, the Can Grow option is off.

Max number of 
lines

If you have selected the Can Grow check box, you can use this box to specify the maximum 
number of lines by which the program can expand an object frame. Simply enter the desired 
number of lines into this box or enter a 0 (zero) if you do not want to set a limit.
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Tool Tip Text You can add Tool Tip text for the selected field by clicking the Format Formula Editor button 
and entering text within quotation marks. Tool Tip text appears when you leave your mouse 
pointer over a field for a few seconds.

Text Rotation This list contains the rotation options available for the selected field. Use the Text Rotation 
options to vertically align the fields and text-based objects on your report.

● When you select a text rotation of 90 degrees, the text shifts 90 degrees in a counter-
clockwise direction.

● If text rotation is left at 0 degrees, your report is horizontally formatted.
● For text rotation of text-based objects, the Can Grow option that prevents the truncation of 

text inside an object is automatically cleared. For more information on the Can Grow 
option, see Preventing Truncated Text [page 563].

● Vertically formatted text that spans over the edge of the page cannot be displayed as part 
of your report.

Suppress if 
Duplicated

Select this check box if you don't want the program to print field values that are duplicated 
when it prints the report.

Suppress 
Embedded 
Field Blank 
Lines

Select this check box if you want the program to avoid printing blank fields —that is, fields for 
which the database returns no information. This option prevents blank lines from appearing in 
your report when some fields are empty.

Display String Click the conditional formatting button to enter a formula that lets you display number, 
currency, date, time, date and time, Boolean, or even string fields as a custom string. This type 
of conditional formatting is not limited to database fields; you can use it for running totals, 
formulas, parameter fields, summaries, and so on.

For example, suppose you want to use a notation in your report that represents millions as M 
and thousands as K. You can create a display string formula for your report by selecting the 
appropriate numeric field and entering this formula in the Format Formula Editor:

 if CurrentFieldValue >= 1000000 
then ToText(CurrentFieldValue/1000000, 2) + "M"
else if  CurrentFieldValue >= 1000 
then ToText(CurrentFieldValue/1000, 2) + "K"
else ToText(CurrentFieldValue, 2) 

1.7.3.1.33.2  Boolean Tab (Format Editor)

Use the Boolean tab to select the format for the return values of Boolean fields in your report.

Boolean Text This list includes all the formats in which Boolean fields can be displayed. Select the desired 
format from this list.
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1.7.3.1.33.3  Border Tab (Format Editor)

Use the Border tab to format the borders, background fill, and drop shadows for selected fields on your report. 
Using the options on the border tab, you can create a variety of effects that can enhance both the look of your 
report and highlight important data.

Left This list contains the different line styles available. Your choices include single, double, dashed, 
and dotted line borders. Select the desired style and the program will insert the specified 
border on the left side of the field. The default value is None.

Right This list contains the different line styles available. Your choices include single, double, dashed, 
and dotted line borders. Select the desired style and the program will insert the specified 
border on the right side of the field. The default value is None.

Top This list contains the different line styles available. Your choices include single, double, dashed, 
and dotted line borders. Select the desired style and the program will insert the specified 
border on the top of the field. The default value is set to None.

Bottom This list contains the different line styles available. Your choices include single, double, dashed, 
and dotted line borders. Select the desired style and the program will put the specified border 
on the bottom of the field. The default value is None.

Tight 
Horizontal

Select this check box to trim the border to the size of the field.

● When this check box is not selected, the border will be the same size for each record.
● When this check box is selected, the border will be trimmed to match the size of each 

individual record.

Drop Shadow Select this check box if you want to print a drop shadow below and to the right of the field. 
When the check box is not selected, the program does not print a drop shadow.

Border This list contains the colors available for use as borders. Select the desired color from this list.

Background Select this check box if you want to change the background color. When you select this check 
box, a list appears to the right, allowing you to select a new background color.

1.7.3.1.33.4  Box Tab (Format Editor)

Use the Box tab to change the fill, border, width and style of your box.

Border

Style This list shows all the available line styles for your box; such as: single, double, dashed, and so on.

Width Click the button which represents your desired border line width. This option is available only for 
Single border lines, and not for Dashed or Dotted border lines.

Color This list shows all the available colors for your box. Select the desired color from this list.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 765



Drop Shadow Select this check box if you want to have a drop shadow below and to the right of your box.

Fill

Color If you select this check box, the Color list appears showing all the available colors to fill 
your box.

Close Border on 
Page Breaks

Select this check box if you want the program to convert box segments into finished boxes 
when the program splits a box due to a line break. When this property is selected, the 
program adds the bottom to the first box and the top to the second, creating a finished 
half inch box on each page.

Extend to Bottom of 
Section when 
Printing

Select this check box if you want the program to allow the box to extend to the bottom of 
the section.

Suppress Select this check box if you do not want the box to print.

Repeat on 
Horizontal Pages

Use this option to repeat a report object that does not expand horizontally, such as text 
objects, field objects, OLE objects, charts, maps, lines, boxes, and so on, on each 
additional horizontal page that a cross-tab or OLAP grid might create.

1.7.3.1.33.5  Date Tab (Format Editor)

Use the Date tab to set the formatting options for the date fields in your report.

Style From this pre-defined list, choose a date style to apply to the field selected on your report.

When you choose System Default Long Format or System Default Short Format, the program uses 
the date formats from the Regional Settings Properties dialog box in the Windows Control Panel.

Customize Create a custom date format by clicking the Customize button. Your customized style appears in 
the style list as Custom Style.

Related Information

Format Editor Dialog Box [page 762]

1.7.3.1.33.6  Date and Time Tab (Format Editor)

Use the Date and Time tab to set the formatting options for the date and time fields in your report.
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Style From this pre-defined list, choose a date and time style to apply to the field selected on your report.

When you choose System Default Long Format or System Default Short Format, the program uses 
the date and time formats from the Regional Settings Properties dialog box in the Windows Control 
Panel.

Customize Create a custom date and time format by clicking the Customize button. Your customized style 
appears in the style list as Custom Style.

1.7.3.1.33.7  Font Tab (Format Editor)

Use the Font tab of the Format Editor to change the fonts, the font size, and the font style for text and data fields 
on your reports.

If your text object is in edit mode, this tab appears on the Text Format dialog box.

Font This list contains all the fonts that you have installed for your system. The list appears with the 
font that is currently in use selected.

Style This list contains four additional attributes that you can assign to the selected font. The list 
appears with the style that is currently in use selected.

Size This list includes common point sizes for the selected font. The list appears with the point size 
that is currently in use selected.

If you enter your own font size, the number you type must be between 1 and 1638. SAP Crystal 
Reports will automatically round all fractional entries to the nearest 0.5. Consequently, in your 
report, you can use the fractional font sizes 1.5, 2.5, 3.5, and so on, up to 1637.5.

Color Select the desired color from this list if you want to add color to the font.

Strikeout When you select this check box, the program prints the strikeout character across the font.

Underline When you select this check box, the program underlines characters typed in the selected font.

Character 
spacing 
exactly

Use this option to specify the value that each character in your selected font occupies. The value 
is defined as the distance in number of points measured from the start of one character to the 
start of the next. When you change the character spacing, you change only the spacing between 
adjacent characters, not the font size of the characters.

1.7.3.1.33.8  Hyperlink Tab (Format Editor)

Use this tab to create a hyperlink to a Web site, a field value, an e-mail address, a file, or another SAP Crystal 
Reports file. The hyperlink is saved with your report and is available to other users as a way of viewing additional 
information.

Hyperlink 
type

Click the type of hyperlink you want to create. The available types are:

No Hyperlink This is the default option. There is no hyperlink associated with the selected 
report object.
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A Website on 
the Internet

Select this option if you want your report object to be linked to a static web 
address. Use the formula button to create a URL based on a field value. For 
example, you might enter the following formula if your Customer Name field 
contained information that would create a series of meaningful URLs:

     "http://www." + {Customer.Customer Name} + ".com" 

Current Website 
Field Value

Select this option if you want the program to create a hyperlink out of the 
field you selected. The field must be stored as a proper hyperlink in your 
data source.

An E-mail 
Address

Select this option if you want to create a "mailto" address from the field you 
selected. Use the formula button to create an address based on a field value.

A File Select this option to create a hyperlink to a file on a specific computer or 
networked computer. Use the formula button to create a file path based on a 
field value.

Current E-mail 
Field Value

Select this option if you want the program to create an email hyperlink out of 
the field you selected. The field must be stored as a proper email address in 
your data source.

The available types in the DHTML Viewer Only area are:

Report Part 
Drilldown

For information about how to use this option, see Implementing Report Part 
Drill Down [page 617].

Another Report 
Object

For information about how to use this option, see Another Report Object 
Option [page 619].

Note
Not all hyperlink types are available at all times. The object you select and 
its location on the report determine which types are available.

Hyperlink 
information

Use this section of the tab to enter the appropriate hyperlink information (the URL of a Web site, 
for example). Hyperlink information is available for all Hyperlink types except No hyperlink and 
Current field value.

Browse Use Browse to search for files using the Open dialog box. Browse is available only for A file and 
Another Crystal report file.

Helpful Hint Use these hints to learn how each Hyperlink type works and what it will add to your report.

1.7.3.1.33.9  Line Tab (Format Editor)

Use the Line tab to set the formatting specification for a line in your report.

This tab appears in the Format Editor when you right-click a line and choose the Format from the shortcut menu.

Style This list shows all the available styles for your line, such as: single, double, dashed, and so on.
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Width Click the button that represents the line width you want to use.

Color This list shows all the available colors for your line.

Move to Bottom 
of Section when 
Printing

This option is typically selected when you are printing a horizontal line next to a field that may 
produce variable length output (a memo field, for example) and you format that field using the 
Can Grow (Common tab/Format Editor) option. In this case, if the program needs to grow the 
section to accommodate field output, it will move the line to the bottom of the section so that 
it remains at the bottom of the field.

Select this check box if you want the line to always move to the bottom of the section 
regardless of the length of the section.

Clear the check box if you want the line to be in the same vertical location in each section, 
regardless of section size.

Extend to 
Bottom of 
Section when 
Printing

This option is typically selected when you are printing a vertical line next to a field that may 
produce variable length output (a memo field, for example) and you format that field using the 
Can Grow (Common tab/Format Editor) option. In this case, if the program needs to grow the 
section to accommodate field output, it will lengthen the line to the bottom of the section as 
well.

Select this check box if you want the line to always extend to the bottom of the section 
regardless of the length of the section.

Clear the check box if you want the line to be the same length in each section, regardless of 
section size.

Suppress Select this check box if you do not want the line to print.

Repeat on 
Horizontal 
Pages

Use this option to repeat a report object that does not expand horizontally, such as text 
objects, field objects, OLE objects, charts, maps, lines, boxes, and so on, on each additional 
horizontal page that a cross-tab or OLAP grid might create.

Related Information

Inserting Shapes [page 610]

1.7.3.1.33.10  Number Tab (Format Editor)

Use the Number tab to set the formatting options for number or currency fields in your report.

Style From this pre-defined list, choose a number style to apply to the field selected on your report. 
When you choose System Default Number/Currency Format, the program uses the number 
and currency formats from the Regional Settings Properties dialog box in the Windows Control 
Panel.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 769



Display 
Currency 
Symbol

Select the Display currency symbol check box if you want to display currency symbols in your 
currency fields.

Fixed Click this option if you want the program to place the currency symbol in the first (far left) 
position in the field. The program will leave extra space between the symbol and the currency if 
the field is justified to the right.

Floating Click this option if you want the program to place the currency symbol as close to the currency 
amount as possible so that there are never any extra spaces between the symbol and the 
amount.

Customize You can create a custom number or currency format by clicking the Customize button. Your 
customized style appears in the style list as Custom Style.

Related Information

Currency Symbol Tab (Custom Styles) [page 738]
Number Tab (Custom Styles) [page 739]

1.7.3.1.33.11  Paragraph Tab (Format Editor)

Use the Paragraph tab of the Format Editor to set formatting options for paragraphs in a text object.

Indentations

First Line Enter the distance in inches (or the default measurement for your report) that you want the first line 
of the paragraph to be indented from the rest of the paragraph.

Left Enter the distance in inches (or the default measurement for your report) that you want the 
paragraph to be indented from the left margin of the page.

Right Enter the distance in inches (or the default measurement for your report) that you want the 
paragraph to be indented from the right margin of the page.

Spacing

Line spacing Enter the spacing you want for lines as a multiple of the font size you are using, or as an exact 
number of points.

770 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



Of Use this box to enter the multiple you want to use (if you selected Multiple for Line Spacing), or the 
number of points (if you selected Exact for Line Spacing).

Reading Order

Left to Right Select this button if the text should be read from left to right.

Right to Left Select this button if the text should be read from right to left.

Horizontal Alignment

Alignment Select whether you want the text to be aligned to the Left, to the Right, or in the Center of the text 
box. If you want the text to be aligned on both the left and the right, choose Justified.

Text Interpretation

Text 
interpretation

Use this list to select the type of pre-formatted data (string or memo fields only) or text you are 
inserting in a field. SAP Crystal Reports extracts information about the font, size, style, color, 
and paragraph and displays the data or text with the specified attributes.

Your choices are:

● "none" to interpret the string or memo field or imported text as if it contains plain text
● "RTF Text" to interpret the string or memo field or imported text as if it contains Rich Text 

Format data
● "HTML Text" to interpret the string or memo field or imported text as if it contains HTML 

data.

1.7.3.1.33.12  Picture Tab (Format Editor)

Use the Picture tab to format bitmap graphics.

Crop 
From

Cropping refers to "cutting" away those portions of your graphic that you do not want to print 
(although you can use cropping to add white space between the graphic and the frame that 
surrounds it as well). Using the cropping box, specify the size of the piece you want to cut off the top, 
bottom, left, and/or right side of your graphic:

● positive numbers cut into the graphic the amount specified
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● negative numbers add the specified amount of white space between the outer edge of the 
graphic and the frame.

Note
All cropping activities begin at the outer edge of the graphic.

Scaling Scaling refers to the length and width of a graphic as a percentage of the original length and width.

If you want to resize the graphic as a percentage of the original height and width, enter the new 
scaling percentages.

The program stores a copy of each graphic in its original size. All scaling settings refer back to that 
original size.

Size Size refers to the absolute (measured) length and width of a graphic.

Note
When you change the Size settings, the program automatically recalculates the Scaling settings, 
and when you change the Scaling settings, the program automatically recalculates the Size 
settings. The recalculated settings appear when you next open the Picture tab of the Format 
Editor.

Original 
Size

This box displays the original dimensions of the graphic (its dimensions when first inserted into the 
report). Sizing, scaling, and cropping do not affect this figure nor can you change it directly; it is 
simply provided as a reference.

Reset When you click this button, any changes you have made to your graphic will be reset to the defaults 
displayed in the Original size display box.

1.7.3.1.33.13  Rounding Tab (Format Editor)

Use the Rounding tab to create boxes with rounded corners, as part of your report. The Rounding tab appears in 
the Format Editor when you right-click a box that you have created and choose Format from the shortcut menu.

Slider Move the slider to the right to increase the curvature of the box corners. The box that you started with 
gradually changes to an eclipse or circle, depending on how far you move the slider to the right.

Once the appropriate shape is created, the program remembers the position of the slider and applies it 
unless you discard your changes in the Format Editor.

1.7.3.1.33.14  Subreport Tab (Format Editor)

Use the Subreport tab to select or clear the On-demand subreport and Re-import when opening options.

Subreport Name Use this field to rename a subreport from within your containing report.
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On-demand 
Subreport

Select this check box to create a hyperlink to a subreport.

On-demand 
Subreport Caption

Use the Formula Workshop button to create a caption that appears on your subreport 
object within the containing report.

Subreport Preview 
Tab Caption

Use the Formula Workshop button to create a caption that appears on the subreport 
view button (at the bottom of the designer) when you preview the subreport.

Re-import When 
Opening

Select this check box to refresh the data and formatting each time the subreport opens.

Tip
Use the Default Settings dialog box to change the default values for the program 
instead of individual fields.

Suppress Blank 
Subreport

Select this check box to withhold blank subreports. Because blank subreports are 
treated as visible report objects, this option is especially useful when you want to 
suppress blank report sections that contain blank subreports.

File Name for Linked 
Subreport

When you have a linked subreport, you can see the source location of that subreport and 
change the location, if necessary. If you have an embedded subreport, this option is 
unavailable.

Related Information

Reporting Tab (Default Settings) [page 751]
Inserting Subreports [page 631]
Unlinked vs. Linked Subreports [page 633]

1.7.3.1.33.15  Time Tab (Format Editor)

Use the Time tab to set the formatting options for the time fields in your report.

Style From this pre-defined list, choose a time style to apply to the field selected on your report.

When you choose System Default Time, the program uses the time formats from the Regional 
Settings Properties dialog box in the Windows Control Panel.

Customize Create a custom time format by clicking the Customize button. Your customized style appears in 
the style list as Custom Style.

1.7.3.1.34  Format Grid Lines Dialog Box

The Format Grid Lines dialog box allows you to control the appearance of grid lines.
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This dialog box appears when you click Format Grid Lines on the Customize Style tab of the Cross-Tab Expert.

Grid line diagram Shows the grid layout based on the current settings.

Grid section Click a section then specify the grid display settings.

Show Grid Lines Select or clear this check box to show or hide all grid lines.

Line Options

Color Click a color for the item selected in the Grid line location list.

Style Click a line style for the item selected in the Grid line location list.

Width Click a line width for the item selected in the Grid line location list.

Draw Select or clear this check box to show or hide the item selected in the Grid line location list.

Draw Grand 
Total Line Only

Select or clear this check box to show or hide the grand total grid line. When the grand total 
grid line is shown, the lines usually displayed at the grid line location are hidden.

Related Information

Cross-Tab Expert Dialog Box [page 829]
Crystal Report Creation Wizards [page 542]

1.7.3.1.35  Formula Editor Dialog Box

The Formula Editor is a major component of the Formula Workshop dialog box. The editor has a variety of names 
depending on the kind of formula you are working with:

● Formula Editor.
● Format Formula Editor.
● Record Selection Formula Editor.
● Group Selection Formula Editor.
● Running Total Condition Formula Editor.

The Formula Editor is similar to the Custom Function Editor and the SQL Expression Editor. These editors are 
included in this description.

This dialog box appears when you edit an existing formula field or create a new formula field by right-clicking 
Formula Fields in the Field Explorer and selecting New. After you name your formula, the Formula Editor dialog 
box appears.
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Formula Editor Windows

The Formula Editor contains four main windows.

Report Fields Report fields contain all database fields accessible for your report. They also contain any 
formulas or groups already created for the report.

Note
This window does not appear when you create a custom function.

Functions Functions are pre-built procedures that return values. They perform calculations such as 
average, sum, count, sin, trim, and uppercase.

Note
Changing the syntax from Crystal syntax to Basic syntax or vice versa will change the list of 
functions in the Functions window as well as the list of operators in the Operators window. The 
functions and operators differ from syntax to syntax.

Operators Operators are the "action verbs" you use in formulas. They describe an operation or an action to 
take place between two or more values.

Examples of operators: add, subtract, less than, and greater than.

Formula Text 
Window

This is the area where you create or edit a formula.

Create a formula by double-clicking on any of the components listed in the Report Fields, 
Functions, or Operators trees. When you choose a component, the required syntax is also 
inserted. You can also manually enter a formula.

When you are finished creating or editing a formula, click the Check button to identify any errors 
in the formula. Click the Save button to save the formula.

Formula Workshop Buttons

The buttons for the General Toolbar of the Formula Workshop perform the following functions:

Table 31:

Button Description

Closes the Formula Workshop after prompting you to save changes. If you save changes, your 
formula is checked for errors.

Saves the formula, SQL Expression, or custom function.

Creates a new formula of the type selected from the list. Also used to create a new custom func
tion or SQL Expression.
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Button Description

Shows or hides the Workshop Tree.

Toggles display between Custom Function Editor and Custom Function Properties Dialog Box 
[page 737]. Custom functions and formulas (where possible) are displayed in the selected mode 
until this button is clicked again.

Opens the Formula Expert [page 837]. Use the Formula Expert to help you create a formula 
based on a custom function.

Note
This button is not available when creating a custom function.

Opens the online help for this dialog box.

The buttons for the Workshop Tree Toolbar of the Formula Workshop perform the following functions:

Table 32:

Button Description

Lets you rename the selected formula, custom function, or SQL Expression.

Deletes the selected formula, custom function, or SQL Expression.

Expands or collapses the selected node in the Workshop Tree. Also works with multiple node se
lections.

Shows or hides report object nodes in the Formatting Formulas folder if the objects do not have 
formulas associated with them.

The buttons for the Expressions Editor Toolbar of the Formula Workshop perform the following functions:

Table 33:

Button Description

Tests the syntax of the formula or custom function and identifies syntax errors if they are found.

Undoes the last action performed.

Redoes the last action.

When you select a field from the Report Fields window and click the Browse Data button, a dia
log box appears with a list of the values for the selected field.

View values for the selected field and select individual values to insert into your formula.

Note
This button is not available for custom functions.
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Button Description

Searches the Formula Editor for a specified word, number, or formula string.

Inserts a bookmark at the beginning of a selected formula line. Click the button again to remove 
the bookmark.

Jumps to the next bookmark.

Jumps to the previous bookmark.

Deletes all bookmarks in the current formula.

Arranges all Report Fields, Functions, and Operators trees in alphabetical order.

Hides or views the Report Fields tree.

Note
This button is not available for custom functions.

Hides or views the Functions tree.

Hides or views the Operators tree.

Allows you to select Crystal Syntax or Basic Syntax as your formula syntax. For more informa
tion, see Formula Reference [page 647].

Changing the syntax from Crystal syntax to Basic syntax or vice versa will change the list of 
functions in the Functions window as well as the list of operators in the Operators window. The 
functions and operators differ from syntax to syntax.

Comments out the highlighted selection of a formula. Commented lines are not evaluated as 
part of the formula.

Shortcut Keys

The following shortcut keys work in the Formula Editor:

Table 34:

Keyboard Combination Action Performed

Alt+B Opens Browse dialog box for highlighted field.

Alt+C Checks formula for errors.

Alt+F Opens or closes the Shows Field tree.

Alt+M Comments out or removes comments from current line
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Keyboard Combination Action Performed

Alt+O Sorts contents of trees.

Alt+P Opens or closes the Shows Operator tree.

Alt+S Saves formula without closing Formula Editor.

Alt+U Opens or closes the Shows Function tree.

Ctrl+A Selects all.

Ctrl+C Copies.

Ctrl+End Goes to the end of the last line of the formula.

Ctrl+F Opens the Find dialog box (same as clicking the find button).

Ctrl+F2 Sets bookmark.

Ctrl+Shift+F2 Clears all bookmarks.

Ctrl+Home Goes to the beginning of file.

Ctrl+Left Arrow Goes to the beginning of the left word (+Shift key will do the selection).

Ctrl+N Opens Formula Name dialog box, or another appropriate dialog box, to create a new formula.

Ctrl+S Saves formula and closes Formula Workshop.

Ctrl+T Sets focus to the syntax name list box.

Ctrl+Shift+Tab Changes focus to next control box (reverse order of Ctrl-Tab).

Ctrl+Tab Changes focus to next control box.

Ctrl+V Pastes.

Ctrl+X Cuts.

Ctrl+Z Undoes an action.

Ctrl+Shift+Z Repeats an action.

Ctrl+Space Keyword Auto Complete — shows a list of the functions available.

End Goes to end of line.

Enter Copies a selected object from a list to the formula text box.

F2 Goes to next bookmark.

F3 Finds next item as defined in the Find dialog box.

Shift+F2 Goes to previous bookmark.

Related Information

Performing Report Calculations [page 597]
Basic Syntax [page 647]
Crystal Syntax [page 680]
Tutorial: Filtering Data Using Selection Formulas [page 249]
Formula Workshop Dialog Box [page 779]
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1.7.3.1.36  Formula Name Dialog Box

Use the Formula Name dialog box to specify a name for your formula or custom function.

New Name Enter a name for the formula, custom function, SQL Expression, or parameter you are creating.

When placed on the report, the formula will appear as @YourFormulaName if you have "Show Field 
Names" selected in the Default Settings dialog box.

Use Expert Click the Use Expert button if you want to use the Formula Expert for creating your formula.

Use Editor Click the Use Editor button if you want to use the Formula Editor dialog box for creating your 
formula.

Related Information

Default Settings Dialog Box [page 745]
Field Explorer [page 539]
Custom Function Name Dialog Box [page 736]

1.7.3.1.37  Formula Workshop Dialog Box

The Formula Workshop is the place in SAP Crystal Reports where you can work with all types of formulas, custom 
functions, and SQL Expressions. The workshop consists of a toolbar, a tree that lists the types of formulas you can 
create or modify, and an area for defining the formula itself.

To access this dialog box, right-click in the Report Designer, point to Report and click Formula Workshop.

Toolbar See Formula Editor Dialog Box [page 774] for a description of each of the buttons on the various 
Formula Workshop toolbars.

Tree view The Workshop Tree contains folders for each type of formula you can create in SAP Crystal 
Reports. It also contains folders for custom functions and SQL Expressions. If the workshop 
appears as the result of using a specific command (for example, you've selected the Record 
command on the Selection Formulas submenu), the appropriate folder in the tree is selected, and 
the appropriate version of the Formula Editor appears.

Expand any folder in the tree to see the formulas that already exist. New formulas can be added, 
and existing formulas can be edited or deleted as needed.

Tip
The Workshop Tree can be docked. By default, it appears docked on the left-hand side of the 
Formula Workshop, but you can manually dock it on the right-hand side. In free-floating mode, 
the Workshop Tree can be dragged to any location in the workshop.
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Definition 
area

The definition area of the Formula Workshop is where you define or modify your formula, custom 
function, or SQL Expression. A version of the Formula Editor dialog box is the primary editor you 
will encounter in the definition area, but you might also see the Formula Expert or one of a number 
of dialog boxes used for working with custom functions.

Related Information

Formula Editor Dialog Box [page 774]
Performing Report Calculations [page 597]

1.7.3.1.38  Group Name Formula Editor

This dialog box appears when you are customizing a group name field. In the Insert Group dialog box, click 
Customize Group Name Field and then click Use a Formula as Group Name. Click the Formula button to open the 
Formula Editor.

Related Information

Grouping Data [page 582]

1.7.3.1.39  Help Text Dialog Box

The Help Text dialog box appears when you click the Help Text button on the Custom Function Properties dialog 
box.

Use this dialog box to specify a message to help others use the custom function you're creating. Help text is 
available only in this dialog box.

Related Information

Custom Function Properties Dialog Box [page 737]
Custom Functions [page 601]
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1.7.3.1.40  Hierarchical Group Options Dialog Box

Use the Hierarchical Options dialog box to group data hierarchically. When you group data hierarchically, you sort 
information based on the relationship between two fields.

This dialog box appears when you right-click in the Report Designer, point to Report, and click Hierarchical 
Grouping Options.

Available Groups Select the group that you want to sort hierarchically from the list.

Sort Data 
Hierarchically

Select this check box to hierarchically sort the data in the selected group.

Instance ID field This field is only for display; it shows the value for the group selected from the Available 
Groups list.

Parent ID field Select the field by which you want the Instance ID field organized.

For example, for a company hierarchal report, select the data field listing whom the 
employee reports to.

The type of the Instance ID and the Parent ID must be the same. For example, they both 
must be strings (text) or numbers.

Group Indent field Enter the amount you want to indent for each subgroup.

Note
The top level of the hierarchy is determined by group instances that match the 
Instance ID and Parent ID. If a group instance is not connected to any Parent ID, it 
appears at the top of the hierarchy.

Related Information

Grouping Data Hierarchically [page 583]
Grouping Data [page 582]

1.7.3.1.41  Index Legend Dialog Box

This dialog box appears when you click the Index Legend button on the Links tab of the Database Expert.

Use the Index Legend dialog box to see a key to the index indicators used in the Links display area.

Related Information

Links Tab (Database Expert) [page 836]
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1.7.3.1.42  Insert Group Dialog Box

Use the Insert Group dialog box to group your data without summarizing the data in the groups. This dialog box 
appears when you right-click in the Report Designer, point to Insert, and click Group.

Note
The information in this section also applies to the Change Group Options dialog box, the Chart Sort Order 
dialog box, and the Cross-Tab Group Options dialog box.

1.7.3.1.42.1  Common Tab

Use the Common tab to specify the field and sort order for your grouping.

Fields This list contains the fields and formulas used in your report. Select the field that you want to use 
for grouping.

Sort Order This list contains four sort direction options. The default is in ascending order. To change the sort 
direction, click the box to reveal the options and make your selection from the list.

Date Options This lists appears only when you are working with a date field. The list contains choices for 
grouping by time periods (each week, each month, and so on).

1.7.3.1.42.2  Options Tab

This tab can appear as part of several dialog boxes:

● Insert Group dialog box
● Change Group Options dialog box
● Cross-Tab Group Options dialog box

Note
The Options tab does not appear in the Chart Sort Order dialog box.

Customize 
Group Name 
Field

The group name field is displayed in the group tree and in the group header. By default, the 
group name field has the same values as the group field. Select this check box to define the 
group name field as:

● A database field.
● A group name formula that returns a string value, to generate values for a group name 

field.

For example, you could group on the Customer ID, but display the Customer Name as the 
group name. To do this, select the Choose From Existing Field option and choose the 
appropriate field from the list.
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Alternatively, you could group on the Customer ID, but use the following formula to display 
both the Customer ID and the Customer Name in the group name:

 ToText ({Customer.CustomerID}) + " : " + {Customer.CustomerName} 

To do this, select Use a Formula as Group Name and click the Formula button to enter your 
formula in the Formula Workshop.

Note
The Customize Group Name Field option is not available for groups sorted "in specified 
order."

You cannot include a field that is evaluated at runtime, such as a running total field, 
summary field or another group name field, in a group name formula.

Keep Group 
Together

Select this check box to keep your groups from breaking across pages.

Note
This option does not appear for the Cross-Tab Group Options dialog box.

Repeat Group 
Header On Each 
Page

If you want your groups to break across pages, select this check box to repeat the group 
header for every successive page.

Note
This option does not appear for the Cross-Tab Group Options dialog box.

1.7.3.1.42.3  Specified Order Tab

Use the Specified Order tab when you want to set up custom groups. Custom groups are freeform groups that are 
not necessarily triggered by any one field value. You define the groups and you specify the individual values that 
belong in each.

Note
The Specified Order tab appears only after you select "in specified order" as your sort order on the Common 
tab.

Named 
Group

Use this box to enter the name you want for your specified order group. You can also browse and 
select values in the database field to use as group names.

The box below displays the fields you have selected and the groups you have created as specified 
order groups.

Up arrow Click this button to move the highlighted group higher in the list.

Down arrow Click this button to move the highlighted group lower in the list.
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New Click this button to open the Define Named Group dialog box where you can create a new named 
group. If you entered a new name in the Named Group list on the Specified Order tab, it appears 
as the Group Name on the Define Named Group dialog box.

Edit Click this button open the Define Named Group dialog box where you can edit a group you've 
highlighted in the Named Group list.

Delete Click this button to delete the highlighted group.

1.7.3.1.42.4  Others Tab

Use the Others tab to set up what you want the program to do with all values not included in any of the specified 
groups.

Note
The Others tab appears only in connection with the Specified Order tab.

Discard all others Select this option if you do not want to print the unselected fields in the groups for your 
report. If you summarize groups, values in the discarded groups will not be summarized nor 
will they be included in any grand total if you have one.

Put all others 
together, with the 
name

Select this option and enter a name if you want to put all unselected fields in one group. The 
default name for this group is Others. If you summarize groups, the values in the group will 
be summarized and will be included in any grand total.

Leave in their own 
groups

When you click this option, your specified groups are shown in the order you specified. 
Remaining groups are displayed normally. If you summarize the groups, the values in the 
group will be summarized and will be included in any grand total.

1.7.3.1.43  Insert Object Dialog Box

Use the Insert Object dialog box to insert an object into you report. You can either insert an existing object, or 
create a new one.

This dialog box appears when you right-click in the Report Designer, point to Insert, and click OLE Object.

Create 
New

Click this option to create a new object and embed it in your report. When the Create New option is 
active, the Object Type list is displayed.

Create 
from File

Click this option if you would like to embed or link an object that already exists. For example, if you 
have created and saved a spreadsheet file in Microsoft Excel and you want to use it as an object, 
click Create from File and then select the file name via the File box.

The program displays the File box as well as the Browse button and Link check box whenever you 
select Create from File.
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Object 
Type

This box lists all of the object types available on your system.

Note
This list is based on the registration database. When OLE server applications are installed on 
your system, they are responsible for registering themselves with that database. If you have 
server applications on your system but they do not appear on this list, the applications may not 
have registered themselves properly.

Select the type of object you would like to embed in your report.

Display As 
Icon

Specifies whether the embedded object will appear in the report as an icon or whether the actual 
contents of the object will always be visible. Note that some object applications only display objects 
as icons.

If you select Display as Icon, you can open the object in your document by double-clicking its icon.

Related Information

Inserting Underlaying Images [page 640]
Inserting Shapes [page 610]

1.7.3.1.44  Insert Subreport Dialog Box

Use the Insert Subreport dialog box to insert a subreport into your report. Once the dialog box appears, you can 
either choose an already existing report to insert as a subreport or create a new report from scratch.

This dialog box appears when you right-click in the Report Designer, point to Insert and click Subreport.

Related Information

Inserting Subreports [page 631]
Unlinked vs. Linked Subreports [page 633]
Design Choices to Optimize Performance [page 646]
Crystal Report Creation Wizards [page 542]

1.7.3.1.44.1  Subreport Tab (Insert Subreport Dialog Box)

Use the Insert Subreport dialog box to insert a subreport into your report. Once the dialog box appears, you can 
either choose an already existing report to insert as a subreport or create a new report from scratch.
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Choose a Crystal 
Report in project

When you choose this option, the Report Name list under the option is activated.

Report Name Choose a report from your current project to be a subreport.

Choose an existing 
report

When you choose this option, the File name box under the option is activated. Enter the 
name of the report you want to use as a subreport. If you do not know the name of the 
report, click Browse to find the file.

File name Enter the full path for the report file you want to insert as a subreport. If you do not know 
the exact path, click Browse to find the desired file.

Browse Click the Browse button to find a report you'd like to include as a subreport. Double-click 
the report, or select Open and you are returned to the Insert Subreport dialog box. Notice 
that the file path to the report you just selected is now in the File name box.

Create a subreport 
with the Report 
Wizard

When you choose this option, the New report name edit box under the option is activated. 
Enter a name for the subreport and then click the Report Wizard button to create the new 
subreport.

New report name Enter the name you would like to assign to your new subreport and then click the Report 
Wizard button to create your new report.

Report Wizard Click this button to open the Standard Report Creation Wizard. Follow the directions on the 
tabs to create a new subreport.

On-demand 
subreport

Select this check box if you want your subreport to be On-demand. Data for an On-demand 
subreport is not read from the database until you drill down on the hyperlink used to 
represent it. Otherwise, subreport data is collected at the same time as the data for the 
container report.

Related Information

Inserting Subreports [page 631]
Unlinked vs. Linked Subreports [page 633]
Design Choices to Optimize Performance [page 646]
Crystal Report Creation Wizards [page 542]

1.7.3.1.44.2  Link Tab (Insert Subreport)

Use the Link Tab to specify the field in the parent report that will serve as the link field to the data in the subreport.

For Subreport Use this list to select the subreport that you want linked to the data in the container 
report.

Available fields The Available fields box lists all of the fields available in the container report to which you 
can link your subreport.
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Add (>) Click the Add button (>) to copy a field from the Available Fields box into the Field(s) to 
link to box.

Remove (<) Click the Remove button (<) to remove a field from the Field(s) to link to box.

Field(s) to link to The Field(s) to link to box displays the currently selected fields to which you intend to have 
your subreport link.

Subreport 
parameter field to 
use

The Subreport parameter field to use list appears when the Field(s) to link to box contains 
at least one field name. Use the Subreport parameter field to use list to determine the 
subreport field on which the container report and the subreport are linked.

Select data in 
subreport based on 
field

Use the Select data in subreport based on field check box to activate the Select data in 
subreport based on field list.

After you select this check box, choose a field from the list below to organize the 
subreport data based on a specific field. Clear this check box to have the subreport adopt 
the organization used in the primary report.

1.7.3.1.45  Insert Summary Dialog Box

Use the Insert Summary dialog box to summarize the data in a field in your report. You can insert summaries, 
subtotals, and grand totals while using this dialog box.

This dialog box appears when you right-click in the Report Designer, point to Insert, and click Summary.

Choose the field 
to summarize

This list displays the fields and formulas used in the report along with the fields available in 
the report's data source tables. Select the field that you want to summarize.

Calculate this 
summary

This list contains all the summary operations available for use in your report. Select the 
desired operation.

Note
Not all the summary types available apply to all fields. For example, you cannot sum or 
average a text, Boolean, date/time, time, or date field.

Summary 
location

This list contains the locations in your report in which you can place a summary. By default, 
every report can contain a summary field in the Report Footer (this is a Grand Total). If you 
want to add a different kind of summary, such as a subtotal, add a group using the Insert 
Group button.

Insert Group Use this button to add a group to your report. The Insert Group dialog box appears. After you 
save your group, it appears in the Summary location list and can be selected.

Show as a 
percentage of

Select this check box if you want to calculate the percentage total of one group within a 
broader grouping. For example, you can show the percentage of sales in each city based on 
the total sales for each country.

After you select the check box, you can choose the total or group you want the comparison 
to be based on.
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Note
The percentage option is available only when the result of a summary operation is 
numeric.

Summarize 
across hierarchy

This option enables you to calculate a summary across hierarchical groupings. To set or edit 
Hierarchical Options for existing groups, click Hierarchical Grouping Options on the Report 
menu.

Related Information

Insert Group Dialog Box [page 782]
Grouping Data Hierarchically [page 583]
Hiding Details in Summary Reports [page 587]
Grouping, Sorting, and Totaling Data [page 582]

1.7.3.1.46  Link Options Dialog Box

Use the Link Options dialog box to specify join and link types.

This dialog box appears when you have a link line selected and you click the Link Options button in the Links tab of 
the Database Expert.

Link Display This box describes the selected link.

Join Type The program enables you to specify the type of join you want it to use when joining SQL tables.

Enforce 
Join

The program enables you to enforce the use of tables while you're specifying joins:

Not 
Enforced

When you select this option, the link you've created is used only if it's explicitly 
required by the Select statement. This is the default option. Your users can create 
reports based on the selected tables without restriction (that is, without 
enforcement based on other tables).

Enforced 
From

When you select this option, if the "to" table for the link is used, the link is enforced. 
For example, if you create a link from Table A to Table B using Enforce From and 
select only a field from Table B, the Select statement will still include the join to 
Table A because it is enforced. Conversely, selecting only from Table A with the 
same join condition will not cause the join to Table B to be enforced.

Enforced To When you select this option, if the "from" table for the link is used, the link is 
enforced. For example, if you create a link from Table A to Table B using Enforce To 
and select only a field from Table A, the join to Table B will be enforced, and the 
Select statement that is generated will include both tables.

Enforced 
Both

When you select this option, if either the "from" table or the "to" table for this link is 
used, the link is enforced.
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Link Type The program enables you to specify the type of link you want it to use when joining tables.

Related Information

Links Tab (Database Expert) [page 836]
Accessing and Adding Data [page 549]

1.7.3.1.47  Map Fields Dialog Box

The Map Fields dialog box is used to link report fields to their corresponding database fields when changes are 
made to the structure of the database, or when moving a database from a direct access type to an SQL type. The 
Map Fields process helps you to make sure your reports print with the current version of the active database.

This dialog box appears when you click Update in the Set Datasource Location dialog box, or if the report 
database has changed since you last ran the report.

Unmapped fields 
(report fields)

The Unmapped fields list (upper left) shows the unmapped report fields for which the 
program detects a change in the active database.

Unmapped Fields 
(database fields)

The Unmapped fields list (upper right) shows the unmapped database fields for which the 
program detects a change.

Map Click Map to map the report field selected in the Unmapped fields list (upper left) to the 
database field selected in the Unmapped fields list (upper right).

Match type When the Match Type check box is selected, the Unmapped fields list (upper right) shows 
only the names of unmapped database fields that are of the same type as the field selected 
in the Unmapped fields list (upper left). When the Match Type check box is not selected, 
the Unmapped fields list (upper right) shows all unmapped database fields, regardless of 
the field type.

Mapped fields 
(report fields)

The Mapped fields list (lower left) displays the names of mapped report fields. When you 
map report fields, those fields appear in this list.

Mapped fields 
(database fields)

The Mapped fields list (lower right) shows the mapped database fields. When you map 
database fields, those fields appear in this list.

Unmap Click Unmap to unmap the report field selected in the Mapped fields list (lower left) and the 
database field selected in the Mapped fields list (lower right). After you click this button, the 
two fields are longer mapped.

Related Information

Accessing and Adding Data [page 549]

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 789



1.7.3.1.48  New Formatting Formula Dialog Box

The New Formatting Formula dialog box appears when you select the Formatting Formula option from the New 
list in the Formula Workshop dialog box.

Note
The Formatting Formula option is available after you have selected a section or object to format in the 
Formatting Formulas folder of the Formula Workshop.

Use this dialog box to determine the kind of formatting formula you want to create for the selected item (the 
choices differ depending on which item you've selected in the Formatting Formulas folder of the Formula 
Workshop). For example, for the Page Footer, you have options to create these formatting formulas:

● Background Color
● Reset Page Number After
● Suppress (No Drill-Down)
● Suppress Blank Section
● Underlay Following Sections

Select the appropriate option and click the Use Editor button to create your formula in the Formula Editor dialog 
box.

Related Information

Performing Report Calculations [page 597]
Formula Editor Dialog Box [page 774]

1.7.3.1.49  Numeric Axis Grids and Scales Dialog Box

Use the Numeric Axis Grids and Scales dialog box to format all of the axes in your chart. This dialog box appears 
when you right-click on a chart, point to Chart Options, and click Grid.

The Numeric Axis Grids and Scales dialog box contains different options depending on which axis and formatting 
tab is selected.

The tabs on the left of the dialog box show the available axes in the chart:

● Group Axis
● Data axis
● Data2 Axis (for dual-axes charts)
● X Axis (for bubble, radar, histogram, and scatter charts)
● Series Axis (for 3D charts).

When you select an axis tab, the tabs at the top of the dialog will also change to represent the formatting options 
for each axis.
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1.7.3.1.50  Order Links Dialog Box

This dialog box appears when you click Order Links from the Links tab of the Database Expert.

Use this dialog box to specify the order in which the program should process the table links. By default, the 
processing order matches the order in which the links appear on the Links tab. Use the arrow buttons in the Links 
Order dialog box to change the default order.

For example, if you have chosen the Credit, Customer, Orders, and Orders Details tables from the Xtreme 
database, the links tab shows the tables linked in alphabetical order.

In this case, the links will be processed first between the Credit/Customer tables, then between the Customer/
Orders tables, and finally between the Orders/Orders Details tables.

Note
Different link orders may result in different data sets returned for use in your report.

Related Information

Links Tab (Database Expert) [page 836]
Accessing and Adding Data [page 549]

1.7.3.1.51  Page Setup Dialog Box

Use the Page Setup dialog box to set the page margins for your report. The dialog box displays default margins 
when it first appears.

This dialog box appears when you right-click in the Report Designer, point to Design and click Page Setup.

Note
The program uses the non-printing areas established for your printer as default printer margins. While you can 
set margins that fall inside the non-printing areas, parts of your report may be clipped if you do.

Top Margin Enter the top margin in inches (or in the default value set for your report).

Left Margin Enter the left margin in inches (or in the default value set for your report).

Bottom Margin Enter the bottom margin in inches (or in the default value set for your report).

Right Margin Enter the right margin in inches (or in the default value set for your report).

Use Default Margins Select this check box to use the default page margin settings.

Adjust Automatically Select this check box so that when you print your report on paper that's a different size 
from that you designed for, the program readjusts the margins so that the size of the 
report's design area is not changed but is aligned on the page to match the same ratio you 
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originally specified. For example, if the new page is an inch larger than the original, that 
inch will be divided up in such as way as to enlarge all the margins in a ratio that remains 
faithful to the original.

Related Information

Determining Printing Area Characteristics [page 549]
Report Section Overview [page 534]

1.7.3.1.52  Print Setup Dialog Box

Use the Print Setup dialog box to select the printer, page orientation, and paper size you want to use to print the 
report. If you do not select a printer, the program will print to the Windows default printer.

This dialog box appears when you right-click in the Report Designer, point to Design, and click Printer Setup.

No Printer Select the No Printer check box when printing is not an option from a particular workstation.

Printer

Name Find the name of the printer to which you can send reports in the Name list.

Properties Click the Properties button to bring up the Properties dialog box for the selected printer.

Paper

Size Use the Size list to select from a variety of paper- or envelope-size options.

Source Use the Source list to select from a variety of feed or paper source options.

Orientation

Portrait Select the Portrait option to print your report in a standard-letter orientation.

Landscape Select the Landscape option to print your report in landscape orientation.

Reset to Default Click the Default Properties button to set all printer properties to their default settings.
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Related Information

Determining Printing Area Characteristics [page 549]
Report Section Overview [page 534]

1.7.3.1.53  Record Sort Expert

Use the Record Sort Expert to define how you want the records in your report to be sorted for printing. A sort field 
is a data field on which the sort procedure is based. You can add and remove sort fields and define the sort 
direction (ascending or descending) for the data in your report.

This dialog box appears when you right-click in the Report Designer, point to Report, and click Record Sort Expert.

Available Fields Displays a list of the report fields currently in the report as well as those available in the report's 
data source tables.

Sort Fields Displays a list of the sort fields currently in the report.

Add (>) Adds the selected report field to the Sort Fields list.

Remove (<) Removes the selected sort field from the Sort Fields list.

Sort Direction Sets the sort direction to ascending or descending.

Related Information

Grouping, Sorting, and Totaling Data [page 582]
Hiding Details in Summary Reports [page 587]
Design Choices to Optimize Performance [page 646]

1.7.3.1.54  Refresh Report Data Dialog Box

Use this dialog box to run the report using the current parameter values or to enter new parameter values.

Use current parameter 
values

Click this option to run the report using the current parameter values.

Prompt for new 
parameter values

Click this option if you want to run the report with different parameter values. When 
you choose this option the Enter Parameter Values dialog box appears, in which you 
can supply a specific parameter value or a range of parameter values.
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Related Information

Setting Parameters [page 576]

1.7.3.1.55  Rename Formula Dialog Box

Use the Rename Formula dialog box to specify a name for your formula, SQL Expression, or parameter.

Name Enter a name for the formula, SQL Expression, or parameter you are creating.

When placed on the report, the formula will appear as @YourFormulaName if you have "Show Field 
Names" selected in the Default Settings dialog box.

Related Information

Formula Editor Dialog Box [page 774]
Default Settings Dialog Box [page 745]
Field Explorer [page 539]

1.7.3.1.56  Rename Parameter Dialog Box

Use the Rename Parameter dialog box to give a new name to a parameter field. This dialog box appears when you 
right-click Parameter Fields in the Field Explorer and click Rename.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

Name Use this box to type the new name for your parameter field.

Related Information

Setting Parameters [page 576]
Incorporating Parameters into Formulas [page 581]
Tutorial: Reading and Setting Discrete Parameters [page 219]
Tutorial: Reading and Setting Discrete Parameters [page 326]
Field Explorer [page 539]
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1.7.3.1.57  Rename Running Total Dialog Box

Use the Rename Running Total dialog box to give a new name to a running total field. This dialog box appears 
when you right-click Running Total Fields in the Field Explorer and click Rename.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

Name Use this box to type the new name for your running total field.

Related Information

Creating Running Totals [page 593]
Placement of Running Total Fields [page 593]
Field Explorer [page 539]

1.7.3.1.58  Report Options Dialog Box

Use the Report Options dialog box to change the options for the current report. This dialog box appears when you 
right-click in the Report Designer, point to Report and select Report Options.

See Default Settings Dialog Box [page 745] if you want to change the default values for the program.

Convert 
Database NULL 
Values to Default

Select this check box to have the program convert null values from the database to a 0 (for 
numeric fields) or a blank (for non-numeric fields).

This option affects only null values found in the database used for a report.

Convert Other 
NULL Values to 
Default

Select this check box to have the program convert non-database null values in the report to a 
0 (for numeric fields) or a blank (for non-numeric fields).

This option affects only non-database null values in the report.

Show All Headers 
on Drill Down

Use this check box if you would like report drill-down views to include headers for all sections 
above the drill-down records. This option is not selected by default.

Always Sort 
Locally

Select this check box to ensure your records are sorted locally even if they were pre-sorted 
when retrieved from your data source.

Database Server 
is Case-
Insensitive

This check box specifies whether or not the SQL data you use in the report becomes case 
sensitive. If the data you are using contains fields where the data is in both upper case and 
lower case, and you do not wish to categorize the data by this aspect, select this check box.

Case Sensitive SQL data is not supported in the 32-bit standard edition of the program.
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Perform 
Grouping On 
Server

This check box is only available if the Use Indexes or Server For Speed check box is selected.

This option is not available for reports created from OLAP data.

Select this check box to have the program perform grouping on the server (server-side 
processing). Server-side processing allows you to set up a report that performs the majority 
of its processing on the server and pushes only relevant details to your computer. Server-
side processing provides you with a number of benefits:

● Less time connected to the server.
● Less memory needed to process the report on your computer.
● Lower transfer time from the server to the client.

Server-side processing works only for reports based on SQL data sources (you cannot, for 
example, use server-side processing for a report based on a query, since a query is not an 
SQL data source).

This option is not selected by default.

Use Indexes Or 
Server for Speed

When you select this check box, the program uses available indexes/servers to speed the 
record selection process.

When you clear this check box, the program selects records without the use of indexes/
specified servers (a much slower process).

If an index has a different name than the database it indexes, you need to identify the index 
for the program. You do this using the Link Options dialog box, which is accessed from the 
Links tab (Database Expert).

Verify on First 
Refresh

When this check box is selected, the report refreshes with the current version of the active 
database (unless it is a stored procedure) and resets its record buffers to the current record 
size the first time you refresh it per session. This option is not selected by default.

Verify Stored 
Procedures on 
First Refresh

When this check box is selected, the report refreshes with the current version of the stored 
procedure and resets its record buffers to the current record size the first time you refresh it 
per session. This option is not selected by default.

Respect Keep 
Group Together 
On First Page

Clear this check box to ensure that SAP Crystal Reports begins printing your first group on 
the first page of the report, even when you have selected the Keep Group Together check box 
on the Options Tab [page 782].

Select this check box along with the Keep Group Together check box to have SAP Crystal 
Reports begin printing the first group on the second page of the report, when the first group 
extends beyond a single page.

Select Distinct 
Records

Use this option to select only unique records from SQL tables in your database. By selecting 
this option in the Report Options dialog box, you set the option for the current report. 
Alternatively, you can set the option for all reports by switching on the Select Distinct 
Records command on the Database menu.

This option is not available for reports created from OLAP data.

Select Distinct 
Data for 
Browsing

When you browse a field, by default you see the first 500 unique values of the field. You can 
change this for the current report by clearing this option. If Select Distinct Data for Browsing 
is not selected, browsing returns the unique values in the first 500 records.
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Note that since most SQL servers do not support selecting distinct records for long data 
types such as memo and blob fields, selecting and browsing distinct records are not 
supported for such fields.

Retain Original 
Image Color 
Depth

If you want images in your report to keep their original color depth when they are 
encapsulated, select this option. Otherwise, all images are converted to 8 bits per pixel 
before being encapsulated.

Initial Report Part 
Settings

If you want to use objects from this report in the CrystalReportPartsViewer control, define 
the home object in this area. The home object provides the base for a path of Report Part 
hyperlinks; it also becomes the first object from the report that appears in the 
CrystalReportPartsViewer control.

Paste the Report 
Part Link

Use the Paste Link button to paste the name and data context of a report object that you 
selected and copied earlier. The button has these options: Context Report Part and Preview 
Report Part. These options affect the kind of data context that is pasted.

Object Name Enter the name of the report object that you want to use as the home object.

Data Context Enter the data context (that is, the specific record or records) that you want to use in your 
home object.

Preview Pages 
Start With

This list enables you to select the default level of magnification for displaying reports on the 
Preview tab.

● Full size allows you to view your report at the highest magnification for easy reading. The 
page is larger than a standard VGA Preview tab. When you resize the Preview tab, the 
report size remains unchanged. All that changes is the amount of the report you can view 
at one time. You may need to use scroll bars to see all sections of your report.

● Fit Width adjusts the width of the report to the width of the Preview tab. When you resize 
the Preview tab (within realistic limits), the page image resizes as well. To see a larger 
image, you can expand the window.

● Fit Page adjusts the width and the length of the report to let you see a full page of your 
report in the Preview tab. When you resize the Preview tab (within realistic limits), the 
page image resizes as well. To see a larger image, you can expand the window.

Related Information

Default Settings Dialog Box [page 745]
Report Parts Overview [page 614]
Optimizing Report Performance [page 644]

1.7.3.1.59  Report Part Map Fields Dialog Box

This dialog box opens when you are creating an Another Report Object hyperlink and choose the Design View 
Report Part option (or if you choose the Smart Report Part option for an object copied from a report's Design 
view) and your source and target reports have different data structures. Each field in the Unmapped Fields area 
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represents a group in your source report. Use this dialog box to map these groups to report fields in your target 
report.

Unmapped Fields The Unmapped fields list shows the unmapped groups in your source report.

Report Fields The Report Fields list shows the database fields in your target report that you can select for 
mapping.

Map Click Map to map the group selected in the Unmapped Fields list to the database field 
selected in the Report Fields list. After you click this button, the selected group and field are 
mapped, and both are moved to the Mapped Fields area.

Original Fields The Original Fields list displays the groups in your source report that you have mapped.

Mapped Fields The Mapped fields list shows the database fields in your target report that you have mapped.

Unmap Click Unmap to unmap the report groups and field selected in the Mapped fields area. After 
you click this button, the selected group and field are longer mapped.

Related Information

Report Parts Overview [page 614]
Implementing Report Part Drill Down [page 617]

1.7.3.1.60  Set CSS Class Dialog Box

Use Set CSS Class dialog box to apply formatting to reports using classes in a cascading style sheet (CSS). This 
dialog box appears when you right-click in the Report Designer and select Set CSS Class.

Note
This dialog box affects report output only when the report is rendered into HTML and the class has been 
defined in the .aspx file of the project.

Object Scope Select the objects or sections you would like the class to be applied to when the report is 
rendered into HTML.

CSS Class 
Name

Enter the name of the class. When the report is rendered into HTML, this class name will be 
attached to all the objects or sections defined in the Object Scope field.

Related Information

Formatting Reports using Cascading Style Sheets [page 613]

798 C U S T O M E R
SAP Crystal Reports for Visual Studio .NET SDK Developer Guide

SAP Crystal Reports .NET SDK Developer Guide



1.7.3.1.61  Set Datasource Location Dialog Box

Use the Set Datasource Location dialog box to specify a new database or a new location for the database used in 
the report. To access this dialog box, right-click in the Database Fields folder in the Field Explorer and click Set 
Datasource Location.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

Current 
Data 
Source

This list displays the database and tables currently used in the report. The main report is shown as 
the root node.

Note
● All subreports are located under one node so that the data sources for them are grouped 

together. A data source used in two or more subreports is indicated by a different icon at the 
data source level.

● If a table is used in two or more subreports but the alias name is different, the real table 
name is appended to the end.

Expanding the Properties node for a data source or for a table displays detailed information about 
the item. Some entries in the Properties node, such as Database Name, have shortcut menu 
options.

Replace 
With

This list displays the same options as the Data tab of the Database Expert. See Data Tab (Database 
Expert) [page 833] for information about how to select a new data source or table.

Update Click the Update button to update the new data source information in the Current Data Source list. 
If the new data source is different from the one you're replacing, the Map Fields dialog box appears.

Related Information

Map Fields Dialog Box [page 789]
Accessing and Adding Data [page 549]

1.7.3.1.62  Set Default Values Dialog Box

Use the Set Default Values dialog box to specify the default prompts you want to appear with your parameter 
field.

This dialog box appears when you click Set Default Values in the Create Parameter Field dialog box or the Edit 
Parameter Fields dialog box.
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Select From Database

Browse table Use this list to pick the table you want to browse for fields/values to use for changing the Default 
Values for your parameter field.

Browse field Use this list to pick the field you want to browse for values to use for changing the Default Values 
for your parameter field.

Select or Enter Value

Use the "Select or enter value" box to enter values in the Default Values list. You can type new values in the "Select 
or enter value" box and then press the add button (>), or you can select a value from the "Select or enter value" 
list (beneath the "Select or enter value" box) and then press the add button (>).

Add (>) Use the add button to move values from the "Select or enter value" box to the Default 
Values list.

Add all (>>) Use the add all button to move all values in the "Select or enter value" list to the Default 
Values list.

Delete (<) Use the delete button to remove a value from the Default Values list.

Delete all (<<) Use the delete all button to remove all values from the Default Values list.

Default Values Use this list to create a list of default values for the parameter field you are creating. The 
items you choose for the Default Values list may represent a subset of the items you chose 
in the Browse Table list and the Browse Field list.

Order arrow buttons Use the Order arrow buttons to move a value up or down in the Default Values list.

Import Click this button to import a text file containing a pick list of parameter values.

Export Click this button to export the pick list of parameter values to a text file.

Set Description Use this option to add a description to any value in the Default Values list. Clicking this 
button opens the Define Description dialog box.

Options

Length limit By selecting the Length limit check box for a String value, you can determine the minimum or 
maximum length for a parameter value entered on the Enter Parameter Values dialog box. This 
option is not selected by default.

Min Length Use the Min Length box to limit the minimum number of characters that can appear in your String 
value parameter field.

Max Length Use the Max Length box to limit the maximum number of characters that can appear in your String 
value parameter field.
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Edit mask For a string parameter field, you can choose to enter an Edit Mask in the Edit Mask box, rather than 
specifying a range. The Edit Mask can be any of a set of masking characters used to restrict the 
values you can enter as parameter values (the edit mask also limits the values you can enter as 
default prompting values).

Note
When you enter an Edit Mask, the length options become inactive.

Display Use the Display list to select how you'd like the Default Values in the Enter Parameter Values dialog 
box to appear. If you select Value and description, the default values are displayed as the values 
and their corresponding Descriptions. If you select Description, only the descriptions of the values 
are displayed.

Order In the Order list, you can specify whether you want the default values sorted. The sorting order can 
be alphabetically ascending, alphabetically descending, numerically ascending, numerically 
descending, DateTime ascending, or DateTime descending.

Order 
based on

In the Order based on list, you can specify whether to sort default values based on value or 
description.

Note
If you apply numerical sorting to an alphabetic value or description, the default values will not be 
sorted.

Related Information

Setting Parameters [page 576]
Create Parameter Field Dialog Box [page 731]
Limiting Entry Type and Format in Parameters [page 579]

1.7.3.1.63  Set Print Date and Time Dialog Box

Use the Set Print Date/Time dialog box to set the date and time for your report. You can choose either today's 
date and time or specify another date and time.

This dialog box appears when you right-click in the Report Designer, point to Report and select Set Print Date and 
Time.

Today's Date and 
Time

Select this check box to use today's date and time as your report date.

Other Select this check box if you want to use a date other than today's as the report date. When 
you select this check box, the Year, Month, and Day edit boxes are activated where you can 
specify the desired print date.
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Date Use the Date list to select a print date.

Time Use the Time box to set the print time.

Related Information

Default Settings Dialog Box [page 745]

1.7.3.1.64  Show SQL Query Dialog Box

The Show SQL Query dialog box displays the SQL query that the program is sending to your SQL server. This 
dialog box appears when you right-click in the Report Designer, point to Database and click Show SQL Query.

SELECT SELECT lists all of the fields used in the report, including fields used in formulas, totals, the sort 
order, the selection formula, and ranges.

FROM FROM lists all the tables used in the report, and each table name is followed by an alias name.

WHERE WHERE specifies any links between tables and field ranges for the report.

ORDER BY ORDER BY sorts the data in alphabetic or numeric ascending or descending order.

Related Information

Selecting Records [page 566]
Pushing Down Record Selection to the Database Server [page 569]
Defining Virtual Tables Based on a Command/SQL Query [page 552]

1.7.3.1.65  SQL Expression Name Dialog Box

Use the SQL Expression Name dialog box to enter a name for a SQL expression field you are creating. This dialog 
box appears when you right-click SQL Expression Fields in the Field Explorer and select New.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

Name Use this box to enter a name for a new SQL expression field you are creating.

Then click OK to open the SQL Expression Editor. You can use the SQL Expression Editor to enter the 
SQL expression.
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Related Information

Formula Editor Dialog Box [page 774]
SQL Expressions [page 608]
Pushing Down Record Selection to the Database Server [page 569]

1.7.3.1.66  Subreport Links Dialog Box

Use the Subreport Links dialog box to specify the field in the parent report that will serve as the link field to the 
data in the subreport.

This dialog box appears when you right-click the subreport object and choose the Change Subreport Links 
command.

For Subreport Use this list to select the subreport that you want linked to the data in the container report. 
This list is active only if you have multiple subreports.

Available fields The Available fields box lists all of the fields available in the container report to which you 
can link your subreport.

Add (>) Click the Add button (>) to copy a field from the Available Fields box into the Field(s) to 
link to box.

Remove (<) Click the Remove button (<) to remove a field from the Field(s) to link to box.

Field(s) to link to The Field(s) to link to box displays the currently selected fields to which you intend to have 
your subreport link.

Subreport 
parameter field to 
use

The Subreport parameter field to use list appears when the Field(s) to link to box contains 
at least one field name. Use the Subreport parameter field to use list to determine the 
subreport field on which the container report and the subreport are linked.

Select data in 
subreport based on 
field

Use the Select data in subreport based on field check box to activate the Select data in 
subreport based on field list.

After you select this check box, choose a field from the list below to organize the subreport 
data based on a specific field. Clear this check box to have the subreport adopt the 
organization used in the primary report.

Related Information

Inserting Subreports [page 631]
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1.7.3.1.67  Text Format Dialog Box

Use the Text Format dialog box to change font types/styles, format paragraphs, and set tabs for a text object. 
This dialog box appears when you edit a text object, select text in the object, and then right-click the selected text 
and choose Text Formatting.

1.7.3.1.67.1  Paragraph tab (Text Format)

Use the Paragraph tab to set formatting options for paragraphs in a text object.

Indentations

First Line Enter the distance in inches (or the default measurement for your report) that you want the first line 
of the paragraph to be indented from the rest of the paragraph.

Left Enter the distance in inches (or the default measurement for your report) that you want the 
paragraph to be indented from the left margin of the page.

Right Enter the distance in inches (or the default measurement for your report) that you want the 
paragraph to be indented from the right margin of the page.

Spacing

Line spacing Enter the spacing you want for lines as a multiple of the font size you are using, or as an exact 
number of points.

Of Use this box to enter the multiple you want to use (if you selected Multiple for Line Spacing), or the 
number of points (if you selected Exact for Line Spacing).

Reading Order

Left to Right Select this button if the text should be read from left to right.

Right to Left Select this button if the text should be read from right to left.
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Horizontal Alignment

Alignment list Select the desired alignment option for your paragraph from this list. The four choices available 
are: left, right, center, and justified alignment.

Related Information

Field and Text Objects [page 556]

1.7.3.1.67.2  Tabs Tab (Text Format)

Use the Tabs tab to set, delete, modify and edit tabs in a text object.

Tab Stop Position Enter the desired tab stop position in this box. Tab stops are measured in inches.

Alignment options Choose from four alignment options for the selected tab stop: left, right, center, and decimal.

Set Once you have entered a tab stop position into the Tab Stop Position box, click this button to 
set it.

Delete When you click this button, the selected tab stop is deleted.

Delete All When you click this button all the defined tab stops are deleted.

Related Information

Format Editor Dialog Box [page 762]
Field and Text Objects [page 556]

1.7.3.1.68  Titles Dialog Box

Use the Titles dialog box to add, change, or delete a Title, Subtitle, Footnote, Group Title, Data Axis Title, Data2 
Axis Title, and a Series Axis title in your chart.

This dialog box appears when you right-click a chart, point to Chart Options, and select Titles.

Title By default, the chart title is placed at the top center of your chart

Subtitle By default, the subtitle is placed at the top center of your chart, directly below the chart title.

Footnote By default, the chart footnote is placed at the bottom right corner of your chart.
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Series Axis 
Title

In 3D charts, the series labels that are normally displayed in the legend area are plotted along a 
secondary group axis. In the default configuration, these series labels are drawn on the lower 
left side of the 3D cube. Add a series axis title to further describe the information that is being 
charted on this series axis.

Group Title Adds a title for your chart's group axis. The group title is placed just above, below, or next to the 
group axis labels.

Data Title Adds a title to the primary data (Y1) axis in your chart:

Data2 Title In dual-axes and bi-polar charts, the primary data (Y1) axis shows some of the groups in your 
data sheet and a secondary data (Y2) axis plots other groups of data. Add a title to the Y2 axis 
to explain what is being plotted on this axis.

1.7.3.1.69  3D Settings

This section describes the options available in the Choose a Viewing Angle dialog box. Use this dialog box to define 
viewing angles in your 3D charts.

About 3D settings

The 3D Viewing Angles dialog box gives you a variety of preset angle options to choose from. Not only can you 
Pan, Rotate, or Move your 3D chart to anywhere on the screen, but you can also adjust the thickness of the frame 
walls as well as stretch and shrink them. The 3D View Angles enables you to really get creative with the 
presentation of your 3D chart. In addition to the viewing angles for a 3D chart, you also use these features in an 
Advanced 3D chart.
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1.7.3.1.69.1  Choose a viewing angle

The Choose a Viewing Angle dialog box shows a picture of all defined viewing angles. It may contain more or fewer 
viewing angle pictures depending on previous selections in the Advanced Options section of the dialog box.

1.7.3.1.69.1.1  To select a defined viewing angle

1. Select a viewing angle picture.
2. Select the OK button to apply the Viewing Angle to your 3D chart, and then exit to the Choose a Viewing Angle 

dialog box.
3. Select the Advanced Options button to display additional viewing angle selections.

1.7.3.1.69.2  Advanced viewing angle options

To begin, select the Advanced Options button in the Choose a Viewing Angle dialog box.

Options

● Select the Presets Only button to close the advanced options section of the Choose a Viewing Angle dialog 
box.

● Use the arrow buttons underneath the viewing angle picture to scroll through and select from the different 
viewing angles on the left side of the dialog box. The double left-arrow [<<] and right arrow [>>] buttons scroll 
through the list of viewing angles continuously. The single left-arrow [<] and right-arrow [>] buttons scroll to 
the next viewing angle in the list. The square button in the center of the arrow buttons stops continuous 
scrolling.

● Use the Rotate, Pan, Walls, and Move tabs to change a viewing angle. See Rotate a 3D chart [page 808], Pan 
a 3D chart [page 809], 3D chart walls [page 810], and Move a 3D chart [page 811].

● After you have changed or created a new viewing angle, select the Save button to save an existing or new 
viewing angle using the existing viewing angle file name.

● Select the Save As button to save the new viewing angle with a new name.
● Select the Rename button to change the name of a viewing angle file name.
● Select the Delete button to delete an existing viewing angle file.
● Select the Duplicate button to create another viewing angle file that is a duplicate of another angle.
● Select the OK button to apply the viewing angle to your chart and close this dialog box. When you select this 

button, you will be prompted to save any changes to a viewing angle. You may save your changes to an 
existing viewing angle or create a new viewing angle that will appear in the Choose a Viewing Angle dialog box 
the next time you select the 3D Settings option.

● Select the Cancel button to exit this dialog box without changing your chart.
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1.7.3.1.69.3  Rotate a 3D chart

You can use the Rotate tab inside the Advanced Options section of the Choose a Viewing Angle dialog box to 
rotate a 3D chart to any angle.

1.7.3.1.69.3.1  To rotate a 3D chart

1. Select the Advanced Options button in the Choose a Viewing Angle dialog box.
2. Select the Rotate tab in Advanced Options section of the Choose a Viewing Angle dialog box.

When the Rotate tab is selected in the Advanced Options section of Choose a Viewing Angle, you can rotate 
the 3D chart several ways:

○ Click the X, Y, and Z arrow tabs.
X rotates the chart from left to right or right to left, Y rotates from top to bottom or bottom to top, and Z 
rotates the chart from side to side. As you rotate a chart with the X, Y, or Z, notice that the arrows on the 
rotation orb light up.

The arrows on the rotation orb corresponds to the X, Y, and Z rotation. The left and right arrows 
correspond to the X direction. The up and down arrows correspond to the Y direction. The middle arrows 
correspond to the Z direction. You can use the arrows on the rotation orb to rotate a chart. Simply click 
the arrows. The arrows rotate the chart in the same way as the X, Y, Z left-right arrow buttons.

○ Use the Advanced Options 3D Viewing Angle Display Window.

Click and drag your mouse inside this window to rotate the 3D chart.
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1.7.3.1.69.4  Pan a 3D chart

You can use the Pan tab inside the Advanced Options section of the Choose a Viewing Angle dialog box to pan and 
zoom a 3D chart inside the chart frame. You can move the chart from left to right or from top to bottom within the 
chart frame. To move the chart along the X, Y, and Z axes, see Move a 3D chart [page 811].

1.7.3.1.69.4.1  To pan a 3D chart

1. Select the Advanced Options button in the Choose a Viewing Angle dialog box.
2. Select the Pan tab in the Advanced Options section of the Choose a Viewing Angle dialog box.

When the Pan tab is selected in the Advanced Options section of Choose a Viewing Angle, you can pan and 
zoom the 3D chart several ways:

○ Click the X, Y, and Zoom arrow tabs.
X pans from left to right or right to left, Y pans from top to bottom or bottom to top, and Zoom pans 
nearer or further away.

○ Use these arrows to pan the 3D chart in the X and Y direction.

○ Use the Advanced Options 3D Viewing Angle Display Window.

Click and drag your mouse inside this window to pan the 3D chart.
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1.7.3.1.69.5  3D chart walls

Use the Walls tab inside the Advanced Options section of the Choose a Viewing Angle dialog box to increase and 
decrease the thickness of the walls on a 3D chart. You can use the Walls tab inside the Advanced Options section 
of the Choose a Viewing Angle dialog box to change the 3D chart walls.

1.7.3.1.69.5.1  To change wall thickness in a 3D chart

1. Select the Advanced Options button in the Choose a Viewing Angle dialog box.
2. Select the Walls tab in the Advanced Options section of the Choose a Viewing Angle dialog box.

When the Walls tab is selected in the Advanced Options section of Choose a Viewing Angle, you can change 
the size of the 3D chart walls several ways:

○ Use Length and Thickness X, Y, and Z areas to increase and decrease the length and thickness of the 
walls.
X controls length and thickness along the X-axis, Y controls length and thickness along the Y-axis, Z 
controls length and thickness along the Z-axis.
Selecting Link grays out the Y and Z options in either the Length or Thickness area. When you select Link, 
changes made to X are duplicated for both Y and Z.

○ Use the arrows on the chart in the Walls tab to change the length and thickness of the 3D chart walls.
The arrows on the chart correspond to the X, Y, and Z length and thickness arrows.

The upper left arrows correspond to the X wall thickness. The bottom center arrows correspond to the Y 
wall thickness. The upper right arrows correspond to the Z wall thickness. The bottom right arrows 
correspond to the X wall length. The top center arrows correspond to the Y wall length. The bottom left 
arrows correspond to the Z wall length.

○ Use the Advanced Options 3D Viewing Angle Display Window.
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Click and drag your mouse inside this window to change the length and thickness of the 3D chart walls.

1.7.3.1.69.6  Move a 3D chart

Use the Move tab inside the Advanced Options section of the Choose a Viewing Angle dialog box to increase move 
and set the perspective of the 3D chart within the chart frame. You can move the chart along the X, Y, and Z axes 
within the chart frame. To move the chart from left to right or from top to bottom, see Pan a 3D chart [page 809].

1.7.3.1.69.6.1  To move a 3D chart

1. Select the Advanced Options button in the Choose a Viewing Angle dialog box.
2. Select the Move tab in the Advanced Options section of the Choose a Viewing Angle dialog box.

When the Move tab is selected in the Advanced Options section of Choose a Viewing Angle, you can move the 
3D chart several ways:

○ Use the X, Y, Z, and Perspective arrow tabs to move and change the perspective of the chart.
X moves the 3D chart from bottom right to top left, Y moves the chart up and down, Z moves the chart 
from top right to bottom left.

○ Use these arrows to move the chart in the X, Y, and Z directions.

The left and right arrows correspond to X. The up and down arrows correspond to Y. The shorter middle 
arrows correspond to Z.
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○ Use the Advanced Options 3D Viewing Angle Display Window.

Click and drag your mouse inside this window to move the 3D chart inside the chart frame.

1.7.3.2 SAP Crystal Reports Wizards and Experts

SAP Crystal Reports includes a number of experts and wizards that help you create several kinds of reports, 
prepare graphs, set up the overall report format, link related databases, select records and groups for inclusion in 
the report, and gather the files you need to include when you distribute the report with step-by-step instructions.

Follow the instructions in the dialog boxes or tabs that appear and the Expert will lead you through otherwise 
complex procedures with a minimum of effort.

1.7.3.2.1 Report Creation Wizards

The Report Creation Wizard guides you through the creation of a new report. This dialog box appears when you 
create a new Crystal report and choose "Using the Report Wizard" option in the Crystal Report Gallery dialog box.

The following Report Creation Wizards are included in SAP Crystal Reports:

● Standard
● Cross-Tab
● Mail Label

Each Report Creation Wizard consists of several screens that lead you through step-by-step instructions for 
creating the specified report. The Cross-Tab and Mail Label Report Creation Wizards have screens unique to their 
specific type of report.

Related Information

Mailing Labels Report Creation Wizard [page 543]
Cross-Tab Report Creation Wizard [page 543]
Standard Report Creation Wizard [page 542]
Designing New Reports [page 546]
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1.7.3.2.1.1  Data Screen (Report Creation Wizard)

The Data screen appears in the Report Creation Wizard when you select any of the wizards in the Crystal Reports 
Gallery dialog box when creating a new report.

Use the Data screen to select the data source and tables for your new report.

Available Data 
Sources

The available data sources tree is where you select your data source. For information about 
how to use this list, see Data Tab (Database Expert) [page 833].

Selected Tables Once you have chosen the desired data source, use the > arrow to add the tables you want 
to use in your report.

Related Information

Accessing and Adding Data [page 549]
Link Screen (Report Creation Wizard) [page 813]

1.7.3.2.1.2  Link Screen (Report Creation Wizard)

Use the Link screen to link tables in your new report. The Link screen appears in the Report Creation Wizard when 
you have selected two or more tables on the Data Screen (Report Creation Wizard) [page 813].

The Links tab has the same functionality as the Links Tab (Database Expert) [page 836] in the Database Expert 
Dialog Box.

1.7.3.2.1.3  Fields Screen (Report Creation Wizard)

Use the Fields screen to select the fields you want included in your report.

Available Fields This list displays all of the fields available for use in your report. The list is based on the 
tables you selected on the Data Screen (Report Creation Wizard) [page 813].

Browse Data Click this button to browse the data of the field that is selected in the Available Fields list.

Find Field Click this button to enter the name of a field you'd like to locate in the Available Fields list.

Add or remove 
arrow buttons

Use the > arrow adjacent to the Fields to Display list to add fields from the Available Fields 
list. Use the < arrows to remove fields you've already added. Double arrows add or 
remove all fields.

Fields to Display This list displays all of the report fields presently active in the report.

Up or down arrow 
buttons

Use the up and down arrows adjacent to the Fields to Display list to change the order of 
fields you've added from the Available Fields list.
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Related Information

Find Field Name Dialog Box [page 761]
Field and Text Objects [page 556]

1.7.3.2.1.4  Grouping Screen (Report Creation Wizard)

Use the Group screen to specify how fields will be grouped on the report. Creating groups is an optional step in the 
wizard.

Available Fields This list displays all of the fields available for use in your report. The list is based on the fields 
you chose on the Fields screen (Report Creation Wizard) and the tables you selected on the 
Data screen (Report Creation Wizard).

Browse Data Click this button to browse the data of the field that is selected in the Available Fields list.

Find Field Click this button to enter the name of a field you'd like to locate in the Available Fields list.

Add or remove 
arrow buttons

Use the > arrow adjacent to the Group By list to add fields from the Available Fields list. Use the 
< arrows to remove fields you've already added. Double arrows add or remove all fields.

Group By This list displays all of the fields you've selected for grouping. As you add fields, they are added 
in a hierarchy. This hierarchy establishes the order the groups will appear in the report. You can 
change the order of the hierarchy by using the up and down arrow buttons.

You can also set the sorting order for each field you add to the Group By list. Select a sort order 
from the adjacent list:

● Click in ascending order to sort the values for the field selected in the Group By list in 
ascending (A to Z, 1 to 9) order.

● Click in descending order to sort the values for the field selected in the Group By list in 
descending (Z to A, 9 to 1) order.

Up or down 
arrow buttons

Use the up and down arrows adjacent to the Group By list to change the order of fields you've 
added from the Available Fields list.

1.7.3.2.1.5  Summaries Screen (Report Creation Wizard)

Use the Summaries screen to choose fields to be subtotals, counted, and so on. This screen appears only if you've 
specified a group on the Grouping Screen (Report Creation Wizard) [page 814]. Creating a summary field is an 
optional step in the wizard.

Available Fields This list displays the report fields available for totaling in the report.

Browse Data Click this button to browse the data of the field that is selected in the Available Fields 
list.

Find Field Click this button to enter the name of a field you'd like to locate in the Available Fields 
list.
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Summarized Fields This list displays the total fields currently in use in the report.

Add or remove arrow 
buttons

Use the > arrow adjacent to the Summarized Fields list to add fields from the Available 
Fields list. Use the < arrows to remove fields you've already added. Double arrows add 
or remove all fields.

Summary options Click a summary option for the field selected in the Summarized list. You can choose 
options to total a field, or to count its entries, and so on.

Related Information

Hiding Details in Summary Reports [page 587]
Design Choices to Optimize Performance [page 646]

1.7.3.2.1.6  Group Sorting Screen (Report Creation Wizard)

Use the Group Sorting screen to sort groups you created on the Grouping Screen. You can sort all groups, or you 
can choose the top or bottom 5 groups. When sorting by the top or bottom 5 groups, you can also choose the 
summarized field you want to base the sorting on.

This screen appears only if you've specified a group on the Grouping Screen (Report Creation Wizard) [page 814] 
and a summary on the Summaries Screen (Report Creation Wizard) [page 814]. Creating a group sort is an 
optional step in the wizard.

Group that will be 
sorted

Select the group to be sorted from a list of groups you created on the Grouping screen.

Group ordering 
options

Select a group sorting option.

If you choose Top 5 or Bottom 5, your report displays data for only those groups; no 
other groups appear on your report.

Comparing summary 
values

If you've chosen Top 5 or Bottom 5 as your group ordering option, you must select a 
summarized field to base the sorting on. The choices that appear in this list are the 
summaries you created on the Summaries screen.

Related Information

Grouping, Sorting, and Totaling Data [page 582]
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1.7.3.2.1.7  Chart Screen (Report Creation Wizard)

Use the Chart screen to insert a graph or chart into a report. This screen appears with slight variations in all 
Report Creation Wizards except the Mailing Labels wizard.

In the Standard Report Creation Wizard, the Chart screen appears only if you've specified a group on the Grouping 
Screen (Report Creation Wizard) [page 814] and a summary on the Summaries Screen (Report Creation Wizard) 
[page 814]. Creating a chart is an optional step in all wizards.

Chart types Click the type of chart you'd like to add to your report. You can choose from these types:

● Bar Chart
● Line Chart
● Pie Chart.

Chart title Add a title for your chart.

On change of Select the group field you want to use as a condition for plotting values in a graph or chart. 
Points will be plotted whenever the value in the field changes. You can choose from the groups 
you created on the Grouping Screen (Report Creation Wizard) [page 814].

Subdivided by Use this list to choose the secondary row or column to base your chart on. Clicking this list 
displays the row/columns fields in your report that you can choose from.

Show summary Use this list to select the summary field whose values you want to display in your graph. You 
can choose from the groups you created on the Summaries Screen (Report Creation Wizard) 
[page 814].

Related Information

Chart Types [page 624]
Chart Layouts [page 624]

1.7.3.2.1.8  Record Selection Screen (Report Creation Wizard)

Use the Record Selection screen to choose fields to select (or filter) records in a report. By selecting records in 
this manner, you can narrow the scope of your report and improve processing speed. Creating a record selection 
is an optional step in the wizard.

Available Fields This list displays the report fields currently available for selection in your report.

Filter Fields This list displays the fields currently selected as filter for your report.

Add or remove 
arrow buttons

Use the > arrow adjacent to the Filter Fields list to add fields from the Available Fields list. Use 
the < arrows to remove fields you've already added.

Selection 
options

A list of Selection options appears under the Filter Fields list when you add a field. The options 
in the list are dynamic and depend on the field you've chosen.
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● Use the first list box and the others that might appear to select the condition that best 
finishes this sentence:
"I want to select all records where the value in the field I have selected is…"

● Using the selection options, you might create a record selection such as:
"I want to select all records where the value of the Sales field is between 10,000 and 
20,000."

Related Information

Filtering Data [page 566]

1.7.3.2.1.9  Report Style (Report Creation Wizard)

Use the Report Style screen to choose from predefined formatting templates for use in your report. Adding a style 
is an optional step in the wizard.

Available Styles This area displays the styles available for use in your report. Select the desired style from the 
list.

Preview This box displays a sample of the style selected in the Available Styles area.

Related Information

Absolute Formatting [page 609]
Conditional Formatting [page 610]
Formatting Report Sections [page 539]

1.7.3.2.1.10  Cross-Tab Screen (Cross-Tab Report Creation 
Wizard)

Use the Cross-Tab screen to create and format a cross-tab object for your report. This screen appears only in the 
Cross-Tab Report Creation Wizard.

Available 
Fields

This list displays all the tables and fields that you have activated for use in the report.

Select the field you want to use and drag it into the appropriate list, or click the appropriate arrow 
button. Repeat this process to add additional fields.

Browse Data Click the Browse Data button to view the values for a field you have selected in the Available 
Fields list.
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Find Field Click this button to enter the name of a field you'd like to locate in the Available Fields list.

Add or 
remove arrow 
buttons

Use the > arrows adjacent to each list to add fields from the Available Fields list. Use the < arrows 
to remove fields you've already added.

Up or down 
arrow 
buttons

Use the up and down arrows adjacent to each list to change the order of fields you've added from 
the Available Fields list.

Columns This list displays the fields that you have selected as column headings for your cross-tab. If you 
have multiple column headings, they will appear on your report in the order in which they appear 
on this list.

To add a column heading to this list, select a field from the Available Fields list and then drag it 
onto the list, or click the > arrow adjacent to the Columns list.

If you choose a Date field or a Boolean field, the adjacent list becomes available with options that 
apply to that type of field. For example, if you pick a date field, you can select options such as "for 
each day," 'for each week," "for each two weeks," and so on.

Rows This list displays the fields that you have selected as row headings for your cross-tab. If you have 
multiple row headings, they will appear on your report in the order they appear on this list.

To add a row heading to this list, select a field from the Available Fields list and then drag it onto 
the list, or click the > arrow adjacent to the Rows list.

If you choose a Date field or a Boolean field, the adjacent list becomes available with options that 
apply to that type of field. For example, if you pick a Boolean field, you can select options such as 
"on any change," "on change to yes," "on change to no," and so on.

Summary 
Fields

This list displays the fields that you have selected as summarized field headings for your cross-
tab. If you have multiple summarized field headings, they will appear on your report in the order 
they appear on this list.

To add a summarized field heading to this list, select a field from the Available Fields list, then 
drag it onto the list, or click the > arrow adjacent to the Summary Fields list.

If you add your summary field, the adjacent list becomes available with summary options. 
Choose the kind of summary you'd like to apply to the field.

Related Information

Cross-Tab Objects [page 634]

1.7.3.2.1.11  Grid Style Screen (Cross-Tab Report Creation 
Wizard)

Use the Grid Style screen to choose a predefined style for your cross-tab.
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Available Styles This box displays the formatting styles available for use with your cross-tab. Select the desired 
style from the list.

Sample Preview This box displays a sample of the style selected in the Available Styles list.

Related Information

Absolute Formatting [page 609]
Conditional Formatting [page 610]
Formatting Report Sections [page 539]

1.7.3.2.1.12  Label Screen (Mailing Labels Report Creation 
Wizard)

Use the Label screen to set up mailing label options. The Label screen lets you to print data on virtually any labels 
that are commercially available for line printers (dot matrix) or page printers (laser, ink jet). Use the settings and 
formatting commands to fine-tune your printing so the labels come out just the way you want them.

Mailing 
Label Type

You can define your own label type by selecting User-Defined Label from this list. However, to make 
your work easier, the program comes with preset templates for many other label types. Those 
labels are listed in the Mailing Label Type list.

When you choose a preset label template, the program automatically sets up the specifications for 
that label.

Label Size These edit boxes enable you to specify the dimensions (height and width) of one label. This 
information can usually be found on the box or folder the labels come in. Simply enter the height 
and width values in the respective edit boxes.

The unit of measurement used in the dialog box (inches or centimeters) is based on settings in the 
Regional Options of the Windows Control Panel.

Gap 
Between 
Labels

These edit boxes enable you to specify the empty area (gap, gutter, and so on) between labels. 
Simply measure the gaps and then enter the horizontal and vertical values in the respective edit 
boxes.

Horizontal The gaps between labels going across the page. One-up (one across) labels don't 
have any horizontal gaps.

Vertical The gaps between labels going down the page.

Note
The unit of measurement used in the dialog box (inches or centimeters) is based 
on settings in the Regional Options of the Windows Control Panel.
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Page 
Margins

These edit boxes enable you to set the top, bottom, left, and right margins of your page. Simply 
measure the margins and enter the values in the respective edit boxes.

Note
● All margins are figured from the edge of the paper. For example, a setting of .5 inches sets a 

half-inch margin.
● You cannot use page margin settings to set the paper size; you must set the paper size via 

the Paper Size list in the Print Setup dialog box.
● The unit of measurement used in the dialog box (inches or centimeters) is based on settings 

in the Regional Options of the Windows Control Panel.

Printing 
Direction

The Printing Direction section enables you to specify the path that the program follows when 
printing the data on your labels.

Across then Down Prints data left to right across the first row of labels, then across the second 
row, and so on.

Down then Across Prints data down the first column of labels, then down the second column, 
and so on.

Number of 
Labels

This information box displays the maximum number of labels that can print across the page and 
the maximum number that can print down the page based on your settings in the Page Margins, 
Mailing Label Size, and Gap Between Labels edit boxes and paper size (which is set up in Windows 
Control Panel).

Note
● The program displays only the number of complete labels it can print. For example, if it 

determines that there is space available to print 2.75 labels across the page, it displays 2 as 
the Across Page setting and prints only two labels across the page.

● If you want to print fewer labels across than the number calculated (fewer columns), 
increase the size of the right margin, left margin, or horizontal gap until the calculation 
changes to the number across that you want.

Related Information

Report Creation Wizards [page 812]

1.7.3.2.2 Chart Color Format Expert Dialog Box

The Chart Color Format Expert appears when you click the Format button in the "Chart color" area of the Options 
Tab (Chart Expert) [page 827]. The expert lets you conditionally apply color based on chart value fields. You 
apply a color to the selected item by specifying a condition.
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The dialog box is divided into two areas: the Item list area displays the formula conditions; the Item editor area lets 
you create the formula conditions.

Note
● If your chart type is line, the chart must have data markers before you can see conditional formatting.
● An area chart must have two "On change of" values for conditional formatting to appear.
● After you apply conditional formatting, you must select "Color by Group" on the Look tab of the Chart 

Options dialog box before you will be able to see your formatting. To set this option, right-click your chart, 
point to Chart Options on the shortcut menu, and select General from the submenu. This note applies to 
line, 3-D Riser, and 3-D Surface charts with one "On change of" field, as well as to bar, numeric axis, 3-D 
Surface, radar, stock, and gauge charts with two summaries.

Item list The Item list displays the chart color formula conditions created for the currently selected field.

Priority Use the Priority buttons in the Item list of the Chart Color Format Expert to set the priorities for 
your formulas.

New Click the New button to create a new formula with the default settings.

Remove Use the Remove button to discard unwanted Chart Color Format formulas for the currently 
selected field.

Value of Use this list to select the field upon which the condition is based. That is, choose a field for X in 
the following phrase: "If the value of field X meets condition A, then apply the selected color."

Comparison list From this second list, select the comparison for your conditional formula. This comparative 
phrase works as the operator in your conditional formula.

Field values Use this box to enter the value to which you want to apply color formatting. For example, to 
apply the color red when the value is equal to $25,000, type 25,000 in this box.

If the field selected in the "Value of" list is nonnumeric, then you can select from a list of 
available values.

Format color Use this list to select a color for the field value to which you want to apply conditional color 
formatting.

Related Information

Inserting Charts [page 622]
Chart Layouts [page 624]

1.7.3.2.3 Chart Expert

Use the Chart Expert to prepare graphs for use in a report. When the Chart Expert appears, the Type tab is active.
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1.7.3.2.3.1  Type Tab (Chart Expert)

The Type tab offers a choice of fifteen different chart types to insert in a report. Click the button of the type of 
chart you want, and the program begins the construction of a chart of that type which you can further customize.

Automatically set 
chart options

Select this check box to have the Chart Expert use the default options on the Axes and 
Options tabs. If you want to customize some of the chart's properties — such as the scaling 
of the axes, the legend, and the data points — ensure that this check box is not selected.

The following settings have default values when "Automatically set chart options" is 
selected:

● Data values
● Number of divisions
● Data points
● Customize settings
● Legend

Chart Type Use the Chart Type list to select the chart type you want to use. Once a chart type is 
selected, you can use the buttons to the right of the list to select the chart type format to use 
for the chart.

Vertical/
Horizontal

Use the Vertical and Horizontal option buttons to specify whether the chart is to represent 
increasing values in a vertical or a horizontal direction.

These options are only available for the Bar, Line, and Area chart types.

Related Information

Chart Types [page 624]
Chart Layouts [page 624]

1.7.3.2.3.2  Data Tab (Chart Expert)

Placement

In the Placement section, you determine where you would like your chart to be placed on the report, as well as 
how often the chart will appear on the report.

Place chart Use this list to choose the report section where your chart will appear. Your chart can appear either 
once per report or once per group (the group section containing the summary field that the chart is 
based upon).
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Note
Your choice of where to put the chart will affect how the data in the chart can be subdivided.

Header/
Footer

Use the Header/Footer option buttons to display a chart in either the Group Header or Group 
Footer section of a report. If the chart appears once per report, the Header/Footer choice will 
place it in either the Report Header section or the Report Footer section of the report.

Layout

In the Layout section, you determine the actual layout of the chart, depending on the data you wish to chart. There 
are four options:

● Advanced option view
● Group option view
● Cross-Tab option view
● OLAP option view

Advanced Option View

Available 
fields

This list displays all of the fields available for use in your chart.

Click the Add (>) button to add the selected field(s) from the Available Fields list to the On 
change of list. Click the Remove (<) button to remove the selected field(s) from the On change 
of list.

Browse Click this button to browse the values for the field that is selected in the Available fields list.

On change of Use the options in the "On change of" list to determined what values you want to see in your 
chart:

● Choose "On change of" to see values summarized by the field you choose for the area below 
the list.
For example, if you choose "Country," you'll see summarized values for each country.

● Choose "For each record" to see values for each record in your report.

Note
For this option, you don't choose a field for the area below the list.

● Choose "All records" to see a summarized value that is a grand total for all the records in 
your report.

Note
For this option, you don't choose a field for the area below the list.
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If it's necessary to choose a field for the area below the "On change of" list, use the arrow 
buttons to add or remove the field(s) selected in the Available fields list.

Order Click the Order button to change the sort order for the selected field. When you click this button, 
the Chart Sort Order Dialog Box [page 725] appears.

This button is only active when a single field in the "On change of" list is selected.

TopN Click the TopN button to sort the selected field by Top N, Bottom N, or Sort All. When you click 
this button, the Top N/Sort Group Expert appears.

This button is only active when a single field in the "On change of" list is selected.

Show Value(s) This list displays the field chosen as a value for your graph or chart. Points will be plotted for 
these values on the chart whenever the condition selected in the "On Change of" list changes. 
For example, if you create a graph of last year's sales for all your customers, you will select the 
Customer Name field as the condition and the Last Year's Sales field as the value. Whenever the 
Customer Name changes a point will be plotted according to the value of their last year's sales.

Use the arrow buttons to add or remove the field(s) selected in the Show value(s) list. Click the 
double-arrow button to remove all the fields from the Show value(s) list.

Don't 
Summarize 
Values

Use the Don't summarize values check box to determine if the program should automatically 
summarize the values that will appear on the chart.

Note
This option is available only for formula fields.

● If you select this check box, the program will not summarize the values.
● If you clear this check box, the program will summarize the map values, and the Set 

Summary Operation button will activate. The program adds a summary field to the Map 
Values list.

Set Summary 
Operation

Use this button to set or change the summary operation for the selected field. When you click 
this button, the Edit Summary Dialog Box [page 756] appears. This button is only active when 
you have cleared the Don't summarize values check box, and when you have selected a field in 
the Map Values list.

Group Option View

On change of Select the field you want to use as a condition for plotting values in a graph or chart. Points will be 
plotted whenever the value in the condition field changes.

Show Use this list to select the summary field whose values you want to display in your graph. Use the 
Insert Summary dialog box to create a summary field.
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Cross-Tab Option View

On change of Select the field you want to use as a condition for plotting values in a graph or chart. Points will 
be plotted whenever the value in the condition field changes.

Subdivided by Use this list to choose the secondary row or column to base your chart on. Clicking this box 
displays a list of the row/columns fields in your report that you can choose from.

Show Use this list to select the summary field whose values you want to display in your graph.

OLAP Option View

The OLAP layout enables you to chart on an OLAP grid.

Note
OLAP grid objects are not supported in this version of SAP Crystal Reports. The OLAP Option View is disabled.

Related Information

Selecting Top or Bottom N Groups [page 587]

1.7.3.2.3.3  Axes Tab (Chart Expert)

The Axes tab lets you set the properties for each of the chart axes. The Axes tab changes depending upon the 
type of chart you are creating.

If you want the Chart Expert to use the default options on the Axes and Options tabs, select "Automatically set 
chart options" on the Type tab.

Show Gridlines

Use gridlines to add lines to your chart. For example, with a bar chart, you can add horizontal lines for each 
vertical axis value.

Major Use the Major check boxes to determine whether major guidelines will be shown for the chart axes. 
Depending on the type of chart you are creating, there may be a Major check box for the Group, Series, 
Data, and/or Data2 axes.

● Select a Major check box to show the guideline for the corresponding axis.

SAP Crystal Reports for Visual Studio .NET SDK Developer Guide
SAP Crystal Reports .NET SDK Developer Guide C U S T O M E R 825



● Clear a Major check box to hide the guideline for the corresponding axis.

Minor Use the Minor check boxes to determine whether minor guidelines will be shown for the chart axes. 
Depending on the type of chart you are creating, there may be a Minor check box for the Group, Series, 
Data, and/or Data2 axes.

● Select a Minor check box to show the guideline for the corresponding axis.
● Clear a Minor check box to hide the guideline for the corresponding axis.

Data Values

Auto scale When you select the Auto Scale check box, the number of labels is adjusted to ensure a clear 
display along the Data axis.

Auto range When you select the Auto Range check box, the data values for the corresponding axis are assigned 
a default range.

Min Use the Min text box to enter the range minimum for the data values on the corresponding Data 
axis. There is a Min text box for the Data axis, and there may also be a Min text box for the Data2 
axis. The second Min text box is only active if the chart is a cross-tab or OLAP chart.

If the corresponding Auto Range check box is selected, the Min text box is inactive.

Note
OLAP grid objects are not supported in this version of SAP Crystal Reports.

Max Use the Max text box to enter the range maximum for the data values on the corresponding Data 
axis. There is a Max text box for the Data axis, and there may also be a Max text box for the Data2 
axis. The second Max text box is only active if the chart is a cross-tab or OLAP chart.

If the corresponding Auto Range check box is selected, the Max text box is inactive.

Number 
format

Use the Number Format list to select a number format for the data values on the corresponding 
Data axis. There is a Number Format list for the Data axis (y), and there may also be a list for the 
Data2 axis. The second Number Format list is only active if the chart is a cross-tab or OLAP chart.

If the corresponding Auto Range check box is selected, the Number Format list is inactive.

Number of Divisions

Automatic If you select the Automatic option, the program automatically sets the number of divisions for the 
corresponding Data axis. There is an Automatic option for the Data axis, and there may also be an 
Automatic option for the Data2 axis. The second Automatic option is only active if the chart is a 
cross-tab or OLAP chart.
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Note
OLAP grid objects are not supported in this version of SAP Crystal Reports.

Manual Use the Manual option to manually set the number of divisions for the corresponding Data axis. 
There is a Manual option for the Data axis, and there may also be a Manual option for the Data2 axis. 
The second Manual option is only active if the chart is a cross-tab or OLAP chart.

When you click the Manual option button, the adjacent text box becomes active. Use the text box to 
enter the number of divisions.

Related Information

Text Tab (Chart Expert) [page 828]

1.7.3.2.3.4  Options Tab (Chart Expert)

The Options tab offers choices for displaying a chart.

If you want the Chart Expert to use the default options on the Axes and Options tabs, be sure to select 
"Automatically set chart options" on the Type tab.

Chart color

Use the Chart Color option buttons to specify whether the chart will be Color or Black and White.

Data points

Use the Data Points option buttons to specify the type of label that will appear for each data item (that is, for each 
chart value). You can click None, Show Label, or Show Value. If you click Show Value, the Number Format list 
becomes active. Use the Number Format list to select a format for your chart values.

Customize settings

Transparent 
Background

When this check box is selected, the chart background will become transparent so 
objects positioned behind it are visible.
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Marker Size Use this list to specify the marker size for the chart value markers on a Line Chart.

Marker Shape Use this list to specify the marker shape for the chart value markers on a Line Chart.

Viewing Angle Use this list to specify the angle from which the chart is viewed (Standard Angle, From 
The Top, and so on).

Pie size Use this list to select the pie size for a Pie Chart (Minimum, Small, Average, Large, or 
Maximum).

Bar size Use this list to select a bar size for a Bar Chart (Minimum, Small, Average, Large, or 
Maximum).

Detach pie slice When this check box is selected, a pie slice is detached from the pie chart. You can click 
Smallest slice or Largest slice to specify which pie slice to pull out.

Legend

Show Legend When this check box is selected, the Legend is displayed for your chart/graph. When the check 
mark is not visible, the option is not selected, and no legend will be displayed for your chart. By 
default, the option is selected.

Placement Use the Placement list to specify where you want the chart legend to appear (upper right corner 
of the chart, to the left, to the right, and so on).

This list is only active when the Show Legend check box is selected.

Layout Use this list to display percentage values, actual values, actual and percentage values or no 
values.

Related Information

Chart Options Dialog Box [page 714]

1.7.3.2.3.5  Text Tab (Chart Expert)

The Text tab lets you specify titles, footnotes and axis titles for a chart.

Titles

Auto-Text When these check boxes are selected, chart titles are generated automatically. If they are cleared 
you can specify titles for the chart manually.
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Title Use this text box to enter a title for the chart. The title will appear just above the chart.

Subtitle Use this text box to enter a subtitle for the chart. The subtitle will appear just below the title, above 
the chart.

Footnote Use this text box to enter text for a footnote. The footnote will appear just below the chart on your 
report.

Group title Use this text box to enter a title for the chart's x axis.

Data title Use this text box to enter a title for the chart's y axis.

Data2 title Use this text box to enter a title for the chart's second y axis (if you are creating a cross-tab or OLAP 
chart).

Series title Use this text box to enter a title for the chart series.

Format

Use this list to select the text for which you are setting the font options.

Font Click the Font button to set the font options for the set of text selected in the Format list. When you click 
this button, the Font dialog box appears.

Related Information

Font Dialog Box [page 762]
Chart Types [page 624]

1.7.3.2.4 Cross-Tab Expert Dialog Box

Use the Cross-Tab Expert to create a cross-tab quickly and easily. Cross-tabs are used in reports to present 
summarized data in a row/column structure, similar to that of a spreadsheet. These reports are easy to read, and 
they are particularly useful for making rapid comparisons and identifying trends.

This dialog box appears when you right-click in the report, point to Insert and click Cross-Tab.

Related Information

Crystal Report Creation Wizards [page 542]
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1.7.3.2.4.1  Cross-Tab Tab (Cross-Tab Expert)

The Cross-Tab tab contains the basic functionality you need to create a cross-tab. You can define rows, columns, 
and summarized fields. As well, you can create groups and formulas directly from this tab.

Available Fields This list displays all the tables and fields that you have activated for use in the report.

Select the field you want to use and drag it into the appropriate list, or click the appropriate 
Add button. Repeat this process to add additional fields.

Browse Data Click the Browse Data button to view the values for a field you have selected in the Available 
Fields list.

Find Field Click this button to enter the name of a field you'd like to locate in the Available Fields list.

New Formula When you click this button, the Formula Name dialog box appears. Enter a name for your new 
formula and then click OK. The Formula Workshop dialog box appears with the Formula 
Editor active so you can create the new formula.

Edit Formula When you click this button, the Formula Workshop dialog box appears with the Formula 
Editor active. Use the editor to edit the selected formula. Edit Formula is available only when 
a formula field is selected in one of the lists.

Columns This list displays the fields that you have selected as column headings for your cross-tab. If 
you have multiple column headings, they will appear on your report in the order in which they 
appear on this list.

To add a column heading to this list, select a field from the Available Fields list and then drag 
it onto the list, or click the Add Column button.

Rows This list displays the fields that you have selected as row headings for your cross-tab. If you 
have multiple row headings, they will appear on your report in the order they appear on this 
list.

To add a row heading to this list, select a field from the Available Fields list and then drag it 
onto the list, or click the Add Row button.

Summarized 
Fields

This list displays the fields that you have selected as summarized field headings for your 
cross-tab. If you have multiple summarized field headings, they will appear on your report in 
the order they appear on this list.

To add a summarized field heading to this list, select a field from the Available Fields list, then 
drag it onto the list, or click the Add Summarized Field button.

Add or remove 
arrow buttons

Use the > arrows adjacent to each list to add fields from the Available Fields list. Use the < 
arrows to remove fields you've already added.

Group Options When you click this button, the Cross-Tab Group Options dialog box appears. Use this dialog 
box to enter a group for your cross-tab. Group Options is available only for rows and 
columns.

Change 
Summary

When you click this button, the Edit Summary dialog box appears. Use this dialog box to 
change the summary type of the cross-tab's summarized fields. Change Summary is 
available only for summarized fields.
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Related Information

Cross-Tab Group Options Dialog Box [page 735]
Formula Editor Dialog Box [page 599]
Edit Summary Dialog Box [page 756]
Crystal Report Creation Wizards [page 542]

1.7.3.2.4.2  Style Tab (Cross-Tab Expert)

The Style tab allows you to choose a pre-defined style for your cross-tab's grid. An example of each style appears 
on the right side of the screen as you highlight its name.

Note
The color of the style you select may not appear correctly if your screen resolution is set to 256 colors. Increase 
the resolution to correct this.

If you select any of the pre-defined grid styles, the settings for it appear on the Customize Style tab. You can 
create a custom style based on any of the pre-defined styles by choosing it and modifying the settings on the 
Customize Style tab. Once you have created a custom style, a new option, called Custom, is added to the list on 
the Style tab.

1.7.3.2.4.3  Customize Style Tab (Cross-Tab Expert)

Use the Customize Style tab to format your cross-tab's grid with background color, gridlines, and cell margins.

Columns This list displays the columns you selected for your cross-tab. Select the field for which you 
want to customize the style.

Rows This list displays the rows you selected for your cross-tab. Select the field for which you want 
to customize the style.

Summarized 
Fields

Use the options in this area to determine how multiple summarized fields are to be displayed.

Vertical Choose this option to display multiple summarized fields in a vertical list:

● Summary 1
● Summary 2
● Summary 3

Horizontal Choose this option to display multiple summarized fields in a horizontal list:

Summary 1 -- Summary 2 -- Summary 3

Show Labels Choose this option to display the names of multiple summarized fields. Labels can be 
displayed for both vertical and horizontal summaries.
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Group Options

Suppress Subtotal Use this check box to suppress the subtotal for a selected field. You must first have a field 
selected in either the Rows list or the Columns list.

Suppress Label Use this check box to suppress the label of a suppressed subtotal field. This check box is 
inactive if the Suppress Subtotal check box is not selected.

Alias for Formulas Enter an alias name for the selected row or column field. Creating an alias shortens long field 
names, which is useful later when you refer to a field in a conditional formatting formula. The 
field's original name is shown in this box by default.

Background Color Use this list to select a color for the selected row or column field.

Grid Options

Show Cell Margins Select this check box to have the program automatically format the cells of the cross-tab. 
When this check box is not selected, any extra space (white space) within the cells of the 
cross-tab will be eliminated and the contents of the cells will be adjusted to utilize the least 
amount of space in your report as possible.

Indent Row Labels Select this check box to indent row labels on your cross-tab. Use the inches box to specify 
the size of the indent you want to see.

Format Grid Lines When you click this button, the Format Grid Lines dialog box appears. In this dialog box, you 
can define whether the grid lines are shown or not, as well as the color, style, and width 
you'd like the grid lines to have.

Repeat Row Labels Select this check box to have the program repeat row labels on every page for cross-tabs 
that print across more than one page.

Keep Columns 
Together

Select this check box to have the program keep columns together on every page for cross-
tabs that print across more than one page.

Column Totals on 
Top

Select this check box if you want column totals to appear at the top of the cross-tab rather 
than at the bottom (the default position).

Row Totals on Left Select this check box if you want row dimensions to appear on the left of the cross-tab 
rather than on the right (the default position).

Suppress Empty 
Rows

Select this check box to have the program remove empty rows from the cross-tab. When 
this check box is selected, any rows whose fields do not contain any records will be hidden.

Suppress Empty 
Columns

Select this check box to have the program remove empty columns from the cross-tab. 
When this check box is selected, any columns whose fields do not contain any records will 
be hidden.

Suppress Row 
Grand Totals

Select this check box to have the program remove the grand total from rows in the cross-
tab.

Suppress Column 
Grand Totals

Select this check box to have the program remove the grand total from columns in the 
cross-tab.
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Related Information

Format Grid Lines Dialog Box [page 773]

1.7.3.2.5 Database Expert Dialog Box

The Database Expert provides an integrated tree view of all the data sources you can use with SAP Crystal 
Reports. This dialog box appears when you right-click Database Fields in the Field Explorer and select Database 
Expert. You can also right-click in the Report Designer, point to Database, and click Database Expert, or click the 
Database Expert button the the toolbar in the embedded designer.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

With the Database Expert, you can:

● create a report using one of the currently connected data sources
● create a report based on a customized "Favorites" list of data sources (which you also maintain within the 

Database Expert)
● create a report based on a list of recently accessed data sources (that the Database Expert automatically 

maintains for you)
● create a report by connecting to an existing data source (for example, a data file residing locally, or an ODBC 

data source that has already been set up)
● create a report by first creating a new connection (for example, a new ODBC data source, or an OLE DB File 

Data Link)
● view information about a database connection by right-clicking its icon and selecting Properties from the 

shortcut menu.

The Database Expert contains the following tabs:

Data Tab Use the Data tab to select the data source and tables you want to use in your report.

Links Tab Use the Links tab to link two or more tables together.

Related Information

Accessing and Adding Data [page 549]
Reporting off ADO.NET Datasets [page 550]

1.7.3.2.5.1  Data Tab (Database Expert)

The Data tab provides an integrated tree view of all the data sources you can use with SAP Crystal Reports. Use 
the Data Tab to select the data source and tables you want to use in your report.
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If the database you are using supports a query language such as SQL, you can write your own command which will 
be represented in SAP Crystal Reports as a Table object. See Defining Virtual Tables Based on a Command/SQL 
Query [page 552].

Available Data Sources

This window of the Database Expert shows a tree view of possible data sources you can select when creating a 
report. The tree is made up of folders for:

Project Data Shows a list of the data sources you are currently connected to, as well as ADO.NET data 
sources added to your current project.

Current 
Connections

Shows a list of data sources you are currently connected to.

Favorites Shows a list of data sources you commonly use and have maintained in your Favorites list.

History Shows a list of data sources you have used recently. The last five data sources used are 
usually displayed.

Create New 
Connection

Shows subfolders for various data sources you can connect to. Some popular choices are 
described here:

● Access/Excel (DAO) lets you connect to a supported database type (Access, dBASE, 
Excel, Lotus, and so on). You can create a new connection using the Make New 
Connection option.

● Database Files shows a list of standard PC databases that reside locally.

Tip
To customize the default extensions in the Files of type list in the Open dialog box, add 
the extensions in the Database File Filter field in the Data Source Defaults Tab (Default 
Settings) [page 750].

● ODBC (RDO) shows a list of ODBC data sources you have already configured for use.
● OLE DB (ADO) shows a list of OLE DB providers you have already configured for use. You 

can also specify a Microsoft Data Link file to use.
● More Data Sources shows a list of other data sources that can be accessed through 

native drivers, such as Field Definitions.
Field Definitions are special drivers used to create reports based on only a schema 
without actual data. This driver is included mainly for backward compatibility and is only 
used during the report creation process. At runtime, a report created with it must be 
passed a recordset or dataset.

Note
The data source options available in the Create New Connections folder depend on the data access 
components selected during installation.
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Selected Tables

This list shows the tables you've selected for your report. If more than one table has been added, the Links Tab 
(Database Expert) [page 836] is added to the expert.

Use the arrows to add or remove tables from this list.

Tip
To edit the alias for a table, select the table and press F2.

Buttons and Shortcut Menus

Buttons and shortcut menus are available in the Database Expert. You can right-click any item in the Database 
Expert to see a shortcut menu with the following options:

Add to Report Use this option to add a database object (for example, a table or stored procedure) to 
your report. This option is also available by clicking the right arrow on the Database 
Expert.

Add to Favorites Use this option to add a selected data source to the Favorites folder.

Add Command to 
Report

Use this option to add a new SQL query to your report. After you define your query in the 
Add Command to Report dialog box, it appears in the Selected Tables list.

Make New 
Connection

Use this option to make a new connection to a database file or other data source.

Remove from Report Use this option to remove a database object (for example, a table or stored procedure) 
from your report.

Properties Use this option to obtain detailed information on the selected database connection.

Rename Favorite Use this option to rename a data source in the Favorites folder.

Delete Favorite Use this option to remove a data source from the Favorites folder.

Options Use this option to set the global options that appear on the Database tab of the Default 
Settings dialog box.

Refresh Use this option to refresh the list of available data sources in the Database Expert.

Add (>) Adds the selected database object to the report.

Add all (>>) Adds all the database objects to the report.

Delete (<) Removes the selected database object from the report.

Delete all (<<) Removes all database objects from the report.

Note
To add or change an alias for a database object, click the database object to edit it. If 
you want to add an additional alias to the database object, add the database object 
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again to the selected table. When you create an alias you do not change the location of 
the database. If you want to change the location of a database, see To change the data 
source location [page 552]. Changes you make via this dialog box do not affect the 
aliases already used in formulas.

Related Information

Accessing and Adding Data [page 549]
Reporting off ADO.NET Datasets [page 550]

1.7.3.2.5.2  Links Tab (Database Expert)

Use the Links tab to link two or more database tables together. When you choose more than one table on the Data 
Tab, the Links tab appears.

You link tables so records from one table will match related records from another. The easiest way to link tables is 
to select Auto-Link. Auto-Linking automatically chooses links for your tables based on common fields in tables, or 
foreign key relationships between tables (if your database supports foreign keys). You can also manually link 
database tables.

Links display 
area

The display area shows all the tables currently in your report along with links and indexes.

A key to the index indicators is displayed when you click the Index Legend button.

Click and drag one field to another to manually link the tables. There are no limitations to your 
linking structure, provided they are within the limitations defined by the database vendor.

Auto-Arrange When you click this button, the program arranges the tables to fit in the most efficient manner 
inside the Links display area.

Auto-Link Click By Name to link tables by their names or By Key to use foreign key information.

Link Click Link to link tables automatically. Clicking this button automatically chooses links for your 
tables based on common fields in tables or foreign key relationships among the tables (if your 
data supports foreign keys).

Order Links If you have multiple links, you can use the Order Links function to arrange the links in the order 
you would like them to be processed. Different link orders may result in different queries.

Clear Links Click this button to clear all the current table links.

Delete Link Click a link then click this button to remove it.

Link Options To activate this button, you must have a link line selected. Once you have a link selected, click 
this button to open the Link Options dialog box where you can choose the join type and link 
type.

Index Legend Click this button to open the Index Legend dialog box so you can see a key to the index 
indicators used in the Links display area.
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Related Information

Order Links Dialog Box [page 791]
Link Options Dialog Box [page 788]
Database Expert Dialog Box [page 833]
Index Legend Dialog Box [page 781]

1.7.3.2.6 Formula Expert

Use the Formula Expert to create a Formula based on an existing custom function. The expert appears when you 
click Use Expert in the Formula Name dialog box, or when you select a simple formula in the Formula Workshop 
without selecting the Toggle Properties Display button.

The Formula Expert also appears when you edit an empty formula field or a formula field that makes a simple call 
to a custom function.

Custom 
Function 
Supplying 
Logic

This list includes all the custom functions available in your report (Report Custom Functions). 
Select a custom function to base your new formula on.

When you select a custom function, the Summary, Return Type, and Function Arguments areas 
are filled in based on the function's definition.

Summary This area contains the summary that has been defined for the custom function in the Custom 
Function Properties dialog box. The summary information is only for reference and cannot be 
modified.

Return Type This area contains the data type that the selected custom function will return. The return type 
information is only for reference and cannot be modified.

Reset Values Click this button to reset values you've entered in the Value fields of the Function Arguments 
area. If an argument has a set of default values, the value is reset to the first default value. If an 
argument has no default values assigned, the value is reset to "Select Field or Enter Value" (that 
is, the value is unbound). If an argument is optional, it is set to "Use Optional Value:" followed by 
the current value of the optional value defined in the custom function.

More Info Click this button to see more information about the selected custom function.

Function 
Arguments

This area contains the arguments defined for the custom function. Most of the argument 
information is only for reference and cannot be modified.

However, the Value field is where you specify the argument value for the formula you are 
creating. You can enter a value directly, or you can click the Value field and select from the list 
that appears. You can choose from possible values (the choices you see are specific to the 
argument's data type):

● A set of default values created in the Custom Function Properties dialog box. You can save 
the formula without selecting a value; the first default value from the set is used.

● An optional value as specified in the custom function. This choice appears as the text "Use 
Option Value" followed by the current value of the optional value defined in the custom 
function. You can save the formula without selecting a value; the optional value is used.
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● A field of the type that matches the selected argument's type (that is, if the argument's type 
is string, you can pick a string field). The field must be used in the current report for it to 
appear in this list.

● True or False for arguments with a Boolean data type.
● A formula field or SQL Expression whose return type matches the selected argument's 

type. The formula or expression must exist in the Formula Workshop dialog box, but does 
not have to be used in the report for it to appear in this list.

● A running total whose summary field's type matches the selected argument's type. The 
running total must exist in the Field Explorer, but does not have to be used in the report for 
it to appear in this list.

● A parameter field whose value type matches the selected argument's type. The parameter 
must exist in the Field Explorer, but does not have to be used in the report for it to appear in 
this list.

● A group name. The group must exist in the current report for it to appear in this list.
● A constant value. For some types, such as string or number, you can enter a simple 

constant value directly. For others that require specific formatting, such as date, date and 
time, and so on, a version of the Enter Value for dialog box appears so you can choose a 
value or range.

● Another field. Click Choose Other Field to see the Choose Field dialog box, which displays 
only the report and database fields of the type that matches the selected argument's type.

Related Information

Custom Functions [page 601]
Formula Editor Dialog Box [page 774]

1.7.3.2.7 Group Expert Dialog Box

Use the Group Expert to specify how fields will be grouped on your report. You can also use the dialog box to 
reposition groups and to edit the criteria used for triggering and sorting groups. This dialog box appears when you 
right-click a Group Header in the Report Designer or Group Name in the Field Explorer and select Group Expert, or 
when you right-click in the Report Designer, point to Report and choose Group Expert.

Tip
To display the Field Explorer, click the Crystal Reports menu, click Field Explorer.

Available Fields This list displays all of the fields available for use in grouping. The list is based on the report 
fields you chose in the Field Explorer and the tables you selected on the Data tab of the 
Database Expert.

Browse Data Click this button to browse the data of the field that is selected in the Available Fields list.

Find Field Click this button to enter the name of a field you'd like to locate in the Available Fields list.
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Add or remove 
arrow buttons

Use the > arrow adjacent to the Group By list to add fields from the Available Fields list. Use the 
< arrows to remove fields you've already added. Double arrows add or remove all fields.

Group By This list displays all of the fields you've selected for grouping. As you add fields, they are added 
in a hierarchy. This hierarchy establishes the order the groups will appear in the report.

When you enter a group, that group appears directly above and below the Details section. 
When you add a second group, it appears between the Details section and the first group. The 
third group is between the Details section and the second group, and so on. Thus, when you 
look at the Report Designer, the Group Header for the first group is the top group header, and 
the Group Footer for the first group is the bottom group footer.

This Group By list reflects the group footer order of groups; the bottom group in the list is the 
first group, the group next to the bottom is the second group, and so forth.

When you select a group in this list, the program activates those buttons that apply to the 
selected group.

Up or down 
arrow buttons

Use the up and down arrows adjacent to the Group By list to change the order of fields you've 
added from the Available Fields list.

Options When you click this button the Change Group Options dialog box appears. Use this dialog box 
to edit the criteria used for triggering and sorting groups.

Related Information

Change Group Options Dialog Box [page 713]

1.7.3.2.8 Group Sort Expert Dialog Box

Use the Group Sort Expert to identify top or bottom groups (the states with the most/fewest customers in a 
customer report, for example). You can also identify top or bottom percentages.

This dialog box appears when you right-click the Report Designer, point to Report, and click Group Sort Expert.

Note
A report must contain a summary value in order to be able to perform a Group Sort. See Summarizing Grouped 
Data [page 585].

For this group sort Use this list to choose one of the following sorting options for your group:

● No Sort
● All
● Top N
● Bottom N
● Top Percentage
● Bottom Percentage
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Depending on which option you choose, the expert displays different options.

based on This list displays a list of summary fields in your report. Select the field you want to select 
top or bottom values or percentages for from this list. When All is selected, use the scroll 
box beneath the "based on" list to see the fields chosen for sorting.

Where N is Enter the number of top or bottom values (where N is the number of values) you want to 
select into this edit box.

Where Percentage 
is

Enter the percentage of top or bottom values you want to select into this edit box.

Include Others, with 
the name

Select this option if you want to include all fields that do not fit into your top or bottom 
selection under a specified group name. Enter the group name you want all fields that do 
not fit into your selection to appear under.

Include ties Select this option to accommodate groups whose summarized values are equal.

Related Information

Grouping, Sorting, and Totaling Data [page 582]
Selecting Top or Bottom N Groups [page 587]

1.7.3.2.9 Highlighting Expert Dialog Box

The Highlighting Expert enables you to apply conditional formatting to all types of report fields (Number, 
Currency, String, Boolean, Date, Time, and DateTime fields). With the expert, you format the selected field either 
by specifying a condition based on that field's value, or by specifying a condition based on the value of a different 
report field. In other words, the expert enables you create the following formula: If the value of field X meets 
condition A, then apply the specified formatting to the field selected on the report.

This dialog box appears when you right-click a currency or number field object and select Highlighting Expert from 
the shortcut menu.

Item list

The Item list displays the highlighting formulas created for the currently selected field.

Priority Use the Priority buttons in the Item List of the Highlighting Expert to set the priorities for your 
formulas.

New Use the New button to add a new highlighting formula. After you click New, specify the formula's 
values in the Item editor.

Remove Use the Remove button to discard unwanted highlighting formulas for the currently selected field.
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Item Editor

The Item editor allows you to set the formula. The Item editor includes a Sample view to demonstrate the 
formatting specifications applied.

Value of Use the first drop-down list to choose the field the highlighting rule should apply to.

Use the second drop-down list to specify the condition. The default is "is equal to".

Use the third drop-down list to enter the currency value or numeric value to which you want to 
apply highlighting conditions.

Font style Use this list to select a font style for the number or currency value to which you want to apply a 
highlighting condition.

Font color Use this list to select a font color for the number or currency value to which you want to apply a 
highlighting condition.

Background Use this list to select a background color for the number or currency value to which you want to 
apply a highlighting condition.

Border Use this list to select a border style for the number or currency value to which you want to apply a 
highlighting condition.

Sample Shows a sample using the settings selected in the Highlighting Expert.

Related Information

Conditional Formatting [page 610]
Format Editor Dialog Box [page 762]

1.7.3.2.10  Section Expert

Use the Section Expert to make formatting changes that affect entire sections of your report. This dialog box 
appears when you right-click in the Report Designer, and select Section Expert, or when you right-click in the 
Report Designer, point to Insert and click Section.

Tip
In SAP Crystal Report 2008 you can access the Section Expert by clicking the Section Expert button in the 
embedded designer.

Sections This box lists all of the sections in the active report. When you highlight a section in this list, the 
program sets the dialog box buttons to indicate the actions you can take and the properties you 
can set for the selected section.

Insert Use this button to insert a new report section immediately below and of the same type as the 
section you have selected in the Sections list.
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Delete Use this button to delete the section you have selected in the Sections list. You can only delete 
sections that have been added to the originating sections; you cannot delete any of the originating 
sections.

Merge Use this button to merge the current section with the companion section that appears 
immediately below it.

Note
You cannot merge sections of different types; for example, you cannot merge a Details section 
with a Group Header section.

Arrow 
buttons

Use these buttons to move a section up or down with respect to other related sections.

Note
You cannot move a section past a section of a different type

Related Information

Report Section Overview [page 534]
Formatting Report Sections [page 539]

1.7.3.2.10.1  Common Tab (Section Expert)

Use the Common tab to set properties such as: visible, new page before, keep together, etc. for a desired section.

Hide (Drill-
Down OK)

Select this check box if you do not want the section to print, but you want the section contents to 
be available for drill-down.

Suppress (No 
Drill-Down)

Select this check box if you do not want the section to print, and you do not want the section 
contents to be available for drill-down.

Print at 
Bottom of 
Page

This check box causes each group value to print only at the bottom of a page. (Details continue 
to print in their normal positions.) The command is useful for printing invoices and other reports 
where you want a single group (i.e., line items grouped by order number) to appear on a page 
and the value for that group (subtotal, summary field, etc.) to print only at the bottom of the 
page.

New Page 
Before

New Page Before is an available format property for Group (header and footer) and Details 
sections. When you select this option, the program inserts a page break before it prints the 
section. The page break thus comes before:

● the group (if using the option with a Group footer section), or
● each report record (if using the option with a Details section).
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The Page Header and Page Footer appear on each page. If you have a subtotal or summary field 
in a Group Footer section, you can use the New Page Before option to put these values on pages 
following the value being totaled.

New Page 
After

When this check box is selected, the program inserts a page break after it prints the section.

● The Page Header and Page Footer appear on each page.
● Use New Page After in the Group footer section to print each group on a separate page.

Reset Page 
Number After

Resets the page number to one (1) for the following page, after it prints a group total. When this 
option is used in conjunction with Print at Bottom of Page, the program prints a single group on a 
page, prints the group value at the bottom of the page, and resets the page number to 1 for the 
next page. This option is useful whenever you are printing multiple reports from a single file (i.e., 
invoices), and you want each report to be numbered beginning with Page 1.

Keep 
Together

When this check box is selected, the program keeps all the lines of the section together, either on 
the current page (if there is room) or on the next (if not).

In a customer list, for example, data on a single customer (from a single record or linked 
records) may extend over several lines. If the standard page break falls within the data for a 
customer, the data will be split, part on one page, part on the next. But with Keep Together, the 
program inserts the page break before the record begins so that all the data will be printed 
together, on the following page.

Note
This option does not work with multi-line string or memo fields. A page break may occur in the 
middle of a multi-line field.

Suppress 
Blank Section

When you select this check box, the program hides the report section if it is blank, and prints it if 
it is not.

Underlay 
Following 
Sections

Select this check box if you want the selected object to underlay the following section(s) when it 
prints.

Format with 
Multiple 
Columns

When you select this, the Layout tab appears.

Reserve 
Minimum 
Page Footer

This option enables you to minimize the space reserved for your Page Footer sections, thereby 
maximizing the space available for valuable report information on each page. This option only 
affects a Page Footer area with multiple sections.

By default, SAP Crystal Reports reserves space at the bottom of each page for your Page Footer 
sections. This space is reserved whether or not the Page Footer sections are conditionally 
suppressed. Normally, the space reserved is equivalent to the combined height of all Page 
Footer sections that are shown or conditionally suppressed.

You can, however, minimize the space reserved. To do so, first conditionally suppress individual 
Page Footers as desired. Then select Page Footer in the Sections area of the Section Expert, and 
select the Reserve Minimum Page Footer option on the Expert's Common tab. When you do this, 
SAP Crystal Reports will only reserve space on each page for the tallest of your Page Footer 
sections.
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Relative 
Positions

This option allows you to lock the relative position of a report object next to a grid object within a 
section. For example, if you place a text object one centimeter to the right of a cross-tab object, 
during report generation the program will push the text object to the right, so that the one 
centimeter space is maintained regardless of the width of the cross-tab object.

● Only horizontal locking is possible. If you need to preserve relative vertical positioning, you 
should create a new report section.

● Once Relative Positions is selected for a section, you can no longer drag objects to new 
positions within that section.

● Relative positioning applies only to objects placed to the right of grid objects (that is, objects 
that can grow horizontally).

Related Information

Report Section Overview [page 534]
Determining Printing Area Characteristics [page 549]
Report Processing Model [page 544]
Inserting Underlaying Images [page 640]
Layout Tab (Section Expert) [page 844]

1.7.3.2.10.2  Color Tab (Section Expert)

Use the Color tab to set the background color for the desired section.

Background Color To add a background color to the selected section, select this check box, then choose a 
color from the list.

Conditional Formula Click this button if you want to set up a conditional formatting formula for the 
corresponding property.

Related Information

Formula Editor Dialog Box [page 774]

1.7.3.2.10.3  Layout Tab (Section Expert)

The Layout tab appears when you have the details section selected and the Format with Multiple Columns box is 
checked on the Common tab.

Use the Layout tab to set up your report in a multi-column format. That is, instead of having the data print straight 
down the page, you can set up multiple columns and have the data flow from column to column. You can also have 
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your data print across then down the page, printing one record in each column, then printing a second record in 
each column, then a third, etc. The dialog box is divided into four smaller boxes.

Detail Size This box enables you to specify the dimensions (height and width) of one detail. Determine how 
wide you want each detail to be (based on number of characters, font size, etc.) and enter that 
value in the Width edit box.

Determine how high you want each detail to be (based on number of lines in the detail, font size, 
etc.) and enter that value in the Height edit box.

Gap Between 
Details

This box enables you to specify the empty area (gap) you want to allow between details. 
Horizontal = the gaps between details going across the page, Vertical = the gaps between details 
going down the page.

Determine the gaps you want to allow. Enter the horizontal gap in the Horizontal edit box and 
enter the vertical gap in the Vertical edit box.

Printing 
Direction

The Printing direction box enables you to specify the path the program follows when printing the 
details on a report page. Your options are:

Across then 
Down

Prints details across the columns, one detail in the first column, one in the next, 
one in the next, etc. Then, when all the columns have a detail, the program 
moves down the page and prints a second detail in the first column, then in the 
second, etc.

Down then 
Across

Prints details down the first column, then down the second column, etc.

Format 
Groups with 
Multiple 
Column

Select this check box if you want the program to format groups with multiple columns using the 
Width, Gap between Details, and Printing Directions specified for the selected section.

Related Information

Report Section Overview [page 534]
Determining Printing Area Characteristics [page 549]

1.7.3.2.10.4  Paging Tab (Section Expert)

Use the Paging tab to set properties such as: page numbers, orientation, and so on for a desired section.

New Page 
Before

New Page Before is an available format property for Group (header and footer) and Details 
sections. When you select this option, the program inserts a page break before it prints the 
section. The page break thus comes before:

● the group (if using the option with a Group footer section), or
● each report record (if using the option with a Details section).
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The Page Header and Page Footer appear on each page. If you have a subtotal or summary field 
in a Group Footer section, you can use the New Page Before option to put these values on pages 
following the value being totaled.

New Page 
After

When this check box is selected, the program inserts a page break after it prints the section.

● The Page Header and Page Footer appear on each page.
● Use New Page After in the Group footer section to print each group on a separate page.

Reset Page 
Number After

Resets the page number to one (1) for the following page, after it prints a group total. When this 
option is used in conjunction with Print at Bottom of Page, the program prints a single group on 
a page, prints the group value at the bottom of the page, and resets the page number to 1 for the 
next page. This option is useful whenever you are printing multiple reports from a single file (i.e., 
invoices), and you want each report to be numbered beginning with Page 1.

Orientation Allows you to set page orientation for each section in the report except for the Page Header and 
Page Footer. The default setting will be the same as the report page orientation in the Page 
Setup dialog box.

Note
Once changed from the default setting, section page orientation will not be affected by any 
further changes to the report page orientation.

1.7.3.2.11  Select Expert Dialog Box

Use the Select Expert to select the records or groups you want to include in your report (if you do not want them 
all included). When using the Select Expert, the program automatically generates a record or group selection 
formula.

To access the Select Expert options, right-click in the Report Designer, point to Report and click Select Expert, or 
click the Select Expert button in the Crystal Reports toolbar.

SAP Crystal Reports 2008 has added a new option to the Select Expert: the Saved Data Selection formula. This 
option lets users view a subset of data that has been saved in a report. When the report is refreshed, the 
SavedDataFilter prevents the saved data from being discarded and makes no call to the database to refresh that 
data. A saved Data Selection formula uses the same syntax as a Record Selection formula.

Tip
This Expert allows you to set up reasonably complex selection criteria, but to have more control over the 
formula that is generated, use the Formula Editor.

Search 
settings

Use the lists to select the condition that best finishes this sentence:

"I want to select all records where the value in the field I have selected is"

You can select primary conditions, date conditions or Boolean conditions, depending on the 
type of field you have selected.
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New Click the New tab or button to create a new selection formula. When you click this tab, the 
Choose Field dialog box appears where you select a field to create the selection formula on.

Delete Click this button to delete the active selection formula and its associated tab.

Browse The Browse button has been included as an aid in selecting the values that define your selection 
formula. When you click this button, the program displays a list of field values in the database. If 
the value you want is on the list, select the value and click the Paste Data button. The program 
enters the value selected in the active text box (the text box displaying the insertion point).

Note
If you need to select multiple values (for example, if you want to include records in which the 
field value is one of three values), the insertion point automatically moves to the next text box 
as soon as it finishes pasting data in the previous box.

Show/Hide 
Formula

Record selection criteria that you enter via the Expert automatically generates a record 
selection formula. You can review and modify this formula by clicking the Show button. When 
you click the button the Expert expands to show the formula. When you are finished editing/
reviewing, click the Hide button to hide the formula from view. The Select Expert is automatically 
updated with any modifications you make to the formula.

Record 
Selection/ 
Group 
Selection

Select the Record Selection option to create a record selection formula.

Select the Group Selection option to create a group selection formula.

Formula 
Editor

When you click this button, the Formula Editor appears with the selection formula shown in the 
Formula text box.

Related Information

Pushing Down Record Selection to the Database Server [page 569]
Formula Editor Dialog Box [page 774]

1.8 Glossary

CrystalReportViewer control A class that provides the functionality to view a report.

CrystalReportPartsViewer 
control

A class that provides the functionality to view individual report parts, such as 
chart, text, or field objects.

database field A SAP Crystal Reports field that represents a particular column of data in a 
database.

drill To change the way data is displayed in a report to gain a more specific 
understanding of where the data comes from ("drilling down") or to gain a 
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higher level understanding of the data by putting data sets together ("drilling 
up").

embedded report A report that has been imported into, or created within, a Visual Studio 2005 
project. When a report is embedded into the project, a wrapper class is 
automatically generated for the report. When you compile the project, both the 
report and its wrapper class are embedded into the assembly, the same as with 
any other project resource.

managed report A Crystal report file that resides in the BusinessObjects Enterprise CMS 
repository, and is accessed programmatically through an instance of the 
InfoObject class.

filter An expression that limits the data returned.

formula field A SAP Crystal Reports field that stores an executable expression. A formula can 
be a combination of operations, numeric values, and fields.

hierarchical data Data that contains multiple parameters that have a parent-child relationship.

non-embedded report A report that is external to the Visual Studio 2005 project. This includes reports 
located on the hard drive along a file directory path, reports exposed as a 
Report Web Service, and reports that are one of a group of reports that are 
exposed through Crystal Services

parameter field A SAP Crystal Reports field that represents a dynamic value. The user then 
populates the value at runtime with a parameter. There are two types of 
parameters, discrete and ranged. Discrete parameters are a single value, while 
ranged parameters are a range of values between a lower and upper boundary. 
A parameter with multiple values can be both discrete and ranged. In addition 
to those two types, parameters can be static, dynamic, or interactive. Static 
parameter values are stored in the report. Dynamic parameter values are 
retrieved from a data source outside of the report. A interactive parameter can 
be manipulated during runtime.

parameter prompt A UI prompt that helps users set a value for report parameters.

Report Application Server A rich set of server-based reporting services that let you tightly integrate 
reporting into your custom web applications. RAS provides a base set of 
services, focused on report processing, application integration, and run-time 
report modification.

report part A report object displayed by itself in a viewer without the rest of the report 
page.

report source A report source is an object used by the viewer to access the properties of a 
report. It provides the viewer with the means to query for report data, page 
information, and other internal report information

.rpt The file format of a Crystal report. By default reports are saved as .rpt.

.rptr The file format of a read-only Crystal report. It has the same properties as a 
regular report except that it can not be modified, or opened in any designer 
program. It can only be viewed in the SAP Crystal Reports Viewer.

saved data The current data in a report. It can be saved when the report is saved, and if not 
it will be discarded when refreshing or closing a report.
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selection formula A formula that specifies the records, or groups of records, you want included in 
your report. There are three possible selection formulas that you can use to 
filter your data: group, record or saved data selection formulas. The group 
selection formula specifies which records will be rendered. The record selection 
formula specifies which records will be saved data. The saved data selection 
formula shows a subset of the saved data in a report.

special field A field which contains report specific information such as page count, data, and 
time information.

subreport A subreport is a freestanding or linked report found within the main report. It 
allows you to retrieve information and set generic format options inherited from 
the report, as well as allowing you to open the subreport as a report.

User-defined Function Library 
(UFL)

A library of functions that is created by a developer to address a specific need.

unmanaged report A Crystal report file that resides on a local file system and is accessed 
programmatically by a file path.
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Important Disclaimers and Legal Information

Coding Samples
Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system 
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and 
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP 
intentionally or by SAP's gross negligence.

Accessibility
The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a 
binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does 
not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language
As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales 
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not 
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks
The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not 
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages 
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency 
(see: http://help.sap.com/disclaimer).
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